
IGEL OS Release Notes



IGEL OS Release Notes   2 / 1492

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Notes for Release 11.09.100 (see page 4)
Notes for Release 11.08.440 (see page 34)
Notes for Release 11.08.360 (see page 64)
Notes for Release 11.08.330 (see page 84)
Notes for Release 11.08.290 (see page 112)
Notes for Release 11.08.230 (see page 141)
Notes for Release 11.08.200 (see page 165)
Notes for Release 11.08.110 (see page 199)
Notes for Release 11.07.920 (see page 226)
Notes for Release 11.07.170 (see page 249)
Notes for Release 11.07.140 (see page 269)
Notes for Release 11.07.110 (see page 290)
Notes for Release 11.07.100 (see page 309)
Notes for Release 11.06.250 (see page 341)
Notes for Release 11.06.210 (see page 361)
Notes for Release 11.05.133 (see page 362)
Notes for Release 11.05.120 (see page 381)
Notes for Release 11.05.100 (see page 405)
Notes for Release 11.04.270 (see page 467)
Notes for Release 11.04.240 (see page 487)
Notes for Release 11.04.200 (see page 508)
Notes for Release 11.04.100 (see page 528)
Notes for Release 11.03.500 (see page 623)
Notes for Release 11.03.110 (see page 649)
Notes for Release 11.03.100 (see page 667)
Notes for Release 11.02.150 (see page 708)
Notes for Release 11.02.130 (see page 724)
Notes for Release 11.02.100 (see page 738)
Notes for Release 11.01.130 (see page 800)
Notes for Release 11.01.120 (see page 812)
Notes for Release 11.01.110 (see page 823)
Notes for Release 11.01.100 (see page 847)
Notes for Release 10.06.190 (see page 869)
Notes for Release 10.06.170 (see page 870)
Notes for Release 10.06.130 (see page 897)
Notes for Release 10.06.120 (see page 923)
Notes for Release 10.06.110 (see page 954)
Notes for Release 10.06.100 (see page 977)
Notes for Release 10.05.830 (see page 1073)
Notes for Release 10.05.800 (see page 1121)
Notes for Release 10.05.700 (see page 1157)
Notes for Release 10.05.500 (see page 1177)
Notes for Release 10.05.100 (see page 1220)
Notes for Release 10.04.100 (see page 1319)
Notes for Release 10.03.570 (see page 1385)
Notes for Release 10.03.550 (see page 1402)



IGEL OS Release Notes   3 / 1492

• Notes for Release 10.03.500 (see page 1421)



Notes for Release 11.09.100

IGEL OS Release Notes   4 / 1492

•
•
•
•
•
•

•

Notes for Release 11.09.100
Software: Version 11.09.100

Release Date: 2023-10-12

Release Note: Version RN-1109100-1

Last update: 2023-10-12

Supported Devices 11.09.100 (see page 5)
Component Versions 11.09.100 (see page 6)
Known Issues 11.09.100 (see page 14)
Security Fixes 11.09.100 (see page 19)
New Features 11.09.100 (see page 21)
Resolved Issues 11.09.100 (see page 28)

The Release Notes of IGEL OS 11.09.100 are also available in the following formats:

Plain text:
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Supported Devices 11.09.100
UD2-LX: UD2-LX 52

UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX UD6-LX 51

UD7-LX UD7-LX 20

UD7-LX 11

UD7-LX 10

See also Geräte, die von IGEL OS 11 unterstützt werden.
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Component Versions 11.09.100

Clients
Product Version

Amazon WorkSpaces Client  4.1.0      

Chromium 115.0.5790.170-2igel1695992905 

Cisco JVDI Client 14.1.a

Cisco Webex VDI plugin  43.6.0.26643  

Cisco Webex Meetings VDI plugin 42.10.8.14

Cisco Webex Meetings VDI plugin 42.6.11.6 

Cisco Webex Meetings VDI plugin  43.6.0.158  

Zoom Media Plugin 5.13.10.23090  

Zoom Media Plugin 5.14.10.23670 

Zoom Media Plugin  5.15.2.23760 

Citrix HDX Realtime Media Engine 2.9.600

Citrix Workspace App 20.10.0.6

Citrix Workspace App 23.05.0.58   

Citrix Workspace App 23.07.0.17 

deviceTRUST Citrix Channel 21.1.310.0

Crossmatch DP Citrix Channel 0125

Conky System Monitor 1.12.2-1 

ControlUp Agent 8.1.5.500

deskMate Client 2.1.3

DriveLock Agent 22.2.2.42489  

EPOS Connect 7.4.0.37727  

Ericom PowerTerm 14.0.3.71814

Evidian AuthMgr 1.5.8134

Evince PDF Viewer 42.3-0ubuntu3 
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FabulaTech Plugins 3.10.1.5

FabulaTech USB for Remote Desktop 6.1.3.1 

FabulaTech Scanner for Remote Desktop 3.3.0.2

FabulaTech Webcam for Remote Desktop 2.8.11

Firefox 115.2.1 

IBM iAccess Client Solutions 1.1.9.2

IGEL RDP Client  2.2igel1687350866   

IGEL AVD Client 1.1.30igel1695044534 

deviceTRUST RDP Channel  21.1.310.0     

Imprivata OneSign ProveID Embedded onesign-generic-bootstrap-
loader_7.12.0.688624_amd64

Lakeside SysTrack Channel 9.0

Login VSI Enterprise 4.8.6

NCP Secure Enterprise Client 6.00_rev29368

NX Client 7.8.2-4igel1685535669   

OpenVPN 2.6.3-2igel1684821787

Zulu JRE 17.0.8-1   

Parallels Client  19.2.0.23906 

Spice GTK (Red Hat Virtualization) 0.42-2igel1684932691

Remote Viewer (Red Hat Virtualization) 11.0-2igel1661863477 

Usbredir (Red Hat Virtualization) 0.13.0-2igel1677968775  

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.2-3   

Systancia AppliDis 6.1.4-17

HP Anyware PCoIP Software Client 23.01.1-18.04

ThinLinc Client 4.14.0-2324

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55  

Parole Media Player  4.16.0-3igel1686304269
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VNC Viewer 1.12.0+dfsg-8igel1675065715 

VMware Horizon Client 2306-8.10.0-21964631

Voip Client Ekiga 4.0.1-9build1igel1685429059 

Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.4

Philips Speech driver 13.2.3

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902 

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.1013

PKCS#11 Library OpenSC 0.23.0-0.3igel1686055473

PKCS#11 Library SecMaker NetID Enterprise 6.8.5.20   

PKCS#11 Library SecMaker NetID Client 1.1.0.37  

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.10-1igel1691506428 

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35
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Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.5.2-1igel1678006273  

Reader Driver REINER SCT cyberJack 3.99.5final.sp14-2igel1686635168

Resource Manager PC/SC Lite 2.0.0-1igel1691065840 

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.13igel1686114423

OpenSSL 1.1.1f-1ubuntu2.19    

OpenSSL 3.0.2-0ubuntu1.10  

OpenSSH Client 9.3p2-1igel1690097953 

OpenSSH Server 9.3p2-1igel1690097953   

Bluetooth stack (bluez) 5.66-1igel1669186181  

MESA OpenGL stack  23.1.2-1igel1686636111 

VDPAU Library version 1.5-2igel1677954724     

Graphics Driver INTEL 2.99.917+git20210115-1igel1654609037

Graphics Driver ATI/RADEON 19.1.0-3igel1657777718 

Graphics Driver ATI/AMDGPU 23.0.0-1igel1677481842       

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1654608979

Graphics Driver Nvidia 525.125.06-0ubuntu0.22.04.1

Graphics Driver VMware 13.3.0-3igel1654607153

Graphics Driver QXL (Spice) 0.1.6-1igel1687782644   

Graphics Driver FBDEV 0.5.0-2igel1654609009 

Graphics Driver VESA 2.5.0-1+b1igel1647004096 

Input Driver Evdev 2.10.6-2+b1igel1647004239   

Input Driver Elographics 1.4.3-1igel1678083379   

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.2-1+b1igel1683803726 
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Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891 

Input Driver Wacom 1.2.0-1igel1686600941 

Input Driver ELO Multitouch 4.3.0.0   

Input Driver ELO Singletouch 5.2                              

Kernel 6.1.42 #mainline-lxos-g1696246906

Xorg X11 Server 21.1.7-3igel1683808186       

Xorg Xephyr 21.1.7-3igel1683808186 

CUPS printing Daemon 2.4.2-5igel1687852452

PrinterLogic 25.1.0.637  

Lightdm Graphical Login Manager 1.30.0-0ubuntu5igel1685475374     

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.4.1-2.3ubuntu2.4  

NetworkManager 1.42.4-1igel1692869696 

ModemManager  1.20.6-2igel1693224023  

GStreamer 1.x 1.22.4-1igel1690179327

GStreamer 1.0 Fluendo aacdec 1.0.1

GStreamer 1.0 Fluendo asfdemux 1.0.1

GStreamer 1.0 Fluendo h264dec 1.0.4

GStreamer 1.0 Fluendo mp3dec 1.0.1

GStreamer 1.0 Fluendo mpeg4videodec 1.0.1

GStreamer 1.0 Fluendo vadec 1.0.2

GStreamer 1.0 Fluendo wmadec 1.0.1

GStreamer 1.0 Fluendo wmvdec 1.0.1

WebKit2Gtk 2.40.5-1igel1691399103  

Python2 2.7.18

Python3 3.10.12   

VM Guest Support Components
Virtualbox Guest Utils 7.0.8-dfsg-2igel1682408222        
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Virtualbox X11 Guest Utils 7.0.8-dfsg-2igel1682408222   

Open VM Tools 12.1.5-3~ubuntu0.22.04.1

Open VM Desktop Tools 12.1.5-3~ubuntu0.22.04.1      

Xen Guest Utilities 7.20.2-0ubuntu1~22.04.2

Spice Vdagent 0.22.1-3+b2igel1680584586

Qemu Guest Agent  8.0.4+dfsg-1igel1691991170  

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.21-1igel1690183811  

Mobile Device Access USB (imobile)  1.3.0-6+b3igel1677964762  

Mobile Device Access USB (gphoto) 2.5.30-1igel1677966247

VPN OpenConnect 9.12-1igel1687783022 

Scanner support 1.1.1-5

VirtualBox VM within IGEL OS 7.0.8-dfsg-2igel1682408222 

Virtual Background for Webcam

Services
Service Size Reduced Firmware

Asian Language Support 22.0 M  Included

Java SE Runtime Environment 54.5 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

678.2 M  Included

Ericom PowerTerm InterConnect 10.0 M Included

Media Player 256.0 K Included

Local Browser (Firefox)
Citrix Appliance

86.8 M Included

VMware Horizon
RDP

4.0 M Included

Cendio ThinLinc 11.0 M Included
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Printing (Internet printing protocol CUPS) 19.0 M Included

NoMachine NX 27.0 M Included

VMware Horizon 176.8 M  Included

Voice over IP (Ekiga)  6.2 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 11.8 M  Not included

Fluendo GStreamer Codec Plugins 3.2 M  Included

IBM i Access Client Solutions 134.8 M Not included

Red Hat Enterprise Virtualization 2.8 M Included

Parallels Client 6.0 M Included

NVIDIA graphics driver 378.2 M Not included

Imprivata Appliance 32.8 M Included

AppliDis 512.0 K Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 14.5 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 768.0 K Included

x32 Compatibility Support 4.2 M Included

Cisco JVDI client 63.2 M Included

PrinterLogic 38.0 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M  Not included

Stratusphere UX CID Key software 5.5 M Not included

Elastic Filebeat 36.0 M Not included

AVD  41.8 M Included

Local Browser (Chromium) 95.0 M  Not included

Amazon WorkSpaces Client 32.5 M Included

deskMate client 5.8 M Included

Cisco Webex VDI 104.5 M Not included
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Cisco Webex Meetings VDI 193.8 M  Not included

Zoom Media Plugin 161.8 M Not included

DriveLock 13.0 M Included

SpeechWrite Client 256.0 K Included

IGEL Imprivata Agent 768.0 K Included

LRS Output Management  256.0 K Included

Fluendo Browser Codec Plugins 10.5 M Included

HP Factory deployment documentation 88.5 M  Included

BIOS Tools 2.0 M  Included

HP Anyware Client 18.5 M Included

90meter Smart Card Support 256.0 K Included

Virtual Background for Webcam (Limited 
IGEL Support)

Limited Support Features

Mobile Device Access USB (Limited 
support)

Virtualbox (Limited support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

256.0 K Not included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 9.2 M Not included

VirtualBox (Limited support) 74.2 M Not included

Virtual Background for Webcam (Limited 
IGEL Support)

47.8 M Included
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Known Issues 11.09.100

Citrix
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, the 
following registry key needs to be enabled:
More...

Parameter Activate workaround for dual RTME 

sessions and H264 acceleration

Registry ica.workaround-dual-rtme

Range enabled / disabled (default)

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active session does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
Browser Content Redirection (BCR) does not work if DRI3 and hardware accelerated H.264 
deep compression codec is enabled.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" -> "For 
the entire screen".
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.
While starting Self-Service, it is possible that process ServiceRecord segfaults -> Self-Service 
cannot be started afterwards. 
A cache cleanup with reboot is needed. In addition, the following parameters should set to 
true.
More...

Parameter Clean up UI cache after Self-Service 

termination

Registry ica.selfservice.cleanupwebui

Value false (default)/true

Parameter Clean up Store cache after Self-Service 

termination

Registry ica.selfservice.cleanupstore
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Value false (default)/true

Browser Content Redirection (BCR) may not work with Chrome version 105.0.* or later. See 
https://support.citrix.com/article/CTX473065/hdx-browser-content-redirection-broken-with-
google-chrome-browser-version-105-or-higher
White / green fragments may appear during desktop launch if JPEG graphical codec is used.

OSC installer
OSC not deployable with IGEL Deployment Appliance: Version 11.3 or later is required for 
deploying IGEL OS 11.06. and following.

AVD
H.264 hardware decoding for MS-Teams optimization is currently limited to non-AMD devices 
due to stability issues on AMD devices.

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with local logon. It is 
necessary to switch off local logon and enable the following two keys via IGEL registry: 
userinterface.softkeyboard.autoshow  

userinterface.softkeyboard.autohide
With usage of PCoIP protocol, the virtual channel provided by VMware used for serial port 
and scanner redirection could freeze on logout from a remote session.
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry: 
vmware.view.enable-serial-port-redir

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only with usage of local layout and 
deadkeys enabled. If a keyboard layout is used which has deadkeys disabled (which is the 
default on IGEL OS), Horizon client falls back to en-US layout.
PCoIP sessions may crash in some cases, switch to Blast Protocol is recommended then. 
H.264/HEVC encoding can be disabled when overall performance is too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadic problems. Horizon Client tracks the drives which are dynamically 
mounted and adds them to the remote session using client drive mapping, means USB redirection 
is not used for these devices then. However, in case of devices like USB SD card readers, Horizon 

https://support.citrix.com/article/CTX473065/hdx-browser-content-redirection-broken-with-google-chrome-browser-version-105-or-higher
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does not map them as client drives but forcefully uses USB-redirection which results in an unclean 
unmount. 
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session
USB device redirection is considered as experimental for the Parallels client for Linux.

Firefox
With enabled Citrix Browser Content Redirection, Firefox has no H.264 and AAC multimedia 
codec support. Means, when codec support is needed in Firefox, BCR needs to be disabled. 
Citrix Browser Content Redirection is disabled by default.

Network
Wakeup from system suspend fails on DELL Latitude 5510.

Wi-Fi
TP-Link Archer T2UH WiFi adapters does not work after system suspend/resume. 
Workaround: Disabling system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client
There may be a segfault shown in the logs (during logout of Citrix Desktop session). Occurs only 
when using Citrix Workspace App 2010 and Cisco JVDI.

Base System
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).
It is not possible to perform an unattended OS12 migration to base system 12.2.0 as an 
additional / manual reboot is necessary. The recommended upgrade version for unattended 
migration is base system 12.2.1.

Conky
The right screen when using multiscreen environment may not be shown correctly. 
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920)



Notes for Release 11.09.100

IGEL OS Release Notes   17 / 1492

•

•

•

•

•

•

•

•

•

•

•
•
•

Firmware Update
On devices with 4 GB of flash or smaller, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit https://
kb.igel.com/igelos-11.04/en/error-not-enough-space-on-local-drive-when-updating-to-igel-
os-11-04-or-higher-32870765.htm for a possible solution and additional information.

 Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice (instead 
of once).
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersand (& character). 
Workaround: Add quotes at the beginning and the end of an affected URL. E.g.:
https://www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch

Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.

Audio jack detection on Advantec POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3-M340C: Sound preferences are showing Headphone & Microphone, although not 
connected.

Multimedia
Multimedia redirection with GStreamer could fail when using Nouveau GPU driver.

Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.
Wake up from suspend via UMS does not work on HP mt645 devices. 
Workaround: Disable system suspend and use shutdown instead.
Built-in fingerprint sensor is not supported on HP mt440 and mt645.
MAC-Address Passthrough not supported on Lenovo USB-C Hybrid Docking Station.
Wake-on-Lan via docking stations is not supported.

https://www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch
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In some rare cases, it is possible that connecting or booting Lenovo USB-C Hybrid Docking 
station over USB-C results in non-working / faulty display output. 
It may help to (re-)connect via USB-A. If this is the case, USB-C should be also functional then.
Display configuration of displays connected to HP G5 Docking Station may fail with HP t655.

Remote Management
AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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Security Fixes 11.09.100

IBM_5250
Updated IBM iAccess Client Solutions to version 1.1.9.2. Complete changelog via [https://
www.ibm.com/support/pages/ibm-i-access-acs-updates]

Chromium
Updated Chromium browser to version 115.0.5790.170.

Firefox
Updated Mozilla Firefox browser to version 115.2.1.

Base System
Fixed nss security issue CVE-2023-0767.  
Fixed libxml2 security issues CVE-2023-29469, CVE-2023-28484, CVE-2022-40304 and 
CVE-2022-40303.  
Fixed wavpack security issue CVE-2021-44269.  
Fixed tar security issue CVE-2022-48303.  
Fixed python3.6 security issue CVE-2022-37454.  
Fixed tiff security issues 
CVE-2023-0804, CVE-2023-0803, CVE-2023-0802,
CVE-2023-0801, CVE-2023-0800, CVE-2023-0799, CVE-2023-0798, CVE-2023-0797,
CVE-2023-0796 and CVE-2023-0795.  
Fixed rsync security issue CVE-2022-29154.  
Fixed vim security issues
More...

CVE-2022-2946, CVE-2022-2923, CVE-2022-2849,
CVE-2022-2845, CVE-2022-2581, CVE-2022-2571, CVE-2022-2345, CVE-2022-2304,
CVE-2022-2206, CVE-2022-2183, CVE-2022-2175, CVE-2022-2129, CVE-2022-2126,
CVE-2022-2125, CVE-2022-2124, CVE-2022-1968, CVE-2022-1942, CVE-2022-1898,
CVE-2022-1851, CVE-2022-1796, CVE-2022-1785, CVE-2022-1735, CVE-2022-1733,
CVE-2022-1720, CVE-2022-1674, CVE-2022-1629, CVE-2022-0413, CVE-2023-1175,
CVE-2023-1170, CVE-2023-0433, CVE-2023-0288, CVE-2023-0054, CVE-2023-0049 and
CVE-2022-47024.  

Fixed systemd security issues 
CVE-2022-4415 and CVE-2022-3821.  
Fixed curl security issues 
CVE-2023-27538, CVE-2023-27537, CVE-2023-27536, CVE-2023-27535, CVE-2023-27534 and 
CVE-2023-27533.  

https://www.ibm.com/support/pages/ibm-i-access-acs-updates
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Fixed xorg-server security issue CVE-2023-1393.  
Fixed protobuf security issues 
CVE-2022-1941 and CVE-2021-22570.  
Fixed python2.7 security issue CVE-2023-24329.  
Fixed python3.6 security issue CVE-2023-24329.  
Fixed libtpms security issues CVE-2023-1018 and CVE-2023-1017.  
Fixed chromium-browser security issues
Fixed sudo security issues CVE-2023-28487, CVE-2023-28486 and CVE-2023-2848.  
Fixed vim security issues
More...

CVE-2022-2207, CVE-2022-0729, CVE-2022-0714,
CVE-2022-0685, CVE-2022-0572, CVE-2022-0554, CVE-2022-0443, CVE-2022-0408,
CVE-2022-0368, CVE-2022-0361, CVE-2022-0359, CVE-2022-0351, CVE-2022-0319,
CVE-2022-0318, CVE-2022-0261, CVE-2022-0213, CVE-2021-4193 and CVE-2021-4192.  

Fixed heimdal security issue CVE-2022-45142.  
Fixed ghostscript security issue CVE-2023-28879.  
Fixed dnsmasq security issue CVE-2023-28450.  
Fixed zulu8-ca security issues 
CVE-2023-21930, CVE-2023-21937, CVE-2023-21938,
CVE-2023-21939, CVE-2023-21954, CVE-2023-21967 and CVE-2023-21968.
Updated Intel microcode to version 20230808.  
Updated AMD microcode to version 20230809.
Fixed libwebp security issue 
CVE-2023-4863 (initial only Chromium related) and CVE-2023-5129.
Fixed libvpx security issue CVE-2023-5217.  
Fixed libx11 security issues 
CVE-2023-43787, CVE-2023-43786 and CVE-2023-43785.  
Fixed Chromium security issue CVE-2023-5217.  
Fixed libxpm security issues 
CVE-2023-43789, CVE-2023-43788, CVE-2023-43787 and CVE-2023-43786.  
Fixed glibc security issue CVE-2023-4911.



Notes for Release 11.09.100

IGEL OS Release Notes   21 / 1492

•

•

•

•

•

•

•
•

New Features 11.09.100

Citrix 
Updated Citrix Workspace App to version 2307. Available Citrix Workspace Apps in this release: 
2307 (default), 2305, and 2010. Added support for playing short tones in optimized Microsoft 
Teams - requires an update to the latest version of Microsoft Teams.
Changes with Citrix Workspace App 2305 and 2307: 
New features:
Copy and paste files and folders between two virtual desktops [Technical Preview]
Parameter Copy and paste files and folders between two virtual desktops

Registry ica.module.vdgdt

Value true (default)/ false

Enhancement on 32-bit cursor support [Technical Preview]
Parameter Enhancement on 32-bit cursor support

Registry ica.wfclient.Cursor32bitSupport

Value true (default)/ false

Change the default browser for FIDO2
Parameter Change the default browser for FIDO

Registry ica.authman.fido2authbrowser

Value CEB (default), chromium, firefox, chromium-browser 

Support for authentication using FIDO2 when connecting to on-premises stores [Technical 
Preview]
Parameter Support for authentication using FIDO2 when connecting to on-

premises stores

Registry ica.authman.fido2enabled

Value false (default)/ true       

Fixed:
App Protection works with all the Citrix session types, including Firefox
  browser. Reboot of system after enabling/disabling the feature
  (ica.appprotection) is required.
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OSC Installer
Added possibility to create a minimal (self extracting) factory image with the OSC installer.

AVD
Updated IGEL AVD Client to version 1.1.30.

Chromium
Added possibility to use compressed BTRFS for Chromium profile partition. This is enabled by 
default.  
Enhanced registry key system.customization.chpro.fs_type with new option btrfs.
Parameter Chromium Profiles Partition Filesystem Type

Registry system.customization.chpro.fs_type

Range [ext4][f2fs][ntfs][ntfs-3g][btrfs] 

Value btrfs

 Added registry key to block the restore popup which is shown if Chromium browser is (re-)started 
after a crash.

Firefox
Added possibility to use compressed BTRFS and ntfs-3g for firefox profile partition.  
Enhanced registry key system.customization.chpro.fs_type with new options btrfs and ntfs-3g.
Parameter Firefox Profiles Partition Filesystem Type

Registry system.customization.ffpro.fs_type

Range [ext4][f2fs][ntfs][ntfs-3g][btrfs]      

Value ntfs

Network
Added MAC-address passthrough among Ethernet devices. With the following registry key a LAN 
device can be specified from which the MAC address shall be adopted. The donor device and any 
conflicting receiver device will be removed (by unbinding the driver) as long as the receiving 
device is present.
Parameter MAC address source
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Registry network.interfaces.ethernet.device%.mac_sou

rce

Range  [none][LAN][LAN2][LAN3][LAN4]  

Value none

Example: If LAN2 and LAN3 are configurations for docking stations that shall adopt the MAC 
address from LAN, the following two parameters must be set to
"LAN":  
  network.interfaces.ethernet.device1.mac_source  

  network.interfaces.ethernet.device2.mac_source  

   Warning: Misconfiguration may result in loss of connectivity
Added Lenovo FCC unlock tool for Quectel EM05

NCP VPN
Updated NCP Enterprise client to version 6.0 r29368.

OpenConnect VPN
Added further supported protocols for OpenConnect VPN client by adding Fortinet, F5 and Array. 
OpenConnect VPN is a feature with limited support, and the new protocols are not validated by 
IGEL.
Setup Network>VPN>OpenConnect VPN>Name>Session 

Parameter Protocol

Registry sessions.openconnect<INST>.vpnopts.protocol

Value {**}anyconnect{**}/nc/pulse/gp/f5/fortinet/

array      

Imprivata
Updated Imprivata bootstrap loader to version 7.12.0.688624  
This version can only be used with G4 Appliance and PIE Agents 7.12 or later!!

IGEL Agent Imprivata
Added: Computer policy affects showing shutdown and reboot buttons at lock screen.  
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Added: Query email from standard principal information. The following registry key will override it 
with an email provided by the App Moniker - if available.
Parameter Query Email from App Moniker

Registry iia.query_moniker

Range bool        

Value enabled / disabled    

Added: Reporting IGEL OS version to Imprivata Appliance  
Added: Display user name on 2nd factor query  
Added: Minor UI improvements

HID
Updated ELO touch driver to version 5.4 for single touch and 4.3 for multitouch.
Added support for usage or more than one touch screen (without calibration for now).

CUPS Printing
Updated PrinterLogic PrinterInstallerClient to version 25.1.0.637. The update fixes the 
determination of AD user if Kerberos login is used.

Cisco JVDI Client
Integrated Cisco JVDI 14.1.4

Base System
Updated kernel to version 6.1.42.
Added support for migrating IGEL OS11 to IGEL OS12. Details can be found here:
https://kb.igel.com/igelos-11.09/en/upgrading-from-igel-os-11-to-igel-os-12-101063106.html. 
UMS 12.02.120 or later is required. 
Migration related parameters:
Registry system.upgrade_igelos.ignore_memory_require

ment

Value false / true  

Hint Force upgrade of the IGEL OS if the device does not meet the 
minimal hardware requirement regarding RAM. Upgrade is 
performed on own risk and without official support by IGEL.



Notes for Release 11.09.100

IGEL OS Release Notes   25 / 1492

•

•

•
•

•

Registry system.upgrade_igelos.delete_custom_partiti

on

Value false / true  

Hint Automatically delete the existing custom partition while 
upgrading to the IGEL OS12.

 Changed: If firmware is reset to factory defaults or reinstalled with OSC, the IGEL Setup Assistant 
starts again.
Added some additional resolutions to the webcam virtual background solution (see changed 
registry keys).  
Enables to choose webcams for virtual background by device name and priority.  
Added new registry keys:
More...

Parameter Select webcam by devicename for example /dev/video0 or 
video0 (only valid if choose by devicename is used)

Registry Select webcam by devicename for example  /dev/video0 

or video0 
(only valid if choose by devicename is used)

Type  string         

Value empty 

Parameter Select webcam by priority list for example 
dev=video0;name=HD_Webcam_C270 (only valid if choose by 
priority is used)

Registry multimedia.webcam.virtual_background.webcam

_priority

Type  string         

Value empty 

Changed registry keys
More...

ParameterSelect how the webcam to use should be choosen.

Registry [Use first webcam][Choose by name]   

[Choose by vendor_id:product_id][Choose by number] 

[Choose by devicename][Choose by priority]  
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Value Use first webcam

ParameterSelect resolution to use.

Registry multimedia.webcam.virtual_background.resolution     

Value Use first webcam

Updated base system to Ubuntu Jammy 22.04.
Enabled Wifi Manager, Multi Monitor configuration and Display Switch to be fully functional also 
when endpoint is unlicensed.
Updated NVIDIA driver to version 525.
Added ddcutil and ddcui to firmware which are tools to reading and changing monitor settings.
Changed: IGEL Setup Assistant will come up on every boot as long as the system has starter- or no 
license. Setup Assistant is not triggered anymore if demo- or productive license is deployed and / 
or device is connected to an UMS.
Changed label of mobile broadband configuration dialogue in IGEL OS setup (Country or Region).

X11 System
Changed default of DRI3 parameter. This is now enabled by default.
Parameter Use DRI

Registry x.drivers.use_dri  

Type bool    

Value enabled / disabled

Zoom VDI
Updated Zoom VDI plugin 5.15.2.23760  
Available plugins in this release: 5.15.2.23760, 5.14.10.23670 and 5.14.10.23670

Multimedia
Removed GStreamer 0.10 support.
Changed: Backscrub package is still from Bionic compile. So, rebuilded against current Jammy libs 
to get rid of old dependencies.

Hardware
Added hardware support for LG USB Multi Port Hub.
Added hardware support for Lenovo ThinkPad L14 (AMD) Gen 4.
Added hardware support for Lenovo ThinkPad L15 (AMD) Gen 4.
Added hardware support for Pepperl&Fuchs BTC12N and BTC14N.
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Added hardware support for HP Pro mt440 G3.
Added hardware support for Lenovo ThinkPad L14 Intel Gen 4.
Added hardware support for Lenovo ThinkPad L15 Intel Gen 4.

Java
Updated Java runtime environment to Zulu JRE version 17.0.8-1.

Remote Management
Added: Transfer devices serial number to UMS on first boot of device.
If requirements for upgrading to IGEL OS12 are fulfilled, the field OS Type in UMS is extended by 
the OS12 Upgrade Ready attribute - e.g. IGEL Linux 11
  (OS12 Upgrade Ready; Kernel Version 6.1.42)



Notes for Release 11.09.100

IGEL OS Release Notes   28 / 1492

•

•

•

•

•

•

•

•

•

•
•
•

•

•
•
•

Resolved Issues 11.09.100

Citrix
Fixed: Situations where hardware decoder has not enough memory to handle certain video 
formats properly, are optimized / better handled now.
Fixed: In rare situations (observed when using teams app sharing) intermixed video frames appear 
which come from different H.264 streams. These frames are now being separated from each other 
and will be decoded separately.  
Added a new registry key to suppress such secondary frames entirely, as they render mostly 
duplicated content of the primary frames.
Parameter In case of mixed up H264 streams: Don't display frames from secondary 

streams

Registry ica.hw-accelerated-h264-suppress-secondary-frames

Type bool  

Value enabled / disabled

Fixed: Refresh/Redraw issues of Citrix session windows. Resuming from screensaver or 
uncovering a session window which was covered by another window works as expected now.
Changed: Default for ica.module.audioredirectionv4=true  due to connection 
problems with some VDI versions.
Fixed: H.264 streams with multiple reference frames (as produced by hardware encoders) are 
supported properly and do not lead to a potential crash anymore.
Fixed: In special situations, certain frames did not show up on the screen when VDPAU was 
configured.
Fixed: MS Teams optimization (CWA 2307).

AVD
Changed the x264enc QP setting to do less aggressive video quantization to improve outgoing 
video quality in MS Teams.
Fixed smartcard redirection in AVD client.
Fixed crash when last audio device was removed.  
Adaptive (average) MS-Teams video playback delay calculation and no key frame skipping on 
decoding to make playback more reliable.
Changed: Raised net.core.wmem_max  setting if AVD sessions are configured to avoid TCP 
connection resets being triggered by the Linux Kernel on large RdClientSDK data transfers.
Fixed screenshare issue with direct MS Teams calls when screen share is already active.  
Fixed potential client crash when virtual backgrounds are enabled in MS Teams.  
Fixed stale video window content in MS Teams when video feeds are switched but incoming 
video is not directly decodable.  
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Changed quantization range for the x264enc to allow a little more quantization being applied to 
outgoing MS Teams video streams.  
Fixed: Avoid large display delay of incoming MS Teams video streams by measuring NTP 
latency.
Changed MS-Teams video scaling default to fill-frame, instead of fit-frame.
Note that the related MS Teams settings are not redirected through the RdClientSDK, so it will 
always show in fill-frame mode in MS Teams.

RDP/IGEL RDP Client 2
Removed Multimedia Redirection for Windows Server2012r2 RDP Sessions.

VMware Horizon
Fixed: Horizon session starter cannot handle backslashes in password.

Parallels Client
Fixed an issue with multiple USB devices not being redirected correctly.

Network
Added possibility to set an antenna bitmap to configure which antenna should be used (for 
iwlwifi devices).  
Added new registry key to configure the antenna bitmap.
More...

Parameter Tx antenna bitmap

Registry network.interfaces.wirelesslan.device0.antenna_b

itmap_tx

Type string

Value None

Parameter Rx antenna bitmap

Registry network.interfaces.wirelesslan.device0.antenna_b

itmap_rx

Type string

Value None

Improved behaviour of WWAN devices on suspend/resume
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WiFi
Improved handling of WiFi network names with non-ASCII characters
Added registry keys for restricting frequencies used by WPA Supplicant (see the WPA Supplicant 
documentation regarding the network-specific settings freq_list  and scan_freq ). In IGEL 
OS, the settings affect all configured WiFi´s - these may be useful to improve roaming behaviour.
More...

Parameter List of allowed frequencies

Registry network.interfaces.wirelesslan.device0.freq_list

Type string

Value None

Parameter List of frequencies to scan

Registry network.interfaces.wirelesslan.device0.scan_freq

Type string

Value None

CUPS Printing
Fixed cups not starting properly.

Cisco Webex
Fixed Webex Meetings VDI not connecting to enterprise site.

Base System
Fixed reconnect of Lenovo Docking Station TBT Gen 3.
Added new registry key to set acpi= kernel cmdline  options (some devices needs 

acpi=off ).

Parameter Set ACPI kernel parameters.

Registry system.kernel.bootparams.acpi

Range [No setting][Force][On][Off][Noirq][Strict][Rsdt][Copy_dsdt]

Value None            
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Added new registry key to set reboot kernel cmdline  which can be used if reboot or 
shutdown issues are present.
Parameter Set reboot kernel parameters.

Registry system.kernel.bootparams.reboot

Range [Default][Bios][Triple][Kbd][Acpi][Efi][Pci]          

Value Default

Fixed ELO AccuTouch not picking up selection.
Fixed reloading of license page in IGEL Setup Assistant.
Added licensing information for Lenovo's FCC unlock tool.
Changed to s2idle on HP mt440 G3 as it improves behavior.  
Changed registry key for use mem sleep mode, depending on hardware
Parameter Set suspend mem sleep mode.

Registry system.suspend.sleep_mode

Range [Default][Suspend to RAM][Suspend to idle]          

Value Default

Fixed ELO multitouch configuration: No kernel module is needed anymore.
Fixed handling of custom bootsplash and wallpaper download-url
Fixed feature selection in OS Creator.
Changed the default setting for the mirror mode to the biggest common resolution (was 
Panning before)
Parameter Choose the mode which should be used for mirroring monitors if 

resolution differs.

Registry x.xserver%.mirror_mod

Range [Panning][Biggest common resolution][Scaling][Scaling down]      

Value Biggest common resolution

Changed the  handle_brightness_keys  default to enabled as this setting is needed for 
most of the current laptops anyways.
Parameter Handle Brightness Keys

Registry x.xserver%.handle_brightness_keys

Type bool    

Value enabled / disabled
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Use new DP MST connector setup name handling as new default as this avoids issue with only one 
monitor could get configured. This may cause issues with already present display profiles so you 
may need to revert this but in most cases you will already have this key set.
Parameter Use new DP MST connector setup name handling

Registry x.drm_daemon.use_new_dp_mst_handling

Type bool    

Value enabled / disabled

Fixed suspend / resume support on Lenovo L14 Intel Gen3 device.

H624
Fixed: H.264 streams with multiple reference frames (as produced by hardware encoders) are 
supported properly and do not lead to a potential crash anymore.
Fixed: In special situations, certain frames did not show up on the screen when VDPAU was 
configured.

X11 system
Changed default setting for DisplayLink Quirk which solves an issue with long startup times  
Registry key parameter now defaults to true:
Parameter Quirk to fix issues with Xorg start take ages with DisplayLink connected.

Registry x.xserver%.quirks.displaylink_crash_workaround

Type bool    

Value enabled / disabled

Changed: Update of screen configuration after resume - to ensure changes while suspend are 
detected / effective.

Audio
Fixed: Sound preferences not getting saved over reboot.

Misc
Fixed autostart notification of sessions in case restart is also active.

Hardware
Fixed screen lagging issue with Dell Latitude 7430.
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Added possibility to configure Intel PSR setting via registry.
Parameter Change settings for intel PSR (panel self refresh).

Registry x.drivers.intel.psr

Range [Default][Disable][Enable][Use only up to PSR1][Use up to PSR2]   

Value Default

Fixed immediate wakeup issue after shutdown on some HP mt645 G7

Remote Management
Fixed submitting device states to the UMS.
Fixed: Web console shadowing via ICG.
Fixed submitting device's uptime and total usage over ICG.
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Notes for Release 11.08.440
Software: Version 11.08.440

Release Date: 2023-08-16

Release Note: Version RN-1108440-1

Last update: 2023-08-16

Supported Devices 11.08.440 (see page 35)
Component Versions 11.08.440 (see page 36)
Known Issues 11.08.440 (see page 45)
Security Fixes 11.08.440 (see page 50)
New Features 11.08.440 (see page 51)
Resolved Issues 11.08.440 (see page 59)

The Release Notes of IGEL OS 11.08.440 are also available in the following formats:

Plain text: readme_11.08.440.txt1

https://www.igel.de/wp-content/uploads/2023/08/lxos_11.08.440.txt
https://www.igel.de/wp-content/uploads/2023/08/lxos_11.08.440.txt
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Supported Devices 11.08.440
UD2-LX: UD2-LX 52

UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX UD6-LX 51

UD7-LX UD7-LX 20

UD7-LX 11

UD7-LX 10

See also Devices Supported by IGEL OS 11.
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Component Versions 11.08.440

Clients
Product Version

Amazon WorkSpaces Client  4.1.0      

Chromium 114.0.5735.198-1igel1689190033

Cisco JVDI Client 14.1.3

Cisco Webex VDI plugin 43.6.0.26643   

Cisco Webex Meetings VDI plugin 42.10.8.14

Cisco Webex Meetings VDI plugin 42.6.11.6 

Cisco Webex Meetings VDI plugin 43.6.0.158

Zoom Media Plugin 5.12.6.22200

Zoom Media Plugin 5.13.10.23090   

Zoom Media Plugin 5.14.10.23670

Citrix HDX Realtime Media Engine 2.9.600

Citrix Workspace App 20.10.0.6

Citrix Workspace App 23.05.0.58    

Citrix Workspace App 23.07.0.17

deviceTRUST Citrix Channel 21.1.310.0

Crossmatch DP Citrix Channel 0125

Conky System Monitor 1.10.8-1

ControlUp Agent 8.1.5.500

deskMate Client 2.1.3

DriveLock Agent 22.2.2.42489  

EPOS Connect 7.4.0.37727  

Ericom PowerTerm 14.0.3.71814

Evidian AuthMgr 1.5.8134

Evince PDF Viewer 3.28.4-0ubuntu1.2  
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FabulaTech Plugins 3.10.0.9 

FabulaTech USB for Remote Desktop 6.1.3.1

FabulaTech Scanner for Remote Desktop 3.3.0.2

FabulaTech Webcam for Remote Desktop 2.8.11

Firefox 102.13.0 

IBM iAccess Client Solutions 1.1.9.2

IGEL RDP Client 2.2igel1687350866

IGEL AVD Client 1.1.27igel1691066375

deviceTRUST RDP Channel 21.1.310.0  

Imprivata OneSign ProveID Embedded onesign-generic-bootstrap-
loader_7.11.0.665541_amd64

Lakeside SysTrack Channel 9.0

Login VSI Enterprise 4.8.6

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628  

OpenVPN 2.6.1-1igel1680534357 

Zulu JRE 8.0.382-1

Parallels Client  19.2.0.23906 

Spice GTK (Red Hat Virtualization) 0.41-2igel1661863274  

Remote Viewer (Red Hat Virtualization) 11.0-2igel1661863477 

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980  

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.2-3   

Systancia AppliDis 6.1.4-17

HP Anyware PCoIP Software Client 23.01.1-18.04

ThinLinc Client 4.14.0-2324

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55  

Parole Media Player  4.16.0-1igel1611217037   
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VNC Viewer 1.12.0+dfsg-4igel1648284944

VMware Horizon Client 2306-8.10.0-21964631

Voip Client Ekiga 4.0.1-9build1igel1646743191 

Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.4

Philips Speech driver 13.2.3

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902 

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.1013

PKCS#11 Library OpenSC 0.23.0-0.3igel1686055473 

PKCS#11 Library SecMaker NetID Enterprise 6.8.5.20   

PKCS#11 Library SecMaker NetID Client 1.1.0.37  

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057 

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35
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Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.5.0-2igel1667897461 

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 2.0.0-1igel1691065840 

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.13

OpenSSL 1.1.1-1ubuntu2.1~18.04.23   

OpenSSH Client 9.3p2-1igel1690097953

OpenSSH Server 9.3p2-1igel1690097953   

Bluetooth stack (bluez) 5.65-1igel1663161703 

MESA OpenGL stack 22.1.7-0igel1661885230 

VAAPI ABI Version 0.40

VDPAU Library version 1.5-1igel1646992192     

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046 

Graphics Driver ATI/RADEON 19.1.0-3igel1657777718 

Graphics Driver ATI/AMDGPU 22.0.0-3igel1661860347    

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678 

Graphics Driver Nvidia 470.141.03-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-3igel1628859075

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534

Graphics Driver FBDEV 0.5.0-2igel1644486279  

Graphics Driver VESA 2.5.0-1igel1628504011  

Input Driver Evdev 2.10.6-2igel1629196047  

Input Driver Elographics 1.4.2-1igel1629196349 

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146  
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Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891 

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980 

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.17.15 #mainline-lxos-g1690808458

Xorg X11 Server 21.1.7-2igel1680497175 

Xorg Xephyr 21.1.7-2igel1680497175 

CUPS printing daemon 2.2.7-1ubuntu2.10igel1687852140

PrinterLogic 25.1.0.637

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14     

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.3.5-3ubuntu7.4   

NetworkManager 1.32.12-0ubuntu1igel1684263019 

ModemManager 1.18.10-2igel1662722763  

GStreamer 0.10 0.10.36-2ubuntu0.1igel201 

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.20.3-2igel1655908747 

GStreamer 1.0 Fluendo aacdec 1.0.1

GStreamer 1.0 Fluendo asfdemux 1.0.1

GStreamer 1.0 Fluendo h264dec 1.0.4

GStreamer 1.0 Fluendo mp3dec 1.0.1



Notes for Release 11.08.440

IGEL OS Release Notes   41 / 1492

GStreamer 1.0 Fluendo mpeg4videodec 1.0.1

GStreamer 1.0 Fluendo vadec 1.0.2

GStreamer 1.0 Fluendo wmadec 1.0.1

GStreamer 1.0 Fluendo wmvdec 1.0.1

WebKit2Gtk 2.38.6-0+deb10u1igel1684758904 

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.38-dfsg-3igel1662536482  

Virtualbox X11 Guest Utils 6.1.38-dfsg-3igel1662536482

Open VM Tools 11.0.5-4ubuntu0.18.04.2 

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.2

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.22.1-3igel1661859915 

Qemu GuestAgent 8.0.3+dfsg-3igel1690307265

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.20-1igel1660111560   

Mobile Device Access USB (imobile)  1.3.0-6igel12   

Mobile Device Access USB (gphoto) 2.5.29-1igel1653377622 

VPN OpenConnect 9.01-1igel1657119743  

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.38-dfsg-3igel1662536482 

Virtual Background for Webcam

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M  Included
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Java SE Runtime Environment 35.5 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

683.0 M  Included

Ericom PowerTerm InterConnect 10.2 M Included

Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

84.2 M Included

VMware Horizon
RDP

6.2 M Included

Cendio ThinLinc 11.0 M Included

Printing (Internet printing protocol CUPS) 21.2 M Included

NoMachine NX 27.2 M Included

VMware Horizon 189.5 M  Included

Voice over IP (Ekiga)  6.2 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M  Not included

Fluendo GStreamer Codec Plugins 6.5 M  Included

IBM i Access Client Solutions 134.8 M Not included

Red Hat Enterprise Virtualization 2.8 M Included

Parallels Client 6.0 M Included

NVIDIA graphics driver 260.8 M Not included

Imprivata Appliance 14.8 M Included

AppliDis 512.0 K Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 13.2 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.8 M Included

Cisco JVDI client 68.8 M Included



Notes for Release 11.08.440

IGEL OS Release Notes   43 / 1492

PrinterLogic 43.5 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M  Not included

Stratusphere UX CID Key software 5.5 M Not included

Elastic Filebeat 22.2 M Not included

AVD 133.0 M Included

Local Browser (Chromium) 96.2 M  Not included

Amazon WorkSpaces Client 32.8 M Included

deskMate client 5.8 M Included

Cisco Webex VDI 105. M Not included

Cisco Webex Meetings VDI 194.0 M  Not included

Zoom Media Plugin 177.0 M Not included

DriveLock 13.0 M Included

SpeechWrite Client 256.0 K Included

IGEL Imprivata Agent 1.5 M Included

LRS Output Management  256.0 K Included

Fluendo Browser Codec Plugins 10.5 M Included

HP Factory deployment documentation 88.5 M  Included

BIOS Tools 2.0 M  Included

HP Anyware Client 18.8 M Included

90meter Smart Card Support 256.0 K Included

Virtual Background for Webcam (Limited 
IGEL Support)

Limited Support Features

Mobile Device Access USB (Limited 
support)

Virtualbox (Limited support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

256.0 K Not included
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Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 67.2 M Not included

Virtual Background for Webcam (Limited 
IGEL Support)

34.8 M Included
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Known Issues 11.08.440

Citrix
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264
acceleration plugin, the following registry key needs to be enabled:
More...

Parameter Activate workaround for dual RTME sessions and H264 

acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled (default)

This workaround is not applicable when Enable Secure ICA is active for the
specific delivery group.
Adding smartcard readers during running / active session does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These occure with 
multimedia redirection of H.264, MPEG1 and MPEG2. (GStreamer 1.0 is used if browser content 
redirection is enabled active.)
Browser Content Redirection (BCR) does not work if DRI3 and hardware accelerated H.264 
deep compression codec is enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to a freeze. 
Selective H.264 mode (API v2) is not affected from this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression" -> > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.
While starting Self-Service, it is possible that process ServiceRecord segfaults -> Self-Service 
cannot be started afterwards.
A cache cleanup with reboot is needed. In addition, the following parameters should set to 
"true".
More...

Parameter Clean up UI cache after Self-Service termination

Registry ica.selfservice.cleanupwebui

Value false (default)/true

Parameter Clean up Store cache after Self-Service termination
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Registry ica.selfservice.cleanupstore

Value false (default)/true

Logoff of Self-Service causes a segfault with CWAL 2211 which ends the application. Restart of 
Self-Service is functional.
Browser Content Redirection (BCR) may not work with Chrome version 105.0.* or later
White/ green fragments may appear during desktop launch if JPEG graphical codec is used.
Under certain conditions, webcam redirection may not work.
If this is the case, GStreamer has to be set to version 1.0 via registry or by enabling Browser 
Content Redirection (BCR).

OSC Installer
OSC not deployable with IGEL Deployment Appliance: Version 11.3 or later is required for 
deploying IGEL OS 11.06. and following.

AVD
H.264 hardware decoding for MS-Teams optimization is currently limited to non -  AMD 
devices due to stability issues on AMD devices.

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window, which contains the server 
or sessions overview, cannot be resized anymore.
Copying text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with local logon.
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop when TC Setup is running at the same time.
With usage of PCoIP protocol, the virtual channel provided by VMware used for serial port 
and scanner redirection could freeze on logout from remote session.
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir

vmware.view.enable-scanner-redir  
Keyboard Input Source Language Synchronization works only with usage of local layout and 
deadkeys enabled.
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If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL OS), 
Horizon client falls back to en-US layout.
PCoIP sessions may crash in some cases, switching to Blast Protocol is recommended then. 
H.264/HEVC encoding can be disabled when overall performance is too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadic problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for theses devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB-redirection which results in an unclean unmount.
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session
USB device redirection is considered as experimental for the Parallels client for Linux.

Firefox
With enabled Citrix Browser Content Redirection, Firefox has no H.264 and AAC multimedia 
codec support. Means, when codec support is needed in Firefox, BCR needs to be disabled. 
Citrix Browser Content Redirection is disabled by default.
Multimedia playback in Firefox is unstable if GStreamer version 0.10 is active. The default 
GStreamer version for Firefox sessions.browser<inst>.gstreamer_version was set to 1.0.

Network
Wakeup from system suspend fails on DELL Latitude 5510.
If applications are configured to start after established network connection and network mounts 
are configured, spurious "Failed to start application" notifications may be shown. The 
applications still start.

Wi-Fi
TP-Link Archer T2UH WiFi adapters does not work after system suspend/resume. 
Workaround: Disabling system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client
There may be a segfault shown in the logs (during logout of Citrix Desktop session). Occurs only 
when using Citrix Workspace App 2010 and Cisco JVDI.



Notes for Release 11.08.440

IGEL OS Release Notes   48 / 1492

•

•

•

•

•

•

•

•

•

•

Base system
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary)

Conky
The right screen when using multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920)

Firmware update
On devices with 2 GB of flash storage it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit [https://
kb.igel.com/igelos-11.04/en/error-not-enough- space-on-local-drive-when-updating-to-igel-
os-11-04-or-higher-32870765.html] for a possible solution and additional information.

Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice (instead 
of once).
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersand (& character).
Workaround: Add quotes at the beginning and the end of an affected URL. E.g.:
'https://www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'

Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3-M340C: Sound preferences are showing Headphone & Microphone, although not 
connected.

Multimedia
Multimedia redirection with GStreamer could fail when using Nouveau GPU driver.

https://www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch
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Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.
Wake-up from suspend via UMS does not work on HP mt645 devices. Workaround: Disable 
system suspend and use shutdown instead.
System suspend is not supported on Lenovo L14 Gen 3 Intel-based device.
Built-in fingerprint sensor is not supported on HP mt440 and mt645.
Mac-Address Passthrough not supported on Lenovo USB-C Hybrid Docking Station.
Wake on Lan via docking stations is not supported.

Remote Management
AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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Security Fixes 11.08.440

IBM_5250
Updated IBM iAccess Client Solutions to version 1.1.9.2. Complete changelog via [https://
www.ibm.com/support/pages/ibm-i-access-acs-updates]

Chromium
Updated Chromium browser to version 114 (for fixing CVE-2023-3079).

Firefox
Updated Mozilla Firefox to version 102.13.0 ESR:
Fixes for mfsa2023-23, also known as: CVE-2023-37201, CVE-2023-37202, CVE-2023-37207, 
CVE-2023-37208, CVE-2023-37211.
Fixes for mfsa2023-19, also known as: CVE-2023-34414, CVE-2023-34416.
Fixes for mfsa2023-17, also known as: CVE-2023-32205, CVE-2023-32206, CVE-2023-32207, 
CVE-2023-32211, CVE-2023-32212, CVE-2023-32213, CVE-2023-32215.

Base System
Fixed cups security issue CVE-2023-32324.
Fixed libx11 security issue CVE-2023-3138.
Fixed libxml2 security issue CVE-2022-2309.
Fixed openssh security issue CVE-2023-28531.
Fixed dmidecode security issue CVE-2023-30630.
Fixed opensc security issue CVE-2023-2977.
Fixed texlive-bin security issue CVE-2023-32700.
Fixed ncurses security issues CVE-2023-29491, CVE-2022-29458, CVE-2021-39537, CVE-2019-17595 
and CVE-2019-17594.
Fixed perl security issue CVE-2023-31484.
Fixed openssl1.0 security issue, CVE-2023-2650.
Fixed openssl security issue CVE-2023-2650.
Fixed libuv1 security issue CVE-2021-22918.
Fixed zulu8-ca security issues CVE-2023-22049, CVE-2023-22043 and CVE-2023-22045.
Fixed openssh security issue CVE-2023-38408.
Fixed qemu security issues CVE-2023-2861, CVE-2023-1544, CVE-2023-0330 and CVE-2022-1050.

https://www.ibm.com/support/pages/ibm-i-access-acs-updates
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New Features 11.08.440

Citrix
Updated Citrix Workspace App to version 2307.
Available Citrix Workspace Apps in this release: 2307 (default), 2305 and 2010. Added support 
for playing short tones in optimized Microsoft Teams - requires update to the latest version of 
Microsoft Teams.
Changes with Citrix Workspace App 2305 and 2307:
New features:
Copy and paste files and folders between two virtual desktops [Technical Preview]

Parameter Copy and paste files and folders between 

two virtual desktops

Registry ica.module.vdgdt

Value true (default)/ false

Enhancement on 32-bit cursor support [Technical Preview]
Parameter Enhancement on 32-bit cursor support

Registry ica.wfclient.Cursor32bitsupport

Value true (default)/ false

Change the default browser fo FIDO2
Parameter Change the default browser for FIDO2

Registry ica.authman.fido2authbrowser

Value CEB (default), chromium, firefox, chromium-browser

Support for authentication using FIDO2 when connecting to on-premises stores [Technical 
Preview]
Parameter Support for authentication using FIDO2 

when connecting to on-premises stores

Registry ica.authman.fido2enabled

Value flase (default)/ true

Fixed:
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App Protection works with all the Citrix session types, including Firefox browser. Reboot of system 
after enabling/disabling the feature (ica.appprotection) is required.

AVD
Added WebRTC h264 encoder preset option:
Registry sessions.wvd%.options.webrtcencoderpreset

Value none / ultrafast / superfast / veryfast / faster / 
fast / medium (default) / slow / slower / veryslow / placebo

Added initial secondary ringer support. But since the RdClientSDK support for it currently is non-
functional (the sinkId does not change on the related MS- Teams setting), we added a command 
line option " --webrtc-ring-all-devices " and have set that as default in the cmd_ext
setting. This makes MS-Teams ring on all audio output devices. This default setting will be 
removed as soon as the RdClientSDK implementation works as expected!
Added clock to appbar - enable via System > Registry > 
sessions.wvd%.options.cmd_ext = -a

If appbar is enabled, the workarea of the session is reduced accordingly.
The appbar is always visible now

VMware Horizon
Updated Horizon client to version 2306-8.10.0-21964631
Parameter Open local files in published 

applications

Registry vmware.view.enable-file-association

Type bool

Value enabled (default) / disabled

Parameter Auto-connect to remote desktop or 

published app in case there's only one of 

them

Registry vmware.view.single-auto-connect

Type bool

Value enabled / disabled (default)
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Parameter Automatically connect to the desktop if 

there is only one or connect to the one 

which name is given

Registry vmware.view.auto-connect-desktop

Type bool

Value enabled / disabled (default)

Parameter Automatically connect to this server 

when starting the client

Registry vmware.view.auto-connect-broker

Type string

Value empty Default

Parameter Client behavior when all Sessions have 

been disconnected

Registry vmware.view.all-sessions-disconnected-

behavior

Range [Unconfigured][Quit client][Logoff from server][Keep 
current state]

Value Unconfigured

Parameter Disconnect empty App session 

automatically

Registry vmware.view.auto-disconnect-empty-app-

session

Type bool

Value enabled (default) / disabled

Parameter Maximum count of core dump files 

allowed
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Registry vmware.view.maxcoredumps

Type integer

Value 0 Default

Network
Added MAC-address pass through among Ethernet devices. With the following registry key a 
LAN device can be specified from which the MAC address shall be adopted. The donor device 
and any conflicting receiver device will be removed (by unbinding the driver) as long as the 
receiving device is present.
Parameter MAC address source

Registry network.interfaces.ethernet.device%.ma

c_source

Range [none][LAN][LAN2][LAN3][LAN4]

Value none

Example: If LAN2 and LAN3 are configurations for docking stations that shall adopt the MAC 
address from LAN, the following two parameters must be set to "LAN":
network.interfaces.ethernet.device1.mac_source

network.interfaces.ethernet.device2.mac_source
Warning: Misconfiguration may result in loss of connectivity
Added Lenovo FCC unlock tool for Quectel EM05

Open VPN
Updated cipher configuration of Open VPN. Now it is possible to specify the data-ciphers list. By 
default, the default cipher list AES-256-GCM:AES-128-GCM:CHACHA20-POLY1305 is active. 
Otherwise, a custom list can be specified in the Data ciphers parameter. Enter the ciphers 
separated with :. The existing parameter Cipher was renamed to Cipher (legacy parameter) and 
now has a new value unset in range, which means that the parameter cipher will be omitted in the 
configuration.
Setup Network > VPN > Open VPN > Connection > 

Options

Parameter Use default data cipher list
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Registry sessions.openvpn%.vpnopts.use_default_c

ipher_list

Value on / off

Setup Network > VPN > Open VPN > Connection 

> Options

Parameter Data ciphers

Registry sessions.openvpn%.vpnopts.data_ciphers

Value empty Default

OpenConnect VPN
Added further supported protocols for OpenConnect VPN client by adding Fortinet, F5 and 
Array. OpenConnect VPN is a feature with limited support, and the new protocols are not 
validated by IGEL.
Setup Network>VPN>OpenConnect VPN>Name>Session

Parameter Protocol

Registry sessions.openconnect<INST>.vpnopts.pro

tocol

Value {}anyconnect{}/nc/pulse/gp/f5/fortinet/array

Imprivata
Added 'IGEL Agent for Imprivata'. This requires an addon license (request via [https://
www.igel.com/imprivata-agent/]).

CUPS Printing
Updated PrinterLogic PrinterInstallerClient to version 25.1.0.637
Fixes the determination of the AD user when Kerberos login is used.

Cisco Webex
Updated Cisco Webex Meetings VDI plugin to version 43.6.0.158
** Available versions: 42.6.11.6, 42.10.8.14, 43.6.0.158

https://www.igel.com/imprivata-agent/
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Updated Cisco Webex VDI plugin to version 43.6.0.26643

Base system
Added some additional resolutions to the webcam virtual background solution (see changed 
registry keys).
Enables to choose webcams for virtual background by device name and priority.
Added new registry keys:
Parameter Select webcam by devicename for example /

dev/video0 or video0 (only valid if choose 

by devicename is used)

Registry multimedia.webcam.virtual_background.webc

am_device

Type string

Value empty Default

Parameter Select webcam by priority list for example 

dev=video0;name=HD_Webcam_C270 (only valid 

if choose by priority is used)

Registry multimedia.webcam.virtual_background.webca

m_priority

Type string

Value empty Default

Changed registry keys
Parameter Select how the webcam to use should be 

choosen.

Registry multimedia.webcam.virtual_background.choos

e_webcam_by

Range [Use first webcam][Choose by name] [Choose by 
vendor_id:product_id][Choose by number] [Choose by 
devicename][Choose by priority]

Value Use first webcam
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Parameter Select resolution to use.

Registry multimedia.webcam.virtual_background.reso

lution

Range [webcam default][webcam max][1920x1080][1280x720]
[640x480][480x360][424x240][320x240][320x180]

Value webcam default

Enabled Wi-Fi Manager, Multi Monitor configuration and Display Switch to be fully functional also 
when endpoint is unlicensed.

Driver
Updated Olympus driver for dictation to version 4.0.4.
Updated Philips Speech driver to version 13.2.3. Update fixes a minor bug in the Linux drivers 
which possibly caused unexpected error messages in some target software products. Furthermore, 
driver supports usage of PulseAudio (contrary to ALSA) audio interface. To be enabled via 
following registry parameter:
Parameter Use PulseAudio

Registry devices.philipsspeech.use_pulseaudio

Type bool

Value enabled / disabled (default)

zoomvdi
Updated ZoomVDI to version 5.14.10.23670. 
Available versions: 5.14.10.23670 (default), 5.13.10.23090 and 5.12.6.22200.

Hardware
Added hardware support for the Lenovo USB-C Universal Docking
Added hardware support for Lenovo L14 (AMD) Gen 4
Added hardware support for Lenovo L15 (AMD) Gen 4
Added hardware support for HP Pro mt440 G3 (excluding WWAN support).

Remote Management
Added: Transfer device's serial number to UMS on first boot of device.
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Fabulatech
Updated FabulaTech USB for Remote Desktop to version 6.1.3.1.
Updated FabulaTech Plugins to version 3.10.1.5.
Updated FabulaTech Scanner for Remote Desktop to version 3.3.0.2.
Updated FabulaTech Webcam for Remote Desktop to version 2.8.11.
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Resolved Issues 11.08.440

Citrix
Fixed: Situations where hardware decoder has not enough memory to handle certain video 
formats properly, are optimized / better handled now.
Fixed: In rare situations (observed when using teams app sharing) intermixed video frames 
appear which come from different H.264 streams. These frames are now being separated from 
each other and will be decoded separately.
Added a new registry key to suppress such secondary frames entirely, as they render mostly 
duplicated content of the primary frames.
Parameter In case of mixed up H264 streams: Don't 

display frames from secondary streams

Registry ica.hw-accelerated-h264-suppress-

secondary-frames

Type bool

Value enabled (default) / disabled

Fixed: Refresh/Redraw issues of Citrix session windows. Resuming from screensaver or 
uncovering a session window which was covered by another window works as expected now.
Fixed: dynamic e911 feature.
Added registry key ica.chrome-double-download  to control flock feature at 
wfica_wrapper. Enable flock blocks double app starts (due to double downloads by Chromium 
browser).
Parameter Control download mechanic for Citrix 

applications for Chrome web access

Registry ica.chrome-double-download

Range [Enable Lock][Disable Lock]

Value enable / disable (default)

Fixed: Web-based Citrix Cloud authentication pages.
Changed: Default for ica.module.audioredirectionv4=true  due to connection 
problems with some VDI versions.
Fixed: H.264 streams with multiple reference frames (as produced by hardware encoders) are 
supported properly and do not lead to a potential crash any more.
Fixed: In special situations, certain frames did not show up on the screen when VDPAU was 
configured.
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AVD
Improved: MS Teams video quality optimizations applied.
Fixed broken appbar - which can be enabled with System > Registry > 
sessions.wvd%.options.cmd_ext = -a
Changed the x264enc QP setting to do less aggressive video quantization to improve outgoing 
video quality in MS Teams.
Fixed autostartsingle registry option.
Fixed screenshare issue with direct MS Teams calls when a screenshare is already active.
Fixed potential client crash when virtual backgrounds are enabled in MS Teams.
Fixed stale video window content in MS Teams when video feeds are switched, but incoming video 
is not directly decodable.
Adjusted the quantization range for the x264enc to allow a little more quantization being applied 
to outgoing MS Teams video streams.
Fixed: Avoid large display delay of incoming MS Teams video streams by measuring NTP latency.

RDP/IGEL RDP Client 2
Fixed RDP timezone redirection not working for some locations.
Fixed fullscreen RDP session not starting with no monitor connected.

VMware Horizon
Fixed: Horizon session starter cannot handle backslashes in password.

Chromium
Added registry key to toggle prompt to accept downloads:
Parameter Enable IGEL Download Dialog

Registry chromiumglobal.app.enable_download_dia

log

Type bool

Value enabled (default) / disabled

Network
Fixed network configuration on HyperV.
Added possibility to set an antenna bitmap to configure which antenna should be used (for iwlwifi 
devices)
Added new registry key to configure the antenna bitmap
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Parameter Tx antenna bitmap

Registry network.interfaces.wirelesslan.device0.

antenna_bitmap_tx

Type string

Value empty Default

Parameter Rx antenna bitmap

Registry network.interfaces.wirelesslan.device0.

antenna_bitmap_rx

Type string

Value empty Default

Improved behaviour of WWAN devices on suspend/resume
Fixed setting credentials for system-wide proxy.

Cisco Webex
Renamed libstdc++.so.6, Webex Meetings client expects the highest version of libstdc++.so.6.

Base System
Added new registry key to set acpi= kernel cmdline options (some devices needs acpi=off).
Parameter Set ACPI kernel parameters.

Registry system.kernel.bootparams.acpi

Range [No setting][Force][On][Off][Noirq][Strict][Rsdt]
[Copy_dsdt]

Value No setting

Added new registry key to set reboot kernel cmdline which can be used if reboot or shutdown 
issues are present
Parameter Set reboot kernel parameters.

Registry system.kernel.bootparams.reboot

Range [Default][Bios][Triple][Kbd][Acpi][Efi][Pci]
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Value Default

Fixed issue with ELO AccuTouch not picking up selection.
Changed the handle_brightness_keys  default to enabled, as this setting is needed for 
most of the current laptops anyways.
Parameter Handle Brightness Keys

Registry x.xserver%.handle_brightness_keys

Type bool

Value enabled (default) / disabled

Fixed instability in handling of certain webcam devices, e.g. Meeting Owl 3.
Added licensing information for Lenovo's FCC unlock tool.
Use s2idle on HP mt440 G3 as it works better
Changed registry key to be able to use mem sleep mode depending on hardware
Parameter Set suspend mem sleep mode.

Registry system.suspend.sleep_mode

Range [Default][Suspend to RAM][Suspend to idle]

Value Default

H264
Fixed: H.264 streams with multiple reference frames (as produced by hardware encoders) are 
supported properly and do not lead to a potential crash anymore.
Fixed: In special situations, certain frames did not show up on the screen when VDPAU was 
configured.

X11 System
Changed default setting for DisplayLink Quirk which solves an issue with long startup times
Registry key parameter now defaults to true:
Parameter Quirk to fix issues with Xorg start take 

ages with DisplayLink connected.

Registry x.xserver%.quirks.displaylink_crash_work

around

Type bool
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Value enabled (default) / disabled

Audio
Fixed: Sound preferences not getting saved over reboot.

Remote Management
Added: Create log for support information if rmagent has been requested to release the device 
from UMS.
Retrieve the device's unit ID in more robust way.
The log file is only accessible to root
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Notes for Release 11.08.360
Software: Version 11.08.360

Release Date: 2023-06-14

Release Notes: Version RN-1108360-1

Last update: 2023-06-14

Supported Devices 11.08.360 (see page 65)
Component Versions 11.08.360 (see page 66)
Known Issues 11.08.360 (see page 75)
Security Fixes 11.08.360 (see page 80)
New Features 11.08.360 (see page 81)
Resolved Issues 11.08.360 (see page 82)

The Release Notes for IGEL OS 11.08.360 are also available in the following formats:

Plain text: readme_11.08.360.txt
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Supported Devices 11.08.360
UD2-LX: UD2-LX 52

UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.08.360

Clients
Product Version

Amazon WorkSpaces Client  4.1.0      

Chromium 112.0.5615.165-igel1686558208  

Cisco JVDI Client 14.1.3

Cisco Webex VDI plugin 43.4.0.25788     

Cisco Webex Meetings VDI plugin 42.10.8.14

Cisco Webex Meetings VDI plugin 42.6.11.6 

Cisco Webex Meetings VDI plugin 43.2.1.18    

Zoom Media Plugin 5.12.6.22200

Zoom Media Plugin 5.13.10.23090   

Zoom Media Plugin 5.14.0.23370

Citrix HDX Realtime Media Engine 2.9.600

Citrix Workspace App 20.10.0.6

Citrix Workspace App 23.02.0.10    

Citrix Workspace App 23.03.0.32  

deviceTRUST Citrix Channel 21.1.310.0

Crossmatch DP Citrix Channel 0125

Conky System Monitor 1.10.8-1

ControlUp Agent 8.1.5.500

deskMate Client 2.1.3

DriveLock Agent 22.2.2.42489  

EPOS Connect 7.4.0.37727  

Ericom PowerTerm 14.0.3.71814

Evidian AuthMgr 1.5.8134

Evince PDF Viewer 3.28.4-0ubuntu1.2  
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FabulaTech Plugins 3.10.0.9 

FabulaTech USB for Remote Desktop 6.1.2.9 

FabulaTech Scanner for Remote Desktop 3.0.1.0

FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 102.10.0 

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1685958191  

IGEL AVD Client 1.1.17igel1683185301 

deviceTRUST RDP Channel 21.1.310.0  

Imprivata OneSign ProveID Embedded onesign-generic-bootstrap-
loader_7.11.0.665541_amd64

Lakeside SysTrack Channel 9.0

Login VSI Enterprise 4.8.6

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628  

OpenVPN 2.6.1-1igel1680534357 

Zulu JRE 8.0.372-1  

Parallels Client  19.2.0.23906 

Spice GTK (Red Hat Virtualization) 0.41-2igel1661863274  

Remote Viewer (Red Hat Virtualization) 11.0-2igel1661863477 

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980  

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.2-3   

Systancia AppliDis 6.1.4-17

HP Anyware PCoIP Software Client 23.01.1-18.04

ThinLinc Client 4.14.0-2324

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55  

Parole Media Player  4.16.0-1igel1611217037   
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VNC Viewer 1.12.0+dfsg-4igel1648284944

VMware Horizon Client 2303-8.9.0-21435420   

Voip Client Ekiga 4.0.1-9build1igel1646743191 

Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.3

Philips Speech driver 13.1.10

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902 

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.1013

PKCS#11 Library OpenSC 0.22.0-2igel1643799581 

PKCS#11 Library SecMaker NetID Enterprise 6.8.5.20   

PKCS#11 Library SecMaker NetID Client 1.1.0.37  

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057 

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35
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Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.5.0-2igel1667897461 

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.9-1igel1677589353 

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.12   

OpenSSL 1.1.1-1ubuntu2.1~18.04.22   

OpenSSH Client 9.0p1-1+b1igel1661867805 

OpenSSH Server 9.0p1-1+b1igel1661867805   

Bluetooth stack (bluez) 5.65-1igel1663161703 

MESA OpenGL stack 22.1.7-0igel1661885230 

VAAPI ABI Version 0.40

VDPAU Library version 1.5-1igel1646992192     

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046 

Graphics Driver ATI/RADEON 19.1.0-3igel1657777718 

Graphics Driver ATI/AMDGPU 22.0.0-3igel1661860347    

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678 

Graphics Driver Nvidia 470.141.03-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-3igel1628859075

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534

Graphics Driver FBDEV 0.5.0-2igel1644486279  

Graphics Driver VESA 2.5.0-1igel1628504011  

Input Driver Evdev 2.10.6-2igel1629196047  

Input Driver Elographics 1.4.2-1igel1629196349 

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146  
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Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891 

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980 

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.17.15 #mainline-lxos-g1681319724

Xorg X11 Server 21.1.7-2igel1680497175 

Xorg Xephyr 21.1.7-2igel1680497175 

CUPS printing daemon 2.2.7-1ubuntu2.9igel1654064309

PrinterLogic 25.1.0.625  

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14     

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.3.5-3ubuntu7.4   

NetworkManager 1.32.12-0ubuntu1igel1684263019 

ModemManager 1.18.10-2igel1662722763  

GStreamer 0.10 0.10.36-2ubuntu0.1igel201 

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.20.3-2igel1655908747 

GStreamer 1.0 Fluendo aacdec 1.0.1

GStreamer 1.0 Fluendo asfdemux 1.0.1

GStreamer 1.0 Fluendo h264dec 1.0.4

GStreamer 1.0 Fluendo mp3dec 1.0.1
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GStreamer 1.0 Fluendo mpeg4videodec 1.0.1

GStreamer 1.0 Fluendo vadec 1.0.2

GStreamer 1.0 Fluendo wmadec 1.0.1

GStreamer 1.0 Fluendo wmvdec 1.0.1

WebKit2Gtk 2.38.6-0+deb10u1igel1684758904 

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.38-dfsg-3igel1662536482      

Virtualbox X11 Guest Utils 6.1.38-dfsg-3igel1662536482 

Open VM Tools 11.0.5-4ubuntu0.18.04.2  

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.2    

Xen Guest Utilities 7.10.0-0ubuntu1 

Spice Vdagent 0.22.1-3igel1661859915

Qemu Guest Agent 7.2+dfsg-6igel1683015333   

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.20-1igel1660111560   

Mobile Device Access USB (imobile)  1.3.0-6igel12   

Mobile Device Access USB (gphoto) 2.5.29-1igel1653377622 

VPN OpenConnect 9.01-1igel1657119743  

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.38-dfsg-3igel1662536482 

Virtual Background for Webcam

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M  Included
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Java SE Runtime Environment 35.5 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

481.0 M  Included

Ericom PowerTerm InterConnect 10.2 M Included

Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

84.2 M Included

VMware Horizon
RDP

6.2 M Included

Cendio ThinLinc 11.0 M Included

Printing (Internet printing protocol CUPS) 21.2 M Included

NoMachine NX 27.2 M Included

VMware Horizon 187.2 M  Included

Voice over IP (Ekiga)  6.2 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M  Not included

Fluendo GStreamer Codec Plugins 6.5 M  Included

IBM i Access Client Solutions 128.2 M Not included

Red Hat Enterprise Virtualization 2.8 M Included

Parallels Client 6.0 M Included

NVIDIA graphics driver 260.8 M Not included

Imprivata Appliance 14.8 M Included

AppliDis 512.0 K Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 14.2 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.8 M Included

Cisco JVDI client 68.8 M Included
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PrinterLogic 43.5 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M  Not included

Stratusphere UX CID Key software 5.5 M Not included

Elastic Filebeat 22.2 M Not included

AVD 133.0 M Included

Local Browser (Chromium) 107.5 M  Not included

Amazon WorkSpaces Client 32.8 M Included

deskMate client 5.8 M Included

Cisco Webex VDI 99.0 M Not included

Cisco Webex Meetings VDI 177.2 M  Not included

Zoom Media Plugin 176.8 M Not included

DriveLock 13.0 M Included

SpeechWrite Client 256.0 K Included

IGEL Imprivata Agent 1.5 M Included

LRS Output Management  256.0 K Included

Fluendo Browser Codec Plugins 9.5 M Included

HP Factory deployment documentation 88.5 M  Included

BIOS Tools 2.0 M  Included

HP Anyware Client 18.8 M Included

90meter Smart Card Support 256.0 K Included

Virtual Background for Webcam (Limited 
IGEL Support)

Limited Support Features

Mobile Device Access USB (Limited 
support)

Virtualbox (Limited support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

256.0 K Not included
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Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 66.8 M Not included

Virtual Background for Webcam (Limited 
IGEL Support)

34.8 M Included
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Known Issues 11.08.360
Citrix

To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These 
occur with multimedia redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if 
browser content redirection is enabled active.)
Browser Content Redirection (BCR) does not work if DRI3 and hardware-accelerated H.264 
deep compression codec are enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to 
a freeze. Selective H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.
When starting Self-Service, it is possible that the process ServiceRecord is segfaulted - Self-
Service cannot be started afterwards. 
A cache cleanup with a reboot is needed. In addition, the following parameters should be set to 
"true".
More...

Parameter Clean up UI cache after Self-Service termination

Registry ica.selfservice.cleanupwebui

Value false / true

Parameter Clean up Store cache after Self-Service termination

Registry ica.selfservice.cleanupstore

Value false / true
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Logoff of Self-Service causes a segfault with CWAL 2211 which ends the application. The restart 
of Self-Service is functional.
Browser Content Redirection (BCR) may not work with Chrome version 105.0.* or later.
White/ green fragments may appear during desktop launch if JPEG graphical codec is used.
-There may be problems with webcam redirection at Citrix. To fix the problem, GStreamer 
1.0 must be enabled - this can be done either via the registry for the session or by enabling the 
browser content redirection (BCR).
- Under certain conditions, webcam redirection may not work.  If this is the case, GStreamer has 
to be set to version 1.0 via registry or by enabling Browser Content Redirection (BCR).

OSC Installer
OSC not deployable with IGEL Deployment Appliance: Version 11.3 or later is required for 
deploying IGEL OS 11.06. and following.

AVD
AVD MS-Teams optimization can crash the AVD client if H264 software decoder 
is used (fluh264dec). AVD prefers the hardware decoders (fluvadec) but when there are no 
hardware decoders or when all hardware decoders are in use already, the software decoder is 
utilized, which may randomly crash the AVD client. It is likely when it crashes in a certain MS-
Teams call, it might crash quite soon again when rejoining the same call. A fix for that is under 
development.
A workaround is to disable incoming video in such MS-Teams calls, which is an option in the "..." 
menu from the control bar during an active call.
H264 hardware decoding for MS-Teams optimization is currently limited to non-AMD 
devices due to stability issues on AMD devices.
Scanning images within an AVD session (with the usage of FabulaTech Scanner 
Redirection) might fail and cause a reconnection if the compression level is set to high quality.
As a workaround, the compression level must be reduced.

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon.
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
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With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session.
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only with usage of local layout and 
deadkeys enabled.
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL 
OS), Horizon client falls back to en-US layout.
PCoIP sessions may crash in some cases, switching to Blast Protocol 
is recommended then. H.264/HEVC encoding can be disabled when overall performance is 
too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadical problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for these devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB redirection which results in an unclean unmount.
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.

Firefox
With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.
Multimedia playback in Firefox is unstable if GStreamer version 0.10 is active. The default 
GStreamer version for Firefox  sessions.browser\<inst>.gstreamer_version  was set 
to 1.0.

Network
Wakeup from system suspend fails on DELL Latitude 5510.
If applications are configured to start after established network connection and network mounts 
are configured, spurious "Failed to start application" notifications may be shown. The 
applications still start.
Set of credentials for manual system-wide proxy is broken.
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Wi-Fi
TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client
There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system
Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).

Conky
The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920).

Firmware Update
On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character).
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'
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Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3 M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia
Multimedia redirection with GStreamer could fail when using Nouveau GPU driver.

Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.
Wake-up from suspend via UMS does not work on HP mt645 devices. Workaround: Disable 
system suspend and use shutdown instead.
System suspend is not supported on Lenovo L14 Gen 3 Intel-based device.
If bluetooth is disabled via tray icon / menu on Lenovo L14 Gen3 (Intel-based), bluetooth tray 
icon is permanently disabled. Can be solved / re-enabeld with console command  rfkill 

unblock bluetooth
Built-in fingerprint sensor is not supported on HP mt645.

Remote Management
AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.

Fabulatech
Scanning images within an AVD session (with the usage of FabulaTech Scanner Redirection) 
might fail and cause a reconnection if the compression level is set to high quality.  
  As a workaround, the compression level must be reduced.
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Security Fixes 11.08.360

Base System
For security reasons, the accessory 'Network Tools' is enforced to run with Administrator (root) 
privileges only. Therefore, parameter 'Password protection on page Accessories > Network 
Tools was removed.
Fixed cups-filters security issue CVE-2023-24805.
Fixed mysql-5.7 security issues CVE-2023-21980 and CVE-2023-21912.
Fixed libwebp security issue CVE-2023-1999.
Fixed libssh security issues CVE-2023-2283 and CVE-2023-1667.
Fixed webkit2gtk security issues CVE-2023-28205, CVE-2023-27954, CVE-2023-27932, 
CVE-2022-32885, and CVE-2022-0108.
Fixed binutils security issues CVE-2023-25588, CVE-2023-25585 and CVE-2023-25584.
Fixed postgresql-10 security issues CVE-2023-2455 and CVE-2023-2454.
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New Features 11.08.360

Parallels Client
Updated Parallels client to version 19.2.0

Network
Added support for WWAN chipset Quectel EM05 on Lenovo L14 Gen3

Wi-Fi

Added option for DHCP refresh after roaming (within the same network).
Parameter Refresh DHCP after roaming

Registry network.interfaces.wirelesslan.device0.

roam_refresh_dhcp

Type bool

Value enabled  / disabled

Base System
Added possibility to clean-up IGEL licenses in license partition. License files which are 
superseded by other licenses will be removed and not downloaded from the UMS again. This helps 
keeping free space for new license files. The following parameter activates the license cleanup:
Parameter Clean up redundant licenses

Registry system.remotemanager.license_cleanup

Value true / false

zoomvdi
Integrated Zoom VDI 5.14.0.23370 
Available Zoom VDI Clients: 5.12.6.22200, 5.13.10.23090, and 5.14.0.23370

Hardware
Added hardware support for LG CQ601I
Added hardware support for Lenovo ThinkEdge SE10
Added hardware support for HP mt645 G7 with Ryzen 5
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Resolved Issues 11.08.360

RD Web Access
Fixed mouse pointer disappearing in RemoteApp sessions.

VMware Horizon
Fixed Single Sign-On feature in Horizon. 
The domain name is given by Kerberos in the format like in domain.com . 
This does not work for all Horizon installations.
Therefore, configuration option to specify / set domain format is added:
Parameter Fixup domain for Single Sign-On

Registry vmware.view.sso-cred-mode

Range [Derive domain from username] [Use fully qualified 
domain name] 
[Use short domain name] [Keep domain as is]

Value Derive domain from username

Network
Improved automatic connection with LTE module Quectel EM05.

Cisco JVDI Client
Fixed issue, Jabra Headset control button is not working.

Base System
Fixed the issue that on some devices the Bluetooth stays off if once disabled over Bluetooth 
tray menu.

Audio
New parameter to disable the time scheduling in pulseaudio module-udev-detect.
Parameter Disable timer scheduling for module-udev
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Registry   multimedia.pulseaudio.daemon.disable-

module-udev-tsched

Range     [auto] [true] [false]

Remote Management
Fixed assignment of the device's hostname by the UMS while registering a device.
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Notes for Release 11.08.330
Software: Version 11.08.330

Release Date: 2023-05-17

Release Notes: Version RN-1108330-1

Last update: 2023-05-17

Supported Devices 11.08.330 (see page 85)
Component Versions 11.08.330 (see page 86)
Known Issues 11.08.330 (see page 95)
Security Fixes 11.08.330 (see page 100)
New Features 11.08.330 (see page 102)
Resolved Issues 11.08.330 (see page 109)

The Release Notes for IGEL OS 11.08.330 are also available in the following formats:

Plain text: readme_11.08.330.txt
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Supported Devices 11.08.330
UD2-LX: UD2-LX 52

UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.08.330

Clients
Product Version

Amazon WorkSpaces Client 3.1.9

Chromium 112.0.5615.165-igel1682056835

Cisco JVDI Client 14.1.3

Cisco Webex VDI plugin 43.4.0.25788     

Cisco Webex Meetings VDI plugin 42.10.8.14

Cisco Webex Meetings VDI plugin 42.6.11.6 

Cisco Webex Meetings VDI plugin 43.2.1.18    

Zoom Media Plugin 5.12.6.22200

Zoom Media Plugin 5.13.10.23090   

Zoom Media Plugin 5.8.4.21112

Citrix HDX Realtime Media Engine 2.9.600

Citrix Workspace App 20.10.0.6

Citrix Workspace App 23.02.0.10    

Citrix Workspace App 23.03.0.32  

deviceTRUST Citrix Channel 21.1.310.0

Crossmatch DP Citrix Channel 0125

Conky System Monitor 1.10.8-1

ControlUp Agent 8.1.5.500

deskMate Client 2.1.3

DriveLock Agent 22.2.2.42489  

EPOS Connect 7.4.0.37727  

Ericom PowerTerm 14.0.3.71814

Evidian AuthMgr 1.5.8134

Evince PDF Viewer 3.28.4-0ubuntu1.2  
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FabulaTech Plugins 3.10.0.9 

FabulaTech USB for Remote Desktop 6.1.2.9 

FabulaTech Scanner for Remote Desktop 3.0.1.0

FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 102.10.0 

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1683897932 

IGEL AVD Client 1.1.17igel1683185301      

deviceTRUST RDP Channel 21.1.310.0  

Imprivata OneSign ProveID Embedded  onesign-generic-bootstrap-
loader_7.11.0.665541_amd64

Lakeside SysTrack Channel 9.0

Login VSI Enterprise 4.8.6

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628

Open VPN  2.6.1-1igel1680534357 

Zulu JRE 8.0.372-1  

Parallels Client  19.1.1.23476   

Spice GTK (Red Hat Virtualization) 0.41-2igel1661863274  

Remote Viewer (Red Hat Virtualization) 11.0-2igel1661863477 

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980    

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.2-3   

Systancia AppliDis 6.1.4-17

HP Anyware PCoIP Software Client 23.01.1-18.04

ThinLinc Client 4.14.0-2324

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55 

Parole Media Player 4.16.0-1igel1611217037 
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VNC Viewer 1.12.0+dfsg-4igel1648284944 

VMware Horizon Client 2303-8.9.0-21435420  

Voip Client Ekiga 4.0.1-9build1igel6 

Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.3

Philips Speech driver 13.1.10

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902 

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.1013

PKCS#11 Library OpenSC 0.22.0-2igel1643799581  

PKCS#11 Library SecMaker NetID Enterprise 6.8.5.20   

PKCS#11 Library SecMaker NetID Client 1.1.0.37  

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057 

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35
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Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.5.0-2igel1667897461 

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15   

Resource Manager PC/SC Lite  1.9.9-1igel1677589353    

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.12   

OpenSSL 1.1.1-1ubuntu2.1~18.04.22   

OpenSSH Client 9.0p1-1+b1igel1661867805

OpenSSH Server 9.0p1-1+b1igel1661867805 

Bluetooth stack (bluez) 5.65-1igel1663161703 

MESA OpenGL stack 22.1.7-0igel1661885230 

VAAPI ABI Version 0.40

VDPAU Library version 1.5-1igel1646992192    

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046 

Graphics Driver ATI/RADEON 19.1.0-3igel1657777718 

Graphics Driver ATI/AMDGPU 22.0.0-3igel1661860347

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678 

Graphics Driver Nvidia 470.141.03-0ubuntu0.20.04.1   

Graphics Driver VMware 13.3.0-3igel1628859075 

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534 

Graphics Driver FBDEV 0.5.0-2igel1644486279 

Graphics Driver VESA 2.5.0-1igel1628504011 

Input Driver Evdev 2.10.6-2igel1629196047

Input Driver Elographics 1.4.2-1igel1629196349 

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146 
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Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891 

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980 

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.17.15 #mainline-lxos-g1681319724

Xorg X11 Server 21.1.7-2igel1680497175  

Xorg Xephyr 21.1.7-2igel1680497175  

CUPS printing daemon 2.2.7-1ubuntu2.9igel1654064309

PrinterLogic 25.1.0.625  

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14  

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.3.5-3ubuntu7.4  

NetworkManager 1.32.12-0ubuntu1igel1672314294

ModemManager 1.18.10-2igel1662722763

GStreamer 0.10  0.10.36-2ubuntu0.1igel201  

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.20.3-2igel1655908747 

GStreamer 1.0 Fluendo aacdec 1.0.1

GStreamer 1.0 Fluendo asfdemux 1.0.1

GStreamer 1.0 Fluendo h264dec 1.0.4

GStreamer 1.0 Fluendo mp3dec 1.0.1
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GStreamer 1.0 Fluendo mpeg4videodec 1.0.1

GStreamer 1.0 Fluendo vadec 1.0.2

GStreamer 1.0 Fluendo wmadec 1.0.1

GStreamer 1.0 Fluendo wmvdec 1.0.1

WebKit2Gtk 2.38.5-1igel1676531358  

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.38-dfsg-3igel1662536482  

Virtualbox X11 Guest Utils 6.1.38-dfsg-3igel1662536482

Open VM Tools 11.0.5-4ubuntu0.18.04.2 

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.2 

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.22.1-3igel1661859915  

Qemu Guest Agent 7.2+dfsg-6igel1683015333

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.20-1igel1660111560 

Mobile Device Access USB (imobile) 1.3.0-6igel12 

Mobile Device Access USB (gphoto) 2.5.29-1igel1653377622 

VPN OpenConnect 9.01-1igel1657119743 

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.38-dfsg-3igel1662536482

Virtual Background for Webcam

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M  Included
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Java SE Runtime Environment 35.5 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

481.0 M  Included

Ericom PowerTerm InterConnect 10.2 M Included

Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

84.2 M Included

VMware Horizon
RDP

6.2 M Included

Cendio ThinLinc 11.0 M Included

Printing (Internet printing protocol CUPS) 21.2 M Included

NoMachine NX 27.2 M Included

VMware Horizon 187.2 M  Included

Voice over IP (Ekiga)  6.5 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M  Not included

Fluendo GStreamer Codec Plugins 6.5 M  Included

IBM i Access Client Solutions 128.2 M Not included

Red Hat Enterprise Virtualization 2.8 M Included

Parallels Client 6.0 M Included

NVIDIA graphics driver 260.8 M Not included

Imprivata Appliance 14.8 M Included

AppliDis 512.0 K Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 14.2 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.8 M Included

Cisco JVDI client 68.8 M Included
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PrinterLogic 43.5 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M  Not included

Stratusphere UX CID Key software 5.5 M Not included

Elastic Filebeat 22.2 M Not included

AVD 133.0 M Included

Local Browser (Chromium) 144.2 M  Not included

Amazon WorkSpaces Client 32.8 M Included

deskMate client 5.8 M Included

Cisco Webex VDI 99.0 M Not included

Cisco Webex Meetings VDI 177.2 M  Not included

Zoom Media Plugin 164.5 M Not included

DriveLock 13.0 M Included

SpeechWrite Client 256.0 K Included

IGEL Imprivata Agent 1.5 M Included

LRS Output Management  256.0 K Included

Fluendo Browser Codec Plugins 9.5 M Included

HP Factory deployment documentation 88.5 M  Included

BIOS Tools 2.0 M  Included

HP Anyware Client 18.8 M Included

90meter Smart Card Support 256.0 K Included

Virtual Background for Webcam (Limited 
IGEL Support)

Limited Support Features

Mobile Device Access USB (Limited 
support)

Virtualbox (Limited support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

256.0 K Not included
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Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 66.8 M Not included

Virtual Background for Webcam (Limited 
IGEL Support)

34.8 M Included
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Known Issues 11.08.330
Citrix

To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These 
occur with multimedia redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if 
browser content redirection is enabled active.)
Browser Content Redirection (BCR) does not work if DRI3 and hardware-accelerated H.264 
deep compression codec are enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to 
a freeze. Selective H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.
When starting Self-Service, it is possible that the process ServiceRecord is segfaulted - Self-
Service cannot be started afterwards. 
A cache cleanup with a reboot is needed. In addition, the following parameters should be set to 
"true".
More...

Parameter Clean up UI cache after Self-Service termination

Registry ica.selfservice.cleanupwebui

Value false / true

Parameter Clean up Store cache after Self-Service termination

Registry ica.selfservice.cleanupstore
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Value false / true

Logoff of Self-Service causes a segfault with CWAL 2211 which ends the application. The restart 
of Self-Service is functional.
Browser Content Redirection (BCR) may not work with Chrome version 105.0.* or later.
White/ green fragments may appear during desktop launch if JPEG graphical codec is used.
-There may be problems with webcam redirection at Citrix. To fix the problem, GStreamer 1.0 
must be enabled - this can be done either via the registry for the session or by enabling the 
browser content redirection (BCR).

OSC Installer
OSC not deployable with IGEL Deployment Appliance: Version 11.3 or later is required for 
deploying IGEL OS 11.06. and following.

AVD
AVD MS-Teams optimization can crash the AVD client if H264 software decoder 
is used (fluh264dec). AVD prefers the hardware decoders (fluvadec) but when there are no 
hardware decoders or when all hardware decoders are in use already, the software decoder is 
utilized, which may randomly crash the AVD client. It is likely when it crashes in a certain MS-
Teams call, it might crash quite soon again when rejoining the same call. A fix for that is under 
development.
A workaround is to disable incoming video in such MS-Teams calls, which is an option in the "..." 
menu from the control bar during an active call.
H264 hardware decoding for MS-Teams optimization is currently limited to non-AMD 
devices due to stability issues on AMD devices.
Scanning images within an AVD session (with the usage of FabulaTech Scanner Redirection) 
might fail and cause a reconnection if the compression level is set to high quality. 
As a workaround, the compression level must be reduced.

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon.
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
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With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session.
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only with usage of local layout and 
deadkeys enabled.
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL 
OS), Horizon client falls back to en-US layout.
PCoIP sessions may crash in some cases, switching to Blast Protocol 
is recommended then. H.264/HEVC encoding can be disabled when overall performance is 
too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadical problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for these devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB redirection which results in an unclean unmount.
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.

Firefox
With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.
Multimedia playback in Firefox is unstable if GStreamer version 0.10 is active. The default 
GStreamer version for Firefox  sessions.browser\<inst>.gstreamer_version  was set 
to 1.0.

Network
Wakeup from system suspend fails on DELL Latitude 5510.
If applications are configured to start after established network connection and network mounts 
are configured, spurious "Failed to start application" notifications may be shown. The 
applications still start.
Set of credentials for manual system-wide proxy is broken.
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Wi-Fi
TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client
There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system
Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).

Conky
The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920).

Firmware Update
On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character).
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'
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Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3 M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia
Multimedia redirection with GStreamer could fail when using Nouveau GPU driver.

Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.
Wake-up from suspend via UMS does not work on HP mt645 devices. Workaround: Disable 
system suspend and use shutdown instead.
System suspend is not supported on Lenovo L14 Gen 3 Intel-based device.
If bluetooth is disabled via tray icon / menu on Lenovo L14 Gen3 (Intel-based), bluetooth tray 
icon is permanently disabled. Can be solved / re-enabeld with console command rfkill 

unblock bluetooth

Remote Management
AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.

Fabulatech
Scanning images within an AVD session (with the usage of FabulaTech Scanner Redirection) 
might fail and cause a reconnection if the compression level is set to high quality.  
  As a workaround, the compression level must be reduced.
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Security Fixes 11.08.330

Chromium
Fixed Chromium browser security issues:
More...

CVE-2023-1236, CVE-2023-1235, CVE-2023-1234, CVE-2023-1233,
CVE-2023-1232, CVE-2023-1231, CVE-2023-1230, CVE-2023-1229,
CVE-2023-1228, CVE-2023-1227, CVE-2023-1226, CVE-2023-1225,
CVE-2023-1224, CVE-2023-1223, CVE-2023-1222, CVE-2023-1221,
CVE-2023-1220, CVE-2023-1219, CVE-2023-1218, CVE-2023-1217,
CVE-2023-1216, CVE-2023-1215, CVE-2023-1214, and CVE-2023-1213

Fixed Chromium browser security issues:
More...

CVE-2023-2137, CVE-2023-2136, CVE-2023-2135, CVE-2023-2134,
CVE-2023-2133, CVE-2023-2033, CVE-2023-1534, CVE-2023-1533,
CVE-2023-1532, CVE-2023-1531, CVE-2023-1530, CVE-2023-1529,
CVE-2023-1528, CVE-2022-2136, and CVE-2022-2033

Updated Chromium browser to version 112.0.5615.165

Firefox
Updated Mozilla Firefox to version 102.10.0 ESR
Security fixes for mfsa2023-14, also known as:  
  CVE-2023-29533, CVE-2023-29535, CVE-2023-29536, CVE-2023-29539,  
  CVE-2023-29541, CVE-2023-1945, CVE-2023-29548, CVE-2023-29550
  
  Security fixes for mfsa2023-10, also known as:  
  CVE-2023-25751, CVE-2023-28164, CVE-2023-28162, CVE-2023-25752, and CVE-2023-28176.

Base System
Updated Intel-microcode from 20221108 to 20230214 version for solving relevant security issues.
Fixed sudo security issues CVE-2023-28487, CVE-2023-28486, and CVE-2023-2848.
Fixed vim security issues:
More...

CVE-2023-1175, CVE-2023-1170, CVE-2023-0433,
CVE-2023-0288, CVE-2023-0054, CVE-2023-0049, CVE-2022-47024, CVE-2022-2946,
CVE-2022-2923, CVE-2022-2849, CVE-2022-2845, CVE-2022-2581, CVE-2022-2571,
CVE-2022-2345, CVE-2022-2304, CVE-2022-2206, CVE-2022-2183, CVE-2022-2175,
CVE-2022-2129, CVE-2022-2126, CVE-2022-2125, CVE-2022-2124, CVE-2022-1968,



Notes for Release 11.08.330

IGEL OS Release Notes   101 / 1492

•
•
•
•
•
•
•
•

•
•
•
•
•
•

CVE-2022-1942, CVE-2022-1898, CVE-2022-1851, CVE-2022-1796, CVE-2022-1785,
CVE-2022-1735, CVE-2022-1733, CVE-2022-1720, CVE-2022-1674, CVE-2022-1629, and CVE-2022-0413.

Fixed bubblewrap security issue CVE-2021-41133.
Fixed heimdal security issue CVE-2022-45142.
Fixed xorg-server security issue CVE-2023-1393.
Fixed ghostscript security issue CVE-2023-28879.
Fixed protobuf security issues CVE-2022-1941 and CVE-2021-22570.
Fixed python2.7 security issue CVE-2023-24329.
Fixed python3.6 security issue CVE-2023-24329.
Fixed zulu8-ca security issues:
More...

CVE-2023-21930, CVE-2023-21937, CVE-2023-21938,
CVE-2023-21939, CVE-2023-21954, CVE-2023-21967, and CVE-2023-21968  

Fixed systemd security issues CVE-2022-3821 and CVE-2022-4415.
Fixed openssl1.0 security issues CVE-2023-0466, CVE-2023-0465, and CVE-2023-0464.
Fixed openssl security issues CVE-2023-0466, CVE-2023-0465, and CVE-2023-0464.
Fixed gnutls28 security issue CVE-2023-0361.
Fixed qemu security issue CVE-2022-1050.
Fixed ffmpeg security issues CVE-2022-48434, CVE-2022-3964, CVE-2022-3341, and CVE-2022-3109.
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New Features 11.08.330

Citrix
Integrated Citrix Workspace App 2303
Available Workspace Apps in this release: 2303 (default), 2302, and 2010
New features:

Inactivity Timeout for Citrix Workspace app
Parameter Inactivity Timeout for Citrix Workspace app

Registry ica.authman.itoenabled

Value false / true

Background blurring for webcam redirection
Parameter Background blurring for webcam redirection

Registry ica.wfclient.HDXWebCamEnableBac

kgndEffect

Value false / true

Integrated RTME 2.9.600 for Skype for Business

AVD
Updated IGEL AVD client to version 1.1.17  
Added: Cache of last entered username for AVD sessions if no other username preset is active.  
Added parameter to disable the username cache:
Registry sessions.wvd%.options.cache-username

Value enabled  / disabled

VMware Horizon
Updated Horizon client to version 2303-8.9.0-21435420  
Added parameter for the browser redirection feature and setting rtav-related audio out option:
More...

Parameter Browser Redirection

Registry vmware.view.html5mmrbcr.enable-bcr
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Type bool

Value enabled  / disabled

Parameter Allow client webcam in Browser Redirection

Registry vmware.view.html5mmrbcr.media-stream-

enabled

Type bool

Value enabled  / disabled

Parameter Ignore website's certificate errors

Registry vmware.view.html5mmrbcr.ignore-certs

Type bool

Value enabled / disabled 

Parameter Save Cookies for Browser Redirection

Registry vmware.view.html5mmrbcr.use-cache-

enabled

Type bool

Value enabled  / disabled

Parameter Select audio output devices

Registry vmware.view.audio-out-option

Range [Default] [All] [User selection]

Chromium
Updated Chromium browser to version 112.0.5615.165

Firefox
Updated Mozilla Firefox to version 102.10.0 esr

Wi-Fi

Added iwlwifi backport Wi-Fi driver which can be used if issues with Intel Wi-Fi devices occur.  
Added registry key (reboot is required to become effective):
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Parameter Use the newer backport drivers for WLAN.

Registry network.drivers.use_backport_drivers

Type bool

Value enabled / disabled

Smartcard
Updated Pointsharp (formerly SecMaker) Net iD Client to version 1.1.0.37.

CUPS Printing
Added LRS printing agent V1R1.0.000
Corresponding configuration options in the Setup - Devices > Printing > LRS:
More...

Parameter Custom path to LRS software

Registry LRS.custom_path

Type string

Value empty

Parameter Manage printers by LRS VPSA

Registry LRS.active

Type bool

Value enabled / disabled

Parameter Debug mode

Registry LRS.debug_mode

Type bool

Value enabled / disabled

Parameter Pass Username to the LRS Backend

Registry LRS.pass_username

Type bool

Value enabled  / disabled
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Parameter Username Format

Registry LRS.username_format

Range [Username]  [Domain\Username]  
[Username@Domain]

Parameter Cups printer model name for local printing

Registry LRS.cups_model

Type string

Value Generic Raw Queue 

Parameter Driver name used in remote Windows session

Registry LRS.windows_driver

Type string

Value MS Publisher Color Printer

Parameter VSPA URL

Registry LRS.homeurl

Type string

Value http://replace.me.server/lrs/nlrswc2.exe/vpsx

Parameter ICA Sessions

Registry LRS.map_ica

Type bool

Value enabled / disabled

Parameter RDP Sessions

Registry LRS.map_rdp

Type bool

Value enabled  / disabled

Parameter Parallels Sessions

Registry LRS.map_twox

Type bool
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Value enabled / disabled

Parameter NX Client Sessions

Registry LRS.map_nxclient

Type bool

Value enabled / disabled

Parameter LRS Output Management

Registry services.printing_lrs.enabled

Type bool

Value enabled / disabled

Cisco Webex
Integrated Cisco Webex VDI  43.4.0.25788

Base System
Added Canadian Multilingual Standard keyboard layout.
Added BIOS update and password management support for HP t540 and t640. How-to guide 
via https://kb.igel.com/hp-ami-bios, added parameters:
More...

Setup System > Firmware Customization > Features

Parameter BIOS Tools

Registry services.bios_tools.enabled

Value enabled / disabled

Registry fwtools.bios_tools.bios_update_file

Value empty

Registry fwtools.bios_tools.bios_settings_set_fi

le

Value empty
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Registry fwtools.bios_tools.bios_settings_get_fi

le

Value empty

Registry fwtools.bios_tools.bios_pwd_file

Value empty

Registry fwtools.bios_tools.bios_pwd_file_old

Value empty

Registry fwtools.bios_tools.bios_download_userna

me

Value empty

Registry fwtools.bios_tools.bios_download_c

rypt_password

Value empty

Driver
Updated Olympus driver for dictation to version 4.0.3.

Audio
Updated EPOS Connect to version 7.4

Hardware
Added hardware support for Lenovo ThinkPad L14 Gen3 (Intel) - integrated LTE is not 
supported yet.
Added hardware support for HP Elite mt645 G7, includes WWAN Intel XMM 7560 R+
Added hardware support for LG CQ600i-6N.
Added hardware support for LG 24CQ650i-6N.
Added hardware support for HP t550.



Notes for Release 11.08.330

IGEL OS Release Notes   108 / 1492

•

•
•

•

Remote Management
Remote management evaluates an HTTP cookie which is propagated to the device during the ICG 
handshake and uses this cookie in all HTTP and WebSocket connections belonging to the 
established ICG connection. This enables the load balancing mechanism involving an affinity HTTP 
cookie to relate device's HTTP and WebSocket requests to a particular ICG connection.
Upgraded libwebsockets to v4.1.6
IGEL remote manager agent exposes in all ICG connections and HTTP(s) requests the User-
Agent HTTP header in the form:  igel-rmagent/\<RMAGENTVERSION>

Fabulatech
Updated Fabulatech plugins to version 3.10.0.9
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Resolved Issues 11.08.330

AVD
Fixed MS-Teams video color issues for remote video feeds and screenshares.
Optimized h.264 encoder settings for MS-Teams VDI calls.
Added a registry parameter to change the x264enc speed-preset property used for MS-Teams 
VDI:
Registry sessions.wvd%.options.webrtcencoderpres

et

Value [none] [ultrafast] [superfast] [veryfast] [faster] [fast]
[medium] [slow] [slower] [veryslow] [placebo]

Removed smartcard option until smartcard support is stabilized. Smartcard redirection can still 
be enabled by setting sessions.wvd%.options.cmd_ext = --smartcard

RDP/IGEL RDP Client 2
Fixed RDP sessions not starting on configured monitor.
Fixed RDP sessions no longer starting on multiple monitors when using different resolutions.
Fixed cursor position not updated correctly in RDP sessions.

Firefox
Fixed browser startup behavior if multiple browser sessions are started. As example, different 
autostarted browser sessions on different monitors. 
For that browser's remote interface is required to start the next session which takes time on slow 
endpoints. 
A configurable timeout is implemented:
Parameter Timeout for starting next browser session

Registry browserglobal.app.startup-timeout

Range [0][2][4][6][8][10][12][14][16][18][20]

Value 0

Fixed usage of more than one Firefox session. This was prevented by app-armor lacking an 
additional exception for Firefox 102 ESR.
Fixed handling of ica files - required to start Citrix sessions (restored former behavior).
Fixed typo in browser start script which could corrupt URL in some cases.
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Network
Fixed: Set third-party r8125 as the default driver on Lenovo L14 Gen 3 (Intel-based)
Added new registry key to prefer third-party r8125 over r8169 network driver.
Parameter Use thirdparty r8125 kernel module.

Registry network.drivers.r8169.prefer_r8125

Range [Auto] [Yes] [No]

Fixed tray icon for Fibocom L860-GL-16 LTE Module
SCEP:

Fixed SCEP via proxy
Added separator definition to use if multiple values of distinguished name attributes are 
desired, e.g. multiple organizational units. The separator also affects organization, state, 
locality, and potentially more in the future.
Parameter Name separator

Registry network.scepclient.cert%.multivalues

eparator

Range [<none>]

Value <none>

Wi-Fi
Fixed: Wi-Fi IP setting changes become effective immediately now.

Base System
Fixed serial port support for TSharc touch devices.
Added new registry key:
Parameter Set serial interface for TSharc touch (None for USB 

device).

Registry userinterface.touchscreen.tsharc_serial_

device

Range [None] [COM1] [COM2] [COM3 ][COM4] [COM1 (USB)] 
[COM2 (USB)]

Value None

Fixed missing node actions for changing Device Encryption settings
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Disabled suspend support on Intel-based Lenovo L14 Gen 3 as it does not work currently.
Fixed handling of certificate files in PEM format which do not include a final newline character.

Custom Partition
Fixed: Creating or updating a custom partition is decoupled from the partition's mounting so 
that the creating process doesn't interrupt the boot process and runs in the background now. This 
fixes problems with premature abort while creating the custom partition by a timeout during boot.

X11 System
Fixed out-of-range issue for NEC EA223WM monitors.
Added quirk for DisplayLink leads to long Xorg start on boot.
Added new registry key x.xserver0.quirks.displaylink_crash_workaround
Parameter Quirk to fix issues with Xorg start take ages with 

DisplayLink connected.

Registry x.xserver0.quirks.displaylink_crash_work

around

Type bool

Value enabled / disabled

VNC Viewer
Added VNC viewer parameter to control if current or all monitors are used when switching to 
full-screen mode.
Parameter Use all monitors in full-screen mode

Registry sessions.vncviewer<num>.option.fullsc

reenallmonitors

Value disabled / enabled

Remote Management
IGEL remote management reacts now on every change among the all available network 
interfaces in the running IGEL OS. So if a network interface becomes online or offline, then the 
remote management tries to connect the UMS or the ICG server.
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Notes for Release 11.08.290
Software: Version 11.08.290

Release Date: 2023-03-30

Release Notes: Version RN-1108290-1

Last update: 2023-03-30

Supported Devices 11.08.290 (see page 113)
Component Versions 11.08.290 (see page 114)
Known Issues 11.08.290 (see page 123)
Security Fixes 11.08.290 (see page 128)
New Features 11.08.290 (see page 130)
Resolved Issues 11.08.290 (see page 137)

The Release Notes for IGEL OS 11.08.290 are also available in the following formats:

Plain text: readme_11.08.290.txt



Notes for Release 11.08.290

IGEL OS Release Notes   113 / 1492

Supported Devices 11.08.290
UD2-LX: UD2-LX 52

UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.08.290

Clients
Product Version

Amazon WorkSpaces Client 3.1.9

Chromium 110.0.5481.177-igel1677133876

Cisco JVDI Client 14.1.3

Cisco Webex VDI plugin 43.2.0.25211 

Cisco Webex Meetings VDI plugin 42.10.8.14 

Cisco Webex Meetings VDI plugin 42.6.11.6

Cisco Webex Meetings VDI plugin 43.2.1.18

Zoom Media Plugin 5.12.6.22200

Zoom Media Plugin 5.13.10.23090   

Zoom Media Plugin 5.8.4.21112

Citrix HDX Realtime Media Engine 2.9.400

Citrix Workspace App 20.10.0.6

Citrix Workspace App 22.11.0.19 

Citrix Workspace App 23.02.0.10 

deviceTRUST Citrix Channel 21.1.310.0

Crossmatch DP Citrix Channel 0125

Conky System Monitor 1.10.8-1

ControlUp Agent 8.1.5.500

deskMate Client 2.1.3

DriveLock Agent 22.2.2.42489  

Ericom PowerTerm 14.0.3.71814

Evidian AuthMgr 1.5.8134

Evince PDF Viewer 3.28.4-0ubuntu1.2  

FabulaTech Plugins 3.8.0
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FabulaTech USB for Remote Desktop 6.1.2.9 

FabulaTech Scanner for Remote Desktop 3.0.1.0

FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 102.8.0 

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1679036889 

IGEL AVD Client 1.1.12igel1677413961  

deviceTRUST RDP Channel 21.1.310.0

Imprivata OneSign ProveID Embedded onesign-generic-bootstrap-
loader_7.11.0.665541_amd64

Lakeside SysTrack Channel 9.0

Login VSI Enterprise 4.8.6

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628 

Open VPN  2.6.0~git20220818-1igel1661859138

Zulu JRE 8.0.362-3 

Parallels Client  19.1.1.23476     

Spice GTK (Red Hat Virtualization) 0.41-2igel1661863274 

Remote Viewer (Red Hat Virtualization) 11.0-2igel1661863477 

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980   

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.2-3   

Systancia AppliDis 6.1.4-17

HP Anyware PCoIP Software Client 23.01.1-18.04   

ThinLinc Client 4.14.0-2324

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 4.16.0-1igel1611217037  

VNC Viewer 1.12.0+dfsg-4igel1648284944 



Notes for Release 11.08.290

IGEL OS Release Notes   116 / 1492

VMware Horizon Client 2212-8.8.0-21079016

Voip Client Ekiga 4.0.1-9build1igel6  

Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.2

Philips Speech driver 13.1.10

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902 

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.1013

PKCS#11 Library OpenSC 0.22.0-2igel1643799581

PKCS#11 Library SecMaker NetID Enterprise 6.8.5.20   

PKCS#11 Library SecMaker NetID Client 1.0.2.67

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057  

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5
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Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.5.0-2igel1667897461   

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15 

Resource Manager PC/SC Lite 1.9.9-1igel1677589353    

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.11 

OpenSSL 1.1.1-1ubuntu2.1~18.04.21 

OpenSSH Client 9.0p1-1+b1igel1661867805

OpenSSH Server 9.0p1-1+b1igel1661867805

Bluetooth stack (bluez) 5.65-1igel1663161703

MESA OpenGL stack 22.1.7-0igel1661885230

VAAPI ABI Version 0.40

VDPAU Library version 1.5-1igel1646992192

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046

Graphics Driver ATI/RADEON 19.1.0-3igel1657777718

Graphics Driver ATI/AMDGPU 22.0.0-3igel1661860347

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678 

Graphics Driver Nvidia 470.141.03-0ubuntu0.20.04.1 

Graphics Driver VMware 13.3.0-3igel1628859075 

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534 

Graphics Driver FBDEV 0.5.0-2igel1644486279  

Graphics Driver VESA 2.5.0-1igel1628504011 

Input Driver Evdev 2.10.6-2igel1629196047  

Input Driver Elographics 1.4.2-1igel1629196349   

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146

Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891



Notes for Release 11.08.290

IGEL OS Release Notes   118 / 1492

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980  

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.17.15 #mainline-lxos-g1677144800

Xorg X11 Server 21.1.7-1igel1677744226 

Xorg Xephyr 21.1.7-1igel1677744226   

CUPS printing daemon 2.2.7-1ubuntu2.9igel1654064309

PrinterLogic 25.1.0.625  

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14  

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.3.5-3ubuntu7.4  

NetworkManager 1.32.12-0ubuntu1igel1672314294 

ModemManager 1.18.10-2igel1662722763

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.20.3-2igel1655908747   

GStreamer 1.0 Fluendo aacdec 1.0.1

GStreamer 1.0 Fluendo asfdemux 1.0.1

GStreamer 1.0 Fluendo h264dec 1.0.4

GStreamer 1.0 Fluendo mp3dec 1.0.1

GStreamer 1.0 Fluendo mpeg4videodec 1.0.1
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GStreamer 1.0 Fluendo vadec 1.0.2

GStreamer 1.0 Fluendo wmadec 1.0.1

GStreamer 1.0 Fluendo wmvdec 1.0.1

WebKit2Gtk 2.38.5-1igel1676531358 

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.38-dfsg-3igel1662536482

Virtualbox X11 Guest Utils 6.1.38-dfsg-3igel1662536482 

Open VM Tools 11.0.5-4ubuntu0.18.04.2  

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.2

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.22.1-3igel1661859915  

Qemu Guest Agent 7.2+dfsg-1+b2igel1673334696

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.20-1igel1660111560  

Mobile Device Access USB (imobile) 1.3.0-6igel12 

Mobile Device Access USB (gphoto) 2.5.29-1igel1653377622

VPN OpenConnect 9.01-1igel1657119743  

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.38-dfsg-3igel1662536482

Virtual Background for Webcam

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M  Included

Java SE Runtime Environment 35.5 M Included
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Citrix Appliance
Citrix Workspace app
Citrix StoreFront

326.2M Included

Ericom PowerTerm InterConnect 10.2 M Included

Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

83.2 M Included

VMware Horizon
RDP

6.0 M Included

Cendio ThinLinc 11.0 M Included

Printing (Internet printing protocol CUPS) 21.2 M Included

NoMachine NX 27.2 M Included

VMware Horizon 270.2 M  Included

Voice over IP (Ekiga)  6.5 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M  Not included

Fluendo GStreamer Codec Plugins 6.5 M  Included

IBM i Access Client Solutions 128.2 M Not included

Red Hat Enterprise Virtualization 2.8 M Included

Parallels Client 6.0 M Included

NVIDIA graphics driver 260.8 M Not included

Imprivata Appliance 14.8 M Included

AppliDis 512.0 K Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 14.2 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.8 M Included

Cisco JVDI client 68.8 M Included

PrinterLogic 43.5 M Not included
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Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M  Not included

Stratusphere UX CID Key software 5.5 M Not included

Elastic Filebeat 22.2 M Not included

AVD 132.0 M Included

Local Browser (Chromium) 106.0 M Not included

Amazon WorkSpaces Client 32.8 M Included

deskMate client 5.8 M Included

Cisco Webex VDI 102.2 M Not included

Cisco Webex Meetings VDI 177.2 M  Not included

Zoom Media Plugin 164.5 M Not included

DriveLock 13.0 M Included

SpeechWrite Client 256.0 K Included

IGEL Imprivata Agent 1.5 M Included

Fluendo Browser Codec Plugins 9.5 M Included

HP Factory deployment documentation 88.5 M  Included

BIOS Tools 256.0 K Included

HP Anyware Client 18.8 M Included

90meter Smart Card Support 256.0 K Included

Virtual Background for Webcam (Limited 
IGEL Support)

Limited Support Features

Mobile Device Access USB (Limited 
support)

Virtualbox (Limited support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

256.0 K Not included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included
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Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 66.8 M Not included

Virtual Background for Webcam (Limited 
IGEL Support)

34.8 M Included
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Known Issues 11.08.290

Citrix
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These 
occur with multimedia redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if 
browser content redirection is enabled active.)
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to 
a freeze. Selective H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.
When starting Self-Service, it is possible that the process ServiceRecord is segfaulted - Self-
Service cannot be started afterwards. 
A cache cleanup with a reboot is needed. In addition, the following parameters should be set to 
"true".
More...

Parameter Clean up UI cache after Self-Service termination

Registry ica.selfservice.cleanupwebui

Value false / true

Parameter Clean up Store cache after Self-Service termination

Registry ica.selfservice.cleanupstore
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Value false / true

Logoff of Self-Service causes a segfault with CWAL 2211 which ends the application. The restart 
of Self-Service is functional.
Browser Content Redirection (BCR) may not work with Chrome version 105.0.* or later.
When the Jpeg graphical codec is in use, white/ green fragments may appear during the 
desktop launch. 

OSC Installer
OSC not deployable with IGEL Deployment Appliance: Version 11.3 or later is required for 
deploying IGEL OS 11.06. and following.

AVD
AVD MS-Teams optimization can crash the AVD client if H264 software decoder 
is used (fluh264dec). AVD prefers the hardware decoders (fluvadec) but when there are no 
hardware decoders or when all hardware decoders are in use already, the software decoder is 
utilized, which may randomly crash the AVD client. It is likely when it crashes in a certain MS-
Teams call, it might crash quite soon again when rejoining the same call. A fix for that is under 
development.
A workaround is to disable incoming video in such MS-Teams calls, which is an option in the "..." 
menu from the control bar during an active call.
H264 hardware decoding for MS-Teams optimization is currently limited to non-AMD 
devices due to stability issues on AMD devices.

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon.
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session.
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
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vmware.view.enable-serial-port-redir

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only with usage of local layout and 
deadkeys enabled.
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL 
OS), Horizon client falls back to en-US layout.
PCoIP sessions may crash in some cases, switching to Blast Protocol 
is recommended then. H.264/HEVC encoding can be disabled when overall performance is 
too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadical problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for these devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB redirection which results in an unclean unmount.
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.

Firefox
With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.
Multimedia playback in Firefox is unstable if GStreamer version 0.10 is active. The default 
GStreamer version for Firefox sessions.browser\<inst>.gstreamer_version  was set 
to 1.0.

Network
Wakeup from system suspend fails on DELL Latitude 5510.
If applications are configured to start after established network connection and network mounts 
are configured, spurious "Failed to start application" notifications may be shown. The 
applications still start.
Set of credentials for manual system-wide proxy is broken.

Wi-Fi
TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.
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Cisco JVDI Client
There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system
Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).

Conky
The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920).

Firmware Update
On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character).
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'

Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
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UD3 M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia
Multimedia redirection with GStreamer could fail when using Nouveau GPU driver.

Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.
Wake-up from suspend via UMS does not work on HP mt645 devices. Workaround: Disable 
system suspend and use shutdown instead.

Remote Management
AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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Security Fixes 11.08.290

Chromium
Fixed forbidden file access. If enabled, downloads, bookmarks and printing in Chromium are 
disabled.
Fixed Chromium browser security issues
More...

CVE-2023-0941, CVE-2023-0933, 
CVE-2023-0932, CVE-2023-0931, CVE-2023-0930, CVE-2023-0929, CVE-2023-0928, 
CVE-2023-0927, CVE-2023-0705, CVE-2023-0704, CVE-2023-0703, CVE-2023-0702,
CVE-2023-0701, CVE-2023-0700, CVE-2023-0699, CVE-2023-0698, CVE-2023-0697,
CVE-2023-0696, CVE-2023-0474, CVE-2023-0473, CVE-2023-0472, CVE-2023-0471,
CVE-2023-0141, CVE-2023-0140, CVE-2023-0139, CVE-2023-0138, CVE-2023-0137,
CVE-2023-0136, CVE-2023-0135, CVE-2023-0134, CVE-2023-0133, CVE-2023-0132,
CVE-2023-0131, CVE-2023-0130, CVE-2023-0129, CVE-2023-0128, CVE-2022-4440,
CVE-2022-4439, CVE-2022-4438, CVE-2022-4437, and CVE-2022-4436  

Updated Chromium browser to version 110.0.5481.177.

Network
Fixed privilege escalation in network management.

Base System

Fixed privilege escalation in setup_cmd  tool.
Changed: For security reasons, the default password protection value for the System 
Information accessory is set to Administrator.
IGEL Setup Accessories > System Information

Parameter Password protection

Registry sessions.device_manager0.pwprotected

Value Administrator (default)

Fixed empty password entry for floppy group.
Fixed sysstat security issue CVE-2022-39377.  
Fixed binutils security issue CVE-2022-38533.
Fixed libarchive security issues CVE-2022-36227 and CVE-2022-28066.
Fixed curl security issues 
More...
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CVE-2023-23916, CVE-2023-23915, CVE-2023-23914, CVE-2022-43552,
CVE-2022-43551, CVE-2022-42916, CVE-2022-42915, CVE-2022-35260, and CVE-2022-32221 

Fixed xorg-server security issues CVE-2022-46344, CVE-2022-46343, CVE-2022-46342, 
CVE-2022-46341, CVE-2022-46340, and CVE-2022-46283.
Fixed libksba security issue CVE-2022-47629.
Fixed nautilus security issue CVE-2022-37290.
Fixed python2.7 security issue CVE-2022-45061.
Fixed python3.6 security issue CVE-2022-45061.  
Fixed net-snmp security issues CVE-2022-44793, CVE-2022-44792, and CVE-2022-4479.  
Fixed tiff security issue CVE-2022-3970.
Fixed webkit2gtk security issues
More...

CVE-2023-23518, CVE-2023-23517, CVE-2022-42826, CVE-2022-46700,
CVE-2022-46699, CVE-2022-46698, CVE-2022-46692, CVE-2022-46691,
CVE-2022-42867, CVE-2022-42863, CVE-2022-42856, and CVE-2022-42852  

Fixed qemu security issues CVE-2022-4172 and CVE-2022-3165.
Fixed vim security issue CVE-2022-0392.
Fixed sudo security issue CVE-2023-22809.
Fixed libxpm security issues CVE-2022-4883, CVE-2022-46285, and CVE-2022-44617.
Fixed zulu8-ca security issues CVE-2023-21830, CVE-2023-21835, and CVE-2023-21843.
Fixed heimdal security issues CVE-2022-45142, CVE-2022-44640, CVE-2022-42898, CVE-2022-41916, 
CVE-2022-3437, and CVE-2021-44758.
Fixed python-setuptools security issue CVE-2022-40897.  
Fixed pam security issue CVE-2022-28321.
Fixed mysql-5.7 security issue CVE-2023-21840.
Fixed xorg-server security issue CVE-2023-0494.  
Fixed e2fsprogs security issue CVE-2022-1304.
Fixed openssl1.0 security issues CVE-2023-0286 and CVE-2023-0215.
Fixed openssl security issues CVE-2023-0286, CVE-2023-0215, CVE-2022-4450, and CVE-2022-4304.
Fixed tpm2-tss security issue CVE-2023-22745.  
Fixed nss security issue CVE-2023-0767.
Fixed python3.6 security issue CVE-2022-37454.
Fixed tiff security issues
More...

CVE-2023-0804, CVE-2023-0803, CVE-2023-0802,
CVE-2023-0801, CVE-2023-0800, CVE-2023-0799,
CVE-2023-0798, CVE-2023-0797, CVE-2023-0796, and CVE-2023-0795

Fixed rsync security issue CVE-2022-29154.  
Fixed tar security issue CVE-2022-48303.
Updated ca-certificates to version 20230311.
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New Features 11.08.290

Citrix
Added Citrix Workspace App 2302.
New features:  
Screen pinning in custom web stores [Technical Preview]
Parameter Multi-monitor support

Registry ica.authman.screenpinenabled

Value disabled / enabled

Available Citrix Workspace apps: 23.02 (default), 22.11, and 20.10

Citrix NSGClient
Added Citrix EPA client for Netscaler analysis.
No configuration is necessary. When the Netscaler URL is opened in the browser (Chromium or 
Firefox), the NSEPA checks configured in Netscaler are performed automatically. 
Dynamic updates are not possible in IGEL OS, due to the read-only system. Therefore, the option 
"Linux EPA Plugin Upgrade" must be set to "Never" in Netscaler.
Added Citrix NSGClient client for Netscaler VPN connections. 
No configuration is necessary. When the Netscaler URL is called in the browser (Chromium or 
Firefox), the NSGClient is configured automatically. Additionally, a desktop icon can be configured 
by adding an instance of sessions.nsgclient%

AVD
Updated AVD client to version 1.1.12 with MS-Teams screen share and tcp buffer bump fixes.

VMware Horizon
Updated VMware Horizon client to version 2212-8.8.0-21079016.
Fixed vmware-view protocol handler used for federated (SAML-based) authentication.
Added support for the monitor's option to specify which monitors (and in what order) are to be 
used for an all-monitors fullscreen mode. 
Furthermore, added minimized launch of the client window and the use of the useExisting
option for letting the client use an already running client to start a new desktop or app session.
More...

Parameter Specify a list of monitor numbers you want to use in all-
monitors fullscreen mode
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Registry vmware.view.use-monitors

Type string

Value empty (default)

Parameter Specify a list of monitor numbers you want to use in all-
monitors fullscreen mode

Registry sessions.vdm_client%.options.use-monitors

Type string

Value empty (default)

Parameter Use an already running Horizon session to start apps or 
desktops

Registry vmware.view.use-existing

Range [on] [off]

Parameter Use an already running Horizon session to start apps or 
desktops

Registry sessions.vdm_client%.options.use-

existing

Range [Global setting] [on] [off]

Parameter Run Horizon client in minimized mode

Registry vmware.view.launch-minimized

Range [on] [off]

Parameter Run Horizon client in minimized mode

Registry sessions.vdm_client%.options.launch-

minimized

Range [Global setting] [on] [off]

Parallels Client
Updated Parallels client to version 19.1.1.
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HP Anyware
Updated HP Anyware PCoIP Software Client to version 23.01.1
Added a new parameter in the registry for enabling high-performance options:
More...

Parameter Enable high performance on endpoint

Registry   pcoip.high_performance

Type       bool

Value     enabled / disabled 

Parameter Enable PCoIP Ultra on host

Registry   pcoip.ultra

Range     [Off] [CPU Offload] [GPU Offload] [Auto]

Firefox
Updated Firefox to version 102.8.0.

Network
Added check if BIOS has Wake-on-LAN disabled. If disabled, it is not recommended to configure 
the network interface to use WoL.

Registry key:
Parameter Respect the BIOS WoL setting so if disabled reflect this 

for the linux network devices settings.

Registry network.interfaces.respect_bios_wol_se

tting

Type bool

Value enabled / disabled

This check is only supported / possible on Lenovo devices with official IGEL OS hardware 
support.

Wi-Fi
Added: Set default wireless regulatory domain on HP devices, based on product option code.
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HID
Changed touchpad parameter name from "Enable Touchpad" to "Enable Touchpad on Boot" - 
just to clarify what is meant here.
Setup User Interface > Input > Touchpad

Parameter Enable Touchpad on Boot

Tooltip Can be overruled by Hotkey.

Registry userinterface.touchpad.general.Touchpa

dEnable

Type bool

Value enabled / disabled

Furthermore, changed the function of TouchpadOff  registry key. This is now only used for 
switching on and off tapping.
Setup User Interface > Input > Touchpad

Parameter Tapping Mode

Registry userinterface.touchpad.general.Touchpa

dOff

Range [With tapping] [Without tapping]

CUPS Printing
Updated PrinterLogic (Vasion) PrinterInstallerClient to version 25.1.0.625

Cisco Webex
Integrated Cisco Webex VDI 43.2

Integrated Cisco Webex Meetings VDI Plugin 43.2.1.18
Available Webex Meetings Plugins in this release: 43.2.1.18 (default), 42.10.8.14; and 42.6.11.6

Cisco JVDI Client
Integrated Cisco JVDI 14.1.3.307560

Note: Webex VDI requires a compatible Webex Meetings plugin installed in the client.
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Base System
Updated sscep to version 0.10.0
Added CPU temperature monitoring tools:
Graphical tool /usr/bin/psensor

Command line tool /usr/bin/sensors

Changed the default mem sleep mode to deep as some devices defaults to s2idle  which 
cases issues.  
Added a new registry key to set the suspend mem sleep mode.
Parameter Set suspend mem sleep mode.

Registry system.suspend.sleep_mode

Range [Suspend to RAM] [Suspend to idle]

Updated DriveLock Agent to version 22.2.2.42489 (2022.2).
Added for LVFS BIOS update support:

Improved version detection of installed BIOS version with fwupd .
Added registry key for enabling installation of not signed BIOS files
Parameter Allow only signed cab files (sometimes this must be 

switched off as not all BIOS files are signed).

Registry fwtools.bios_tools.allow_only_trusted

Type bool

Value enabled / disabled

Added registry key to enable bluetooth debugging messages.
Parameter Activate bluetooth debugging.

Registry devices.bluetooth.debug

Type bool

Value enabled / disabled 

CID Key Agent
Update of Stratusphere Connector ID Key to version 6.6.2-3

X11 System
Added new registry key to activate tear-free for modesetting driver:
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Parameter Enable tear free option for modesetting driver

Registry x.drivers.modesetting.use_tear_free

Type bool

Value enabled / disabled 

Multimedia
Added VP9 video hardware acceleration.
Added new registry key to switch from fluendo to vaapi gstreamer plugin for h264 hardware 
acceleration.
Parameter Switch from Fluendo to VAAPI h264 hardware accelerated 

decoder.

Registry multimedia.gstreamer.use_vaapi_for_h264

Type bool

Value enabled / disabled

zoomvdi
Updated Zoom VDI plugin to version 5.13.10.23090  
Available Zoom VDI plugins in this release: 5.13.10.23090 (default), 5.12.6.22200, and 
5.8.4.21112

Hardware
Added hardware support for HP USB-C G5 ESSENTIAL DOCK
Added hardware support for Lenovo ThinkCentre Neo50q Gen 4 (Celeron) device.
Added hardware support for Lenovo ThinkCentre Neo50q Gen 4 (i3) device.
Added hardware support for Lenovo ThinkCentre M75q Gen 2 device.
Added hardware support for Lenovo K14 Gen 1 (AMD-based) device.
Added hardware support for Lenovo ThinkCentre M70q Gen 3 device.
Added hardware support for HP t740.
Added hardware support for Lenovo K14 Gen1 (INTEL) device.

TC Setup (Java)
Added usage of long(er) device names - with port name in Audio Setup now. This affects 
"Default Sound Output" and "Default Sound Input" configuration at the Setup page Accessories 
> Sound Preferences > Options. The change is backwards-compatible.
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Fabulatech
Updated Fabulatech USB for Remote Desktop version 6.1.2.9
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Resolved Issues 11.08.290

Citrix
Fixed H264 codec: When the server was configured to update only regions which have changed, 
sometimes massive glitches in the shape of green rectangles appeared.
Fixed: Expired DigiCertSHA2SecureServerCA certificate was replaced with a valid one.

RDP/IGEL RDP Client 2
Fixed RDP fullscreen-toggle not working when trying to switch from fullscreen to windowed 
mode.

AVD
Fixed MS Teams optimized video playback to not slow down on high CPU load.
Fixed percentage (%) window size settings.
Fixed workarea session window size.
Fixed multimonitor switching during the session.
Supports all kinds of multimonitor constellations.
MS Teams optimization stability fixes.
Fixed Zoom VDI support for multimonitor.
Fixed video encoder buffer queuing up endlessly and crashing the client when it runs out of 
memory. Instead, we drop webcam frames when the CPU cannot catch up with encoding.
Fixed MS Teams screen share on multimonitor.
Fixed session size preset to take effect when not multimonitor.
Added fixes from the latest RdClientSDK including the TCP buffer bump to avoid unwanted 
client session dis-/reconnections.

NX Client

The value of sessions.nxclient%.general.commandline  is not converted to 
lowercase anymore when being written to a session config file

Chromium
Fixed Chromium browser could not be restarted after closing it too quickly.
Fixed ClearBrowsingDataOnExitList policy for Chromium browser.
Fixed Chromium browser not starting if persistent partition was missing.
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Firefox
Mozilla Firefox 102 ESR starting Citrix Desktops, requires an ica file to start sessions.
In normal browser session, the following parameter must be disabled: Sessions > Firefox Browser 
> Firefox Browser Global > Security > Hide local filesystem
If browser appliance mode is used, it is required to activate the following:
Parameter File system access needed for ica file handling

Registry browserglobal.app.ica-file-access-

needed

Type bool

Value enabled / disabled

Fixed Registry parameter sessions.browser\<instance>.gstreamer_version : If set 
to 1.0 via setup, 0.10 was activated and vice versa.

Network
Added registry key for choosing the base of decisions regarding automatically switching on and 
off enabling Wi-Fi carrier: either completed IP configuration of an Ethernet interface (default, 
traditional implementation) or just Ethernet carrier. The new key has no effect if 
network.applet.wireless.enable_wifi_auto_switch  is false.

Parameter Enable Wi-Fi automatic switch on Ethernet carrier change

Registry network.applet.wireless.enable_wifi_auto

_switch_on_carrier

Type bool

Value enabled / disabled

Fixed set of 100Mbps ethernet modes.
Improved reliability of Ethernet configuration on IGEL D220 devices.
Fixed disabling of WoL - which was not applied without a reboot.

Wi-Fi

Fixed: System regulatory domain now also set on the self-managed driver rtl8852be
Fixed default wireless regulatory domain for HP devices delivered to Indonesia - by detecting 
the HP option code.
Fixed: HP Probook 450 G8 with Intel AX201 Wi-Fi.
Improved finding hidden SSIDs with MT7922 WLAN adapter (e.g. in  Lenovo ThinkPad L14 Gen 3)
Improved restoration of Wi-Fi rfkill  state on startup
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Imprivata
Improved error messages on PIN enrollment.

Smartcard
Fixed cryptas TicTok v3 smartcards for usage within Horizon sessions.
Fixed sporadic duplicated smartcard user entries at login screen.

Cisco Webex
Integrated Cisco Webex Meetings VDI Plugin 42.6.11.6

Base System
Added new registry key to set left-hand on touchpad devices
Parameter Left hand

Registry userinterface.touchpad.gener

al.LeftHand

Type bool

Value disabled (default)

Fixed sporadic delayed local logon when logon logging is enabled.
Fixed German translation of "Enter new password" in password change dialog of local login 
window.
Fixed Starter license on devices with multiple network interfaces.
Fixed autostart notification.
Fixed error message on login screen in case Kerberos KDC (domain controller) is unreachable.
Added Fluendo h264 codec version 24012023, which fixes stability issues with AVD MS Teams 
optimization.
Changed default of registry key devices.bluetooth.connect_only  to true to make 
connect after reboot for bluetooth the new default.
Parameter Connect devices without pairing

Registry devices.bluetooth.connect_only

Type bool

Value enabled / disabled

Fixed WoL BIOS setting detection for Lenovo M75q Gen 2.
Fixed "fwupdmgr get-devices" command.
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Fixed disabling of the "BIOS Tools" feature on the Setup page System > Firmware 
Customization > Features.
Improved Bluetooth auto connect.

X11 System
Fixed monitor refresh rate handling in Display Switcher.
Fixed issue that display switcher settings were overwritten by UMS if network connection 
changed and the display switcher is still open.
Added registry key to influence the graphic card order in IGEL Setup.
Parameter Preserve card order in setup even if the X11 order of the 

cards was changed.

Registry x.drivers.preserve_order_if_swapped

Type bool

Value enabled / disabled 

Changed default X11 graphic driver from modesetting to intel on Dell Wyse 5070.

Audio
Added new registry key to limit max headphone volume (setting will survive a reset to factory 
defaults)
Parameter Limit max headphone volume (use auto or 0 - 100 as 

values).

Registry multimedia.alsa.limit_headphone_volume

Type string

Value auto (default)

Fixed audio output on jack in LG 24CN650N device.

Hardware
Fixed issue on specific monitors stayed black after resume (DPMS off).
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Notes for Release 11.08.230
Software: Version 11.08.230

Release Date: 2022-12-13

Release Notes: Version RN-1108230-1

Last update: 2022-12-13

Supported Devices 11.08.230 (see page 142)
Component Versions 11.08.230 (see page 143)
Known Issues 11.08.230 (see page 152)
Security Fixes 11.08.230 (see page 157)
New Features 11.08.230 (see page 159)
Resolved Issues 11.08.230 (see page 162)

The Release Notes for IGEL OS 11.08.230 are also available in the following formats:

Plain text: readme_11.08.230.txt
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Supported Devices 11.08.230
UD2-LX: UD2-LX 52

UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.08.230

Clients
Product Version

Amazon WorkSpaces Client 3.1.9

Chromium 108.0.5359.94-igel1670091085 

Cisco JVDI Client 14.1.2

Cisco Webex VDI plugin 42.10.0.23814 

Cisco Webex Meetings VDI plugin 41.12.6.12

Cisco Webex Meetings VDI plugin 42.2.10.7

Cisco Webex Meetings VDI plugin 42.6.8.5

Zoom Media Plugin 5.11.2.21530  

Zoom Media Plugin 5.12.1.21950 

Zoom Media Plugin 5.8.4.21112

Citrix HDX Realtime Media Engine 2.9.400

Citrix Workspace App 20.10.0.6

Citrix Workspace App 22.07.0.20      

Citrix Workspace App 22.11.0.19   

deviceTRUST Citrix Channel 21.1.310.0

Crossmatch DP Citrix Channel 0125

Conky System Monitor 1.10.8-1

ControlUp Agent 8.1.5.500

deskMate Client 2.1.3

DriveLock Agent 22.1.2.38801   

Ericom PowerTerm 14.0.3.71814

Evidian AuthMgr 1.5.8134

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech Plugins 3.8.0
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FabulaTech USB for Remote Desktop 6.0.35

FabulaTech Scanner for Remote Desktop 3.0.1.0

FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 91.13.0

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1663073494

IGEL AVD Client 1.1.6igel1670568183

deviceTRUST RDP Channel 21.1.310.0

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

Lakeside SysTrack Channel 9.0

Login VSI Enterprise 4.8.6

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628  

Open VPN  2.6.0~git20220818-1igel1661859138

Zulu JRE 8.0.352-1 

Parallels Client  19.1.0     

Spice GTK (Red Hat Virtualization) 0.41-2igel1661863274 

Remote Viewer (Red Hat Virtualization) 11.0-2igel1661863477

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.0-3

Systancia AppliDis 6.1.4-17

HP Anyware PCoIP Software Client 22.07.0-18.04

ThinLinc Client 4.14.0-2324

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player  4.16.0-1igel1611217037 

VNC Viewer 1.12.0+dfsg-4igel1648284944

VMware Horizon Client 2206-8.6.0-20094634  



Notes for Release 11.08.230

IGEL OS Release Notes   145 / 1492

Voip Client Ekiga  4.0.1-9build1igel6

Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.2

Philips Speech driver 13.1.10

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902 

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.1013

PKCS#11 Library OpenSC 0.22.0-2igel1643799581

PKCS#11 Library SecMaker NetID Enterprise 6.8.5.20   

PKCS#11 Library SecMaker NetID Client 1.0.2.67

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.5.0-2igel1667897461   

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.8-1igel1655196158   

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.10    

OpenSSL 1.1.1-1ubuntu2.1~18.04.20

OpenSSH Client 9.0p1-1+b1igel1661867805

OpenSSH Server 9.0p1-1+b1igel1661867805 

Bluetooth stack (bluez) 5.65-1igel1663161703 

MESA OpenGL stack 22.1.7-0igel1661885230 

VAAPI ABI Version 0.40

VDPAU Library version 1.5-1igel1646992192

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046

Graphics Driver ATI/RADEON 19.1.0-3igel1657777718  

Graphics Driver ATI/AMDGPU 22.0.0-3igel1661860347  

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678 

Graphics Driver Nvidia 470.141.03-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-3igel1628859075 

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534 

Graphics Driver FBDEV 0.5.0-2igel1644486279 

Graphics Driver VESA 2.5.0-1igel1628504011  

Input Driver Evdev 2.10.6-2igel1629196047

Input Driver Elographics 1.4.2-1igel1629196349 

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146 

Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980  
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Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.17.15 #mainline-lxos-g1666777173

Xorg X11 Server 21.1.4-3igel1668497029  

Xorg Xephyr 21.1.4-3igel1668497029 

CUPS printing daemon 2.2.7-1ubuntu2.9igel1654064309 

PrinterLogic 25.1.0.500

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14  

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202 

ISC DHCP Client 4.3.5-3ubuntu7.4  

NetworkManager 1.32.12-0ubuntu1igel1656495558 

ModemManager 1.18.10-2igel1662722763  

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.20.3-2igel1655908747

GStreamer 1.0 Fluendo aacdec 1.0.1

GStreamer 1.0 Fluendo asfdemux 1.0.1

GStreamer 1.0 Fluendo h264dec 1.0.3

GStreamer 1.0 Fluendo mp3dec 1.0.1

GStreamer 1.0 Fluendo mpeg4videodec 1.0.1

GStreamer 1.0 Fluendo vadec 1.0.2
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GStreamer 1.0 Fluendo wmadec 1.0.1

GStreamer 1.0 Fluendo wmvdec 1.0.1

WebKit2Gtk 2.38.2-1igel1667805620  

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.38-dfsg-3igel1662536482

Virtualbox X11 Guest Utils 6.1.38-dfsg-3igel1662536482

Open VM Tools 11.0.5-4ubuntu0.18.04.2 

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.2  

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.22.1-3igel1661859915 

Qemu Guest Agent 7.1+dfsg-2igel1663754599  

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.20-1igel1660111560  

Mobile Device Access USB (imobile)  1.3.0-6igel12   

Mobile Device Access USB (gphoto) 2.5.29-1igel1653377622    

VPN OpenConnect 9.01-1igel1657119743

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.38-dfsg-3igel1662536482 

Virtual Background for Webcam

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M  Included

Java SE Runtime Environment 36.5 M Included
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Citrix Appliance
Citrix Workspace app
Citrix StoreFront

373.8 M Included

Ericom PowerTerm InterConnect 10.2 M Included

Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

81.5 M Included

VMware Horizon
RDP

6.0 M Included

Cendio ThinLinc 11.0 M Included

Printing (Internet printing protocol CUPS) 21.2 M Included

NoMachine NX 27.2 M Included

VMware Horizon 256.0 M Included

Voice over IP (Ekiga)  6.5 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M  Not included

Fluendo GStreamer Codec Plugins 6.5 M  Included

IBM i Access Client Solutions 128.2 M Not included

Red Hat Enterprise Virtualization 2.8 M Included

Parallels Client 6.0 M Included

NVIDIA graphics driver 260.8 M Not included

Imprivata Appliance 14.2 M Included

AppliDis 512.0 K Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 14.2 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.8 M Included

Cisco JVDI client 66.8 M Included

PrinterLogic 47.8 M Not included
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Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M  Not included

Stratusphere UX CID Key software 7.5 M Not included

Elastic Filebeat 22.2 M Not included

AVD 132.2 M Included

Local Browser (Chromium) 103.8 M Not included

Amazon WorkSpaces Client 32.8 M Included

deskMate client 5.8 M Included

Cisco Webex VDI 69.0 M Not included

Cisco Webex Meetings VDI 119.0 M Not included

Zoom Media Plugin 127.8 M Not included

DriveLock 12.8 M Included

SpeechWrite Client 256.0 K Included

IGEL Imprivata Agent 1.5 M Included

Fluendo Browser Codec Plugins 4.0 M Included

HP Factory deployment documentation 88.5 M  Included

BIOS Tools 256.0 K Included

HP Anyware Client 16.5 M Included

90meter Smart Card Support 256.0 K Included

Virtual Background for Webcam (Limited 
IGEL Support)

Limited Support Features

Mobile Device Access USB (Limited support)

Virtualbox (Limited support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

256.0 K Not included

Mobile Device Access USB (Limited support) 256.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included
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VirtualBox (Limited support) 66.5 M Not included

Virtual Background for Webcam (Limited 
IGEL Support)

34.8 M Included
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Known Issues 11.08.230

Citrix
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These 
occur with multimedia redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if 
browser content redirection is enabled active.)
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to 
a freeze. Selective H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.
When starting Self-Service, it is possible that the process ServiceRecord is segfaulted - Self-
Service cannot be started afterwards. 
A cache cleanup with a reboot is needed. In addition, the following parameters should be set to 
"true".
More...

Parameter Clean up UI cache after Self-Service termination

Registry ica.selfservice.cleanupwebui

Value false / true

Parameter Clean up Store cache after Self-Service termination

Registry ica.selfservice.cleanupstore
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Value false / true

Logoff of Self-Service causes a segfault with CWAL 2211 which ends the application. The restart 
of Self-Service is functional.
BCR may not work with Chrome version 107.0.**. or later.
When the Jpeg graphical codec is in use, white/ green fragments may appear during the 
desktop launch. 

OSC Installer
OSC not deployable with IGEL Deployment Appliance: Version 11.3 or later is required for 
deploying IGEL OS 11.06. and following.

AVD
AVD MS-Teams optimization can crash the AVD client if H264 software decoder 
is used (fluh264dec). AVD prefers the hardware decoders (fluvadec) but when there are no 
hardware decoders or when all hardware decoders are in use already, the software decoder is 
utilized, which may randomly crash the AVD client. It is likely when it crashes in a certain MS-
Teams call, it might crash quite soon again when rejoining the same call. A fix for that is under 
development.
A workaround is to disable incoming video in such MS-Teams calls, which is an option in the "..." 
menu from the control bar during an active call.
H264 hardware decoding for MS-Teams optimization is currently limited to non-AMD 
devices due to stability issues on AMD devices.
For the case " sessions.wvd%.options.workspace-1.enabled " is explicitly set to 
"true", although there are no legacy WVD resources availabe for a certain user, the workspace 
download (that happens after the Azure-AD login) will take 5 minutes before it actually 
comes back showing the available workspaces for the user. This is an issue in the RdClientSDK 
and will be fixed in upcoming versions!

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon.
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
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With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session.
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only with usage of local layout and 
deadkeys enabled.
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL 
OS), Horizon client falls back to en-US layout.
PCoIP sessions may crash in some cases, switching to Blast Protocol 
is recommended then. H.264/HEVC encoding can be disabled when overall performance is 
too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadical problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for these devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB redirection which results in an unclean unmount.
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.

Firefox
With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.

Network
Wakeup from system suspend fails on DELL Latitude 5510.
If applications are configured to start after established network connection and network mounts 
are configured, spurious "Failed to start application" notifications may be shown. The 
applications still start.
Set of credentials for manual system-wide proxy is broken.
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Wi-Fi
TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client
There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system
Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).

Conky
The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920).

Firmware Update
On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character).
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'
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Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3 M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia
Multimedia redirection with GStreamer could fail when using Nouveau GPU driver.

Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.
Wake-up from suspend via UMS does not work on HP mt645 devices. Workaround: Disable 
system suspend and use shutdown instead.

Remote Management
AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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Security Fixes 11.08.230

Chromium
Fixed Chromium browser security issues:
More...

CVE-2022-4262, CVE-2022-4195,
CVE-2022-4194, CVE-2022-4193, CVE-2022-4192, CVE-2022-4191, CVE-2022-4190,
CVE-2022-4189, CVE-2022-4188, CVE-2022-4187, CVE-2022-4186, CVE-2022-4185,
CVE-2022-4184, CVE-2022-4183, CVE-2022-4182, CVE-2022-4181, CVE-2022-4180,
CVE-2022-4179, CVE-2022-4178, CVE-2022-4177, CVE-2022-4176, CVE-2022-4175,
CVE-2022-4174, CVE-2022-4135, CVE-2022-3890, CVE-2022-3889, CVE-2022-3888,
CVE-2022-3887, CVE-2022-3886, CVE-2022-3885, CVE-2022-3450, CVE-2022-3449,
CVE-2022-3448, CVE-2022-3447, CVE-2022-3446, CVE-2022-3445, CVE-2022-3444,
CVE-2022-3443, CVE-2022-3373, CVE-2022-3370, CVE-2022-3318, CVE-2022-3317,
CVE-2022-3316, CVE-2022-3315, CVE-2022-3314, CVE-2022-3313, CVE-2022-3312,
CVE-2022-3311, CVE-2022-3310, CVE-2022-3309, CVE-2022-3308, CVE-2022-3307,
CVE-2022-3306, CVE-2022-3305, CVE-2022-3304, CVE-2022-3201, CVE-2022-3661,
CVE-2022-3660, CVE-2022-3659, CVE-2022-3658, CVE-2022-3657, CVE-2022-3656,
CVE-2022-3655, CVE-2022-3654, CVE-2022-3653, CVE-2022-3652, and CVE-2022-3723

Updated Chromium browser to version 108.0.5359.94.

Base System
Fixed beacown vulnerability
Fixed kernel Wi-Fi stack security issues CVE-2022-41674, CVE-2022-42719,  CVE-2022-42720, 
CVE-2022-42721, and CVE-2022-42722.
Fixed bind9 security issues CVE-2022-38178, CVE-2022-38177, and CVE-2022-2795.
Fixed gmp security issue CVE-2021-43618.
Fixed ghostscript security issue CVE-2020-27792.
Fixed libksba security issue CVE-2022-3515.
Fixed sqlite3 security issues CVE-2020-35525 and CVE-2022-35737.
Fixed isc-dhcp security issues CVE-2022-2929 and CVE-2022-2928.
Fixed webkit2gtk security issues:
More...

CVE-2022-42824, CVE-2022-42823, CVE-2022-42799, CVE-2022-32923,
CVE-2022-32888, CVE-2022-32912, CVE-2022-32891, and CVE-2022-32886  

Fixed zulu8-cd security issues CVE-2022-21628, CVE-2022-21626, CVE-2022-21624, and 
CVE-2022-21619.
Fixed expat security issue CVE-2022-43680.
Fixed pillow security issue CVE-2022-22817.  
Fixed perl security issue CVE-2020-16156.
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Fixed mysql-5.7 security issues CVE-2022-21617, CVE-2022-21608, CVE-2022-21592, and 
CVE-2022-21589.
Fixed dbus security issues CVE-2022-42012, CVE-2022-42011, and CVE-2022-42010.
Fixed ntfs-3g security issue CVE-2022-40284.
Fixed libxml2 security issues CVE-2022-40304 and CVE-2022-40303.
Fixed pixman security issue CVE-2022-44638.
Fixed tiff security issues:
More...

CVE-2022-3599, CVE-2022-3598, CVE-2022-3570, CVE-2022-34526,
CVE-2022-2869, CVE-2022-2868, and CVE-2022-2867  

Fixed xorg-server security issues CVE-2022-3550 and CVE-2022-3551.
Fixed krb5 security issue CVE-2022-42898.
Fixed libvncserver security issue CVE-2020-29260.
Fixed libarchive security issues CVE-2022-36227 and CVE-2022-26280.
Fixed heimdal security issues CVE-2022-44640, CVE-2022-42898, CVE-2022-3437, and 
CVE-2021-44758.  
Fixed libice security issue CVE-2017-2626.
Fixed jbigkit security issue CVE-2017-9937.
Updated ca-certificates to version 20211016ubuntu0.20.04.1.
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New Features 11.08.230

Citrix
Integrated Citrix Workspace App 2211.
Available Citrix Workspace apps in this release: 2211 (default), 2207, and 2010.
New features:

Support for Authentication using FIDO2 (Technical Preview)
Parameter FIDO2 Authentication

Registry ica.module.virtualdriver.fido2.enab

le

Value enabled / disabled

AVD
Added max-threads option for WebRTC H.264 decoder module fluh264dec.
Registry sessions.wvd%.options.webrtcdecodermaxth

reads

Value 1 (default) / 0-16 

Updated AVD client
Based on Microsoft's new RdClientSDKv2 that includes stability and performance fixes
MS Teams stability fixes
MS Teams background blur and virtual background support
Preliminary UDP short path support (disabled by default, enable on your own risk)
Registry sessions.avd%.options.udp-short-path

Value enabled / disabled

VMware Horizon
Added support of deviceTRUST virtual channel:
Parameter deviceTRUST virtual channel

Registry vmware.view.vcdevicetrust.enable

Type bool
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Value enabled / disabled 

Parallels Client
Updated Parallels client to version 19.1

Wi-Fi

Added registry key for controlling kernel parameters arp_evict_nocarrier

and  ndisc_evict_nocarrier  for WLAN with WPA Supplicant. 
The default "1" leaves the traditional behavior unchanged, i.e. the respective tables are evicted 
particularly during roaming. 
"0" results in quicker resumption of sending packets after roaming, but it also leads to some 
packet loss.
Parameter ARP/NDP evict on nocarrier

Registry network.interfaces.wirelesslan.device0.a

rp_ndisc_evict_nocarrier

Range [0] [1]

Value 1 

Imprivata
Added support for smartcard reader RFIDEAS CCID (USB vid=0x0C27, pid=0xCCDB).
Added registry key for enabling "auto-open-grid-menu":
Parameter Published application chooser to cover persistent 

application

Registry imprivata.auto-open-grid-menu

Type bool

Smartcard
Updated SecMaker Net iD Enterprise to version 6.8.5.20 with support for Thales ID Prime 940.
Beginning with this version, the admin console has to be started with command iid -admin .
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Cisco Webex
Integrated Cisco WebEx VDI plugin version 42.10.0.23814

Base System
Updated IGEL EULA to version August 2022.

Audio
Added new registry key which possibly fixes microphone issues on newer Intel devices.
Parameter Use PDM1 topology files (can help with microphone 

issues).

Registry system.sound_driver.use_pdm1_tplg

Type bool

Value enabled / disabled 

zoomvdi
Integrated Zoom VDI plugin 5.12.1.21950  
  Available plugins in this release: 5.12.1.21950 (default), 5.11.2.21530, and 5.8.4.21112

Misc
Updated DriveLock Agent to version 2022.1 (22.1.2.38801).  
 "Fixed issues:  
  On IgelOS, the DriveLock Linux Agent can not reset/disconnect USB drives during policy updates. 
The Linux Agent now handles Unicode characters correctly."  
  New parameter:
Parameter Join Token

Registry devices.drivelock.jointoken

Value empty 

Hardware
Added hardware support for HP mt645 G7 (without LTE support).
Added hardware support for Lenovo L14 Gen 3 (without LTE support).
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Resolved Issues 11.08.230

AVD
Fixed umlaut keys for Swiss keyboard layout
Fixed crash of AVD client if Fabulatech plugins were enabled.
Fixed smartcard redirection
Fixed possibly frozen incoming video in MS Teams.
Added paths where AVD searches for static, dynamic-1.1 and dynamic-2.0 virtual channel 
plugins and automatically loads all of them:  
  /usr/lib/igelrdp3/plugins/automatic/static-channels  

 /usr/lib/igelrdp3/plugins/automatic/dynamic-1.1-channels  

 /usr/lib/igelrdp3/plugins/automatic/dynamic-2.0-channels  
 
This is used by all AVD sessions automatically on session startup.

Disabled legacy workspace download by default. It still can be enabled under 
options.workspace-1.enabled  per AVD session. This slightly speeds up workspace 

download time.
Fixed MS Teams background FX-related client crashes.
Fixed immediate AVD session crash on M350C and similar hardware - caused by some compiler 
optimization applied at build time. This optimization has been removed for the sake of 
compatibility.

Firefox
Fixed passthrough authentication for Firefox manual proxy.

Network
Fixed shutdown getting stuck if local logon was configured and the network (LAN)  was not 
connected.
Fixed mounting of NFS version 3 shares at boot time

Smartcard
Fixed smartcard access in the Firefox browser with activated AppArmor.

Base System
Fixed power line frequency configuration upon plug/unplug of a camera device.
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Fixed battery notification on other language than English.
Fixed on-screen keyboard being broken after Kerberos logon.
Fixed persistence of brightness, changed by function keys, over reboot.
Fixed handling of BIOS update files.
Fixed LVFS BIOS update did not work with enabled secure boot.
Enhance possibilities to set cstate kernel parameters:

Allow 0 for  max_cstate  now too which sets intel_idle.max_cstate kernel 
cmdline parameter
Parameter Set maximum allowed cstate on intel cpus.

Registry system.kernel.bootparams.max_cstate

Range [No limit] [0] [1] [2] [3] [4] [5] [6]    

Value No limit

Added new registry key to set processor.max_cstate kernel cmdline parameter.

Parameter Set maximum allowed processor cstate.

Registry system.kernel.bootparams.max_proc_c

state

Range [No limit] [1] [2] [3] [4] [5] [6] [7] [8] [9]   

Value No limit

X11 System
Fixed DisplaySwitcher UI bug that displayed the wrong frequency.
Fixed monitor went to sleep after resolution change on HP docking stations.
Added quirks to overcome Hotplug or DP MST issues.
Added new registry keys:
Parameter Quirk to improve DP MST hotplug behaviour.

Registry x.xserver%.quirks.dp_mst_hotplug

Type bool

Value enabled / disabled 

Parameter Quirk to fix issues with screen stays black after DPMS off or 
DP MST hotplug.

Registry x.xserver%.quirks.screen_stay_black

Type bool
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Parameter Quirk to fix issues with screen stays black by switch screen 
off and on again.

Registry x.xserver%.quirks.screen_stay_black_on_o

ff

Type bool

Value enabled / disabled 

Audio
Fixed audio support on HP T240 hardware.

Hardware
Fixed bluetooth support on Lenovo L14 Gen 3 hardware.
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Notes for Release 11.08.200
Software: Version 11.08.200

Release Date: 2022-10-18

Release Notes: Version RN-1108200-1

Last update: 2022-10-17

Supported Devices 11.08.200 (see page 166)
Component Versions 11.08.200 (see page 167)
Known Issues 11.08.200 (see page 176)
Security Fixes 11.08.200 (see page 181)
New Features 11.08.200 (see page 184)
Resolved Issues 11.08.200 (see page 194)

The Release Notes for IGEL OS 11.08.200 are also available in the following formats:

Plain text: readme_11.08.200.txt
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Supported Devices 11.08.200
UD2-LX: UD2-LX 52

UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.08.200

Clients
Product Version

Amazon WorkSpaces Client 3.1.9

Chromium 105.0.5195.125-igel1663653255

Cisco JVDI Client 14.1.2

Cisco Webex VDI plugin 42.8.0.23214

Cisco Webex Meetings VDI plugin 41.12.6.12

Cisco Webex Meetings VDI plugin 42.2.10.7

Cisco Webex Meetings VDI plugin 42.6.8.5

Zoom Media Plugin 5.10.6.21295

Zoom Media Plugin 5.11.2.21530

Zoom Media Plugin 5.8.4.21112

Citrix HDX Realtime Media Engine 2.9.400

Citrix Workspace App 20.10.0.6

Citrix Workspace App 22.05.0.16

Citrix Workspace App 22.07.0.20

deviceTRUST Citrix Channel 21.1.310.0

Crossmatch DP Citrix Channel 0125

Conky System Monitor 1.10.8-1

ControlUp Agent 8.1.5.500

deskMate Client 2.1.3

DriveLock Agent 20.1.4.30482

Ericom PowerTerm 14.0.3.71814

Evidian AuthMgr 1.5.8134

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech Plugins 3.8.0
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FabulaTech USB for Remote Desktop 6.0.35

FabulaTech Scanner for Remote Desktop 3.0.1.0

FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 91.13.0

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1663073494

IGEL AVD Client 1.1.0igel1663740227

deviceTRUST RDP Channel 21.1.310.0

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

Lakeside SysTrack Channel 9.0

Login VSI Enterprise 4.8.6

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628

Open VPN 2.6.0~git20220818-1igel1661859138

Zulu JRE 8.0.345-1

Parallels Client  18.3.1

Spice GTK (Red Hat Virtualization) 0.41-2igel1661863274

Remote Viewer (Red Hat Virtualization) 11.0-2igel1661863477

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980

SpeechWrite 1.0

Stratusphere UX Connector ID Key 
software

6.6.0-3

Systancia AppliDis 6.1.4-17

HP Anyware PCoIP Software Client 22.07.0-18.04

ThinLinc Client 4.14.0-2324

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 4.16.0-1igel1611217037
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VNC Viewer 1.12.0+dfsg-4igel1648284944

VMware Horizon Client 2206-8.6.0-20094634

Voip Client Ekiga 4.0.1-9build1igel6

Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.2

Philips Speech driver 13.1.10

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.1013

PKCS#11 Library OpenSC 0.22.0-2igel1643799581

PKCS#11 Library SecMaker NetID Enterprise 6.8.3.21

PKCS#11 Library SecMaker NetID Client 1.0.2.67

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35
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Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.5.0-2igel1646035471

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.8-1igel1655196158

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.10

OpenSSL 1.1.1-1ubuntu2.1~18.04.20

OpenSSH Client 9.0p1-1+b1igel1661867805

OpenSSH Server 9.0p1-1+b1igel1661867805

Bluetooth stack (bluez) 5.65-1igel1663161703

MESA OpenGL stack 22.1.7-0igel1661885230

VAAPI ABI Version 0.40

VDPAU Library version 1.5-1igel1646992192

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046

Graphics Driver ATI/RADEON 19.1.0-3igel1657777718

Graphics Driver ATI/AMDGPU 22.0.0-3igel1661860347

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678

Graphics Driver Nvidia 470.141.03-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-3igel1628859075

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534

Graphics Driver FBDEV 0.5.0-2igel1644486279

Graphics Driver VESA 2.5.0-1igel1628504011

Input Driver Evdev 2.10.6-2igel1629196047

Input Driver Elographics 1.4.2-1igel1629196349

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146
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Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.17.15 #mainline-lxos_dev-g1663242518

Xorg X11 Server 21.1.4igel1657689370

Xorg Xephyr 21.1.4igel1657689370

CUPS printing daemon 2.2.7-1ubuntu2.9igel1654064309

PrinterLogic 25.1.0.500

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.3.5-3ubuntu7.3

NetworkManager 1.32.12-0ubuntu1igel1656495558

ModemManager 1.18.10-2igel1662722763

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.20.3-2igel1655908747

GStreamer 1.0 Fluendo aacdec 1.0.1

GStreamer 1.0 Fluendo asfdemux 1.0.1

GStreamer 1.0 Fluendo h264dec 1.0.3

GStreamer 1.0 Fluendo mp3dec 1.0.1
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GStreamer 1.0 Fluendo mpeg4videodec 1.0.1

GStreamer 1.0 Fluendo vadec 1.0.2

GStreamer 1.0 Fluendo wmadec 1.0.1

GStreamer 1.0 Fluendo wmvdec 1.0.1

WebKit2Gtk 2.36.7-1igel1661518099

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.38-dfsg-3igel1662536482

Virtualbox X11 Guest Utils 6.1.38-dfsg-3igel1662536482

Open VM Tools 11.0.5-4ubuntu0.18.04.2

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.2

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.22.1-3igel1661859915

Qemu Guest Agent 7.1+dfsg-2igel1663754599

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.20-1igel1660111560

Mobile Device Access USB (imobile) 1.3.0-6igel12

Mobile Device Access USB (gphoto) 2.5.29-1igel1653377622

VPN OpenConnect 9.01-1igel1657119743

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.38-dfsg-3igel1662536482

Virtual Background for Webcam

Services
Service Size Reduced Firmware

Asian Language Support 24.8 M Included
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Java SE Runtime Environment 43.2 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

370.2 M Included

Ericom PowerTerm InterConnect 11.5 M Included

Media Player 768.0 K Included

Local Browser (Firefox)
Citrix Appliance

94.5 M Included

VMware Horizon
RDP

7.0 M Included

Cendio ThinLinc 12.8 M Included

Printing (Internet printing protocol CUPS) 22.5 M Included

NoMachine NX 30.8 M Included

VMware Horizon 295.8 M Included

Voice over IP (Ekiga) 7.2 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 30.8 M Not included

Fluendo GStreamer Codec Plugins 7.2 M Included

IBM i Access Client Solutions 128.5 M Not included

Red Hat Enterprise Virtualization 3.0 M Included

Parallels Client 6.8 M Included

NVIDIA graphics driver 280.2 M Not included

Imprivata Appliance 16.0 M Included

AppliDis 512.0 K Included

Evidian AuthMgr 3.0 M Included

Hardware Video Acceleration 16.5 M Included

Extra Font Package 1.2 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 4.2 M Included

Cisco JVDI client 76.0 M Included
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PrinterLogic 53.2 M Not included

Biosec BS Login 10.2 M Not included

Login VSI Login Enterprise 32.8 M Not included

Stratusphere UX CID Key software 8.5 M Not included

Elastic Filebeat 25.0 M Not included

AVD 130.5 M Included

Local Browser (Chromium) 112.0 M Not included

Amazon WorkSpaces Client 37.2 M Included

deskMate client 6.5 M Included

Cisco Webex VDI 75.0 M Not included

Cisco Webex Meetings VDI 130.5 M Not included

Zoom Media Plugin 138.8 M Not included

DriveLock 14.8 M Included

SpeechWrite Client 256.0 K Included

IGEL Imprivata Agent 256.0 K Included

Fluendo Browser Codec Plugins 4.5 M Included

HP Factory deployment documentation 90.0 M Included

BIOS Tools 256.0 K Included

HP Anyware Client 18.5 M Included

90meter Smart Card Support 256.0 K Included

Virtual Background for Webcam (Limited 
IGEL Support)

Limited Support Features

Mobile Device Access USB (Limited support)

Virtualbox (Limited support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

256.0 K Not included

Mobile Device Access USB (Limited support) 512.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included
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Scanner support / SANE (Limited support) 2.8 M Not included

VirtualBox (Limited support) 74.0 M Not included

Virtual Background for Webcam (Limited 
IGEL Support)

38.0 M Included
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Known Issues 11.08.200

Citrix
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These occur with 
multimedia redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if browser content 
redirection is enabled active.)
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to a 
freeze. Selective H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.
With start of Self-Service, it is possible that the process ServiceRecord is segfaulted - Self-
Service cannot be started afterwards. A cache cleanup with reboot should help, also the 
following parameters should be set to "true".
More...

Parameter Clean up UI cache after Self-Service termination

Registry ica.selfservice.cleanupwebui

Value false / true

Parameter Clean up Store cache after Self-Service termination

Registry ica.selfservice.cleanupstore
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Value false / true

OSC Installer
OSC not deployable with IGEL Deployment Appliance: Version 11.3 or later is required for 
deploying IGEL OS 11.06. and following.

AVD
AVD MS-Teams optimization can crash the AVD client if H264 software decoder is used
(fluh264dec). AVD prefers the hardware decoders (fluvadec) but when there are no hardware 
decoders or when all hardware decoders are in use already, the software decoder is utilized, which 
may randomly crash the AVD client. It is likely when it crashes in a certain MS-Teams call, it might 
crash quite soon again when rejoining the same call. A fix for that is under development.
A workaround is to disable incoming video in such MS-Teams calls, which is an option in the "..." 
menu from the control bar during an active call.
H264 hardware decoding for MS-Teams optimization is currently limited to non-AMD devices
due to stability issues on AMD devices.

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon. 
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session. 
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir 

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only with usage of local layout and 
deadkeys enabled.
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL OS), 
Horizon client falls back to en-US layout.
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PCoIP sessions may crash in some cases, switching to Blast Protocol is recommended then. 
H.264/HEVC encoding can be disabled when overall performance is too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadical problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for these devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB redirection which results in an unclean unmount. 
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.

Firefox
With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.

Network
Wakeup from system suspend fails on DELL Latitude 5510.
If applications are configured to start after established network connection and network mounts 
are configured, spurious "Failed to start application" notifications may be shown. The 
applications still start.

Wi-Fi
TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client
There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system
Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).
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Conky
The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920).

Firmware Update
On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character). 
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'

Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3 M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia
Multimedia redirection with GStreamer could fail when using Nouveau GPU driver.

Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.
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AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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Security Fixes 11.08.200

Chromium
Fixed Chromium browser security issues:
More...

CVE-2022-3075, CVE-2022-3058,
CVE-2022-3057, CVE-2022-3056, CVE-2022-3055, CVE-2022-3054, CVE-2022-3053,
CVE-2022-3052, CVE-2022-3051, CVE-2022-3050, CVE-2022-3049, CVE-2022-3048,
CVE-2022-3047, CVE-2022-3046, CVE-2022-3045, CVE-2022-3044, CVE-2022-3043,
CVE-2022-3042, CVE-2022-3041, CVE-2022-3040, CVE-2022-3039, CVE-2022-3038,
CVE-2022-2861, CVE-2022-2860, CVE-2022-2859, CVE-2022-2858, CVE-2022-2857,
CVE-2022-2856, CVE-2022-2855, CVE-2022-2854, CVE-2022-2853, and CVE-2022-2852

Fixed Chromium browser security issues:
More...

CVE-2022-3195, CVE-2022-3196, CVE-2022-3197, CVE-2022-3198,
CVE-2022-3199, CVE-2022-3200, and CVE-2022-3201

Updated Chromium browser to version 105.0.5195.125.

Firefox
Updated Mozilla Firefox to version 91.13.0 ESR
Fixes for mfsa2022-35, also known as CVE-2022-38472, CVE-2022-38473, CVE-2022-38478.
Fixes for mfsa2022-29, also known as CVE-2022-36319, CVE-2022-36318.
Fixes for mfsa2022-25, also known as: 
CVE-2022-34479, CVE-2022-34470, CVE-2022-34468, CVE-2022-34481, 
CVE-2022-31744, CVE-2022-34472, CVE-2022-2200, CVE-2022-34484
Fixes for mfsa2022-21, also known as: 
CVE-2022-31736, CVE-2022-31737, CVE-2022-31738, CVE-2022-31740, 
CVE-2022-31741, CVE-2022-31742, CVE-2022-31747.

Base System
Fixed libinput security issue CVE-2020-1215.
Fixed libarchive security issue CVE-2022-26280.
Fixed ntfs-3g security issues: 
More...

CVE-2022-30789, CVE-2022-30788, CVE-2022-30787, CVE-2022-30786,
CVE-2022-30785, CVE-2022-30784, CVE-2022-30783, and CVE-2021-46790

Fixed openssl1.0 security issues CVE-2022-2068 and CVE-2022-1292.
Fixed openssl security issues CVE-2022-2097, CVE-2022-2068, and CVE-2022-1292.
Fixed gnupg2 security issues CVE-2022-34903 and CVE-2019-13050.
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Fixed webkit2gtk security issues:
More...

CVE-2022-26710, CVE-2022-22677, CVE-2022-22662, CVE-2022-30294,
CVE-2022-30293, CVE-2022-26719, CVE-2022-26717, CVE-2022-26716,
CVE-2022-26709, and CVE-2022-26700

Fixed nss security issues CVE-2022-34480 and CVE-2022-22747.
Fixed Nvidia graphics driver 470 security issues CVE-2022-31607 and CVE-2022-31608.
Updated Nvidia graphics driver to version 470.141.03.
Fixed curl security issues CVE-2022-32208, CVE-2022-32207, CVE-2022-32206, and CVE-2022-32205.
Fixed curl security issue CVE-2022-35252.
Fixed unzip security issues CVE-2022-0530 and CVE-2022-0529.
Fixed freetype security issues CVE-2022-31782, CVE-2022-27406, CVE-2022-27405, and 
CVE-2022-27404.
Fixed gnutls28 security issues CVE-2022-2509 and CVE-2021-4209.
Fixed mysql-5.7 security issue CVE-2022-21515.
Fixed python2.7 security issue CVE-2015-20107.
Fixed python3.6 security issue CVE-2015-20107.
Fixed net-snmp security issues:
More...

CVE-2022-24810, CVE-2022-24809, CVE-2022-24808,
CVE-2022-24807, CVE-2022-24806, CVE-2022-24805, and CVE-2022-248

Fixed zulu8-ca security issues CVE-2022-34169, CVE-2022-25647, CVE-2022-21541, and 
CVE-2022-21540.
Updated zulu8-ca JRE to version 8.0.345.
Fixed libtirpc security issue CVE-2021-46828.
Updated Intel microcode to version 20220809 which fixed security issue CVE-2022-21233.
Fixed postgresql-10 security issue CVE-2022-1552.
Fixed webkit2gtk security issues CVE-2022-32816, CVE-2022-32792, and CVE-2022-2294.
Updated webkit2gtk to version 2.36.6.
Fixed open-vm-tools security issue CVE-2022-31676.
Fixed postgresql-10 security issue CVE-2022-2625.
Fixed libxslt security issues CVE-2021-30560 and CVE-2019-5815.
Fixed zlib security issue CVE-2022-37434.
Fixed rsync security issue CVE-2022-37434.
Fixed webkit2gtk security issue CVE-2022-32893.
Fixed gnutls28 security issues CVE-2022-2509 and CVE-2021-4209.
Fixed flac security issues CVE-2017-6888, CVE-2020-0499, and CVE-2021-0561.
Fixed libsndfile security issue CVE-2021-4156.
Fixed gst-plugins-good1.0 security issues 
More...

CVE-2022-1920, CVE-2022-1921, CVE-2022-1922, CVE-2022-1923,
CVE-2022-1924, CVE-2022-1925, and CVE-2022-2122

Updated GStreamer 1.x to version 1.20.3.
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Fixed vim security issues CVE-2022-1621, CVE-2022-1620, CVE-2022-1619, CVE-2022-1616, 
CVE-2022-1154, and CVE-2022-0943.
Fixed tiff security issues:
More...

CVE-2022-22844, CVE-2022-2058, CVE-2022-2057,CVE-2022-2056,
CVE-2022-1355, CVE-2022-0924, CVE-2022-0909, CVE-2022-0908,
CVE-2022-0907, CVE-2020-19144, and CVE-2020-19131.

Fixed qemu security issues CVE-2022-35414, CVE-2022-2962, CVE-2022-1050, CVE-2022-0216, and 
CVE-2020-14394.
Fixed expat security issue CVE-2022-40674.

X Server
Fixed Xorg security issues CVE-2022-2319 and CVE-2022-2320.
Updated Xorg server to version 21.1.4.
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New Features 11.08.200

Citrix
Support for dynamic emergency calling within MS Teams
Parameter Citrix Support for dynamic e911

Registry ica.emergencycalling

Value false /true

Integrated Citrix Workspace App 2207.
Available Citrix Workspace Apps in this release: 2207 (default), 2205 and 2010.

Composite USB redirection
Parameter Native USB Redirection class rule

Registry ica.usbredirection.devicepolicy.clas

s_rule%.rule

Value Deny, Allow, Connect

Parameter Native USB Redirection product rule

Registry ica.usbredirection.devicepolicy.prod

uct_rule%.rule

Value Deny, Allow, Connect

Citrix Workspace app allows the splitting of composite USB devices. A composite USB 
device can perform more than one function. These functions are accomplished by exposing 
each of those functions using different interfaces.
An example of a composite USB device is the Bloomberg keyboard which consists of a 
keyboard, fingerprint reader, an audio device, and USB hub, etc.
The Composite USB redirection feature adds the CONNECT value to the rules for USB 
devices.
CONNECT – Set the “CONNECT” keyword to enable auto-redirect of a device when 
a session starts.
ALLOW – Set the “ALLOW” keyword to allow auto-redirect of a device only after a session 
starts. However, if the “CONNECT” or “ALLOW” keyword is set, the device is auto-redirected 
when it is unplugged and plugged in during a session.
When redirect the composite USB device, normally the whole device is forwarded to the 
virtual host. However, now there is the possibility to split and forward only the child 
interfaces that use a generic USB channel. To do this, it is necessary to add the following 
filter parameters ( split  and intf ) to the device rules. The split  parameter 
specifies whether a composite device must be forwarded as separate devices or as a single 
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composite device. "Split=1" means that the selected child interfaces of a composite device 
must be forwarded as split devices, while split=0 must not be forwarded (If the split 
parameter is omitted, Split=0 is assumed). The intf  parameter selects the specific 
child interfaces of the composite unit to which the action is to be applied.
In IGEL Setup, the device rules can be added under Sessions > Citrix > Citrix Global > 
Native USB Redirection > Device Rules. Adding the first two filter parameters Vendor id/
vid and Product id/ pid, which redirects the entire
composite device in the session. If splitting of the composite device is required, adding 
additional parameters in the "Extra config" as shown in the example is required.
Example: 
CONNECT: vid=047F pid=C039 split=1 intf=03  # Allow HID device and 

connect automatically. 
DENY: vid=047F pid=C039 split=1 intf=00  # Deny audio endpoints 

ALLOW: vid=047F pid=C039 split=1 intf=05  # Allow mgmt intf but do not 
connect automatically
Note: Native USB Redirection for Citrix Sessions in IGEL OS - the third option "connect" has 
been added to the class and device rules. Composite USB redirection can change the 
behavior. If a device is no longer redirected with CWA 2207, the rule should be changed 
to 'Connect'.

Enhancement to improve audio quality
Playback Delay Thresh
Parameter Playback Delay Thresh

Registry ica.module.PlaybackDelayThreshV4

Value 50 (default)

With this enhancement, the maximum output buffering value is decreased from 200 ms 
to 50 ms in Citrix Workspace app. As a result, the user experience of the interactive audio 
application is improved. Also, the Round trip time (RTT) is decreased by 150 ms. This 
parameter is valid only when "AudioRedirectionV4" is set to "True".
Audio Temp Latency Boost
Parameter Audio Temp Latency Boost

Registry ica.module.AudioTempLatencyBoostV4

Value 100 (default)

When the audio throughput undergoes a sudden spike or is not enough for an unstable 
network, this value increases the output buffering value. This increase in the output 
buffering value provides smooth audio. However, the
audio might be slightly delayed. This parameter is only valid when "AudioRedirectionV4" 
and "AudioLatencyControlEnabled" are set to "True".

Improved audio echo cancellation support
Parameter Improved audio echo cancellation support
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Registry ica.module.enableechocancellation

Value false / true

Support for DPI matching
Parameter Support for DPI matching

Registry ica.wfclient.dpimatchingenabled

Value false / true

The display resolution and DPI scale values set in the Citrix Workspace app match the 
corresponding values in the virtual apps and desktops session. DPI scaling is mostly used with 
large size and high-resolution monitors to display
applications, text, images, and other graphical elements in a size that can be viewed comfortably.
App Protection
Parameter Citrix App Protection

Registry ica.appprotection

Value false / true

App protection is an add-on feature for the Citrix Workspace app that provides enhanced security 
when using Citrix Virtual Apps and Desktops published resources. Two policies provide anti-
keylogging and anti-screen-capturing
capabilities for a Citrix HDX session. This feature is fully supported only for workspace app 
2207, with older workspace apps, you may experience x11vnc crashes.
Updated deviceTRUST Client Extension to version 21.1.310.0.

OSC Installer
Added option in factory mode for an automatical shutdown after self-check. Log file of this 
deployment self-check is written to dummy partition.

AVD
Added SIGTERM and SIGHUP signal handlers to disconnect sessions once received these 
signals. Since remote log-off is not supported in RDP, both signal handlers perform a session 
disconnect.
Fixed audio crackling
Added potential fix for the ClaimsTokenAuthChallenge issue that dialog pops up too often.
Added SIGTERM and SIGHUP. As soon as the RdCoreSDK supports session log-off as well, SIGHUP 
handler will be used instead of the disconnect.
Added potential fixes for crashes with enabled printer redirection
Fixed MS-Teams VDI the local video window went black occasionally.
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Applied patch to fix bug in boost 1.69.0 that caused the "User cancelled" issue.
https://github.com/boostorg/container/commit/90de9533ecef08e98d82e8f8c26fad57839e4184 at 
boost 1.74.0
Added two parameters regarding MS-Teams (WebRTC) redirection video decoding:
Registry sessions.wvd0.options.webrtchardwaredeco

ding

Value on / auto / off

Registry sessions.wvd0.options.webrtcdecodermaxth

reads

Value 1 (default) / 0 (auto) / 0-16

RDP/IGEL RDP Client 2
Updated deviceTRUST Client Extension to version 21.1.310.0.

RD Web Access
Added new parameter to enable support for Interactive Logon Messages.
Registry rdp.rd_web_access.options.remote_app_inte

ractive_logon_message

Type bool

Value enabled / disabled

VMware Horizon
Updated VMware Horizon client to version 2206-8.6.0-20094634

PowerTerm
Updated Ericom PowerTerm LTC to version 14.0.3.71814. This fixes scaling the emulation 
window to large sizes.

IBM_5250
Added startup splash screen to IBM iAccess client. Thus, the user gets visual feedback of sessions 
about to start.

https://github.com/boostorg/container/commit/90de9533ecef08e98d82e8f8c26fad57839e4184
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Parameter Show splash screen at session startup

Registry ibm.iaccess.showsplash

Value true / false

HP Anyware
Renamed Teradici PCoIP Ultra to HP Anyware PCoIP
Updated HP Anyware PCoIP client to version 22.07.0-18.04

Network
Updated Modemmanager and libraries to improve LTE device support.

Wi-Fi
Added initial support for Realtek 8852ce Wi-Fi chipset.

AppliDis
Updated Applidis SLB Linux client to version 6.1.4.17.

Smartcard
Updated Thales SafeNet Authentication client to version 10.8.1013.

CUPS Printing
Parameter Make connected printer default printer

Registry print.cups.dynamic_default

Type bool

Value enabled / disabled

Added the dynamic default printer feature: If several printers are defined, the last plugged printer 
will be set as the default printer. 
On boot, the printer will be selected which is connected at the time. 
If more than one printer is connected at boot, the one which is the last in the list of printers 
defined in the OS gets the default.
If a printer which was default is removed, the remaining printer will be elected as default. 
If more than one remains, the last in the list of printers defined in the OS, gets the default.
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Fixed printer activation on USB hotplug which could fail in rare occasions.
Fixed cases where choosing the first USB printer fails as not named usblp0  by the kernel as 
expected, as higher numbers were used (e.g. usblp2) even if no other USB printers were 
connected. The first USB printer is now defined as the one which is the first in the (sorted) list of all 
connected USB printers. 
Accordingly, the second USB printer is the second in the list of USB printers. 
For the case more than one USB printer is used at the same time, the first or second printer should 
not be used as a selection method, as the numbering is also depending on the timing the printer is 
registered on the endpoint. On the next boot, the numbering can be different especially if the 
devices are switched on individually. 
In this case, it's recommended to use instead the usbclass  backend or selection by the USB 
Port on the endpoint or by the printer's USB IDs.
Updated HP Linux Imaging and Printing (HPLIP) to version 3.22.6
Updated printer list to include all new printers from HPLIP 3.22.6 (which do not require a 
proprietary plugin).

Cisco Webex
Integrated Cisco WebEx Meetings VDI plugins 42.6.8.5 and 42.2.10.7 
Available plugins in this release: 42.6.8.5 (default), 42.2.10.7 and 41.12.6.12
Integrated Cisco WebEx VDI plugin 42.8.0.23214

Cisco JVDI Client
Integrated Cisco JVDI 14.1.2

Base System
Updated kernel to version 5.17.15.
Updated VDPAU library to version 1.5.
Updated gphoto library to version 2.5.29.
Updated OpenConnect VPN client to version 9.01.
Updated bluetooth stack (bluez) to version 5.64.
Updated OpenVPN client to version 2.6.0 (with OpenVPN DCO support).
Updated MESA OpenGL stack to version 22.1.5.
Updated wireless regdb to version 2022.06.06.
Added support for webcam virtual background (must be activated in System > Fimware 
Customization > Features > Virtual Background for Webcam)
Minimum hardware requirements:
- 4 GB RAM
- Quad Core CPU with 1.5 GHz or higher

Also added new registry keys (to use the 
feature,  multimedia.webcam.virtual_background.enabled  must be set to 
true)
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Parameter Enable virtual background for webcam.

Registry multimedia.webcam.virtual_background

.enabled

Type bool

Value enabled / disabled 

Parameter Replace default webcam with virtual one.

Registry multimedia.webcam.virtual_background

.replace_video0

Type bool

Value enabled / disabled

Parameter Select how the webcam to use should be choosen.

Registry multimedia.webcam.virtual_background

.choose_webcam_by

Range [Use first webcam] [Choose by name] [Choose by 
vendor_id:product_id] [Choose by number]

Parameter Select webcam by number (only valid if choose by 
number is used)

Registry multimedia.webcam.virtual_background.

webcam_number

Type integer

Value 1 

Parameter Select webcam by name (only valid if choose by name 
is used)

Registry multimedia.webcam.virtual_background.

webcam_name

Type string

Value empty 
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Parameter Select webcam by vendor_id:product_id (only valid if 
choose by vendor_id:product_id is used)

Registry multimedia.webcam.virtual_background.w

ebcam_vendor_product

Type string

Value empty 

Parameter Background picture file to use as virtual background

Registry multimedia.webcam.virtual_background

.background_file

Type string

Value empty 

Parameter Strength of background blurring

Registry multimedia.webcam.virtual_backgroun

d.blur

Type integer

Value 25 

Parameter Select type of virtual background.

Registry multimedia.webcam.virtual_backgroun

d.type

Range [Use blur] [Use background picture]

Parameter Select resolution to use.

Registry multimedia.webcam.virtual_background

.resolution

Range [webcam default] [webcam 
max] [1280x720] [640x480] [480x360]

Parameter Select model for background segmentation.
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Registry multimedia.webcam.virtual_background

.backscrub.model

Range [segm_full] [selfiesegmentation] [segm_lite] [deeplab
v3]

Value segm_full

Added possibility to use ntfs with compression as Chromium and Firefox 
profile partition filesystem.
Changed registry keys (added ntfs option):
Parameter Firefox Profiles Partition Filesystem Type

Registry system.customization.ffpro.fs_type

Range [reiser4] [ext4] [f2fs] [ntfs]

Parameter Chromium Profiles Partition Filesystem Type

Registry system.customization.chpro.fs_type

Range [reiser4] [ext4] [f2fs] [ntfs]

zoomvdi
Added Smart Virtual Background support for zoomvdi.
IGEL Setup Sessions > Unified Communication > Zoom Client 

Selection

Parameter Smart Virtual Background Support

Registry multimedia.zoomvdi.smartvb

Type string

Value [ Off ][ Auto ][ Always ]

Integrated Zoom VDI plugin 5.11.2.21530 
Available plugins in this release: 5.11.2.21530 (default), 5.10.6.21295 and 5.8.4.21112

Hardware
Updated DisplayLink driver to version 5.6.0.
Improved performance of AMD devices and DisplayLink solutions.
Added hardware support for Dell Optiplex 3000TC
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TC Setup (Java)
Updated TC Setup to version 6.10.4.

Fabulatech
Updated FabulaTech Scanner for Remote Desktop to version 3.0.1.0
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Resolved Issues 11.08.200

OSC Installer
Fixed wrong icon in OSC installer.
Fixed deploying IGEL OS GPT images to Fujitsu Lifebook U7311 via IGEL SCCM Add-On.

RDP/IGEL RDP Client 2
Fixed RDP Client displaying a wrong error message when the account is locked.

Amazon Workspace Client
Fixed deviceTRUST virtual channel configuration.

Chromium
Fixed hardware-accelerated video decoding on newer Intel chipsets using the iHD VA-API 
backend.

Firefox
Fixed Firefox tabs crashing if the system uses iHD VAAPI driver.

Network
Fixed MBB connection editor

Wi-Fi
Fixed: System regulatory domain now also set on the self-managed driver rtl8852be
Fixed: HP Probook 450 G8 with Intel AX201 Wi-Fi.
Fixed: Realtek 8852BE Wi-Fi chipsets (included in HP T655)
Fixed missing firmware files of iwlwifi driver for INTEL chipsets.

Imprivata
Improved disconnect/reconnect speed with Imprivata and Horizon. Fixes Imprivata/Horizon 
roaming issue.
Added: Minor improvements on Vendor Launch Scripts.
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AppliDis
Fixed wrong port for HTTPS.

Smartcard
Fixed startup of SecMaker Net iD service.

Base System
Fixed confusing touchpad functions if changed between right- and left-hand mouse.
Fixed touchpad enable / disable by hotkey.
Fixed battery notification.
Fixed: Not rotate SystemInformation.log at startup. Rotation is only done with a successful 
upload.
Fixed failed firmware update from servers with low bandwidth
Fixed NTP time configuration in Setup Assistant if time was set before issued starter license.
Fixed corrupted BIOS update where relevant files were missing in rare cases.
Added experimental DSC over DP MST support to Intel graphic driver.
Added new registry key:
Parameter Enable DSC over DP MST support (experimental).

Registry x.drivers.intel.dsc_over_dp_mst

Type bool

Value enabled / disabled 

Updated fwupd tool to fix possible issue with LVFS BIOS update.

X11 System
Updated xprintidle to version 0.2.4, which offers reasonable output also when DPMS state is not 
On.
Added support for HDMI4 to HDMI8 connectors as newer devices possibly have these 
connectors.
Changed registry keys to allow HDMI connectors up to HDMI8:

More...

Parameter Monitor

Registry x.xserver%.connector
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Range [Automatic][VGA][VGA(II)][DVI-D][DVI-D(II)][DisplayPort]
[DisplayPort(II)][DisplayPort(III)][DisplayPort(IV)] 
[DisplayPort(V)][DisplayPort(VI)][DisplayPort(VII)]
[DisplayPort(VIII)][HDMI][HDMI(II)][HDMI(III)][HDMI(IV)]
[HDMI(V)]
[HDMI(VI)][HDMI(VII)][HDMI(VIII)][Internal Panel(LVDS)] 
[Internal Panel(LVDS II)][Internal Panel(eDP)] 
[Internal Panel(eDP II)][DVI-D(III)][DVI-D(IV)][DVI-D(V)] 
[DVI-D(VI)][DVI-D(VII)][DVI-D(VIII)]

Value Automatic

Parameter Monitor

Registry x.xserver%.screen1.connector

Range [Automatic][VGA][VGA(II)][DVI-D][DVI-D(II)][DisplayPort]
[DisplayPort(II)][DisplayPort(III)][DisplayPort(IV)]
[DisplayPort(V)][DisplayPort(VI)][DisplayPort(VII)] 
[DisplayPort(VIII)][HDMI][HDMI(II)][HDMI(III)][HDMI(IV)]
[HDMI(V)]
[HDMI(VI)][HDMI(VII)][HDMI(VIII)][Internal Panel(LVDS)] 
[Internal Panel(LVDS II)][Internal Panel(eDP)]
[Internal Panel(eDP II)][DVI-D(III)][DVI-D(IV)][DVI-D(V)] 
[DVI-D(VI)][DVI-D(VII)][DVI-D(VIII)]

Value Automatic

Parameter Monitor

Registry x.xserver%.screen2.connector

Range [Automatic][VGA][VGA(II)][DVI-D][DVI-D(II)][DisplayPort]
[DisplayPort(II)][DisplayPort(III)][DisplayPort(IV)]
[DisplayPort(V)][DisplayPort(VI)][DisplayPort(VII)] 
[DisplayPort(VIII)][HDMI][HDMI(II)][HDMI(III)][HDMI(IV)]
[HDMI(V)]
[HDMI(VI)][HDMI(VII)][HDMI(VIII)][Internal Panel(LVDS)] 
[Internal Panel(LVDS II)][Internal Panel(eDP)]
[Internal Panel(eDP II)][DVI-D(III)][DVI-D(IV)][DVI-D(V)] 
[DVI-D(VI)][DVI-D(VII)][DVI-D(VIII)]

Value Automatic

Parameter Monitor
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Registry x.xserver%.screen3.connector

Range [Automatic][VGA][VGA(II)][DVI-D][DVI-D(II)][DisplayPort]
[DisplayPort(II)][DisplayPort(III)][DisplayPort(IV)]
[DisplayPort(V)][DisplayPort(VI)][DisplayPort(VII)] 
[DisplayPort(VIII)][HDMI][HDMI(II)][HDMI(III)][HDMI(IV)]
[HDMI(V)]
[HDMI(VI)][HDMI(VII)][HDMI(VIII)][Internal Panel(LVDS)] 
[Internal Panel(LVDS II)][Internal Panel(eDP)]
[Internal Panel(eDP II)][DVI-D(III)][DVI-D(IV)][DVI-D(V)] 
[DVI-D(VI)][DVI-D(VII)][DVI-D(VIII)]

Value Automatic

Parameter Monitor

Registry x.xserver%.screen4.connector

Range [Automatic][VGA][VGA(II)][DVI-D][DVI-D(II)][DisplayPort]
[DisplayPort(II)][DisplayPort(III)][DisplayPort(IV)]
[DisplayPort(V)][DisplayPort(VI)][DisplayPort(VII)] 
[DisplayPort(VIII)][HDMI][HDMI(II)][HDMI(III)][HDMI(IV)]
[HDMI(V)]
[HDMI(VI)][HDMI(VII)][HDMI(VIII)][Internal Panel(LVDS)] 
[Internal Panel(LVDS II)][Internal Panel(eDP)]
[Internal Panel(eDP II)][DVI-D(III)][DVI-D(IV)][DVI-D(V)] 
[DVI-D(VI)][DVI-D(VII)][DVI-D(VIII)]

Value Automatic

Parameter Monitor

Registry x.xserver%.screen5.connector

Range [Automatic][VGA][VGA(II)][DVI-D][DVI-D(II)][DisplayPort]
[DisplayPort(II)][DisplayPort(III)][DisplayPort(IV)]
[DisplayPort(V)][DisplayPort(VI)][DisplayPort(VII)] 
[DisplayPort(VIII)][HDMI][HDMI(II)][HDMI(III)][HDMI(IV)]
[HDMI(V)]
[HDMI(VI)][HDMI(VII)][HDMI(VIII)][Internal Panel(LVDS)] 
[Internal Panel(LVDS II)][Internal Panel(eDP)]
[Internal Panel(eDP II)][DVI-D(III)][DVI-D(IV)][DVI-D(V)] 
[DVI-D(VI)][DVI-D(VII)][DVI-D(VIII)]

Value Automatic
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Parameter Monitor

Registry x.xserver%.screen6.connector

Range [Automatic][VGA][VGA(II)][DVI-D][DVI-D(II)][DisplayPort]
[DisplayPort(II)][DisplayPort(III)][DisplayPort(IV)]
[DisplayPort(V)][DisplayPort(VI)][DisplayPort(VII)] 
[DisplayPort(VIII)][HDMI][HDMI(II)][HDMI(III)][HDMI(IV)]
[HDMI(V)]
[HDMI(VI)][HDMI(VII)][HDMI(VIII)][Internal Panel(LVDS)] 
[Internal Panel(LVDS II)][Internal Panel(eDP)]
[Internal Panel(eDP II)][DVI-D(III)][DVI-D(IV)][DVI-D(V)] 
[DVI-D(VI)][DVI-D(VII)][DVI-D(VIII)]

Value Automatic

Parameter Monitor

Registry x.xserver%.screen7.connector

Range [Automatic][VGA][VGA(II)][DVI-D][DVI-D(II)][DisplayPort]
[DisplayPort(II)][DisplayPort(III)][DisplayPort(IV)]
[DisplayPort(V)][DisplayPort(VI)][DisplayPort(VII)] 
[DisplayPort(VIII)][HDMI][HDMI(II)][HDMI(III)][HDMI(IV)]
[HDMI(V)]
[HDMI(VI)][HDMI(VII)][HDMI(VIII)][Internal Panel(LVDS)] 
[Internal Panel(LVDS II)][Internal Panel(eDP)]
[Internal Panel(eDP II)][DVI-D(III)][DVI-D(IV)][DVI-D(V)] 
[DVI-D(VI)][DVI-D(VII)][DVI-D(VIII)]

Value Automatic

Updated ATI / Radeon graphic driver to version 19.1.0 which fixed issues with radeon Xorg driver 
and rotation.
Updated amdgpu graphic driver to version 22.0.0 which improves performance with DisplayLink 
USB solutions.

 Audio
Fixed audio output via display port/HDMI for HP Elitedesk 800 G6
Fixed issues with 3.5mm audio jack on LG AiO 24CN67 and 24CN65 devices.

Hardware
Improved bluetooth stability.
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Notes for Release 11.08.110
Software: Version 11.08.110

Release Date: 2022-09-15

Release Notes: Version RN-1108110-1

Last update: 2022-09-15

Supported Devices 11.08.110 (see page 200)
Component Versions 11.08.110 (see page 201)
Known Issues 11.08.110 (see page 209)
Security Fixes 11.08.110 (see page 214)
New Features 11.08.110 (see page 216)
Resolved Issues 11.08.110 (see page 221)

The Release Notes for IGEL OS 11.08.110 are also available in the following formats:

Plain text: readme_11.08.110.txt
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Supported Devices 11.08.110
UD2-LX: UD2-LX 52

UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.08.110

Clients
Product Version

Amazon WorkSpaces Client 3.1.9

Chromium 104.0.5112.79-igel1659897252

Cisco JVDI Client 14.1.1

Cisco Webex VDI plugin 42.6.0.22645

Cisco Webex Meetings VDI plugin 41.12.6.12

Cisco Webex Meetings VDI plugin 42.3.1.12

Cisco Webex Meetings VDI plugin 42.5.5.9

Zoom Media Plugin 5.10.0.21068

Zoom Media Plugin 5.10.6.21295

Zoom Media Plugin 5.8.4.21112

Citrix HDX Realtime Media Engine 2.9.400

Citrix Workspace App 20.10.0.6

Citrix Workspace App 22.03.0.24

Citrix Workspace App 22.05.0.16

deviceTRUST Citrix Channel 20.2.310.0

Crossmatch DP Citrix Channel 0125

Conky System Monitor 1.10.8-1

ControlUp Agent 8.1.5.500

deskMate Client 2.1.3

DriveLock Agent 20.1.4.30482

Ericom PowerTerm 14.0.1.62267

Evidian AuthMgr 1.5.8134

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech Plugins 3.8.0
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FabulaTech USB for Remote Desktop 6.0.35

FabulaTech Scanner for Remote Desktop 2.7.0.1

FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 91.9.1

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1648540238

IGEL AVD Client 1.0.99.7igel1651063614

deviceTRUST RDP Channel 20.2.310.0

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

Lakeside SysTrack Channel 9.0

Login VSI Enterprise 4.8.6

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628

Open VPN 2.5.6-1igel1647855849

Zulu JRE 8.0.345-1

Parallels Client  18.3.1

Spice GTK (Red Hat Virtualization) 0.39-3igel1633543285

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.0-3

Systancia AppliDis 6.0.0-4

Teradici PCoIP Software Client 22.04.0-18.04

ThinLinc Client 4.14.0-2324

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 4.16.0-1igel1611217037

VNC Viewer 1.12.0+dfsg-3igel1644994551

VMware Horizon Client 2203-8.5.0-19586897
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Voip Client Ekiga 4.0.1-9build1igel6

Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.2

Philips Speech driver 13.1.10

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.28

PKCS#11 Library OpenSC 0.22.0-2igel1643799581

PKCS#11 Library SecMaker NetID Enterprise 6.8.3.21

PKCS#11 Library SecMaker NetID Client 1.0.2.67

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.5.0-2igel1646035471

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.5-3igel1646034250

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.10

OpenSSL 1.1.1-1ubuntu2.1~18.04.20

OpenSSH Client 8.9p1-3igel1646033299

OpenSSH Server 8.9p1-3igel1646033299

Bluetooth stack (bluez) 5.64-0igel1647863644

MESA OpenGL stack 21.3.7-1igel1646288715

VAAPI ABI Version 0.40

VDPAU Library version 1.4-3igel1099

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046

Graphics Driver ATI/RADEON 19.1.0-3igel1657777718

Graphics Driver ATI/AMDGPU 22.0.0-1igel1645768768

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678

Graphics Driver Nvidia 470.129.06-0ubuntu0.21.10.1

Graphics Driver VMware 13.3.0-3igel1628859075

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534

Graphics Driver FBDEV 0.5.0-2igel1644486279

Graphics Driver VESA 2.5.0-1igel1628504011

Input Driver Evdev 2.10.6-2igel1629196047

Input Driver Elographics 1.4.2-1igel1629196349

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146

Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980
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Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.15.26 #mainline-lxos_dev-g1657794738

Xorg X11 Server 21.1.4igel1657689370

Xorg Xephyr 21.1.4igel1657689370

CUPS printing daemon 2.2.7-1ubuntu2.9igel1654064309

PrinterLogic 25.1.0.500

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.3.5-3ubuntu7.3

NetworkManager 1.32.12-0ubuntu1igel1656495558

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.18.5-1igel1633086114

GStreamer 1.0 Fluendo aacdec 1.0.1

GStreamer 1.0 Fluendo asfdemux 1.0.1

GStreamer 1.0 Fluendo h264dec 1.0.3

GStreamer 1.0 Fluendo mp3dec 1.0.1

GStreamer 1.0 Fluendo mpeg4videodec 1.0.1

GStreamer 1.0 Fluendo vadec 1.0.2
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GStreamer 1.0 Fluendo wmadec 1.0.1

GStreamer 1.0 Fluendo wmvdec 1.0.1

WebKit2Gtk 2.36.6-1igel1660197492

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.32-dfsg-1igel1643178233

Virtualbox X11 Guest Utils 6.1.32-dfsg-1igel1643178233

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.22.1-1igel1646032976

Qemu Guest Agent 7.0+dfsg-7igel1654064676

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.19-1igel1633453264

Mobile Device Access USB (imobile) 1.3.0-6igel12

Mobile Device Access USB (gphoto) 2.5.27-1igel8

VPN OpenConnect 8.20-1igel1645458039

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.32-dfsg-1igel1643178233

Services
Service Size Reduced Firmware

Asian Language Support 24.8 M Included

Java SE Runtime Environment 43.2 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

373.8 M Included
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Ericom PowerTerm InterConnect 11.5 M Included

Media Player 768.0 K Included

Local Browser (Firefox)
Citrix Appliance

94.5 M Included

VMware Horizon
RDP

6.5 M Included

Cendio ThinLinc 12.8 M Included

Printing (Internet printing protocol CUPS) 23.8 M Included

NoMachine NX 30.8 M Included

VMware Horizon 281.5 M Included

Voice over IP (Ekiga) 7.2 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 30.8 M Not included

Fluendo GStreamer Codec Plugins 7.2 M Included

IBM i Access Client Solutions 128.2 M Not included

Red Hat Enterprise Virtualization 3.0 M Included

Parallels Client 6.8 M Included

NVIDIA graphics driver 280.0 M Not included

Imprivata Appliance 16.0 M Included

AppliDis 256.0 K Included

Evidian AuthMgr 3.0 M Included

Hardware Video Acceleration 16.2 M Included

Extra Font Package 1.2 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 4.2 M Included

Cisco JVDI client 76.0 M Included

PrinterLogic 53.2 M Not included

Biosec BS Login 10.2 M Not included

Login VSI Login Enterprise 32.8 M Not included
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Stratusphere UX CID Key software 8.5 M Not included

Elastic Filebeat 25.0 M Not included

AVD 129.5 M Included

Local Browser (Chromium) 112.0 M Not included

Amazon WorkSpaces Client 36.8 M Included

deskMate client 6.5 M Included

Cisco Webex VDI 78.2 M Not included

Cisco Webex Meetings VDI 140.8 M Not included

Zoom Media Plugin 136.5 M Not included

DriveLock 14.8 M Included

SpeechWrite Client 256.0 K Included

IGEL Imprivata Agent 256.0 K Included

Fluendo Browser Codec Plugins 4.5 M Included

HP Factory deployment documentation 90.0 M Included

Teradici PCoIP Client 17.5 M Included

90meter Smart Card Support 256.0 K Included

Virtualbox (Limited support)

Mobile Device Access USB (Limited 
support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

Limited Support Features

256.0 K Not included

Mobile Device Access USB (Limited 
support)

512.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 2.8 M Not included

VirtualBox (Limited support) 72.8 M Not included
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Known Issues 11.08.110

Citrix
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These occur with 
multimedia redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if browser content 
redirection is enabled active.)
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to a 
freeze. Selective H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.
With start of Self-Service, it is possible that the process ServiceRecord is segfaulted - Self-
Service cannot be started afterwards. A cache cleanup with reboot should help, also the 
following parameters should be set to "true".
More...

Parameter Clean up UI cache after Self-Service termination

Registry ica.selfservice.cleanupwebui

Value false / true

Parameter Clean up Store cache after Self-Service termination

Registry ica.selfservice.cleanupstore



Notes for Release 11.08.110

IGEL OS Release Notes   210 / 1492

•

•

•

•

•
•

•

•

•

Value false / true

OSC Installer
OSC not deployable with IGEL Deployment Appliance: New version 11.3 is required for 
deployment of IGEL OS 11.06. and later.

AVD
AVD MS-Teams optimization can crash the AVD client if H264 software decoder is used
(fluh264dec). AVD prefers the hardware decoders (fluvadec) but when there are no hardware 
decoders or when all hardware decoders are in use already, the software decoder is utilized, which 
may randomly crash the AVD client. It is likely when it crashes in a certain MS-Teams call, it might 
crash quite soon again when rejoining the same call. A fix for that is under development.
A workaround is to disable incoming video in such MS-Teams calls, which is an option in the "..." 
menu from the control bar during an active call.
H264 hardware decoding for MS-Teams optimization is currently limited to non-AMD devices
due to stability issues on AMD devices.

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon. 
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session. 
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir 

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only with usage of local layout and 
deadkeys enabled.
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL OS), 
Horizon client falls back to en-US layout.



Notes for Release 11.08.110

IGEL OS Release Notes   211 / 1492

•

•

•
•

•

•
•

•

•

•

•

PCoIP sessions may crash in some cases, switching to Blast Protocol is recommended then. 
H.264/HEVC encoding can be disabled when overall performance is too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadical problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for these devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB redirection which results in an unclean unmount. 
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.

Firefox
With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.

Network
Wakeup from system suspend fails on DELL Latitude 5510.
If applications are configured to start after established network connection and network mounts 
are configured, spurious "Failed to start application" notifications may be shown. The 
applications still start.

Wi-Fi
TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client
There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system
Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).
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Conky
The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920).

Firmware Update
On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character). 
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'

Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3 M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia
Multimedia redirection with GStreamer could fail when using Nouveau GPU driver.

Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.
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AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.



Notes for Release 11.08.110

IGEL OS Release Notes   214 / 1492

•

•

•
•

•
•
•

•
•
•

•
•
•
•
•
•
•

Security Fixes 11.08.110

Chromium
Fixed Chromium browser security issues:
More...

CVE-2022-2624, CVE-2022-2623, CVE-2022-2622, CVE-2022-2621, CVE-2022-2620, 
CVE-2022-2619, CVE-2022-2618, CVE-2022-2617, CVE-2022-2616, CVE-2022-2615, 
CVE-2022-2614, CVE-2022-2613, CVE-2022-2612, CVE-2022-2611, CVE-2022-2610, 
CVE-2022-2609, CVE-2022-2608, CVE-2022-2607, CVE-2022-2606, CVE-2022-2605, 
CVE-2022-2604, CVE-2022-2603, CVE-2022-2481, CVE-2022-2480, CVE-2022-2479, 
CVE-2022-2478, CVE-2022-2477, and CVE-2022-2163

Fixed Chromium browser security issues:
More...

CVE-2022-2296, CVE-2022-2295, CVE-2022-2294, CVE-2022-2165, CVE-2022-2164,
CVE-2022-2163, CVE-2022-2162, CVE-2022-2161, CVE-2022-2160, CVE-2022-2158,
CVE-2022-2157, CVE-2022-2156, CVE-2022-2011, CVE-2022-2010, CVE-2022-2008, and CVE-2022-2007

Google is aware that an exploit for CVE-2022-2294 exists in the wild.
Updated Chromium browser to version 104.0.5112.79

Base System
Fixed gnupg2 security issues CVE-2019-13050 and CVE-2022-34903.
Fixed cups security issues CVE-2022-26691, CVE-2020-10001, and CVE-2019-8842.
Fixed ntfs-3g security issues:
More...

CVE-2022-30789, CVE-2022-30788, CVE-2022-30787,CVE-2022-30786, 
CVE-2022-30785, CVE-2022-30784, CVE-2022-30783, and CVE-2021-46790

Fixed libvirt security issue CVE-2022-0897.
Fixed qemu security issue CVE-2021-3611.
Fixed webkit2gtk security issues:
More...

CVE-2022-26710, CVE-2022-22677, CVE-2022-22662, CVE-2022-30294,
CVE-2022-30293, CVE-2022-26719, CVE-2022-26717, CVE-2022-26716,
CVE-2022-26709, and CVE-2022-26700

Fixed openssl1.0 security issue CVE-2022-2068.
Fixed openssl security issues CVE-2022-2097 and CVE-2022-2068.
Fixed libarchive security issue CVE-2022-26280.
Fixed ffmpeg security issues DSA-5124-1 and DSA-5126-1.
Fixed nss security issues CVE-2022-34480 and CVE-2022-22747.
Fixed kernel security issue CVE-2022-32250.
Fixed libtirpc security issue CVE-2021-46828.
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Fixed unzip security issues CVE-2022-0530 and CVE-2022-0529.
Fixed freetype security issues CVE-2022-31782, CVE-2022-27406, CVE-2022-27405, and 
CVE-2022-27404.
Fixed gnutls28 security issues CVE-2022-2509 and CVE-2021-4209.
Fixed mysql-5.7 security issue CVE-2022-21515.
Fixed python2.7 security issue CVE-2015-20107.
Fixed python3.6 security issue CVE-2015-20107.
Fixed net-snmp security issues:
More...

CVE-2022-24810, CVE-2022-24809, CVE-2022-24808,
CVE-2022-24807, CVE-2022-24806, CVE-2022-24805, and CVE-2022-248

Fixed zulu8-ca security issues CVE-2022-34169, CVE-2022-25647, CVE-2022-21541, and 
CVE-2022-21540.
Fixed curl security issues CVE-2022-32208, CVE-2022-32207, CVE-2022-32206, and CVE-2022-32205.
Fixed postgresql-10 security issue CVE-2022-1552.
Fixed webkit2gtk security issues CVE-2022-32816, CVE-2022-32792, and CVE-2022-2294.

X Server
Fixed xorg security issues CVE-2022-2319 and CVE-2022-2320.
Updated Xorg server to version 21.1.4.
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New Features 11.08.110

VMware Horizon
Added system-wide handler to start links which use the vmware-view protocol.
View session can now be started by Chromium or any other application which uses xdg-open.

Chromium
Added list and dictionary support for custom policies.

Smartcard
Added support for Cherry eHealth ST-1506 in USB RNDIS mode. There is a systray icon per 
device. The tooltip says whether it is connected or disconnected in terms of network 
configuration. Per device, one instance of the template
devices.cherry.terminal%  must be created and configured. By default, none 

is configured and so the feature is essentially disabled.
This is for potentially distinguishing multiple connected devices and may contain a MAC address 
or the value of the udev property ID_NET_NAME_PATH . It may be left empty if only one 
device shall be supported:
Parameter Device ID

Registry devices.cherry.terminal%.rndis.device_

id

Type string

Value empty (Default)

Parameter Device IP address

Registry devices.cherry.terminal%.rndis.device_

ipaddress

Type string

Value 192.168.42.42 (Default)

Parameter Host IP address
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Registry devices.cherry.terminal%.rndis.host_ip

address

Type string

Value 192.168.42.1 (Default)

This port on the host will be passed through to the same port on the device:
Parameter Device TCP port

Registry devices.cherry.terminal%.rndis.device_

tcpport

Type string

Value 4742 (Default)

This port on the host will be passed through to the same port on the device:
Parameter Passed through device UDP port

Registry devices.cherry.terminal%.rndis.device_

udpport

Type string

Value 4742 (Default)

This port on the host will be forwarded to the device's port 443:
Parameter Host SSL port

Registry devices.cherry.terminal%.rndis.host_ss

lport

Type string

Value empty (Default)

Added support for concurrent usage of multiple smartcard middleware libraries for 
authentication with smartcard to Active Directory / Kerberos and Citrix.
In the Setup on page Security > Smartcard > Middleware, multiple libraries can be activated. If 
none is activated, OpenSC is taken as fallback.

Cisco Webex
Integrated WebEx VDI Client 42.6.0.22645
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Base System
Added LVFS utility for BIOS update. For detailed instructions, see BIOS Update for Devices 
Supported by LVFS.

Parameter Allow installation of bios version that's older than current.

Registry fwtools.bios_tools.allow_downgrade

Value enabled / disabled

Parameter Allow installation of bios version that's equivalent to 
current.

Registry fwtools.bios_tools.allow_reinstall

Value enabled / disabled

Added parameter for LVFS BIOS update:
IGEL Setup System > Firmware Customization > Features

Parameter BIOS Tools

Registry services.bios_tools.enabled

Value enabled / disabled

Parameter BIOS Update file

Registry fwtools.bios_tools.bios_update_file

Value empty (Default)

Note The URL or path to the BIOS Update binary must be 
entered here (e.g. any *.cab  file for LVFS).

LVFS BIOS Updates can be downloaded at https://
fwupd.org/lvfs/.

Download credentials:
Parameter Download Username

Registry fwtools.bios_tools.bios_download_usern

ame

Value empty (Default)

Please note: IGEL supports just the mechanism – BIOS updates are executed at own risk (as usual).

https://fwupd.org/lvfs/
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Parameter Download Password

Registry fwtools.bios_tools.bios_download_crypt

_password

Value empty (Default)

Known issue: No support for BIOS password handling.

Added a Generic Device Command "BIOS - Trigger update" to trigger BIOS updates via UMS.
Added new registry key to disable DisplayPort MST support of amdgpu driver:
Parameter Disable DP MST support of the AMDPU DRM driver.

Registry x.drivers.amdgpu.disable_dp_mst_suppor

t

Type bool

Value enabled / disabled

X11 System
Updated ATI/Radeon graphic driver to version 19.1.0.
Updated amdgpu graphic driver to version 22.0.0.

Login Enterprise
Updated Login VSI Enterprise to version 4.8.6.

zoomvdi
Integrated Zoom VDI client 5.10.6.21295
Available Zoom Media Plugins in this release: 5.8.4.21112, 5.10.0.21068, and 5.10.6.21295
(default)

Multimedia
Updated Fluendo GStreamer 1.x multimedia codecs to fix stability problems with AVD Teams
Optimization:
More...

gst-fluendo-aacdec 1.0.1

gst-fluendo-asfdemux 1.0.1
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gst-fluendo-h264dec 1.0.3

gst-fluendo-mp3 1.0.1

gst-fluendo-mpeg4video 1.0.1

gst-fluendo-vadec - h264_mpeg4 1.0.2

gst-fluendo-wmadec 1.0.1

gst-fluendo-wmvdec 1.0.1

Hardware
Added hardware support for HP T655 Elite Thin Client.

TC Setup (Java)
Updated TC Setup to version 6.10.3.
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Resolved Issues 11.08.110

Citrix
Fixed: Random disconnects, segfaults or session freezes with enabled H.264 decoding in Citrix 
sessions.
Improved keyboard layout synchronization:

required setting: ica.module.virtualdriver.keyboardsync.enable=true
(changed to default=true)
for configuring the new KeyboardSyncMode. Windows Server may require 
config, see https://docs.citrix.com/en-us/citrix-workspace-app-for-linux/configure-
xenapp.htm#keyboard-layout-synchronization:
default for ica.wfclient.keyboardsyncmode  changed to "dynamic"
for configuring new KeyboardEventMode: 
default for  ica.wfclient.keyboardeventmode  changed to "Unicode"

AVD
Fixed stability issues of MS Teams Optimization in AVD with enabled H.264 decoding via 
updated Fluendo codec pack and switch of Radeon(SI) driver from vdpau to vaapi.

Chromium
Added : User is asked where to save each file before downloading for the case no download 
location is set.
Fixed hardware accelerated video decoding on newer Intel chipsets using the iHD VA-API 
backend.

Network
Fixed MBB connection editor
Fixed negotiation of inner method for 802.1X PEAP authentication

Wi-Fi

Added registry key for set of WPA supplicant parameter wpa_deny_ptk0_rekey .
This should be changed to "driver-dependent" (i.e. deny unless driver explicitly asserts 
capability) or "always" if WLAN problems are associated with messages of the form " kernel: 

Rekeying PTK for STA ... but driver can't safely do that ".
The default "never" preserves the traditional behavior.

https://docs.citrix.com/en-us/citrix-workspace-app-for-linux/configure-xenapp.htm#keyboard-layout-synchronization
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More...

Parameter Deny PTK0 rekey

Registry network.interfaces.wirelesslan.device0.w

pa_deny_ptk0_rekey

Range [never] [driver-dependent] [always]

Value never

Added missing German text for Wi-Fi passphrase.
Added missing firmware files for Intel AX210 Wi-Fi adapters.

HID
Fixed touchpad acceleration if libinput driver is used.

Base System
Fixed failed firmware update from servers with low bandwidth.
Fixed touchpad enable / disable by hotkey.
Fixed sporadic downgrade issue - as occured with 11.07.191.
Added several registry keys to set new kernel commandline options:
More...

Parameter Use polling for IRQs.

Registry system.kernel.bootparams.irqpoll

Type bool

Value enabled / disabled

Parameter Disable use of Hyperthreading.

Registry system.kernel.bootparams.nosmt

Type bool

Value enabled / disabled

Parameter Enable debug output for i8042 driver.

Registry system.kernel.bootparams.i8042.debug

Type bool

Value enabled / disabled
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Parameter Do not use muxing for i8042 driver.

Registry system.kernel.bootparams.i8042.nomux

Type bool

Value enabled / disabled

Parameter Disable use of PnP configuration for i8042 driver.

Registry system.kernel.bootparams.i8042.nopnp

Type bool

Value enabled / disabled

Parameter Disable use of AUX loopback command for i8042 driver.

Registry system.kernel.bootparams.i8042.noloop

Type bool

Value enabled / disabled

Parameter Ignore timeout signaled by controller for i8042 driver.

Registry system.kernel.bootparams.i8042.notimeou

t

Type bool

Value enabled / disabled

Parameter Reset controller during init for i8042 driver.

Registry system.kernel.bootparams.i8042.reset

Type bool

Value enabled / disabled

Parameter Set PCI kernel parameters.

Registry system.kernel.bootparams.pci

Range [No setting] [Conf1] [Conf2]
[Nodomains] [Nommconf] [Nomsi]
[Nocrs] [Noacpi] [Routeirq]  

Value No setting
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Parameter Set kernel clocksource to use.

Registry system.kernel.bootparams.clocksource

Range [Default] [Jiffies] [ACPI PM] [HPET] [TSC]  

Value no

Parameter PCIe Active State Power Management setting.

Registry system.kernel.bootparams.pcie_aspm

Range [On] [Off]

Value On

Parameter Dynamic ticks setting.

Registry system.kernel.bootparams.nohz

Range [On] [Off] 

Value On

Parameter Delay in seconds before new devices are scanned.

Registry system.kernel.bootparams.usb_storage_d

elay

Type integer

Value 0 (Default)

X11 System
Added a new registry key to enable the old monitor connector scheme:
More...

Parameter Use old DP connector setup name handling.

Registry x.drm_daemon.use_legacy_dp_handling

Type bool

Value enabled / disabled

Updated ati/radeon graphic driver to version 19.1.0 which fixed issues with radeon Xorg driver 
and rotation.
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X Server
Fixed DisplayPort on Shuttle DS77U device.
Some older ATI/Radeon cards have issues with current Xorg servers. For that reason, switch to 
an older one was added.
Added a new registry key to switch to an older Xorg server version:
More...

Parameter Use older xorg server version.

Registry x.server.use_legacy_xorg_server

Type bool

Value enabled / disabled

Audio
Fixed audio output via display port/HDMI for HP Elitedesk 800 G6
Use this registry key to set the default audio device as fallback device after device unplug:
More...

Parameter Use default audio device as fallback device

Registry multimedia.use_default_fallback

Type bool

Value enabled / disabled

Hardware
Fixed ADS-TEC front key.
Fixed issue with Intel Elkhart devices like HP t550.
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Notes for Release 11.07.920
Software: Version 11.07.920

Release Date: 2022-09-15

Release Notes: Version RN-1107920-1

Last update: 2022-09-15

Supported Devices 11.07.920 (see page 227)
Component Versions 11.07.920 (see page 228)
Known Issues 11.07.920 (see page 236)
Security Fixes 11.07.920 (see page 241)
New Features 11.07.920 (see page 243)
Resolved Issues 11.07.920 (see page 244)

The Release Notes for IGEL OS 11.07.920 are also available in the following formats:

Plain text: readme_11.07.920.txt
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Supported Devices 11.07.920
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.07.920

Clients
Product Version

Amazon WorkSpaces Client 3.1.9

Chromium 104.0.5112.79-igel1659897252

Cisco JVDI Client 14.1.1

Cisco Webex VDI plugin 42.4.0.21893

Cisco Webex Meetings VDI plugin 41.12.6.12

Cisco Webex Meetings VDI plugin 42.3.1.12

Cisco Webex Meetings VDI plugin 42.5.5.9

Zoom Media Plugin 5.10.0.21068

Zoom Media Plugin 5.10.6.21295

Zoom Media Plugin 5.8.4.21112

Citrix HDX Realtime Media Engine 2.9.400

Citrix Workspace App 20.10.0.6

Citrix Workspace App 22.03.0.24

Citrix Workspace App 22.05.0.16

deviceTRUST Citrix Channel 20.2.310.0

Crossmatch DP Citrix Channel 0125

Conky System Monitor 1.10.8-1

ControlUp Agent 8.1.5.500

deskMate Client 2.1.3

DriveLock Agent 20.1.4.30482

Ericom PowerTerm 14.0.1.62267

Evidian AuthMgr 1.5.8134

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech Plugins 3.8.0
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FabulaTech USB for Remote Desktop 6.0.35

FabulaTech Scanner for Remote Desktop 2.7.0.1

FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 91.9.1

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1648540238

IGEL AVD Client 1.0.99.7igel1651063614

deviceTRUST RDP Channel 20.2.310.0

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

Lakeside SysTrack Channel 9.0

Login VSI Enterprise 4.5.11

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628

Open VPN 2.6.0~git20220808-1igel1660123886

Zulu JRE 8.0.345-1

Parallels Client  18.3.1

Spice GTK (Red Hat Virtualization) 0.39-3igel1633543285

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.0-3

Systancia AppliDis 6.0.0-4

Teradici PCoIP Software Client 22.04.0-18.04

ThinLinc Client 4.14.0-2324

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 4.16.0-1igel1611217037

VNC Viewer 1.12.0+dfsg-3igel1644994551

VMware Horizon Client 2203-8.5.0-19586897
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Voip Client Ekiga 4.0.1-9build1igel6

Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.2

Philips Speech driver 13.1.10

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.28

PKCS#11 Library OpenSC 0.22.0-2igel1643799581

PKCS#11 Library SecMaker NetID Enterprise 6.8.3.21

PKCS#11 Library SecMaker NetID Client 1.0.2.67

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.5.0-2igel1646035471

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.5-3igel1646034250

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.10

OpenSSL 1.1.1-1ubuntu2.1~18.04.20

OpenSSH Client 8.9p1-3igel1646033299

OpenSSH Server 8.9p1-3igel1646033299

Bluetooth stack (bluez) 5.64-0ubuntu1igel1660041146

MESA OpenGL stack 22.1.5-1igel1659869061

VAAPI ABI Version 0.40

VDPAU Library version 1.5-1igel1646992192

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046

Graphics Driver ATI/RADEON 19.1.0-3igel1657777718

Graphics Driver ATI/AMDGPU 22.0.0-2igel1657776223

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678

Graphics Driver Nvidia 470.141.03-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-3igel1628859075

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534

Graphics Driver FBDEV 0.5.0-2igel1644486279

Graphics Driver VESA 2.5.0-1igel1628504011

Input Driver Evdev 2.10.6-2igel1629196047

Input Driver Elographics 1.4.2-1igel1629196349

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146

Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980
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Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.17.15 #mainline-lxos_dev-g1659943300

Xorg X11 Server 21.1.4igel1657689370

Xorg Xephyr 21.1.4igel1657689370

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.500

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.3.5-3ubuntu7.3

NetworkManager 1.32.12-0ubuntu1igel1656495558

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.18.5-1igel1633086114

GStreamer 1.0 Fluendo aacdec 0.10.42

GStreamer 1.0 Fluendo asfdemux 0.10.92

GStreamer 1.0 Fluendo h264dec 0.10.59

GStreamer 1.0 Fluendo mp3dec 0.10.41

GStreamer 1.0 Fluendo mpeg4videodec 0.10.44

GStreamer 1.0 Fluendo vadec 0.10.229
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GStreamer 1.0 Fluendo wmadec 0.10.70

GStreamer 1.0 Fluendo wmvdec 0.10.66

WebKit2Gtk 2.36.6-1igel1660197492

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.32-dfsg-1igel1643178233

Virtualbox X11 Guest Utils 6.1.32-dfsg-1igel1643178233

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.22.1-1igel1646032976

Qemu Guest Agent 6.2+dfsg-3igel1646036781

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.19-1igel1633453264

Mobile Device Access USB (imobile) 1.3.0-6igel12

Mobile Device Access USB (gphoto) 2.5.29-1igel1653377622

VPN OpenConnect 9.01-1igel1657119743

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.32-dfsg-1igel1643178233

Services
Service Size Reduced Firmware

Asian Language Support 24.8 M Included

Java SE Runtime Environment 43.2 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

373.8 M Included
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Ericom PowerTerm InterConnect 11.5 M Included

Media Player 768.0 K Included

Local Browser (Firefox)
Citrix Appliance

94.5 M Included

VMware Horizon
RDP

6.5 M Included

Cendio ThinLinc 12.8 M Included

Printing (Internet printing protocol CUPS) 23.8 M Included

NoMachine NX 30.8 M Included

VMware Horizon 281.5 M Included

Voice over IP (Ekiga) 7.2 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 30.8 M Not included

Fluendo GStreamer Codec Plugins 7.5 M Included

IBM i Access Client Solutions 128.2 M Not included

Red Hat Enterprise Virtualization 3.0 M Included

Parallels Client 6.8 M Included

NVIDIA graphics driver 280.2 M Not included

Imprivata Appliance 16.0 M Included

AppliDis 256.0 K Included

Evidian AuthMgr 3.0 M Included

Hardware Video Acceleration 15.0 M Included

Extra Font Package 1.2 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 4.2 M Included

Cisco JVDI client 76.0 M Included

PrinterLogic 53.2 M Not included

Biosec BS Login 10.2 M Not included

Login VSI Login Enterprise 32.8 M Not included
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Stratusphere UX CID Key software 8.5 M Not included

Elastic Filebeat 25.0 M Not included

AVD 129.5 M Included

Local Browser (Chromium) 112.0 M Not included

Amazon WorkSpaces Client 36.8 M Included

deskMate client 6.5 M Included

Cisco Webex VDI 77.0 M Not included

Cisco Webex Meetings VDI 140.8 M Not included

Zoom Media Plugin 136.5 M Not included

DriveLock 14.8 M Included

SpeechWrite Client 256.0 K Included

IGEL Imprivata Agent 256.0 K Included

Fluendo Browser Codec Plugins 4.5 M Included

HP Factory deployment documentation 90.0 M Included

Teradici PCoIP Client 17.5 M Included

90meter Smart Card Support 256.0 K Included

Virtualbox (Limited support)

Mobile Device Access USB (Limited 
support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

Limited Support Features

256.0 K Not included

Mobile Device Access USB (Limited 
support)

512.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 2.8 M Not included

VirtualBox (Limited support) 72.5 M Not included
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Known Issues 11.07.920

Citrix
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These occur with 
multimedia redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if browser content 
redirection is enabled active.)
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to a 
freeze. Selective H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.
With start of Self-Service, it is possible that the process ServiceRecord is segfaulted - Self-
Service cannot be started afterwards. A cache cleanup with reboot should help, also the 
following parameters should be set to "true".
More...

Parameter Clean up UI cache after Self-Service termination

Registry ica.selfservice.cleanupwebui

Value false / true

Parameter Clean up Store cache after Self-Service termination

Registry ica.selfservice.cleanupstore



Notes for Release 11.07.920

IGEL OS Release Notes   237 / 1492

•

•

•

•

•
•

•

•

•

Value false / true

OSC Installer
OSC not deployable with IGEL Deployment Appliance: New version 11.3 is required for 
deployment of IGEL OS 11.06. and later.

AVD
AVD MS-Teams optimization can crash the AVD client if H264 software decoder is used
(fluh264dec). AVD prefers the hardware decoders (fluvadec) but when there are no hardware 
decoders or when all hardware decoders are in use already, the software decoder is utilized, which 
may randomly crash the AVD client. It is likely when it crashes in a certain MS-Teams call, it might 
crash quite soon again when rejoining the same call. A fix for that is under development.
A workaround is to disable incoming video in such MS-Teams calls, which is an option in the "..." 
menu from the control bar during an active call.
H264 hardware decoding for MS-Teams optimization is currently limited to non-AMD devices
due to stability issues on AMD devices.

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon. 
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session. 
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir 

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only with usage of local layout and 
deadkeys enabled.
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL OS), 
Horizon client falls back to en-US layout.
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PCoIP sessions may crash in some cases, switching to Blast Protocol is recommended then. 
H.264/HEVC encoding can be disabled when overall performance is too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadical problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for these devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB redirection which results in an unclean unmount. 
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.

Firefox
With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.

Network
Wakeup from system suspend fails on DELL Latitude 5510.
If applications are configured to start after established network connection and network mounts 
are configured, spurious "Failed to start application" notifications may be shown. The 
applications still start.

Wi-Fi
TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client
There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system
Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).
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Conky
The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920).

Firmware Update
On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character). 
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'

Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3 M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia
Multimedia redirection with GStreamer could fail when using Nouveau GPU driver.

Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.
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AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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Security Fixes 11.07.920

Chromium
Fixed Chromium browser security issues:
More...

CVE-2022-2624, CVE-2022-2623, CVE-2022-2622, CVE-2022-2621,
CVE-2022-2620, CVE-2022-2619, CVE-2022-2618, CVE-2022-2617,
CVE-2022-2616, CVE-2022-2615, CVE-2022-2614, CVE-2022-2613,
CVE-2022-2612, CVE-2022-2611, CVE-2022-2610, CVE-2022-2609,
CVE-2022-2608, CVE-2022-2607, CVE-2022-2606, CVE-2022-2605,
CVE-2022-2604, CVE-2022-2603, CVE-2022-2481, CVE-2022-2480,
CVE-2022-2479, CVE-2022-2478, CVE-2022-2477, and CVE-2022-2163

Fixed Chromium browser security issues:
More...

CVE-2022-2296, CVE-2022-2295, CVE-2022-2294, CVE-2022-2165,
CVE-2022-2164, CVE-2022-2163, CVE-2022-2162, CVE-2022-2161,
CVE-2022-2160, CVE-2022-2158, CVE-2022-2157, CVE-2022-2156,
CVE-2022-2011, CVE-2022-2010, CVE-2022-2008, and CVE-2022-2007

Google is aware that an exploit for CVE-2022-2294 exists in the wild.
Updated Chromium browser to version 104.0.5112.79

Base System
Fixed libinput security issue CVE-2020-1215.
Fixed libarchive security issue CVE-2022-26280.
Fixed ntfs-3g security issues:
More...

CVE-2022-30789, CVE-2022-30788, CVE-2022-30787, CVE-2022-30786, 
CVE-2022-30785, CVE-2022-30784, CVE-2022-30783, and CVE-2021-46790

Fixed openssl1.0 security issues CVE-2022-2068 and CVE-2022-1292.
Fixed openssl security issues CVE-2022-2097, CVE-2022-2068, and CVE-2022-1292.
Fixed gnupg2 security issues CVE-2022-34903 and CVE-2019-13050.
Fixed webkit2gtk security issues:
More...

CVE-2022-26710, CVE-2022-22677, CVE-2022-22662, CVE-2022-30294,
CVE-2022-30293, CVE-2022-26719, CVE-2022-26717, CVE-2022-26716, 
CVE-2022-26709, and CVE-2022-26700

Fixed nss security issues CVE-2022-34480 and CVE-2022-22747.
Fixed Nvidia graphics driver 470 security issues CVE-2022-31607 and CVE-2022-31608.
Updated Nvidia graphics driver to version 470.141.03.
Fixed curl security issues CVE-2022-32208, CVE-2022-32207, CVE-2022-32206, and CVE-2022-32205.
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Fixed unzip security issues CVE-2022-0530 and CVE-2022-0529.
Fixed freetype security issues CVE-2022-31782, CVE-2022-27406, CVE-2022-27405, and 
CVE-2022-27404.
Fixed gnutls28 security issues CVE-2022-2509 and CVE-2021-4209.
Fixed mysql-5.7 security issue CVE-2022-21515.
Fixed python2.7 security issue CVE-2015-20107.
Fixed python3.6 security issue CVE-2015-20107.
Fixed net-snmp security issues:
More...

CVE-2022-24810, CVE-2022-24809, CVE-2022-24808,
CVE-2022-24807, CVE-2022-24806, CVE-2022-24805, and CVE-2022-248

Fixed zulu8-ca security issues CVE-2022-34169, CVE-2022-25647, CVE-2022-21541, and 
CVE-2022-21540.
Updated zulu8-ca JRE to version 8.0.345.
Fixed libtirpc security issue CVE-2021-46828.
Updated Intel microcode to version 20220809 which fixed security issue CVE-2022-21233.
Fixed postgresql-10 security issue CVE-2022-1552.
Fixed webkit2gtk security issues CVE-2022-32816, CVE-2022-32792, and CVE-2022-2294.
Updated webkit2gtk to version 2.36.6.

X Server
Fixed xorg security issues CVE-2022-2319 and CVE-2022-2320. 
Updated Xorg server to version 21.1.4.
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New Features 11.07.920

Chromium
Added list and dictionary support for custom policies.

Base System
Added new registry key to disable DisplayPort MST support of amdgpu driver.
More...

Parameter Disable DP MST support of the AMDPU DRM driver.

Registry x.drivers.amdgpu.disable_dp_mst_suppor

t

Type bool

Value enabled / disabled

Updated kernel to version 5.17.15.
Updated VDPAU library to version 1.5.
Updated gphoto library to version 2.5.29.
Updated OpenConnect VPN client to version 9.01.
Updated bluetooth stack (bluez) to version 5.64.
Updated OpenVPN client to version 2.6.0 (with OpenVPN DCO support).
Updated MESA OpenGL stack to version 22.1.5.
Updated wireless regdb to version 2022.06.06.

X11 System
Updated ATI/Radeon graphic driver to version 19.1.0.
Updated amdgpu graphic driver to version 22.0.0.

zoomvdi
Integrated Zoom VDI client 5.10.6.21295
Available Zoom Media Plugins in this release: 5.8.4.21112, 5.10.0.21068, and 5.10.6.21295
(default)

Hardware
Updated DisplayLink driver to version 5.6.0.
Improved performance of AMD devices and DisplayLink solutions.
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Resolved Issues 11.07.920

Chromium
Added: User is asked where to save each file before downloading for the case no download 
location is set.
Fixed hardware accelerated video decoding on newer Intel chipsets using the iHD VA-API 
backend.

Network
Fixed MBB connection editor
Fixed negotiation of inner method for 802.1X PEAP authentication

Wi-Fi

Added registry key for set of WPA supplicant parameter wpa_deny_ptk0_rekey .
This should be changed to "driver-dependent" (i.e. deny unless driver explicitly asserts 
capability) or "always" if WLAN problems are associated with messages of the form "kernel: 
Rekeying PTK for STA ... but driver can't safely do that".
The default "never" preserves the traditional behavior.
More...

Parameter Deny PTK0 rekey

Registry network.interfaces.wirelesslan.device0.w

pa_deny_ptk0_rekey

Range [never] [driver-dependent] [always]

Value never

Added missing German text for Wi-Fi passphrase.
Added missing firmware files for Intel AX210 Wi-Fi adapters.

HID
Fixed touchpad acceleration if libinput driver is used.

Base System
Fixed failed firmware update from servers with low bandwidth.
Fixed touchpad enable / disable by hotkey.
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Fixed sporadic downgrade issue - as occured with 11.07.191.
Added several registry keys to set new kernel commandline options:
More...

Parameter Use polling for IRQs.

Registry system.kernel.bootparams.irqpoll

Type bool

Value enabled / disabled

Parameter Disable use of Hyperthreading.

Registry system.kernel.bootparams.nosmt

Type bool

Value enabled / disabled

Parameter Enable debug output for i8042 driver.

Registry system.kernel.bootparams.i8042.debug

Type bool

Value enabled / disabled

Parameter Do not use muxing for i8042 driver.

Registry system.kernel.bootparams.i8042.nomux

Type bool

Value enabled / disabled

Parameter Disable use of PnP configuration for i8042 driver.

Registry system.kernel.bootparams.i8042.nopnp

Type bool

Value enabled / disabled

Parameter Disable use of AUX loopback command for i8042 driver.

Registry system.kernel.bootparams.i8042.noloop

Type bool

Value enabled / disabled
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Parameter Ignore timeout signaled by controller for i8042 driver.

Registry system.kernel.bootparams.i8042.notimeou

t

Type bool

Value enabled / disabled

Parameter Reset controller during init for i8042 driver.

Registry system.kernel.bootparams.i8042.reset

Type bool

Value enabled / disabled

Parameter Set PCI kernel parameters.

Registry system.kernel.bootparams.pci

Range [No setting] [Conf1] [Conf2]
[Nodomains] [Nommconf] [Nomsi]
[Nocrs] [Noacpi] [Routeirq]  

Value No setting

Parameter Set kernel clocksource to use.

Registry system.kernel.bootparams.clocksource

Range [Default] [Jiffies] [ACPI PM] [HPET] [TSC]  

Value no

Parameter PCIe Active State Power Management setting.

Registry system.kernel.bootparams.pcie_aspm

Range [On] [Off]

Value On

Parameter Dynamic ticks setting.

Registry system.kernel.bootparams.nohz

Range [On] [Off] 

Value On
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Parameter Delay in seconds before new devices are scanned.

Registry system.kernel.bootparams.usb_storage_d

elay

Type integer

Value 0 (Default)

X11 System
Added a new registry key to enable the old monitor connector scheme:
More...

Parameter Use old DP connector setup name handling.

Registry x.drm_daemon.use_legacy_dp_handling

Type bool

Value enabled / disabled

Updated ati/radeon graphic driver to version 19.1.0 which fixed issues with radeon Xorg driver 
and rotation.
Updated amdgpu graphic driver to version 22.0.0 which improves performance with 
DisplayLink USB solutions.

X Server
Fixed DisplayPort on Shuttle DS77U device.
Some older ATI/Radeon cards have issues with current Xorg servers. For that reason, switch to 
an older one was added.
Added a new registry key to switch to an older Xorg server version:
More...

Parameter Use older xorg server version.

Registry x.server.use_legacy_xorg_server

Type bool

Value enabled / disabled

Audio
Fixed audio output via display port/HDMI for HP Elitedesk 800 G6
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Hardware
Fixed issue with Intel Elkhart devices like HP t550.
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Notes for Release 11.07.170
Software: Version 11.07.170

Release Date: 2022-06-28

Release Notes: Version RN-1107170-1

Last update: 2022-06-28

Supported Devices 11.07.170 (see page 250)
Component Versions 11.07.170 (see page 251)
Known Issues 11.07.170 (see page 259)
Security Fixes 11.07.170 (see page 264)
New Features 11.07.170 (see page 265)
Resolved Issues 11.07.170 (see page 267)

The Release Notes for IGEL OS 11.07.170 are also available in the following formats:

Plain text: readme11.07.170.txt
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Supported Devices 11.07.170
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.07.170

Clients
Product Version

Amazon WorkSpaces Client 3.1.9

Chromium 102.0.5005.61-igel1653480432

Cisco JVDI Client 14.1.1

Cisco Webex VDI plugin 42.4.0.21893

Cisco Webex Meetings VDI plugin 41.12.6.12

Cisco Webex Meetings VDI plugin 42.3.1.12

Cisco Webex Meetings VDI plugin 42.5.5.9

Zoom Media Plugin 5.10.0.21068

Zoom Media Plugin 5.4.59458

Zoom Media Plugin 5.9.6.20931

Citrix HDX Realtime Media Engine 2.9.400

Citrix Workspace App 20.10.0.6

Citrix Workspace App 22.03.0.24

Citrix Workspace App 22.05.0.16

deviceTRUST Citrix Channel 20.2.310.0

Crossmatch DP Citrix Channel 0125

Conky System Monitor 1.10.8-1

ControlUp Agent 8.1.5.500

deskMate Client 2.1.3

DriveLock Agent 20.1.4.30482

Ericom PowerTerm 14.0.1.62267

Evidian AuthMgr 1.5.8134

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech Plugins 3.8.0
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FabulaTech USB for Remote Desktop 6.0.35

FabulaTech Scanner for Remote Desktop 2.7.0.1

FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 91.9.1

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1648540238

IGEL AVD Client 1.0.99.7igel1651063614

deviceTRUST RDP Channel 20.2.310.0

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

Lakeside SysTrack Channel 9.0

Login VSI Enterprise 4.5.11

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628

Open VPN 2.5.6-1igel1647855849

Zulu JRE 8.0.332-1

Parallels Client  18.3.1

Spice GTK (Red Hat Virtualization) 0.39-3igel1633543285

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.0-3

Systancia AppliDis 6.0.0-4

Teradici PCoIP Software Client 22.04.0-18.04

ThinLinc Client 4.14.0-2324

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 4.16.0-1igel1611217037

VNC Viewer 1.12.0+dfsg-3igel1644994551

VMware Horizon Client 2203-8.5.0-19586897
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Voip Client Ekiga 4.0.1-9build1igel6

Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.2

Philips Speech driver 13.1.10

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.28

PKCS#11 Library OpenSC 0.22.0-2igel1643799581

PKCS#11 Library SecMaker NetID Enterprise 6.8.3.21

PKCS#11 Library SecMaker NetID Client 1.0.2.67

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.5.0-2igel1646035471

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.5-3igel1646034250

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.9

OpenSSL 1.1.1-1ubuntu2.1~18.04.17

OpenSSH Client 8.9p1-3igel1646033299

OpenSSH Server 8.9p1-3igel1646033299

Bluetooth stack (bluez) 5.64-0igel1647863644

MESA OpenGL stack 21.3.7-1igel1646288715

VAAPI ABI Version 0.40

VDPAU Library version 1.4-3igel1099

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046

Graphics Driver ATI/RADEON 19.1.0-2igel1629135948

Graphics Driver ATI/AMDGPU 22.0.0-1igel1645768768

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678

Graphics Driver Nvidia 470.129.06-0ubuntu0.21.10.1

Graphics Driver VMware 13.3.0-3igel1628859075

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534

Graphics Driver FBDEV 0.5.0-2igel1644486279

Graphics Driver VESA 2.5.0-1igel1628504011

Input Driver Evdev 2.10.6-2igel1629196047

Input Driver Elographics 1.4.2-1igel1629196349

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146

Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980
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Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.15.26 #mainline-lxos-g1652790891

Xorg X11 Server 21.1.3igel1645782509

Xorg Xephyr 21.1.3igel1645782509

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.500

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.3.5-3ubuntu7.3

NetworkManager 1.32.12-0ubuntu1igel1641211455

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.18.5-1igel1633086114

GStreamer 1.0 Fluendo aacdec 0.10.42

GStreamer 1.0 Fluendo asfdemux 0.10.92

GStreamer 1.0 Fluendo h264dec 0.10.59

GStreamer 1.0 Fluendo mp3dec 0.10.41

GStreamer 1.0 Fluendo mpeg4videodec 0.10.44

GStreamer 1.0 Fluendo vadec 0.10.229
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GStreamer 1.0 Fluendo wmadec 0.10.70

GStreamer 1.0 Fluendo wmvdec 0.10.66

WebKit2Gtk 2.34.6-1igel1645163872

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.32-dfsg-1igel1643178233

Virtualbox X11 Guest Utils 6.1.32-dfsg-1igel1643178233

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.22.1-1igel1646032976

Qemu Guest Agent 6.2+dfsg-3igel1646036781

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.19-1igel1633453264

Mobile Device Access USB (imobile) 1.3.0-6igel12

Mobile Device Access USB (gphoto) 2.5.27-1igel8

VPN OpenConnect 8.20-1igel1645458039

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.32-dfsg-1igel1643178233

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M Included

Java SE Runtime Environment 36.5 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

322.0 M Included
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Ericom PowerTerm InterConnect 10.2 M Included

Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

81.5 M Included

VMware Horizon
RDP

5.5 M Included

Cendio ThinLinc 11.0 M Included

Printing (Internet printing protocol CUPS) 22.2 M Included

NoMachine NX 27.2 M Included

VMware Horizon 243.0 M Included

Voice over IP (Ekiga) 6.5 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M Not included

Fluendo GStreamer Codec Plugins 6.5 M Included

IBM i Access Client Solutions 128.2 M Not included

Red Hat Enterprise Virtualization 2.8 M Included

Parallels Client 6.0 M Included

NVIDIA graphics driver 260.5 M Not included

Imprivata Appliance 14.2 M Included

AppliDis 256.0 K Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 14.2 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.8 M Included

Cisco JVDI client 66.8 M Included

PrinterLogic 47.8 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M Not included
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Stratusphere UX CID Key software 7.5 M Not included

Elastic Filebeat 22.2 M Not included

AVD 113.8 M Included

Local Browser (Chromium) 97.5 M Not included

Amazon WorkSpaces Client 32.2 M Included

deskMate client 5.8 M Included

Cisco Webex VDI 70.8 M Not included

Cisco Webex Meetings VDI 129.2 M Not included

Zoom Media Plugin 124.0 M Not included

DriveLock 13.2 M Included

SpeechWrite Client 256.0 K Included

IGEL Imprivata Agent 256.0 K Included

Fluendo Browser Codec Plugins 4.0 M Included

HP Factory deployment documentation 88.5 M Included

Teradici PCoIP Client 15.5 M Included

90meter Smart Card Support 256.0 K Included

Virtualbox (Limited support)

Mobile Device Access USB (Limited 
support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

Limited Support Features

256.0 K Not included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 65.2 M Not included
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Known Issues 11.07.170

Citrix
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These occur with 
multimedia redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if browser content 
redirection is enabled active.)
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to a 
freeze. Selective H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.
With start of Self-Service, it is possible that the process ServiceRecord is segfaulted - Self-
Service cannot be started afterwards. A cache cleanup with reboot should help, also the 
following parameters should be set to "true".
More...

Parameter Clean up UI cache after Self-Service termination

Registry ica.selfservice.cleanupwebui

Value false / true

Parameter Clean up Store cache after Self-Service termination

Registry ica.selfservice.cleanupstore
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Value false / true

OSC Installer
OSC not deployable with IGEL Deployment Appliance: New version 11.3 is required for 
deployment of IGEL OS 11.06. and later.

AVD
AVD MS-Teams optimization can crash the AVD client if H264 software decoder is used
(fluh264dec). AVD prefers the hardware decoders (fluvadec) but when there are no hardware 
decoders or when all hardware decoders are in use already, the software decoder is utilized, which 
may randomly crash the AVD client. It is likely when it crashes in a certain MS-Teams call, it might 
crash quite soon again when rejoining the same call. A fix for that is under development.
A workaround is to disable incoming video in such MS-Teams calls, which is an option in the "..." 
menu from the control bar during an active call.
H264 hardware decoding for MS-Teams optimization is currently limited to non-AMD devices
due to stability issues on AMD devices.

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon. 
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session. 
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir 

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only with usage of local layout and 
deadkeys enabled.
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL OS), 
Horizon client falls back to en-US layout.
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PCoIP sessions may crash in some cases, switching to Blast Protocol is recommended then. 
H.264/HEVC encoding can be disabled when overall performance is too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadical problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for these devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB redirection which results in an unclean unmount. 
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.

Firefox
With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.

Network
Wakeup from system suspend fails on DELL Latitude 5510.
If applications are configured to start after established network connection and network mounts 
are configured, spurious "Failed to start application" notifications may be shown. The 
applications still start.

Wi-Fi
TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client
There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system
Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).
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Glibc has a serious memcpy performance regression on AMD Zen-based systems.

Conky
The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920).

Firmware Update
On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character). 
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'

Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3 M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia
Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.
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Remote Management
AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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Security Fixes 11.07.170

Firefox
Updated Firefox to version 91.9.1 
Fixes critical CVEs as below: 
CVE-2022-1802: Prototype pollution in Top-Level Await implementation 
CVE-2022-1529: Untrusted input used in JavaScript object indexing, leading to prototype 
pollution

Chromium
Fixed Chromium browser security issues:
CVE-2022-1876, CVE-2022-1875,
CVE-2022-1874, CVE-2022-1873, CVE-2022-1872, CVE-2022-1871, CVE-2022-1870,
CVE-2022-1869, CVE-2022-1868, CVE-2022-1867, CVE-2022-1866, CVE-2022-1865,
CVE-2022-1864, CVE-2022-1863, CVE-2022-1862, CVE-2022-1861, CVE-2022-1860,
CVE-2022-1859, CVE-2022-1858, CVE-2022-1857, CVE-2022-1856, CVE-2022-1855,
CVE-2022-1854, and CVE-2022-1853
Updated to Chromium version 102.0.5005.61.
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New Features 11.07.170

Citrix
Integrated Citrix Workspace App 2205.
Available Citrix Workspace apps in this release: 2205 (default), 2203 and 2010
Added registry keys for Citrix Workspace app 2205:

Authentication enhancement for Storebrowse:
More...

Parameter Disable Authentication enhancement for Storebrowse

Registry ica.authman.StorebrowseIPCDisabled

Value true / false

An authentication dialog is present inside Citrix Workspace app and the store details are displayed 
on the login screen. The authentication tokens are encrypted and stored so that it is not necessary 
to re-enter credentials when the system or session restarts.

Email-based auto-discovery of store:
More...

Parameter Email-based auto-discovery of store

Registry ica.authman.AppConfigEnabled

Value true / false

Automatically discovers the store associated with the email address.
Feature Flag Management:
More...

Parameter Feature flag management

Registry ica.module.enablelaunchdarkly

Value disable / enable

For the case an issue occurs with Citrix Workspace app in production, it is possible to 
disable an affected feature dynamically in Citrix Workspace app during runtime. For that 
feature flags and a third-party service called LaunchDarkly are used.

Imprivata
Improved reconnect/disconnect times with Imprivata and Horizon
Added parameter for inserting Citrix NetScaler cookie:
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More...

Parameter NetScaler COOKIEINSERT

Registry imprivata.cookieinsert

Type string

Cisco JVDI Client
Integrated Cisco JVDI client 14.1.1

Cisco Webex
Integrated Cisco WebEx Meetings VDI Plugin 42.5.5.9
Available Webex Meetings Plugins in this release: 42.5.5.9 (default), 42.3.1.12, and 41.12.6.12

Base system
Updated glibc to version 2.31-0ubuntu9.9 with memcpy improvements.
Updated IGEL EULA to version of 1st July 2022.

Evidian
Updated rsUserAuth to version 1.5.8134

Remote Management
Added new generic UMS job to update HP G5 USB-C docking stations.
More...

Parameter The path to the firmware file on the device

Registry update.devices.hp_g5_dock.path

Value /wfs/hp_g5_dock_firmware.cab

Parameter Whether the update should proceed even if the provided 
firmware is older than the current one on the Dock.

Registry update.devices.hp_g5_dock.allow_downgrade

Value enabled / disabled
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Resolved Issues 11.07.170

RD Web Access
Fixed virtual channel plugins in RD Web Access sessions: PhilipsSpeech, deviceTRUST, 
Diktamen, Grundig, Lakeside, and Olympus.

Imprivata
Fixed Imprivata data partition not fully populated/created.
Fixed FUS password not being accepted.

CUPS Printing
Fixed support for usb-to-parallel adapters

Base system
Fixed sporadic firmware downgrade issues from 11.07 to 11.05.

Conky
Fixed special characters in custom_text.

Storage Devices
Added parameter for Mobile Device Access USB to ignore exposed PTP interface:
More...

Parameter Don't query the PTP interface

Registry sessions.mtp-devices0.omit_ptp

Type bool

Value enabled / disabled

X11 system
Added new registry key to fix issues with DP MST handling:
More...
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Parameter Use new DP MST connector setup name handling.

Tooltip Use this if you have issues with not getting all displays 
configured.

Registry x.drm_daemon.use_new_dp_mst_handling

Type bool

Value enabled / disabled

Window manager
Fixed random restart of the panel when dragging around taskbar items.
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Notes for Release 11.07.140
Software: Version 11.07.140

Release Date: 2022-05-31

Release Notes: Version RN-1107140-1

Last update: 2022-05-27

Supported Devices 11.07.140 (see page 270)
Component Versions 11.07.140 (see page 271)
Known Issues 11.07.140 (see page 279)
Security Fixes 11.07.140 (see page 283)
New Features 11.07.140 (see page 286)
Resolved Issues 11.07.140 (see page 287)

The Release Notes for IGEL OS 11.07.140 are also available in the following formats:

Plain text: RNs_11.07.140.txt
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Supported Devices 11.07.140
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.07.140

Clients
Product Version

Amazon WorkSpaces Client 3.1.9

Chromium 101.0.4951.64-igel1652263123

Cisco JVDI Client 14.1.0

Cisco Webex VDI plugin 42.4.0.21893

Cisco Webex Meetings VDI plugin 41.10.11.5

Cisco Webex Meetings VDI plugin 42.2.4.12

Cisco Webex Meetings VDI plugin 42.3.1.12

Zoom Media Plugin 5.10.0.21068

Zoom Media Plugin 5.4.59458

Zoom Media Plugin 5.9.6.20931

Citrix HDX Realtime Media Engine 2.9.400

Citrix Workspace App 20.10.0.6

Citrix Workspace App 22.02.0.20

Citrix Workspace App 22.03.0.24

deviceTRUST Citrix Channel 20.2.310.0

Crossmatch DP Citrix Channel 0125

deskMate Client 2.1.3

DriveLock Agent 20.1.4.30482

Ericom PowerTerm 14.0.1.62267

Evidian AuthMgr 1.5.7789

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech Plugins 3.8.0

FabulaTech USB for Remote Desktop 6.0.35

FabulaTech Scanner for Remote Desktop 2.7.0.1
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FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 91.9.0

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1648540238

IGEL AVD Client 1.0.99.7igel1651063614

deviceTRUST RDP Channel 20.2.310.0

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

Lakeside SysTrack Channel 9.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628

Open VPN 2.5.6-1igel1647855849

Zulu JRE 8.0.332-1

Parallels Client  18.3.1

Spice GTK (Red Hat Virtualization) 0.39-3igel1633543285

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.0-3

Systancia AppliDis 6.0.0-4

Teradici PCoIP Software Client 22.04.0-18.04

ThinLinc Client 4.14.0-2324

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 4.16.0-1igel1611217037

VNC Viewer 1.12.0+dfsg-3igel1644994551  

VMware Horizon Client 2203-8.5.0-19586897

Voip Client Ekiga 4.0.1-9build1igel6
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Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.2

Philips Speech driver 13.1.10

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.28

PKCS#11 Library OpenSC 0.22.0-2igel1643799581

PKCS#11 Library SecMaker NetID Enterprise 6.8.3.21

PKCS#11 Library SecMaker NetID Client 1.0.2.67

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.5.0-2igel1646035471
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Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.5-3igel1646034250

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.9

OpenSSL 1.1.1-1ubuntu2.1~18.04.17

OpenSSH Client 8.9p1-3igel1646033299

OpenSSH Server 8.9p1-3igel1646033299

Bluetooth stack (bluez) 5.64-0igel1647863644

MESA OpenGL stack 21.3.7-1igel1646288715

VAAPI ABI Version 0.40

VDPAU Library version 1.4-3igel1099

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046

Graphics Driver ATI/RADEON 19.1.0-2igel1629135948

Graphics Driver ATI/AMDGPU 22.0.0-1igel1645768768

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678

Graphics Driver Nvidia 470.129.06-0ubuntu0.21.10.1

Graphics Driver VMware 13.3.0-3igel1628859075

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534

Graphics Driver FBDEV 0.5.0-2igel1644486279

Graphics Driver VESA 2.5.0-1igel1628504011

Input Driver Evdev 2.10.6-2igel1629196047

Input Driver Elographics 1.4.2-1igel1629196349

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146

Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980

Input Driver ELO Multitouch 3.0.0
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Input Driver ELO Singletouch 5.1.0

Kernel 5.15.26 #mainline-lxos-g1652790891

Xorg X11 Server 21.1.3igel1645782509

Xorg Xephyr 21.1.3igel1645782509

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.500

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.3.5-3ubuntu7.3

NetworkManager 1.32.12-0ubuntu1igel1641211455

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.18.5-1igel1633086114

GStreamer 1.0 Fluendo aacdec 0.10.42

GStreamer 1.0 Fluendo asfdemux 0.10.92

GStreamer 1.0 Fluendo h264dec 0.10.59

GStreamer 1.0 Fluendo mp3dec 0.10.41

GStreamer 1.0 Fluendo mpeg4videodec 0.10.44

GStreamer 1.0 Fluendo vadec 0.10.229

GStreamer 1.0 Fluendo wmadec 0.10.70
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GStreamer 1.0 Fluendo wmvdec 0.10.66

WebKit2Gtk 2.34.6-1igel1645163872

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.32-dfsg-1igel1643178233

Virtualbox X11 Guest Utils 6.1.32-dfsg-1igel1643178233

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.22.1-1igel1646032976

Qemu Guest Agent 6.2+dfsg-3igel1646036781

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.19-1igel1633453264

Mobile Device Access USB (imobile) 1.3.0-6igel12

Mobile Device Access USB (gphoto) 2.5.27-1igel8

VPN OpenConnect 8.20-1igel1645458039

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.32-dfsg-1igel1643178233

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M Included

Java SE Runtime Environment 36.5 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

320.2 M Included

Ericom PowerTerm InterConnect 10.2 M Included
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Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

81.5 M Included

VMware Horizon
RDP

5.5 M Included

Cendio ThinLinc 11.0 M Included

Printing (Internet printing protocol CUPS) 22.2 M Included

NoMachine NX 27.2 M Included

VMware Horizon 243.0 M Included

Voice over IP (Ekiga) 6.5 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M Not included

Fluendo GStreamer Codec Plugins 6.5 M Included

IBM i Access Client Solutions 128.2 M Not included

Red Hat Enterprise Virtualization 2.8 M Included

Parallels Client 6.0 M Included

NVIDIA graphics driver 260.5 M Not included

Imprivata Appliance 14.2 M Included

AppliDis 256.0 K Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 14.2 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.8 M Included

Cisco JVDI client 66.5 M Included

PrinterLogic 47.8 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M Not included

Stratusphere UX CID Key software 7.5 M Not included
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Elastic Filebeat 22.2 M Not included

AVD 113.8 M Included

Local Browser (Chromium) 97.8 M Not included

Amazon WorkSpaces Client 32.2 M Included

deskMate client 5.8 M Included

Cisco Webex VDI 70.8 M Not included

Cisco Webex Meetings VDI 111.5 M Not included

Zoom Media Plugin 124.0 M Not included

DriveLock 13.2 M Included

SpeechWrite Client 256.0 K Included

Fluendo Browser Codec Plugins 4.0 M Included

HP Factory deployment documentation 88.5 M Included

Teradici PCoIP Client 15.5 M Included

90meter Smart Card Support 256.0 K Included

Virtualbox (Limited support)

Mobile Device Access USB (Limited 
support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

Limited Support Features

256.0 K Not included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 65.2 M Not included
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Known Issues 11.07.140

Citrix
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These occur with 
multimedia redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if browser content 
redirection is enabled active.)
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to a 
freeze. Selective H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.

OSC Installer
OSC not deployable with IGEL Deployment Appliance: New version 11.3 is required for 
deployment of IGEL OS 11.06. and later.

AVD
AVD MS-Teams optimization can crash the AVD client if H264 software decoder is used
(fluh264dec). AVD prefers the hardware decoders (fluvadec) but when there are no hardware 
decoders or when all hardware decoders are in use already, the software decoder is utilized, which 
may randomly crash the AVD client. It is likely when it crashes in a certain MS-Teams call, it might 
crash quite soon again when rejoining the same call. A fix for that is under development.
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A workaround is to disable incoming video in such MS-Teams calls, which is an option in the "..." 
menu from the control bar during an active call.
H264 hardware decoding for MS-Teams optimization is currently limited to non-AMD devices
due to stability issues on AMD devices.

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon. 
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session. 
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir 

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only with usage of local layout and 
deadkeys enabled.
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL OS), 
Horizon client falls back to en-US layout.
PCoIP sessions may crash in some cases, switching to Blast Protocol is recommended then. 
H.264/HEVC encoding can be disabled when overall performance is too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadical problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for these devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB redirection which results in an unclean unmount. 
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.



Notes for Release 11.07.140

IGEL OS Release Notes   281 / 1492

•

•
•

•

•

•

•

•

•

•

Firefox
With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.

Network
Wakeup from system suspend fails on DELL Latitude 5510.
If applications are configured to start after established network connection and network mounts 
are configured, spurious "Failed to start application" notifications may be shown. The 
applications still start.

Wi-Fi
TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client
There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system
Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).
Glibc has a serious memcpy performance regression on AMD Zen-based systems.

Conky
The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920).

Firmware Update
On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.
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Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character). 
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'

Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3 M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia
Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.

Remote Management
AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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Security Fixes 11.07.140

VMware Horizon
Updated Horizon Client to version 2203 8.5.0-19586897

Teradici PCoIP Client
Updated Teradici PCoIP Ultra client to version 22.04.

Chromium
Fixed Chromium browser security issues:
More...

CVE-2022-1641, CVE-2022-1640,
CVE-2022-1639, CVE-2022-1638, CVE-2022-1637, CVE-2022-1636, CVE-2022-1635,
CVE-2022-1634, CVE-2022-1633, CVE-2022-1501, CVE-2022-1500, CVE-2022-1499,
CVE-2022-1498, CVE-2022-1497, CVE-2022-1496, CVE-2022-1495, CVE-2022-1494,
CVE-2022-1493, CVE-2022-1492, CVE-2022-1491, CVE-2022-1490, CVE-2022-1489,
CVE-2022-1488, CVE-2022-1487, CVE-2022-1486, CVE-2022-1485, CVE-2022-1484,
CVE-2022-1483, CVE-2022-1482, CVE-2022-1481, CVE-2022-1480, CVE-2022-1479,
CVE-2022-1478, CVE-2022-1477, CVE-2022-1314, CVE-2022-1313, CVE-2022-1312,
CVE-2022-1311, CVE-2022-1310, CVE-2022-1309, CVE-2022-1308, CVE-2022-1307,
CVE-2022-1306, CVE-2022-1305, and CVE-2022-1364

Updated Chromium browser to version 101.0.4951.64

Firefox
Updated Mozilla Firefox to version 91.9.0 ESR
Fixes for mfsa2022-17, also known as 
CVE-2022-29914, CVE-2022-29909, CVE-2022-29916, 
CVE-2022-29911, CVE-2022-29912, CVE-2022-29917.
Fixes for mfsa2022-14, also known as 
CVE-2022-1097, CVE-2022-28281, CVE-2022-1196, CVE-2022-28282, 
CVE-2022-28285, CVE-2022-28286, CVE-2022-24713, CVE-2022-28289.
Fixes for mfsa2022-11, also known as 
CVE-2022-26383, CVE-2022-26384, CVE-2022-26387,
CVE-2022-26381, CVE-2022-26386.

Base system
Fixed curl security issues:
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More...

CVE-2022-2777, CVE-2022-30115, CVE-2022-27782,
CVE-2022-27781, CVE-2022-27780, CVE-2022-27779, 
CVE-2022-27778, CVE-2022-27775, CVE-2022-27774, CVE-2022-22576

Fixed ghostscript security issue CVE-2019-25059.
Fixed libsdl1.2 security issue CVE-2021-33657.
Fixed libsepol security issues CVE-2021-36087, CVE-2021-36086, CVE-2021-36085, and 
CVE-2021-36084.
Fixed bash security issue CVE-2019-18276.
Fixed zulu8-ca security issues:
More...

CVE-2022-21426, CVE-2022-21434, CVE-2022-21443,
CVE-2022-21476, CVE-2022-21496, and CVE-2018-25032

Fixed rsyslog security issue CVE-2022-24903.
Fixed mysql-5.7 security issues:
More...

CVE-2022-21460, CVE-2022-21454, CVE-2022-21451,
CVE-2022-21444, CVE-2022-21427, and CVE-2022-21417

Fixed sqlite3 security issue CVE-2021-36690.
Fixed openssl1.0 security issue CVE-2022-1292.
Fixed openssl security issue CVE-2022-1292.
Fixed dbus security issue CVE-2020-35512.
Fixed nss security issue CVE-2020-25648.
Fixed dnsmasq security issue CVE-2022-0934.
Fixed cifs-utils security issues CVE-2022-29869 and CVE-2022-27239.
Fixed libxml2 security issue CVE-2022-29824.
Fixed cifs-utils security issues CVE-2022-29869 and CVE-2022-27239.
Fixed openldap security issue CVE-2022-29155.
Fixed pcre3 security issues CVE-2020-14155 and CVE-2019-20838.
Fixed tiff security issues:
More...

CVE-2022-0891, CVE-2022-0865, CVE-2022-0562,
CVE-2022-0561, and CVE-2020-35522

Updated Intel microcode to version 20220510.
Updated AMD microcode to version from 20220408.
Fixed security issue CVE-2022-21151.
Fixed sshd security issue CVE-2002-20001 (Denial of Service).
Added new registry key to prevent D(HE)ater CVE-2002-20001 DoS attacks:
More...

Parameter Disable Diffie Hellman key exchange algorithms
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Registry network.ssh_server.disable_dhe_k

exalgorithms

Type bool

Value enabled / disabled 

Fixed Nvidia security issues CVE-2022-28181, CVE-2022-28182, CVE-2022-28183, and 
CVE-2022-28184.
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New Features 11.07.140

ThinLinc
Updated ThinLinc client to version 4.14.0

Chromium
Changed Safe Browsing default value to "enabled".
IGEL Setup Sessions > Chromium Browser > Chromium Browser 

Global > Security

Parameter Safe Browsing

Registry chromiumglobal.app.safebrowsing_enabled

Type bool

Value enabled / disabled

Smartcard
Added support for concurrent usage of multiple smartcard middleware libraries for 
authentication with a smartcard to Active Directory / Kerberos and Citrix.
In the Setup on page Security > Smartcard > Middleware, multiple libraries can be activated. If 
none is activated, OpenSC is taken as fallback.

Cisco Webex
Integrated Cisco WebEx VDI plugin 42.4.0.21893

zoomvdi
Integrated Zoom VDI plugin 5.10.0.21068
Available plugins in this release: 5.10.0.21068 (default), 5.9.6.20931, and 5.4.59458

TC Setup (Java)
Updated TC Setup to version 6.10.2
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Resolved Issues 11.07.140

Citrix
Added parameter for Citrix Workspace app 2203 Keyboard sync feature:

Parameter to configure new KeyboardSyncMode as following.
Windows Server may require config as well, further information via https://
docs.citrix.com/en-us/citrix-workspace-app-for-linux/configure-xenapp.html#keyboard-
layout-synchronization:
More...

Parameter Configure KeyboardSyncMode

Registry ica.wfclient.keyboardsyncmode

Value  no  / dynamic / once

Note no – indicates that the client uses the keyboard layout 
present on the server.

dynamic – synchronizes the client keyboard layout to 
the server when client keyboard layout is changed.

once – when session launches

to configure new KeyboardEventMode:
More...

Parameter Configure KeyboardEventMode

Registry ica.wfclient.keyboardeventmode

Value Unicode / Scancode

Note Citrix recommends "Scancode" for 
KeyboardSyncMode=no 
and 
"Unicode" for the other values.

RDP/IGEL RDP Client 2
Fixed RDP drive redirection redirecting the same drive twice if storage hotplug is set to static.

RD Web Access
Fixed RD Web ignoring RD Gateway when starting apps from browser.

https://docs.citrix.com/en-us/citrix-workspace-app-for-linux/configure-xenapp.html#keyboard-layout-synchronization
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Chromium
Fixed an issue with the startup URL containing a '&' character.

Network
Fixed 802.1X authentication method PEAP-TLS - was broken since 11.07.100 due to 
incompatibility with Network Manager 1.32.

Application Launcher
Fixed application launcher starting multiple times if auto-restart was enabled.

Base system
Fixed non-working DRM/KMS driver on Zebra ET51 tablet.
Fixed downgrading from 11.07. to 11.05. firmware versions
Fixed XServer startup for Device Encryption login screen on devices with Intel-powered 
graphics, such as H830.

Driver
Added bluetooth driver for Realtek RTL8852BE device.

X11 system
Add option to force special handling of Nvidia graphics cards.
More...

Parameter Force X injected DRM data with nvidia driver

Registry x.drivers.nvidia.force_quack

Value enabled / disabled

X server
Fixed detection of some Nvidia Quadro T400 graphic cards.

Remote Management
Deallocate resources used for Websocket connection after closing the connection.
Added parameter to control ICG reconnecting:
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More...

Parameter Reconnect Interval (seconds)

Registry system.remotemanager.reconnect_interva

l

Value 20 (default)
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Notes for Release 11.07.110
Software: Version 11.07.110

Release Date: 2022-04-29

Release Notes: Version RN-1107110-1

Last update: 2022-04-29

Supported Devices 11.07.110 (see page 291)
Component Versions 11.07.110 (see page 292)
Known Issues 11.07.110 (see page 300)
Security Fixes 11.07.110 (see page 304)
New Features 11.07.110 (see page 305)
Resolved Issues 11.07.110 (see page 307)

The Release Notes for IGEL OS 11.07.110 are also available in the following formats:

Plain text: RNs_1107110.txt
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Supported Devices 11.07.110
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.07.110

Clients
Product Version

Amazon WorkSpaces Client 3.1.9

Chromium 100.0.4896.75-igel1649171874

Cisco JVDI Client 14.1.0

Cisco Webex VDI plugin 42.2.0.21338

Cisco Webex Meetings VDI plugin 41.10.11.5

Cisco Webex Meetings VDI plugin 42.2.4.12

Cisco Webex Meetings VDI plugin 42.3.1.12

Zoom Media Plugin 5.4.59458

Zoom Media Plugin 5.8.4.21112

Zoom Media Plugin 5.9.6.20931

Citrix HDX Realtime Media Engine 2.9.400

Citrix Workspace App 20.10.0.6

Citrix Workspace App 22.02.0.20

Citrix Workspace App 22.03.0.24

deviceTRUST Citrix Channel 20.2.310.0

Crossmatch DP Citrix Channel 0125

deskMate Client 2.1.3

DriveLock Agent 20.1.4.30482

Ericom PowerTerm 14.0.1.62267

Evidian AuthMgr 1.5.7789

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech Plugins 3.8.0

FabulaTech USB for Remote Desktop 6.0.35

FabulaTech Scanner for Remote Desktop 2.7.0.1
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FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 91.6.1

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1648540238

IGEL AVD Client 1.0.99.7igel1651063614

deviceTRUST RDP Channel 20.2.310.0

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

Lakeside SysTrack Channel 9.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628

Open VPN 2.5.6-1igel1647855849

Zulu JRE 8.0.322-1

Parallels Client  18.3.1

Spice GTK (Red Hat Virtualization) 0.39-3igel1633543285

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.0-3

Systancia AppliDis 6.0.0-4

Teradici PCoIP Software Client 21.03.0-18.04

ThinLinc Client 4.13.0-2172

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 4.16.0-1igel1611217037

VNC Viewer 11.12.0+dfsg-3igel1644994551 

VMware Horizon Client 2111.1-8.4.1-19480456

Voip Client Ekiga 4.0.1-9build1igel6
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Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.2

Philips Speech driver 13.1.10

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.28

PKCS#11 Library OpenSC 0.22.0-2igel1643799581

PKCS#11 Library SecMaker NetID Enterprise 6.8.3.21

PKCS#11 Library SecMaker NetID Client 1.0.2.67

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.5.0-2igel1646035471
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Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.5-3igel1646034250

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.8

OpenSSL 1.1.1-1ubuntu2.1~18.04.15

OpenSSH Client 8.9p1-3igel1646033299

OpenSSH Server 8.9p1-3igel1646033299

Bluetooth stack (bluez) 5.64-0igel1647863644

MESA OpenGL stack 21.3.7-1igel1646288715

VAAPI ABI Version 0.40

VDPAU Library version 1.4-3igel1099

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046

Graphics Driver ATI/RADEON 19.1.0-2igel1629135948

Graphics Driver ATI/AMDGPU 22.0.0-1igel1645768768

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678

Graphics Driver Nvidia 470.103.01-0ubuntu0.21.10.1

Graphics Driver VMware 13.3.0-3igel1628859075

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534

Graphics Driver FBDEV 0.5.0-2igel1644486279

Graphics Driver VESA 2.5.0-1igel1628504011

Input Driver Evdev 2.10.6-2igel1629196047

Input Driver Elographics 1.4.2-1igel1629196349

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146

Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980

Input Driver ELO Multitouch 3.0.0
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Input Driver ELO Singletouch 5.1.0

Kernel 5.15.26 #mainline-lxos-g1647514766

Xorg X11 Server 21.1.3igel1645782509

Xorg Xephyr 21.1.3igel1645782509

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.500

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.3.5-3ubuntu7.3

NetworkManager 1.32.12-0ubuntu1igel1641211455

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.18.5-1igel1633086114

GStreamer 1.0 Fluendo aacdec 0.10.42

GStreamer 1.0 Fluendo asfdemux 0.10.92

GStreamer 1.0 Fluendo h264dec 0.10.59

GStreamer 1.0 Fluendo mp3dec 0.10.41

GStreamer 1.0 Fluendo mpeg4videodec 0.10.44

GStreamer 1.0 Fluendo vadec 0.10.229

GStreamer 1.0 Fluendo wmadec 0.10.70
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GStreamer 1.0 Fluendo wmvdec 0.10.66

WebKit2Gtk 2.34.6-1igel1645163872

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.32-dfsg-1igel1643178233

Virtualbox X11 Guest Utils 6.1.32-dfsg-1igel1643178233

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.22.1-1igel1646032976

Qemu Guest Agent 6.2+dfsg-3igel1646036781

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.19-1igel1633453264

Mobile Device Access USB (imobile) 1.3.0-6igel12

Mobile Device Access USB (gphoto) 2.5.27-1igel8

VPN OpenConnect 8.20-1igel1645458039

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.32-dfsg-1igel1643178233

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M Included

Java SE Runtime Environment 36.5 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

320.2 M Included

Ericom PowerTerm InterConnect 10.2 M Included
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Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

81.8 M Included

VMware Horizon
RDP

5.5 M Included

Cendio ThinLinc 10.0 M Included

Printing (Internet printing protocol CUPS) 22.2 M Included

NoMachine NX 27.2 M Included

VMware Horizon 216.2 M Included

Voice over IP (Ekiga) 6.5 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M Not included

Fluendo GStreamer Codec Plugins 6.5 M Included

IBM i Access Client Solutions 128.2 M Not included

Red Hat Enterprise Virtualization 2.8 M Included

Parallels Client 6.0 M Included

NVIDIA graphics driver 261.0 M Not included

Imprivata Appliance 14.2 M Included

AppliDis 256.0 K Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 14.2 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.8 M Included

Cisco JVDI client 66.5 M Included

PrinterLogic 47.8 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M Not included

Stratusphere UX CID Key software 7.5 M Not included
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Elastic Filebeat 22.2 M Not included

AVD 113.8 M Included

Local Browser (Chromium) 94.2 M Not included

Amazon WorkSpaces Client 32.2 M Included

deskMate client 5.8 M Included

Cisco Webex VDI 60.0 M Not included

Cisco Webex Meetings VDI 111.5 M Not included

Zoom Media Plugin 127.8 M Not included

DriveLock 13.2 M Included

SpeechWrite Client 256.0 K Included

Fluendo Browser Codec Plugins 4.0 M Included

HP Factory deployment documentation 88.5 M Included

Teradici PCoIP Client 16.0 M Included

90meter Smart Card Support 256.0 K Included

Virtualbox (Limited support)

Mobile Device Access USB (Limited 
support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

Limited Support Features

256.0 K Not included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 65.2 M Not included
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Known Issues 11.07.110

Citrix
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These occur with 
multimedia redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if browser content 
redirection is enabled active.)
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to a 
freeze. Selective H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.

OSC Installer
OSC not deployable with IGEL Deployment Appliance: New version 11.3 is required for 
deployment of IGEL OS 11.06. and later.

AVD
AVD MS-Teams optimization can crash the AVD client if H264 software decoder is used
(fluh264dec). AVD prefers the hardware decoders (fluvadec) but when there are no hardware 
decoders or when all hardware decoders are in use already, the software decoder is utilized, which 
may randomly crash the AVD client. It is likely when it crashes in a certain MS-Teams call, it might 
crash quite soon again when rejoining the same call. A fix for that is under development.
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A workaround is to disable incoming video in such MS-Teams calls, which is an option in the "..." 
menu from the control bar during an active call.
H264 hardware decoding for MS-Teams optimization is currently limited to non-AMD devices
due to stability issues on AMD devices.

VMware Horizon
After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon. 
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session. 
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir 

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only when using a local layout with 
deadkeys enabled. 
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL OS), 
Horizon client falls back to en-US layout.
PCoIP sessions may crash in some cases, switching to Blast Protocol is recommended then. 
H.264/HEVC encoding can be disabled when overall performance is too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadical problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for these devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB redirection which results in an unclean unmount. 
As a workaround, the IDs of these card readers can be added to IGEL USB access rules and denied.

Parallels Client
Attached storage devices appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.
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Firefox
With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.

Network
Wakeup from system suspend fails on DELL Latitude 5510.
If applications are configured to start after established network connection and network mounts 
are configured, spurious "Failed to start application" notifications may be shown. The 
applications still start.

Wi-Fi
TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client
There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system
Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).

Conky
The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920).

Firmware Update
On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.
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Appliance Mode
When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character). 
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'

Audio
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3 M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia
Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hardware
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.

Remote Management
AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.

https://www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch
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Security Fixes 11.07.110

Chromium
Fixed security issue CVE-2022-1096.
Fixed security issues:
CVE-2022-1232, CVE-2022-1146, CVE-2022-1145,
CVE-2022-1144, CVE-2022-1143, CVE-2022-1142, CVE-2022-1141, CVE-2022-1139,
CVE-2022-1138, CVE-2022-1137, CVE-2022-1136, CVE-2022-1135, CVE-2022-1134,
CVE-2022-1133, CVE-2022-1132, CVE-2022-1131, CVE-2022-1130, CVE-2022-1129,
CVE-2022-1128, CVE-2022-1127, and CVE-2022-1125
Updated Chromium browser to version 100.0.4896.75

Base system
Fixed kernel security issues CVE-2022-1015 and CVE-2022-1016.
Fixed python2.7 security issues CVE-2022-0391 and CVE-2021-4189.
Fixed python3.6 security issues CVE-2022-0391, CVE-2021-4189, and CVE-2021-3426.
Fixed zlib security issue CVE-2018-25032.
Fixed rsync security issue CVE-2018-25032.
Fixed paramiko security issue CVE-2022-24302.
Fixed xz-utils security issue CVE-2022-1271.
Fixed tcpdump security issues CVE-2020-8037 and CVE-2018-16301.
Fixed gzip security issue CVE-2022-1271.
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New Features 11.07.110

Citrix
Integrated Citrix Workspace App 2203.
Available Citrix Workspace apps in this release: 2203 (default), 2202 and 2010
Added registry keys for Citrix Workspace App 2203:

for configuring the new KeyboardSyncMode. Windows Server may require config, 
see https://docs.citrix.com/en-us/citrix-workspace-app-for-linux/configure-
xenapp.html#keyboard-layout-synchronization
More...

Parameter Configure KeyboardSyncMode

Registry ica.wfclient.keyboardsyncmode

Value no / dynamic / once

Note: no - Indicates that the client uses the keyboard layout 
present on the server.

dynamic - This option synchronizes the client keyboard 
layout to the server when you change the client keyboard 
layout.

once - when the session launches

for configuring new KeyboardEventMode:
More...

Parameter Configure KeyboardEventMode

Registry ica.wfclient.keyboardeventmode

Value Unicode/ Scancode

Note: Citrix recommends "Scancode" for 
KeyboardSyncMode=no
and "Unicode" for the other values.  

Fixed implementation for DNSCacheEnabled.

AVD
Updated AVD client to version 1.0.99.7
Added and enabled MS-Teams optimization

https://docs.citrix.com/en-us/citrix-workspace-app-for-linux/configure-xenapp.html#keyboard-layout-synchronization
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VMware Horizon
Added system-wide handler to start links which use the vmware-view protocol.
View session can now be started by Chromium or any other application which uses xdg-open.
Updated Horizon Client to version 2111.1-8.4.1-19480456 which fixes the typematic (key-
repeat) issue

Wi-Fi
Added support for Realtek 8852be WiFi cards.

Cisco JVDI Client
Updated Cisco JVDI to version 14.1.0

Base system
Added new field netmask to SystemInformationLog - only relevant for specific customer.

zoomvdi
Updated Zoom Media Plugin to version 5.9.6.20931 
Available Zoom Media Plugins in this release: 5.4.59458, 5.8.4.21112, and 5.9.6.20931



Notes for Release 11.07.110

IGEL OS Release Notes   307 / 1492

•

•

•
•

•

•

•

Resolved Issues 11.07.110

Citrix
Fix for Self-Service enumeration problem with consecutive users when Multi user is off. 
Introduced new parameters to enable cleanup after Self-Service termination:
More...

Parameter Clean up UI cache after Self-Service termination

Registry ica.selfservice.cleanupwebui

Value false / true

Parameter Clean up Store cache after Self-Service termination

Registry ica.selfservice.cleanupstore

Value false / true

RD Web Access
Fixed RD Web Access autostart error.

Chromium
Fixed custom downloads not working when the path was invalid 
Fixed 'custom location' for Chromium Browser downloads

Imprivata
Fixed VMware disconnect delay

HID
Fixed issues with non working touchpads, touchscreens, and multimedia keys.

CUPS Printing
Fixed printer selection by pattern where manufacturer or product pattern could be left empty.
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Base system
Fixed loss of settings on certain hardware devices after update from a 11.05.xxx or older 
firmware version.
Fixed reliability of power off in case UD Pocket stick is removed.
Fixed / stabilized factory reset with enabled device encryption.

Driver
Fixed Olympus Dictation devices DS-5000, DS-7000, and DS-9500 buttons disturbing client side 
window handling.

Hardware
Fixed non working Bluetooth with Mediatek MT7961.
Fixed issue with suspend/resume on Lenovo K14 Gen1 with Mediatek WiFi card.

Remote Management
Reduced UMS communication load for asset inventory tracker (AIT) feature.
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Notes for Release 11.07.100
Software: Version 11.07.100

Release Date: 2022-03-29

Release Notes: Version RN-1107100-1

Last update: 2022-03-29

Supported Devices 11.07.100 (see page 310)
Component Versions 11.07.100 (see page 311)
Known Issues 11.07.100 (see page 319)
Security Fixes 11.07.100 (see page 322)
New Features 11.07.100 (see page 326)
Resolved Issues 11.07.100 (see page 333)

The Release Notes for IGEL OS 11.07.100 are also available in the following formats:

Plain text:  RNs_1107100.txt
HTML: lxos_11.07.100.html
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Supported Devices 11.07.100
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.07.100

Clients
Product Version

Amazon WorkSpaces Client 3.1.9

Chromium 99.0.4844.74-igel1647438342

Cisco JVDI Client 14.0.3

Cisco Webex VDI plugin 42.2.0.21338

Cisco Webex Meetings VDI plugin 41.10.11.5

Cisco Webex Meetings VDI plugin 42.2.4.12

Cisco Webex Meetings VDI plugin 42.3.1.12

Zoom Media Plugin 5.4.59458

Zoom Media Plugin 5.8.4.21112

Zoom Media Plugin 5.9.0.20720

Citrix HDX Realtime Media Engine 2.9.400

Citrix Workspace App 20.10.0.6

Citrix Workspace App 21.11.0.20

Citrix Workspace App 21.12.0.18

deviceTRUST Citrix Channel 20.2.310.0

Crossmatch DP Citrix Channel 0125

deskMate Client 2.1.3

DriveLock Agent 20.1.4.30482

Ericom PowerTerm 14.0.1.62267

Evidian AuthMgr 1.5.7789

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech Plugins 3.8.0

FabulaTech USB for Remote Desktop 6.0.35

FabulaTech Scanner for Remote Desktop 2.7.0.1
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FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 91.6.1

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1643693920 

IGEL AVD Client 1.0.39igel1646773894

deviceTRUST RDP Channel 20.2.310.0

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

Lakeside SysTrack Channel 9.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.8.2-4igel1644853628

Open VPN 2.5.6-1igel1647855849

Zulu JRE 8.0.322-1

Parallels Client  18.3.1

Spice GTK (Red Hat Virtualization) 0.39-3igel1633543285

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.11.0-2igel1633506980

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.6.0-3

Systancia AppliDis 6.0.0-4

Teradici PCoIP Software Client 21.03.0-18.04

ThinLinc Client 4.13.0-2172

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 4.16.0-1igel1611217037

VNC Viewer 1.12.0+dfsg-3igel1644994551

VMware Horizon Client 2111-8.4.0-18957622

Voip Client Ekiga 4.0.1-9build1igel6
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Dictation
Diktamen driver for dictation 2017/09/29

Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.2

Philips Speech driver 13.1.10

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.10

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902

PKCS#11 Library cryptovision sc/interface 8.0.13

PKCS#11 Library Thales SafeNet 10.8.28

PKCS#11 Library OpenSC 0.22.0-2igel1643799581

PKCS#11 Library SecMaker NetID Enterprise 6.8.3.21

PKCS#11 Library SecMaker NetID Client 1.0.2.67

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.5.0-2igel1646035471
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Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.5-3igel1646034250

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.8

OpenSSL 1.1.1-1ubuntu2.1~18.04.15

OpenSSH Client 8.9p1-3igel1646033299

OpenSSH Server 8.9p1-3igel1646033299

Bluetooth stack (bluez) 5.64-0igel1647863644

MESA OpenGL stack 21.3.7-1igel1646288715

VAAPI ABI Version 0.40

VDPAU Library version 1.4-3igel1099

Graphics Driver INTEL 2.99.917+git20210115-1igel1647326046

Graphics Driver ATI/RADEON 19.1.0-2igel1629135948

Graphics Driver ATI/AMDGPU 22.0.0-1igel1645768768

Graphics Driver Nouveau (Nvidia Legacy) 1.0.17-2igel1644486678

Graphics Driver Nvidia 470.103.01-0ubuntu0.21.10.1

Graphics Driver VMware 13.3.0-3igel1628859075

Graphics Driver QXL (Spice) 0.1.5-2build1igel1634304534

Graphics Driver FBDEV 0.5.0-2igel1644486279

Graphics Driver VESA 2.5.0-1igel1628504011

Input Driver Evdev 2.10.6-2igel1629196047

Input Driver Elographics 1.4.2-1igel1629196349

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-2igel1646823146

Input Driver VMMouse 13.1.0-1ubuntu2igel1628499891

Input Driver Wacom 0.39.0-0ubuntu1igel1629136980

Input Driver ELO Multitouch 3.0.0
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Input Driver ELO Singletouch 5.1.0

Kernel 5.15.26 #mainline-lxos-g1647852051

Xorg X11 Server 21.1.3igel1645782509

Xorg Xephyr 21.1.3igel1645782509

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.500

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14

XFCE4 Window Manager 4.14.5-1~18.04igel1643191202

ISC DHCP Client 4.3.5-3ubuntu7.3

NetworkManager 1.32.12-0ubuntu1igel1641211455

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.18.5-1igel1633086114

GStreamer 1.0 Fluendo aacdec 0.10.42

GStreamer 1.0 Fluendo asfdemux 0.10.92

GStreamer 1.0 Fluendo h264dec 0.10.59

GStreamer 1.0 Fluendo mp3dec 0.10.41

GStreamer 1.0 Fluendo mpeg4videodec 0.10.44

GStreamer 1.0 Fluendo vadec 0.10.229

GStreamer 1.0 Fluendo wmadec 0.10.70
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GStreamer 1.0 Fluendo wmvdec 0.10.66

WebKit2Gtk 2.34.6-1igel1645163872

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.32-dfsg-1igel1643178233

Virtualbox X11 Guest Utils 6.1.32-dfsg-1igel1643178233

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.22.1-1igel1646032976

Qemu Guest Agent 6.2+dfsg-3igel1646036781

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.19-1igel1633453264

Mobile Device Access USB (imobile) 1.3.0-6igel12

Mobile Device Access USB (gphoto) 2.5.27-1igel8

VPN OpenConnect 8.20-1igel1645458039

Scanner support 1.0.27-1

VirtualBox VM within IGEL OS 6.1.32-dfsg-1igel1643178233

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M Included

Java SE Runtime Environment 36.5 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

311.0 M Included

Ericom PowerTerm InterConnect 10.2 M Included
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Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

81.8 M Included

VMware Horizon
RDP

5.5 M Included

Cendio ThinLinc 10.0 M Included

Printing (Internet printing protocol CUPS) 22.2 M Included

NoMachine NX 27.2 M Included

VMware Horizon 216.2 M Included

Voice over IP (Ekiga) 6.5 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M Not included

Fluendo GStreamer Codec Plugins 6.5 M Included

IBM i Access Client Solutions 128.2 M Not included

Red Hat Enterprise Virtualization 2.8 M Included

Parallels Client 6.0 M Included

NVIDIA graphics driver 261.0 M Not included

Imprivata Appliance 14.2 M Included

AppliDis 256.0 K Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 14.2 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.8 M Included

Cisco JVDI client 66.2 M Included

PrinterLogic 47.8 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M Not included

Stratusphere UX CID Key software 7.5 M Not included
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Elastic Filebeat 22.2 M Not included

AVD 105.8 M Included

Local Browser (Chromium) 94.2 M Not included

Amazon WorkSpaces Client 32.2 M Included

deskMate client 5.8 M Included

Cisco Webex VDI 60.0 M Not included

Cisco Webex Meetings VDI 111.5 M Not included

Zoom Media Plugin 127.8 M Not included

DriveLock 13.2 M Included

SpeechWrite Client 256.0 K Included

Fluendo Browser Codec Plugins 4.0 M Included

HP Factory deployment documentation 88.5 M Included

Teradici PCoIP Client 16.0 M Included

90meter Smart Card Support 256.0 K Included

Virtualbox (Limited support)

Mobile Device Access USB (Limited 
support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

Limited Support Features

256.0 K Not included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 65.2 M Not included
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Known Issues 11.07.100
Citrix

To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 in combination with Citrix. These occur with 
multimedia redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if browser content 
redirection is enabled active.)
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec enabled.
Enabled DRI3 on an AMD GPU with enabled Citrix H.264 acceleration could lead to a 
freeze. Selective H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
Currently, H.264 for Citrix sessions cannot be used in parallel with video input acceleration.

OSC Installer

OSC not deployable with IGEL Deployment Appliance: New version 11.3 is required for 
deployment of IGEL OS 11.06. and later.

VMware Horizon

After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon. 
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide
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Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session. 
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir 

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only when using a local layout with 
deadkeys enabled. 
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL OS), 
Horizon client falls back to en-US layout.
PCoIP sessions may crash in some cases, switching to Blast Protocol is recommended then. 
H.264/HEVC encoding can be disabled when overall performance is too low.
Client drive mapping and USB redirection for storage devices can be enabled at the same time, 
but this could lead to sporadical problems.
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, means USB redirection is not used for these devices then.
However, in case of devices like USB SD card readers, Horizon does not map them as client drives 
but forcefully uses USB redirection which results in an unclean unmount. 
As a work-around, the IDs of these card readers can be added to IGEL USB access rules and 
denied.

Parallels Client

Attached storage devices appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.

Firefox

With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.

Network

Wakeup from system suspend fails on DELL Latitude 5510.

Wi-Fi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client

There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system
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Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are triggered / necessary).

Conky

The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920).

Firmware update

On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode

When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character). 
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'

Audio

IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3-M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hardware

Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.

Remote Management

AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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Security Fixes 11.07.100
Chromium

Fixed chromium-browser security issues:
More...

CVE-2021-37973, CVE-2021-37972,
CVE-2021-37971, CVE-2021-37970, CVE-2021-37969, CVE-2021-37968,
CVE-2021-37967, CVE-2021-37966, CVE-2021-37965, CVE-2021-37964,
CVE-2021-37963, CVE-2021-37962, CVE-2021-37961, CVE-2021-37960,
CVE-2021-37959, CVE-2021-37958, CVE-2021-37957, CVE-2021-37956,
CVE-2021-30633, CVE-2021-30632, CVE-2021-30631, CVE-2021-30630,
CVE-2021-30629, CVE-2021-30628, CVE-2021-30627, CVE-2021-30626,
CVE-2021-30625, CVE-2021-30624, CVE-2021-30623, CVE-2021-30622,
CVE-2021-30621, CVE-2021-30620, CVE-2021-30619, CVE-2021-30618,
CVE-2021-30617, CVE-2021-30616, CVE-2021-30615, CVE-2021-30614,
CVE-2021-30613, CVE-2021-30612, CVE-2021-30611, CVE-2021-30610,
CVE-2021-30609, CVE-2021-30608, CVE-2021-30607, CVE-2021-30606,
CVE-2021-30604, CVE-2021-30603, CVE-2021-30602, CVE-2021-30601,
CVE-2021-30600, CVE-2021-30599, CVE-2021-30598, CVE-2021-30597,
CVE-2021-30596, CVE-2021-30594, CVE-2021-30593, CVE-2021-30592,
CVE-2021-30591, CVE-2021-30590, CVE-2021-30589, CVE-2021-30588,
CVE-2021-30587, CVE-2021-30586, CVE-2021-30585, CVE-2021-30584,
CVE-2021-30583, CVE-2021-30582, CVE-2021-30581, CVE-2021-30580,
CVE-2021-30579, CVE-2021-30578, CVE-2021-30577, CVE-2021-30576,
CVE-2021-30575, CVE-2021-30574, CVE-2021-30573, CVE-2021-30572,
CVE-2021-30571, CVE-2021-30569, CVE-2021-30568, CVE-2021-30567,
CVE-2021-30566, CVE-2021-30565, CVE-2021-37976, CVE-2021-37975,
CVE-2021-37974, CVE-2021-37977, CVE-2021-37979, CVE-2021-37980,
CVE-2021-37981, CVE-2021-37982, CVE-2021-37983, CVE-2021-37984,
CVE-2021-37985, CVE-2021-37986, CVE-2021-37987, CVE-2021-37988,
CVE-2021-37989, CVE-2021-37990, CVE-2021-37991, CVE-2021-37992,
CVE-2021-37993, CVE-2021-37996, CVE-2021-37994, CVE-2021-37995,
CVE-2021-38003, CVE-2021-38002, CVE-2021-38001, CVE-2021-38000,
CVE-2021-37999, CVE-2021-37998, and CVE-2021-37997

Base system

Fixed binutils security issues CVE-2021-3487 and CVE-2020-16592.
Fixed bind9 security issues CVE-2021-25219 and CVE-2021-25220.
Fixed libcaca security issues CVE-2021-30499 and CVE-2021-30498.
Fixed icu security issue CVE-2020-21913.
Fixed mysql-5.7 security issues:
More...

CVE-2021-35624, CVE-2021-35604, CVE-2022-21367,
CVE-2022-21344, CVE-2022-21304, CVE-2022-21303,
CVE-2022-21270, and CVE-2022-21245

Fixed postgresql-10 security issues CVE-2021-23222 and CVE-2021-23214.
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Fixed nfs-utils security issue CVE-2019-3689.
Fixed openssh security issue CVE-2021-41617.
Fixed qemu security issues:
More...

CVE-2021-3748, CVE-2021-3713, CVE-2021-3682,
CVE-2021-3638, CVE-2021-3608, CVE-2021-3607, CVE-2021-3582, CVE-2021-3546,
CVE-2021-3545, CVE-2021-3544, CVE-2021-3527, CVE-2021-3416, CVE-2021-3409,
CVE-2021-3392, CVE-2021-20263, CVE-2021-20257, CVE-2021-20221, CVE-2021-20181,
CVE-2020-35517, CVE-2020-35506, CVE-2020-35505, CVE-2020-35504,
CVE-2020-29443, CVE-2020-25085, CVE-2020-17380, CVE-2021-20203,
CVE-2021-20196, CVE-2021-20255, and CVE-2021-4158

Fixed tpm2-tools security issue CVE-2021-3565.
Fixed chromium-browser security issues:
More...

CVE-2021-38022, CVE-2021-38021,
CVE-2021-38020, CVE-2021-38019, CVE-2021-38018, CVE-2021-38017,
CVE-2021-38016, CVE-2021-38015, CVE-2021-38014, CVE-2021-38013,
CVE-2021-38012, CVE-2021-38011, CVE-2021-38010, CVE-2021-38009,
CVE-2021-38008, CVE-2021-38007, CVE-2021-38006, CVE-2021-38005, CVE-2021-4102,
CVE-2021-4101, CVE-2021-4100, CVE-2021-4099, CVE-2021-4098, CVE-2021-4078,
CVE-2021-4068, CVE-2021-4066, CVE-2021-4065, CVE-2021-4064, CVE-2021-4063,
CVE-2021-4062, CVE-2021-4059, CVE-2021-4058, CVE-2021-4057, CVE-2021-4056,
CVE-2021-4055, CVE-2021-4054, CVE-2021-4053, CVE-2021-4052, CVE-2022-0120,
CVE-2022-0118, CVE-2022-0117, CVE-2022-0116, CVE-2022-0115, CVE-2022-0114,
CVE-2022-0113, CVE-2022-0112, CVE-2022-0111, CVE-2022-0110, CVE-2022-0109,
CVE-2022-0108, CVE-2022-0107, CVE-2022-0106, CVE-2022-0105, CVE-2022-0104,
CVE-2022-0103, CVE-2022-0102, CVE-2022-0101, CVE-2022-0100, CVE-2022-0099,
CVE-2022-0098, CVE-2022-0097, CVE-2022-0096, CVE-2022-0311, CVE-2022-0310,
CVE-2022-0309, CVE-2022-0308, CVE-2022-0307, CVE-2022-0306, CVE-2022-0305,
CVE-2022-0304, CVE-2022-0302, CVE-2022-0301, CVE-2022-0300, CVE-2022-0298,
CVE-2022-0297, CVE-2022-0296, CVE-2022-0295, CVE-2022-0294, CVE-2022-0293,
CVE-2022-0292, CVE-2022-0291, CVE-2022-0290, CVE-2022-0289, CVE-2022-0980,
CVE-2022-0979, CVE-2022-0978, CVE-2022-0977, CVE-2022-0976, CVE-2022-0975,
CVE-2022-0974, CVE-2022-0973, CVE-2022-0972, and CVE-2022-0971

Fixed vim security issues:
More...

CVE-2021-3928, CVE-2021-3927, CVE-2021-3903,
CVE-2021-4069, CVE-2021-4019, and CVE-2021-3984

Fixed hivex security issue CVE-2021-3504.
Fixed heimdal security issue CVE-2021-3671.
Fixed nss security issue CVE-2021-43527.
Fixed glib2.0 security issue CVE-2021-3800.
Fixed python3.6 security issues CVE-2021-3737 and CVE-2021-3733.
Fixed samba security issues:
More...
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CVE-2021-3671, CVE-2020-25722, CVE-2020-25717,
CVE-2016-2124, and CVE-2021-44142

Fixed xorg-server security issues CVE-2021-4011, CVE-2021-4010, CVE-2021-4009, and 
CVE-2021-4008.
Fixed webkit2gtk security issues:
More...

CVE-2021-30809, CVE-2021-30836, CVE-2021-30818, CVE-2021-30823,
CVE-2021-30884, CVE-2021-30888, CVE-2021-30889, CVE-2021-30897,
CVE-2021-30887, CVE-2021-30890, CVE-2021-45482, CVE-2021-45481, 
CVE-2021-45483, CVE-2021-30934, CVE-2021-30936, CVE-2021-30951, 
CVE-2021-30952, CVE-2021-30953, CVE-2021-30954, CVE-2021-30984, 
CVE-2022-22592, CVE-2022-22590, CVE-2022-22589, and CVE-2022-22620

Fixed policykit-1 security issue CVE-2021-4034.
Fixed bluez security issues CVE-2021-43400 and CVE-2021-41229.
Fixed ghostscript security issues CVE-2021-45949 and CVE-2021-45944.
Fixed lxml security issue CVE-2021-43818.
Fixed pillow security issues:
More...

CVE-2022-22817, CVE-2022-22816, CVE-2022-22815,
CVE-2021-34552, and CVE-2021-23437

Fixed systemd security issue CVE-2021-3997.
Fixed bubblewrap security issue CVE-2020-5291.
Fixed libgcrypt20 security issues CVE-2021-40528, CVE-2021-33560, and CVE-2019-13627.
Fixed ntfs-3g security issues:
More...

CVE-2021-39263, CVE-2021-39262, CVE-2021-39261,
CVE-2021-39260, CVE-2021-39259, CVE-2021-39258, CVE-2021-39257,
CVE-2021-39256, CVE-2021-39255, CVE-2021-39254, CVE-2021-39253,
CVE-2021-39252, CVE-2021-39251, CVE-2021-35269, CVE-2021-35268,
CVE-2021-35267, CVE-2021-35266, CVE-2021-33289, CVE-2021-33287,
CVE-2021-33286, and CVE-2021-33285

Fixed cifs-utils security issues CVE-2021-20208 and CVE-2020-14342.
Fixed qtsvg-opensource-src security issues CVE-2021-45930, CVE-2021-3481, and CVE-2018-19869.
Fixed shadow security issue CVE-2018-7169.
Fixed ldns security issues CVE-2020-19861 and CVE-2020-19860.
Fixed expat security issues:
More...

CVE-2022-23990, CVE-2022-23852, CVE-2022-22827,
CVE-2022-22826, CVE-2022-22825, CVE-2022-22824, CVE-2022-22823,
CVE-2022-22822, CVE-2021-46143, CVE-2021-45960, CVE-2019-15903,
CVE-2018-20843, CVE-2013-0340, CVE-2022-25315, CVE-2022-25314,
CVE-2022-25313, CVE-2022-25236, and CVE-2022-25235

Fixed libvirt security issues CVE-2021-4147 and CVE-2021-3667.
Fixed libproxy security issues CVE-2020-26154 and CVE-2020-25219.
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Fixed libssh security issues:
More...

CVE-2020-1730, CVE-2019-14889, CVE-2018-10933,
CVE-2021-3634, and CVE-2020-16135

Fixed speex security issue CVE-2020-23903.
Fixed libxml2 security issue CVE-2022-23308.
Fixed cyrus-sasl2 security issue CVE-2022-24407.
Fixed glibc security issues:
More...

CVE-2022-23219, CVE-2022-23218, CVE-2021-3999,
CVE-2021-35942, CVE-2021-3326, CVE-2021-27645, CVE-2020-6096, CVE-2020-29562,
CVE-2020-27618, CVE-2019-25013, and CVE-2016-10228

Fixed openssl1.0 security issue CVE-2022-0778.
Fixed openssl security issue CVE-2022-0778.
Fixed tar security issue CVE-2021-20193.
Fixed openvpn security issue CVE-2022-0547.
Fixed duplicated User IDs.
Fixed kernel security issue CVE-2022-0847, also known as Dirty Pipe.
Fixed security issues CVE-2021-0127 and CVE-2021-0146 via updated intel-microcode to version 
20220207
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New Features 11.07.100
Citrix

Changed: For Browser Content Redirection, the Chromium Embedded Framework is used by 
default now - Parameter ica.allregions.usecefbrowser  is set to true (as default).
Added Citrix Workspace App 2112
Available Citrix Workspace Apps in this release: 2112 (default), 2111, and 2010
New features:

The cursor color inverts based on the background color of a text.
More...

Parameter Support for cursor color inverting

Registry ica.wfclient.invertcurs

orenabled

Value false / true

Enhancement on smartcard support.
More...

Parameter SmartCard driver

Registry ica.module.VirtualDriver.SmartCard.dr

ivername

Value VDSCARD.DLL / VDSCARDV2.DLL

Note VDSCARDV2.DLL supports the Plug and Play 
functionality for smartcard reader

The PulseAudio library is used instead of ALSA to access multiple audio devices within a 
session (Experimental).
More...

Parameter Multiple Audio Device support

Registry ica.module.audioredirectionv4

Value false / true

Note: The VdcamVersion4Support is renamed to AudioRedirectionV4, so registry key 
ica.module.vdcamversion4support  is removed.

UDP audio through Citrix Gateway (Experimental).
More...

Parameter UDP audio through Citrix Gateway
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Registry ica.module.enableudpthroughgateway

Value false / true

Webcam redirection for 64-bit apps (Technical Preview)
For 64-bit webcam redirection, the following parameters must be enabled:
ica.wfclient.allowaudioinput = True (default)

ica.wfclient.hdxh264inputenabled = True
Added a registry key to enable hardware acceleration for webcam redirection with 64-bit 
applications. The effect is based on prerequisites as following:
ica.wfclient.allowaudioinput=true

(default),  ica.wfclient.hdxh264inputenabled=true , 

ica.wfclient.hdxwebcamenabled=true  and available acceleration hardware 
plus license.
More...

Parameter Enable gstreamer input hardware encoder

Registry ica.wfclient.gstread_encoder

Value false / true

Known issue: Currently, H.264 for Citrix sessions in parallel with the above 
video acceleration will fail, only either or is possible.
Updated signotec Virtual Channel Driver to version 8.0.10

AVD

Added global proxy setting via Automatic Proxy Configuration ( pac  file).
The following parameters need to be set accordingly:
More...

IGEL Setup Network > Proxy

Parameter Automatic proxy configuration

IGEL Setup Sessions > AVD > AVD Sessions > AVD Session > Proxy

Parameter Global Proxy Setting

Added version notification when new IGEL AVD client versions are available. To disable the 
notification, the following parameter has been added:
More...

Registry sessions.wvd%.options.version-check

Value enabled / disabled

Parallels Client
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Updated Parallels client to version 18.3.1

NX client

Updated NX client to version 7.8.2

Chromium

Removed support for TLS 1.0 and 1.1.
Updated Chromium Browser to version 99.0.4844.74.

Firefox

Updated Mozilla Firefox to version 91.6.1 ESR.

Network

Updated Network Manager to version 1.32.

Wi-Fi

Updated Network Manager to version 1.32.
Added ath11k Wi-Fi driver.
Updated wpa_supplicant to version 2.10.

Smartcard

Updated cryptovision sc/interface to version 8.0.13. Changes are:
Support for CardOS 5.4 / 5.5
Support for DTRUST 4.x
Support for Bayern-PKI Legacy-Karte
Support for ePasslet-Suite-3.5 on NXP JCOP4
Integration of CardOS based "PKIBw-Karte 7.1" (tPKI)

Added new smartcard middleware SecMaker Net iD Client. The existing middleware SecMaker 
Net iD remains in the firmware and is renamed to SecMaker Net iD Enterprise (no need for 
configuration changes).
More...

IGEL Setup Security > Smartcard > Middleware

Parameter Secmaker Net iD Client

Registry scard.pkcs11.use_netid-client

Value false / true

IGEL Setup Sessions > Horizon Client > Horizon Client Global > 
Smartcard

Parameter Horizon logon with SecMaker Net iD Client smartcards

Registry vmware.view.pkcs11.use_netid-client

Value false / true
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IGEL Setup Sessions > Firefox Browser > Firefox Browser Global > 
Smartcard Middleware

Parameter SecMaker Net iD Client Security Device

Registry browserglobal.security_device.use_netid

-client

Value false / true

IGEL Setup Sessions > Chromium Browser > Chromium Browser 
Global > Smartcard Middleware

Parameter SecMaker Net iD Client Security Device

Registry chromiumglobal.security_device.use_neti

d-client

Value false / true

Updated Athena IDProtect smartcard library to version 7-20210902. This fixes smartcard logon 
using Horizon client and CRYPTAS TicTok v2 cards.
Added configuration parameters for options of PC/SC lite smartcard daemon which are needed 
in some cases:
More...

Parameter Maximum number of threads

Registry scard.pcscd.max_threa

d

Value 200 (default)

Parameter Maximum number of card handles per thread

Registry scard.pcscd.max_card_handle_per_thread

Value 200 (default)

Parameter Maximum number of card handles per reader

Registry scard.pcscd.max_card_handle_per_reader

Value 200 (default)

Parameter Keep card always powered on

Registry scard.pcscd.power_on
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Value false (default)

Cisco Webex

Updated Cisco WebEx VDI plugin to version 42.2
Updated Cisco WebEx Meeting VDI plugins. Available plugins in this release: 42.3.1.12 (default), 
42.2.4.12, and 41.10.11.5

 Base system

Added support for Thai keyboard layout and localization.
Updated kernel to version 5.15.26
Fixed security issue CVE-2022-0185.
Updated intel-microcode to version 20220207 to fix security issues CVE-2021-0127 and 
CVE-2021-0146.
Updated mesa to version 21.3.7.
Switched to Ubuntu Focal version of glibc.
Switched to Ubuntu Focal version of libstdc++6
Updated HP documentation for devices deployed directly by HP.
Added new registry key to include systemd information in the support files.
More...

Parameter Collect systemd information for support files

Registry debug.collect_sysd_info_for_support

Value enabled / disabled

Added new registry key to include systemd-analyze plot in the support files.
More...

Parameter Include systemd-analyze plot svg-image in support files

Registry debug.create_sysd_plot_for_support

Value enabled / disabled

Teradici PCoIP Client does not require an Add-On license anymore, this is now part of the 
Workspace Edition license.
Added new registry key to switch between the default (igel) and the unchanged asound2 pulse 
plugin type:
More...

Parameter Asound2 plugins type

Registry multimedia.alsa.asound2_plugin_type

Range [default] [igel] [vanilla]

CID Key Agent

Updated Stratusphere UX Agent to version 6.6.0-3
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Driver

Updated Philips Speech dictation drivers to version 13.1.10. Changes are amongst others:
Increased robustness in session switching/roaming use cases
Support of Philips SmartMike Duo USB devices
RDP plugins now use native freerdp instead of elusiva interface

X server

Updated Xorg server to version 21.1

Window manager

Added: The location of the notification pop-up window is now configurable.
More...

Parameter Location of notifications

Registry windowmanager.wm%.variables.notificatio

ns.location

Range [Top left] [Bottom left] [Top right] [Bottom right] [Center]

Audio

Added audio support for LG AiO with Realtek ALC256 chipset.
Updated EPOS Connect to version 7.0.0.19714.

Multimedia

Added a parameter to control the webcam powerline frequency. The "Auto" option uses the 
camera's default settings.
More...

IGEL Setup Registry > multimedia > webcam

Parameter powerline_frequency

Registry multimedia.webcam.powerline_frequency

Range [Auto] [50 HZ] [60 HZ]

zoomvdi

Updated Zoom VDI plugin to version 5.9.0.20720
Available plugins in this release: 5.9.0.20720 (default), 5.8.4.21112, and 5.4.59458

Misc

Added representation of all systemd-units installed in the firmware is now included in the 
support_information, which can be created in the UMS.

Hardware

Added HP mt46 Mobile Thin Client into supported hardware list.
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Updated NVIDIA driver to version 470.86.
Added gddccontrol to control monitor parameters like brightness, contrast, and so on.

TC Setup (Java)

Updated TC Setup to version 6.10.1.

Remote Management

Added: Transfer details (MAC addresses etc.) of all available network adapters.
Added support for device-specific attributes defined by the UMS. The list of device attributes is 
received from the UMS during boot. To access the data, the new rmagent commands are available:

/sbin/rmagent-devattrs-enum 
Enumerate the list in the form: ATTR_NAME:ATTR_TYPE:ATTR_VALUE. The enumeration is ordered 
according to the attribute's order id. 

/sbin/rmagent-devattrs-enum-range \<ATTR_NAME> 
Enumerate entries of the given range. The enumeration is ordered according to the range item's order id. 

/sbin/rmagent-devattrs-get-type \<ATTR_NAME> 
Print type of the given attribute. Known types are string, number, data or range. 

/sbin/rmagent-devattrs-get \<ATTR_NAME> 
Print value of the given attribute. 

/sbin/rmagent-devattrs-set \<ATTR_NAME> \<ATTR_VALUE> 
Set the given attribute to the specified value. The command doesn't check value type but permission rule 
defined for the attribute. 

/sbin/rmagent-devattrs-reset \<ATTR_NAME> 
Reset the given attribute, the attribute doesn't have then an empty value. 

/sbin/rmagent-devattrs-sync 
Calculate current checksum and send the attribute list to the UMS if the checksum is different than the sum 
received from the UMS. 

/sbin/rmagent-write-device-attributes 
Send the attribute list to the UMS.

As attribute name, the UMS internal name of the attribute must be used. See Managing IGEL OS Devices by 
Device Specific Data - What Device Attributes Can Do for You.

Fabulatech

Updated Fabulatech USB Redirection Client plugins to 3.8.0
Updated FabulaTech USB for Remote Desktop to version 6.0.35.
Added: FabulaTech device redirection now works with Horizon Blast
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Resolved Issues 11.07.100
Citrix

With CWA 2012, Citrix has revised the client drive mapping, with which we can no longer preset 
the right of the drives. Since then, the user can assign these rights in the session itself. So that this 
selection remains also over a
reboot, we store the necessary file persistently on our system.
Updated window manager so that the proxy Authentication window comes to the foreground and 
is focused when the Citrix Brower content redirection with Cef is used.
Fixed window settings for Citrix Desktop sessions
Added parameter for Browser Content Redirection with CEF to enable global proxy support.
More...

Parameter Browser content redirection with CEF via proxy

Registry ica.module.virtualdriver.webpageredirec

tion.cef_proxy_env

Value true / false

Fixed multimedia support for Citrix when used HWA in Firefox.
Fixed high CPU load in MS Teams and Citrix Workspace App 2112.

OSC Installer

Fixed OSC Recovery with enabled "Migrate Old Settings"
Fixed OSC issue with bogus character in license type field and not shown add-on licenses.
Fixed returning to installer after closing Factory ID window.

AVD

Added several performance optimizations.

RDP/IGEL RDP Client 2

Fixed wrong error message when RDP session was closed by idle timeout.

RD Web Access

Fixed RD Web Access windows moving out of the screen.
Fixed downloading published applications.

Parallels Client

Fixed multi-monitor issues.

X session (Xephyr)

Fixed segfault with xdmcp sessions to an OpenVMS environment.
Fixed fullscreen and workarea x sessions that are expanded over 2 or more monitors: The 
session window opens properly and the single monitors are detected inside the x session.
Fixed host chooser button events in x sessions with connection type "indirect via localhost".
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Firefox

Fixed usage of Athena IDProtect smartcards.
Fixed usage of IGEL extensions when private browsing is enabled. These are important to set 
restricted kiosk mode settings.
Fixed installed translations for user interface.
Fixed download prevention with restricted / hidden file system access. Without the fix, the 
current browser implicitly put the file into the standard Downloads folder - without the possibility 
to interfere.
Fixed crash which always occurred during the internal probing of 3D support for WebGL. So 
WebGL is now available again for the supported display drivers.
Fixed client certificate management via IGEL TC Setup. Firefox's standard certificate dialog is 
used now.

Chromium

Fixed comma-separated strings in custom policies broke some Chromium Browser policies.
Fixed emojis have not been loaded in Chromium (also affects Chromium Embedded Framework).
Removed "What's new" tab showing on the first start and after Chromium updates.

Network

Fixed could not mount issue with some NFS 4.1 and 4.2 servers (QNAP).
Fixed global no-proxy list getting effective via gconf2. This e.g. can help Citrix Workspace App 
using the right proxy configuration.
Removed now unsupported samba security modes (NTLM, NTLMi, and LanMan) as these would 
cause mount failures. This removes also support for very old SMB v1 servers. Changed the 
following registry key to:
More...

Parameter Security Mode

Registry network.smbmount%.security_mode

Range [default] [ntlmv2] [NTLMSSP] [ntlmv2i] [NTLMSSPi]

Wi-Fi

Added setup registry key to select between wpa_supplicant/iwd as Wireless back-end.
AVM Fritz!WLAN N v2 USB Stick, only works with iNet Wireless Daemon (iwd) as Wi-Fi back-end.
More...

Parameter Wi-Fi backend

Registry network.interfaces.wirelesslan.wireless_

backend

Range [iNet Wireless Daemon (iwd)]

Value Wi-Fi Protected Access client and IEEE 802.1X supplicant 
(wpa_supplicant)
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Fixed issue with TP-Link AC600 not working on 5GHz (8821au driver).
Improved reconfiguring regulatory domain settings at runtime

Open VPN

Added config parameter for extending arguments of VPN command:
More...

Registry sessions.openvpn%.vpnopts.extend_opts

Value extend parameter as string

Enter parameter starting with `--`.
Example:  `--ping 10 --ping-restart 120`
Parameters that are already set in the GUI must not be used.

Imprivata

Fixed Imprivata data partition: remove outdated artefacts, keep latest version of the 
configuration-editor

Smartcard

Added option to unlock screen lock in case of Kerberos smartcard login by only checking the 
PIN of the smart card.
More...

Parameter Only check smartcard PIN on unlock

Registry auth.login.pkcs11_screenlock_unlock

Value false / true

Fixed: Maximum number of simultaneous smartcard contexts were raised in smartcard 
resource manager PC/SC lite.

HID

Changed default of userinterface.touchpad.tapping.TapButton1  registry key to 
1 so tapping is active as default again (if set to 0 tapping is disabled).

CUPS Printing

Fixed handling of more than one printer and printer selection by USB IDs.
Fixed classification of some HP printers as scanners only which made printing impossible 
because of missing access rights.

Fixed TCP/IP print server functionality with USB printers. Printing was not possible in some 
cases, e.g. when certain other USB devices were connected.

Base system

Added driver for several Intel SOC NVME controller. Required for e.g. HP G8 250.
Added new parameter for custom font path configuration. Add a new instance for each custom 
font path:
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More...

Parameter Enable Custom Font Path

Registry x.fontpaths.custom<instance 

nr>.enabled

Value enabled / disabled

Parameter Custom Font Path

Registry x.fontpaths.custom<instance nr>.path

Parameter Font Path Position

Registry x.fontpaths.custom<instance 

nr>.position

Value 99 (default)

Fixed display configuration problems caused by wrong access permissions of  /wfs/user/

graphic  folder.
Fixed battery indicator.
Fixed Setup Assistant - After acceptance of EULA, Demo License flow was not available.
Fixed wrongly shown Starter license info in Product ID on fully licensed devices.
Fixed product id for IGEL UD6.
Fixed issues with global proxy configuration.
Fixed sporadic failures while custom partition initialisation.
Fixed Finish button label in Setup Assistant.
Fixed missing generation number in Product ID (About and UMS).
Fixed applications from custom partition get killed when network is up.
Fixed IGEL system uses far too much RAM inside a VM.
Added registry key to allow old weak public key algorithms for older SSH servers.
More...

Parameter Disable weak Pubkey algorithms

Registry network.ssh_client.disable_weak_pubkey

_algos

Type bool

Value enabled / disabled

Added registry key to switch between the default (igel) and the unchanged asound2 pulse 
plugin type:
More...
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Parameter Asound2 plugins type

Registry multimedia.alsa.asound2_plugin_type

Range [default] [igel] [vanilla]

Driver

Fixed Citrix terminate with Olympus RM4010P connected and hardware button pressed.
Fixed Olympus FootSwitch being detected as mouse buttons.
Added driver for MediaTek MT7921.
Fixed several problems of MediaTek MT7921 driver.

X11 system

Added new registry keys which can be useful to fix issues with monitors not waking up after 
DPMS off events.
More...

Parameter Quirk for DPMS Off to On event.

Registry x.dpms_quirks.off_on.quirk

Range [none] [refresh-change]

Parameter Wait time in seconds before executing quirk after DPMS 
event.

Registry x.dpms_quirks.off_on.wait_before

Type string

Value 1  

Parameter Wait time in seconds between two quirk states.

Registry x.dpms_quirks.off_on.wait_between

Type string

Value 3 

Parameter Wait time in seconds after execution of quirk.

Registry x.dpms_quirks.off_on.wait_after

Type string

Value 1 

Parameter Xrandr connector names where quirk should apply (empty 
means all)
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Registry x.dpms_quirks.off_on.connectors_to_quirk

Type string

Value empty 

X server

Fixed monitor configuration when modesetting graphics driver is enabled.
Added new registry keys for xorg modesetting options:
More...

Parameter Use linear framebuffer instead of tiling one.

Registry x.drivers.modesetting.use_linear_frame

buffer

Range [Default] [True] [False]

Parameter Use variable refresh rate.

Registry x.drivers.modesetting.use_variable_ref

resh

Range [Default] [True] [False]

Parameter Use async flips for secondary video outputs on multi-
display setups.

Registry x.drivers.modesetting.use_async_flip_sec

ondaries

Range [Default] [True] [False]

Parameter Use DRI3 page flipping.).

Registry x.drivers.modesetting.use_page_flip

Range [Default] [True] [False]

Parameter Use shadow framebuffer layer (default on).

Registry x.drivers.modesetting.use_shadow_fb

Range [Default] [True] [False]

Parameter Use double buffer for shadow updates (default depends 
on hardware).
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Registry x.drivers.modesetting.use_double_shadow

Range [Default] [True] [False]

Parameter Use software cursor (default off).

Registry x.drivers.modesetting.use_sw_cursor

Range [Default] [True] [False]

Parameter Use gamma look up table (warning some devices have 
problems with this).

Registry x.drivers.modesetting.use_gamma_lut

Range [Default] [True] [False]

Window manager

Fixed taskbar clock is displaying seconds (again) if enabled in system registry.
Fixed taskbar was displayed incorrectly in some special configuration cases.

VirtualBox

Added new registry key to disable initial boot framebuffer
More...

Parameter Disable use of initial boot framebuffer.

Registry system.kernel.bootparams.vga_off

Type bool

Value enabled / disabled

Audio

Fixed multimedia.disable_audio.pci  registry key setting.
Fixed switch of Speaker / Headsets

Multimedia

Added new registry key to prefer i965 VAAPI driver over iHD (if usage of iHD cause trouble)
More...

Parameter Prefer i965 over iHD VAAPI driver

Registry multimedia.vaapi.prefer_i965

Range [Default] [Prefer] [Force]

Remote Management
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Fixed opening communication ports in rmagent - now all network ports use IPv4 only.
Fixed keepalive mechanism in rmagent. The mechanism must prevent premature closing 
connection by the UMS if a remote command takes a time period over 30 seconds.
Fixed removing files in the file transfer mechanism. Files are properly removed from the file 
system, when files are not assigned anymore to a device in the UMS.
Fixed UMS file transfer of trusted certificates which have spaces in file names.
Fixed IP address retrieving of a WLAN interface.
Fixed losing ICG connection on switching from LAN to WLAN - now a new ICG connection is 
established.
Fixed spurious creation of empty directories /wfs/ca-certs?*  and /wfs/user?*  when 
using certificates with spaces in filenames for file transfer.
Changed applying of remote settings received during boot - the settings are synced with the 
current local settings at the end of the boot process. If these changes require a system interaction 
to be applied (like restart of some
services) then the user is asked about applying. The dialog is optional and quits after a timeout. 
This bugfix solves the problem, that the "Apply changes" dialog is shown on every boot.
Fixed evaluation of the exit status of a UMS generic job if the corresponding generic command 
is implemented as a systemd service.

IGEL Cloud Gateway

Fixed exchange of the ICG certificate chain.

VNC

Fixed keyboard mapping in shadowing sessions, especially with backslash, euro and at keys in 
French keyboard layout.
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Notes for Release 11.06.250
Software: Version 11.06.250

Release Date: 2022-02-07

Release Notes: Version RN-1106250-1

Last update: 2022-02-07

Supported Devices 11.06.250 (see page 342)
Component Versions 11.06.250 (see page 343)
Known Issues 11.06.250 (see page 351)
Security Fixes 11.06.250 (see page 354)
New Features 11.06.250 (see page 355)
Resolved Issues 11.06.250 (see page 357)



Notes for Release 11.06.250

IGEL OS Release Notes   342 / 1492

Supported Devices 11.06.250
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.06.250

Clients
Product Version

Amazon WorkSpaces Client 3.1.9

Chromium 95.0.4638.69-igel1635513789

Cisco JVDI Client 14.0.3

Cisco Webex VDI plugin 41.12.0.20899

Cisco Webex Meetings VDI plugin 41.10.9.15

Cisco Webex Meetings VDI plugin 41.12.6.12

Cisco Webex Meetings VDI plugin 42.1.1.20

Zoom Media Plugin 5.4.59458

Zoom Media Plugin 5.8.4.21112

Zoom Media Plugin 5.9.0.20720

Citrix HDX Realtime Media Engine 2.9.400

Citrix Workspace App 20.10.0.6

Citrix Workspace App 21.11.0.20

Citrix Workspace App 21.12.0.18

deviceTRUST Citrix Channel 20.2.310.0

Crossmatch DP Citrix Channel 0125

deskMate Client 2.1.3

DriveLock Agent 20.1.4.30482

Ericom PowerTerm 14.0.1.62267

Evidian AuthMgr 1.5.7789

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech Plugins 3.7.3

FabulaTech USB for Remote Desktop 6.0.28

FabulaTech Scanner for Remote Desktop 2.7.0.1
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FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 91.3.0

IBM iAccess Client Solutions 1.1.8.6

IGEL RDP Client 2.2igel1639469055

IGEL AVD Client 1.0.37igel1639058670

deviceTRUST RDP Channel 20.2.310.0

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

Lakeside SysTrack Channel 9.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 7.1.3-1igel9

Open VPN 2.5.1-3igel1621236751

Zulu JRE 8.0.302-1

Parallels Client  18.2.0

Spice GTK (Red Hat Virtualization) 0.39-1igel106

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.8.0-1+b1igel71

SpeechWrite 1.0

Stratusphere UX Connector ID Key software 6.5.0-2

Teradici PCoIP Software Client 21.03.0-18.04

ThinLinc Client 4.13.0-2172

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 4.16.0-1igel1611217037

VNC Viewer 1.11.0+dfsg-2igel19

VMware Horizon Client 2111-8.4.0-18957622

Voip Client Ekiga 4.0.1-9build1igel6

Dictation
Diktamen driver for dictation 2017/09/29
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Grundig Business Systems dictation driver 0.12/21-12-21

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 4.0.1

Philips Speech driver 12.9.1

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.9

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7-20210902

PKCS#11 Library cryptovision sc/interface 7.3.1

PKCS#11 Library Thales SafeNet 10.8.28

PKCS#11 Library OpenSC 0.21.0-1igel39

PKCS#11 Library SecMaker NetID 6.8.3.21

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.8-1igel1632136057

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.36-2igel1636006599

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.1-1igel18

Cherry USB2LAN Proxy 3.2.0.3
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System Components
OpenSSL 1.0.2n-1ubuntu5.7

OpenSSL 1.1.1-1ubuntu2.1~18.04.13

OpenSSH Client 8.4p1-5igel6

OpenSSH Server 8.4p1-5igel6

Bluetooth stack (bluez) 5.56-0ubuntu2igel12

MESA OpenGL stack 21.1.5-1igel145

VAAPI ABI Version 0.40

VDPAU Library version 1.4-3igel1099

Graphics Driver INTEL 2.99.917+git20200515-igel1013

Graphics Driver ATI/RADEON 19.1.0-2igel1066

Graphics Driver ATI/AMDGPU 19.1.0-2+git20210202igel1122

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 460.91.03-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel1012

Graphics Driver VESA 2.4.0-1igel1010

Input Driver Evdev 2.10.6-2igel1037

Input Driver Elographics 1.4.2-1igel1113

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-1ubuntu1igel1009

Input Driver VMMouse 13.1.0-1ubuntu2igel957

Input Driver Wacom 0.39.0-0ubuntu1igel1036

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.12.19 #mainline-lxos_dev-g1634042087

Xorg X11 Server 1.20.11-1igel1120
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Xorg Xephyr 1.20.11-1igel1120

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.500

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel14

XFCE4 Window Manager 4.14.5-1~18.04igel1600422786

ISC DHCP Client 4.3.5-3ubuntu7.3

NetworkManager 1.30.0-2igel114

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.92

GStreamer 0.10 Fluendo h264dec 0.10.59

GStreamer 0.10 Fluendo mp3dec 0.10.41

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.229

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.18.5-1igel1633086114

GStreamer 1.0 Fluendo aacdec 0.10.42

GStreamer 1.0 Fluendo asfdemux 0.10.92

GStreamer 1.0 Fluendo h264dec 0.10.59

GStreamer 1.0 Fluendo mp3dec 0.10.41

GStreamer 1.0 Fluendo mpeg4videodec 0.10.44

GStreamer 1.0 Fluendo vadec 0.10.229

GStreamer 1.0 Fluendo wmadec 0.10.70

GStreamer 1.0 Fluendo wmvdec 0.10.66

WebKit2Gtk 2.32.4-1igel1632209494

Python2 2.7.17
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Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.22-dfsg-1igel55

Virtualbox X11 Guest Utils 6.1.22-dfsg-1igel55

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.20.0-2igel104

Qemu Guest Agent 5.2+dfsg-3igel17

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.17-3igel5

Mobile Device Access USB (imobile) 1.3.0-6igel12

Mobile Device Access USB (gphoto) 2.5.27-1igel8

VPN OpenConnect 8.10-2igel6

Scanner support 1.0.27-1

VirtualBox 6.1.22-dfsg-1igel55

Services
Service Size Reduced Firmware

Asian Language Support 24.8 M Included

Java SE Runtime Environment 43.0 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

361.2 M Included

Ericom PowerTerm InterConnect 11.5 M Included

Media Player 768.0 K Included

Local Browser (Firefox)
Citrix Appliance

94.8 M Included
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VMware Horizon
RDP

6.2 M Included

Cendio ThinLinc 11.5 M Included

Printing (Internet printing protocol CUPS) 23.8 M Included

NoMachine NX 31.8 M Included

VMware Horizon 251.0 M Included

Voice over IP (Ekiga) 7.2 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 30.8 M Not included

Fluendo GStreamer Codec Plugins 7.5 M Included

IBM i Access Client Solutions 128.2 M Not included

Red Hat Enterprise Virtualization 3.5 M Included

Parallels Client 6.8 M Included

NVIDIA graphics driver 181.5 M Not included

Imprivata Appliance 16.0 M Included

AppliDis 256.0 K Included

Evidian AuthMgr 3.0 M Included

Hardware Video Acceleration 15.8 M Included

Extra Font Package 1.2 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 4.0 M Included

Cisco JVDI client 75.5 M Included

PrinterLogic 53.2 M Not included

Biosec BS Login 10.2 M Not included

Login VSI Login Enterprise 32.8 M Not included

Stratusphere UX CID Key software 3.2 M Not included

Elastic Filebeat 25.0 M Not included

AVD 120.5 M Included

Local Browser (Chromium) 105.5 M Not included
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Amazon WorkSpaces Client 36.8 M Included

deskMate client 6.5 M Included

Cisco Webex VDI 55.0 M Not included

Cisco Webex Meetings VDI 103.8 M Not included

Zoom Media Plugin 145.0 M Not included

DriveLock 14.8 M Included

SpeechWrite Client 256.0 K Included

Fluendo Browser Codec Plugins 4.5 M Included

HP Factory deployment documentation 27.5 M Included

Teradici PCoIP Client 18.2 M Included

90meter Smart Card Support 256.0 K Included

Virtualbox (Limited support)

Mobile Device Access USB (Limited 
support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

Limited Support Features

256.0K Not included

Mobile Device Access USB (Limited 
support)

512.0 K Not included

VPN OpenConnect (Limited support) 1.2 M Not included

Scanner support / SANE (Limited support) 2.8 M Not included

VirtualBox (Limited support) 70.8 M Not included
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Known Issues 11.06.250
Citrix

To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers during running / active sessions does not work. The reader is visible, 
but cannot be used due to unknown reader status. Only relevant for CWA versions earlier than 
2112.
There are known issues with GStreamer 1.0 and usage in Citrix. These occur with multimedia 
redirection of H.264, MPEG1, and MPEG2. (GStreamer 1.0 is used if browser content redirection 
is enabled active.)
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec enabled.
Enabled DRI3 and an AMD GPU Citrix H.264 acceleration could lead to a freeze. Selective H.264 
mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.

OSC Installer

OSC not deployable with IGEL Deployment Appliance: New version 11.3 is required for 11.06 
deployment.

VMware Horizon

After disconnect of an RDP-based session, the Horizon main window which contains the server 
or sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon. 
It is necessary to switch off local logon and enable the following two keys via IGEL registry:
userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin versions below 5.8.0 make Horizon Client crash upon connection to 
the remote desktop in cases when TC Setup is running at the same time.
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With the usage of the PCoIP protocol, the virtual channel provided by VMware used for serial 
port and scanner redirection could freeze on logout from the remote session. 
This happens only with enabled scanner or serial port redirection. The freeze does not occur if 
both redirection methods are enabled or none of them. The Blast Protocol is not affected by this 
bug.
The respective settings can be found in the IGEL Registry:
vmware.view.enable-serial-port-redir 

vmware.view.enable-scanner-redir
Keyboard Input Source Language Synchronization works only when using a local layout with 
deadkeys enabled. 
If a keyboard layout is used which has deadkeys disabled (which is the default on IGEL OS), 
Horizon client falls back to en-US layout.
PCoIP sessions may crash in some cases, switching to Blast Protocol is recommended then. 
H.264/HEVC encoding can be disabled when overall performance is too low.
Client drive mapping and USB redirection for storage devices can be switched on at the same 
time, but could lead to problems under some circumstances:
Horizon Client tracks the drives which are dynamically mounted and adds them to the remote 
session using client drive mapping, i.e. USB redirection is then not used for these devices. 
However, in the case of devices like USB SD card readers, Horizon does not map them as client 
drives but forcefully uses USB redirection which results in an unclean unmount. 
As a work-around, the IDs of these card readers can be added to IGEL USB access rules and 
denied.

Parallels Client

Storage devices attached to the thin client will appear as network drives in the remote session.
USB device redirection is considered experimental for the Parallels client for Linux.

Firefox

With enabled Citrix Browser Content Redirection (BCR), Firefox has no H.264 and 
AAC multimedia codec support. This means when codec support is needed in Firefox, 
BCR needs to be disabled. Citrix Browser Content Redirection is disabled by default.

Network

Wakeup from system suspend fails on DELL Latitude 5510.

Wi-Fi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client

There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 2010 and Cisco JVDI.

Base system

Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
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Update from memory stick requires network online state (at least when multiple update stages 
are involved.
Wrong license information may be shown in Product ID. In detail, ‘Starter License’ is indicated 
sporadically by Product ID suffix ‘Starter‘, even with deployed and enabled WE license.

Conky

The right screen when using a multiscreen environment may not be shown correctly.
Workaround: The horizontal offset should be set to the width of the monitor (e.g. if the monitor 
has a width of 1920, the offset should be set to 1920)

Firmware update

On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode

When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.
Browser Appliance mode can fail when the Web URL contains special control characters like 
ampersands (& character). 
Workaround: Add quotes at the beginning and the end of an affected URL. Example: 'https://
www.google.com/search?q=aSearchTerm&source=lnms&tbm=isch'

Audio

IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantech POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.
UD3-M340C: Sound preferences are showing Headphone & Microphone, although 
not connected.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hardware

Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.

Remote Management

AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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Security Fixes 11.06.250
Base system

Update policykit-1 package for CVE-2021-4034 (fixes Polkit Escalation of Privilege).

Citrix

Removed registry key ica.appprotection  due to possible security vulnerability. Please 
follow this document for more information: https://support.citrix.com/article/CTX338435.

https://support.citrix.com/article/CTX338435
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New Features 11.06.250
Smartcard

Updated smartcard reader driver MUSCLE CCID to version 1.4.36.
Updated smartcard reader driver ACS CCID to version 1.1.8.

Cisco JVDI Client

Updated Cisco JVDI to version 14.0.3

Base system

Added support for Thai keyboard layout and localization.

Zoom VDI

Integrated Zoom Plugin 5.9.0.20720
Available Zoom Plugins in this release: 5.9.0.20720 (default), 5.8.4.21112, and 5.4.59458

Citrix

Integrated Citrix Workspace app 21.12
Available Citrix Workspace Apps in this release: 21.12 (default), 21.11, and 20.10
New features:

The cursor color inverts based on the background color of a text.
More...

Parameter Support for cursor color inverting

Registry ica.wfclient.invertcurs

orenabled

Value false / true

Enhancement on smartcard support.
More...

Parameter SmartCard driver

Registry ica.module.VirtualDriver.SmartCard.dr

ivername

Value VDSCARD.DLL / VDSCARDV2.DLL

Note VDSCARDV2.DLL supports the Plug and Play 
functionality for smartcard reader

The PulseAudio library is used instead of ALSA to access multiple audio devices within a 
session (Experimental).
More...
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Parameter Multiple Audio Device support

Registry ica.module.audioredirectionv4

Value false / true

Note: The VdcamVersion4Support is renamed to AudioRedirectionV4, so registry key 
ica.module.vdcamversion4support  is removed.

UDP audio through Citrix Gateway (Experimental).
More...

Parameter UDP audio through Citrix Gateway

Registry ica.module.enableudpthroughgateway

Value false / true

Webcam redirection for 64-bit apps (Technical Preview)
For 64bit webcam redirection the following parameters must be enabled:
ica.wfclient.allowaudioinput = True (default)

ica.wfclient.hdxh264inputenabled = True
For Browser Content Redirection, the Chromium Embedded Framework is used by default 
now. Parameter ica.allregions.usecefbrowser  was set to default value "true".

VMware Horizon

Updated Horizon Client to version 2111 8.4.0-18957622

Cisco Webex

Available Cisco Webex Meetings VDIs in this release: 42.1.1.20 (default), 41.12.6.12, and 
41.10.9.15
Integrated Cisco Webex VDI 41.12.0.20899

Multimedia

Added libcam-tools to firmware.
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Resolved Issues 11.06.250
Citrix

Fixed window settings for Citrix Desktop sessions
Fixed, no useless "to" icon is created with the StoreFront session.
Fixed startup of Self-Service after reboot in some cases.
Added a parameter to control if the cache of Self-Service files is persistent over reboots:
More...

Parameter Persistent cache of configuration and UI

Registry ica.selfservice.persistentcache

Value true / false

In 2112 CWA, Citrix introduced a fix for a video flicker by always capturing the camera at 
maximum resolution (1080 or 720p depending on the camera’s capabilities) and then scaling 
down dynamically to match the constraints set by Teams servers. Example: in a conference 
call, the Teams servers might only require 360p at the beginning of the call and 480p as the call 
progresses.
This scaling causes high CPU usage on thin clients as we are capturing HD video constantly, 
even if the endpoint is low-powered.
Workaround: Add the following custom command under System > Firmware Customization > 
Custom Commands > Desktop > Final desktop command:
mkdir -p /var/.config/citrix/hdx_rtc_engine

touch /var/.config/citrix/hdx_rtc_engine/config.json

echo "{" > /var/.config/citrix/hdx_rtc_engine/config.json

echo "\"UseDefaultCameraConfig\":0" >> /var/.config/citrix/

hdx_rtc_engine/config.json

echo "}" >> /var/.config/citrix/hdx_rtc_engine/config.json

Base system

Fixed Product ID for IGEL UD6.
Fixed prevented detection of USB device by its UUID
Fixed missing generation number in Product ID (About and UMS)
Added new registry key to include systemd information in the support files.
More...

Parameter Collect systemd information for support files

Registry debug.collect_sysd_info_for_support

Value disabled / enabled

Added new registry key to include systemd-analyze plot in the support files.
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More...

Parameter Include systemd-analyze plot svg-image in support files

Registry debug.create_sysd_plot_for_support

Value disabled / enabled

OSC Installer

Fixed OSC Recovery with enabled "Migrate Old Settings"

RDP/IGEL RDP Client 2

Fixed native USB redirection of Elatec TWN4 MultiTech 2 LF RFID reader
Fixed wrong error message when RDP session was closed by idle timeout

AVD

Added full support for Thai (Kedmanee) keyboard layout
Added support for Thai (Pattachote) only with sessions.wvd%.options.remote-

keymapping=on
Added potential support for other keyboard layouts when the special key codes are of the type 
0xeXX

Added new parameter for avoiding incompatibilities between the AAD login and the 
QWebEngine we use. Enablement of this new parameter is needed when AAD login hangs (likely 
showing a white screen after the username has been entered):
More...

Registry sessions.wvd%.options.compact-login-

view

Value enabled / disabled

RD Web Access

Fixed downloading published applications

VMware Horizon

Fixed not starting Firefox if called by Horizon client for 2FA. Libraries from Horizon installation 
were prevented by apparmor.

Firefox

Added apparmor exception to fix webrtc
Fixed usage of Athena IDProtect smartcards
Removed superfluous permission dialog before starting Horizon client or Citrix receiver from 
the browser.

Network
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Fixed: Network interfaces were unusable when name assignment failed due to length. In such 
cases, names are now determined according to NamePolicy=mac.
Improved synchronization of IPv4 and IPv6 when both are desired
Added a registry key for specifying a period in seconds to wait for Ethernet link settings. A 
value greater than "0" can be beneficial in the case where applying the link settings would 
interfere with 802.1X authentication.
More...

Parameter Wait for Ethernet link configuration

Registry network.interfaces.ethernet.device%.wai

t_for_link_config

Type integer

Value 1 (default)

Wi-Fi

Fixed "bestsignal" in network.interfaces.wirelesslan.device0.bssid  and 

network.interfaces.wirelesslan.device0.alt_ssid%.bssid  had no effect.
Improved reconfiguring regulatory domain settings at runtime
Fixed: Enabling wpa supplicant's background scan was broken 
(settings  network.interfaces.wirelesslan.device0.bgscan.** ) since the step to 
Network Manager 1.30.0

Smartcard

Fixed smartcard PIN verify with HP Skylab smartcard keyboard.
Fixed pcsc_scan and ATR_analysis tools and updated list of known smartcards.

Base system

Fix USB deny rules not working in certain situations.
Added new parameter to enable English international dead keys:
More...

Parameter English (International) dead keys

Registry userinterface.keyboard.us_intl_compose

Value disabled / enabled

Added parameter to enable dead keys:
More...

IGEL Setup User Interface > Input > Keyboard

Parameter Enable dead keys
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Registry userinterface.keyboard.usedeadkeys

Value disabled / enabled

Fixed Setup Assistant - After acceptance of EULA, Demo License flow was not available.
Fixed removal of Kerberos credential cache after session logoff.
Fixed faulty suspend with locked screen.

Firmware update

Implemented support for FTP over implicit TLS (port 990)

Driver

Updated Grundig Dictation driver to version 0.12/21-12-21
Fix crashes with newer Citrix clients
Add support to set up default speaker & microphone in Citrix & RDP session
Add support for Olympus DS-xxxx configuration
Various bug fixes

X server

Fixed XC font service support

Audio

Fixed multimedia.disable_audio.pci  registry key setting
Fixed switch of Speaker / Headsets

Remote Management

Fixed evaluation of the exit status of a UMS generic job if the corresponding generic command 
is implemented as a systemd  service.
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Notes for Release 11.06.210
Software: Version 11.06.210

Release Date: 2021-11-30

Release Notes: Version RN-1106210-1

Last update: 2021-11-30

The Release Notes for IGEL OS 11.06.210 are available in the following formats:

Plain text:  RNs_1106210.txt
HTML: lxos_11.06.210.html
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Notes for Release 11.05.133
Software: Version 11.05.133

Release Date: 2021-04-29

Release Notes: Version RN-1105133-1

Last update: 2021-04-26

Supported Devices 11.05.133 (see page 363)
Component Versions 11.05.133 (see page 364)
General Information 11.05.133 (see page 372)
Known Issues 11.05.133 (see page 373)
Security Fixes 11.05.133 (see page 376)
New Features 11.05.133 (see page 377)
Resolved Issues 11.05.133 (see page 379)
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Supported Devices 11.05.133
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.05.133

Clients
Product Version

Chromium (experimental)  88.0.4324.150-igel1612763117

CID Key 6.5.0-2

Cisco JVDI Client 14.0.0

Cisco Webex Teams VDI Client 41.4.0.18516

Cisco Webex Meetings VDI Client 41.4.0.162

Zoom Media Plugin 5.5.12716

Citrix HDX Realtime Media Engine 2.9.300

Citrix Workspace App 19.12.0.19

Citrix Workspace App 20.12.0.12

Citrix Workspace App 21.03.0.38

deskMate Client 2.1.3

deviceTRUST Citrix Channel 20.1.200.0

Crossmatch DP Citrix Channel 0125

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 14.0.0.45623

Evidian AuthMgr 1.5.7617

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech USB for Remote Desktop 6.0.28

FabulaTech Scanner for Remote Desktop 2.7.0.1

FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 78.6.1

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2igel1605251065

IGEL WVD Client 1.0.24igel1619015530
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Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

deviceTRUST RDP Channel 20.1.200.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.11.2-1igel8

Open VPN 2.5.0-1igel1606475118

Zulu JRE 8.48.0.51-2

Parallels Client  17.1.3

Spice GTK (Red Hat Virtualization) 0.39-1igel106

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.8.0-1+b1igel71

SpeechWrite 1.0

Teradici PCoIP Software Client 21.03.0-18.04

ThinLinc Client 4.12.0-6517

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 1.0.5-1igel1583919770

VNC Viewer 1.10.1+dfsg-9igel17

VMware Horizon Client 2012-8.1.0-17349998

Voip Client Ekiga 4.0.1-9build1igel6

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20201118

Philips Speech driver 12.9.1

Signature
Kofax SPVC Citrix Channel 3.1.41.0
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signotec Citrix Channel 8.0.9

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7

PKCS#11 Library cryptovision sc/interface 7.3.1

PKCS#11 Library Gemalto SafeNet 10.7.77

PKCS#11 Library OpenSC 0.21.0-1igel39

PKCS#11 Library SecMaker NetID 6.8.3.21

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel2

Reader Driver Gemalto eToken 10.7.77

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.31-1igel12

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.0-1igel18

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.5

OpenSSL 1.1.1-1ubuntu2.1~18.04.7

OpenSSH Client 8.4p1-3igel4

OpenSSH Server 8.4p1-3igel4

Bluetooth stack (bluez) 5.55-0ubuntu1.1igel10
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MESA OpenGL stack 20.2.6-1igel131

VAAPI ABI Version 0.40

VDPAU Library version 1.4-3igel1099

Graphics Driver INTEL 2.99.917+git20200515-igel1013

Graphics Driver ATI/RADEON 19.1.0-2igel1066

Graphics Driver ATI/AMDGPU 19.1.0-2+git20200828igel1064

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 450.102.04-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel1012

Graphics Driver VESA 2.4.0-1igel1010

Input Driver Evdev 2.10.6-2igel1037

Input Driver Elographics 1.4.1-1+b6igel952

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-1ubuntu1igel1009

Input Driver VMMouse 13.1.0-1ubuntu2igel957

Input Driver Wacom 0.39.0-0ubuntu1igel1036

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.9.16 #mainline-lxos-g1615563496

Xorg X11 Server 1.20.10-2igel1100

Xorg Xephyr 1.20.10-2igel1100

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.425

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel13

XFCE4 Window Manager 4.14.2-1~18.04igel1600339249

ISC DHCP Client 4.3.5-3ubuntu7.1

NetworkManager 1.20.4-2ubuntu2.2igel109
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ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.90

GStreamer 0.10 Fluendo h264dec 0.10.58

GStreamer 0.10 Fluendo mp3dec 0.10.40

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.224

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.18.3-1igel283

GStreamer 1.0 Fluendo aacdec 0.10.42.2-8d6d

GStreamer 1.0 Fluendo asfdemux 0.10.90

GStreamer 1.0 Fluendo h264dec 0.10.58

GStreamer 1.0 Fluendo mp3dec 0.10.40

GStreamer 1.0 Fluendo mpeg4videodec 0.10.44

GStreamer 1.0 Fluendo vadec 0.10.224

GStreamer 1.0 Fluendo wmadec 0.10.70

GStreamer 1.0 Fluendo wmvdec 0.10.66

WebKit2Gtk 2.30.4-1igel40

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.18-dfsg-3igel52

Virtualbox X11 Guest Utils 6.1.18-dfsg-3igel52

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1
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Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.20.0-2igel104

Qemu Guest Agent 5.2+dfsg-3igel17

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.17-3igel5

Mobile Device Access USB (imobile) 1.3.0-5igel11

Mobile Device Access USB (gphoto) 2.5.26-2igel7

VPN OpenConnect 8.10-2igel6

Scanner support 1.0.27-1

VirtualBox 6.1.18-dfsg-3igel52

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M Included

Java SE Runtime Environment 36.0 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

329.0M Included

Ericom PowerTerm InterConnect 15.5 M Included

Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

76.5 M Included

VMware Horizon
RDP

4.5 M Included

Cendio ThinLinc 10.0 M Included

Printing (Internet printing protocol CUPS) 22.2 M Included

NoMachine NX 26.8 M Included

VMware Horizon 131.2 M Included

Voice over IP (Ekiga) 6.5 M Included
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Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M Not included

Fluendo GStreamer Codec Plugins 6.5 M Included

IBM i Access Client Solutions 72.5 M Not included

Red Hat Enterprise Virtualization 3.0 M Included

Parallels Client 5.5 M Included

NVIDIA graphics driver 126.8 M Not included

Imprivata Appliance 10.8 M Included

Evidian AuthMgr 2.5 M Included

Hardware Video Acceleration 13.5 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.5 M Included

Cisco JVDI client 61.8 M Included

PrinterLogic 40.8 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M Not included

Stratusphere UX CID Key software 2.8 M Not included

Elastic Filebeat 15.8 M Not included

WVD 89.2 M Included

Local Browser (Chromium) 87.8 M Not included

deskMate client 5.8 M Included

Cisco Webex Teams VDI 43.8 M Not included

Cisco Webex Meetings VDI 32.8 M Not included

Zoom VDI Media Plugin 47.2 M Not included

DriveLock 13.2 M Included

SpeechWrite Client 256.0 K Included

Teradici PCoIP Client 16.0 M Included

90meter Smart Card Support 256.0 K Included
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Virtualbox (Limited support)

Mobile Device Access USB (Limited 
support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

Limited Support Features

256.0K Not included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.0 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 63.8 M Not included
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General Information 11.05.133

The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver

To be beneficial to all new features and implementations, it is recommended to use UMS 6.07.100 or 
higher and update the corresponding profiles.



Firmware downgrade to older versions (11.01 or 11.02) is not possible, due to the unsigned firmware 
update files.


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Known Issues 11.05.133
Citrix

To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers while the session is ongoing does not work. The reader is visible, but 
cannot be used due to permanently unknown reader status.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1, and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec.
With activated DRI3 and an AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.

VMware Horizon

Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, when using USB redirection for storage devices:
The USB on-insertion feature is only working when the client drive mapping is switched off. 
In the IGEL Setup client drive mapping can be found in: 
Sessions > Horizon Client > Horizon Client Global > Drive Mapping > Enable Drive 
Mapping.
It is also recommended to disable local Storage Hotplug on setup page Devices > Storage 
Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. 
Furthermore, Horizon Client relies on the OS to mount the storage devices themselves. 
Enable local `Storage Hotplug` on setup page Devices > Storage Devices > Storage 
Hotplug.
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External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.
After disconnect of an RDP-based session, the Horizon main window which contains the server or 
sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions isn't possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon. 
You have to switch off the local logon and switch on these two keys in the IGEL registry: 
userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin makes Horizon Client crash upon connection to the remote desktop in 
cases when TCSetup is running at the same time.
When using the PCoIP protocol the virtual channel provided by VMware used for serial port 
and scanner redirection can make Horizon client hang on logout from the remote session. 
This happens if you enable only one of scanner or serial port redirection. The freeze does not occur 
if both redirection methods are enabled or none of them. The Blast Protocol isn't affected by this 
bug.
The respective settings can be found here in the IGEL Registry: 
vmware.view.enable-serial-port-redir 

vmware.view.enable-scanner-redir

Parallels Client

Native USB redirection does not work with Parallels Client.

Chromium

H.264 decoding is not supported anymore.

WiFi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client

There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 20.10 and Cisco JVDI.

Base system

Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are involved)
Unreliable messages in user dialog for applying settings during boot. Could occur when new 
settings were fetched from the UMS.

deskMate
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Some stability issues may remain.

Firmware update

On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode

When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.

VirtualBox

The current VirtualBox Guest Tools/Drivers will not work with VirtualBox 5.2.x or older hosts. 
This results in a black screen and non-working graphic.  
Possible workaround: Installation with Failsafe Installation + Recovery and 
set of  x.drivers.force_vesa  registry key to "true".

Audio

IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantec POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hardware

Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.

Remote Management

AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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Security Fixes 11.05.133
Remote Management

Fixed a possible privilege escalation while sending user logoff event to the UMS.
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New Features 11.05.133
Citrix

Integrated Zoom Media Plugin 5.5.12716.0227
Added: In StoreFront sessions, HTTP can now be selected for the URL in addition to HTTPS.
Implement "Synchronize Citrix password with screensaver" for SelfService. The parameter for 
StoreFront was reused.

UD Pocket

Added official support for Secured Kobra Stick from DIGITTRADE.

VMware Horizon

Added switch for enabling Cisco Webex Meetings within VMware Horizon.
More...

Parameter Cisco Webex Meetings VDI

Registry vmware.view.vdciscomeetings.enable

Type bool

Value enabled / disabled

Removed deprecated ThinPrint virtual channel (tprpdp.so) from Horizon sessions used for 
virtual printing. It is replaced by Horizon's integrated printing mechanism.

Imprivata

Added registry key to overcome the window overlap. That occurred when using local setup or 
hotkeyed applications like the 'Display switch'.
More...

IGEL Setup Registry

Registry imprivata.avoid_focus_ownership

Type bool

Value enabled / disabled

Smartcard

Added smartcard reader driver for DIGITTRADE "Secured Kobra Stick".

WVD

Added WVD printer redirection.
More...

Registry sessions.wvd%.printing.cups
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Value enabled / disabled

Registry print.cups.printer%.map_wvd

Value enabled / disabled

Registry print.cups.printer%.wvd_printer_driver

Value ""

The default Windows driver name is "Microsoft PS Class Driver", which should be installed by 
default and work generically. 
To install a custom printer driver, the exact name must be set and the driver must be installed on 
the WVD side.

Base system

Post-session commands: Added support to monitor multiple sessions and have a post-session 
command triggered if all sessions exited successfully.
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Resolved Issues 11.05.133
Citrix

Integrated HDX Realtime Optimization Pack 2.9.300
Updated Grundig Dictation driver to version 20-09-16. This fixes termination of Citrix sessions 
when USB devices are plugged or unplugged - happens with Citrix Workspace App versions 
newer than 20.09.
Citrix Hardware Decoder doesn't crash anymore when using 12 CPU cores (or even more) at the 
server.

WVD

Fixed forced Azure re-authentication (every 30 minutes)

Parallels Client

Updated Parallels client to version 17.1.3

Teradici PCoIP Client

Teradici client update 21.03

Imprivata

Fixed missing vendor logo

Firefox

Fixed apparmor rule for allowing Firefox to use widevine DRM plugin.

Smartcard

Fixed smartcard resource manager: Reset is triggered when eject of smartcard fails.

Cisco Webex

Updated Cisco Webex Teams VDI to 41.4.0.18516
Updated Cisco Webex Meetings VDI to 41.4.0.162
Please make sure your Webex meetings client version is WBS 41.4.0 or later, otherwise it will 
fail to launch Webex VDI optimized meeting.

Cisco JVDI Client

Updated Cisco JVDI to 14.0.0

IBM_5250

Fixed error in iAccess configuration.

Base system

Fixed bootcode update is done on each reboot on some EFI devices. 
Changed: Minimized periodic write access to permanent storage.

Firmware update
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Added: sftp protocol supports now the following key exchange methods: 
ecdh-sha2-nistp256 (BSI) 

ecdh-sha2-nistp384 (BSI) 

ecdh-sha2-nistp521 (BSI) 

curve25519-sha256 (BSI) 

curve25519-sha256@libssh.org (BSI) 

diffie-hellman-group-exchange-sha256 

diffie-hellman-group-exchange-sha1 

diffie-hellman-group14-sha1 

diffie-hellman-group1-sha1

X11 system

Fixed monitor sorting order to be independent from montior startup time (GTK-3)
Fixed panel on wrong monitor, when original monitor takes longer to come online
Fixed Turkish (Q) and Turkish (F) keyboard layout configuration.
Fixed panel keyboard layout indicator for French (Switzerland), Turkish (Q) and Turkish (F)
keyboard layouts.
Added inhibit screensaver while a Cisco Webex Meetings session is active in Citrix Workspace 
App.

Audio

Fixed not working audio on Intel Tiger Lake-based devices.
Fixed automatic start of output audio stream in ALSA Pulse PCM. The bug caused a complete 
freeze of a Parallels session while playback audio data.
Bugfix for USB audio default device switch and update of igel-sound-control

Hardware

Fixed touchpad issues for some Dynabook laptops.

Remote Management

Fixed execution of generic commands (Deploy Jabra Xpress package) if they invoked as a UMS 
scheduled job.
Fixed handling of UMS scheduled jobs during boot process.

Network

Improved network device order for LG CL600N, LG CN650N
The currently used parameter  tls-remote  is deprecated and was removed in openVPN 

2.4. It was be changed to verify-x509-name .

H264

Citrix Hardware Decoder doesn't crash anymore when using 12 CPU cores (or even more) at the 
server.
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Notes for Release 11.05.120
Software: Version 11.05.120

Release Date: 2021-03-25

Release Notes: Version RN-1105120-1

Last update: 2021-03-23

IGEL OS 11 (see page 382)
IGEL OS Creator (OSC) (see page 400)
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IGEL OS 11
Supported Devices 11.05.120 (see page 383)
Component Versions 11.05.120 (see page 384)
General Information 11.05.120 (see page 392)
Known Issues 11.05.120 (see page 393)
New Features 11.05.120 (see page 396)
Resolved Issues 11.05.120 (see page 398)
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Supported Devices 11.05.120
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.05.120

Clients

Product Version

Chromium (experimental)  88.0.4324.150-igel1612763117

CID Key 6.5.0-2

Cisco JVDI Client 12.9.3

Cisco Webex Teams VDI Client 41.1.0.17621

Cisco Webex Meetings VDI Client 41.2.0.142

Zoom Media Plugin 5.4.59458.0109

Citrix HDX Realtime Media Engine 2.9.200-2506

Citrix Workspace App 19.12.0.19

Citrix Workspace App 20.12.0.12

Citrix Workspace App 21.03.0.38

deskMate Client 2.1.3

deviceTRUST Citrix Channel 20.1.200.0

Crossmatch DP Citrix Channel 0125

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 14.0.0.45623

Evidian AuthMgr 1.5.7617

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech USB for Remote Desktop 6.0.28

FabulaTech Scanner for Remote Desktop 2.7.0.1

FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 78.6.1

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2igel1605251065

IGEL WVD Client 1.0.22igel1612537530



Notes for Release 11.05.120

IGEL OS Release Notes   385 / 1492

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

deviceTRUST RDP Channel 20.1.200.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.11.2-1igel8

Open VPN 2.5.0-1igel1606475118

Zulu JRE 8.48.0.51-2

Parallels Client (64 bit) 17.1.2.1

Spice GTK (Red Hat Virtualization) 0.39-1igel106

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.8.0-1+b1igel71

SpeechWrite 1.0

Teradici PCoIP Software Client 20.10.0-18.04

ThinLinc Client 4.12.0-6517

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 1.0.5-1igel1583919770

VNC Viewer 1.10.1+dfsg-9igel17

VMware Horizon Client 2012-8.1.0-17349998

Voip Client Ekiga 4.0.1-9build1igel6

Dictation

Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20201118

Philips Speech driver 12.9.1

Signature

Kofax SPVC Citrix Channel 3.1.41.0
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signotec Citrix Channel 8.0.9

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard

PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7

PKCS#11 Library cryptovision sc/interface 7.3.1

PKCS#11 Library Gemalto SafeNet 10.7.77

PKCS#11 Library OpenSC 0.21.0-1igel39

PKCS#11 Library SecMaker NetID 6.8.3.21

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel2

Reader Driver Gemalto eToken 10.7.77

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.31-1igel12

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.0-1igel16

Cherry USB2LAN Proxy 3.2.0.3

System Components

OpenSSL 1.0.2n-1ubuntu5.5

OpenSSL 1.1.1-1ubuntu2.1~18.04.7

OpenSSH Client 8.4p1-3igel4

OpenSSH Server 8.4p1-3igel4

Bluetooth stack (bluez) 5.55-0ubuntu1.1igel10
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MESA OpenGL stack 20.2.6-1igel131

VAAPI ABI Version 0.40

VDPAU Library version 1.4-3igel1099

Graphics Driver INTEL 2.99.917+git20200515-igel1013

Graphics Driver ATI/RADEON 19.1.0-2igel1066

Graphics Driver ATI/AMDGPU 19.1.0-2+git20200828igel1064

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 450.102.04-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel1012

Graphics Driver VESA 2.4.0-1igel1010

Input Driver Evdev 2.10.6-2igel1037

Input Driver Elographics 1.4.1-1+b6igel952

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-1ubuntu1igel1009

Input Driver VMMouse 13.1.0-1ubuntu2igel957

Input Driver Wacom 0.39.0-0ubuntu1igel1036

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.9.16 #mainline-lxos-g1615563496

Xorg X11 Server 1.20.10-2igel1100

Xorg Xephyr 1.20.10-2igel1100

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.425

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel13

XFCE4 Window Manager 4.14.2-1~18.04igel1600339249

ISC DHCP Client 4.3.5-3ubuntu7.1

NetworkManager 1.20.4-2ubuntu2.2igel109
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ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.90

GStreamer 0.10 Fluendo h264dec 0.10.58

GStreamer 0.10 Fluendo mp3dec 0.10.40

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.224

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.18.3-1igel283

GStreamer 1.0 Fluendo aacdec 0.10.42.2-8d6d

GStreamer 1.0 Fluendo asfdemux 0.10.90

GStreamer 1.0 Fluendo h264dec 0.10.58

GStreamer 1.0 Fluendo mp3dec 0.10.40

GStreamer 1.0 Fluendo mpeg4videodec 0.10.44

GStreamer 1.0 Fluendo vadec 0.10.224

GStreamer 1.0 Fluendo wmadec 0.10.70

GStreamer 1.0 Fluendo wmvdec 0.10.66

WebKit2Gtk 2.30.4-1igel40

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components

Virtualbox Guest Utils 6.1.18-dfsg-3igel52

Virtualbox X11 Guest Utils 6.1.18-dfsg-3igel52

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1
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Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.20.0-2igel104

Qemu Guest Agent 5.2+dfsg-3igel17

Features with Limited IGEL Support

Mobile Device Access USB (MTP) 1.1.17-3igel5

Mobile Device Access USB (imobile) 1.3.0-5igel11

Mobile Device Access USB (gphoto) 2.5.26-2igel7

VPN OpenConnect 8.10-2igel6

Scanner support 1.0.27-1

VirtualBox 6.1.18-dfsg-3igel52

Services

Service Size Reduced Firmware

Asian Language Support 22.5 M Included

Java SE Runtime Environment 36.0 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

329.0M Included

Ericom PowerTerm InterConnect 15.5 M Included

Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

76.5 M Included

VMware Horizon
RDP

4.5 M Included

Cendio ThinLinc 10.0 M Included

Printing (Internet printing protocol CUPS) 22.2 M Included

NoMachine NX 26.8 M Included

VMware Horizon 131.2 M Included

Voice over IP (Ekiga) 6.5 M Included

Citrix Appliance 768.0 K Included
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NCP Enterprise VPN Client 27.0 M Not included

Fluendo GStreamer Codec Plugins 6.5 M Included

IBM i Access Client Solutions 72.5 M Not included

Red Hat Enterprise Virtualization 3.0 M Included

Parallels Client 5.5 M Included

NVIDIA graphics driver 126.8 M Not included

Imprivata Appliance 10.8 M Included

Evidian AuthMgr 2.5 M Included

Hardware Video Acceleration 13.5 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.5 M Included

Cisco JVDI client 45.8 M Included

PrinterLogic 40.8 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M Not included

Stratusphere UX CID Key software 2.8 M Not included

Elastic Filebeat 15.8 M Not included

WVD 88.2 M Included

Local Browser (Chromium) 87.8 M Not included

deskMate client 5.8 M Included

Cisco Webex Teams VDI 36.8 M Not included

Cisco Webex Meetings VDI 32.2 M Not included

Zoom VDI Media Plugin 42.2 M Not included

DriveLock 13.2 M Included

SpeechWrite Client 256.0 K Included

Teradici PCoIP Client 14.5 M Included

90meter Smart Card Support 256.0 K Included
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Virtualbox (Limited support)

Mobile Device Access USB (Limited 
support)

VPN OpenConnect (Limited support) 

Scanner support / SANE (Limited support)

Limited Support Features

256.0K Not included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.0 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 63.8 M Not included
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General Information 11.05.120

The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver

To be beneficial to all new features and implementations, it is recommended to use UMS 6.07.100 or 
higher and update the corresponding profiles.



Firmware downgrade to older versions (11.01 or 11.02) is not possible, due to the unsigned firmware 
update files.


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Known Issues 11.05.120
Citrix

For using multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when Enable Secure ICA is active for the specific delivery 
group.
Adding smartcard readers while the session is ongoing does not work. The reader is visible, but 
cannot be used due to permanently unknown reader status.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1, and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware-accelerated H.264 
deep compression codec.
With activated DRI3 and an AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected by this issue.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.

VMware Horizon

Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, when using USB redirection for storage devices:
The USB on-insertion feature is only working when the client drive mapping is switched off. 
In the IGEL Setup client drive mapping can be found in: 
Sessions > Horizon Client > Horizon Client Global > Drive Mapping > Enable Drive 
Mapping.
It is also recommended to disable local Storage Hotplug on setup page Devices > Storage 
Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. 
Furthermore, Horizon Client relies on the OS to mount the storage devices themselves. 
Enable local `Storage Hotplug` on setup page Devices > Storage Devices > Storage 
Hotplug.
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External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.
After disconnect of an RDP-based session, the Horizon main window which contains the server or 
sessions overview, cannot be resized anymore.
Copying Text from Horizon Blast sessions isn't possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with the local 
logon. 
You have to switch off the local logon and switch on these two keys in the IGEL registry: 
userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin makes Horizon Client crash upon connection to the remote desktop in 
cases when TCSetup is running at the same time.
When using the PCoIP protocol the virtual channel provided by VMware used for serial port 
and scanner redirection can make Horizon client hang on logout from the remote session. 
This happens if you enable only one of scanner or serial port redirection. The freeze does not occur 
if both redirection methods are enabled or none of them. The Blast Protocol isn't affected by this 
bug 
The respective settings can be found here in the IGEL Registry: 
vmware.view.enable-serial-port-redir 

vmware.view.enable-scanner-redir

Parallels Client

Native USB redirection does not work with Parallels Client.

Chromium

H.264 decoding is not supported anymore / in this release.

WiFi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Cisco JVDI Client

There may be a segfault shown in the logs (during log out of Citrix Desktop session). Occurs only 
when using Citrix Workspace app 20.10 and Cisco JVDI.

Base system

Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.
Update from memory stick requires network online state (at least when multiple update stages 
are involved)
Unreliable messages in user dialog for applying settings during boot. Could occur when new 
settings were fetched from the UMS.

deskMate
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Some stability issues may remain.

Firmware update

On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Please visit Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a possible solution and 
additional information.

Appliance Mode

When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported.
The Console Invocation has to allow Native client (auto is also possible) and should be started in 
fullscreen to prevent any opening windows.

VirtualBox

The current VirtualBox Guest Tools/Drivers will not work with VirtualBox 5.2.x or older hosts. 
This results in a black screen and non-working graphic.  
Possible workaround: Installation with Failsafe Installation + Recovery and 
set of  x.drivers.force_vesa  registry key to true.

Audio

IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
Audio jack detection on Advantec POC-W243L does not work. Therefore, sound output goes 
through a possibly connected headset and also the internal speakers.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hardware

Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work on INTEL-based 
devices.

Remote Management

AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.
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New Features 11.05.120
OSC Installer

Enhanced OSC Installer for creating so-called factory preload images (master images)
Added possibility to add initial settings to OSC Installer ISO.

Citrix

Added automatic configuration of the Citrix webcam redirection in ICA sessions.
More...

IGEL Setup Sessions > Citrix > Citrix Global > HDX Multimedia

Parameter Automatic HDX webcam configuration

Registry ica.igel_hdxwebcam.enabled

Value enabled / disabled

IGEL Setup Sessions > Citrix > Citrix Global > HDX Multimedia

Parameter Resolution grade

Registry ica.igel_hdxwebcam.quality

Range [Very low][Low][Normal] [High][Very high][Best]

IGEL Setup Sessions > Citrix > Citrix Global > HDX Multimedia

Parameter Minimal frame rate

Registry ica.igel_hdxwebcam.framerate

Value 15

Added configuration for h264 encoding in the Citrix webcam redirection.
More...

Parameter HDX Webcam H264 encoding

Registry ica.wfclient.hdxh264inputenabled

Value enabled / disabled

Added configuration for native h264 encoding provided by webcam and used in the Citrix 
webcam redirection. This parameter requires the  ica.wfclient.hdxh264inputenabled
to be set to true.
More...

Parameter HDX Webcam H264 native
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Registry ica.wfclient.hdxh264enablenative

Value enabled / disabled

Available Citrix Workspace apps in this release: 21.03(default), 20.12 and 19.12
Added new Citrix feature for an enhanced experience of multi-monitor scenarios.
You can save the selection for a multi-monitor screen layout. Pinning helps to relaunch a session 
with the selected layout, resulting in an optimized user experience. 
Note: Works only with Self Service.
More...

Parameter Enhanced Experience of Multi-Monitor scenarios

Registry ica.authman.screenpinenabled

Value enabled / disabled

All parameters of the Citrix set log program are now available via setup under 
ica.logging.setlog . Logging can be set easier and permanent. 

Therefore, changed the structure of parameters to show the inheritance.

VMware Horizon

Fixed broken session handling when using Webex Teams, Horizon session could only be started 
once.

WVD

New WVD icon.

Network

Added Realtek RTL8125 2.5Gigabit Ethernet driver.

WiFi

Added support for Realtek RTW8852AE WiFi device.

Hardware

Added hardware support for LG 34CN650N AiO.
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Resolved Issues 11.05.120
OSC Installer

Fixed OSC 11.05.xxx not deployable with Deployment Appliance (ODA).

Citrix

Fixed link to icacontrol
Fixed: Several audio device problems through an enabled registry 
key  ica.module.vdcamversion4support . The default was changed to disabled. This 
ensures that Citrix CWA behaves as before.
More...

Parameter Multiple Audio Device support

Registry ica.module.vdcamversion4support

Value enabled / disabled

Fixed Citrix logging, the log file is written as expected.

RDP/IGEL RDP Client 2

Added parameter to enable serverside audio for RDP sessions.
More...

Parameter Enable serverside audio

Registry sessions.winconnect%.option.enable-
serverside-audio

Value enabled / disabled

Parallels Client

Fixed an issue where the post-session command got triggered too early when using the Parallels 
Client.

Network

Fixed network device order for LG 34CN650W and CL600W devices.
Fixed a graphics distortion in Setup Assistant

WiFi

Added registry key for tweaking the WPA supplicant. In general, the value is a comma-separated 
list of names. If it contains LATESUCCESS, a late EAP-Success message will be ignored.
More...

Parameter IGEL Tweaks
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Registry network.interfaces.wirelesslan.device0.wpa.
igel_tweaks

Value " "

Added registry key to activate the use of Broadcom sta driver (needed for older Broadcom WiFi 
devices).
More...

Parameter Use Broadcom sta driver instead of b43 for WLAN

Registry network.drivers.broadcom.use_broadcom_sta

Value enabled / disabled

NCP VPN

Fixed NCP session start.

Smartcard

Fixed: Usage of Nexus Personal smartcard in combination with Gemalto IDBridge CT30 reader, in 
Citrix and RDP

Base system

Fixed custom environment variables when an administrator password is set.
Fixed boot problems due to 2 partitions are marked active (legacy boot with GPT partition table).
Fixed RDP not triggering the post-session command on session disconnect.
Fixed grub boot code and boot error message: Unknown TPM error.
Fixed Demo License browser crashes after EULA.

X11 system

Fixed taskbar hide/show delay has no effect

VirtualBox

Fixed screen resolution issues with SINA OS 3.5.1 version.
Fixed screen remains black after started multi-monitor configuration in VirtualBox.
Fixed second screen in VirtualBox environment only is configured with 1024x768.
Fixed issue when getting screen resolution from special VirtualBox version.

Audio

Improved playback function in the ALSA Pulse PCM - for applications using ALSA API (e.g. Citrix 
Workspace App).

Hardware

Fixed microphone detection on Dell Optiplex devices.

Remote Management

Fixed WOL proxy command.
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IGEL OS Creator (OSC)

Supported Devices
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.

Component Versions 11.05.120 (see page 401)
New Features 11.05.120 (see page 403)
Resolved Issues 11.05.120 (see page 404)
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Component Versions 11.05.120

Clients

Product Version

Zulu JRE 8.48.0.51-2

System Components

OpenSSL 1.0.2n-1ubuntu5.5

OpenSSL 1.1.1-1ubuntu2.1~18.04.7

Bluetooth stack (bluez) 5.55-0ubuntu1.1igel10

MESA OpenGL stack 20.2.6-1igel131

VDPAU Library version 1.4-3igel1099

Graphics Driver INTEL 2.99.917+git20200515-igel1013

Graphics Driver ATI/RADEON 19.1.0-2igel1066

Graphics Driver ATI/AMDGPU 19.1.0-2+git20200828igel1064

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 450.102.04-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel1012

Graphics Driver VESA 2.4.0-1igel1010

Input Driver Evdev 2.10.6-2igel1037

Input Driver Elographics 1.4.1-1+b6igel952

Input Driver Synaptics 1.9.1-1ubuntu1igel1009

Input Driver VMMouse 13.1.0-1ubuntu2igel957

Input Driver Wacom 0.39.0-0ubuntu1igel1036

Kernel 5.9.16 #mainline-lxos-g1615563496

Xorg X11 Server 1.20.10-2igel1100

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel13
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XFCE4 Window Manager 4.14.2-1~18.04igel1600339249

ISC DHCP Client 4.3.5-3ubuntu7.1

Python3 3.6.9

VM Guest Support Components

Virtualbox Guest Utils 6.1.18-dfsg-3igel52

Virtualbox X11 Guest Utils 6.1.18-dfsg-3igel52

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.20.0-2igel104

Qemu Guest Agent 5.2+dfsg-3igel17

Services

Service Size Reduced Firmware

Java SE Runtime Environment 36.0 M Included

NVIDIA graphics driver 122.5 M Included
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•
•

New Features 11.05.120
OSC Installer

Enhanced OSC Installer for creating so-called factory preload images (master images)
Added possibility to add initial settings to OSC Installer ISO.
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•

Resolved Issues 11.05.120
OSC Installer

Fixed OSC 11.05.xxx not deployable with Deployment Appliance (ODA).
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Notes for Release 11.05.100
Software: Version 11.05.100

Release Date: 2021-02-25

Release Notes: Version RN-1105100-1

Last update: 2021-03-08

IGEL OS 11 (see page 406)
IGEL OS Creator (OSC) (see page 462)
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•
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•

IGEL OS 11
Supported Devices 11.05.100 (see page 407)
Component Versions 11.05.100 (see page 408)
General Information 11.05.100 (see page 416)
Known Issues 11.05.100 (see page 417)
Security Fixes 11.05.100 (see page 420)
New Features 11.05.100 (see page 425)
Resolved Issues 11.05.100 (see page 438)
CA Certificates Contained in IGEL OS 11.05 (see page 449)
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Supported Devices 11.05.100
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.



Notes for Release 11.05.100

IGEL OS Release Notes   408 / 1492

Component Versions 11.05.100

Clients

Product Version

Chromium 88.0.4324.150-igel1612763117

CID Key 6.5.0-2

Cisco JVDI Client 12.9.3

Cisco Webex Teams VDI Client 41.1.0.17621

Cisco Webex Meetings VDI Client 41.2.0.142

Zoom Media Plugin 5.4.59458.0109

Citrix HDX Realtime Media Engine 2.9.200-2506

Citrix Workspace App 19.12.0.19

Citrix Workspace App 20.10.0.6

Citrix Workspace App 20.12.0.12

deskMate Client 2.1.3

deviceTRUST Citrix Channel 20.1.200.0

Crossmatch DP Citrix Channel 0125

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 14.0.0.45623

Evidian AuthMgr 1.5.7617

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech USB for Remote Desktop 6.0.28

FabulaTech Scanner for Remote Desktop 2.7.0.1

FabulaTech Webcam for Remote Desktop 2.8.10

Firefox 78.6.1

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2igel1605251065

IGEL WVD Client 1.0.22igel1612537530
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Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

deviceTRUST RDP Channel 20.1.200.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.11.2-1igel8

Open VPN 2.5.0-1igel1606475118

Zulu JRE 8.48.0.51-2

Parallels Client (64 bit) 17.1.2.1

Spice GTK (Red Hat Virtualization) 0.39-1igel106

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.8.0-1+b1igel71

SpeechWrite 1.0

Teradici PCoIP Software Client 20.10.0-18.04

ThinLinc Client 4.12.0-6517

ThinPrint Client 7-7.6.126

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 1.0.5-1igel1583919770

VNC Viewer 1.10.1+dfsg-9igel17

VMware Horizon Client 2012-8.1.0-17349998

Voip Client Ekiga 4.0.1-9build1igel6

Dictation

Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20201118

Philips Speech driver 12.9.1

Signature

Kofax SPVC Citrix Channel 3.1.41.0
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signotec Citrix Channel 8.0.9

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard

PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7

PKCS#11 Library cryptovision sc/interface 7.3.1

PKCS#11 Library Gemalto SafeNet 10.7.77

PKCS#11 Library OpenSC 0.21.0-1igel39

PKCS#11 Library SecMaker NetID 6.8.3.21

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel2

Reader Driver Gemalto eToken 10.7.77

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.31-1igel11

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.9.0-1igel16

Cherry USB2LAN Proxy 3.2.0.3

System Components

OpenSSL 1.0.2n-1ubuntu5.5

OpenSSL 1.1.1-1ubuntu2.1~18.04.7

OpenSSH Client 8.4p1-3igel4

OpenSSH Server 8.4p1-3igel4

Bluetooth stack (bluez) 5.55-0ubuntu1.1igel10
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MESA OpenGL stack 20.2.6-1igel131

VAAPI ABI Version 0.40

VDPAU Library version 1.4-3igel1099

Graphics Driver INTEL 2.99.917+git20200515-igel1013

Graphics Driver ATI/RADEON 19.1.0-2igel1066

Graphics Driver ATI/AMDGPU 19.1.0-2+git20200828igel1064

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 450.102.04-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel1012

Graphics Driver VESA 2.4.0-1igel1010

Input Driver Evdev 2.10.6-2igel1037

Input Driver Elographics 1.4.1-1+b6igel952

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-1ubuntu1igel1009

Input Driver VMMouse 13.1.0-1ubuntu2igel957

Input Driver Wacom 0.39.0-0ubuntu1igel1036

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.9.16 #mainline-lxos-g1613995475

Xorg X11 Server 1.20.10-2igel1100

Xorg Xephyr 1.20.10-2igel1100

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.425

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel13

XFCE4 Window Manager 4.14.2-1~18.04igel1600339249

ISC DHCP Client 4.3.5-3ubuntu7.1

NetworkManager 1.20.4-2ubuntu2.2igel105
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ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42

GStreamer 0.10 Fluendo asfdemux 0.10.90

GStreamer 0.10 Fluendo h264dec 0.10.58

GStreamer 0.10 Fluendo mp3dec 0.10.40

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.224

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.18.3-1igel283

GStreamer 1.0 Fluendo aacdec 0.10.42.2-8d6d

GStreamer 1.0 Fluendo asfdemux 0.10.90

GStreamer 1.0 Fluendo h264dec 0.10.58

GStreamer 1.0 Fluendo mp3dec 0.10.40

GStreamer 1.0 Fluendo mpeg4videodec 0.10.44

GStreamer 1.0 Fluendo vadec 0.10.224

GStreamer 1.0 Fluendo wmadec 0.10.70

GStreamer 1.0 Fluendo wmvdec 0.10.66

WebKit2Gtk 2.30.4-1igel40

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components

Virtualbox Guest Utils 6.1.18-dfsg-1igel49

Virtualbox X11 Guest Utils 6.1.18-dfsg-1igel49

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1
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Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.20.0-2igel104

Qemu Guest Agent 5.2+dfsg-3igel17

Features with Limited IGEL Support

Mobile Device Access USB (MTP) 1.1.17-3igel5

Mobile Device Access USB (imobile) 1.3.0-5igel11

Mobile Device Access USB (gphoto) 2.5.26-2igel7

VPN OpenConnect 8.10-2igel6

Scanner support 1.0.27-1

VirtualBox 6.1.18-dfsg-1igel49

Services

Service Size Reduced Firmware

Asian Language Support 22.5 M Included

Java SE Runtime Environment 36.0 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

235.8 M Included

Ericom PowerTerm InterConnect 15.5 M Included

Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

76.5 M Included

VMware Horizon
RDP

4.5 M Included

Cendio ThinLinc 10.0 M Included

Printing (Internet printing protocol CUPS) 22.2 M Included

NoMachine NX 26.8 M Included

VMware Horizon 131.2 M Included

Voice over IP (Ekiga) 6.5 M Included

Citrix Appliance 768.0 K Included
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NCP Enterprise VPN Client 27.0 M Not included

Fluendo GStreamer Codec Plugins 6.5 M Included

IBM i Access Client Solutions 72.5 M Not included

Red Hat Enterprise Virtualization 3.0 M Included

Parallels Client 5.5 M Included

NVIDIA graphics driver 126.8 M Not included

Imprivata Appliance 10.8 M Included

Evidian AuthMgr 2.5 M Included

Hardware Video Acceleration 13.5 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 3.5 M Included

Cisco JVDI client 45.8 M Included

PrinterLogic 40.8 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M Not included

Stratusphere UX CID Key software 2.8 M Not included

Elastic Filebeat 15.8 M Not included

WVD 88.2 M Included

Local Browser (Chromium) 87.8 M Not included

deskMate client 5.8 M Included

Cisco Webex Teams VDI 36.8 M Not included

Cisco Webex Meetings VDI 32.2 M Not included

Zoom VDI Media Plugin 42.2 M Not included

DriveLock 13.2 M Included

SpeechWrite Client 256.0 K Included

Teradici PCoIP Client 14.5 M Included

90meter Smart Card Support 256.0 K Included



Notes for Release 11.05.100

IGEL OS Release Notes   415 / 1492

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.0 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 63.8 M Not included
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General Information 11.05.100

The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver

To be beneficial to all new features and implementations, it is recommended to use UMS 6.07.100 or 
higher and update the corresponding profiles.



Firmware downgrade to older versions (11.01 or 11.02) is not possible, due to the unsigned firmware 
update files.


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Known Issues 11.05.100
Firmware Update

On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Check Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a solution.

Citrix

With activated DRI3 and an AMD GPU Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1 and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery group.

Adding smartcard readers while the session is ongoing does not work. The reader is visible, but 
cannot be used due to permanently unknown reader status.

VMware Horizon

Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Enable local Storage Hotplug on Setup page Devices > Storage Devices > Storage 
Hotplug.
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External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.
After the disconnect of an RDP-based session, the Horizon main window which contains the 
server or sessions overview cannot be resized anymore.
Copying a text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with local logon. 
Workaround: Switch off local logon and switch on the corresponding two keys via IGEL registry: 

userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide
Zoom VDI Media Plugin makes Horizon Client crash upon connection to the remote desktop in 
cases when TC Setup is running at the same time.

Chromium

H.264 decoding is not supported anymore.

Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters do not work after system suspend/resume. Workaround: 
Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Parallels Client

Native USB redirection does not work with Parallels Client.

Cisco JVDI Client

There may be a segfault shown in the logs (during logout of Citrix Desktop session). This occurs 
only when using Citrix Workspace app 20.10 and Cisco JVDI.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hyper-V

Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.

VirtualBox

The current VirtualBox Guest Tools/Drivers will not work with VirtualBox 5.2.x or older hosts 
which leads to a black screen and non-working graphics.
Possible workaround: Install with 'Failsafe Installation + Recovery' and set the registry key 
x.drivers.force_vesa  to 'true'.

Audio

Audio jack detection on Advantech POC-W243L doesn't work. Therefore, sound output 
goes through a possibly connected headset and the internal speakers.
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.

Hardware
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Some newer Delock 62599 active DisplayPort-to-DVI (4k) adapters only work with INTEL 
devices.

Remote Management

AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.

Base system

Update from memory stick requires network online state (at least when multiple update stages 
are involved).
Unreliable messages in user dialog for applying settings during boot. Could occur when new 
settings were fetched from the UMS.

deskMate

Some stability issues may remain.

Appliance Mode

When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.



Notes for Release 11.05.100

IGEL OS Release Notes   420 / 1492

•

•

•
•
•
•

Security Fixes 11.05.100
Citrix

Fixed file properties for /var/log/.ctxlogconf  adjusted, so no code can be executed by 
the user.

Firefox

Added view-source:file:///  to the blocklist in case the browser should not have 
random access to the local file system.

Base system

Fixed bluez security issue CVE-2020-0556.
Fixed librsvg security issue CVE-2019-20446.
Fixed ppp security issue CVE-2020-15704.
Fixed chromium-browser security issues:
More...

CVE-2020-6541, CVE-2020-6540,
CVE-2020-6539, CVE-2020-6538, CVE-2020-6537, CVE-2020-6536, CVE-2020-6535,
CVE-2020-6534, CVE-2020-6533, CVE-2020-6532, CVE-2020-6531, CVE-2020-6530,
CVE-2020-6529, CVE-2020-6528, CVE-2020-6527, CVE-2020-6526, CVE-2020-6525,
CVE-2020-6524, CVE-2020-6523, CVE-2020-6522, CVE-2020-6521, CVE-2020-6520,
CVE-2020-6519, CVE-2020-6518, CVE-2020-6517, CVE-2020-6516, CVE-2020-6515,
CVE-2020-6514, CVE-2020-6513, CVE-2020-6512, CVE-2020-6511, CVE-2020-6510,
CVE-2020-6509, CVE-2020-6507, CVE-2020-6506, CVE-2020-6505, CVE-2020-6496,
CVE-2020-6495, CVE-2020-6494, CVE-2020-6493, CVE-2020-6571, CVE-2020-6570,
CVE-2020-6569, CVE-2020-6568, CVE-2020-6567, CVE-2020-6566, CVE-2020-6565,
CVE-2020-6564, CVE-2020-6563, CVE-2020-6562, CVE-2020-6561, CVE-2020-6560,
CVE-2020-6559, CVE-2020-6558, CVE-2020-6556, CVE-2020-6555, CVE-2020-6554,
CVE-2020-6553, CVE-2020-6552, CVE-2020-6551, CVE-2020-6550, CVE-2020-6549,
CVE-2020-6548, CVE-2020-6547, CVE-2020-6546, CVE-2020-6545, CVE-2020-6544,
CVE-2020-6543, CVE-2020-6542, CVE-2020-6576, CVE-2020-6575, CVE-2020-6574,
CVE-2020-6573, CVE-2020-15966, CVE-2020-15965, CVE-2020-15964, CVE-2020-15963,
CVE-2020-15962, CVE-2020-15961, CVE-2020-15960, CVE-2020-15959, CVE-2020-6557,
CVE-2020-15992, CVE-2020-15991, CVE-2020-15990, CVE-2020-15989,
CVE-2020-15988, CVE-2020-15987, CVE-2020-15986, CVE-2020-15985,
CVE-2020-15984, CVE-2020-15983, CVE-2020-15982, CVE-2020-15981,
CVE-2020-15980, CVE-2020-15979, CVE-2020-15978, CVE-2020-15977,
CVE-2020-15976, CVE-2020-15975, CVE-2020-15974, CVE-2020-15973,
CVE-2020-15972, CVE-2020-15971, CVE-2020-15970, CVE-2020-15969,
CVE-2020-15968, CVE-2020-15967, CVE-2020-16017, CVE-2020-16013,
CVE-2020-16011, CVE-2020-16009, CVE-2020-16008, CVE-2020-16007,
CVE-2020-16006, CVE-2020-16005, CVE-2020-16003, CVE-2020-16002,
CVE-2020-16001, CVE-2020-16000, CVE-2020-15999, CVE-2020-16036,
CVE-2020-16035, CVE-2020-16034, CVE-2020-16033, CVE-2020-16032,
CVE-2020-16031, CVE-2020-16030, CVE-2020-16029, CVE-2020-16028,
CVE-2020-16027, CVE-2020-16026, CVE-2020-16025, CVE-2020-16024,
CVE-2020-16023, CVE-2020-16022, CVE-2020-16021, CVE-2020-16020,
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CVE-2020-16019, CVE-2020-16018, CVE-2020-16015, CVE-2020-16014,
CVE-2020-16012, CVE-2019-8075, CVE-2020-16042, CVE-2020-16041, CVE-2020-16040,
CVE-2020-16039, CVE-2020-16038, CVE-2020-16037, CVE-2021-21116,
CVE-2021-21115, CVE-2021-21114, CVE-2021-21113, CVE-2021-21112,
CVE-2021-21111, CVE-2021-21110, CVE-2021-21109, CVE-2021-21108,
CVE-2021-21107, CVE-2021-21106, CVE-2020-16043, CVE-2020-15995,
CVE-2021-21148, CVE-2021-21147, CVE-2021-21146, CVE-2021-21145,
CVE-2021-21144, CVE-2021-21143, CVE-2021-21142, CVE-2021-21141,
CVE-2021-21140, CVE-2021-21139, CVE-2021-21138, CVE-2021-21137,
CVE-2021-21136, CVE-2021-21135, CVE-2021-21134, CVE-2021-21133,
CVE-2021-21132, CVE-2021-21131, CVE-2021-21130, CVE-2021-21129,
CVE-2021-21128, CVE-2021-21127, CVE-2021-21126, CVE-2021-21125,
CVE-2021-21124, CVE-2021-21123, CVE-2021-21122, CVE-2021-21121,
CVE-2021-21120, CVE-2021-21119, CVE-2021-21118, CVE-2021-21117, and
CVE-2020-16044.

Fixed ffmpeg security issues CVE-2020-14212, CVE-2020-13904, CVE-2020-35965, and 
CVE-2020-35964.
Fixed pulseaudio security issues CVE-2020-11931 and CVE-2020-16123.
Fixed nss security issues CVE-2020-6829, CVE-2020-12401, CVE-2020-12400, and CVE-2020-12403.
Fixed libvirt security issues CVE-2020-14301, CVE-2020-12430, CVE-2020-10701, and 
CVE-2020-14339.
Fixed libslirp security issues CVE-2020-10756, CVE-2020-29130, and CVE-2020-29129.
Fixed samba security issues:
More...

CVE-2020-14303, CVE-2020-1472, CVE-2020-1472,
CVE-2020-14383, CVE-2020-14323, and CVE-2020-14318.

Fixed qemu security issues:
More...

CVE-2020-16092, CVE-2020-14364, CVE-2020-15863, CVE-2020-13800,
CVE-2020-13791, CVE-2020-13754, CVE-2020-13659, CVE-2020-13362,
CVE-2020-13361, CVE-2020-13253, CVE-2020-12829, CVE-2020-10761, 
CVE-2020-28916, CVE-2020-27821, CVE-2020-27661, CVE-2020-27617,
CVE-2020-27616, CVE-2020-25723, CVE-2020-25707, CVE-2020-25625, 
CVE-2020-25624, CVE-2020-25085, CVE-2020-25084, and CVE-2020-15859.

Fixed bind9 security issues CVE-2020-8624, CVE-2020-8623, and CVE-2020-8622.
Fixed grub2 security issues:
More...

CVE-2020-10713, CVE-2020-14308, CVE-2020-14309, CVE-2020-14310,
CVE-2020-14311, CVE-2020-15706, and CVE-2020-15707.

Fixed sane-backends security issues:
More...

CVE-2020-12867, CVE-2020-12866, CVE-2020-12865, CVE-2020-12864,
CVE-2020-12863, CVE-2020-12862, and CVE-2020-12861.

Fixed ghostscript security issues:
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More...

CVE-2020-17538, CVE-2020-16310, CVE-2020-16309, CVE-2020-16308,
CVE-2020-16307, CVE-2020-16306, CVE-2020-16305, CVE-2020-16304, 
CVE-2020-16303, CVE-2020-16302, CVE-2020-16301, CVE-2020-16300, 
CVE-2020-16299, CVE-2020-16298, CVE-2020-16297, CVE-2020-16296, 
CVE-2020-16295, CVE-2020-16294, CVE-2020-16293, CVE-2020-16292,
CVE-2020-16291, CVE-2020-16290, CVE-2020-16289, CVE-2020-16288, 
CVE-2020-16287, CVE-2020-16, CVE-2020-8112, CVE-2020-6851, 
CVE-2020-27845, CVE-2020-27843, CVE-2020-27842, CVE-2020-27841,
CVE-2020-27824, CVE-2020-27814, and CVE-2018-5727.

Fixed net-snmp security issues CVE-2020-15862 and CVE-2020-15861.
Fixed curl security issues: 
More...

CVE-2020-8231, CVE-2020-8177, CVE-2020-8169,
CVE-2020-8286, CVE-2020-8285, and CVE-2020-8284.

Fixed chrony security issue CVE-2020-14367.
Fixed libx11 security issue CVE-2020-14344. 
Fixed xorg-server security issues:
More...

CVE-2020-14347, CVE-2020-25712, CVE-2020-14360, CVE-2020-14362,
CVE-2020-14361, CVE-2020-14346, and CVE-2020-14345.

Fixed cairo security issues CVE-2018-19876 and CVE-2020-35492.
Fixed openssl1.0 security issues:
More...

CVE-2020-1968, CVE-2019-1563, CVE-2019-1551,
CVE-2019-1547, and CVE-2020-1971.

Fixed libproxy security issues CVE-2020-25219 and CVE-2020-26154.
Fixed gnupg2 security issue CVE-2019-14855.
Fixed util-linux security issue CVE-2018-7738. 
Fixed ntp security issue CVE-2019-8936.
Fixed tigervnc security issue CVE-2020-26117.
Fixed brotli security issue CVE-2020-8927.
Fixed vim security issue CVE-2019-20807.
Fixed python2.7 security issue CVE-2020-26116.
Fixed python3.6 security issue CVE-2020-26116.
Fixed freetype security issue CVE-2020-15999.
Fixed perl security issues CVE-2020-12723, CVE-2020-10878 and CVE-2020-10543.
Fixed spice security issue CVE-2020-14355.
Fixed glibc security issue CVE-2017-18269.
Fixed python-cryptography security issue CVE-2020-25659.
Fixed openldap security issues CVE-2020-25692, CVE-2020-25710, and CVE-2020-25709.
Fixed libexif security issue CVE-2020-0452. 
Fixed krb5 security issue CVE-2020-28196.
Fixed libvncserver security issues CVE-2018-21247, and CVE-2020-14396.
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Fixed poppler security issues CVE-2020-27778, CVE-2019-9959, CVE-2019-10871, and 
CVE-2018-21009.
Fixed xdg-utils security issue CVE-2020-27748. 
Fixed wpa security issue CVE-2020-12695.
Fixed x11vnc security issue CVE-2020-29074.
Fixed spice-gtk security issue CVE-2020-14355.
Fixed libssh2 security issues CVE-2019-17498 and CVE-2019-13115.
Fixed spice-vdagent security issues:
More...

CVE-2020-25653, CVE-2020-25652, CVE-2020-25651, 
CVE-2020-25650, and CVE-2020-2565.

Fixed openssl security issue CVE-2020-1971.
Fixed libxml2 security issue CVE-2020-24977.
Fixed webkit2gtk security issues:
More...

CVE-2020-9983, CVE-2020-9952, CVE-2020-9951,
CVE-2020-9948, and CVE-2020-13584.

Fixed lxml security issue CVE-2020-27783.
Fixed p11-kit security issues CVE-2020-29363, CVE-2020-29362, and CVE-2020-29361.
Fixed wavpack security issue CVE-2020-35738.
Fixed nvidia-graphics-drivers-450 security issues CVE-2021-1053 and CVE-2021-1052.
Fixed tar security issues CVE-2019-9923 and CVE-2018-20482. 
Fixed pillow security issues CVE-2020-35655 and CVE-2020-35653.
Fixed dnsmasq security issues:
More...

CVE-2020-25687, CVE-2020-25686, CVE-2020-25685,
CVE-2020-25684, CVE-2020-25683, CVE-2020-25682, 
CVE-2020-25681 and CVE-2019-14834.

Fixed sudo security issues CVE-2021-3156 and CVE-2021-23239.
Fixed privilege escalation via environment variable PATH  in /bin/usershell  binary.

Fixed privilege escalation via environment variables in the /bin/update  binary.
Fixed BleedingTooth security issue which means CVE-2020-12351, CVE-2020-12352 and 
CVE-2020-24490.
Fixed kernel security issues named Platypus (CVE-2020-8694 and CVE-2020-8695).
Fixed possible security issue
Fixed a local command injection with SSH session.

Remote Management

Added secure channel for following commands
show_message , get_file_from_url , write_file_to_url

and  upload_tc_support_information
sends all relevant data in a secured way.
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Fixed a secure terminal and secure VNC shadowing remote code execution vulnerability.
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New Features 11.05.100
Citrix

The new "screen pinning" feature for Citrix desktop sessions has been integrated. With this 
feature, it is possible to start multiple Citrix desktop sessions on different screens. 
The following parameters have been added for this purpose:

This parameter defines the session name on which the settings are to be used. Also the 
known wildcards like * and ? are possible here.
More...

IGEL Setup Sessions > Citrix > Citrix Global > Window

Parameter Citrix session name

Registry ica.destination_window.session%.nam

e

Value ""

The parameter defines which mode should be used.
More...

IGEL Setup Sessions > Citrix > Citrix Global > Window

Parameter Multimonitor full-screen mode

Registry ica.destination_window.session%.mult

imonitor_mode

Range [Restrict full-screen session to one monitor] 
[Expand full-screen session across all monitors]
[Expand the session over a self-selected number of 
monitors]

For "Restrict full-screen session to one monitor" 
also  ica.destination_window.session%.monitor  needs to be set.
For "Expand the session over a self-selected number of monitors" 
also  ica.destination_window.session%.multimonitor_selection  needs
to be set.
Further information is also offered via tooltip.
More...

IGEL Setup Sessions > Citrix > Citrix Global > Window

Parameter Desktop session start monitor
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Registry ica.destination_window.session%.mon

itor

Range [1st Monitor][2nd Monitor][3rd Monitor][4rd ...]

IGEL Setup Sessions > Citrix > Citrix Global > Window

Parameter Monitor selection

Registry ica.destination_window.session%.mul

timonitor_selection

Value ""

Integrated HDX RTME 2.9.200 for the usage of SfB (Skype for Business).
Available Citrix Workspace apps in this release: 20.12 (default), 20.10 and 19.12.
Added new feature, where multiple audio devices could be mapped inside the sessions. This 
will display audio devices with their device name and not only HDX audio.
More...

Parameter Multiple Audio Device support

Registry ica.module.vdcamversion4support

Value true/false

Note: Bluetooth devices are currently not supported for Device Redirection.
New centralized Citrix logging in IGEL OS, only one parameter is needed to activate logging.
More...

Parameter Enable logging for Citrix sessions

Registry ica.logging.debug

Value on/off

Since Workspace app 20.09, the tool setlog is used to configure the logging. For this purpose, 
parameters are provided in the registry ica.logging.setlog , but usually nothing needs to 
be changed.
Fixed issue: mic and webcam devices can be redirected using Browser Content Redirection.
More...

Parameter Enables mic and webcam redirection using BCR

Registry ica.allregions.cefenablemediadevices

Value [Factory default is "**"] [False][True]
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Added new parameter Readers Status Poll Period to specify the delay, in milliseconds, for 
reading information from a smartcard after the card is inserted or removed, or a reader is 
disconnected, etc.
More...

Parameter Readers Status Poll Period

Registry ica.wfclient.ReadersStatusPollPeriod

Type Integer

Value 250/Range 100..5000

Integrated Zoom Media Plugin 5.4.59458.0109
The default value of the parameter  ica.module.vdcamversion4support  was set to 
"true".

WVD

Added option to always prompt for password upon session host connection. 
More...

Parameter Always prompt for password upon session host connection

Registry sessions.wvd%.options.always-prompt-for-

session-password

Type bool

Value enabled / disabled

Note: The same can be achieved on the server side by setting the 
RDP group policy of "Always prompt for password upon 
connection".

Added options to configure Fabulatech for WVD. This includes Webcam redirection, Scanner 
redirection, and USB redirection.
The USB redirection configuration is still to be done via Sessions > RDP > RDP Global > 
Fabulatech USB Redirection. Later releases should mirror that under WVD as well.
There are global WVD settings to select which redirections (Webcam, Scanner, USB) should be 
enabled for WVD.
There is a switch per WVD session that allows to enable/disable Fabulatech for that sessions
respectively.
Note: Technically, the Fabulatech redirections are selected system-wide. That means, when 
Scanner redirection is enabled for Citrix and Webcam redirection is
enabled for WVD, both these redirections are visible in Citrix and in WVD sessions. Only disabling 
Fabulatech support in general for a WVD session is possible.
More...

IGEL Setup Sessions > WVD > WVD Global > Plugins > Fabulatech
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Parameter Fabulatech Webcam Redirection

Registry wvd.plugins.fabulatech.webcam

Value enabled / disabled

IGEL Setup Sessions > WVD > WVD Global > Plugins > Fabulatech

Parameter Fabulatech Scanner Redirection

Registry wvd.plugins.fabulatech.scanner

Value enabled / disabled

IGEL Setup Sessions > WVD > WVD Global > Plugins > Fabulatech

Parameter Fabulatech USB Redirection

Registry wvd.plugins.fabulatech.usb

Value enabled / disabled

IGEL Setup Sessions > WVD > WVD Sessions > WVD Session > 
Plugins > Fabulatech

Parameter Fabulatech Webcam/Scanner/USB Redirection

Registry sessions.wvd%.plugins.fabulatech

Value enabled / disabled

Integrated Zoom Media Plugin 5.4.59458.0109 with support for WVD.
More...

IGEL Setup Sessions > WVD > WVD Sessions > WVD Session > 
Plugins > Fabulatech

Parameter Zoom VDI Media Plugin

Registry sessions.wvd%.plugins.zoomvdi

Value enabled / disabled

Added option to always prompt for username and password upon session host connection.
More...

Parameter Always prompt for username and password upon session 
host connection

Registry sessions.wvd%.options.always-prompt-for-

session-username-and-password
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Type bool

Value enabled / disabled

Added option to preset the workspace view zoom
More...

Parameter Initial workspace zoom

Registry sessions.wvd%.options.workspacezoom

Type string

Value 100

Added option to select specific monitors in a multimonitor session.
Only monitors matching this mask are used.

Monitors start with zero (0).
If empty all monitors are enabled, which is the default.
Can be one or a comma-separated list of the following specifiers without the quotes:

"1-2": An inclusive range of monitor indexes.
"-2": An inclusive range beginning from 0 to the given monitor index.
"2-": An inclusive range beginning with the specified monitor up to index 63, which is 
the maximum monitor index supported.
"2,3,5": A comma-separated list of monitor indexes.
More...

Parameter Multimonitor enable mask

Registry sessions.wvd%.options.multimonito

rmask

Type string

Value (empty by default)

If the username is preset with a string that starts with "@", the rest of the string is taken as a 
preset domain name. The user then only needs to enter her/his username and the domain name 
is automatically appended for AAD login.
Additionally, the following parameter has been added to allow/disallow the preset domain 
being overwritten when the username enters a name that contains an @ symbol itself. If this 
option is enabled, the entered domain is accepted. Otherwise, the entered domain is replaced by 
the preset domain.
More...

Parameter Allow preset domain overwrite

Registry sessions.wvd%.options.allow-preset-

domain-overwrite



Notes for Release 11.05.100

2 http://options.no

3 http://options.no

IGEL OS Release Notes   430 / 1492

•

•

•
•

Type bool

Value enabled / disabled

Added company logo customization, but the download of custom images to the local filesystem 
needs to be defined. So at the moment, the settings are not really useful, except for disabling 
the IGEL logo maybe.
More...

Parameter Disable company logo

Registry sessions.wvd%.options.no2-logo

Type bool

Value enabled / disabled

Parameter Logo image filename

Registry sessions.wvd%.options.logo-image

Type string

Value (empty by default)

Added background customization, but download of custom images to the local filesystem needs 
to be defined. So at the moment, the settings are not really useful, except for disabling the 
background image or defining a solid color for the background.
More...

Parameter Disable background image

Registry sessions.wvd%.options.no3-background

Type bool

Value enabled / disabled

Parameter Background image filename or color (#rrggbb)

Registry sessions.wvd%.options.background-image

Type string

Value (empty by default) / filename / #rrggbb

VMware Horizon

Updated Horizon Client to version 2012-8.1.0-17349998
Integrated Zoom Media Plugin 5.4.59458.0109

http://options.no
http://options.no
http://options.no
http://options.no
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Fixed failure to start Horizon serial port redirection service at boot time

Chromium

Updated Chromium browser to version 88.0.4324.150.
H.264 decoding is not supported anymore.
Custom preferences setup is not supported anymore.
Reworked custom commandline setup: Enter all commandline parameters in a single entry 
field.

Wi-Fi

Added support for WPS push button connect method

Imprivata

Added: The FUS Username is an editable combobox with prefilled values now. Set of an own 
string is also possible. 

Hostname of the endpoint
MAC address of the endpoint
Serial number of the endpoint
More...

IGEL Setup Sessions > Appliance mode > Imprivata

Parameter FUS User

Registry imprivata.fus.user

Smartcard

Updated A.E.T. Europe SafeSign Identity Client to version 3.6.0.0.
Added Smartcard PIN passthrough in Firefox and Chromium. The PIN will be cached while 
logging on via Active Directory/Kerberos with smartcard. In Firefox and Chromium, no further PIN 
input is necessary to use the smartcard.
More...

Parameter Smartcard PIN caching

Registry scard.pkcs11.pin_cache.enable

Value enabled / disabled

Updated SecMaker Net iD to version 6.8.3. New features are:
Support for Thales IDPrime 940 SIS & IDPrime 3940 SIS
Support for FIPS level 3 versions of Thales IDPrime MD smart cards (based on MD830B and 
MD840)
Support for FINEID 3.0 
Updated support for Yubico YubiKey serial numbers (version 5 and later) 
Updated support for Feitian ePass FIDO serial numbers (version 99 and later) 
For detailed release information, see https://docs.secmaker.com/net-id-enterprise/6.8/nie-
release-notes/nie-683-release-notes.html.

https://docs.secmaker.com/net-id-enterprise/6.8/nie-release-notes/nie-683-release-notes.html
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ThinPrint

Added ezeep by ThinPrint support for WVD
More...

IGEL Setup Sessions > WVD > WVD Sessions > WVD Session > Printing 
> ezeep by ThinPrint

Parameter Printing with ezeep

Registry sessions.wvd%.printing.thinprint-ezeep

Value enabled / disabled

Note Ezeep is directly related to the ThinPrint 
configuration under Devices > Printer > ThinPrint 
> ...
When ThinPrint configuration is changed, you need 
to close running WVD sessions and reconnect to 
make ThinPrint/Ezeep work again for the related
session.

Application Launcher

Added optional custom message in 'About' page of application launcher. The message is 
displayed below the License Information section. The text can be plain text or HTML, supported 
HTML subset are mentioned in Qt RichText.
More...

Parameter Custom message

Registry userinterface.launcher.custom_message

Value empty

Cisco Webex

Integrated Cisco Webex Meetings 41.2.0.142
Integrated Cisco Webex Teams 41.1.0.17621

Cisco JVDI Client

Integrated Cisco JVDI 12.9.3 client

Base system

Added post-session command support for WVD sessions.
Updated OpenVPN to version 2.5.0.
Updated OpenSSH to version 8.4p1-2.
Added warning at boot time if Workspace Edition maintenance has expired.
Updated Fluendo multimedia codecs.
Updated Linux kernel to version 5.9.16.
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Added inhibit screensaver when Zoom, Teams or Skype for Business meeting is active. Possible 
for native clients and Citrix optimization plugins.
More...

Parameter Enable debug logging for igel-screensaver-monitor

Registry debug.tools.igel-screensaver-

monitor.enable

Value enabled / disabled

Added functionality to change the desktop icon font color via new Setup parameter.
More...

IGEL Setup User Interface > Desktop

Parameter Desktop Icon Font Color

Registry windowmanager.defaulttheme.desktop.ico

nfont_color

CID Key Agent

Update of CID Key Agent to version 6.5.0-2

Driver

Updated Olympus dictation driver for Citrix and RDP to version 20201118.
The changes are:

Support motion events for Olympus RecMic devices
Support integration with the Olympus AudioSDK for limited server-side device 
communication

Updated Crossmatch driver to version 0125. 
The changes are:

Improved USB encryption for the 4500 readers
Support for the 5300-101 reader (the 5300-100 was already supported)

Updated deviceTRUST client plugin for Citrix and RDP to version 20.1.200.0. Detailed release 
notes can be found at https://docs.devicetrust.com/docs/releases-igel-20.1.200/.

X11 system

Enhanced x.xserver%.mirror_mode  registry key with new Scaling down mode (Scales all 
monitors to the monitor with the lowest resolution)
More...

Parameter Choose the mode which should be used for mirroring 
monitors if resolution differs

Registry x.xserver%.mirror_mode

https://docs.devicetrust.com/docs/releases-igel-20.1.200/
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Range [Default] [Biggest common resolution] [Scaling] [Scaling 
down]

Audio

Added EPOS Connect 5.0.1.2795
More...

IGEL Setup Devices > Unified Communications > EPOS Audio > 
EPOS Connect

Parameter Enable EPOS Connect

Registry devices.epos.connect.enable

Type bool

Value enabled / disabled

IGEL Setup Devices > Unified Communications > EPOS Audio > 
EPOS Connect

Parameter Tenant ID

Registry devices.epos.connect.tenant_id

Type string

Value ''

IGEL Setup Devices > Unified Communications > EPOS Audio > 
EPOS Connect

Parameter Backend Endpoint

Registry devices.epos.connect.tenant_url

Type string

Value ''

IGEL Setup Devices > Unified Communications > EPOS Audio > 
EPOS Connect

Parameter Proxy

Registry devices.epos.connect.proxy

Type string

Value ''
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Registry devices.epos.connect.log_level

Value Trace / Debug / Information / Warnings / Errors / 
Exceptions / No logs

Pulseaudio upgraded to the 13.99 version.
Added parameter to differentiate sound volume for applications. If the parameter is set to true, 
each application can set its own volume level. Otherwise, the sound volume is set to the same 
value as the default volume for output and input device respectively.
More...

Registry userinterface.sound.app_volume_ctrl

Value true / false

Misc

Added DriveLock Agent 20.1.4.30482 for USB device access control.
More...

IGEL Setup Devices > Storage Devices > DriveLock

Parameter Enable DriveLock agent

Registry devices.drivelock.enable

Value enabled / disabled

IGEL Setup Devices > Storage Devices > DriveLock

Parameter DES server URL

Registry devices.drivelock.server

Value (empty)

IGEL Setup Devices > Storage Devices > DriveLock

Parameter Tenant

Registry devices.drivelock.tenant

Value root

Evidian

Added new session type RD Web Access.
Updated Evidian to version 1.5.7617.

Hardware

Added hardware support for new IGEL UD7-LX 20 (H860C).
Added hardware support for LG 34CN650N AiO.
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Added hardware support for Dell Wyse Z Class thin client.
Added hardware support for Lenovo ThinkCentre M70q.
Added hardware support for Dell Wyse 5470.
Added hardware support for Lenovo L14.
Added hardware support for Lenovo ThinkCentre M75n.
Added hardware support for Lenovo 14w.
Added hardware support for LG CN65 All in one.
Added hardware support for DELL LATITUDE 5510.
Added hardware support for ELO i2 Touch all-in-one (15 and 22) inch.
Added detection of UD Pocket UC5-LX 2.
Added support for headset Jabra Evolve2 65.

Remote Management

Added support for Reportable Heartbeats to the UMS.
Added support for exchanging ICG certificates.
The remote management of the endpoint device automatically installs TLS certificates provided 
by the UMS into the local trusted CA certificates storage. The automatic deployment of TLS 
certificates to endpoint devices requires UMS 6.06.100 or higher. This feature allows verifying 
certificates used in downloading files from the UMS, downloading of a firmware update and 
custom partition archives over HTTPS or FTPS protocols. The verifying of certificates must be 
enabled by the parameter  system.security.remote_management.tls_verify_peer .
More...

Registry system.security.remote_management.tls_ve

rify_peer

Value true / false

Registry system.security.remote_management.tls_ho

stname_validation

Value true / false

Added support for UMS commands to store and remove ICG configuration.
Introduced parameters for ICG Websocket connections: debug log, network timeout (in 
seconds) and ping-pong interval (in seconds). The parameters are applied on the next established 
ICG agent connection and ICG tunnel connections: VNC and Secure Terminal. 
More...

Registry system.icg.websocket.debug

Value off / all / tunnel / agent

Registry system.icg.websocket.network_timeout

Value 30
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Registry system.icg.websocket.pingpong_interval

Value 120

IGEL Remote Management agent sends now keep-alive packets to the ICG server to prevent 
the Websocket connection to the ICG server from being closed by networking infrastructure. 
The Websocket's ping-pong mechanism is used for that purpose (see RFC6455). The keep-alive 
interval in seconds can be configured by the parameter 
system.icg.websocket.pingpong_interval , 0 disables the keep-alive mechanism.

More...

Registry system.icg.websocket.pingpong_interval

Value 120

Fabulatech

Updated FabulaTech USB for Remote Desktop to version 6.0.28
Updated FabulaTech Scanner for Remote Desktop to version 2.7.0.1
Fixed FabulaTech scanner redirection not working for Citrix if it's exclusively enabled in IGEL 
Setup.
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Resolved Issues 11.05.100
Citrix

Fixed the problem with apparmor and the Citrix MS Teams workaround
Following registry keys help to edit horizontal and vertical window size (works only for desktops 
not for applications).
More...

Parameter Set desired horizontal window dimension

Registry ica.allregions.desiredhres

Value [**]  [640] [800] [1024] [1280] [1600]

Parameter Set desired vertical window dimension

Registry ica.allregions.desiredvres

Value [**] [480] [600] [768] [1024] [1200]

Citrix Desktop sessions have a sound device again, when using smartcard watch daemon. 
scard.scwatchd.insert_action = su user -c /config/sessions/pnlogin0

Parameter  ica.module.virtualdrivers.vdwebrtc.keyboard_workaround
has been removed. This workaround is no longer needed because the problem is solved as of CWA 
20.10.
Added new parameters to add config parameters for Citrix USB devices: the parameter string is 
appended to the config line in usb.conf , when the device is explicitly allowed. Citrix 
introduced this to handle special behavior with single devices, e.g. to set 
" disableselectconfig=1 ".
More...

Parameter Extra Config

Registry ica.usbredirection.devicepolicy.product

_rule%.parameter

Type String

Value "" 

Parameter Extra Config

Registry ica.usbredirection.devicepolicy.product_

rule_igel%.parameter
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Type String

Value "" 

Improved Fabulatech USB Redirection and Scanner Support
New parameter added:
More...

Parameter Fabulatech loglevel

Registry ica.module.virtualdriver.fabulatech.lo

glevel

Value 1 

Added new parameter AckDelayThresh: Max time (in milliseconds) between sending "resource 
free" message if any resources free. Default=350
More...

Parameter AckDelayThresh

Registry ica.module.AckDelayThresh

Type Integer

Value 350

Added new parameter AudioBufferSizeMilliseconds: Audio buffer size, in ms. Default=200 ms
More...

Parameter AudioBufferSizeMilliseconds

Registry ica.module.AudioBufferSizeM

illiseconds

Type Integer

Value 200 

Added new parameter AudioLatencyControlEnabled: Enables latency control. Default=False
More...

Parameter AudioLatencyControlEnabled

Registry ica.module.AudioLatencyControlEnabled

Type Boolean

Value true / false

Added new parameter AudioMaxLatency: Sets the maximum latency (in ms) before trying to 
discard audio data. Default=300 ms
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More...

Parameter AudioMaxLatency

Registry ica.module.AudioMaxLatency

Type Integer

Value 300 

Added new parameter AudioLatencyCorrectionInterval: Defines how often to correct the latency 
(in ms). Default=300 ms
More...

Parameter AudioLatencyCorrectionInterval

Registry ica.module.AudioLatencyCorrectionInter

val

Type Integer

Value 300 

Added new parameter AudioTempLatencyBoost: Sets the higher latency band (in ms) above the 
lower PlaybackDelayThresh band. Default=300 ms
More...

Parameter AudioTempLatencyBoost

Registry ica.module.AudioTempLatencyBoost

Type Integer

Value 300

Added new parameter CommandAckThresh: Number of free client command buffers causing a 
"resource free" message to be sent to the server. Default=10
More...

Parameter CommandAckThresh

Registry ica.module.CommandAckThresh

Type Integer

Value 10

Added new parameter DataAckThresh: Number of free client data buffers causing a "resource 
free" message to be sent to the server. Default=10
More...

Parameter DataAckThresh
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Registry ica.module.DataAckThresh

Type Integer

Value 10

Added new parameter MaxDataBufferSize: Maximum size of each data buffer. Default=2048 bytes
More...

Parameter MaxDataBufferSize

Registry ica.module.MaxDataBufferSize

Type Integer

Value 2048

Added new parameter NumCommandBuffers: Number of client buffers to use for audio 
commands. Default=64
More...

Parameter NumCommandBuffers

Registry ica.module.NumCommandBuffers

Type Integer

Value 64 

Added new parameter PlaybackDelayThresh: Delay (in ms) between being asked to start audio 
playback and actually starting audio playback in order to build up a backlog of sound. Default=150
More...

Parameter PlaybackDelayThresh

Registry ica.module.PlaybackDelayThresh

Type Integer

Value 150

Fixed: ICA Connection Center starts again as expected.
Fixed Citrix Kerberos Passthrough authentication.
Added: When the password has expired but the password change is not allowed on the Citrix 
server, the Citrix error message is displayed.
Added: The parameter for mouseinput ica.wfclient.mousesendcontrolv  is 
available with this release on the Setup page Sessions > Citrix > Citrix Global > Keyboard.
Added: The parameter for the Citrix Connection bar ica.allregions.connectionbar  is 
available on the Setup page Sessions > Citrix > Citrix Global > Window.
Fixed Citrix sessions with H.264 hardware acceleration on and DRI3 off that crashed with error 
message: The X Request 130.1 caused error: 10 BadAccess .
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OSC Installer

Fixed warning message after feature deselection for installations on 2 GB flashes.
Fixed a display issue with Intel and Nvidia GPU.

RDP/IGEL RDP Client 2

Fixed USB redirection for RDP sessions.
Added new parameter to enable/disable dynamic drive mapping.
More...

Registry rdp.winconnect.enable-dynamic-

drivemapping

Value enabled / disabled

Registry sessions.winconnect%.option.enable-

dynamic-drivemapping

Range Global Setting  / On / Off

Fixed login information not being set after reboot.
Improved error logging.

WVD

WVD now comes with Qt 5.12.10 in order to get fixes mainly for QWebEngine. This should fix
issues with .htaccess protected login pages.
Fixed proxy usage for WVD feed download.

RD Web Access

Fixed RD Web Access Login not working with user@domain.
Fixed RD Web Access username not being set correctly after reboot.

VMware Horizon

Fixed remember last user functionality in Horizon local logon
Fixed Local Logon Window for visibility in appliance mode
When using the PCoIP protocol, the virtual channel provided by VMware used for both serial 
port and scanner redirection may hang on logout. 
The virtual channel is not used when both redirection methods are set to "false" which is the 
default. 
For the usage of either one of these redirection methods, enable the corresponding parameter 
below to prevent the logout freeze. 
These settings can be found here in the IGEL Registry: 
vmware.view.enable-serial-port-redir 

vmware.view.enable-scanner-redir

Firefox
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Fixed smartcard access in Firefox. Before this fix, smartcards were not recognized in seldom 
cases. 
Fixed possibility to use the pre-installed spellcheckers in Firefox input fields.

Chromium

Fixed browser and download history not being cleared. 
Fixed Chromium browser was not clearing browsing history properly. 
Fixed: Custom Chromium Policies datatypes now written in the correct way 
to  policies.json
Fixed resetting kiosk mode would only work after reboot 
Fixed: Chromium settings were parent settings did not influence the child settings

Network

Added registry keys for enabling/disabling sending of hostname in DHCPv4 and DHCPv6 
requests.
More...

Parameter Send hostname in DHCP requests

Registry network.dhcp.send_hostname

Range [Disabled][Network Manager default]

Value Network Manager default

Parameter Send hostname in DHCPv6 requests

Registry network.dhcp6.send_hostname

Range [Disabled][Network Manager default]

Value Network Manager default

Fixed: SCEP failed when scep_getca  received only a single certificate. 
Added registry key specifying the number of 802.1X authentication attempts on Ethernet.
More...

Registry network.interfaces.ethernet.device%.ieee8

021x.auth_attempts

Type Integer

Value 1

The default value 
of  network.interfaces.ethernet.device%.nm_disable_link_config
(forbidding Network Manager to modify Ethernet link settings) has been changed to "true".
Fixed handling of DNS default domain
Added registry key for disabling Ethernet link reconfiguration by Network Manager.
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More...

Parameter Disable NetworkManager link configuration

Registry network.interfaces.ethernet.device%.nm_d

isable_link_config

Type bool

Value true / false

Setting this to "true" can be beneficial when 802.1X authentication is disturbed. It is currently 
enforced automatically in the case of e1000e drivers.
Changed default value of minimum size of a TCP packet from 750 to 500 bytes as a result this 
would allow a minimal MTU size of 576 bytes.

Wi-Fi

Added missing iwlwifi-6000-4 firmware file.
Fixed issues with D-Link DWA-131 WLAN dongle.
Removed network.drivers.use_backport_drivers  IGEL registry key as this is not 
used anymore. 
Added some missing iwlwifi firmware files to IGEL OS.

Open VPN

Fixed segmentation fault when nameserver is used.
Now it is allowed to use an empty password for the private key. Important: Not enter a password
when the private key doesn't have one.
OpenConnect VPN: Different protocols are selectable:
More...

Parameter protocol

Registry sessions.openconnect%.vpnopts.protocol

Value Cisco AnyConnect / Juniper Network / Junos Pulse / PAN 
GlobalProtect

Imprivata

Fixed: Usage the Horizon Window Size settings
Fixed: Set keyboard repeat rate correctly on Horizon session end 
Added Imprivatas "grid-theme" feature
More...

Parameter PIE Application Launcher for Citrix

Registry imprivata.grid_theme

Value enabled / disabled
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Smartcard

Added parameter to disable HID Global OMNIKEY smartcard reader driver. If this driver is 
disabled, some of the readers are handled by the MUSCLE CCID driver. This can help when 
problems with OMNIKEY reader driver occur.
More...

Parameter HID Global OMNIKEY driver for smart card readers

Registry scard.pcscd.omnikey_enable

Value enabled / disabled

HID

Fixing double tapping of desktop icons on touchscreen devices.

CUPS Printing

Fixed CUPS printer spooling configuration where printjob files were preserved in the spooling 
directory too long and could fill up the file system.

Logging

Fixed: Filebeat now starts after the hostnames are set so they will be shown in the logs.

Base system

Fixed problems with hostnames containing one or more "_" characters. 
Post-session command binaries and return codes are now customizable via registry. Allows 
post-session commands if a binary doesn't return 0.

Name of the binary:
More...

Parameter Binary

Registry pcom.valid_return_codes%.binary

Value binary name

Comma-separated return codes (e.g. 7,99) or/and return code ranges (e.g. 3..5 for 3,4,5) to 
be accepted:
More...

Parameter Return Codes

Registry pcom.valid_return_codes%.re

turncodes

Value e.g. 3,5,10..15 for 3,5,10,11,12,13,14,15

Improved post-session command parameter pcom.valid_return_codes%.returncodes
to handle ranges a la 1..255 (see tooltip).
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Fixed remembering last user name with Active Directory/Kerberos logon. Before this fix, the 
user name could not be stored in UMS to appear again after a reboot.
Fixed possibility to add certificates to Chromium and Firefox which are given in DER format.
Fixed default browser not being set properly after reboot. 
Fix GtkMessage dialog localization. 
Fixed: Fluendo vadec codec update closed a memory leak with AMD devices using 
VAAPI acceleration. 
Fixed possible USB issues with suspend/resume on IGEL M350C devices. 
Fixed: Shutdown delay when post-session command is enabled. 
Fixed NetworkManager could not create ipv6 pid/lease file while apparmor is active. 
Bugfix for missing bluetooth tray icon after suspend

Storage Devices

Fixed display of hotplug eject menu in appliance mode

X11 system

Fixed display hotplug detection not working in some situations.
Fixed Display Switch sometimes losing config after reboot.
Fixed missing custom background image after migration from OS 10.
Fixed sporadic hang in logoff session restart.
Updated Display Switch rotate buttons to have usable size.
Added registry key to solve an issue with buggy monitors connected over a DP-to-DVI adapter
(only works for Radeon devices like UD3 LX50).
More...

Parameter Fix issues with buggy monitors connected over DP-DVI 
adapter

Registry x.drivers.ati.dp_dvi_probe_workaround

Type bool

Value enabled / disabled 

Fixed touchpad enable and disable with hotkey.
Fixed issues if 2 DisplayPort MST Hubs are connected behind each other.
Fixed notifications not being hidden properly when in do-not-disturb mode.
Fixed monitor configuration issues with DisplayLink-based Dockingstations with more than 
one independent monitor output.
Fixed issue with non-correctly working default mirror mode.
Fixed screen configuration issues with Nvidia and Intel graphics cards in one device.
Added: Allowance of up to 8 different custom wallpapers (was limited to 4 up to now).
Added notification mute-all parameter in Setup to mute all notifications including urgent ones.

X server

Fixed tearing issue of UD7 with additional graphic card.

Window manager
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Fixed desktop icons not being restricted to one monitor.
Fixed a bug where icons were missing or miss-aligned in some multiscreen setups.
Fixed notify window width not remaining constant.
Fixed crash of start menu when it is not populated with any items.
Fixed start monitor mapping for Firefox. 
Fixed notification urgency for critical background color.

VirtualBox

Fixed authentication window popup if screen configuration is changed in Virtualbox.

Audio

Fixed erroneous closing of the Pulse PCM device as well as a possible deadlock in the ALSA 
Pulse PCM.
Fixed the ALSA Pulse PCM - a possible deadlock while writing audio data and closing Pulse PCM.
Fixed audio for HP Elitebook TRRS 840 G7
Fixed internal microphone in Elitebook TRRS 840 G7
Fixed headset not properly detected if connected on boot in UD2-LX50.
Fixed microphone issues with UD3-LX60 device.
Fixed a sporadic aborting of an application on closing ALSA Pulse PCM. The problem concerns 
only applications using ALSA API directly, like Citrix Receiver.
Added debug output to the ALSA Pulse PCM which must be enabled by the environment variable 
ALSA_PULSE_PCM_DEBUG=1 , the debug output is collected then by the system logging facility 

(journalctl).
Fixed missing audio tray icon after suspend

Evidian

Fixed error on restart.

Hardware

Added script to fix issues with DP MST KVM and connected DaisyChaining monitors. 
Fixed: When KVM is used, mishandling of connectors can occur. 
Added possible workaround via adding  /etc/igel/kms/kvm-workaround.sh  to 

the  userinterface.rccustom.custom_cmd_x11_init  registry key.

TC Setup (Java)

Fixed problems with passwords of a length longer than 127 characters.

Remote Management

Fixed automatic establishment of the configured ICG connection if the UMS Server is 
unreachable. 
Fixed sending the user logoff message to the UMS. 
Fixed: Disabled Nagle caching algorithm on the underlying TCP socket used for SSL connection 
between IGEL rmagent and UMS. 
Fixed sporadic failures while retrieving the Unit ID by the IGEL Remote Management agent. 
Fixed ICG HA functionality broken in the 11.04.100 release.

VNC
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• Fixed handling of CapsLock status in VNC server. Keyboard input now appears correctly also 
when CapsLock is active on the client or server side. This especially fixes upper case "umlaut" 
characters with Swiss German keyboard layout.
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CA Certificates Contained in IGEL OS 11.05
IGEL OS 11.05 contains the following CA certificates:

Certificate name Expiry date File in /etc/ssl/certs

ACCVRAIZ1 Dec 31 09:37:37 2030 
GMT

ACCVRAIZ1.crt

AC RAIZ FNMT-RCM Jan 1 00:00:00 2030 GMT AC_RAIZ_FNMT-RCM.crt

Actalis Authentication Root CA Sep 22 11:22:02 2030 
GMT

Actalis_Authentication

_Root_CA.crt

AffirmTrust Commercial Dec 31 14:06:06 2030 
GMT

AffirmTrust_Commercial

.crt

AffirmTrust Networking Dec 31 14:08:24 2030 
GMT

AffirmTrust_Networking

.crt

AffirmTrust Premium Dec 31 14:10:36 2040 
GMT

AffirmTrust_Premium.cr

t

AffirmTrust Premium ECC Dec 31 14:20:24 2040 
GMT

AffirmTrust_Premium_EC

C.crt

Amazon Root CA 1 Jan 17 00:00:00 2038 
GMT

AmazonRootCA1.pem

Amazon Root CA 1 Jan 17 00:00:00 2038 
GMT

Amazon_Root_CA_1.crt

Amazon Root CA 2 May 26 00:00:00 2040 
GMT

Amazon_Root_CA_2.crt

Amazon Root CA 3 May 26 00:00:00 2040 
GMT

Amazon_Root_CA_3.crt

Amazon Root CA 4 May 26 00:00:00 2040 
GMT

Amazon_Root_CA_4.crt

Atos TrustedRoot 2011 Dec 31 23:59:59 2030 
GMT

Atos_TrustedRoot_2011.

crt
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Certificate name Expiry date File in /etc/ssl/certs

Autoridad de Certificacion 
Firmaprofesional CIF A62634068

Dec 31 08:38:15 2030 
GMT

Autoridad_de_Certifica

cion_Firmaprofesional_

CIF_A62634068.crt

Baltimore CyberTrust Root May 12 23:59:00 2025 
GMT

BTCTRoot.pem

Baltimore CyberTrust Root May 12 23:59:00 2025 
GMT

Baltimore_CyberTrust_R

oot.crt

Buypass Class 2 Root CA Oct 26 08:38:03 2040 
GMT

Buypass_Class_2_Root_C

A.crt

Buypass Class 3 Root CA Oct 26 08:28:58 2040 
GMT

Buypass_Class_3_Root_C

A.crt

CA Disig Root R2 Jul 19 09:15:30 2042 GMT CA_Disig_Root_R2.crt

CFCA EV ROOT Dec 31 03:07:01 2029 
GMT

CFCA_EV_ROOT.crt

COMODO Certification Authority Dec 31 23:59:59 2029 
GMT

COMODO_Certification_A

uthority.crt

COMODO ECC Certification Authority Jan 18 23:59:59 2038 
GMT

COMODO_ECC_Certificati

on_Authority.crt

COMODO RSA Certification Authority Jan 18 23:59:59 2038 
GMT

COMODO_RSA_Certificati

on_Authority.crt

Certigna Jun 29 15:13:05 2027 
GMT

Certigna.crt

Certigna Root CA Oct 1 08:32:27 2033 GMT Certigna_Root_CA.crt

Certum Trusted Network CA Dec 31 12:07:37 2029 
GMT

Certum_Trusted_Network

_CA.crt
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Certum Trusted Network CA 2 Oct 6 08:39:56 2046 GMT Certum_Trusted_Network

_CA_2.crt

Chambers of Commerce Root - 2008 Jul 31 12:29:50 2038 GMT Chambers_of_Commerce_R

oot_-_2008.crt

Class 3 Public Primary Certification 
Authority - G2 (c) 1998 VeriSign, Inc. - 
For authorized use only VeriSign 
Trust Network

Aug 1 23:59:59 2028 GMT Class3PCA_G2_v2.pem

Class 4 Public Primary Certification 
Authority - G2 (c) 1998 VeriSign, Inc. - 
For authorized use only VeriSign 
Trust Network

Aug 1 23:59:59 2028 GMT Class4PCA_G2_v2.pem

AAA Certificate Services Dec 31 23:59:59 2028 
GMT

Comodo_AAA_Services_ro

ot.crt

Cybertrust Global Root Dec 15 08:00:00 2021 
GMT

Cybertrust_Global_Root

.crt

D-TRUST Root Class 3 CA 2 2009 Nov 5 08:35:58 2029 GMT D-

TRUST_Root_Class_3_CA_

2_2009.crt

D-TRUST Root Class 3 CA 2 EV 2009 Nov 5 08:50:46 2029 GMT D-

TRUST_Root_Class_3_CA_

2_EV_2009.crt

DST Root CA X3 Sep 30 14:01:15 2021 
GMT

DST_Root_CA_X3.crt

DigiCert Global Root CA Nov 10 00:00:00 2031 
GMT

DigiCertGlobalRootCA.p

em

DigiCert Global Root CA Mar 8 12:00:00 2023 GMT DigiCertSHA2SecureServ

erCA.pem
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DigiCert Assured ID Root CA Nov 10 00:00:00 2031 
GMT

DigiCert_Assured_ID_Ro

ot_CA.crt

DigiCert Assured ID Root G2 Jan 15 12:00:00 2038 
GMT

DigiCert_Assured_ID_Ro

ot_G2.crt

DigiCert Assured ID Root G3 Jan 15 12:00:00 2038 
GMT

DigiCert_Assured_ID_Ro

ot_G3.crt

DigiCert Global Root CA Nov 10 00:00:00 2031 
GMT

DigiCert_Global_Root_C

A.crt

DigiCert Global Root G2 Jan 15 12:00:00 2038 
GMT

DigiCert_Global_Root_G

2.crt

DigiCert Global Root G3 Jan 15 12:00:00 2038 
GMT

DigiCert_Global_Root_G

3.crt

DigiCert High Assurance EV Root CA Nov 10 00:00:00 2031 
GMT

DigiCert_High_Assuranc

e_EV_Root_CA.crt

DigiCert Trusted Root G4 Jan 15 12:00:00 2038 
GMT

DigiCert_Trusted_Root_

G4.crt

E-Tugra Certification Authority Mar 3 12:09:48 2023 GMT E-

Tugra_Certification_Au

thority.crt

EC-ACC Jan 7 22:59:59 2031 GMT EC-ACC.crt

Entrust.net4 Certification Authority 
(2048)

Jul 24 14:15:12 2029 GMT Entrust.net_Premium_20

48_Secure_Server_CA.cr

t

http://Entrust.net
http://Entrust.net
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Entrust Root Certification Authority Nov 27 20:53:42 2026 
GMT

Entrust_Root_Certifica

tion_Authority.crt

Entrust Root Certification Authority - 
EC1

Dec 18 15:55:36 2037 
GMT

Entrust_Root_Certifica

tion_Authority_-

_EC1.crt

Entrust Root Certification Authority - 
G2

Dec 7 17:55:54 2030 GMT Entrust_Root_Certifica

tion_Authority_-

_G2.crt

Entrust Root Certification Authority - 
G4

Dec 27 11:41:16 2037 
GMT

Entrust_Root_Certifica

tion_Authority_-

_G4.crt

GDCA TrustAUTH R5 ROOT Dec 31 15:59:59 2040 
GMT

GDCA_TrustAUTH_R5_ROOT

.crt

GlobalSign Dec 15 08:00:00 2021 
GMT

GSR2.pem

GTE CyberTrust Global Root Aug 13 23:59:00 2018 
GMT

GTECTGlobalRoot.pem

GTS Root R1 Jun 22 00:00:00 2036 
GMT

GTS_Root_R1.crt

GTS Root R2 Jun 22 00:00:00 2036 
GMT

GTS_Root_R2.crt

GTS Root R3 Jun 22 00:00:00 2036 
GMT

GTS_Root_R3.crt

GTS Root R4 Jun 22 00:00:00 2036 
GMT

GTS_Root_R4.crt

GeoTrust Global CA May 21 04:00:00 2022 
GMT

GeoTrust_Global_CA.pem
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GeoTrust Primary Certification 
Authority - G2

Jan 18 23:59:59 2038 
GMT

GeoTrust_Primary_Certi

fication_Authority_-

_G2.crt

GlobalSign Jan 19 03:14:07 2038 
GMT

GlobalSign_ECC_Root_CA

_-_R4.crt

GlobalSign Jan 19 03:14:07 2038 
GMT

GlobalSign_ECC_Root_CA

_-_R5.crt

GlobalSign Root CA Jan 28 12:00:00 2028 
GMT

GlobalSign_Root_CA.crt

GlobalSign Dec 15 08:00:00 2021 
GMT

GlobalSign_Root_CA_-

_R2.crt

GlobalSign Mar 18 10:00:00 2029 
GMT

GlobalSign_Root_CA_-

_R3.crt

GlobalSign Dec 10 00:00:00 2034 
GMT

GlobalSign_Root_CA_-

_R6.crt

Global Chambersign Root - 2008 Jul 31 12:31:40 2038 GMT Global_Chambersign_Roo

t_-_2008.crt

Go Daddy Class 2 Certification 
Authority

Jun 29 17:06:20 2034 
GMT

Go_Daddy_Class_2_CA.cr

t

Go Daddy Root Certificate Authority - 
G2

Dec 31 23:59:59 2037 
GMT

Go_Daddy_Root_Certific

ate_Authority_-_G2.crt

Hellenic Academic and Research 
Institutions ECC RootCA 2015

Jun 30 10:37:12 2040 
GMT

Hellenic_Academic_and_

Research_Institutions_

ECC_RootCA_2015.crt



Notes for Release 11.05.100

5 http://Izenpe.com

IGEL OS Release Notes   455 / 1492

Certificate name Expiry date File in /etc/ssl/certs

Hellenic Academic and Research 
Institutions RootCA 2011

Dec 1 13:49:52 2031 GMT Hellenic_Academic_and_

Research_Institutions_

RootCA_2011.crt

Hellenic Academic and Research 
Institutions RootCA 2015

Jun 30 10:11:21 2040 
GMT

Hellenic_Academic_and_

Research_Institutions_

RootCA_2015.crt

Hongkong Post Root CA 1 May 15 04:52:29 2023 
GMT

Hongkong_Post_Root_CA_

1.crt

Hongkong Post Root CA 3 Jun 3 02:29:46 2042 GMT Hongkong_Post_Root_CA_

3.crt

ISRG Root X1 Jun 4 11:04:38 2035 GMT ISRG_Root_X1.crt

IdenTrust Commercial Root CA 1 Jan 16 18:12:23 2034 
GMT

IdenTrust_Commercial_R

oot_CA_1.crt

IdenTrust Public Sector Root CA 1 Jan 16 17:53:32 2034 
GMT

IdenTrust_Public_Secto

r_Root_CA_1.crt

Imprivata Embedded Code Signing 
CA

Sep 7 16:20:00 2033 GMT Imprivata.crt

Izenpe.com5 Dec 13 08:27:25 2037 
GMT

Izenpe.com.crt

Microsec e-Szigno Root CA 2009 Dec 30 11:30:18 2029 
GMT

Microsec_e-

Szigno_Root_CA_2009.cr

t

Microsoft ECC Root Certificate 
Authority 2017

Jul 18 23:16:04 2042 GMT Microsoft_ECC_Root_Cer

tificate_Authority_201

7.crt

http://Izenpe.com
http://Izenpe.com
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Microsoft RSA Root Certificate 
Authority 2017

Jul 18 23:00:23 2042 GMT Microsoft_RSA_Root_Cer

tificate_Authority_201

7.crt

NAVER Global Root Certification 
Authority

Aug 18 23:59:59 2037 
GMT

NAVER_Global_Root_Cert

ification_Authority.cr

t

NetLock Arany (Class Gold) 
Főtanúsítvány

Dec 6 15:08:21 2028 GMT NetLock_Arany_=Class_G

old=_Főtanúsítvány.crt

Network Solutions Certificate 
Authority

Dec 31 23:59:59 2029 
GMT

Network_Solutions_Cert

ificate_Authority.crt

OISTE WISeKey Global Root GB CA Dec 1 15:10:31 2039 GMT OISTE_WISeKey_Global_R

oot_GB_CA.crt

OISTE WISeKey Global Root GC CA May 9 09:58:33 2042 GMT OISTE_WISeKey_Global_R

oot_GC_CA.crt

Class 3 Public Primary Certification 
Authority

Aug 1 23:59:59 2028 GMT Pcs3ss_v4.pem

QuoVadis Root Certification Authority Mar 17 18:33:33 2021 
GMT

QuoVadis_Root_CA.crt

QuoVadis Root CA 1 G3 Jan 12 17:27:44 2042 
GMT

QuoVadis_Root_CA_1_G3.

crt

QuoVadis Root CA 2 Nov 24 18:23:33 2031 
GMT

QuoVadis_Root_CA_2.crt

QuoVadis Root CA 2 G3 Jan 12 18:59:32 2042 
GMT

QuoVadis_Root_CA_2_G3.

crt

QuoVadis Root CA 3 Nov 24 19:06:44 2031 
GMT

QuoVadis_Root_CA_3.crt
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QuoVadis Root CA 3 G3 Jan 12 20:26:32 2042 
GMT

QuoVadis_Root_CA_3_G3.

crt

SSL.com6 EV Root Certification 
Authority ECC

Feb 12 18:15:23 2041 
GMT

SSL.com_EV_Root_Certif

ication_Authority_ECC.

crt

SSL.com7 EV Root Certification 
Authority RSA R2

May 30 18:14:37 2042 
GMT

SSL.com_EV_Root_Certif

ication_Authority_RSA_

R2.crt

SSL.com8 Root Certification Authority 
ECC

Feb 12 18:14:03 2041 
GMT

SSL.com_Root_Certifica

tion_Authority_ECC.crt

SSL.com9 Root Certification Authority 
RSA

Feb 12 17:39:39 2041 
GMT

SSL.com_Root_Certifica

tion_Authority_RSA.crt

SZAFIR ROOT CA2 Oct 19 07:43:30 2035 
GMT

SZAFIR_ROOT_CA2.crt

SecureSign RootCA11 Apr 8 04:56:47 2029 GMT SecureSign_RootCA11.cr

t

SecureTrust CA Dec 31 19:40:55 2029 
GMT

SecureTrust_CA.crt

Secure Global CA Dec 31 19:52:06 2029 
GMT

Secure_Global_CA.crt

Security Communication RootCA2 May 29 05:00:39 2029 
GMT

Security_Communication

_RootCA2.crt

Security Communication RootCA1 Sep 30 04:20:49 2023 
GMT

Security_Communication

_Root_CA.crt

http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
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Sonera Class2 CA Apr 6 07:29:40 2021 GMT Sonera_Class_2_Root_CA

.crt

Staat der Nederlanden EV Root CA Dec 8 11:10:28 2022 GMT Staat_der_Nederlanden_

EV_Root_CA.crt

Staat der Nederlanden Root CA - G3 Nov 13 23:00:00 2028 
GMT

Staat_der_Nederlanden_

Root_CA_-_G3.crt

Starfield Class 2 Certification 
Authority

Jun 29 17:39:16 2034 
GMT

Starfield_Class_2_CA.c

rt

Starfield Root Certificate Authority - 
G2

Dec 31 23:59:59 2037 
GMT

Starfield_Root_Certifi

cate_Authority_-

_G2.crt

Starfield Services Root Certificate 
Authority - G2

Dec 31 23:59:59 2037 
GMT

Starfield_Services_Roo

t_Certificate_Authorit

y_-_G2.crt

SwissSign Gold CA - G2 Oct 25 08:30:35 2036 
GMT

SwissSign_Gold_CA_-

_G2.crt

SwissSign Silver CA - G2 Oct 25 08:32:46 2036 
GMT

SwissSign_Silver_CA_-

_G2.crt

T-TeleSec GlobalRoot Class 2 Oct 1 23:59:59 2033 GMT T-

TeleSec_GlobalRoot_Cla

ss_2.crt

T-TeleSec GlobalRoot Class 3 Oct 1 23:59:59 2033 GMT T-

TeleSec_GlobalRoot_Cla

ss_3.crt
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TUBITAK Kamu SM SSL Kok Sertifikasi 
- Surum 1

Oct 25 08:25:55 2043 
GMT

TUBITAK_Kamu_SM_SSL_Ko

k_Sertifikasi_-

_Surum_1.crt

TWCA Global Root CA Dec 31 15:59:59 2030 
GMT

TWCA_Global_Root_CA.cr

t

TWCA Root Certification Authority Dec 31 15:59:59 2030 
GMT

TWCA_Root_Certificatio

n_Authority.crt

TeliaSonera Root CA v1 Oct 18 12:00:50 2032 
GMT

TeliaSonera_Root_CA_v1

.crt

TrustCor ECA-1 Dec 31 17:28:07 2029 
GMT

TrustCor_ECA-1.crt

TrustCor RootCert CA-1 Dec 31 17:23:16 2029 
GMT

TrustCor_RootCert_CA-1

.crt

TrustCor RootCert CA-2 Dec 31 17:26:39 2034 
GMT

TrustCor_RootCert_CA-2

.crt

Trustis FPS Root CA Jan 21 11:36:54 2024 
GMT

Trustis_FPS_Root_CA.cr

t

Trustwave Global Certification 
Authority

Aug 23 19:34:12 2042 
GMT

Trustwave_Global_Certi

fication_Authority.crt

Trustwave Global ECC P256 
Certification Authority

Aug 23 19:35:10 2042 
GMT

Trustwave_Global_ECC_P

256_Certification_Auth

ority.crt

Trustwave Global ECC P384 
Certification Authority

Aug 23 19:36:43 2042 
GMT

Trustwave_Global_ECC_P

384_Certification_Auth

ority.crt
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UCA Extended Validation Root Dec 31 00:00:00 2038 
GMT

UCA_Extended_Validatio

n_Root.crt

UCA Global G2 Root Dec 31 00:00:00 2040 
GMT

UCA_Global_G2_Root.crt

USERTrust ECC Certification 
Authority

Jan 18 23:59:59 2038 
GMT

USERTrust_ECC_Certific

ation_Authority.crt

USERTrust RSA Certification 
Authority

Jan 18 23:59:59 2038 
GMT

USERTrust_RSA_Certific

ation_Authority.crt

VeriSign Universal Root Certification 
Authority

Dec 1 23:59:59 2037 GMT VeriSign_Universal_Roo

t_Certification_Author

ity.crt

XRamp Global Certification Authority Jan 1 05:37:19 2035 GMT XRamp_Global_CA_Root.c

rt

certSIGN ROOT CA Jul 4 17:20:04 2031 GMT certSIGN_ROOT_CA.crt

certSIGN ROOT CA G2 Feb 6 09:27:35 2042 GMT certSIGN_Root_CA_G2.cr

t

e-Szigno Root CA 2017 Aug 22 12:07:06 2042 
GMT

e-

Szigno_Root_CA_2017.cr

t

ePKI Root Certification Authority Dec 20 02:31:27 2034 
GMT

ePKI_Root_Certificatio

n_Authority.crt

emSign ECC Root CA - C3 Feb 18 18:30:00 2043 
GMT

emSign_ECC_Root_CA_-

_C3.crt

emSign ECC Root CA - G3 Feb 18 18:30:00 2043 
GMT

emSign_ECC_Root_CA_-

_G3.crt
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emSign Root CA - C1 Feb 18 18:30:00 2043 
GMT

emSign_Root_CA_-

_C1.crt

emSign Root CA - G1 Feb 18 18:30:00 2043 
GMT

emSign_Root_CA_-

_G1.crt
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•
•
•

IGEL OS Creator (OSC)

Supported Devices
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 20

UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.

Component Versions 11.05.100 (see page 463)
New Features 11.05.100 (see page 465)
Resolved Issues 11.05.100 (see page 466)
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Component Versions 11.05.100

Clients

Product Version

Zulu JRE 8.48.0.51-2

System Components

OpenSSL 1.0.2n-1ubuntu5.5

OpenSSL 1.1.1-1ubuntu2.1~18.04.7

Bluetooth stack (bluez) 5.55-0ubuntu1.1igel10

MESA OpenGL stack 20.2.6-1igel131

VDPAU Library version 1.4-3igel1099

Graphics Driver INTEL 2.99.917+git20200515-igel1013

Graphics Driver ATI/RADEON 19.1.0-2igel1066

Graphics Driver ATI/AMDGPU 19.1.0-2+git20200828igel1064

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 450.102.04-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel1012

Graphics Driver VESA 2.4.0-1igel1010

Input Driver Evdev 2.10.6-2igel1037

Input Driver Elographics 1.4.1-1+b6igel952

Input Driver Synaptics 1.9.1-1ubuntu1igel1009

Input Driver VMMouse 13.1.0-1ubuntu2igel957

Input Driver Wacom 0.39.0-0ubuntu1igel1036

Kernel 5.9.16 #mainline-lxos-g1613995475

Xorg X11 Server 1.20.10-2igel1100

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel13
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XFCE4 Window Manager 4.14.2-1~18.04igel1600339249

ISC DHCP Client 4.3.5-3ubuntu7.1

Python3 3.6.9

VM Guest Support Components

Virtualbox Guest Utils 6.1.18-dfsg-1igel49

Virtualbox X11 Guest Utils 6.1.18-dfsg-1igel49

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.20.0-2igel104

Qemu Guest Agent 5.2+dfsg-3igel17

Services

Service Size Reduced Firmware

Java SE Runtime Environment 36.0 M Included

NVIDIA graphics driver 122.5 M Included
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•

•
•
•
•
•
•
•
•
•
•
•
•

New Features 11.05.100
Base system

Updated Linux kernel to version 5.9.16.

Hardware

Added hardware support for new IGEL UD7-LX 20 (H860C).
Added hardware support for LG 34CN650N AiO.
Added hardware support for Dell Wyse Z Class thin client.
Added hardware support for Lenovo ThinkCentre M70q.
Added hardware support for Dell Wyse 5470.
Added hardware support for Lenovo L14.
Added hardware support for Lenovo ThinkCentre M75n.
Added hardware support for Lenovo 14w.
Added hardware support for LG CN65 All in one.
Added hardware support for DELL LATITUDE 5510.
Added hardware support for ELO i2 Touch all-in-one (15 and 22) inch.
Added detection of UD Pocket UC5-LX 2.
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•
•

Resolved Issues 11.05.100
OSC Installer

Fixed warning message after feature deselection for installations on 2 GB flashes.
Fixed a display issue with Intel and Nvidia GPU.
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•
•
•
•
•
•
•

Notes for Release 11.04.270
Software: Version 11.04.270

Release Date: 2021-02-11

Release Notes: Version RN-1104270-1

Last update: 2021-02-10

Supported Devices 11.04.270 (see page 468)
Component Versions 11.04.270 (see page 469)
General Information 11.04.270 (see page 476)
Known Issues 11.04.270 (see page 477)
Security Fixes 11.04.270 (see page 481)
New Features 11.04.270 (see page 482)
Resolved Issues 11.04.270 (see page 484)
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Supported Devices 11.04.270
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.04.270

Clients
Product Version

Chromium 83.0.4103.61-0ubuntu0.18.04.1

Cisco JVDI Client 12.9.3

Cisco Webex Teams VDI Client 41.1.0.17621

Cisco Webex Meetings VDI Client 41.2.0.142

Zoom Media Plugin 5.4.53376

Citrix HDX Realtime Media Engine 2.9.0-2330

Citrix Workspace App 19.12.0.19

Citrix Workspace App 20.10.0.6

Citrix Workspace App 20.12.0.12

deviceTRUST Citrix Channel 20.1.200.0

Crossmatch DP Citrix Channel 0515.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 14.0.0.45623

Evidian AuthMgr 1.5.7617

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech USB for Remote Desktop 6.0.28

Firefox 68.12.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2igel1600249269

IGEL WVD Client 1.0.21igel1608136172

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

deviceTRUST RDP Channel 20.1.200.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.11.2-1igel8
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Open VPN 2.4.4-2ubuntu1.3

Zulu JRE 8.48.0.51-2

Parallels Client (64 bit) 17.1.2.1

Spice GTK (Red Hat Virtualization) 0.38-2igel93

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.8.0-1+b1igel71

Teradici PCoIP Software Client 20.10.0-18.04

ThinLinc Client 4.12.0-6517

ThinPrint Client 7.5.88

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 1.0.5-1igel1583919770

VNC Viewer 1.10.1+dfsg-4igel13

VMware Horizon Client 5.5.0-16946361

Voip Client Ekiga 4.0.1-9build1igel6

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20200323

Philips Speech driver 12.9.1

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.9

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2
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Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7

PKCS#11 Library cryptovision sc/interface 7.3.1

PKCS#11 Library Gemalto SafeNet 10.7.77

PKCS#11 Library OpenSC 0.20.0-3igel37

PKCS#11 Library SecMaker NetID 6.8.1.31

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel2

Reader Driver Gemalto eToken 10.7.77

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.31-1igel11

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.26-3igel14

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.3

OpenSSL 1.1.1-1ubuntu2.1~18.04.6

OpenSSH Client 7.6p1-4ubuntu0.3

OpenSSH Server 7.6p1-4ubuntu0.3

Bluetooth stack (bluez) 5.52-1igel6

MESA OpenGL stack 20.0.8-1igel117

VAAPI ABI Version 0.40

VDPAU Library version 1.4-1igel1003
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Graphics Driver INTEL 2.99.917+git20200515-igel1013

Graphics Driver ATI/RADEON 19.1.0-1+git20200220igel987

Graphics Driver ATI/AMDGPU 19.1.0-1+git20200318igel986

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 440.100-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel975

Input Driver Elographics 1.4.1-1+b6igel952

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel957

Input Driver Wacom 0.36.1-0ubuntu2igel888

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.4.48 #mainline-lxos-g1607354578

Xorg X11 Server 1.20.8-2igel1016

Xorg Xephyr 1.20.8-2igel1016

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.425

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel13

XFCE4 Window Manager 4.14.2-1~18.04igel1600339249

ISC DHCP Client 4.3.5-3ubuntu7.1

NetworkManager 1.20.4-2ubuntu2.2igel105

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42
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GStreamer 0.10 Fluendo asfdemux 0.10.90

GStreamer 0.10 Fluendo h264dec 0.10.58

GStreamer 0.10 Fluendo mp3dec 0.10.40

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.224

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.16.2-4igel239

GStreamer 1.0 Fluendo aacdec 0.10.42.2-8d6d

GStreamer 1.0 Fluendo asfdemux 0.10.90

GStreamer 1.0 Fluendo h264dec 0.10.58

GStreamer 1.0 Fluendo mp3dec 0.10.40

GStreamer 1.0 Fluendo mpeg4videodec 0.10.44

GStreamer 1.0 Fluendo vadec 0.10.224

GStreamer 1.0 Fluendo wmadec 0.10.70

GStreamer 1.0 Fluendo wmvdec 0.10.66

WebKit2Gtk 2.28.3-2igel36

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.10-dfsg-1igel41

Virtualbox X11 Guest Utils 6.1.10-dfsg-1igel41

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.20.0-1igel95

Qemu Guest Agent 5.0-5igel12
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Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.17-3igel5

Mobile Device Access USB (imobile) 1.2.1~git20191129.9f79242-1+b1igel8

Mobile Device Access USB (gphoto) 2.5.25-2igel4

VPN OpenConnect 8.10-1igel4

Scanner support 1.0.27-1

VirtualBox 6.1.10-dfsg-1igel41

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M Included

Java SE Runtime Environment 36.0 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

235.5 M Included

Ericom PowerTerm InterConnect 15.5 M Included

Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

70.5 M Included

VMware Horizon
RDP

4.2. M Included

Cendio ThinLinc 10.0 M Included

Printing (Internet printing protocol CUPS) 22.2 M Included

NoMachine NX 26.8 M Included

VMware Horizon 123.2 M Included

Voice over IP (Ekiga) 6.5 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M Not included

Fluendo GStreamer Codec Plugins 7.5 M Included



Notes for Release 11.04.270

IGEL OS Release Notes   475 / 1492

IBM i Access Client Solutions 72.5 M Not included

Red Hat Enterprise Virtualization 3.0 M Included

Parallels Client 5.5 M Included

NVIDIA graphics driver 115.0 M Not included

Imprivata Appliance 10.8 M Included

Evidian AuthMgr 2.5 M Included

Hardware Video Acceleration 13.0 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 48.0 M Included

Cisco JVDI client 45.8 M Included

PrinterLogic 40.8 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M Not included

Stratusphere UX CID Key software 2.8 M Not included

Elastic Filebeat 15.8 M Not included

WVD 14.0 M Included

Local Browser (Chromium) 81.2 M Not included

deskMate client 5.8 M Included

Cisco Webex Teams VDI 36.8 M Not included

Cisco Webex Meetings VDI 32.2 M Not included

Zoom Media Plugin 40.5 M Not included

Teradici PCoIP Client 14.5 M Included

90meter Smart Card Support 256.0 K Included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.5 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 62.5 M Not included
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General Information 11.04.270

The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver

To be beneficial to all new features and implementations, it is recommended to use UMS 6.06.100 or 
higher and update the corresponding profiles.



Firmware downgrade to older versions (11.01 or 11.02) is not possible, due to the unsigned firmware 
update files.


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Known Issues 11.04.270
Firmware Update

On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Check Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a solution.

Firefox

Firefox IGEL extensions are not updated automatically under some circumstances. After an 
update from 11.03.xxx to 11.04.100, the IGEL extensions will stay on the old version. 
In this case, the following settings concerning kiosk mode cannot be executed:

Switch off hotkey for new window/tab
Blocking of internal browser pages like preferences, file picker, specific local directories

As a workaround:

a reset to defaults should be performed
or the browser's mimetype template can be switched from "Standard" to "Minimal" by 
registry key browserglobal.app.mimetypes_template . There, the browser profile is 
renewed as well.
After the TC received the new setting, reboot and set the mimetypes_template  registry key 
to "Standard" again.

Citrix

With activated DRI3 and an AMD GPU Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1 and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of login. 
Workaround: Insert the smartcard before starting the StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme
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Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery group.

During the running Microsoft Teams Optimization of Citrix Workspace App 20.09, webcam 
redirection or screen sharing may lead to display errors like black stripes or flickering.

VMware Horizon

Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Enable local `Storage Hotplug` on Setup page Devices > Storage Devices > Storage 
Hotplug.

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.
After the disconnect of an RDP-based session, the Horizon main window which contains the 
server or sessions overview cannot be resized anymore.
Seamless application windows in Horizon Client may not be displayed correctly.  When 
starting the first seamless app, a new iconified window appears in the taskbar, and only if you click 
on it, the application will show up.
On some hardware (UD7-H850, UD2-M250, UD2-D220), however, the client aborts when this new 
window is de-iconified.
When using the RDP protocol, the remote session has a fixed offset of approximately the height of 
the menu bar. That means you have a black bar on top of the window and as a result of that, the 
Windows panel on the bottom is cut off.
Modifier keys ( Shift/Ctrl/Win/Alt ) in session windows using RDP protocol do not send 
the keyup event and keep being pressed, even when actually released. Only when closing the 
session with a mouse, the modifiers are reset.
Copying a text from Horizon Blast sessions is not possible.
The on-screen keyboard in Horizon appliance mode does not work correctly with local logon. 
Workaround: Switch off local logon and switch on the corresponding two keys via IGEL registry: 

userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide

Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters does not work after system suspend/resume. Workaround: 
Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Parallels Client
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Native USB redirection does not work with Parallels Client.

Smartcard

Citrix Certificate Identity Declaration login does not work with SecMaker smartcards.

Cisco JVDI Client

There may be a segfault shown in the logs (during logout of Citrix Desktop session). This occurs 
only when using Citrix Workspace app 20.10 and Cisco JVDI.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hyper-V

Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.

VirtualBox

The current VirtualBox Guest Tools/Drivers will not work with VirtualBox 5.2.x or older hosts 
which leads to a black screen and non-working graphics.
Possible workaround: Install with 'Failsafe Installation + Recovery' and set the registry key 
x.drivers.force_vesa  to 'true'.

When running in VirtualBox virtualization, resizing the window will not automatically change 
desktop resolution of IGEL OS guest.

Audio

Audio jack detection on Advantech POC-W243L doesn't work. Therefore, sound output 
goes through a possibly connected headset and the internal speakers.
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.

Hardware

HP t730 could freeze when monitors with different resolutions are connected (1920x1200 + 
2560x1440 + 3840x1600 for example). When this occurs, the registry 
key  x.drivers.kms.best_console_mode  has to be set to disabled.
Some newer Delock 62599 active DisplayPort-to-DVI (4k) adapters only work with INTEL 
devices.

Remote Management

AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.

Base system

Update from memory stick requires network online state (at least when multiple update stages 
are involved).

deskMate

Some stability issues may remain.

Appliance Mode
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When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.
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Security Fixes 11.04.270
VNC

Fixed Secure Terminal and Secure VNC Shadowing remote code execution vulnerability.
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New Features 11.04.270
Citrix

Integrated Zoom Media Plugin 5.4.53376.1029
Integrated Citrix Workspace App 20.12
Available Citrix Workspace apps in this release: 20.12 (default), 20.10, and 19.12.
New Feature: App Protection [Experimental]. App Protection is an add-on feature that provides 
enhanced security when using Citrix Virtual Apps and Desktops. The feature restricts the 
ability of clients to be compromised by keylogging and screen capturing malware. 
More...

Parameter Citrix App Protection

Registry ica.appprotection

Value enabled / disabled

Note: Experimental feature
This feature is currently only available for Self-Service 
sessions.

Fixed Issue: mic and webcam devices can be redirected using Browser Content Redirection.
More...

Parameter Enables mic and webcam redirection using BCR

Registry ica.allregions.cefenablemediadevices

Value [Factory default is "*"] [False][True]

VMware Horizon

Integrated Zoom Media Plugin 5.4.53376.1029
Updated VMware Horizon Client to version 5.5.0-16946361

Smartcard

Added Smartcard PIN passthrough in Firefox and Chromium. The PIN will be cached while 
logging on via Active Directory/Kerberos with a smartcard. In Firefox and Chromium, no further 
PIN input is necessary to use the smartcard.
More...

Parameter Smartcard PIN caching

Registry scard.pkcs11.pin_cache.enabl

e

Value enabled / disabled
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Cisco JVDI Client

Integrated Cisco JVDI 12.9.3 client

Cisco Webex

Integrated Cisco Webex Meetings 41.2.0.142
Integrated Cisco Webex Teams 41.1.0.17621

Evidian

New session type RD Web Access.
Updated Evidian to version 1.5.7617.

Audio

Added parameter to control applying of sound volume to application's streams. If the 
parameter is set to "true", each application can set its own volume level. Otherwise, the sound 
volume is set to the same value as the default volume for output and input device respectively.
More...

Registry userinterface.sound.app_volu

me_ctrl

Value enabled / disabled
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Resolved Issues 11.04.270
Citrix

Fixed Citrix Kerberos Passthrough authentication.
The parameter ica.module.virtualdrivers.vdwebrtc.keyboard_workaround
has been removed. This workaround is no longer needed because the problem is solved as of 
CWA 20.10.

VMware Horizon

Fixed failure to start Horizon serial port redirection service at boot time.
Fixed remember last user functionality in Horizon local logon.
Fixed VMware integrated printing.

RDP/IGEL RDP Client 2

Added new parameter to enable/disable dynamic drive mapping.
More...

Registry rdp.winconnect.enable-dynamic-

drivemapping

Value enabled / disabled

Registry sessions.winconnect%.option.enable-

dynamic-drivemapping

Range Global setting / on / off

Fixed login information not being set after reboot.

RD Web Access

Fixed RD Web Access login not working with user@domain.

WVD

Fixed proxy usage for WVD feed download.

Parallels Client

Fixed a bug with Parallels not working if the Parallels RAS omits the machine name in the 
application list.

Evidian

Fixed error on restart.

Firefox

Fixed usage of a pre-installed spellchecker in Firefox input fields.
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Added TLS 1.3 to the range of "Maximum supported encryption protocol" from Sessions > 
Firefox Browser > Firefox Browser Global > Encryption.
More...

Parameter Maximum supported encryption protocol

Registry browserglobal.app.security_tls_version

_max

Range [SSL3] [TLS 1.0] [TLS 1.1] [TLS 1.2] [TLS 1.3]

Chromium

Fixed: Custom Chromium Policies datatypes now written in the correct way to policies.json.
Fixed browser and download history not being cleared.

Audio

Fixed a sporadic aborting of an application on closing ALSA Pulse PCM. The problem affects only 
applications using ALSA API directly like Citrix Workspace App.
Added debug output to the ALSA Pulse PCM which must be enabled by the environment 
variable ALSA_PULSE_PCM_DEBUG=1 , the debug output is collected by the system logging 

facility ( journalctl ).
Fixed missing default setup device after reboot.

VNC

Fixed handling of CapsLock status in VNC server. Keyboard input now appears correctly, also if 
CapsLock is active on the client or server side. This especially fixes upper case 'umlaut' 
characters with Swiss and German keyboard layouts.

Network

Fixed bug: SCEP failed when scep_getca  received only a single certificate.

Base system

Fixed issue with early IGEL UD3-LX 60 (M350C) revisions that can lead to read error from MMC.
Fixed crash of IGEL monitoring agent.
Fixed possibility to add certificates to Chromium and Firefox which are given in DER format. 
The Options dialog keeps the settings that were previously set. 
Fix GtkMessage dialog localization.
Fixed: Shutdown delay when Post-session command is enabled.
Fixed remembering last user name with Active Directory/Kerberos logon. Before this fix, the 
user name could not be stored in the UMS to appear again after a reboot.

X11 system

Added registry key to solve an issue with buggy screens connected over a DP-to-DVI adapter
(only works for Radeon devices like IGEL UD3-LX 50).
More...
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Parameter Fix issues with buggy monitors connected over DP-DVI 
adapter

Registry x.drivers.ati.dp_dvi_probe_workaround

Value enabled / disabled

Updated Display Switch rotate buttons to usable size.
Fixed notifications not being hidden properly when in do-not-disturb mode.

Window manager

Fixed notifyd  window width not remaining constant.
Fixed notification urgency critical background color.

OS Converter

Fixed language chooser in installations via Deployment Appliance.
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Notes for Release 11.04.240
Software: Version 11.04.240

Release Date: 2020-11-16

Release Notes: Version RN-1104240-1

Last update: 2020-11-16

Supported Devices 11.04.240 (see page 488)
Component Versions 11.04.240 (see page 489)
General Information 11.04.240 (see page 496)
Known Issues 11.04.240 (see page 497)
Security Fixes 11.04.240 (see page 501)
New Features 11.04.240 (see page 502)
Resolved Issues 11.04.240 (see page 505)
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Supported Devices 11.04.240
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.04.240

Clients
Product Version

Chromium 83.0.4103.61-0ubuntu0.18.04.1

Cisco JVDI Client 12.9.1

Cisco Webex Teams VDI Client 3.0.16605.0

Cisco Webex Meetings VDI Client 40.10.5.2377

Zoom Media Plugin 5.4.53376

Citrix HDX Realtime Media Engine 2.9.0-2330

Citrix Workspace App 19.12.0.19

Citrix Workspace App 20.09.0.15

Citrix Workspace App 20.10.0.6

deviceTRUST Citrix Channel 20.1.200.0

Crossmatch DP Citrix Channel 0515.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 14.0.0.45623

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech USB for Remote Desktop 6.0.28

Firefox 68.12.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2igel1600249269

IGEL WVD Client 1.0.16igel1605091446

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

deviceTRUST RDP Channel 20.1.200.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.11.2-1igel8
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Open VPN 2.4.4-2ubuntu1.3

Zulu JRE 8.48.0.51-2

Parallels Client (64 bit) 17.1.2.1

Spice GTK (Red Hat Virtualization) 0.38-2igel93

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.8.0-1+b1igel71

Teradici PCoIP Software Client 20.10.0-18.04

ThinLinc Client 4.12.0-6517

ThinPrint Client 7.5.88

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 1.0.5-1igel1583919770

VNC Viewer 1.10.1+dfsg-4igel13

VMware Horizon Client 5.4.1-15988340

Voip Client Ekiga 4.0.1-9build1igel6

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20200323

Philips Speech driver 12.9.1

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.9

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2
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Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7

PKCS#11 Library cryptovision sc/interface 7.3.1

PKCS#11 Library Gemalto SafeNet 10.7.77

PKCS#11 Library OpenSC 0.20.0-3igel37

PKCS#11 Library SecMaker NetID 6.8.1.31

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel2

Reader Driver Gemalto eToken 10.7.77

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.31-1igel11

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.26-3igel14

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.3

OpenSSL 1.1.1-1ubuntu2.1~18.04.6

OpenSSH Client 7.6p1-4ubuntu0.3

OpenSSH Server 7.6p1-4ubuntu0.3

Bluetooth stack (bluez) 5.52-1igel6

MESA OpenGL stack 20.0.8-1igel117

VAAPI ABI Version 0.40

VDPAU Library version 1.4-1igel1003
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Graphics Driver INTEL 2.99.917+git20200515-igel1013

Graphics Driver ATI/RADEON 19.1.0-1+git20200220igel987

Graphics Driver ATI/AMDGPU 19.1.0-1+git20200318igel986

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 440.100-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel975

Input Driver Elographics 1.4.1-1+b6igel952

Input Driver eGalax 2.5.8825

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel957

Input Driver Wacom 0.36.1-0ubuntu2igel888

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.4.48 #mainline-lxos-g1605521351

Xorg X11 Server 1.20.8-2igel1016

Xorg Xephyr 1.20.8-2igel1016

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.425

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel13

XFCE4 Window Manager 4.14.2-1~18.04igel1600339249

ISC DHCP Client 4.3.5-3ubuntu7.1

NetworkManager 1.20.4-2ubuntu2.2igel105

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 0.10 Fluendo aacdec 0.10.42
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GStreamer 0.10 Fluendo asfdemux 0.10.90

GStreamer 0.10 Fluendo h264dec 0.10.58

GStreamer 0.10 Fluendo mp3dec 0.10.40

GStreamer 0.10 Fluendo mpegdemux 0.10.85

GStreamer 0.10 Fluendo mpeg4videodec 0.10.44

GStreamer 0.10 Fluendo vadec 0.10.224

GStreamer 0.10 Fluendo wmadec 0.10.70

GStreamer 0.10 Fluendo wmvdec 0.10.66

GStreamer 1.x 1.16.2-4igel239

GStreamer 1.0 Fluendo aacdec 0.10.42.2-8d6d

GStreamer 1.0 Fluendo asfdemux 0.10.90

GStreamer 1.0 Fluendo h264dec 0.10.58

GStreamer 1.0 Fluendo mp3dec 0.10.40

GStreamer 1.0 Fluendo mpeg4videodec 0.10.44

GStreamer 1.0 Fluendo vadec 0.10.224

GStreamer 1.0 Fluendo wmadec 0.10.70

GStreamer 1.0 Fluendo wmvdec 0.10.66

WebKit2Gtk 2.28.3-2igel36

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.10-dfsg-1igel41

Virtualbox X11 Guest Utils 6.1.10-dfsg-1igel41

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.20.0-1igel95

Qemu Guest Agent 5.0-5igel12
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Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.17-3igel5

Mobile Device Access USB (imobile) 1.2.1~git20191129.9f79242-1+b1igel8

Mobile Device Access USB (gphoto) 2.5.25-2igel4

VPN OpenConnect 8.10-1igel4

Scanner support 1.0.27-1

VirtualBox 6.1.10-dfsg-1igel41

Services
Service Size Reduced Firmware

Asian Language Support 22.5 M Included

Java SE Runtime Environment 36.0 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

235.8 M Included

Ericom PowerTerm InterConnect 15.5 M Included

Media Player 512.0 K Included

Local Browser (Firefox)
Citrix Appliance

70.5 M Included

VMware Horizon
RDP

4.2. M Included

Cendio ThinLinc 10.0 M Included

Printing (Internet printing protocol CUPS) 22.2 M Included

NoMachine NX 26.8 M Included

VMware Horizon 116.0 M Included

Voice over IP (Ekiga) 6.5 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M Not included

Fluendo GStreamer Codec Plugins 7.5 M Included
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IBM i Access Client Solutions 72.5 M Not included

Red Hat Enterprise Virtualization 3.0 M Included

Parallels Client 5.5 M Included

NVIDIA graphics driver 115.0 M Not included

Imprivata Appliance 10.8 M Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 13.0 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 48.0 M Included

Cisco JVDI client 45.8 M Included

PrinterLogic 40.8 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M Not included

Stratusphere UX CID Key software 2.8 M Not included

Elastic Filebeat 15.8 M Not included

WVD 14.0 M Included

Local Browser (Chromium) 81.2 M Not included

deskMate client 5.8 M Included

Cisco Webex Teams VDI 33.2 M Not included

Cisco Webex Meetings VDI 40.8 M Not included

Zoom Media Plugin 40.5 M Not included

Teradici PCoIP Client 14.5 M Included

90meter Smart Card Support 256.0 K Included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.5 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 62.5 M Not included
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General Information 11.04.240

The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver

To be beneficial to all new features and implementations, it is recommended to use UMS 6.06.100 or 
higher and update the corresponding profiles.



Firmware downgrade to older versions (11.01 or 11.02) is not possible, due to the unsigned firmware 
update files.


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Known Issues 11.04.240
Firmware Update

On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Check Error: "Not 
enough space on local drive" when Updating to IGEL OS 11.04 or Higher for a solution.

Firefox

Firefox IGEL extensions are not updated automatically under some circumstances. After an 
update from 11.03.xxx to 11.04.100, the IGEL extensions will stay on the old version. 
In this case, the following settings concerning kiosk mode cannot be executed:

Switch off hotkey for new window/tab
Blocking of internal browser pages like preferences, file picker, specific local directories

As a workaround:

a reset to defaults should be performed
or the browser's mimetype template can be switched from "Standard" to "Minimal" by 
registry key browserglobal.app.mimetypes_template . There, the browser profile is 
renewed as well.
After the TC received the new setting, reboot and set the mimetypes_template  registry key 
to "Standard" again.

Citrix

With activated DRI3 and an AMD GPU Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1 and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of login. 
Workaround: Insert the smartcard before starting the StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme
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Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery group.

During the running Microsoft Teams Optimization of Citrix Workspace App 20.09, webcam 
redirection or screen sharing may lead to display errors like black stripes or flickering.
The performance of Citrix sessions when using Workspace App 20.06 may be lower on some 
devices. 
A possible workaround is to disable the virtual channels for Microsoft Teams and NSAP or to 
set the HDX transport protocol to TCP only.

ica.module.virtualdriver.vdwebrtc.enable

ica.module.virtualdriver.nsap.enable 

The protocol can be set via the Setup parameter Sessions > Citrix > Citrix Global > Options > HDX 
Adaptive Transport over EDT or via the server policy 'HDX Adaptive Transport'.

VMware Horizon

Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Enable local `Storage Hotplug` on Setup page Devices > Storage Devices > Storage 
Hotplug.

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.
After the disconnect of an RDP-based session, the Horizon main window which contains the 
server or sessions overview cannot be resized anymore.
Seamless application windows in Horizon Client may not be displayed correctly.  When 
starting the first seamless app, a new iconified window appears in the taskbar, and only if you click 
on it, the application will show up.
On some hardware (UD7-H850, UD2-M250, UD2-D220), however, the client aborts when this new 
window is de-iconified.
When using the RDP protocol, the remote session has a fixed offset of approximately the height of 
the menu bar. That means you have a black bar on top of the window and as a result of that, the 
Windows panel on the bottom is cut off.
Modifier keys ( Shift/Ctrl/Win/Alt ) in session windows using RDP protocol do not send 
the keyup event and keep being pressed, even when actually released. Only when closing the 
session with a mouse, the modifiers are reset.
Copying a text from Horizon Blast sessions is not possible.
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The on-screen keyboard in Horizon appliance mode does not work correctly with local logon. 
Workaround: Switch off local logon and switch on the corresponding two keys via IGEL registry: 

userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide

Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters does not work after system suspend/resume. Workaround: 
Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Parallels Client

Native USB redirection does not work with Parallels Client.

Smartcard

Citrix Certificate Identity Declaration login does not work with SecMaker smartcards.

Cisco JVDI Client

There may be a segfault shown in the logs (during logout of Citrix Desktop session). This occurs 
only when using Citrix Workspace app 20.10 and Cisco JVDI.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hyper-V

Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.

VirtualBox

The current VirtualBox Guest Tools/Drivers will not work with VirtualBox 5.2.x or older hosts 
which leads to a black screen and non-working graphics.
Possible workaround: Install with 'Failsafe Installation + Recovery' and set the registry key 
x.drivers.force_vesa  to 'true'.

When running in VirtualBox virtualization, resizing the window will not automatically change 
desktop resolution of IGEL OS guest.

Audio

Audio jack detection on Advantech POC-W243L doesn't work. Therefore, sound output 
goes through a possibly connected headset and the internal speakers.
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.

Hardware

HP t730 could freeze when monitors with different resolutions are connected (1920x1200 + 
2560x1440 + 3840x1600 for example). When this occurs, the registry 
key  x.drivers.kms.best_console_mode  has to be set to disabled.
Some newer Delock 62599 active DisplayPort-to-DVI (4k) adapters only work with INTEL 
devices.
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Remote Management

AIT feature with IGEL Starter License is only supported by UMS version 6.05.100 or newer.

Base system

Update from memory stick requires network online state (at least when multiple update stages 
are involved).

deskMate

Some stability issues may remain.

Appliance Mode

When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.
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Security Fixes 11.04.240
Base system

Fixed BleedingTooth security issue which means CVE-2020-12351, CVE-2020-12352, and 
CVE-2020-24490.
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New Features 11.04.240
Citrix

Integrated Citrix Workspace app 20.10.
Available Citrix Workspace apps in this release: 20.10 (default), 20.09, and 19.12
Added: Multiple audio devices can be mapped inside the sessions. This will display audio 
devices with their device name and not only HDX audio anymore:
More...

Parameter Multiple Audio Device support

Registry ica.module.vdcamversion4support

Type bool

Value enabled / disabled

Note: Bluetooth devices are currently not supported for device redirection.

Updates Zoom Media Plugin to version 5.4.53376.1029

VMware Horizon

Updated Zoom Media Plugin to version 5.4.53376.1029
Added support for VMware Integrated Printing.
More...

Parameter Integrated Printing

Registry vmware.view.integrated-printing

Type bool

Value enabled / disabled

WVD

New parameter to set HTTP user agent string for AAD login requests.
More...

Parameter HTTP user agent string

Registry sessions.wvd%.options.http-user-agent

Type editable

Value System Default / Windows / Android / iOS / macOS / 
<custom-string>

Cisco Webex VDI

Updated Cisco Webex Teams VDI to version 3.0.16605.0



Notes for Release 11.04.240

IGEL OS Release Notes   503 / 1492

•

•

•
•

•

•
•

•
•

Updated Cisco Webex Meetings VDI to version 40.10

Cisco JVDI Client

Updated Cisco JVDI client to version 12.9.1

Fabulatech

Updated FabulaTech USB for Remote Desktop to version 6.0.28
Updated FabulaTech Scanner for Remote Desktop to version 2.5.0.7

Driver

Updated deviceTRUST client plugin for Citrix and RDP to version 20.1.200.0. Detailed release 
notes can be found at https://docs.devicetrust.com/docs/releases-igel-20.1.200/

Remote Management

Added support for exchanging ICG certificates.
The remote management of the endpoint device automatically installs TLS certificates 
provided by the UMS into the local trusted CA certificates storage. The automatic deployment
of TLS certificates to endpoint devices requires UMS 6.06.100 or higher. This feature allows 
verifying certificates used when downloading files from the UMS, downloading a firmware update 
and custom partition archives over HTTPS or FTPS protocols. The verifying of certificates must 
be enabled by the 
parameter  system.security.remote_management.tls_verify_peer .
More...

Registry system.security.remote_management.tls_ve

rify_peer

Value enabled / disabled

Registry system.security.remote_management.tls_ho

stname_validation

Value enabled / disabled

Added support for UMS commands to store and remove ICG configuration.
Introduced parameters for ICG Websocket connections: debug log, network timeout (in seconds), 
and ping-pong interval (in seconds). The parameters are applied on the next established ICG 
agent connection and ICG tunnel connections: VNC and Secure Terminal. The ping-pong
mechanism is supported only for ICG tunnel connections.
More...

Registry system.icg.websocket.debug

Value off / all / tunnel / agent

Registry system.icg.websocket.network_timeout

https://docs.devicetrust.com/docs/releases-igel-20.1.200/
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Value 30

Registry system.icg.websocket.pingpong_interval

Value 120
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Resolved Issues 11.04.240
Citrix

Fixed issue with Workspace app 2010: Screen flickering while running a video call or sharing the 
screen in Microsoft Teams.
Fixed Issue with Workspace app 2010: Microsoft Teams calls are now working with different 
keyboard layouts.
Fixed: Improved pcom parameter pcom.valid_return_codes%.returncodes  to handle 
ranges a la 1..255 (see tooltip).

Wi-Fi

Fixed issues with D-Link DWA-131 WLAN dongle.

X11 system

Fixed a problem with display hotplug detection when the display switch is not used.
Fixed issues if 2 DisplayPort MST Hubs are connected behind each other.

WVD

WVD memory leak(s) fixed.
Switched back to the local login mask when the AAD login fails for whatever reason. At the 
moment, there is no error message shown. This will come in one of the next versions.

VMware Horizon

Fixed post-session behavior for VMware Horizon sessions where some exit codes of the client 
were discarded and therefore did not trigger the post-session action.
Fixed Local Logon Window in that now we prevent it to get iconified because it always needs to be 
visible, especially in appliance mode where there is no panel to de-iconify it.

CID Key Agent

Update of CID Key Agent to version 6.5.0-1

Teradici PCoIP Client

Updated Teradici PCoIP client to version 20.10

Network

Changed: Usage of r8168 as default network driver on Lenovo M75 Nano.
Added support for some newer Intel e1000e network cards.
Fixed logon by 802.1X authentication.
Fixed: Failing Ethernet connection does not delay online state reached by other means 
anymore.
Added registry keys for enabling/disabling sending of hostname in DHCPv4 and DHCPv6
requests.
More...

Parameter Send hostname in DHCP requests
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Registry network.dhcp.send_hostname

Range [Disabled][Network Manager default]

Parameter Send hostname in DHCPv6 requests

Registry network.dhcp6.send_hostname

Range [Disabled][Network Manager default]

Added registry key for disabling Ethernet link reconfiguration by Network Manager.
More...

Parameter Disable NetworkManager link configuration

Registry network.interfaces.ethernet.device%.nm_di

sable_link_config

Type bool

Value true / false

Note Setting this to "true" can be beneficial when 802.1X 
authentication is disturbed
by link. It is currently set automatically when e1000e drivers 
are used.

Open VPN

Fixed segmentation fault if the nameserver is used. 
Now it is allowed to use an empty password for the private key. Not needed to enter a password 
when the private key does not have one.

Base system

Fixed: The fluendo vadec update closed a memory leak with AMD devices using 
VAAPI acceleration.
Updated Fluendo multimedia codecs to the following versions:
More...

gst-fluendo-aacdec 8/10/2020

gst-fluendo-asfdemux 17/9/2020

gst-fluendo-h264dec 22/9/2020

gst-fluendo-mp3 17/9/2020

gst-fluendo-mpeg4video 18/9/2020

gst-fluendo-vadec 02/11/2020
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gst-fluendo-wmadec 17/9/2020

gst-fluendo-wmvdec 17/9/2020

Fixed possible USB issues with suspend/resume on IGEL M350C devices.
Fixed: Custom applications did not run while being offline even if they did not need network.

Audio

Fixed the ALSA Pulse PCM - a possible deadlock while writing audio data and closing Pulse PCM.
Fixed microphone issues with UD3-LX60 device.

Remote Management

Fixed sporadic failures while retrieving the Unit ID by the IGEL Remote Management agent.
Fixed sending the user logoff message to the UMS.

HID

Updated eGTouch (eGalax) drivers and xorg configuration.
Fixing double tapping of desktop icons on touchscreen devices.

Window manager

Fixed desktop icons not being restricted to one monitor at all.
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Notes for Release 11.04.200
Software: Version 11.04.200

Release Date: 2020-10-08

Release Notes: Version RN-1104200-1

Last update: 2020-10-08

Supported Devices 11.04.200 (see page 509)
Component Versions 11.04.200 (see page 510)
General Information 11.04.200 (see page 517)
Known Issues 11.04.200 (see page 518)
Security Fixes 11.04.200 (see page 522)
New Features 11.04.200 (see page 523)
Resolved Issues 11.04.200 (see page 526)
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Supported Devices 11.04.200
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.04.200

Clients
Product Version

Chromium 83.0.4103.61-0ubuntu0.18.04.1

Cisco JVDI Client 12.9.0

Cisco Webex Teams VDI Client 3.0.15711.0

Cisco Webex Meetings VDI Client 40.10.0.171

Zoom Media Plugin 5.2.456413

Citrix HDX Realtime Media Engine 2.9.0-2330

Citrix Workspace App 19.12.0.19

Citrix Workspace App 20.06.0.15

Citrix Workspace App 20.09.0.15

deviceTRUST Citrix Channel 19.1.200.2

Crossmatch DP Citrix Channel 0515.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 14.0.0.45623

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech USB for Remote Desktop 5.2.29

Firefox 68.12.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2igel1600249269

IGEL WVD Client 1.0.13igel1596142398

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.11.2-1igel8
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Open VPN 2.4.4-2ubuntu1.3

Zulu JRE 8.48.0.51-2

Parallels Client (64 bit) 17.1.2.1

Spice GTK (Red Hat Virtualization) 0.38-2igel93

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.8.0-1+b1igel71

Teradici PCoIP Software Client 20.04.2-18.04

ThinLinc Client 4.12.0-6517

ThinPrint Client 7.5.88

Totem Media Player 2.30.2-0ubuntu1igel55

Parole Media Player 1.0.5-1igel1583919770

VNC Viewer 1.10.1+dfsg-4igel13

VMware Horizon Client 5.4.1-15988340

Voip Client Ekiga 4.0.1-9build1igel6

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20200323

Philips Speech driver 12.9.1

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.9

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2
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Smartcard
PKCS#11 Library A.E.T SafeSign 3.6.0.0-AET.000

PKCS#11 Library Athena IDProtect 7

PKCS#11 Library cryptovision sc/interface 7.3.1

PKCS#11 Library Gemalto SafeNet 10.7.77

PKCS#11 Library OpenSC 0.20.0-3igel37

PKCS#11 Library SecMaker NetID 6.8.1.31

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel2

Reader Driver Gemalto eToken 10.7.77

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.31-1igel11

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.26-3igel14

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2n-1ubuntu5.3

OpenSSL 1.1.1-1ubuntu2.1~18.04.6

OpenSSH Client 7.6p1-4ubuntu0.3

OpenSSH Server 7.6p1-4ubuntu0.3

Bluetooth stack (bluez) 5.52-1igel6

MESA OpenGL stack 20.0.8-1igel117

VAAPI ABI Version 0.40

VDPAU Library version 1.4-1igel1003
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Graphics Driver INTEL 2.99.917+git20200515-igel1013

Graphics Driver ATI/RADEON 19.1.0-1+git20200220igel987

Graphics Driver ATI/AMDGPU 19.1.0-1+git20200318igel986

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 440.100-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel975

Input Driver Elographics 1.4.1-1+b6igel952

Input Driver eGalax 2.5.7413

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel957

Input Driver Wacom 0.36.1-0ubuntu2igel888

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.4.48 #mainline-lxos_dev-g1595410170

Xorg X11 Server 1.20.8-2igel1016

Xorg Xephyr 1.20.8-2igel1016

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.425

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel13

XFCE4 Window Manager 4.14.2-1~18.04igel1600339249

ISC DHCP Client 4.3.5-3ubuntu7.1

NetworkManager 1.20.4-2ubuntu2.2igel100

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 1.x 1.16.2-4igel239
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WebKit2Gtk 2.28.3-2igel36

Python2 2.7.17

Python3 3.6.9

VM Guest Support Components
Virtualbox Guest Utils 6.1.10-dfsg-1igel41

Virtualbox X11 Guest Utils 6.1.10-dfsg-1igel41

Open VM Tools 11.0.5-4ubuntu0.18.04.1

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.20.0-1igel95

Qemu Guest Agent 5.0-5igel12

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.17-3igel5

Mobile Device Access USB (imobile) 1.2.1~git20191129.9f79242-1+b1igel8

Mobile Device Access USB (gphoto) 2.5.25-2igel4

VPN OpenConnect 8.10-1igel4

Scanner support 1.0.27-1

VirtualBox 6.1.10-dfsg-1igel41

Services
Service Size Reduced Firmware

Asian Language Support 24.8 M Included

Java SE Runtime Environment 42.8 M Included

Citrix Appliance
Citrix Workspace app
Citrix StoreFront

258.5 M Included

Ericom PowerTerm InterConnect 17.8 M Included

Media Player 768.0 K Included
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Local Browser (Firefox)
Citrix Appliance

81.8 M Included

VMware Horizon
RDP

5.5. M Included

Cendio ThinLinc 11.5 M Included

Printing (Internet printing protocol CUPS) 23.8 M Included

NoMachine NX 31.5 M Included

VMware Horizon 193.2 M Included

Voice over IP (Ekiga) 7.2 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 30.8 M Not included

Fluendo GStreamer Codec Plugins 8.5 M Included

IBM i Access Client Solutions 96.2 M Not included

Red Hat Enterprise Virtualization 3.5 M Included

Parallels Client 6.2 M Included

NVIDIA graphics driver 128.5 M Not included

Imprivata Appliance 16.0 M Included

Evidian AuthMgr 3.0 M Included

Hardware Video Acceleration 15.0 M Included

Extra Font Package 1.2 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 54.8 M Included

Cisco JVDI client 56.0 M Included

PrinterLogic 50.8 M Not included

Biosec BS Login 10.2 M Not included

Login VSI Login Enterprise 32.8 M Not included

Stratusphere UX CID Key software 3.2 M Not included

Elastic Filebeat 25.0 M Not included

WVD 16.2 M Included
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Local Browser (Chromium) 91.0 M Not included

deskMate client 6.5 M Included

Cisco Webex Teams VDI 40.2 M Not included

Cisco Webex Meetings VDI 46.0 M Not included

Zoom Media Plugin 42.0 M Not included

Teradici PCoIP Client 8.8 M Included

90meter Smart Card Support 256.0 K Included

Mobile Device Access USB (Limited 
support)

512.0 K Not included

VPN OpenConnect (Limited support) 1.8 M Not included

Scanner support / SANE (Limited support) 2.8 M Not included

VirtualBox (Limited support) 69.0 M Not included
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General Information 11.04.200

The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver

To be beneficial to all new features and implementations, it is recommended to use UMS 6.05.110 or 
higher and update the corresponding profiles.



Firmware downgrade to older versions (11.01 or 11.02) is not possible, due to the unsigned firmware 
update files.


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Known Issues 11.04.200
Firmware Update

On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs. Check Updating to IGEL 
OS 11.04 or Higher on a Device with Small Storage (see page 518) for a solution.

Firefox

Firefox IGEL extensions are not updated automatically under some circumstances. After an 
update from 11.03.xxx to 11.04.100, the IGEL extensions will stay on the old version. 
In this case, the following settings concerning kiosk mode cannot be executed:

Switch off hotkey for new window/tab
Blocking of internal browser pages like preferences, file picker, specific local directories

As a workaround:

a reset to defaults should be performed
or the browser's mimetype template can be switched from "Standard" to "Minimal" by 
registry key browserglobal.app.mimetypes_template . There, the browser profile is 
renewed as well.
After the TC received the new setting, reboot and set the mimetypes_template  registry key 
to "Standard" again.

Citrix

With activated DRI3 and an AMD GPU Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1 and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of login. 
Workaround: Insert the smartcard before starting the StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration

Registry ica.workaround-dual-rtme
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Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery group.

During the running Microsoft Teams Optimization of Citrix Workspace App 20.06/20.09, 
webcam redirection or screen sharing may lead to display errors like black stripes or flickering.
The performance of Citrix sessions when using Workspace App 20.06 may be lower on some 
devices. 
A possible workaround is to disable the virtual channels for Microsoft Teams and NSAP or to 
set the HDX transport protocol to TCP only.

ica.module.virtualdriver.vdwebrtc.enable

ica.module.virtualdriver.nsap.enable 

The protocol can be set via the Setup parameter Sessions > Citrix > Citrix Global > Options > HDX 
Adaptive Transport over EDT or via the server policy 'HDX Adaptive Transport'.

VMware Horizon

Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Enable local `Storage Hotplug` on Setup page Devices > Storage Devices > Storage 
Hotplug.

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.
After the disconnect of an RDP-based session, the Horizon main window which contains the 
server or sessions overview cannot be resized anymore.
Seamless application windows in Horizon Client may not be displayed correctly.  When 
starting the first seamless app, a new iconified window appears in the taskbar, and only if you click 
on it, the application will show up.
On some hardware (UD7-H850, UD2-M250, UD2-D220), however, the client aborts when this new 
window is de-iconified.
When using the RDP protocol, the remote session has a fixed offset of approximately the height of 
the menu bar. That means you have a black bar on top of the window and as a result of that, the 
Windows panel on the bottom is cut off.
Modifier keys (Shift/Ctrl/Win/Alt ) in session windows using RDP protocol do not send 
the keyup event and thus keep being pressed even when actually released. Only when you leave 
the session with the mouse, the modifiers are reset.
Copying a text from Horizon Blast sessions is not possible.
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The on-screen keyboard in Horizon appliance mode doesn't work correctly with local logon. 
You have to switch off the local logon and switch on these two keys in the IGEL registry:

userinterface.softkeyboard.autoshow 

userinterface.softkeyboard.autohide

Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters does not work after system suspend/resume. Workaround: 
Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Parallels Client

Native USB redirection does not work with Parallels Client.

Smartcard

Citrix Certificate Identity Declaration login does not work with SecMaker smartcards.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hyper-V

Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.

VirtualBox

The current VirtualBox Guest Tools/Drivers will not work with VirtualBox 5.2.x or older hosts 
which leads to a black screen and non-working graphics.
Possible workaround: Install with 'Failsafe Installation + Recovery' and set the registry key 
x.drivers.force_vesa  to 'true'.

When running in VirtualBox virtualization, resizing the window will not automatically change 
desktop resolution of IGEL OS guest.

Audio

Audio jack detection on Advantech POC-W243L doesn't work. Therefore, sound output 
goes through a possibly connected headset and the internal speakers.
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.

Hardware

HP t730 could freeze when monitors with different resolutions are connected (1920x1200 + 
2560x1440 + 3840x1600 for example). When this occurs, the registry 
key  x.drivers.kms.best_console_mode  has to be set to disabled.
Some newer Delock 62599 active DisplayPort-to-DVI (4k) adapters only work with INTEL 
devices.

Remote Management

AIT feature with IGEL Starter License is supported by the UMS version 6.05.100.

Base system



Notes for Release 11.04.200

IGEL OS Release Notes   521 / 1492

•

•

•

•

Update from memory stick requires network online state (when multiple update stages are 
involved).

deskMate

Some stability issues may remain.

Appliance Mode

When ending a Citrix session in browser appliance mode, the browser is restarted twice instead 
of once.
Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.
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Security Fixes 11.04.200
Firefox

Updated Mozilla Firefox to 68.12.0esr:
Fixes for mfsa2020-11, also known as CVE-2020-6819, CVE-2020-6820.
Fixes for mfsa2020-13, also known as 
More...

CVE-2020-6828, CVE-2020-6827, CVE-2020-6821, 
CVE-2020-6822, and CVE-2020-6825

Fixes for mfsa2020-17 also known as:
More...

CVE-2020-12387, CVE-2020-12388, CVE-2020-12389,
CVE-2020-6831, CVE-2020-12392, CVE-2020-12393, 
and CVE-2020-1239

Fixes for mfsa2020-21 also known as:
More...

CVE-2020-12399, CVE-2020-12405,
CVE-2020-12406, CVE-2020-12410

Fixes for mfsa2020-25 also known as:
More...

CVE-2020-12417, CVE-2020-12418, CVE-2020-12419, 
CVE-2020-12420, CVE-2020-12421

Fixes for mfsa2020-31 also known as:
More...

CVE-2020-15652, CVE-2020-6514, CVE-2020-6463, 
CVE-2020-15650, CVE-2020-15649, and CVE-2020-15659

Fixes for mfsa2020-37 also known as: CVE-2020-15663, CVE-2020-15664, and 
CVE-2020-15669

Base system

Fixed privilege escalation via environment variables in the /bin/update  binary.

Fixed privilege escalation via environment variable PATH  in /bin/usershell  binary.

Fixed privilege escalation via PATH  environment variable in the /bin/update  binary.
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New Features 11.04.200
Citrix

Integrated Citrix Workspace app 20.09. Removed Citrix Workspace app 18.10.
Available Citrix Workspace apps in this release: 20.09 (default), 20.06 and 19.12. 
The performance of the Citrix Workspace app 20.09 was improved and a more detailed logging
was implemented.
Citrix logging was summarized. Now, only one parameter is needed to activate logging.
More...

Parameter Enable logging for Citrix sessions

Registry ica.logging.debug

Value on / off

Since Workspace app 20.09, the tool setlog is used to configure the logging. For this purpose, 
parameters are provided in the registry ica.logging.setlog ; usually, nothing needs to be 
changed.
After disabling logging, the system must be restarted once.
Integrated Zoom Media Plugin 5.2.456413.0902
Added PAC proxy auto configuration support for Zoom Media Plugin (ZoomVDI). 
To configure, the following parameters need to be set:

network.proxy.settings.sys_proxy_type="Automatic proxy 

configuration"

network.proxy.settings.sys_proxy_autoconfig_url="http://..."

   Alternatively, the manual HTTP/HTTPS proxy setting configured at IGEL Setup > Network > Proxy is now 
used for Zoom Media Plugin.

Improved configuration of ZoomVDI client.

Cisco Webex

Integrated Cisco Webex Meetings 40.10.

Parallels Client

Updated Parallels Client to version 17.1.2.1. 
Fixed security vulnerability issue disclosed in the Parallels KB article https://kb.parallels.com/en/
125112.

Audio

Added EPOS Connect 5.0.1.2795.
More...

IGEL Setup Devices > Unified Communications > EPOS Audio > 
EPOS Connect

https://kb.parallels.com/en/125112
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Parameter Enable EPOS Connect

Registry devices.epos.connect.enable

Type bool

Value enabled / disabled

IGEL Setup Devices > Unified Communications > EPOS Audio > 
EPOS Connect

Parameter Tenant ID

Registry devices.epos.connect.tenant_id

Type string

Value ''

IGEL Setup Devices > Unified Communications > EPOS Audio > 
EPOS Connect

Parameter Backend Endpoint

Registry devices.epos.connect.tenant_url

Type string

Value ''

IGEL Setup Devices > Unified Communications > EPOS Audio > 
EPOS Connect

Parameter Proxy

Registry devices.epos.connect.proxy

Type string

Value ''

Registry devices.epos.connect.log_level

Value Trace / Debug / Information / Warnings / Errors / 
Exceptions / No logs

Smartcard

Updated A.E.T. Europe SafeSign Identity Client to version 3.6.0.0.

Multimedia
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Added possibility to fetch log files of the Zoom Media Plugin (ZoomVDI) via UMS support 
information.

Hardware

Added detection of UD Pocket UC5-LX 2.

Misc

Updated Login Enterprise to version 4.2.
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Resolved Issues 11.04.200
Citrix

Fixed the problem with apparmor and the Citrix MS Teams workaround. 
Fixed: In some Citrix sessions, there have been sporadic appearances of black rectangles when 
the feature "Accelerated H.264 Deep Compression Codec" is active.
Integrated parameter to activate the workaround for the keyboard language issue with MS 
Teams Optimization.
More...

Parameter Microsoft Teams optimization keyboard language 
workaround

Registry ica.module.virtualdriver.vdwebrtc.keybo

ard_workaround

Value on / off

RDP/IGEL RDP Client 2

Improved error logging.
Fixed USB redirection for RDP sessions.

Firefox

Fixed smartcard access in Firefox. Before this fix, smartcards were not recognized occasionally.

Network

Fixed handling of DNS default domain.
Added registry key specifying the number of 802.1X authentication attempts on Ethernet.
More...

Registry network.interfaces.ethernet.device%.ieee8021x.a

uth_attempts

Type integer

Value 1

SCEP: Fixed derivation of 802.1X identity from client certificate.

Window manager

Fixed crash of start menu, where it was not populated with any items.
Fixed start monitor mapping for Firefox.

Wi-Fi

Added missing iwlwifi-6000-4 firmware file.

Open VPN
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Fixed segmentation fault when nameserver was used.
Added: Different protocols are now selectable:
More...

Paramete
r

protocol

Registry sessions.openconnect%.vpnopts.protocol

Value Cisco AnyConnect / Juniper Network / Junos Pulse / PAN 
GlobalProtect

Base system

Fixed panels clock format via registry key windowmanager.wm%.variables.clock_time .
Post-session command binaries and return codes are now customizable via registry. Allows 
post-session commands if a binary doesn't return 0.
Name of the binary:
More...

Paramete
r

Binary

Registry pcom.valid_return_codes<NR>.binary

Value binary name

Comma seperated return codes (e.g. 7,99) or/and return code ranges (e.g. 3..5 for 3,4,5) to be 
accepted:
More...

Paramete
r

Return Codes

Registry pcom.valid_return_codes<NR>.returncodes

Value e.g. 3,5,10..15 for 3,5,10,11,12,13,14,15

Fixed problems with hostnames containing one or more "_" characters.
Added: Show AMD Memory Guard in Boot Mode, when enabled.

Storage Devices

Fixed display of hotplug eject menu in appliance mode.

Remote Management

Fixed ICG HA functionality broken in 11.04.100.
Fixed automatic establishment of the configured ICG connection if the UMS Server is 
unreachable.
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Notes for Release 11.04.100
Software: Version 11.04.100

Release Date: 2020-08-05

Release Notes: Version RN-1104100-1

Last update: 2020-08-05

IGEL OS 11 (see page 529)
IGEL OS Creator (OSC) (see page 582)
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IGEL OS 11
Supported Devices 11.04.100 (see page 530)
Component Versions 11.04.100 (see page 531)
General Information 11.04.100 (see page 538)
Known Issues 11.04.100 (see page 539)
Security Fixes 11.04.100 (see page 543)
New Features 11.04.100 (see page 544)
Resolved Issues 11.04.100 (see page 563)
CA Certificates Contained in IGEL OS 11.04.100 (see page 571)
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Supported Devices 11.04.100
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.04.100

Clients

Product Version

Chromium 83.0.4103.61-0ubuntu0.18.04.1

Cisco JVDI Client 12.9.0

Cisco Webex Teams VDI Client 3.0.15711.0

Cisco Webex Meetings VDI Client 40.7.0.375

Citrix HDX Realtime Media Engine 2.9.0-2330

Citrix Workspace App 18.10.0.11

Citrix Workspace App 19.12.0.19

Citrix Workspace App 20.06.0.15

deviceTRUST Citrix Channel 19.1.200.2

Crossmatch DP Citrix Channel 0515.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 14.0.0.45623

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech USB for Remote Desktop 5.2.29

Firefox 68.10.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

IGEL WVD Client 1.0.13igel1596142398

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

Qualification at Imprivata in progress

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.11.2-1igel8
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Open VPN 2.4.4-2ubuntu1.3

Zulu JRE 8.48.0.51-2

Parallels Client (64 bit) 17.1.1

Spice GTK (Red Hat Virtualization) 0.38-2igel93

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.8.0-1+b1igel71

Teradici PCoIP Software Client 20.04.2-18.04

ThinLinc Client 4.12.0-6517

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.5-1igel1583919770

VNC Viewer 1.10.1+dfsg-4igel13

VMware Horizon Client 5.4.1-15988340

Voip Client Ekiga 4.0.1

Dictation

Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20200323

Philips Speech driver 12.9.1

Signature

Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.9

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard

PKCS#11 Library A.E.T SafeSign 3.0.101
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PKCS#11 Library Athena IDProtect 7

PKCS#11 Library cryptovision sc/interface 7.3.1

PKCS#11 Library Gemalto SafeNet 10.7.77

PKCS#11 Library OpenSC 0.20.0-3igel37

PKCS#11 Library SecMaker NetID 6.8.1.31

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel2

Reader Driver Gemalto eToken 10.7.77

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.31-1igel11

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.26-3igel14

Cherry USB2LAN Proxy 3.2.0.3

System Components

OpenSSL 1.0.2n-1ubuntu5.3

OpenSSL 1.1.1-1ubuntu2.1~18.04.6

OpenSSH Client 7.6p1-4ubuntu0.3

OpenSSH Server 7.6p1-4ubuntu0.3

Bluetooth stack (bluez) 5.52-1igel6

MESA OpenGL stack 20.0.8-1igel117

VAAPI ABI Version 0.40

VDPAU Library version 1.4-1igel1003

Graphics Driver INTEL 2.99.917+git20200515-igel1013

Graphics Driver ATI/RADEON 19.1.0-1+git20200220igel987

Graphics Driver ATI/AMDGPU 19.1.0-1+git20200318igel986
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Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 440.100-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel975

Input Driver Elographics 1.4.1-1+b6igel952

Input Driver eGalax 2.5.7413

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel957

Input Driver Wacom 0.36.1-0ubuntu2igel888

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.4.48 #mainline-lxos-g1595410170

Xorg X11 Server 1.20.8-2igel1016

Xorg Xephyr 1.20.8-2igel1016

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.425

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel13

XFCE4 Window Manager 4.14.2-1~18.04igel1595331607

ISC DHCP Client 4.3.5-3ubuntu7.1

NetworkManager 1.20.4-2ubuntu2.2igel100

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 1.x 1.16.2-4igel239

WebKit2Gtk 2.28.3-2igel36

Python2 2.7.17

Python3 3.6.9
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VM Guest Support Components

Virtualbox Guest Utils 6.1.10-dfsg-1igel41

Virtualbox X11 Guest Utils 6.1.10-dfsg-1igel41

Open VM Tools 11.0.5-4ubuntu0.18.04.13

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.20.0-1igel95

Qemu Guest Agent 5.0-5igel12

Features with Limited IGEL Support

Mobile Device Access USB (MTP) 1.1.17-3igel5

Mobile Device Access USB (imobile) 1.2.1~git20191129.9f79242-1+b1igel8

Mobile Device Access USB (gphoto) 2.5.25-2igel4

VPN OpenConnect 8.10-1igel4

Scanner support 1.0.27-1

VirtualBox 6.1.10-dfsg-1igel41

Services

Service Size Reduced Firmware

Asian Language Support 22.5 M Included

Java SE Runtime Environment 36.0 M Included

Citrix Workspace app
Citrix Appliance
Citrix StoreFront

219.5 M Included

Ericom PowerTerm InterConnect 15.5 M Included

Media Player 512.0 K Included

Citrix Appliance
Local Browser (Firefox)

70.2 M Included

RDP
VMware Horizon

4.2 M Included
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Cendio ThinLinc 10.0 M Included

Printing (Internet printing protocol CUPS) 22.2 M Included

NoMachine NX 26.8 M Included

VMware Horizon 114.5 M Included

Voice over IP (Ekiga) 6.5 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M Not included

Fluendo GStreamer Codec Plugins 6.8 M Included

IBM i Access Client Solutions 72.5 M Not included

Red Hat Enterprise Virtualization 3.0 M Included

Parallels Client 5.5 M Included

NVIDIA graphics driver 115.0 M Not included

Imprivata Appliance 10.8 M Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 13.0 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 48.0 M Included

Cisco JVDI client 45.8 M Included

PrinterLogic 40.8 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M Not included

Stratusphere UX CID Key software 2.8 M Not included

Elastic Filebeat 15.8 M Not included

WVD 13.8 M Included

Local Browser (Chromium) 81.2 M Not included

deskMate client 5.8 M Included

Cisco Webex Teams VDI 32.0 M Not included

Cisco Webex Meetings VDI 36.8 M Not included
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Zoom Media Plugin 39.8 M Not included

Teradici PCoIP Client 7.8 M Included

90meter Smart Card Support 256.0 K Included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.5 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 62.5 M Not included
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General Information 11.04.100

The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver

To be beneficial to all new features and implementations, it is recommended to use UMS 6.05.100 or 
higher and update the corresponding profiles.



Firmware downgrade to older versions (11.01 or 11.02) is not possible, due to the unsigned firmware 
update files.


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Known Issues 11.04.100
Firmware Update

On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs and unused features 
must be disabled in IGEL Setup under System > Firmware Customization > Features to perform 
the firmware update. For instructions on how to prevent issues with updating, see _Updating to 
IGEL OS 11.04 or Higher (see page 539).

Firefox

Firefox IGEL extensions are not updated automatically under some circumstances. After an 
update from 11.03.xxx to 11.04.100, the IGEL extensions will stay on the old version. 
In this case, the following settings concerning kiosk mode cannot be executed:

Switch off hotkey for new window/tab
Blocking of internal browser pages like preferences, file picker, specific local directories

As a workaround:

a reset to defaults should be performed
or the browser's mimetype template can be switched from "Standard" to "Minimal" by 
registry key browserglobal.app.mimetypes_template . There, the browser profile is 
renewed as well.
After the TC received the new setting, reboot and set the mimetypes_template  registry key 
to "Standard" again.

Citrix

With activated DRI3 and an AMD GPU Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1 and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of login. 
Workaround: Insert the smartcard before starting the StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration
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Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery group.

Using CWA 19.x sometimes freezes the session while session logoff from a published desktop. 
Workaround: Use CWA 18.10.0.
During the running Microsoft Teams Optimization of Citrix Workspace App 20.06, webcam 
redirection or screen sharing may lead to display errors like black stripes or flickering.
The performance of Citrix sessions when using Workspace App 20.06 may be lower on some 
devices. 
A possible workaround is to disable the virtual channels for Microsoft Teams and NSAP or to 
set the HDX transport protocol to TCP only.

ica.module.virtualdriver.vdwebrtc.enable

ica.module.virtualdriver.nsap.enable 
The protocol can be set via the Setup parameter Sessions > Citrix > Citrix Global > Options 
> HDX Adaptive Transport over EDT or via the server policy 'HDX Adaptive Transport'.

VMware Horizon

Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Enable local `Storage Hotplug` on Setup page Devices > Storage Devices > Storage 
Hotplug.

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.
After the disconnect of an RDP-based session, the Horizon main window which contains the 
server or sessions overview cannot be resized anymore.
Seamless application windows in Horizon Client may not be displayed correctly.  When 
starting the first seamless app, a new iconified window appears in the taskbar, and only if you click 
on it, the application will show up.
On some hardware (UD7-H850, UD2-M250, UD2-D220), however, the client aborts when this new 
window is de-iconified.

Imprivata
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On devices with 2 GB of flash storage, it could happen that there is not enough space to enable 
the Imprivata partition after the update to 11.04.100. In this case, a corresponding error 
message occurs and unused features must be disabled (in IGEL Setup under System > Firmware 
Customization > Features). Imprivata has to be (re-)enabled after a reboot then.

Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters does not work after system suspend/resume. Workaround: 
Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Parallels Client

Native USB redirection does not work with Parallels Client.

Smartcard

Citrix Certificate Identity Declaration login does not work with SecMaker smartcards.
In seldom cases, the authentication hung when using A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hyper-V

Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.

VirtualBox

The current VirtualBox Guest Tools/Drivers will not work with VirtualBox 5.2.x or older hosts 
which leads to a black screen and non-working graphics.
Possible workaround: Install with 'Failsafe Installation + Recovery' and set the registry key 
x.drivers.force_vesa  to 'true'.

When running in VirtualBox virtualization, resizing the window will not automatically change 
desktop resolution of IGEL OS guest.

Audio

Audio jack detection on Advantech POC-W243L doesn't work. Therefore, sound output 
goes through a possibly connected headset and the internal speakers.
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.

Hardware

HP t730 could freeze when monitors with different resolutions are connected (1920x1200 + 
2560x1440 + 3840x1600 for example). When this occurs, the registry 
key  x.drivers.kms.best_console_mode  has to be set to disabled.
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Some newer Delock 62599 active DisplayPort-to-DVI (4k) adapters only work with INTEL 
devices.

Remote Management

AIT feature with IGEL Starter License is supported by the UMS version 6.05.100.

Base system

Update from memory stick requires network online state (when multiple update stages are 
involved).

deskMate

Integrated deskMate solution. Some stability issues may remain.
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Security Fixes 11.04.100
Firefox

Updated Mozilla Firefox to 68.10.0esr:
Fixes for mfsa2020-11, also known as CVE-2020-6819 and CVE-2020-6820
Fixes for mfsa2020-13, also known as:
More...

CVE-2020-6828, CVE-2020-6827, CVE-2020-6821, 
CVE-2020-6822, and CVE-2020-6825

Fixes for mfsa2020-17 also known as:
More...

CVE-2020-12387, CVE-2020-12388, CVE-2020-12389, 
CVE-2020-6831, CVE-2020-12392,
CVE-2020-12393, and CVE-2020-1239

Fixes for mfsa2020-21 also known as:
More...

CVE-2020-12399, CVE-2020-12405, 
CVE-2020-12406, and CVE-2020-12410

Fixes for mfsa2020-25 also known as:
More...

CVE-2020-12417, CVE-2020-12418, CVE-2020-12419, 
CVE-2020-12420, and CVE-2020-12421

Changed option to deny local file browsing via file:// URI per default now.
More...

IGEL Setup Firefox Browser > Firefox Browser Global > Window

Parameter Hide local filesystem

Registry browserglobal.app.filepicker_dialog_hi

dden

Value enabled / disabled

Base system

SSH protocol version 1 is now disabled. All remote connections via SSH must use SSHv2.

Driver

Updated Nvidia driver to version 440.100.
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New Features 11.04.100
Citrix

Integrated Citrix Workspace App 20.06. 
Available Citrix Workspace Apps in this release: 20.06 (default), 19.12, and 18.10
Added a registry key to enable optimization for Microsoft Teams.
More...

IGEL Setup Sessions > Citrix > Citrix Global > Unified 
Communications > VDI Solutions

Parameter Microsoft Teams optimization

Registry ica.module.virtualdriver.vdwebrtc.enabl

e

Value on / off

Added a registry key to enable support for NetScaler App Experience (NSAP) virtual channel.
More...

Parameter HDX uses the NSAP virtual channel

Registry ica.module.virtualdriver.nsap.enable

Value on / off

Integrated Citrix HDX/RTME 2.9.
Integrated ZOOM Media Plugin for Citrix to optimize performance for ZOOM video calls and 
conferences.
IGEL x64: 5.0.415463.0619 requires Windows x86 or x64: 5.0.24002.0619. https://support.zoom.us/
hc/en-us/articles/360031096531-Getting-Started-with-VDI
More...

IGEL Setup Sessions > Citrix > Citrix Global > Unified 
Communications > VDI Solutions

Parameter Zoom Media Plugin

Registry ica.module.virtualdriver.vdzoom.enable

Value enabled / disabled

Updated signotec Virtual Channel to version 8.0.9. 
The corresponding changes are:

Logging has been improved.
A problem with the communication with the signature pads was fixed.
USB communication via bulk transfer is model-independent (improved speed).

https://support.zoom.us/hc/en-us/articles/360031096531-Getting-Started-with-VDI
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Removed parameter Content redirection / ica.wfclient.crenabled  from TC 
Setup (Sessions > Citrix > Citrix Global > HDX Multimedia).

OSC Installer

Added dialog "Feature Selection" in IGEL OS Creator for the selection of features to be installed 
on the target device. It interactively shows if the current selection of features fits onto the device. 
The selection of features is saved on the OSC installer medium (when allowed) and set as the 
default selection for the next installation. If "Migrate Old Settings" is selected, the set of features 
of the old installation is set as the default selection. 
Reduced memory requirements of OSC installer for machines without Nvidia graphic card.

WVD

Added AAC Codec support to Audio Output redirection.
More...

Registry sessions.wvd%.options.enable-aac

Value enabled / disabled

RDP/IGEL RDP Client 2

Added the possibility to add a black background to the RDP auto-reconnect window.
More...

Registry sessions.rdp.options.reconnect-black-

fullscreen

Type bool

Value enabled / disabled

Added configuration option for the amount of RDP auto-reconnect retries. The default value will 
remain "20". A value of "0" means infinite retries.
More...

Registry sessions.rdp.winconnect%.options.reconne

ct-max-retries

Type Integer

Value 20

VMware Horizon

Updated VMware Horizon to version 5.4.1.
For usage with Blast protocol, it is recommended to enable DRI3 graphics mode:
More...

Parameter Use DRI3
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Registry x.driver.use_dri3

Value enabled / disabled

Fixed handling of RDP's fullscreen mode span, which means to combine all local monitors for 
one big remote session.

PowerTerm

Updated Ericom PowerTerm LTC to version 14.0.0.45623.

Parallels Client

Updated Parallels Client to version 17.1.1.

Teradici PCoIP Client

Updated Teradici PCoIP Client to version 20.04.2-18.04. The new version supports hardware-
accelerated H.264 decoding with Ultra PCoIP.
New parameters:
More...

Parameter Log level

Registry pcoip.log-level

Value 0 / 1 / 2  / 3 / 4

PCoIP sessions can now use the global setting.
More...

Parameter Show codec indicator

Registry pcoip.codec_indicator

Value disabled / enabled

Info Show a small dot in the bottom left corner during the session 
to indicate which codec is being used. Green indicates simple 
codec; blue indicates tic2 codec. This setting is only available 
globally.

XEN

Added support to run as XEN guest system.

NX client

Updated NoMachine NX Client to version 6.11.2.

ThinLinc

Updated ThinLinc to version 4.12.

Network



Notes for Release 11.04.100

IGEL OS Release Notes   547 / 1492

•

•
•

•

•

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

DHCP changes: 
The system now sends a vendor-class-identifier(option 60) "igel-dhcp-1". Furthermore, it 
requests vendor-encapsulated-options (43). Those can be used to transfer IGEL-specific options
igelrmserver(224) and umsstructuretag(226) in the vendor namespace (with the same option 
numbers and types) instead of in the global namespace. 
The former way is also still functional, but values transferred in the new way override those which 
were transferred the old way. 
Apart from 224 and 226 one more option is defined in the vendor space: "exclusive", option 1, 
type byte. Its presence means that global options 224 and 226 shall not be interpreted in the 
traditional way and only settings in the vendor space apply. 
IPv6 is not involved.
Added support for LTE module HP lt4132.
Updated Network Manager to version 1.20.4.

The range of network.interfaces.wirelesslan.device0.bgscan.module now includes 
"default" for using original upstream Network Manager settings.

Added some additional Ethernet network drivers.
More...

amd-xgbe : AMD 10 Gigabit Ethernet driver
ec_bhf : Beckhoff EtherCAT
liquidio_vf : Cavium LiquidIO Intelligent Server Adapter Virtual Function driver
liquidio : Cavium LiquidIO Intelligent Server Adapter driver
thunder_bgx : Cavium Thunder BGX/MAC driver
nicvf : Cavium Thunder NIC Virtual Function driver
nicpf : Cavium Thunder NIC Physical Function driver
thunder_xcv : Cavium Thunder RGX/XCV driver
atlantic : aQuantia Corporation(R) network driver
be2net : Emulex OneConnect NIC driver 12.0.0.0
ixgb : Intel(R) PRO/10GbE network driver
igc : Intel(R) 2.5G Ethernet Linux driver
ice : Intel(R) Ethernet Connection E800 Series Linux driver
i40e : Intel(R) Ethernet Connection XL710 network driver
iavf : Intel(R) Ethernet Adaptive Virtual Function network driver
ixgbe : Intel(R) 10 Gigabit PCI Express network driver
igbvf : Intel(R) Gigabit Virtual Function network driver
ixgbevf : Intel(R) 10 Gigabit Virtual Function network driver
ena : Elastic Network Adapter (ENA)
nfp : The Netronome Flow Processor (NFP) driver
bna : QLogic BR-series 10G PCIe Ethernet driver
enic : Cisco VIC Ethernet NIC driver
mlx5_core : Mellanox 5th generation network adapters (ConnectX series) core driver
mlx4_en : Mellanox ConnectX HCA Ethernet driver
ionic : Pensando Ethernet NIC driver
sfc-falcon : Solarflare Falcon network driver
sfc : Solarflare network driver
dwc-xlgmac : Synopsys DWC XLGMAC driver
hinic : Huawei Intelligent NIC driver
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cassini : Sun Cassini Ethernet driver
niu : NIU Ethernet driver
samsung-sxgbe : SAMSUNG 10G/2.5G/1G Ethernet PLATFORM driver
cxgb : Chelsio 10Gb Ethernet driver
qede : QLogic FastLinQ 4xxxx Ethernet driver
qlcnic : QLogic 1/10 GbE Converged/Intelligent Ethernet driver
qed : QLogic FastLinQ 4xxxx Core module
netxen_nic : QLogic/NetXen (1/10) GbE Intelligent Ethernet driver
vxge : Neterion's X3100 Series 10GbE PCIe I/OVirtualized Server adapter
myri10ge : Myricom 10G driver (10GbE)
tehuti : Tehuti Networks(R) network driver
bnxt_en : Broadcom BCM573xx network driver
bnx2x : QLogic BCM57710/57711/57711E/57712/57712_MF/57800/57800_MF/
57810/57810_MF/57840/57840_MF driver

Added a registry key for specifying a space-separated list of DNS resolver options. See "man 
resolv.conf".
More...

Parameter Option list

Registry network.dns.options

Type string

Value empty

Wi-Fi

Added support for WPA3 Personal network authentication.
Added a registry key for preferring WPA3 Personal (i.e. SAE) or WPA2 Personal at the time a 
connection is created with Wireless Manager when the access point offers both:
More...

Parameter Prefer WPA3 Personal to WPA2 Personal

Registry network.applet.wireless.prefer_sae

Range [default] [yes] [no]

Info "default" currently means "no"

Added captive portal support for Wi-Fi. Passing through a captive portal (which is basically a web 
application) is sometimes necessary to achieve full network connectivity (here also referred to 
as online state).

The feature is disabled when the following registry key is empty. Otherwise, it should be 
a URI that is suitable for NetworkManager connectivity check.
More...

Parameter Online check URI
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Registry network.global.onlinecheck.uri

Range [] [http://connectivity-check.ubuntu.com/]

Value http://connectivity-check.ubuntu.com/

The following key specifies the conditions of the online check. It is also required that no 
Ethernet cable is plugged in and DHCP is not set in the UMS.
More...

Parameter Condition for online check

Registry network.global.onlinecheck.conditio

n

Range [None] [Network is user-defined] [Network is open]

This key determines how many seconds to wait for full network connectivity before the 
network connection is considered complete with incomplete connectivity. The timeout 
should allow a user to do what is necessary for passing through the captive portal.
More...

Parameter Online check timeout

Registry network.global.onlinecheck.timeout

Type integer

Value 120

Enabled use of 802.11r, also known as fast BSS transition or FT. This is confirmed to work at least 
in the mode "over the air".

Smartcard

Updated OpenSC to version 0.20.0. See https://github.com/OpenSC/OpenSC/releases/tag/0.20.0
for detailed release notes.

Cisco JVDI Client

Updated Cisco JVDI client to version 12.9.0.

Cisco Webex VDI

Integrated the new feature Cisco Webex Teams VDI for Citrix and Horizon sessions.
Cisco Webex Teams version: 3.0.15711.0
Added a parameter to activate the feature within Citrix:
More...

IGEL Setup Sessions > Citrix > Citrix Global > Unified 
Communications > Cisco

Parameter Cisco Webex Teams VDI

https://github.com/OpenSC/OpenSC/releases/tag/0.20.0
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Registry ica.module.virtualdriver.vdciscoteams.e

nable

Value enabled / disabled

Added a parameter to activate the feature within VMware:
More...

IGEL Setup Sessions > Horizon > Horizon Client Global > Unified 
Communications > Cisco

Parameter Cisco Webex Teams VDI - Horizon

Registry vmware.view.vdciscoteams.enable

Value enabled / disabled

Integrated the new feature Cisco Webex Meetings VDI for Citrix sessions. 
Client Version: 40.7.0.375
Added a parameter to activate the feature within Citrix:
More...

IGEL Setup Sessions > Citrix > Citrix Global > Unified 
Communications > Cisco

Parameter Cisco Webex Meetings VDI

Registry ica.module.virtualdriver.vdciscomeeting

s.enable

Value enabled / disabled

Base system

Updated base system to Ubuntu LTS version 18.04.
Updated kernel to version 5.4.48.
Added notification for critical system out-of-memory state when the available system memory 
is lower than 40 MB and processes were killed to prevent the system from freezing.
Display AMD Memory Guard in Boot Mode when it's active.
Added notification option for Session Autostart when a autostart delay is configured. It is 
possible to cancel the session autostart or to start immediately.
More...

IGEL Setup * > Desktop integration

Parameter Autostart notification

Value enabled / disabled

Added correct UI handling for Wacom DTU-1141B. 
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Updated CA Certificates to version 20190122 (Mozilla authority bundle version 2.30). The 
following authorities were added:
More...

"Certigna Root CA"
"GTS Root R1"
"GTS Root R2"
"GTS Root R3"
"GTS Root R4"
"UCA Extended Validation Root"
"UCA Global G2 Root"
"GlobalSign Root CA - R6"
"OISTE WISeKey Global Root GC CA"
"GDCA TrustAUTH R5 ROOT"
"SSL.com EV Root Certification Authority ECC"
"SSL.com EV Root Certification Authority RSA R2"
"SSL.com Root Certification Authority ECC"
"SSL.com Root Certification Authority RSA"
"TrustCor ECA-1"
"TrustCor RootCert CA-1"
"TrustCor RootCert CA-2"

The following authorities were removed:
More...

"Certplus Root CA G1"
"Certplus Root CA G2"
"OpenTrust Root CA G1"
"OpenTrust Root CA G2"
"OpenTrust Root CA G3"
"TÜRKTRUST Elektronik Sertifika Hizmet Saglayicisi H5"
"Visa eCommerce Root"
"ACEDICOM Root"
"AddTrust Low-Value Services Root"
"AddTrust Public Services Root"
"AddTrust Qualified Certificates Root"
"CA Disig Root R1"
"CNNIC ROOT"
"Camerfirma Chambers of Commerce Root" 
"Camerfirma Global Chambersign Root"
"Certinomis - Autorit‚ Racine"
"Certum Root CA"
"China Internet Network Information Center EV Certificates Root"
"Comodo Secure Services root"
"Comodo Trusted Services root"
"DST ACES CA X6" 
"GeoTrust Global CA 2"
"PSCProcert"
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"Security Communication EV RootCA1"
"Swisscom Root CA 1"
"Swisscom Root CA 2"
"Swisscom Root EV CA 2"
"TURKTRUST Certificate Services Provider Root 2007"
"TUBITAK UEKAE Kok Sertifika Hizmet Saglayicisi - Surum 3"
"UTN USERFirst Hardware Root CA"

Added parameter to override rate limit of debug messages in journal. It should be enabled for 
debugging processes which generate a big amount of messages in order to avoid skipping of 
messages.
More...

Parameter No rate limit

Registry system.journald.no_rate_limit

Value enabled / disabled

It's possible to extend the login options of the Kerberos login window now. 
There are several new registry keys:
More...

Parameter extended login

Registry sessions.xlock0.options.login_extensio

n_active

Value enabled / disabled

If enabled, an "Associate Type" combo box is shown. The entries of the combo box are 
configured with the following login_feature1, login_feature2, and login_feature3 keys.

Configure the label of the "Associate Type" combo box:
More...

Parameter login features label

Registry sessions.xlock0.options.login_featur

es_label

Value Default: empty which means "Associate Type"

The first entry of the "Associate Type" combo box. To enable the combo box entry, add 
e.g. the text "Store associate at home store". 
More...

Parameter login_feature1
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Registry sessions.xlock0.options.login_featu

re1

If the entry is selected, the username is expanded by a fixed string defined in 
login_extension_default  registry key.

The fixed username extension for the first feature. It can be set e.g. by a script.
More...

Parameter login extension default value

Registry sessions.xlock0.options.login_extens

ion_default

The second entry of the "Associate Type" combo box. To enable the combo box entry, 
add e.g. the text "Store associate visiting this store". 
More...

Parameter login_feature2

Registry sessions.xlock0.options.login_featu

re2

If the entry is selected, the username is expanded by a suffix that is entered in 
a separate entry widget.
The label of the entry field for the username suffix. Set it e.g. to "Store Number".
More...

Parameter login_extension_label

Registry sessions.xlock0.options.login_extens

ion_label

Value Default: empty which means "no label"

The third entry of the "Associate Type" combo box. To enable the combo box entry, add 
e.g. the text "Homeoffice associate visiting this store".
More...

Parameter login_feature3

Registry sessions.xlock0.options.login_featu

re3

If the entry is selected, another domain can be selected from an appended 
domain combo box.
The label for the domain entry field.
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More...

Parameter login domain label

Registry sessions.xlock0.options.login_domain

_label

Value Default: empty which means "domain"

The extension to the username is added after a dot ('.').
For the domain drop-down box, four different domains are configurable here:
More...

IGEL Setup Security > Active Directory/Kerberos > Domain 1 - 
4

Parameter Fully qualified domain name

Registry auth.krb5.realms.realm0.realm

Registry auth.krb5.realms.realm1.realm

Registry auth.krb5.realms.realm2.realm

Registry auth.krb5.realms.realm3.realm

There are keys to add more domain names:
More...

Parameter Domain 

Registry auth.krb5.extended_domain%.name

Info Add a new instance for each domain entry.

In the Kerberos login window, it's now possible to turn on or off numlock and/or capslock 
for password input. 
Registry keys:
More...

Parameter Handling of numlock

Registry sessions.xlock0.options.numlock_appr

oach

Range [don't change] [set on] [set off]

Info "set on": force numlock on when password is entered
"set off": force numlock off when password is entered
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Parameter Handling of capslock

Registry sessions.xlock0.options.capslock_app

roach

Range [don't change] [set on] [set off]

Info "set on": force capslock on when password is entered
"set off": force capslock off when password is entered

It's now possible to show a message in the Kerberos login window. Registry key:
More...

Parameter banner text

Registry sessions.xlock0.options.banner_text

Info The user will see the message on the top border.

In the Kerberos login window, there is a mode to convert passwords always to upper 
case. To turn it on, use:
More...

Parameter case-insensitive password

Registry sessions.xlock0.options.case_insensi

tive_password

Value enabled / disabled

With this key, the text for the case-insensitive indicator can be modified:
More...

Parameter case-insensitive text

Registry sessions.xlock0.options.case_insensi

tive_text

Value Default: empty which means "case-insensitive"

Fixed ThinkPad Brazil keyboard layout.
It is possible to show a custom logo in the Kerberos login window. Also, the background 
and text color is customizable now. 
Registry keys:
More...

Parameter path for login image

Registry sessions.xlock0.options.login_image
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Value /usr/share/pixmaps/greeter-user.svg 

Info Supported image formats include: PNG, JPG, SVG

Parameter set specific colors for greeter

Registry sessions.xlock0.options.set_color

Value enabled / disabled

Parameter text color

Registry sessions.xlock0.options.text_color

Value #ffffff

Info Text color in the format #rrggbb
Example: #ff0077

Parameter background color

Registry sessions.xlock0.options.background_

color

Value #000000

Info Background color in the format #rrggbb
Example: #7700ff

Added new local logon method "Login with Smart Card Certificate". It implements the 
pam_pkcs11 smartccard authentication module. For a successful
configuration, the following has to be provided via UMS file transfer:

root and intermediate CA certificates for verification of the client certificates in 
folder /etc/pam_pkcs11/cacerts

file /etc/pam_pkcs11/cn_map  which contains mappings of Common Names 
to UPN names. 
Each line is in the format \<common name> -> \<logon name>  
where 
\<common name>  is the common name part of the subject of the certificate

 \<logon name>  is 

- in case of Kerberos Enterprise ( auth.login.krb5_enterprise ) disabled: 
the UPN name of the SubjectAltName extension of the certificate, 
e.g. user@MY.DOMAIN 
- in case of Kerberos Enterprise ( auth.login.krb5_enterprise ) enabled: 
the UPN name of the SubjectAltName extension of the certificate with 
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Default Domain ( auth.krb5.libdefaults.default_realm ) suffix, 
e.g. user@DOMAIN.SUFFIX@DEFAULT.DOMAIN10

The logon method can either be used standalone or together with Kerberos logon as a 
fallback if Kerberos does not succeed.
More...

Parameter Login with Smart Card Certificate

Registry auth.login.pkcs11

Value false / true

Parameter Certificate verification policy

Registry auth.login.pkcs11_cert_policy

Value ca,ocsp_on,signature

Parameter Enable Debugging of Smart Card Certificate Logon

Registry auth.login.pkcs11_debug

Value false / true

It is possible to expand the store number by a registry key:
More...

Parameter expand store

Registry sessions.xlock0.options.expand_stor

e

Value enabled / disabled

Fixed: The login screen is adjusted to lower resolutions.
It is possible to activate enter key to login on all fields.
More...

Parameter auto login on all fields

Registry sessions.xlock0.options.auto_login

Value enabled / disabled

X11 system

Changed: Use modesetting graphics driver on devices with newer intel GPUs.
Changed registry key:

mailto:DOMAIN.SUFFIX@DEFAULT.DOMAIN
mailto:DOMAIN.SUFFIX@DEFAULT.DOMAIN
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More...

Parameter Use generic modesetting driver for INTEL hardware

Registry x.drivers.intel.use_modesetting

Range [Auto] [True] [False]

Updated DisplayLink driver to version 5.3.1.34.
Added new registry key for Nvidia cards (use this if you want to use PRIME):
More...

Parameter Enable/Disable NVIDIA Kernel Modesetting support

Registry x.drivers.nvidia.use_modeset

Range [Default] [Enabled] [Disabled]

Info "Default" is currently the same as "disabled"

Updated florence soft keyboard to version 0.6.3.
Removed 640x480 from possible display resolution range.
Added possibility to change the order of primary and secondary graphic card. 
New registry key:
More...

Parameter Make the secondary graphic card to the primary one

Registry x.drivers.swap_card0_with_card1

Value true / false

Added possibility to invert the order of all graphic cards. 
New registry key:
More...

Parameter Invert default graphic card ordering

Registry x.drivers.swap_all

Value true / false

Added possibility to choose the driver which should become the primary graphic card. 
New registry key:
More...

Parameter Choose which drivers should be preferred to become the 
primary graphic card

Registry x.drivers.preferred_driver

Value
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X server

Added possibility to influence mode used for mirroring screens with different resolutions. 
(Notice: here scaling may not always work). 
New registry key:
More...

Parameter Choose the mode which should be used for mirroring 
monitors if resolution differs

Registry x.xserver0.mirror_mode

Range [Default] [Biggest common resolution] [Scaling]

Value Default (use panning if needed)

Driver

Updated Grundig Dictation driver for Citrix and RDP to version 0.10. 
The changes are:

Support third-party USB HID devices in a more flexible way
Fixed USB transfer overflow for Philips LFH 9620
Remove erroneous debug output in release configuration
Allow to control also "Headphone" volume & switches

Updated Olympus driver for dictation to version 2020-03-23-143654.
Changelog:

New:

DR-1200: PID 0225
DR-2300: PID 0256

Changed: 

PID 0253 from DR-2100 to DR-1200
Updated Philips Speech driver to version G12.9. 
The changes are:

Support for Philips SpeechLive
Faster and more reliable remote session connection status check
Shutdown of the PSPDispatcher.exe on the server if it's not in use anymore.

Updated StepOver TCP client and Citrix plugin to version 2.4.2. Fixed crash of Citrix session 
while using the signature pad.

Audio

Integrated new sound mixer.
New combo box for audio device selection in TC Setup available:

Accessories > Sound Preferences > Options > Default Sound Output
Accessories > Sound Preferences > Options > Default Sound Input

Appliance Mode
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Integrated: The new Browser Appliance mode is the successor for the XenDesktop 
appliance mode. The Browser is configured as in XenDesktop appliance mode, but does not
use the upstream SAS window.
More...

IGEL Setup Sessions > Appliance Mode

Parameter Browser

Registry xen.xenapp-morph.enabled

Type Bool

Value enabled / disabled

IGEL Setup Sessions > Appliance Mode > Browser

Parameter Web URL

Registry xen.xenapp-morph.xendeliveryserverurl

Type string

A hyperlink to the "On-screen Keyboard" is available on the right side under "Related 
Configurations".

Multimedia

Added ffmpeg support for following codecs:
Added support for new decoders:
More...

flac, gif, libaom_av1, mjpeg, mjpegb,
mp1,mp1float, mp2, mp3, mp3adu,
mp3adufloat, mp3float, opus, theora, vorbis,
vp2, vp8, vp9, and wavepack

Added support for new encoder: libopus
Added support for new hwaccels:
More...

mjpeg_vaapi, mpeg1_vdpau, mpeg2_vaapi,
mpeg2_vdpau, vp8_vaapi, and vp9_vaapi

Added support for new parsers: avi, flac, gif, matroska, mp3, ogg, and wav
Added support for new demuxers: avi, flac, gif, matroska, ogg, and wav
Added support for new muxers: ogg and opus

Chromium Browser

Integrated Chromium browser version 83.0.4103.61 as experimental feature.
Configurable at IGEL Setup > Sessions > Chromium Browser > Chromium Browser Global and 
IGEL Setup > Sessions > Chromium Browser > Chromium Browser Sessions
Main switch to enable and disable IGEL configuration:
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More...

IGEL Setup Sessions > Chromium Browser > Chromium Browser 
Global

Parameter Use IGEL Setup for configuration

Registry chromiumglobal.app.igelsetupconfig

Value disabled / enabled

Info With disabled IGEL configuration, you can use the generic 
Custom Setup to configure Chromium. 
The Custom Setup can be found at IGEL Setup > Sessions 
> Chromium Browser > Chromium Browser Global > 
Custom Setup:
Policies, Preferences, Commandline Options.

Parameter for enabling and disabling the H.264 decoding:
More...

IGEL Setup Sessions > Chromium Browser > Chromium Browser 
Global

Parameter H.264 decoding

Registry chromiumglobal.app.h264_decoding

Value enabled / disabled

Info Enable Audio/Video playback of non-free codecs 
(H.264+AAC) - the support is in
a beta state and therefore disabled by default.

Evidian

Added the Evidian built-in option 'Process To Spy'.
More...

Registry evidian.processtospy

Value YOUR-PROCESS / disabled

ControlUp

Integrated ControlUp Monitoring Tool for Citrix and Horizon sessions.

Hardware

Added hardware support for Lenovo M625q.
Added hardware support for LG CL600N.
Added hardware support for HP Engage Go Mobile System.
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Added hardware support for Fujitsu FUTRO S740.
Added hardware support for OnLogic CL210G-10.
Added hardware support for OnLogic KARBON 300.
Added hardware support for Rein Medical Clinio S 522TCT and S 524TCT.
Added hardware support for HP t640 Thin Client.
Added basic support for Macbook models 2018 and newer.
Added support for Sennheiser MB 660, SC 630, SC 45, SC 160 headsets.
Added support for Plantronics Savi 8245 Office, Voyager 6200 UC, Savi 8220 headsets.
Added serial port driver for Exar UART PCIe card.
Added driver for GSPCA based webcams.

TC Setup (Java)

Added Setup page Sessions > Horizon Client > Horizon Client Global > Window. Settings for 
"Window size" and "Multimonitor full-screen mode" can be set. 
These settings are repeated and originate in RDP Global but are now presented in a more obvious 
place for Horizon sessions.

IGEL Cloud Gateway

Added support for Secure Terminal over ICG.
Changed default order of connecting to the IGEL Remote Management - an available UMS 
Server is preferred now by default. The device establishes a configured ICG connection only if the 
UMS Server is not reachable. This behavior can be changed by the parameter:
More...

Registry system.remotemanager.icg_try_ums_connec

t

Value true / false

Fabulatech

Updated FabulaTech Scanner for Remote Desktop client to version 2.4.0.11. 
Updated FabulaTech plugins to version 3.6.2.
Updated Fabulatech USB for Remote Desktop plugins to version 3.6.8.

Jabra

Jabra Xpress (JDU) is upgraded to the 7.2.0-509 version. List of the newly introduced parameters:
More...

Registry jabra.xpress.show_jdu_gui

Value true / false

Registry jabra.xpress.device_dashboard.autopost

Value true / false
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Resolved Issues 11.04.100
Citrix

"Green artifacts" problem in Citrix sessions (most probably) fixed.
Citrix hardware video acceleration supports the latest Intel hardware.

OSC Installer

Fixed issue with filesystems not always get detected correctly in initramfs OSC Installer (needed 
for using iso file boot parameter).
Fixed: username and password in the error message are not shown anymore when firmware 
file could not be downloaded.
Get URLs with username:password@ working.

RDP/IGEL RDP Client 2

Fixed error when renaming a non-empty shared folder.

WVD

Includes WVD client with fixed RDcoreSDK version.
Clipboard redirection has potential privacy and security risks and is therefore disabled by 
default.
IGEL WVD Client integrated

VMware Horizon

Fixed missing support for ThinPrint and Skype for Business when starting Horizon from Firefox 
browser.

Firefox

Fixed Firefox block extension missing tabs created via command line argument.
Fixed rtsp media stream with enabled apparmor.
Show "blocked" page instead of closing tab when blocked page is viewed in Firefox.
Fixed functionality in the local setup to start the certificate manager of the Firefox browser.
Fixed functionality in the local setup to start the Firefox browser with the internal page to show 
the installed plugins. 
Fixed restart mechanism in the Firefox browser where the browser could not be closed on 
suspend resulting in a superfluous browser window on resume.

Network

Improved Wi-Fi DHCP lease handling: Leases are discarded when the network changes. The 
former behavior caused problems with certain iPhone IOS versions.
802.1X failures now generally result in falling back to a connection without authentication, 
e.g. also in the case of 802.1X settings that don't make sense at all. This only applies if the 
fallback is allowed of course.
wpa_supplicant now adds timestamps to entries of its log file.
Use e1000e driver out of the kernel as default instead of the third-party driver.
Added a registry key that determines whether lldpd is in receive-only mode.
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More...

Parameter Disable sending LLDP packets

Registry network.lldp.rxonly

Value true

Attention:  If the behavior since 10.06.100 shall be preserved, this key 
must be set to "false".

Updated scep to version 0.7.0.

Wi-Fi

Fixed non-working Marvell WLAN device 8997 (SDIO version).

NCP VPN

Added fix for NCP Secure Client.

genucard VPN

genucard 3 is supported now.

Imprivata

Control the visibility of the Horizon session control bar via registry parameter:
More...

Registry vmware.view.menu-bar

Value enabled / disabled

Honor the Citrix Window Configuration in Imprivata Appliance Mode. 
Fixed Lock key and Tap out behavior. 
Fixed MS RDSH session.
Simplified the configuration of Imprivata FUS.
Enable the following if you use Imprivata versions above 6.3:
More...

Registry imprivata.gain_permission

Value enabled / disabled

Fixed bug regarding Imprivata and On-Screen Keyboard.
Restore the keyboard map after Horizon sessions.

Smartcard

Fixed not working 90meter in Firefox when apparmor is active.
Fixed problem in smartcard resource manager PC/SC-Lite which caused disconnects of VMware 
Horizon sessions when using smartcards with certain applications.
Added driver for smartcard reader Elatec TWN4 CCID (USB 0x09D8:0x0425).
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Updated cryptovision scInterface to version 7.3.1. 
The changes are:
More...

Consolidated features of the last versions 7.2 and 7.1
Malta eID Release
Added Admin Card Gemalto V3

Updated PC/SC-Lite smartcard resource manager to version 1.8.26.

HID

Fixed: Switching touchpad to other driver via IGEL registry key.

CUPS Printing

Added new version 25.1.0.425 of Printerlogic Printer Installer Client.
Added new printer models into IGEL OS from the current CUPS drivers.

Base System

Fixed bug in folder generation of the Application Launcher.
Fixed TLS certificate verification problem of certificates signed by "USERTrust RSA CA" or 
"COMODO RSA CA". The problem could occur in clients like Citrix Workspace App and VMWare 
Horizon client.
Fixed password change with AD/Kerberos. Before this fix, the password complexity rules were 
not enforced for users with the Reset Password permission for their account.
You can now connect to Bluetooth devices without pairing. For this a new registry key is 
available.
More...

Parameter connect devices without pairing

Registry devices.bluetooth.connect_only

Value enabled / disabled

Some devices do not connect automatically after reboot. To fix that,  bluetoothctl 

connect \<device-ID>  can be executed via script. If the device is connected (0) or not (1)
can be seen in return value.
Known devices that do not connect:

dialog semiconductor IoT Multi Sensor DK
SSHv1 support is now removed due to newer openssh libraries.
Forcing protocol version 1 via SSH Session > Options is no longer possible.
The network.ssh_server.server_key_bits  registry key parameter is removed due to 
deprecation of SSHv1.
Updates systemd to Ubuntu Focal version.
Improved stability of mounting network shares when using a static network configuration.
Fixed apparmor cache issue after update with OSC installer.
Bug fix: touchscreen calibration on 1 or more normal screen with 1 touch screen environment.
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Fixed syslog, kern.log, auth.log, and daemon.log entries are not shown in IGEL System Log 
Viewer.
Updated Grub2 to current Debian SID/Bullseye version 2.04.
Removed deprecated registry keys system.idlecommand .
New Bluetooth pairing tool and Bluetooth tray icon for Bionic.
Updated kernel to mainline version 5.4.48.
If used as master image, the image will expand itself to full size (limited to 16 GiB) on flash. This 
is done only on first boot and never again.
Possible rollout of initial settings, certificates or licenses placed on first partition for this you 
need to:

Write image to your USB/Flash medium.
Mount or simply access the 1. VFAT partition which is present (should be empty).
Copy your setup.ini and/or **.lic files to the 1st partition (no directories).
Create a ca-certs  directory and copy your certificates into it. They will be copied to the 

/wfs/ca-certs  directory on first boot.
You can now copy the USB/Flash medium several times if needed.
On first boot, the device will reboot out of the splash screen (reread changed partition table)
The settings, certificates and/or licenses will get rolled out and deleted from the 1st 
partition.

Added initial support for Thunderbolt devices (only limited support here, may work but is not 
guaranteed).
Updated IGEL EULA.
Updated AMD Microcode to version 3.20191218.1.
Updated Intel Microcode to version 20200520 and a special update for J1900 devices.
Updated Intel Microcode to 20200616 version.
 Added a userspace oom killer to the firmware.

Firmware Update

An ongoing firmware update can now be canceled by the user when the network online status 
could not be reached after 10 seconds (since start of the firmware update).

H264

Citrix hardware video acceleration supports the latest Intel hardware.

Storage Devices

Fixed mount issues with Iphone XR/XE/11PRO.
Mobile Device Access feature respects USB Access Control now. 
Fixed unwanted ownership change of automounted Linux filesystem root directories.

 X11 System

Fixed Display Switch not saving settings over reboot.
Default to settings from Setup instead of mirror when no Display Switch profile is 
available.

Prevent misconfiguration that picks GPU without render capability as primary (e.g. Displaylink).
Improved Nvidia with additional GPU handling.
Fixed error with single-gpu Nvidia card support.
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•

•

•

•

•
•

X server

Fixed a Xorg crash due to a NULL pointer dereference in the Intel driver.

Window Manager

Fixed random login (greeter) window focus issues.

Shadowing/VNC

Added the "snapfb" option for the VNC server.
More...

Registry network.vncserver.snapfb

Value enabled / disabled

Info This option should only be enabled with experienced delays 
in remote or shadowing
session.

Improved security of the password authentication method - the VNC server does not require 
anymore a file holding the password. During client authentication, the server retrieves now the 
password from the IGEL Setup.

VNC Viewer

Fixed occasional freeze of shadowing session e.g. when resizing a window. Now the session gets 
unlocked again after about 20 seconds.
More...

Parameter Unlock X server in case of shadowing session freeze

Registry network.vncserver.grab_buster

Type bool

Value enabled / disabled

VirtualBox

Fixed no automatic resolution changes as virtualbox guest issue.

Audio

Fixed headset microphone using 3.5mm audio jack in Dell Wyse 3040.
Added possibility to set some snd_hda_intel kernel module parameter to overcome possible 
issues with sound devices. 
New registry keys:
More...

Parameter Enable Message Signaled Interrupt
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Registry system.sound_driver.snd_hda_intel.enab

le_msi

Type bool

Value enabled / disabled

Parameter Force enable device

Registry system.sound_driver.snd_hda_intel.enab

le

Type bool

Value enabled / disabled

Parameter Position fix quirk

Registry system.sound_driver.snd_hda_intel.posit

ion_fix

Range [Default] [Auto (0)] [LPIB (1)] [POSBUF (2)] [VIACOMBO (3)]
[COMBO (4)] [SKL+ (5)] [FIFO (6)]

Parameter Change sound card order

Registry system.sound_driver.snd_hda_intel.inde

x

Type integer

Value empty

Parameter Detection of DMIC devices

Registry system.sound_driver.snd_hda_intel.dmic

_detect

Range [Default] [Disabled] [Enabled]

Parameter Enable this if you encounter sound card problems

Registry system.sound_driver.snd_hda_intel.sing

le_cmd

Type bool
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•

Value enabled / disabled

Parameter Automatic power save timeout

Registry system.sound_driver.snd_hda_intel.powe

r_save

Type integer

Value empty

Parameter Reset controller in power save mode

Registry system.sound_driver.snd_hda_intel.power

_save_controller

Type bool

Value enabled / disabled

Parameter Choose sound model to use

Registry system.sound_driver.snd_hda_intel.mode

l

Type string

Value Auto

Parameter If you encounter sound problems try to choose one of the 
alternative masks

Registry system.sound_driver.snd_hda_intel.probe_

mask

Range [Auto] [1] [8]

Old settings. Command at startup removed.

Jabra

Avoid deploying of the same Jabra Xpress package several times on the same Jabra device.

Evidian

Evidian now triggers the regular Horizon session script.

Hardware

Fixed non-working Prolific PL2303 USB-to-serial adapters.

TC Setup (Java)
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•

•

•
•

•

•

•
•

Removed "default" button left of selection box IGEL Setup: Sessions > Citrix > Citrix Global > 
Window > Multimonitor full-screen mode.

Remote Management

Fixed repeated firmware registering over the ICG which can occur after a new firmware was 
successfully registered in the UMS. The device invokes firmware registering again after every 
settings transfer from the device to the UMS. This behavior lasts until reboot.
Fixed syncing settings changed on the device if the UMS wasn't reachable.
Fixed handling of the structure tag if it was configured in the system dialog "UMS Registering".

IGEL Cloud Gateway

Maximum waiting time for a response from the ICG server can now be configured by the 
parameter system.remotemanager.rmagent_timeout (default: 90 seconds).

VNC

Shadowing notification is restricted to primary monitor and cannot be moved outside of the 
monitor's visible range.
Fixed sporadic connection failure in VNC server.
Fixed occasional freeze of shadowing session e.g. when resizing a window. Now the session gets 
unlocked again after about 20 seconds.
More...

Parameter Unlock X server in case of shadowing session freeze

Registry network.vncserver.grab_buster

Type bool

Value enabled / disabled
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CA Certificates Contained in IGEL OS 11.04.100
Certificate name Expiry date File in /etc/ssl/certs

ACCVRAIZ1 Dec 31 09:37:37 
2030 GMT

ACCVRAIZ1.crt

AC RAIZ FNMT-RCM Jan 1 00:00:00 
2030 GMT

AC_RAIZ_FNMT-RCM.crt

Actalis Authentication Root 
CA

Sep 22 11:22:02 
2030 GMT

Actalis_Authentication_Root_CA.cr

t

AffirmTrust Commercial Dec 31 14:06:06 
2030 GMT

AffirmTrust_Commercial.crt

AffirmTrust Networking Dec 31 14:08:24 
2030 GMT

AffirmTrust_Networking.crt

AffirmTrust Premium Dec 31 14:10:36 
2040 GMT

AffirmTrust_Premium.crt

AffirmTrust Premium ECC Dec 31 14:20:24 
2040 GMT

AffirmTrust_Premium_ECC.crt

Amazon Root CA 1 Jan 17 00:00:00 
2038 GMT

AmazonRootCA1.pem)

Amazon Root CA 1 Jan 17 00:00:00 
2038 GMT

Amazon_Root_CA_1.crt

Amazon Root CA 2 May 26 00:00:00 
2040 GMT

Amazon_Root_CA_2.crt

Amazon Root CA 3 May 26 00:00:00 
2040 GMT

Amazon_Root_CA_3.crt

Amazon Root CA 4 May 26 00:00:00 
2040 GMT

Amazon_Root_CA_4.crt

Atos TrustedRoot 2011 Dec 31 23:59:59 
2030 GMT

Atos_TrustedRoot_2011.crt

Autoridad de Certificacion 
Firmaprofesional CIF 
A62634068

Dec 31 08:38:15 
2030 GMT

Autoridad_de_Certificacion_Firmap

rofesional_CIF_A62634068.crt

Baltimore CyberTrust Root May 12 23:59:00 
2025 GMT

BTCTRoot.pem)
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Certificate name Expiry date File in /etc/ssl/certs

Baltimore CyberTrust Root May 12 23:59:00 
2025 GMT

Baltimore_CyberTrust_Root.crt

Buypass Class 2 Root CA Oct 26 08:38:03 
2040 GMT

Buypass_Class_2_Root_CA.crt

Buypass Class 3 Root CA Oct 26 08:28:58 
2040 GMT

Buypass_Class_3_Root_CA.crt

CA Disig Root R2 Jul 19 09:15:30 
2042 GMT

CA_Disig_Root_R2.crt

CFCA EV ROOT Dec 31 03:07:01 
2029 GMT

CFCA_EV_ROOT.crt

COMODO Certification 
Authority

Dec 31 23:59:59 
2029 GMT

COMODO_Certification_Authority.cr

t

COMODO ECC Certification 
Authority

Jan 18 23:59:59 
2038 GMT

COMODO_ECC_Certification_Authorit

y.crt

COMODO RSA Certification 
Authority

Jan 18 23:59:59 
2038 GMT

COMODO_RSA_Certification_Authorit

y.crt

Certigna Jun 29 15:13:05 
2027 GMT

Certigna.crt

Certigna Root CA Oct 1 08:32:27 
2033 GMT

Certigna_Root_CA.crt

Certinomis - Root CA Oct 21 09:17:18 
2033 GMT

Certinomis_-_Root_CA.crt

Class 2 Primary CA Jul 6 23:59:59 
2019 GMT

Certplus_Class_2_Primary_CA.crt

Certum Trusted Network CA Dec 31 12:07:37 
2029 GMT

Certum_Trusted_Network_CA.crt

Certum Trusted Network CA 2 Oct 6 08:39:56 
2046 GMT

Certum_Trusted_Network_CA_2.crt

Chambers of Commerce Root 
- 2008

Jul 31 12:29:50 
2038 GMT

Chambers_of_Commerce_Root_-

_2008.crt
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Certificate name Expiry date File in /etc/ssl/certs

Class 3 Public Primary 
Certification Authority - G2 (c) 
1998 VeriSign, Inc. - For 
authorized use only VeriSign 
Trust Network

Aug 1 23:59:59 
2028 GMT

Class3PCA_G2_v2.pem)

Class 4 Public Primary 
Certification Authority - G2 (c) 
1998 VeriSign, Inc. - For 
authorized use only VeriSign 
Trust Network

Aug 1 23:59:59 
2028 GMT

Class4PCA_G2_v2.pem)

AAA Certificate Services Dec 31 23:59:59 
2028 GMT

Comodo_AAA_Services_root.crt

Cybertrust Global Root Dec 15 08:00:00 
2021 GMT

Cybertrust_Global_Root.crt

D-TRUST Root Class 3 CA 2 
2009

Nov 5 08:35:58 
2029 GMT

D-

TRUST_Root_Class_3_CA_2_2009.crt

D-TRUST Root Class 3 CA 2 EV 
2009

Nov 5 08:50:46 
2029 GMT

D-

TRUST_Root_Class_3_CA_2_EV_2009.c

rt

DST Root CA X3 Sep 30 14:01:15 
2021 GMT

DST_Root_CA_X3.crt

Deutsche Telekom Root CA 2 Jul 9 23:59:00 
2019 GMT

Deutsche_Telekom_Root_CA_2.crt

DigiCert Global Root CA Nov 10 00:00:00 
2031 GMT

DigiCertGlobalRootCA.pem)

DigiCert Global Root CA Mar 8 12:00:00 
2023 GMT

DigiCertSHA2SecureServerCA.pem)

DigiCert Assured ID Root CA Nov 10 00:00:00 
2031 GMT

DigiCert_Assured_ID_Root_CA.crt

DigiCert Assured ID Root G2 Jan 15 12:00:00 
2038 GMT

DigiCert_Assured_ID_Root_G2.crt

DigiCert Assured ID Root G3 Jan 15 12:00:00 
2038 GMT

DigiCert_Assured_ID_Root_G3.crt
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Certificate name Expiry date File in /etc/ssl/certs

DigiCert Global Root CA Nov 10 00:00:00 
2031 GMT

DigiCert_Global_Root_CA.crt

DigiCert Global Root G2 Jan 15 12:00:00 
2038 GMT

DigiCert_Global_Root_G2.crt

DigiCert Global Root G3 Jan 15 12:00:00 
2038 GMT

DigiCert_Global_Root_G3.crt

DigiCert High Assurance EV 
Root CA

Nov 10 00:00:00 
2031 GMT

DigiCert_High_Assurance_EV_Root_C

A.crt

DigiCert Trusted Root G4 Jan 15 12:00:00 
2038 GMT

DigiCert_Trusted_Root_G4.crt

E-Tugra Certification 
Authority

Mar 3 12:09:48 
2023 GMT

E-

Tugra_Certification_Authority.crt

EC-ACC Jan 7 22:59:59 
2031 GMT

EC-ACC.crt

EE Certification Centre Root 
CA

Dec 17 23:59:59 
2030 GMT

EE_Certification_Centre_Root_CA.c

rt

Entrust.net11 Certification 
Authority (2048)

Jul 24 14:15:12 
2029 GMT

Entrust.net_Premium_2048_Secure_S

erver_CA.crt

Entrust Root Certification 
Authority

Nov 27 20:53:42 
2026 GMT

Entrust_Root_Certification_Author

ity.crt

Entrust Root Certification 
Authority - EC1

Dec 18 15:55:36 
2037 GMT

Entrust_Root_Certification_Author

ity_-_EC1.crt

Entrust Root Certification 
Authority - G2

Dec 7 17:55:54 
2030 GMT

Entrust_Root_Certification_Author

ity_-_G2.crt

GDCA TrustAUTH R5 ROOT Dec 31 15:59:59 
2040 GMT

GDCA_TrustAUTH_R5_ROOT.crt

http://Entrust.net
http://Entrust.net
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Certificate name Expiry date File in /etc/ssl/certs

GlobalSign Dec 15 08:00:00 
2021 GMT

GSR2.pem)

GTE CyberTrust Global Root Aug 13 23:59:00 
2018 GMT

GTECTGlobalRoot.pem)

GTS Root R1 Jun 22 00:00:00 
2036 GMT

GTS_Root_R1.crt

GTS Root R2 Jun 22 00:00:00 
2036 GMT

GTS_Root_R2.crt

GTS Root R3 Jun 22 00:00:00 
2036 GMT

GTS_Root_R3.crt

GTS Root R4 Jun 22 00:00:00 
2036 GMT

GTS_Root_R4.crt

GeoTrust Global CA May 21 04:00:00 
2022 GMT

GeoTrust_Global_CA.crt

GeoTrust Global CA May 21 04:00:00 
2022 GMT

GeoTrust_Global_CA.pem)

GeoTrust Primary 
Certification Authority

Jul 16 23:59:59 
2036 GMT

GeoTrust_Primary_Certification_Au

thority.crt

GeoTrust Primary 
Certification Authority - G2

Jan 18 23:59:59 
2038 GMT

GeoTrust_Primary_Certification_Au

thority_-_G2.crt

GeoTrust Primary 
Certification Authority - G3

Dec 1 23:59:59 
2037 GMT

GeoTrust_Primary_Certification_Au

thority_-_G3.crt

GeoTrust Universal CA Mar 4 05:00:00 
2029 GMT

GeoTrust_Universal_CA.crt

GeoTrust Universal CA 2 Mar 4 05:00:00 
2029 GMT

GeoTrust_Universal_CA_2.crt

GlobalSign Jan 19 03:14:07 
2038 GMT

GlobalSign_ECC_Root_CA_-_R4.crt

GlobalSign Jan 19 03:14:07 
2038 GMT

GlobalSign_ECC_Root_CA_-_R5.crt
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Certificate name Expiry date File in /etc/ssl/certs

GlobalSign Root CA Jan 28 12:00:00 
2028 GMT

GlobalSign_Root_CA.crt

GlobalSign Dec 15 08:00:00 
2021 GMT

GlobalSign_Root_CA_-_R2.crt

GlobalSign Mar 18 10:00:00 
2029 GMT

GlobalSign_Root_CA_-_R3.crt

GlobalSign Dec 10 00:00:00 
2034 GMT

GlobalSign_Root_CA_-_R6.crt

Global Chambersign Root - 
2008

Jul 31 12:31:40 
2038 GMT

Global_Chambersign_Root_-

_2008.crt

Go Daddy Class 2 Certification 
Authority

Jun 29 17:06:20 
2034 GMT

Go_Daddy_Class_2_CA.crt

Go Daddy Root Certificate 
Authority - G2

Dec 31 23:59:59 
2037 GMT

Go_Daddy_Root_Certificate_Authori

ty_-_G2.crt

Hellenic Academic and 
Research Institutions ECC 
RootCA 2015

Jun 30 10:37:12 
2040 GMT

Hellenic_Academic_and_Research_In

stitutions_ECC_RootCA_2015.crt

Hellenic Academic and 
Research Institutions RootCA 
2011

Dec 1 13:49:52 
2031 GMT

Hellenic_Academic_and_Research_In

stitutions_RootCA_2011.crt

Hellenic Academic and 
Research Institutions RootCA 
2015

Jun 30 10:11:21 
2040 GMT

Hellenic_Academic_and_Research_In

stitutions_RootCA_2015.crt

Hongkong Post Root CA 1 May 15 04:52:29 
2023 GMT

Hongkong_Post_Root_CA_1.crt

ISRG Root X1 Jun 4 11:04:38 
2035 GMT

ISRG_Root_X1.crt

IdenTrust Commercial Root 
CA 1

Jan 16 18:12:23 
2034 GMT

IdenTrust_Commercial_Root_CA_1.cr

t

IdenTrust Public Sector Root 
CA 1

Jan 16 17:53:32 
2034 GMT

IdenTrust_Public_Sector_Root_CA_1

.crt
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Certificate name Expiry date File in /etc/ssl/certs

Imprivata Embedded Code 
Signing CA

Sep 7 16:20:00 
2033 GMT

Imprivata.crt

Izenpe.com12 Dec 13 08:27:25 
2037 GMT

Izenpe.com13.crt

LuxTrust Global Root 2 Mar 5 13:21:57 
2035 GMT

LuxTrust_Global_Root_2.crt

Microsec e-Szigno Root CA 
2009

Dec 30 11:30:18 
2029 GMT

Microsec_e-

Szigno_Root_CA_2009.crt

NetLock Arany (Class Gold) 
Főtanúsítvány

Dec 6 15:08:21 
2028 GMT

NetLock_Arany_=Class_Gold=_Főtanú
sítvány.crt

Network Solutions Certificate 
Authority

Dec 31 23:59:59 
2029 GMT

Network_Solutions_Certificate_Aut

hority.crt

OISTE WISeKey Global Root 
GA CA

Dec 11 16:09:51 
2037 GMT

OISTE_WISeKey_Global_Root_GA_CA.c

rt

OISTE WISeKey Global Root 
GB CA

Dec 1 15:10:31 
2039 GMT

OISTE_WISeKey_Global_Root_GB_CA.c

rt

OISTE WISeKey Global Root 
GC CA

May 9 09:58:33 
2042 GMT

OISTE_WISeKey_Global_Root_GC_CA.c

rt

Class 3 Public Primary 
Certification Authority

Aug 1 23:59:59 
2028 GMT

Pcs3ss_v4.pem)

QuoVadis Root Certification 
Authority

Mar 17 18:33:33 
2021 GMT

QuoVadis_Root_CA.crt

QuoVadis Root CA 1 G3 Jan 12 17:27:44 
2042 GMT

QuoVadis_Root_CA_1_G3.crt

QuoVadis Root CA 2 Nov 24 18:23:33 
2031 GMT

QuoVadis_Root_CA_2.crt

http://Izenpe.com
http://Izenpe.com
http://Izenpe.com
http://Izenpe.com
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Certificate name Expiry date File in /etc/ssl/certs

QuoVadis Root CA 2 G3 Jan 12 18:59:32 
2042 GMT

QuoVadis_Root_CA_2_G3.crt

QuoVadis Root CA 3 Nov 24 19:06:44 
2031 GMT

QuoVadis_Root_CA_3.crt

QuoVadis Root CA 3 G3 Jan 12 20:26:32 
2042 GMT

QuoVadis_Root_CA_3_G3.crt

SSL.com14 EV Root 
Certification Authority ECC

Feb 12 18:15:23 
2041 GMT

SSL.com_EV_Root_Certification_Aut

hority_ECC.crt

SSL.com15 EV Root 
Certification Authority RSA R2

May 30 18:14:37 
2042 GMT

SSL.com_EV_Root_Certification_Aut

hority_RSA_R2.crt

SSL.com16 Root Certification 
Authority ECC

Feb 12 18:14:03 
2041 GMT

SSL.com_Root_Certification_Author

ity_ECC.crt

SSL.com17 Root Certification 
Authority RSA

Feb 12 17:39:39 
2041 GMT

SSL.com_Root_Certification_Author

ity_RSA.crt

SZAFIR ROOT CA2 Oct 19 07:43:30 
2035 GMT

SZAFIR_ROOT_CA2.crt

SecureSign RootCA11 Apr 8 04:56:47 
2029 GMT

SecureSign_RootCA11.crt

SecureTrust CA Dec 31 19:40:55 
2029 GMT

SecureTrust_CA.crt

Secure Global CA Dec 31 19:52:06 
2029 GMT

Secure_Global_CA.crt

Security Communication 
RootCA2

May 29 05:00:39 
2029 GMT

Security_Communication_RootCA2.cr

t

Security Communication 
RootCA1

Sep 30 04:20:49 
2023 GMT

Security_Communication_Root_CA.cr

t

http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
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Certificate name Expiry date File in /etc/ssl/certs

Sonera Class2 CA Apr 6 07:29:40 
2021 GMT

Sonera_Class_2_Root_CA.crt

Staat der Nederlanden EV 
Root CA

Dec 8 11:10:28 
2022 GMT

Staat_der_Nederlanden_EV_Root_CA.

crt

Staat der Nederlanden Root 
CA - G2

Mar 25 11:03:10 
2020 GMT

Staat_der_Nederlanden_Root_CA_-

_G2.crt

Staat der Nederlanden Root 
CA - G3

Nov 13 23:00:00 
2028 GMT

Staat_der_Nederlanden_Root_CA_-

_G3.crt

Starfield Class 2 Certification 
Authority

Jun 29 17:39:16 
2034 GMT

Starfield_Class_2_CA.crt

Starfield Root Certificate 
Authority - G2

Dec 31 23:59:59 
2037 GMT

Starfield_Root_Certificate_Author

ity_-_G2.crt

Starfield Services Root 
Certificate Authority - G2

Dec 31 23:59:59 
2037 GMT

Starfield_Services_Root_Certifica

te_Authority_-_G2.crt

SwissSign Gold CA - G2 Oct 25 08:30:35 
2036 GMT

SwissSign_Gold_CA_-_G2.crt

SwissSign Silver CA - G2 Oct 25 08:32:46 
2036 GMT

SwissSign_Silver_CA_-_G2.crt

T-TeleSec GlobalRoot Class 2 Oct 1 23:59:59 
2033 GMT

T-TeleSec_GlobalRoot_Class_2.crt

T-TeleSec GlobalRoot Class 3 Oct 1 23:59:59 
2033 GMT

T-TeleSec_GlobalRoot_Class_3.crt

TUBITAK Kamu SM SSL Kok 
Sertifikasi - Surum 1

Oct 25 08:25:55 
2043 GMT

TUBITAK_Kamu_SM_SSL_Kok_Sertifika

si_-_Surum_1.crt

TWCA Global Root CA Dec 31 15:59:59 
2030 GMT

TWCA_Global_Root_CA.crt

TWCA Root Certification 
Authority

Dec 31 15:59:59 
2030 GMT

TWCA_Root_Certification_Authority

.crt
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Certificate name Expiry date File in /etc/ssl/certs

Government Root 
Certification Authority

Dec 5 13:23:33 
2032 GMT

Taiwan_GRCA.crt

TeliaSonera Root CA v1 Oct 18 12:00:50 
2032 GMT

TeliaSonera_Root_CA_v1.crt

TrustCor ECA-1 Dec 31 17:28:07 
2029 GMT

TrustCor_ECA-1.crt

TrustCor RootCert CA-1 Dec 31 17:23:16 
2029 GMT

TrustCor_RootCert_CA-1.crt

TrustCor RootCert CA-2 Dec 31 17:26:39 
2034 GMT

TrustCor_RootCert_CA-2.crt

Trustis FPS Root CA Jan 21 11:36:54 
2024 GMT

Trustis_FPS_Root_CA.crt

UCA Extended Validation 
Root

Dec 31 00:00:00 
2038 GMT

UCA_Extended_Validation_Root.crt

UCA Global G2 Root Dec 31 00:00:00 
2040 GMT

UCA_Global_G2_Root.crt

USERTrust ECC Certification 
Authority

Jan 18 23:59:59 
2038 GMT

USERTrust_ECC_Certification_Autho

rity.crt

USERTrust RSA Certification 
Authority

Jan 18 23:59:59 
2038 GMT

USERTrust_RSA_Certification_Autho

rity.crt

VeriSign Class 3 Public 
Primary Certification 
Authority - G4

Jan 18 23:59:59 
2038 GMT

VeriSign_Class_3_Public_Primary_C

ertification_Authority_-_G4.crt

VeriSign Class 3 Public 
Primary Certification 
Authority - G5

Jul 16 23:59:59 
2036 GMT

VeriSign_Class_3_Public_Primary_C

ertification_Authority_-_G5.crt

VeriSign Universal Root 
Certification Authority

Dec 1 23:59:59 
2037 GMT

VeriSign_Universal_Root_Certifica

tion_Authority.crt

VeriSign Class 3 Public 
Primary Certification 
Authority - G3

Jul 16 23:59:59 
2036 GMT

Verisign_Class_3_Public_Primary_C

ertification_Authority_-_G3.crt
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Certificate name Expiry date File in /etc/ssl/certs

XRamp Global Certification 
Authority

Jan 1 05:37:19 
2035 GMT

XRamp_Global_CA_Root.crt

certSIGN ROOT CA Jul 4 17:20:04 
2031 GMT

certSIGN_ROOT_CA.crt

ePKI Root Certification 
Authority

Dec 20 02:31:27 
2034 GMT

ePKI_Root_Certification_Authority

.crt

thawte Primary Root CA Jul 16 23:59:59 
2036 GMT

thawte_Primary_Root_CA.crt

thawte Primary Root CA - G2 Jan 18 23:59:59 
2038 GMT

thawte_Primary_Root_CA_-_G2.crt

thawte Primary Root CA - G3 Dec 1 23:59:59 
2037 GMT

thawte_Primary_Root_CA_-_G3.crt
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•
•
•
•
•
•

IGEL OS Creator (OSC)

Supported Devices
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.

Component Versions 11.04.100 (see page 583)
General Information 11.04.100 (see page 590)
Known Issues 11.04.100 (see page 591)
Security Fixes 11.04.100 (see page 595)
New Features 11.04.100 (see page 596)
Resolved Issues 11.04.100 (see page 615)
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Component Versions 11.04.100

Clients

Product Version

Chromium 83.0.4103.61-0ubuntu0.18.04.1

Cisco JVDI Client 12.9.0

Cisco Webex Teams VDI Client 3.0.15711.0

Cisco Webex Meetings VDI Client 40.7.0.375

Citrix HDX Realtime Media Engine 2.9.0-2330

Citrix Workspace App 18.10.0.11

Citrix Workspace App 19.12.0.19

Citrix Workspace App 20.06.0.15

deviceTRUST Citrix Channel 19.1.200.2

Crossmatch DP Citrix Channel 0515.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 14.0.0.45623

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.28.4-0ubuntu1.2

FabulaTech USB for Remote Desktop 5.2.29

Firefox 68.10.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

IGEL WVD Client 1.0.13igel1596142398

Imprivata OneSign ProveID Embedded onesign-bootstrap-loader_1.0.523630_amd64

Qualification at Imprivata in progress

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.11.2-1igel8
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Open VPN 2.4.4-2ubuntu1.3

Zulu JRE 8.48.0.51-2

Parallels Client (64 bit) 17.1.1

Spice GTK (Red Hat Virtualization) 0.38-2igel93

Remote Viewer (Red Hat Virtualization) 8.0-2git20191213.e4bacb8igel83

Usbredir (Red Hat Virtualization) 0.8.0-1+b1igel71

Teradici PCoIP Software Client 20.04.2-18.04

ThinLinc Client 4.12.0-6517

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.5-1igel1583919770

VNC Viewer 1.10.1+dfsg-4igel13

VMware Horizon Client 5.4.1-15988340

Voip Client Ekiga 4.0.1

Dictation

Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20200323

Philips Speech driver 12.9.1

Signature

Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.9

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.4.2

Smartcard

PKCS#11 Library A.E.T SafeSign 3.0.101
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PKCS#11 Library Athena IDProtect 7

PKCS#11 Library cryptovision sc/interface 7.3.1

PKCS#11 Library Gemalto SafeNet 10.7.77

PKCS#11 Library OpenSC 0.20.0-3igel37

PKCS#11 Library SecMaker NetID 6.8.1.31

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel2

Reader Driver Gemalto eToken 10.7.77

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.31-1igel11

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.26-3igel14

Cherry USB2LAN Proxy 3.2.0.3

System Components

OpenSSL 1.0.2n-1ubuntu5.3

OpenSSL 1.1.1-1ubuntu2.1~18.04.6

OpenSSH Client 7.6p1-4ubuntu0.3

OpenSSH Server 7.6p1-4ubuntu0.3

Bluetooth stack (bluez) 5.52-1igel6

MESA OpenGL stack 20.0.8-1igel117

VAAPI ABI Version 0.40

VDPAU Library version 1.4-1igel1003

Graphics Driver INTEL 2.99.917+git20200515-igel1013

Graphics Driver ATI/RADEON 19.1.0-1+git20200220igel987

Graphics Driver ATI/AMDGPU 19.1.0-1+git20200318igel986
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Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 440.100-0ubuntu0.20.04.1

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel975

Input Driver Elographics 1.4.1-1+b6igel952

Input Driver eGalax 2.5.7413

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel957

Input Driver Wacom 0.36.1-0ubuntu2igel888

Input Driver ELO Multitouch 3.0.0

Input Driver ELO Singletouch 5.1.0

Kernel 5.4.48 #mainline-lxos-g1595410170

Xorg X11 Server 1.20.8-2igel1016

Xorg Xephyr 1.20.8-2igel1016

CUPS printing daemon 2.2.7-1ubuntu2.8igel32

PrinterLogic 25.1.0.425

Lightdm Graphical Login Manager 1.26.0-0ubuntu1igel13

XFCE4 Window Manager 4.14.2-1~18.04igel1595331607

ISC DHCP Client 4.3.5-3ubuntu7.1

NetworkManager 1.20.4-2ubuntu2.2igel100

ModemManager 1.10.0-1~ubuntu18.04.2

GStreamer 0.10 0.10.36-2ubuntu0.1igel201

GStreamer 1.x 1.16.2-4igel239

WebKit2Gtk 2.28.3-2igel36

Python2 2.7.17

Python3 3.6.9
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VM Guest Support Components

Virtualbox Guest Utils 6.1.10-dfsg-1igel41

Virtualbox X11 Guest Utils 6.1.10-dfsg-1igel41

Open VM Tools 11.0.5-4ubuntu0.18.04.13

Open VM Desktop Tools 11.0.5-4ubuntu0.18.04.1

Xen Guest Utilities 7.10.0-0ubuntu1

Spice Vdagent 0.20.0-1igel95

Qemu Guest Agent 5.0-5igel12

Features with Limited IGEL Support

Mobile Device Access USB (MTP) 1.1.17-3igel5

Mobile Device Access USB (imobile) 1.2.1~git20191129.9f79242-1+b1igel8

Mobile Device Access USB (gphoto) 2.5.25-2igel4

VPN OpenConnect 8.10-1igel4

Scanner support 1.0.27-1

VirtualBox 6.1.10-dfsg-1igel41

Services

Service Size Reduced Firmware

Asian Language Support 22.5 M Included

Java SE Runtime Environment 36.0 M Included

Citrix Workspace app
Citrix Appliance
Citrix StoreFront

219.5 M Included

Ericom PowerTerm InterConnect 15.5 M Included

Media Player 512.0 K Included

Citrix Appliance
Local Browser (Firefox)

70.2 M Included

RDP
VMware Horizon

4.2 M Included
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Cendio ThinLinc 10.0 M Included

Printing (Internet printing protocol CUPS) 22.2 M Included

NoMachine NX 26.8 M Included

VMware Horizon 114.5 M Included

Voice over IP (Ekiga) 6.5 M Included

Citrix Appliance 768.0 K Included

NCP Enterprise VPN Client 27.0 M Not included

Fluendo GStreamer Codec Plugins 6.8 M Included

IBM i Access Client Solutions 72.5 M Not included

Red Hat Enterprise Virtualization 3.0 M Included

Parallels Client 5.5 M Included

NVIDIA graphics driver 115.0 M Not included

Imprivata Appliance 10.8 M Included

Evidian AuthMgr 2.8 M Included

Hardware Video Acceleration 13.0 M Included

Extra Font Package 1.0 M Included

Fluendo GStreamer AAC Decoder 1.2 M Included

x32 Compatibility Support 48.0 M Included

Cisco JVDI client 45.8 M Included

PrinterLogic 40.8 M Not included

Biosec BS Login 10.0 M Not included

Login VSI Login Enterprise 28.8 M Not included

Stratusphere UX CID Key software 2.8 M Not included

Elastic Filebeat 15.8 M Not included

WVD 13.8 M Included

Local Browser (Chromium) 81.2 M Not included

deskMate client 5.8 M Included

Cisco Webex Teams VDI 32.0 M Not included

Cisco Webex Meetings VDI 36.8 M Not included
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Zoom Media Plugin 39.8 M Not included

Teradici PCoIP Client 7.8 M Included

90meter Smart Card Support 256.0 K Included

Mobile Device Access USB (Limited 
support)

256.0 K Not included

VPN OpenConnect (Limited support) 1.5 M Not included

Scanner support / SANE (Limited support) 2.5 M Not included

VirtualBox (Limited support) 62.5 M Not included
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General Information 11.04.100

The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver

To be beneficial to all new features and implementations, it is recommended to use UMS 6.04.100 or 
higher and update the corresponding profiles.



Firmware downgrade to older versions (11.01 or 11.02) is not possible, due to the unsigned firmware 
update files.





Notes for Release 11.04.100

IGEL OS Release Notes   591 / 1492

•

•

•
•

•
•

•

•

•

•

•

•

Known Issues 11.04.100
Firmware Update

On devices with 2 GB of flash storage, it could happen that there is not enough space for 
updating all features. In this case, a corresponding error message occurs and unused features 
must be disabled in IGEL Setup under System > Firmware Customization > Features to perform 
the firmware update.

Firefox

Firefox IGEL extensions are not updated automatically under some circumstances. After an 
update from 11.03.xxx to 11.04.100, the IGEL extensions will stay on the old version. 
In this case, the following settings concerning kiosk mode cannot be executed:

Switch off hotkey for new window/tab
Blocking of internal browser pages like preferences, file picker, specific local directories

As a workaround:

a reset to defaults should be performed
or the browser's mimetype template can be switched from "Standard" to "Minimal" by 
registry key browserglobal.app.mimetypes_template . There, the browser profile is 
renewed as well.
After the TC received the new setting, reboot and set the mimetypes_template  registry key 
to "Standard" again.

Citrix

With activated DRI3 and an AMD GPU Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1 and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of login. 
Workaround: Insert the smartcard before starting the StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 
acceleration
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Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery group.

Using CWA 19.x sometimes freezes the session while session logoff from a published desktop. 
Workaround: Use CWA 18.10.0.
During the running Microsoft Teams Optimization of Citrix Workspace App 20.06, webcam 
redirection or screen sharing may lead to display errors like black stripes or flickering.
The performance of Citrix sessions when using Workspace App 20.06 may be lower on some 
devices. 
A possible workaround is to disable the virtual channels for Microsoft Teams and NSAP or to 
set the HDX transport protocol to TCP only.

ica.module.virtualdriver.vdwebrtc.enable

ica.module.virtualdriver.nsap.enable 
The protocol can be set via the Setup parameter Sessions > Citrix > Citrix Global > Options 
> HDX Adaptive Transport over EDT or via the server policy 'HDX Adaptive Transport'.

VMware Horizon

Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Enable local `Storage Hotplug` on Setup page Devices > Storage Devices > Storage 
Hotplug.

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.
After the disconnect of an RDP-based session, the Horizon main window which contains the 
server or sessions overview cannot be resized anymore.
Seamless application windows in Horizon Client may not be displayed correctly.  When 
starting the first seamless app, a new iconified window appears in the taskbar, and only if you click 
on it, the application will show up.
On some hardware (UD7-H850, UD2-M250, UD2-D220), however, the client aborts when this new 
window is de-iconified.

Imprivata
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On devices with 2 GB of flash storage, it could happen that there is not enough space to enable 
the Imprivata partition after the update to 11.04.100. In this case, a corresponding error 
message occurs and unused features must be disabled (in IGEL Setup under System > Firmware 
Customization > Features). Imprivata has to be (re-)enabled after a reboot then.

Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters does not work after system suspend/resume. Workaround: 
Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Parallels Client

Native USB redirection does not work with Parallels Client.

Smartcard

Citrix Certificate Identity Declaration login does not work with SecMaker smartcards.
In seldom cases, the authentication hung when using A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hyper-V

Hyper-V (Generation 2) needs a lot of memory (RAM). The machine needs a sufficient amount of 
memory allocated.

VirtualBox

The current VirtualBox Guest Tools/Drivers will not work with VirtualBox 5.2.x or older hosts 
which leads to a black screen and non-working graphics.
Possible workaround: Install with 'Failsafe Installation + Recovery' and set the registry key 
x.drivers.force_vesa  to 'true'.

When running in VirtualBox virtualization, resizing the window will not automatically change 
desktop resolution of IGEL OS guest.

Audio

Audio jack detection on Advantech POC-W243L doesn't work. Therefore, sound output 
goes through a possibly connected headset and the internal speakers.
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.

Hardware

HP t730 could freeze when monitors with different resolutions are connected (1920x1200 + 
2560x1440 + 3840x1600 for example). When this occurs, the registry 
key  x.drivers.kms.best_console_mode  has to be set to disabled.
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Some newer Delock 62599 active DisplayPort-to-DVI (4k) adapters only work with INTEL 
devices.

Remote Management

AIT feature with IGEL Starter License is supported by the UMS version 6.05.100.

Base system

Update from memory stick requires network online state (when multiple update stages are 
involved).

deskMate

Integrated deskMate solution. Some stability issues may remain.
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Security Fixes 11.04.100
Firefox

Updated Mozilla Firefox to 68.10.0esr:
Fixes for mfsa2020-11, also known as CVE-2020-6819 and CVE-2020-6820
Fixes for mfsa2020-13, also known as:
More...

CVE-2020-6828, CVE-2020-6827, CVE-2020-6821, 
CVE-2020-6822, and CVE-2020-6825

Fixes for mfsa2020-17 also known as:
More...

CVE-2020-12387, CVE-2020-12388, CVE-2020-12389, 
CVE-2020-6831, CVE-2020-12392,
CVE-2020-12393, and CVE-2020-1239

Fixes for mfsa2020-21 also known as:
More...

CVE-2020-12399, CVE-2020-12405, 
CVE-2020-12406, and CVE-2020-12410

Fixes for mfsa2020-25 also known as:
More...

CVE-2020-12417, CVE-2020-12418, CVE-2020-12419, 
CVE-2020-12420, and CVE-2020-12421

Changed option to deny local file browsing via file:// URI per default now.
More...

IGEL Setup Firefox Browser > Firefox Browser Global > Window

Parameter Hide local filesystem

Registry browserglobal.app.filepicker_dialog_hi

dden

Value enabled / disabled

Base system

SSH protocol version 1 is now disabled. All remote connections via SSH must use SSHv2.

Driver

Updated Nvidia driver to version 440.100.
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New Features 11.04.100
Citrix

Integrated Citrix Workspace App 20.06. 
Available Citrix Workspace Apps in this release: 20.06 (default), 19.12, and 18.10
Added a registry key to enable optimization for Microsoft Teams.
More...

IGEL Setup Sessions > Citrix > Citrix Global > Unified 
Communications > VDI Solutions

Parameter Microsoft Teams optimization

Registry ica.module.virtualdriver.vdwebrtc.enabl

e

Value on / off

Added a registry key to enable support for NetScaler App Experience (NSAP) virtual channel.
More...

Parameter HDX uses the NSAP virtual channel

Registry ica.module.virtualdriver.nsap.enable

Value on / off

Integrated Citrix HDX/RTME 2.9.
Integrated ZOOM Media Plugin for Citrix to optimize performance for ZOOM video calls and 
conferences.
IGEL x64: 5.0.415463.0619 requires Windows x86 or x64: 5.0.24002.0619. https://support.zoom.us/
hc/en-us/articles/360031096531-Getting-Started-with-VDI
More...

IGEL Setup Sessions > Citrix > Citrix Global > Unified 
Communications > VDI Solutions

Parameter Zoom Media Plugin

Registry ica.module.virtualdriver.vdzoom.enable

Value enabled / disabled

Updated signotec Virtual Channel to version 8.0.9. 
The corresponding changes are:

Logging has been improved.
A problem with the communication with the signature pads was fixed.
USB communication via bulk transfer is model-independent (improved speed).

https://support.zoom.us/hc/en-us/articles/360031096531-Getting-Started-with-VDI
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Removed parameter Content redirection / ica.wfclient.crenabled  from TC 
Setup (Sessions > Citrix > Citrix Global > HDX Multimedia).

OSC Installer

Added dialog "Feature Selection" in IGEL OS Creator for the selection of features to be installed 
on the target device. It interactively shows if the current selection of features fits onto the device. 
The selection of features is saved on the OSC installer medium (when allowed) and set as the 
default selection for the next installation. If "Migrate Old Settings" is selected, the set of features 
of the old installation is set as the default selection. 
Reduced memory requirements of OSC installer for machines without Nvidia graphic card.

WVD

Added AAC Codec support to Audio Output redirection.
More...

Registry sessions.wvd%.options.enable-aac

Value enabled / disabled

RDP/IGEL RDP Client 2

Added the possibility to add a black background to the RDP auto-reconnect window.
More...

Registry sessions.rdp.options.reconnect-black-

fullscreen

Type bool

Value enabled / disabled

Added configuration option for the amount of RDP auto-reconnect retries. The default value will 
remain "20". A value of "0" means infinite retries.
More...

Registry sessions.rdp.winconnect%.options.reconne

ct-max-retries

Type Integer

Value 20

VMware Horizon

Updated VMware Horizon to version 5.4.1.
For usage with Blast protocol, it is recommended to enable DRI3 graphics mode:
More...

Parameter Use DRI3
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Registry x.driver.use_dri3

Value enabled / disabled

Fixed handling of RDP's fullscreen mode span, which means to combine all local monitors for 
one big remote session.

PowerTerm

Updated Ericom PowerTerm LTC to version 14.0.0.45623.

Parallels Client

Updated Parallels Client to version 17.1.1.

Teradici PCoIP Client

Updated Teradici PCoIP Client to version 20.04.2-18.04. The new version supports hardware-
accelerated H.264 decoding with Ultra PCoIP.
New parameters:
More...

Parameter Log level

Registry pcoip.log-level

Value 0 / 1 / 2  / 3 / 4

PCoIP sessions can now use the global setting.
More...

Parameter Show codec indicator

Registry pcoip.codec_indicator

Value disabled / enabled

Info Show a small dot in the bottom left corner during the session 
to indicate which codec is being used. Green indicates simple 
codec; blue indicates tic2 codec. This setting is only available 
globally.

XEN

Added support to run as XEN guest system.

NX client

Updated NoMachine NX Client to version 6.11.2.

ThinLinc

Updated ThinLinc to version 4.12.

Network
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DHCP changes: 
The system now sends a vendor-class-identifier(option 60) "igel-dhcp-1". Furthermore, it 
requests vendor-encapsulated-options (43). Those can be used to transfer IGEL-specific options
igelrmserver(224) and umsstructuretag(226) in the vendor namespace (with the same option 
numbers and types) instead of in the global namespace. 
The former way is also still functional, but values transferred in the new way override those which 
were transferred the old way. 
Apart from 224 and 226 one more option is defined in the vendor space: "exclusive", option 1, 
type byte. Its presence means that global options 224 and 226 shall not be interpreted in the 
traditional way and only settings in the vendor space apply. 
IPv6 is not involved.
Added support for LTE module HP lt4132.
Updated Network Manager to version 1.20.4.

The range of network.interfaces.wirelesslan.device0.bgscan.module now includes 
"default" for using original upstream Network Manager settings.

Added some additional Ethernet network drivers.
More...

amd-xgbe : AMD 10 Gigabit Ethernet driver
ec_bhf : Beckhoff EtherCAT
liquidio_vf : Cavium LiquidIO Intelligent Server Adapter Virtual Function driver
liquidio : Cavium LiquidIO Intelligent Server Adapter driver
thunder_bgx : Cavium Thunder BGX/MAC driver
nicvf : Cavium Thunder NIC Virtual Function driver
nicpf : Cavium Thunder NIC Physical Function driver
thunder_xcv : Cavium Thunder RGX/XCV driver
atlantic : aQuantia Corporation(R) network driver
be2net : Emulex OneConnect NIC driver 12.0.0.0
ixgb : Intel(R) PRO/10GbE network driver
igc : Intel(R) 2.5G Ethernet Linux driver
ice : Intel(R) Ethernet Connection E800 Series Linux driver
i40e : Intel(R) Ethernet Connection XL710 network driver
iavf : Intel(R) Ethernet Adaptive Virtual Function network driver
ixgbe : Intel(R) 10 Gigabit PCI Express network driver
igbvf : Intel(R) Gigabit Virtual Function network driver
ixgbevf : Intel(R) 10 Gigabit Virtual Function network driver
ena : Elastic Network Adapter (ENA)
nfp : The Netronome Flow Processor (NFP) driver
bna : QLogic BR-series 10G PCIe Ethernet driver
enic : Cisco VIC Ethernet NIC driver
mlx5_core : Mellanox 5th generation network adapters (ConnectX series) core driver
mlx4_en : Mellanox ConnectX HCA Ethernet driver
ionic : Pensando Ethernet NIC driver
sfc-falcon : Solarflare Falcon network driver
sfc : Solarflare network driver
dwc-xlgmac : Synopsys DWC XLGMAC driver
hinic : Huawei Intelligent NIC driver
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cassini : Sun Cassini Ethernet driver
niu : NIU Ethernet driver
samsung-sxgbe : SAMSUNG 10G/2.5G/1G Ethernet PLATFORM driver
cxgb : Chelsio 10Gb Ethernet driver
qede : QLogic FastLinQ 4xxxx Ethernet driver
qlcnic : QLogic 1/10 GbE Converged/Intelligent Ethernet driver
qed : QLogic FastLinQ 4xxxx Core module
netxen_nic : QLogic/NetXen (1/10) GbE Intelligent Ethernet driver
vxge : Neterion's X3100 Series 10GbE PCIe I/OVirtualized Server adapter
myri10ge : Myricom 10G driver (10GbE)
tehuti : Tehuti Networks(R) network driver
bnxt_en : Broadcom BCM573xx network driver
bnx2x : QLogic BCM57710/57711/57711E/57712/57712_MF/57800/57800_MF/
57810/57810_MF/57840/57840_MF driver

Added a registry key for specifying a space-separated list of DNS resolver options. See "man 
resolv.conf".
More...

Parameter Option list

Registry network.dns.options

Type string

Value empty

Wi-Fi

Added support for WPA3 Personal network authentication.
Added a registry key for preferring WPA3 Personal (i.e. SAE) or WPA2 Personal at the time a 
connection is created with Wireless Manager when the access point offers both:
More...

Parameter Prefer WPA3 Personal to WPA2 Personal

Registry network.applet.wireless.prefer_sae

Range [default] [yes] [no]

Info "default" currently means "no"

Added captive portal support for Wi-Fi. Passing through a captive portal (which is basically a web 
application) is sometimes necessary to achieve full network connectivity (here also referred to 
as online state).

The feature is disabled when the following registry key is empty. Otherwise, it should be 
a URI that is suitable for NetworkManager connectivity check.
More...

Parameter Online check URI
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Registry network.global.onlinecheck.uri

Range [] [http://connectivity-check.ubuntu.com/]

Value http://connectivity-check.ubuntu.com/

The following key specifies the conditions of the online check. It is also required that no 
Ethernet cable is plugged in and DHCP is not set in the UMS.
More...

Parameter Condition for online check

Registry network.global.onlinecheck.conditio

n

Range [None] [Network is user-defined] [Network is open]

This key determines how many seconds to wait for full network connectivity before the 
network connection is considered complete with incomplete connectivity. The timeout 
should allow a user to do what is necessary for passing through the captive portal.
More...

Parameter Online check timeout

Registry network.global.onlinecheck.timeout

Type integer

Value 120

Enabled use of 802.11r, also known as fast BSS transition or FT. This is confirmed to work at least 
in the mode "over the air".

Smartcard

Updated OpenSC to version 0.20.0. See https://github.com/OpenSC/OpenSC/releases/tag/0.20.0
for detailed release notes.

Cisco JVDI Client

Updated Cisco JVDI client to version 12.9.0.

Cisco Webex VDI

Integrated the new feature Cisco Webex Teams VDI for Citrix and Horizon sessions.
Cisco Webex Teams version: 3.0.15711.0
Added a parameter to activate the feature within Citrix:
More...

IGEL Setup Sessions > Citrix > Citrix Global > Unified 
Communications > Cisco

Parameter Cisco Webex Teams VDI

https://github.com/OpenSC/OpenSC/releases/tag/0.20.0
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Registry ica.module.virtualdriver.vdciscoteams.e

nable

Value enabled / disabled

Added a parameter to activate the feature within VMware:
More...

IGEL Setup Sessions > Horizon > Horizon Client Global > Unified 
Communications > Cisco

Parameter Cisco Webex Teams VDI - Horizon

Registry vmware.view.vdciscoteams.enable

Value enabled / disabled

Integrated the new feature Cisco Webex Meetings VDI for Citrix sessions. 
Client Version: 40.7.0.375
Added a parameter to activate the feature within Citrix:
More...

IGEL Setup Sessions > Citrix > Citrix Global > Unified 
Communications > Cisco

Parameter Cisco Webex Meetings VDI

Registry ica.module.virtualdriver.vdciscomeeting

s.enable

Value enabled / disabled

Base system

Updated base system to Ubuntu LTS version 18.04.
Updated kernel to version 5.4.48.
Added notification for critical system out-of-memory state when the available system memory 
is lower than 40 MB and processes were killed to prevent the system from freezing.
Display AMD Memory Guard in Boot Mode when it's active.
Added notification option for Session Autostart when a autostart delay is configured. It is 
possible to cancel the session autostart or to start immediately.
More...

IGEL Setup * > Desktop integration

Parameter Autostart notification

Value enabled / disabled

Added correct UI handling for Wacom DTU-1141B. 
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Updated CA Certificates to version 20190122 (Mozilla authority bundle version 2.30). The 
following authorities were added:
More...

"Certigna Root CA"
"GTS Root R1"
"GTS Root R2"
"GTS Root R3"
"GTS Root R4"
"UCA Extended Validation Root"
"UCA Global G2 Root"
"GlobalSign Root CA - R6"
"OISTE WISeKey Global Root GC CA"
"GDCA TrustAUTH R5 ROOT"
"SSL.com18 EV Root Certification Authority ECC"
"SSL.com19 EV Root Certification Authority RSA R2"
"SSL.com20 Root Certification Authority ECC"
"SSL.com21 Root Certification Authority RSA"
"TrustCor ECA-1"
"TrustCor RootCert CA-1"
"TrustCor RootCert CA-2"

The following authorities were removed:
More...

"Certplus Root CA G1"
"Certplus Root CA G2"
"OpenTrust Root CA G1"
"OpenTrust Root CA G2"
"OpenTrust Root CA G3"
"TÜRKTRUST Elektronik Sertifika Hizmet Saglayicisi H5"
"Visa eCommerce Root"
"ACEDICOM Root"
"AddTrust Low-Value Services Root"
"AddTrust Public Services Root"
"AddTrust Qualified Certificates Root"
"CA Disig Root R1"
"CNNIC ROOT"
"Camerfirma Chambers of Commerce Root" 
"Camerfirma Global Chambersign Root"
"Certinomis - Autorit‚ Racine"
"Certum Root CA"
"China Internet Network Information Center EV Certificates Root"
"Comodo Secure Services root"
"Comodo Trusted Services root"

http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
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"DST ACES CA X6" 
"GeoTrust Global CA 2"
"PSCProcert"
"Security Communication EV RootCA1"
"Swisscom Root CA 1"
"Swisscom Root CA 2"
"Swisscom Root EV CA 2"
"TURKTRUST Certificate Services Provider Root 2007"
"TUBITAK UEKAE Kok Sertifika Hizmet Saglayicisi - Surum 3"
"UTN USERFirst Hardware Root CA"

Added parameter to override rate limit of debug messages in journal. It should be enabled for 
debugging processes which generate a big amount of messages in order to avoid skipping of 
messages.
More...

Parameter No rate limit

Registry system.journald.no_rate_limit

Value enabled / disabled

It's possible to extend the login options of the Kerberos login window now. 
There are several new registry keys:
More...

Parameter extended login

Registry sessions.xlock0.options.login_extensio

n_active

Value enabled / disabled

If enabled, an "Associate Type" combo box is shown. The entries of the combo box are 
configured with the following login_feature1, login_feature2, and login_feature3 keys.

Configure the label of the "Associate Type" combo box:
More...

Parameter login features label

Registry sessions.xlock0.options.login_featur

es_label

Value Default: empty which means "Associate Type"

The first entry of the "Associate Type" combo box. To enable the combo box entry, add 
e.g. the text "Store associate at home store". 
More...

Parameter login_feature1
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Registry sessions.xlock0.options.login_featu

re1

If the entry is selected, the username is expanded by a fixed string defined in 
login_extension_default  registry key.

The fixed username extension for the first feature. It can be set e.g. by a script.
More...

Parameter login extension default value

Registry sessions.xlock0.options.login_extens

ion_default

The second entry of the "Associate Type" combo box. To enable the combo box entry, 
add e.g. the text "Store associate visiting this store". 
More...

Parameter login_feature2

Registry sessions.xlock0.options.login_featu

re2

If the entry is selected, the username is expanded by a suffix that is entered in 
a separate entry widget.
The label of the entry field for the username suffix. Set it e.g. to "Store Number".
More...

Parameter login_extension_label

Registry sessions.xlock0.options.login_extens

ion_label

Value Default: empty which means "no label"

The third entry of the "Associate Type" combo box. To enable the combo box entry, add 
e.g. the text "Homeoffice associate visiting this store".
More...

Parameter login_feature3

Registry sessions.xlock0.options.login_featu

re3

If the entry is selected, another domain can be selected from an appended 
domain combo box.
The label for the domain entry field.
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More...

Parameter login domain label

Registry sessions.xlock0.options.login_domain

_label

Value Default: empty which means "domain"

The extension to the username is added after a dot ('.').
For the domain drop-down box, four different domains are configurable here:
More...

IGEL Setup Security > Active Directory/Kerberos > Domain 1 - 
4

Parameter Fully qualified domain name

Registry auth.krb5.realms.realm0.realm

Registry auth.krb5.realms.realm1.realm

Registry auth.krb5.realms.realm2.realm

Registry auth.krb5.realms.realm3.realm

There are keys to add more domain names:
More...

Parameter Domain 

Registry auth.krb5.extended_domain%.name

Info Add a new instance for each domain entry.

In the Kerberos login window, it's now possible to turn on or off numlock and/or capslock 
for password input. 
Registry keys:
More...

Parameter Handling of numlock

Registry sessions.xlock0.options.numlock_appr

oach

Range [don't change] [set on] [set off]

Info "set on": force numlock on when password is entered
"set off": force numlock off when password is entered
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Parameter Handling of capslock

Registry sessions.xlock0.options.capslock_app

roach

Range [don't change] [set on] [set off]

Info "set on": force capslock on when password is entered
"set off": force capslock off when password is entered

It's now possible to show a message in the Kerberos login window. Registry key:
More...

Parameter banner text

Registry sessions.xlock0.options.banner_text

Info The user will see the message on the top border.

In the Kerberos login window, there is a mode to convert passwords always to upper 
case. To turn it on, use:
More...

Parameter case-insensitive password

Registry sessions.xlock0.options.case_insensi

tive_password

Value enabled / disabled

With this key, the text for the case-insensitive indicator can be modified:
More...

Parameter case-insensitive text

Registry sessions.xlock0.options.case_insensi

tive_text

Value Default: empty which means "case-insensitive"

Fixed ThinkPad Brazil keyboard layout.
It is possible to show a custom logo in the Kerberos login window. Also, the background 
and text color is customizable now. 
Registry keys:
More...

Parameter path for login image

Registry sessions.xlock0.options.login_image
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Value /usr/share/pixmaps/greeter-user.svg 

Info Supported image formats include: PNG, JPG, SVG

Parameter set specific colors for greeter

Registry sessions.xlock0.options.set_color

Value enabled / disabled

Parameter text color

Registry sessions.xlock0.options.text_color

Value #ffffff

Info Text color in the format #rrggbb
Example: #ff0077

Parameter background color

Registry sessions.xlock0.options.background_

color

Value #000000

Info Background color in the format #rrggbb
Example: #7700ff

Added new local logon method "Login with Smart Card Certificate". It implements the 
pam_pkcs11 smartccard authentication module. For a successful
configuration, the following has to be provided via UMS file transfer:

root and intermediate CA certificates for verification of the client certificates in 
folder /etc/pam_pkcs11/cacerts

file /etc/pam_pkcs11/cn_map  which contains mappings of Common Names 
to UPN names. 
Each line is in the format \<common name> -> \<logon name>  
where 
\<common name>  is the common name part of the subject of the certificate

 \<logon name>  is 

- in case of Kerberos Enterprise ( auth.login.krb5_enterprise ) disabled: 
the UPN name of the SubjectAltName extension of the certificate, 
e.g. user@MY.DOMAIN22 
- in case of Kerberos Enterprise ( auth.login.krb5_enterprise ) enabled: 

mailto:user@MY.DOMAIN
mailto:user@MY.DOMAIN
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the UPN name of the SubjectAltName extension of the certificate with 
Default Domain ( auth.krb5.libdefaults.default_realm ) suffix, 
e.g. user@DOMAIN.SUFFIX@DEFAULT.DOMAIN23

The logon method can either be used standalone or together with Kerberos logon as a 
fallback if Kerberos does not succeed.
More...

Parameter Login with Smart Card Certificate

Registry auth.login.pkcs11

Value false / true

Parameter Certificate verification policy

Registry auth.login.pkcs11_cert_policy

Value ca,ocsp_on,signature

Parameter Enable Debugging of Smart Card Certificate Logon

Registry auth.login.pkcs11_debug

Value false / true

It is possible to expand the store number by a registry key:
More...

Parameter expand store

Registry sessions.xlock0.options.expand_stor

e

Value enabled / disabled

Fixed: The login screen is adjusted to lower resolutions.
It is possible to activate enter key to login on all fields.
More...

Parameter auto login on all fields

Registry sessions.xlock0.options.auto_login

Value enabled / disabled

X11 system

Changed: Use modesetting graphics driver on devices with newer intel GPUs.
Changed registry key:

mailto:DOMAIN.SUFFIX@DEFAULT.DOMAIN
mailto:DOMAIN.SUFFIX@DEFAULT.DOMAIN
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More...

Parameter Use generic modesetting driver for INTEL hardware

Registry x.drivers.intel.use_modesetting

Range [Auto] [True] [False]

Updated DisplayLink driver to version 5.3.1.34.
Added new registry key for Nvidia cards (use this if you want to use PRIME):
More...

Parameter Enable/Disable NVIDIA Kernel Modesetting support

Registry x.drivers.nvidia.use_modeset

Range [Default] [Enabled] [Disabled]

Info "Default" is currently the same as "disabled"

Updated florence soft keyboard to version 0.6.3.
Removed 640x480 from possible display resolution range.
Added possibility to change the order of primary and secondary graphic card. 
New registry key:
More...

Parameter Make the secondary graphic card to the primary one

Registry x.drivers.swap_card0_with_card1

Value true / false

Added possibility to invert the order of all graphic cards. 
New registry key:
More...

Parameter Invert default graphic card ordering

Registry x.drivers.swap_all

Value true / false

Added possibility to choose the driver which should become the primary graphic card. 
New registry key:
More...

Parameter Choose which drivers should be preferred to become the 
primary graphic card

Registry x.drivers.preferred_driver

Value
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X server

Added possibility to influence mode used for mirroring screens with different resolutions. 
(Notice: here scaling may not always work). 
New registry key:
More...

Parameter Choose the mode which should be used for mirroring 
monitors if resolution differs

Registry x.xserver0.mirror_mode

Range [Default] [Biggest common resolution] [Scaling]

Value Default (use panning if needed)

Driver

Updated Grundig Dictation driver for Citrix and RDP to version 0.10. 
The changes are:

Support third-party USB HID devices in a more flexible way
Fixed USB transfer overflow for Philips LFH 9620
Remove erroneous debug output in release configuration
Allow to control also "Headphone" volume & switches

Updated Olympus driver for dictation to version 2020-03-23-143654.
Changelog:

New:

DR-1200: PID 0225
DR-2300: PID 0256

Changed: 

PID 0253 from DR-2100 to DR-1200
Updated Philips Speech driver to version G12.9. 
The changes are:

Support for Philips SpeechLive
Faster and more reliable remote session connection status check
Shutdown of the PSPDispatcher.exe on the server if it's not in use anymore.

Updated StepOver TCP client and Citrix plugin to version 2.4.2. Fixed crash of Citrix session 
while using the signature pad.

Audio

Integrated new sound mixer.
New combo box for audio device selection in TC Setup available:

Accessories > Sound Preferences > Options > Default Sound Output
Accessories > Sound Preferences > Options > Default Sound Input

Appliance Mode
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Integrated: The new Browser Appliance mode is the successor for the XenDesktop 
appliance mode. The Browser is configured as in XenDesktop appliance mode, but does not
use the upstream SAS window.
More...

IGEL Setup Sessions > Appliance Mode

Parameter Browser

Registry xen.xenapp-morph.enabled

Type Bool

Value enabled / disabled

IGEL Setup Sessions > Appliance Mode > Browser

Parameter Web URL

Registry xen.xenapp-morph.xendeliveryserverurl

Type string

A hyperlink to the "On-screen Keyboard" is available on the right side under "Related 
Configurations".

Multimedia

Added ffmpeg support for following codecs:
Added support for new decoders:
More...

flac, gif, libaom_av1, mjpeg, mjpegb,
mp1,mp1float, mp2, mp3, mp3adu,
mp3adufloat, mp3float, opus, theora, vorbis,
vp2, vp8, vp9, and wavepack

Added support for new encoder: libopus
Added support for new hwaccels:
More...

mjpeg_vaapi, mpeg1_vdpau, mpeg2_vaapi,
mpeg2_vdpau, vp8_vaapi, and vp9_vaapi

Added support for new parsers: avi, flac, gif, matroska, mp3, ogg, and wav
Added support for new demuxers: avi, flac, gif, matroska, ogg, and wav
Added support for new muxers: ogg and opus

Chromium Browser

Integrated Chromium browser version 83.0.4103.61 as experimental feature.
Configurable at IGEL Setup > Sessions > Chromium Browser > Chromium Browser Global and 
IGEL Setup > Sessions > Chromium Browser > Chromium Browser Sessions
Main switch to enable and disable IGEL configuration:
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More...

IGEL Setup Sessions > Chromium Browser > Chromium Browser 
Global

Parameter Use IGEL Setup for configuration

Registry chromiumglobal.app.igelsetupconfig

Value disabled / enabled

Info With disabled IGEL configuration, you can use the generic 
Custom Setup to configure Chromium. 
The Custom Setup can be found at IGEL Setup > Sessions 
> Chromium Browser > Chromium Browser Global > 
Custom Setup:
Policies, Preferences, Commandline Options.

Parameter for enabling and disabling the H.264 decoding:
More...

IGEL Setup Sessions > Chromium Browser > Chromium Browser 
Global

Parameter H.264 decoding

Registry chromiumglobal.app.h264_decoding

Value enabled / disabled

Info Enable Audio/Video playback of non-free codecs 
(H.264+AAC) - the support is in
a beta state and therefore disabled by default.

Evidian

Added the Evidian built-in option 'Process To Spy'.
More...

Registry evidian.processtospy

Value YOUR-PROCESS / disabled

ControlUp

Integrated ControlUp Monitoring Tool for Citrix and Horizon sessions.

Hardware

Added hardware support for Lenovo M625q.
Added hardware support for LG CL600N.
Added hardware support for HP Engage Go Mobile System.
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Added hardware support for Fujitsu FUTRO S740.
Added hardware support for OnLogic CL210G-10.
Added hardware support for OnLogic KARBON 300.
Added hardware support for Rein Medical Clinio S 522TCT and S 524TCT.
Added hardware support for HP t640 Thin Client.
Added basic support for Macbook models 2018 and newer.
Added support for Sennheiser MB 660, SC 630, SC 45, SC 160 headsets.
Added support for Plantronics Savi 8245 Office, Voyager 6200 UC, Savi 8220 headsets.
Added serial port driver for Exar UART PCIe card.
Added driver for GSPCA based webcams.

TC Setup (Java)

Added Setup page Sessions > Horizon Client > Horizon Client Global > Window. Settings for 
"Window size" and "Multimonitor full-screen mode" can be set. 
These settings are repeated and originate in RDP Global but are now presented in a more obvious 
place for Horizon sessions.

IGEL Cloud Gateway

Added support for Secure Terminal over ICG.
Changed default order of connecting to the IGEL Remote Management - an available UMS 
Server is preferred now by default. The device establishes a configured ICG connection only if the 
UMS Server is not reachable. This behavior can be changed by the parameter:
More...

Registry system.remotemanager.icg_try_ums_connec

t

Value true / false

Fabulatech

Updated FabulaTech Scanner for Remote Desktop client to version 2.4.0.11. 
Updated FabulaTech plugins to version 3.6.2.
Updated Fabulatech USB for Remote Desktop plugins to version 3.6.8.

Jabra

Jabra Xpress (JDU) is upgraded to the 7.2.0-509 version. List of the newly introduced parameters:
More...

Registry jabra.xpress.show_jdu_gui

Value true / false

Registry jabra.xpress.device_dashboard.autopost

Value true / false



Notes for Release 11.04.100

IGEL OS Release Notes   615 / 1492

•
•

•

•

•

•

•
•

•

•

•
•
•
•
•

•

•

•

•
•
•

Resolved Issues 11.04.100
Citrix

"Green artifacts" problem in Citrix sessions (most probably) fixed.
Citrix hardware video acceleration supports the latest Intel hardware.

OSC Installer

Fixed issue with filesystems not always get detected correctly in initramfs OSC Installer (needed 
for using iso file boot parameter).
Fixed: username and password in the error message are not shown anymore when firmware 
file could not be downloaded.
Get URLs with username:password@ working.

RDP/IGEL RDP Client 2

Fixed error when renaming a non-empty shared folder.

WVD

Includes WVD client with fixed RDcoreSDK version.
Clipboard redirection has potential privacy and security risks and is therefore disabled by 
default.
IGEL WVD Client integrated

VMware Horizon

Fixed missing support for ThinPrint and Skype for Business when starting Horizon from Firefox 
browser.

Firefox

Fixed Firefox block extension missing tabs created via command line argument.
Fixed rtsp media stream with enabled apparmor.
Show "blocked" page instead of closing tab when blocked page is viewed in Firefox.
Fixed functionality in the local setup to start the certificate manager of the Firefox browser.
Fixed functionality in the local setup to start the Firefox browser with the internal page to show 
the installed plugins. 
Fixed restart mechanism in the Firefox browser where the browser could not be closed on 
suspend resulting in a superfluous browser window on resume.

Network

Improved Wi-Fi DHCP lease handling: Leases are discarded when the network changes. The 
former behavior caused problems with certain iPhone IOS versions.
802.1X failures now generally result in falling back to a connection without authentication, 
e.g. also in the case of 802.1X settings that don't make sense at all. This only applies if the 
fallback is allowed of course.
wpa_supplicant now adds timestamps to entries of its log file.
Use e1000e driver out of the kernel as default instead of the third-party driver.
Added a registry key that determines whether lldpd is in receive-only mode.



Notes for Release 11.04.100

IGEL OS Release Notes   616 / 1492

•

•

•

•

•

•
•
•
•
•

•
•

•
•

•

More...

Parameter Disable sending LLDP packets

Registry network.lldp.rxonly

Value true

Attention:  If the behavior since 10.06.100 shall be preserved, this key 
must be set to "false".

Updated scep to version 0.7.0.

Wi-Fi

Fixed non-working Marvell WLAN device 8997 (SDIO version).

NCP VPN

Added fix for NCP Secure Client.

genucard VPN

genucard 3 is supported now.

Imprivata

Control the visibility of the Horizon session control bar via registry parameter:
More...

Registry vmware.view.menu-bar

Value enabled / disabled

Honor the Citrix Window Configuration in Imprivata Appliance Mode. 
Fixed Lock key and Tap out behavior. 
Fixed MS RDSH session.
Simplified the configuration of Imprivata FUS.
Enable the following if you use Imprivata versions above 6.3:
More...

Registry imprivata.gain_permission

Value enabled / disabled

Fixed bug regarding Imprivata and On-Screen Keyboard.
Restore the keyboard map after Horizon sessions.

Smartcard

Fixed not working 90meter in Firefox when apparmor is active.
Fixed problem in smartcard resource manager PC/SC-Lite which caused disconnects of VMware 
Horizon sessions when using smartcards with certain applications.
Added driver for smartcard reader Elatec TWN4 CCID (USB 0x09D8:0x0425).
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Updated cryptovision scInterface to version 7.3.1. 
The changes are:
More...

Consolidated features of the last versions 7.2 and 7.1
Malta eID Release
Added Admin Card Gemalto V3

Updated PC/SC-Lite smartcard resource manager to version 1.8.26.

HID

Fixed: Switching touchpad to other driver via IGEL registry key.

CUPS Printing

Added new version 25.1.0.425 of Printerlogic Printer Installer Client.
Added new printer models into IGEL OS from the current CUPS drivers.

Base System

Fixed bug in folder generation of the Application Launcher.
Fixed TLS certificate verification problem of certificates signed by "USERTrust RSA CA" or 
"COMODO RSA CA". The problem could occur in clients like Citrix Workspace App and VMWare 
Horizon client.
Fixed password change with AD/Kerberos. Before this fix, the password complexity rules were 
not enforced for users with the Reset Password permission for their account.
You can now connect to Bluetooth devices without pairing. For this a new registry key is 
available.
More...

Parameter connect devices without pairing

Registry devices.bluetooth.connect_only

Value enabled / disabled

Some devices do not connect automatically after reboot. To fix that,  bluetoothctl 

connect \<device-ID>  can be executed via script. If the device is connected (0) or not (1)
can be seen in return value.
Known devices that do not connect:

dialog semiconductor IoT Multi Sensor DK
SSHv1 support is now removed due to newer openssh libraries.
Forcing protocol version 1 via SSH Session > Options is no longer possible.
The network.ssh_server.server_key_bits  registry key parameter is removed due to 
deprecation of SSHv1.
Updates systemd to Ubuntu Focal version.
Improved stability of mounting network shares when using a static network configuration.
Fixed apparmor cache issue after update with OSC installer.
Bug fix: touchscreen calibration on 1 or more normal screen with 1 touch screen environment.
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g.
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•
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Fixed syslog, kern.log, auth.log, and daemon.log entries are not shown in IGEL System Log 
Viewer.
Updated Grub2 to current Debian SID/Bullseye version 2.04.
Removed deprecated registry keys system.idlecommand .
New Bluetooth pairing tool and Bluetooth tray icon for Bionic.
Updated kernel to mainline version 5.4.48.
If used as master image, the image will expand itself to full size (limited to 16 GiB) on flash. This 
is done only on first boot and never again.
Possible rollout of initial settings, certificates or licenses placed on first partition for this you 
need to:

Write image to your USB/Flash medium.
Mount or simply access the 1. VFAT partition which is present (should be empty).
Copy your setup.ini and/or **.lic files to the 1st partition (no directories).
Create a ca-certs  directory and copy your certificates into it. They will be copied to the 

/wfs/ca-certs  directory on first boot.
You can now copy the USB/Flash medium several times if needed.
On first boot, the device will reboot out of the splash screen (reread changed partition table)
The settings, certificates and/or licenses will get rolled out and deleted from the 1st 
partition.

Added initial support for Thunderbolt devices (only limited support here, may work but is not 
guaranteed).
Updated IGEL EULA.
Updated AMD Microcode to version 3.20191218.1.
Updated Intel Microcode to version 20200520 and a special update for J1900 devices.
Updated Intel Microcode to 20200616 version.
 Added a userspace oom killer to the firmware.

Firmware Update

An ongoing firmware update can now be canceled by the user when the network online status 
could not be reached after 10 seconds (since start of the firmware update).

H264

Citrix hardware video acceleration supports the latest Intel hardware.

Storage Devices

Fixed mount issues with Iphone XR/XE/11PRO.
Mobile Device Access feature respects USB Access Control now. 
Fixed unwanted ownership change of automounted Linux filesystem root directories.

 X11 System

Fixed Display Switch not saving settings over reboot.
Default to settings from Setup instead of mirror when no Display Switch profile is 
available.

Prevent misconfiguration that picks GPU without render capability as primary (e.g. Displaylink).
Improved Nvidia with additional GPU handling.
Fixed error with single-gpu Nvidia card support.
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X server

Fixed a Xorg crash due to a NULL pointer dereference in the Intel driver.

Window Manager

Fixed random login (greeter) window focus issues.

Shadowing/VNC

Added the "snapfb" option for the VNC server.
More...

Registry network.vncserver.snapfb

Value enabled / disabled

Info This option should only be enabled with experienced delays 
in remote or shadowing
session.

Improved security of the password authentication method - the VNC server does not require 
anymore a file holding the password. During client authentication, the server retrieves now the 
password from the IGEL Setup.

VNC Viewer

Fixed occasional freeze of shadowing session e.g. when resizing a window. Now the session gets 
unlocked again after about 20 seconds.
More...

Parameter Unlock X server in case of shadowing session freeze

Registry network.vncserver.grab_buster

Type bool

Value enabled / disabled

VirtualBox

Fixed no automatic resolution changes as virtualbox guest issue.

Audio

Fixed headset microphone using 3.5mm audio jack in Dell Wyse 3040.
Added possibility to set some snd_hda_intel kernel module parameter to overcome possible 
issues with sound devices. 
New registry keys:
More...

Parameter Enable Message Signaled Interrupt



Notes for Release 11.04.100

IGEL OS Release Notes   620 / 1492

Registry system.sound_driver.snd_hda_intel.enab

le_msi

Type bool

Value enabled / disabled

Parameter Force enable device

Registry system.sound_driver.snd_hda_intel.enab

le

Type bool

Value enabled / disabled

Parameter Position fix quirk

Registry system.sound_driver.snd_hda_intel.posit

ion_fix

Range [Default] [Auto (0)] [LPIB (1)] [POSBUF (2)] [VIACOMBO (3)]
[COMBO (4)] [SKL+ (5)] [FIFO (6)]

Parameter Change sound card order

Registry system.sound_driver.snd_hda_intel.inde

x

Type integer

Value empty

Parameter Detection of DMIC devices

Registry system.sound_driver.snd_hda_intel.dmic

_detect

Range [Default] [Disabled] [Enabled]

Parameter Enable this if you encounter sound card problems

Registry system.sound_driver.snd_hda_intel.sing

le_cmd

Type bool
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Value enabled / disabled

Parameter Automatic power save timeout

Registry system.sound_driver.snd_hda_intel.powe

r_save

Type integer

Value empty

Parameter Reset controller in power save mode

Registry system.sound_driver.snd_hda_intel.power

_save_controller

Type bool

Value enabled / disabled

Parameter Choose sound model to use

Registry system.sound_driver.snd_hda_intel.mode

l

Type string

Value Auto

Parameter If you encounter sound problems try to choose one of the 
alternative masks

Registry system.sound_driver.snd_hda_intel.probe_

mask

Range [Auto] [1] [8]

Old settings. Command at startup removed.

Jabra

Avoid deploying of the same Jabra Xpress package several times on the same Jabra device.

Evidian

Evidian now triggers the regular Horizon session script.

Hardware

Fixed non-working Prolific PL2303 USB-to-serial adapters.

TC Setup (Java)
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Removed "default" button left of selection box IGEL Setup: Sessions > Citrix > Citrix Global > 
Window > Multimonitor full-screen mode.

Remote Management

Fixed repeated firmware registering over the ICG which can occur after a new firmware was 
successfully registered in the UMS. The device invokes firmware registering again after every 
settings transfer from the device to the UMS. This behavior lasts until reboot.
Fixed syncing settings changed on the device if the UMS wasn't reachable.
Fixed handling of the structure tag if it was configured in the system dialog "UMS Registering".

IGEL Cloud Gateway

Maximum waiting time for a response from the ICG server can now be configured by the 
parameter system.remotemanager.rmagent_timeout (default: 90 seconds).

VNC

Shadowing notification is restricted to primary monitor and cannot be moved outside of the 
monitor's visible range.
Fixed sporadic connection failure in VNC server.
Fixed occasional freeze of shadowing session e.g. when resizing a window. Now the session gets 
unlocked again after about 20 seconds.
More...

Parameter Unlock X server in case of shadowing session freeze

Registry network.vncserver.grab_buster

Type bool

Value enabled / disabled
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Notes for Release 11.03.500
Software: Version 11.03.500

Release Date: 2020-04-01

Release Notes: Version RN-1103500-1

Last update: 2020-04-01

IGEL OS 11 (see page 624)
IGEL OS Creator (OSC) (see page 644)
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IGEL OS 11
Supported Devices 11.03.500 (see page 625)
Component Versions 11.03.500 (see page 626)
General Information 11.03.500 (see page 630)
Security Fixes 11.03.500 (see page 631)
Known Issues 11.03.500 (see page 632)
New Features 11.03.500 (see page 635)
Resolved Issues 11.03.500 (see page 640)
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Supported Devices 11.03.500
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.03.500
Clients
Product Version

Cisco JVDI Client 12.7.1

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Workspace App 18.10.0.11

Citrix Workspace App 19.10.0.15

Citrix Workspace App 19.12.0.19

deviceTRUST Citrix Channel 19.1.200.2

Crossmatch DP Citrix Channel 0515.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 12.5_x64_20190619_12.5.1.40008

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.6

FabulaTech USB for Remote Desktop 5.2.29

Firefox 68.6.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

IGEL WVD Client 1.0.5

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.7.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.44.0.11

Parallels Client (64 bit) 17.0.21474

Spice GTK (Red Hat Virtualization) 0.37-1igel62
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Remote Viewer (Red Hat Virtualization) 8.0-1igel49

Usbredir (Red Hat Virtualization) 0.8.0-1+b1igel71

Teradici PCoIP Software Client 19.05.9-18.04

ThinLinc Client 4.10.1-6197

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.5-1igel1583919770

VNC Viewer 1.9.0+dfsg-3igel8

VMware Horizon Client 5.3.0-15208949

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech driver 12.8.5

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.3.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 7

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.7.77

PKCS#11 Library OpenSC 0.19.0-2igel35

PKCS#11 Library SecMaker NetID 6.8.1.31

PKCS#11 Library 90meter 20190522
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Reader Driver ACS CCID 1.1.6-1igel2

Reader Driver Gemalto eToken 10.7.77

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.31-1igel10

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel11

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.2.5-1igel93

VAAPI ABI Version 0.40

VDPAU Library version 1.2-1igel911

Graphics Driver INTEL 2.99.917+git20191117-igel939

Graphics Driver ATI/RADEON 19.0.1-3igel936

Graphics Driver ATI/AMDGPU 19.0.1-5igel924

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 418.56-0ubuntu1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel975
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Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.7413

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.85 #mainline-lxos-r2875

Xorg X11 Server 1.20.5-1igel914

Xorg Xephyr 1.20.5-1igel914

CUPS printing daemon 2.1.3-4ubuntu0.10igel29

PrinterLogic 25.1.0.381

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.1-1igel222

WebKit2Gtk 2.26.2-1igel27

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20191129.9f79242-1igel7

Mobile Device Access USB (gphoto) 2.5.23-2igel2

VPN OpenConnect 7.08-1

Scanner support 1.0.27-1

VirtualBox 6.0.14-dfsg-1igel33



Notes for Release 11.03.500

IGEL OS Release Notes   630 / 1492

•
•
•
•
•
•
•
•
•
•
•

General Information 11.03.500

The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver

Firmware downgrade to older versions (11.01 or 11.02) is not possible, due to the unsigned firmware 
update files.


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Security Fixes 11.03.500
Firefox

Updated Mozilla Firefox to 68.6.0 ESR.
Fixes for mfsa2020-09, also known as:
More...

CVE-2020-6805, CVE-2020-6806, CVE-2020-6807, CVE-2020-6811, 
CVE-2019-20503, CVE-2020-6812, and CVE-2020-6814

Fix for mfsa2020-03, also known as CVE-2019-17026.
Fixes for mfsa2020-02, also known as:
More...

CVE-2019-17016, CVE-2019-17017, 
CVE-2019-17022, and CVE-2019-17024

Fixes for mfsa2019-37, also known as: 
More...

CVE-2019-17008, CVE-2019-11745, CVE-2019-17010,
CVE-2019-17005, CVE-2019-17011, and CVE-2019-17012

Base system

Fixed libxml2 security issues CVE-2020-7595 and CVE-2019-19956.
Fixed nss security issues CVE-2019-17007, CVE-2019-17006, and CVE-2019-11745.
Fixed libvncserver security issue CVE-2019-15681.
Fixed libexif security issues CVE-2019-9278, CVE-2017-7544, and CVE-2016-6328.
Fixed cyrus-sasl2 security issue CVE-2019-19906.
Fixed samba security issues CVE-2019-14907, CVE-2019-14870, and CVE-2019-14861.
Fixed zulu security issues:
More...

CVE-2020-2583, CVE-2020-2590, CVE-2020-2593,CVE-2020-2601, 
CVE-2020-2604, CVE-2020-2659, and CVE-2020-2654
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Known Issues 11.03.500
Firmware Update

On devices with 2 GB of flash storage, it could happen that there is too little space for updating 
all features. In this case, a corresponding error message occurs and unused features must be 
disabled in IGEL Setup under  System > Firmware Customization > Features to perform the 
firmware update.

Firefox

Firefox IGEL extensions are not updated automatically under some circumstances. After an 
update from 11.03.10x to 11.03.500, the IGEL extensions will stay on the old version. 
In this case, the following settings concerning kiosk mode cannot be executed:

Switch off Hotkey for new window/tab
Blocking of internal browser pages like preferences, file picker, specific local directories

As a workaround:

a reset to defaults should be performed
or the browser's mimetype template can be switched from "Standard" to "Minimal" by 
registry key browserglobal.app.mimetypes_template . There, the browser profile is 
renewed as well.
After the TC got the new setting, reboot and set the mimetypes_template  registry key back 
to "Standard".

Citrix

With activated DRI3 and an AMD GPU Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1 and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of login. 
Workaround: Insert the smartcard before starting the StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and 
H264 acceleration
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Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery group.

Using CWA 19.x sometimes freezes the session while session logoff from a published desktop. 
Workaround: Use CWA 18.10.0.

VMware Horizon

Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Enable local `Storage Hotplug` on setup page Devices > Storage Devices > Storage 
Hotplug.

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.
After disconnect of an RDP based session, the Horizon main window which contains the server 
or sessions overview cannot be resized anymore.
Seamless application windows in Horizon Client may not be displayed correctly.  When 
starting the first seamless app, a new iconified window appears in the taskbar, and only if you click 
on it, the application will show up.
On some hardware (UD7-H850, UD2-M250, UD2-D220), however, the client aborts when this new 
window is de-iconified.

Imprivata

On devices with 2 GB of flash storage, it could happen that there is too little space to enable the 
Imprivata partition after the update to 11.03.500. In this case, a corresponding error message 
occurs and unused features must be disabled (in IGEL Setup under System > Firmware 
Customization > Features). Imprivata has to be (re-)enabled after a reboot then.

Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters does not work after system suspend/resume. Workaround: 
Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Parallels Client

Native USB redirection does not work with Parallels Client.

Smartcard

In seldom cases, the authentication hung when using A.E.T. SafeSign smartcards.
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Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Hyper-V

Hyper-V (Generation 2) needs a lot of memory. The machine needs a sufficient amount of 
memory allocated.

VirtualBox

The current VirtualBox Guest Tools/Drivers will not work with VirtualBox 5.2.x or older hosts 
which leads to black screen and non-working graphic. 
Workaround: Install with 'Failsafe Installation + Recovery' and set the registry key 
x.drivers.force_vesa  to true.

When running in VirtualBox virtualization, resizing the window will not automatically change 
desktop resolution of IGEL OS guest.

Audio

Audio jack detection on Advantech POC-W243L doesn't work. Sound output goes through the 
headset connection and the internal speakers.
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.

Hardware

HP t730 could freeze when monitors with different resolutions are connected (1920x1200 + 
2560x1440 + 3840x1600 for example). When this occurs, the registry 
key  x.drivers.kms.best_console_mode  has to be set to disabled.
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work with INTEL devices.

Remote Management

AIT feature with IGEL Starter License is supported by the next UMS version 6.05.100.
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New Features 11.03.500
Citrix

Integrated Citrix Workspace App 19.12
Available Citrix Workspace Apps in this release: 19.12 (default), 19.10, and 18.10
New registry keys:

Added a registry key for enabling full-screen banner "Citrix Desktop Viewer" when 
starting a Desktop or Application session.
More...

Parameter Show Citrix Desktop Viewer screen

Registry ica.module.cdviewerscreen

Value off / on

Added a registry key to enable usage of Chromium Embedded Framework (CEF) for 
Browser Content Redirection (BCR) [Experimental].
More...

Parameter Use Chromium Embedded Framework (CEF)

Registry ica.allregions.usecefbrowser

Value factory default is "*" / false / true

"factory default" impact can be set by config file.
Changed default:
More...

Parameter VDTUI protocol

Registry ica.module.virtualdriver.vdtui.enab

le

Value off / on

WVD

Integrated IGEL WVD Client.

VMware Horizon

Updated VMware Horizon Client to version 5.3.0.

ThinLinc

Updated ThinLinc Client to version 4.11.0.

Smartcard

Updated Gemalto / Safenet smartcard middleware to version 10.7.7.
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Added support for smartcard reader HP Business Slim Smartcard CCID Keyboard.
Added configuration parameter to disable PIN pad functionality of smartcard readers, driven 
by Open Source CCID driver. This might work to solve problems with PIN pads, but lowers security 
level.
More...

Parameter Disable PIN pad

Registry scard.pcscd.ccid.disable_pinpad

Value disabled / enabled

Added possibility to add custom CCID smartcard readers to Open Source CCID driver. Readers 
can be specified by USB Vendor, Product Id, and custom name:
More...

Parameter USB Vendor Id

Registry scard.pcscd.ccid.custom_reader<num>.v

id

Value

Parameter USB Product Id

Registry scard.pcscd.ccid.custom_reader<num>.p

id

Value

Parameter Reader name

Registry scard.pcscd.ccid.custom_reader<num>.n

ame

Value

Updated Athena IDProtect library to version 7. This version supports CRYPTAS TicTok V3 cards. 
Known issue: The detection of locked PIN does not work.

CUPS Printing

Added CUPS Printer port "USB class printer". The USB printer is assigned, in this case, by 
matching patterns of USB Manufacturer and Product name strings. In
this way, a single printer definition could work for a class of different USB printer models.
More...

IGEL Setup Devices > Printer > CUPS > Printers

Parameter Printer port
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Registry print.cups.printer<num>.backend

Value USB class printer

IGEL Setup Devices > Printer > CUPS > Printers

Parameter Pattern matching mode

Registry print.cups.printer<num>.usbclass_mode

Value pattern / pattern, case insensitive / regular expression

IGEL Setup Devices > Printer > CUPS > Printers

Parameter Manufacturer pattern

Registry print.cups.printer<num>.usbclass_manufactu

rer

IGEL Setup Devices > Printer > CUPS > Printers

Parameter Product pattern

Registry print.cups.printer<num>.product

Updated PrinterLogic Printer-Installer-Client to version 25.1.0.381. Fixed tray icon 
functionality.

Cisco JVDI Client

Integrated Cisco JVDI 12.7.1 client. Cisco JVDI 12.7.0 has been removed.

Base system

Added Starter License functionality.
This license is now part of every new IGEL OS installation and is valid for 30 days. The license will 
be activated with the first boot after the initial installation. More and detailed information via 
https://kb.igel.com/licensing.
Added 'Licensing' tool to 'System' in local Start menu. Disable the tool by key:
More...

IGEL Setup Accessories > License Browser

Parameter Start Menu's System tab

Registry sessions.license_browser0.startmenu_s

ystem

Value enabled / disabled

If there is only the Starter License and no UMS connection, the Licensing tool is shown on the 
desktop by default.
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Added feature Custom Partition to Workspace Edition license.
Updated Fluendo multimedia codecs to the following versions: gst-fluendo-vadec - 30/01/2020 
0.10.212.
Kerberos Logon:
You can now turn on/off numlock and/or capslock for password input. Registry keys:
More...

Parameter Handling of numlock

Registry sessions.xlock0.options.numlock_approac

h

Value don't change / set on / set off

Note "set on": force numlock on when password is entered
"set off": force numlock off when password is entered

Parameter Handling of capslock

Registry sessions.xlock0.options.capslock_appro

ach

Value don't change / set on / set off

Note "set on": force capslock on when password is entered
"set off": force capslock off when password is entered

Added configuration for special thinkpad keyboard model:
More...

IGEL Setup User Interface > Input > Keyboard

Parameter Keyboard type

Registry userinterface.keyboard.type

Range [Default] [Standard PC Keyboard (105 Keys)] [IBM 
Keyboard (122 Keys)]
[Trimodal Keyboard] [Sun Type 6 
Keyboard] [Chromebook]
[Macbook] [Macbook international] [Thinkpad]

Wi-Fi

Added driver for Realtek 8822ce and 8822be Wi-Fi hardware.
Added driver for Realtek 8821cu Wi-Fi hardware.

Driver
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Updated Crossmatch DP driver for fingerprint. The new version allows the fingerprint image to 
be sent via the Citrix channel. With this change, customers will be able to develop their own SW 
using the Crossmatch DP SDK.

Misc

Updated Login PI 3.6 to the new Login Enterprise 4.0.
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Resolved Issues 11.03.500
Citrix

Fixed video playback on BBC websites redirected via Citrix Browser Content Redirection.
Fixed Multimedia redirection and HDX RealTime Media Engine may used concurrently.

OSC Installer

Fixed issue with failed partitioning.

RDP/IGEL RDP Client 2

Added a new parameter to control audio latency (in milliseconds) which defines the amount of 
buffered audio data in the RDP client.
More...

Registry rdp.winconnect.sound-latency

Value 125 (msec)

WVD

Improved overall sound quality.
Fixed issue caused audio redirection to fail randomly.
Clipboard redirection has potential privacy and security risks and is therefore disabled by 
default.
Fixed dead key support (key composition).
Fixed sound getting choppy after a while.
Several bugfixes for all kind of stability issues.

VMware Horizon

Fixed: Save VMWare Horizon user from last login when in appliance mode.
Reduced the options for "Preset login information" to either "from last login" or "from session 
setup". The redundant option "from appliance mode" is removed because the appliance mode is 
also treated as a session.
More...

IGEL Setup Sessions > Horizon Client > Horizon Client Global > 
Local Logon

Parameter Preset login information

Registry vmware.login.saveusertype

Range [Set user/domain from last login] [Set user/domain from 
session setup] 

Fixed Skype for Business integration.

Firefox
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Fixed switching off firmware feature PrinterLogic removes browser policies file.
Fixed hiding the URL input results in disappearing web content.
Fixed browser startscript which was waiting for a new window even when browser was not 
configured to open an extra one.

Network

Use e1000e driver out-of-the-kernel as default instead of the third-party driver.

Wi-Fi

Fixed connection problems by updating the regulatory domain database.
Improved persistence of Wi-Fi switch state across reboots.
Fixed problems with Wi-Fi backports driver and older Wi-Fi adapters or adapters with external 
kernel drivers.

Open VPN

Fixed timing in OpenVPN credential dialogs to prevent focus loss when started too early at 
system boot.
Fixed session management where VPN connections could get stuck when wrong passwords
were entered with no possibility of retry.

Imprivata

Hide the Imprivata session templates on the desktop as this is misleading.

Smartcard

Fixed smartcard reader VASCO/OneSpan Digipass 905. Disabled USB auto suspend for all smart 
card readers.
Added parameter to control the used smartcard protocol when connecting with raw and other 
protocols allowed. Enable to read smartcards using NHS Identity Agent.
More...

Parameter Avoid raw protocol

Registry scard.pcscd.avoid_raw_protocol

Value false / true  

Fixed use of IDPrime smartcards inside sessions with readers driven by Open Source CCID
smartcard reader driver: implemented attribute  SCARD_ATTR_CHANNEL_ID .
Added parameter to delay smartcard insertion events (in milliseconds). This solves issues 
reading smartcards within the Citrix Workspace App. Issue occured when inserting the card after 
already started StoreFront login.
More...

Parameter Delay smart card insertion event time

Registry scard.pcscd.card_insert_event_delay

Value 0
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Base system

Fixed NTP sync problem with some Windows Timeservers. 
New registry key:
More...

Parameter NTP max allowed distance

Tooltip Set this to a larger value can help to synchronize with 
unreliable NTP servers

Registry system.time.ntp_max_distance

Type Integer

Value 16 (new default 16 seconds instead of 3 before)

Added  _diag  kernel modules needed by Stratusphere IPS.
Fixed Next button usage in Setup Assistant while registering for an evaluation license.
Fixed issue with mounting USB devices in the Licensing tool.
If used as a master image, the image will expand itself to full size (limited to 16 GiB) on flash. 
This is done only on first boot and never again.
Possible rollout of initial settings, certificates, or licenses placed on the first partition.
The necessary steps are:

Writing image to USB or Flash medium
Mount or simply access the 1. VFAT partition which is present (should be empty)
Copying the modified  setup.ini  and/or **.lic  files to the 1st partition (no 
directories)
For copying certificates, a ca-certs  directory must be created where the desired 

certificates can be inserted. These will be copied to the /wfs/ca-certs  directory on 
first boot.
The USB/Flash medium can be copied several times as needed
With the initial boot, the device will reboot out of the splash screen (re-read 
changed partition table)
The settings, certificates and/or licenses will be deployed and also deleted from the 
1st partition.

Firmware update

Improve download speed for SFTP update sources.

Appliance Mode

Fixed RHEV/Spice appliance mode.

X11 system

Fixed displays not being automatically set up on boot.

Media Player (Parole)

Fixed handling of player latency (stream buffering).
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Hardware

Fixed non-working Prolific PL2303 USB-to-serial adapters.
Fixed non-working keyboard and touchpad on Microsoft Surface 3 Laptop.

IGEL Cloud Gateway

Handle UMS jobs intended to be executed on the next boot. This feature requires UMS 6.05.100 or 
later.
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IGEL OS Creator (OSC)

Supported Devices
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.

Component Versions 11.03.500 (see page 645)
New Features 11.03.500 (see page 647)
Resolved Issues 11.03.500 (see page 648)
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Component Versions 11.03.500
Clients
Product Version

Zulu JRE 8.44.0.11

Smartcard
Reader Driver MUSCLE CCID 1.4.31-1igel10

Resource Manager PC/SC Lite 1.8.23-1igel11

System Components
OpenSSL 1.0.2g-1ubuntu4.15

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.2.5-1igel93

VDPAU Library version 1.2-1igel911

Graphics Driver INTEL 2.99.917+git20191117-igel939

Graphics Driver ATI/RADEON 19.0.1-3igel936

Graphics Driver ATI/AMDGPU 19.0.1-5igel924

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 418.56-0ubuntu1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel975

Input Driver Elographics 1.4.1-1build5igel633

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.85 #mainline-lxos-r2875

Xorg X11 Server 1.20.5-1igel914
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Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2
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New Features 11.03.500
OSC Installer

Added Starter License functionality.
This license is now part of every new IGEL OS installation and is valid for 30 days. The license will 
be activated with the first boot after the initial installation. For more information, see https://
kb.igel.com/licensing.
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Resolved Issues 11.03.500
OSC Installer

Fixed issue with failed partitioning.
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Notes for Release 11.03.110
Software: Version 11.03.110

Release Date: 2020-01-15

Release Notes: Version RN-1103110-1

Last update: 2020-01-16

IGEL OS 11 (see page 650)
IGEL OS Creator (OSC) (see page 663)
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IGEL OS 11
See here the list of contained CA certificates:

Supported Devices 11.03.110 (see page 651)
Component Versions 11.03.110 (see page 652)
General Information 11.03.110 (see page 656)
Known Issues 11.03.110 (see page 657)
Security Fixes 11.03.110 (see page 660)
New Features 11.03.110 (see page 661)
Resolved Issues 11.03.110 (see page 662)
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Supported Devices 11.03.110
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.03.110
Clients
Product Version

Cisco JVDI Client 12.7.0

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Workspace App 18.10.0.11

Citrix Workspace App 19.10.0.15

Citrix Workspace App 19.12.0.19

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 12.5_x64_20190619_12.5.1.40008

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.6

FabulaTech USB for Remote Desktop 5.2.29

Firefox 68.4.1

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64
Qualification in progress

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.7.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.42.0.23

Parallels Client (64 bit) 17.0.21474

Spice GTK (Red Hat Virtualization) 0.37-1igel62

Remote Viewer (Red Hat Virtualization) 8.0-1igel49

Usbredir (Red Hat Virtualization) 0.8.0-1+b1igel71
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Teradici PCoIP Software Client 19.05.9-18.04

ThinLinc Client 4.10.1-6197

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VNC Viewer 1.9.0+dfsg-3igel8

VMware Horizon Client 5.2.0-14604769

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech driver 12.8.5

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.3.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library OpenSC 0.19.0-2igel35

PKCS#11 Library SecMaker NetID 6.8.1.31

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0
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Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.31-1igel6

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel9

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.2.5-1igel93

VAAPI ABI Version 0.40

VDPAU Library version 1.2-1igel911

Graphics Driver INTEL 2.99.917+git20191117-igel939

Graphics Driver ATI/RADEON 19.0.1-3igel936

Graphics Driver ATI/AMDGPU 19.0.1-5igel924

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 418.56-0ubuntu1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814
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Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.85 #mainline-lxos-r2872

Xorg X11 Server 1.20.5-1igel914

Xorg Xephyr 1.20.5-1igel914

CUPS printing daemon 2.1.3-4ubuntu0.10igel29

PrinterLogic 25.1.0.303

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.1-1igel222

WebKit2Gtk 2.26.2-1igel27

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.23-2igel2

VPN OpenConnect 7.08-1

Scanner support / Sane 1.0.27-1

VirtualBox 6.0.14-dfsg-1igel33
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General Information 11.03.110

The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver

Firmware downgrade to older versions (11.01 or 11.02) is not possible, due to the unsigned firmware 
update files.


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Known Issues 11.03.110
Firefox

Firefox IGEL extensions are not updated automatically under some circumstances. After an 
update from 11.03.10x to 11.03.110, the IGEL extensions will stay on the old version. 
In this case, the following settings concerning kiosk mode cannot be executed:

Switch off Hotkey for new window/tab
Blocking of internal browser pages like preferences, file picker, specific local directories

As a workaround:

a reset to defaults should be performed
or the browser's mimetype template can be switched from "Standard" to "Minimal" by 
registry key browserglobal.app.mimetypes_template . There, the browser profile is 
renewed as well.
After the TC got the new setting, reboot and set the mimetypes_template  registry key back 
to "Standard".

Citrix

With activated DRI3 and an AMD GPU Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1 and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of login. 
Workaround: Insert the smartcard before starting the StoreFront login.
Citrix H.264 acceleration plugin does not work if server policy Optimize for 3D graphics 
workload is enabled together with server policy Use video codec compression > For the entire 
screen.
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin 
a registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery group.

Multimedia redirection isn't working if "HDX RealTime Media Engine" is enabled at the same 
time. 
Workaround: Switch off HDX RealTime Media Engine.
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More...

IGEL Setup Sessions > Citrix > Citrix Global > HDX Multimedia

Sessions > Citrix > Citrix Global > Unified Communications > Skype for 
Business

Parameter HDX RealTime Media Engine

Registry ica.module.virtualdriver.hdxrtme.enable

Value enabled / disabled

With Citrix Workspace App 19.10.0 or 19.8.0 the session sometimes freezes while session logoff 
from a published desktop:
Workaround: Use CWA 18.10.0.
More...

IGEL Setup Sessions > Citrix > Citrix Global > Citrix Client Selection

Parameter Citrix client version

Registry ica.activeversion

Range Default (19.10.0) / 18.10.0 / 19.8.0 / 19.10.0

VMware Horizon

After disconnect of an RDP based session, the Horizon main window which contains the server 
or sessions overview cannot be resized anymore.
Seamless application windows in Horizon Client may not be displayed correctly.  When 
starting the first seamless app a new iconified window appears in the taskbar and only if you click 
on it the application will show up.
Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore Horizon Client relies on the OS to mount the storage devices itself. 
Enable local `Storage Hotplug` on setup page Devices > Storage Devices > Storage 
Hotplug.

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.

Wi-Fi
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TP-Link Archer T2UH Wi-Fi adapters does not work after system suspend/resume. Workaround: 
Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Parallels Client

Native USB redirection does not work with Parallels Client.

Smartcard

In seldom cases the authentication hung when using A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Audio

Audio jack detection on Advantech POC-W243L doesn't work. Sound output goes through the 
headset connection and the internal speakers.
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.

VirtualBox

The current VirtualBox Guest Tools/Drivers will not work with VirtualBox 5.2.x or older hosts 
which leads to black screen and non working graphic. 
Workaround: Install with 'Failsafe Installation + Recovery' and set registry key 
x.drivers.force_vesa  to true.

When running in VirtualBox virtualization, resizing the window will not automatically change 
desktop resolution of IGEL OS guest.

Hardware

HP t730 could freeze when monitors with different resolutions are connected (1920x1200 + 
2560x1440 + 3840x1600 for example). When this occors, the registry key 

x.drivers.kms.best_console_mode  has to be set to disabled.
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work with INTEL devices.
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Security Fixes 11.03.110
Firefox

Updated Mozilla Firefox to 68.4.1esr.
Fix for mfsa2020-03, also known as CVE-2019-17026.
Fixes for mfsa2020-02, also known as: CVE-2019-17016, CVE-2019-17017, CVE-2019-17022, and 
CVE-2019-17024.
Fixes for mfsa2019-37, also known as:
More...

CVE-2019-17008, CVE-2019-11745, CVE-2019-17010,
CVE-2019-17005, CVE-2019-17011, and CVE-2019-17012.
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New Features 11.03.110
Citrix

Integrated Citrix Workspace App 19.12
Available Citrix Workspace Apps in this release: 19.12 (default), 19.10, and 18.10
New registry keys:

Added a registry key for enabling full-screen banner "Citrix Desktop Viewer" when 
starting a Desktop or Application session.
More...

Parameter Show Citrix Desktop Viewer screen

Registry ica.module.cdviewerscreen

Value off / on

Added a registry key to enable usage of Chromium Embedded Framework (CEF) for 
Browser Content Redirection (BCR) [Experimental].
More...

Parameter Use Chromium Embedded Framework (CEF)

Registry ica.allregions.usecefbrowser

Value factory default / false / true

"factory default" means that can be set by config file.
Changed default:
More...

Parameter VDTUI protocol

Registry ica.module.virtualdriver.vdtui.enab

le

Value off / on
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Resolved Issues 11.03.110
OSC Installer

Fixed deployment of IGEL OS with IGEL Deployment Appliance.

Firefox

Fixed possibility to remove the browser's navigation bar. In 11.03.100, the whole browser 
content was invisible without the navigation bar.

Wi-Fi

Fixed support for some newer Wi-Fi chipsets.
Fixed Wi-Fi backport driver instability problems with updating them to 5.4-rc8-1.

Imprivata

Fixed race condition that may lead to unexpected behavior with RDP connections.
Fixed VMware Horizon session disconnect.

Smartcard

Fixed bug in smartcard transaction locking.

Cisco JVDI Client

The Cisco EULA must be accepted together with the IGEL EULA before installing IGEL OS and also 
within IGEL Setup Assistant when requesting an IGEL OS demo license.

Base system

Fixed potential temporary settings loss when resuming from standby.

RDP/IGEL RDP Client 2

Fixed Fabulatech Scanner Redirection not working for RDP Remote Apps.
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IGEL OS Creator (OSC)

Supported Devices
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.

Component Versions 11.03.110 (see page 664)
Resolved Issues 11.03.110 (see page 666)
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Component Versions 11.03.110
Clients
Product Version

Zulu JRE 8.42.0.23

Smartcard
Reader Driver MUSCLE CCID 1.4.31-1igel6

Resource Manager PC/SC Lite 1.8.23-1igel9

System Components
OpenSSL 1.0.2g-1ubuntu4.15

Bluetooth Stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.2.5-1igel93

VDPAU Library version 1.2-1igel911

Graphics Driver INTEL 2.99.917+git20191117-igel939

Graphics Driver ATI/RADEON 19.0.1-3igel936

Graphics Driver ATI/AMDGPU 19.0.1-5igel924

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 418.56-0ubuntu1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.85 #mainline-lxos-r2872
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Xorg X11 Server 1.20.5-1igel914

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

WebKit2Gtk 2.26.2-1igel27

Python2 2.7.12

Python3 3.5.2
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Resolved Issues 11.03.110
OSC Installer

Fixed deployment of IGEL OS with IGEL Deployment Appliance.
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Notes for Release 11.03.100
Software: Version 11.03.100

Release Date: 2019-12-10

Release Notes: Version RN-1103100-1

Last update: 2019-12-06

IGEL OS 11 (see page 668)
IGEL OS Creator (OSC) (see page 704)
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IGEL OS 11
See here the list of contained CA certificates:

Supported Devices 11.03.100 (see page 669)
Component Versions 11.03.100 (see page 670)
General Information 11.03.100 (see page 674)
Security Fixes 11.03.100 (see page 675)
Known Issues 11.03.100 (see page 678)
New Features 11.03.100 (see page 681)
Resolved Issues 11.03.100 (see page 691)
CA Certificates Contained in IGEL OS 11.03 (see page 694)
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Supported Devices 11.03.100
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.03.100
Clients
Product Version

Cisco JVDI Client 12.7.0

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Workspace App 18.10.0.11

Citrix Workspace App 19.10.0.15

Citrix Workspace App 19.8.0.20

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 12.5_x64_20190619_12.5.1.40008

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.6

FabulaTech USB for Remote Desktop 5.2.29

Firefox 68.2.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.7.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.42.0.23

Parallels Client (64 bit) 17.0.21474

Spice GTK (Red Hat Virtualization) 0.37-1igel62

Remote Viewer (Red Hat Virtualization) 8.0-1igel49

Usbredir (Red Hat Virtualization) 0.8.0-1igel49
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Teradici PCoIP Software Client 19.05.9-18.04

ThinLinc Client 4.10.1-6197

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VNC Viewer 1.9.0+dfsg-3igel8

VMware Horizon Client 5.2.0-14604769

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech driver 12.8.5

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.3.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library OpenSC 0.19.0-2igel35

PKCS#11 Library SecMaker NetID 6.8.1.31

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0
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Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.31-1igel6

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel8

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.2.5-1igel93

VAAPI ABI Version 0.40

VDPAU Library version 1.2-1igel911

Graphics Driver INTEL 2.99.917+git20191117-igel939

Graphics Driver ATI/RADEON 19.0.1-3igel936

Graphics Driver ATI/AMDGPU 19.0.1-5igel924

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 418.56-0ubuntu1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814
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Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.85 #mainline-lxos-r2872

Xorg X11 Server 1.20.5-1igel914

Xorg Xephyr 1.20.5-1igel914

CUPS printing daemon 2.1.3-4ubuntu0.10igel29

PrinterLogic 25.1.0.303

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.1-1igel222

WebKit2Gtk 2.26.2-1igel27

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.23-2igel2

VPN OpenConnect 7.08-1

Scanner support / Sane 1.0.27-1

VirtualBox 6.0.14-dfsg-1igel33
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General Information 11.03.100

The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver

Firmware downgrade to older versions (11.01 or 11.02) is not possible, due to the unsigned firmware 
update files.


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Security Fixes 11.03.100
Firefox

Updated Mozilla Firefox to 68.2.0esr
Fixes for mfsa2019-33.
More...

CVE-2019-15903, CVE-2019-11757, CVE-2019-11758, CVE-2019-11759,

CVE-2019-11760, CVE-2019-11761, CVE-2019-11762, CVE-2019-11763,

CVE-2019-11764.

Fixes for mfsa2019-26.
More...

CVE-2019-11746, CVE-2019-11744, CVE-2019-11742, CVE-2019-11752,

CVE-2019-9812, CVE-2019-11743, CVE-2019-11748, CVE-2019-11749,

CVE-2019-11750, CVE-2019-11738, CVE-2019-11747, CVE-2019-11735,

CVE-2019-11740.

Base system

Added cryptographic signatures to OS 11 firmware files to prevent reading from corrupt images 
or disks.

Updates to firmwares without valid signatures are blocked.
When a signature error on the system partition is detected, the system is halted 
immediately. For system recovery a reinstallation via the OS Creator tool (OSC) is required. 
A signature error during early boot is signalized by a beep sequence.
When a signature error in another partition is detected the partition is removed and a 
firmware update is triggered to reinstall the corrupt partition.
Added user visible notification about partition signature errors.

Fixed admin logout from rescue shell after suspend.
Fixed security issue CVE-2019-15902 in 4.19.x kernel.
Updated Intel microcodes to version 20191115 to fix various security issues (CVE-2019-11135, 
CVE-2019-0117 and CVE-2019-11139).
Fixed cups security issues CVE-2019-8696, CVE-2019-8675 and CVE-2019-86.
Fixed openjpeg2 security issues CVE-2018-6616, CVE-2018-5785, CVE-2018-18088, CVE-2018-14423 
and CVE-2017-17480.
Fixed xorg-server security issue CVE-2018-14665.
Fixed expat security issue CVE-2019-15903.
Fixed freetype security issue CVE-2015-9383.
Fixed ghostscript security issues. 
More...

CVE-2019-14817, CVE-2019-14813, CVE-2019-14812,

CVE-2019-14811, CVE-2019-10216 and CVE-2019-14869.

Fixed python2.7 security issues. 
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More...

CVE-2019-9948, CVE-2019-9947, CVE-2019-9740, CVE-2019-9636,

CVE-2019-5010, CVE-2019-10160 , CVE-2018-20852, CVE-2019-16935 and CVE-2019-16056.

Fixed python3.5 security issues. 
More...

CVE-2019-9948, CVE-2019-9947, CVE-2019-9740, CVE-2019-9636,

CVE-2019-5010, CVE-2019-10160, CVE-2018-20852, CVE-2018-20406, CVE-2019-16935 and CVE-2019-16056.

Fixed giflib security issues CVE-2019-15133 and CVE-2018-11490.
Fixed libvirt security issues. 
More...

CVE-2019-3886, CVE-2019-11091, CVE-2019-10168, CVE-2019-10167,

CVE-2019-10166, CVE-2019-10161, CVE-2019-10132, CVE-2018-6764,

CVE-2018-5748, CVE-2018-12130, CVE-2018-12127, CVE-2018-12126,

CVE-2018-1064, CVE-2017-2635, CVE-2017-1000256 and CVE-2016-5008.

Fixed e2fsprogs security issue CVE-2019-5094.
Fixed rpcbind security issues CVE-2017-8779 and CVE-2015-7236.
Fixed wpa security issues CVE-2019-16275 and CVE-2019-13377.
Fixed tiff security issues CVE-2019-17546 and CVE-2019-14973.
Fixed aspell security issue CVE-2019-17544.
Fixed libsdl1.2 security issues. 
More...

CVE-2019-7638, CVE-2019-7637, CVE-2019-7636,

CVE-2019-7635, CVE-2019-7578, CVE-2019-7577,

CVE-2019-7576, CVE-2019-7575, CVE-2019-7574,

CVE-2019-7573, CVE-2019-7572 and CVE-2019-13616.

Fixed libsoup2.4 security issues CVE-2019-17266, CVE-2018-12910 and CVE-2017-2885.
Fixed rtlwifi driver security issue CVE-2019-17666 .
Fixed libxslt security issues CVE-2019-18197, CVE-2019-13118 and CVE-2019-13117.
Fixed opus security issue CVE-2017-0381.
Fixed curl security issues CVE-2019-5482 and CVE-2019-5481.
Fixed libidn2 security issues CVE-2019-18224 and CVE-2019-12290.
Fixed libarchive security issue CVE-2019-18408.
Fixed samba security issues CVE-2019-14847 and CVE-2019-10218.
Fixed file security issue CVE-2019-18218.
Fixed imagemagick security issues. 
More...

CVE-2019-16713, CVE-2019-16711, CVE-2019-16710, CVE-2019-16709,

CVE-2019-16708, CVE-2019-15140, CVE-2019-15139,

CVE-2019-14981, CVE-2019-13454, CVE-2019-13391, 
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CVE-2019-13311, CVE-2019-13310, CVE-2019-13309, CVE-2019-13307,

CVE-2019-13306, CVE-2019-13305, CVE-2019-13304, CVE-2019-13301,

CVE-2019-13300, CVE-2019-13297, CVE-2019-13295, CVE-2019-13137,

CVE-2019-13135, CVE-2019-12979, CVE-2019-12978, CVE-2019-12977,

CVE-2019-12976, CVE-2019-12975 and CVE-2019-12974.

Fixed libjpeg-turbo security issues CVE-2019-2201, CVE-2018-20330 and CVE-2018-19664.
Fixed python-ecdsa security issues CVE-2019-14859, CVE-2019-14853 and CVE-2019-1485.
Restricted access to journalctl log file for root only.
Limit list of allowed TLS ciphers according to the Germany BSI recommendation (TR-0210202 
Version 2019-01). The functionality is controlled by a parameter. 
More...

Registry system.security.remote_management.tls_policy

Value Default / BSI

The limited cipher list is applied on TLS (SSL) connections in:

IGEL RM Agent
Secure Shadowing
Secure Terminal
Firmware Update
Custom Partition
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Known Issues 11.03.100
Citrix

With activated DRI3 and an AMD GPU Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1 and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of login. 
Workaround: Insert the smartcard before starting the StoreFront login.
Citrix H.264 acceleration plugin does not work if server policy Optimize for 3D graphics 
workload is enabled together with server policy Use video codec compression > For the entire 
screen.
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin 
a registry key must be enabled. 
More...

Parameter Activate workaround for dual RTME sessions and H264 acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery group.

Multimedia redirection isn't working if "HDX RealTime Media Engine" is enabled at the same 
time. 
Workaround: Switch off HDX RealTime Media Engine.
More...

IGEL Setup Sessions > Citrix > Citrix Global > HDX Multimedia

Sessions > Citrix > Citrix Global > Unified Communications > Skype for 
Business

Parameter HDX RealTime Media Engine

Registry ica.module.virtualdriver.hdxrtme.enable

Value enabled / disabled

With Citrix Workspace App 19.10.0 or 19.8.0 the session sometimes freezes while session logoff 
from a published desktop. :
Workaround: Use CWA 18.10.0.
More...
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IGEL Setup Sessions > Citrix > Citrix Global > Citrix Client Selection

Parameter Citrix client version

Registry ica.activeversion

Range Default (19.10.0) / 18.10.0 / 19.8.0 / 19.10.0

VMware Horizon

After disconnect of an RDP based session, the Horizon main window which contains the server 
or sessions overview cannot be resized anymore.
Seamless application windows in Horizon Client may not be displayed correctly.  When 
starting the first seamless app a new iconified window appears in the  taskbar and only if you click 
on it the application will show up.
Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore Horizon Client relies on the OS to mount the storage devices itself. 
Enable local `Storage Hotplug` on setup page Devices > Storage Devices > Storage 
Hotplug.

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.

WiFi

TP-Link Archer T2UH WiFi adapters does not work after system suspend/resume. Workaround: 
Disable system suspend at IGEL Setup > System > Power Options > Shutdown.

Parallels Client

Native USB redirection does not work with Parallels Client.

Smartcard

In seldom cases the authentication hung when using A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.
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Audio

Audio jack detection on Advantec POC-W243L doesn't work. Sound output goes through the 
headset connection and the internal speakers.
IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.

VirtualBox

The current VirtualBox Guest Tools/Drivers will not work with VirtualBox 5.2.x or older hosts 
which leads to black screen and non working graphic. 
Workaround: Install with 'Failsafe Installation + Recovery' and set registry key 
x.drivers.force_vesa  to true.

When running in VirtualBox virtualization, resizing the window will not automatically change 
desktop resolution of IGEL OS guest.

Hardware

HP t730 could freeze when monitors with different resolutions are connected (1920x1200 + 
2560x1440 + 3840x1600 for example). When this occors, the registry key 

x.drivers.kms.best_console_mode  has to be set to disabled.
Some newer Delock 62599 active DisplayPort to DVI (4k) adapters only work with INTEL devices.
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New Features 11.03.100
 Citrix

Integrated Citrix Workspace app 19.10
Available Citrix Workspace apps in this release: 19.10 (default), 19.08 and 18.10
Added a registry key to enable Transparent User Interface [TUI] Virtual Channel [VC] protocol.
More...

Parameter Enable VDTUI protocol

Registry ica.module.virtualdriver.vdtui.enable

Value enabled / disabled

Updated libwebkit2gtk-4.0-37 to version 2.26.2. It is now possible to enable debug output for 
Citrix Browser Content Redirection by running the script /config/bin/install-webkit-

debug . The debug output is written to /var/log/user/webcontainer.debug .

Added support for FabulaTech Scanner for Remote Desktop.
More...

IGEL Setup Sessions > Citrix > Citrix Global > Fabulatech Scanner Redirection 

Parameter Fabulatech Scanner for Remote Desktop

Registry ica.module.virtualdriver.fabulatech_scanner.ena

ble

Value enabled / disabled

RDP/IGEL RDP Client 2

Added support for FabulaTech Scanner for Remote Desktop.
More...

IGEL Setup Sessions > RDP > RDP Global > Fabulatech Scanner Redirection 

Parameter Fabulatech Scanner for Remote Desktop

Registry rdp.fabulatech_scanner.enable

Value enabled / disabled

VMware Horizon

Updated Horizon Client to version 5.2.0-14604769.

Only short sessions with enabled debug output can be tracked, due to the huge amount of 
debugging data which is written to the log file.


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Added local scanner redirection for VMWare Horizon Client.
More...

Parameter Scanner Redirection

Registry vmware.view.enable-scanner-redir

Value enabled / disabled

Added support for FabulaTech Scanner for Remote Desktop.
More...

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Fabulatech Scanner 
Redirection 

Parameter Fabulatech Scanner for Remote Desktop

Registry vmware.view.usb.enable-fabulatech-scanner

Value enabled / disabled

ThinLinc

Updated ThinLinc Client to version 4.10.1.

Parallels Client

Updated Parallels Client to Version 17.0.1 .
For using the FIPS 140-2 compliance mode no special handling is needed anymore.

Teradici PCoIP Client

Updated Teradici PCoIP client to 19.05.9.

Imprivata

Added: When available flash is bigger than 2GB, 500 MB will be used for the Imprivata data 
partition.

Cisco JVDI Client

Integrated new Cisco Jabber Softphone for VDI (Cisco JVDI Client) version 12.7 in 64bit.
More...

IGEL Setup Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Unified 
Communications > Cisco Jabber 

Parameter Cisco JVDI client

Registry ica.module.virtualdriver.vdcisco.enable

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Global > Unified Communications > 
Cisco Jabber
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Parameter Cisco JVDI client

Registry vmware.view.vdcisco.enable

Value enabled / disabled

> Registry path for Common JVDI options: multimedia.ciscovxme.**

Logging

Added Elastic FIlebeat 7.3.0. This is a lightweight way to forward and centralize logs and files. 
There are new registry keys to enable and configure Elastic FIlebeat. 
More...

IGEL Setup System > Firmware Customization > Features

Parameter Elastic Filebeat

Registry services.elastic_filebeat.enabled

Value enabled / disabled

Parameter Use custom configuration

Registry network.filebeat.custom.enabled

Value enabled / disabled

Parameter Custom Configuration

Registry network.filebeat.custom.config

Value filebeat.inputs: ...

Base system

Added support for exFAT filesystem.
Updated Kernel to version 4.19.85 with WiFi backport drivers 5.3.6.1.
Updated Intel microcodes to version 20191115 to fix various security issues (CVE-2019-11135, 
CVE-2019-0117 and CVE-2019-11139).
Updated Xorg Xserver from version 1.19.6 to 1.20.5.
Updated Mesa OpenGL stack from version 19.0.8 to 19.2.5.
Updated the X11 video and input drivers to their most current available versions.
Added functionality to enable or disable touchpad with a hotkey.
More...

IGEL Setup User Interface > Input > Touchpad  

Parameter Enable Touchpad

Registry userinterface.touchpad.general.touchpadenable
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Value enabled / disabled

IGEL Setup User Interface > Input > Touchpad  

Parameter Hotkey

Registry userinterface.touchpad.general.usehotkey

Value enabled / disabled

IGEL Setup User Interface > Input > Touchpad  

Parameter Modifiers

Registry userinterface.touchpad.general.hotkeymodifier

IGEL Setup User Interface > Input > Touchpad  

Parameter Hotkey

Registry userinterface.touchpad.general.hotkey

 Added feature to log into different files and to store log files on a persistent encrypted 
partition.
More...

IGEL Setup System > Logging 

Parameter Local logging

Registry system.syslog.enabled

Value enabled / disabled

IGEL Setup System > Logging 

Parameter Use persistent log partition

Registry system.syslog.persistent

Value enabled / disabled

IGEL Setup System > Logging 

Parameter Partition size in MB

Registry system.syslog.partsize

Value 100

Create /var/log/auth.log:
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Registry system.syslog.sinks.auth

Value enabled / disabled

Create /var/log/daemon.log:

Registry system.syslog.sinks.daemon

Value enabled / disabled

Create /var/log/kern.log:

Registry system.syslog.sinks.kern

Value enabled / disabled

Create /var/log/syslog:

Registry system.syslog.sinks.syslog

Value enabled / disabled

Updated Fluendo multimedia codecs to the following versions:

gst-fluendo-h264dec - 18/09/2019 0.10.54

gst-fluendo-vadec - 16/10/2019 0.10.210

Added beep sequence to signalize a missing system partition during early boot.

CUPS Printing

Updated Printer Installer client to version 25.1.0.303.
Added missing cups model names for some printers.

Smartcard

Updated MUSCLE Open Source CCID driver to version 1.4.31. Added additional smartcard reader 
Cherry SECURE BOARD.
Updated SecMaker Net iD smartcard library to version 6.8.1.31. The changes are:

Support for Gemalto IDPrime 940 and 3940.
Support for new VRK card (IDEMIA IAS ECC, spec: FINEID S1 - FINEID S1 Electronic ID 
Application v4.0).
Support for Aventra MyEID v4.0 (customer specific card profile with read support only).
Fixed problem with detection of cards in Net iD Card Portal.
Other fixes, see release notes at SecMaker24.

WiFi

Added backports kernel drivers with version 5.3.6-1 for better WiFi support.

https://service.secmaker.com/releasenotes/
https://service.secmaker.com/releasenotes/


Notes for Release 11.03.100

IGEL OS Release Notes   686 / 1492

•
•

•

•
•

Disabled backports drivers for Microsoft Surface Laptop 3.
Added new registry key to enable or disable the use of the backport drivers (reboot is needed).
More...

Parameter Use the newer backport drivers for WiFi

Registry network.drivers.use_backport_drivers

Range Default (normally use backport drivers) / False / True 

Added switch for more aggressively search of configured hidden WiFi networks.
More...

Parameter Force connection to hidden network

Registry network.interfaces.wirelesslan.device0.mssid_fo

rce_hidden

Value never / once / continuously

The default value never preserves the old behaviour.

Changing can be useful in situations where the system cannot detect any configured WiFi in the 
environment. If once is selected, the system will blindly try to connect to all configured hidden networks 
once (until the network as a whole gets started again). In the case of continuously, it will continue trying to 
connect to hidden networks.

Remarks: An access point found in this way will be remembered next time and its reconnecting will be 
faster.  Search for hidden networks in the Wireless Manager is not affected.

Driver

Updated Philips Speech Driver to version 12.8.5.
Added login with BioSec BS Login Hand Vein Recognition software. The parameters have to be 
set in IGEL Setup Registry.
More...

Parameter Login with Biosec BS Login

Registry auth.login.biosec_bslogin

Value enabled / disabled

Parameter URL of LifePassServer

Registry auth.biosec.lifepassserverurl

Value localhost:10100

IGEL Setup System > Firmware Customization > Features

Parameter Biosec BS Login
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Registry services.biosec_bslogin.enabled

Value enabled / disabled

Added Broadcom Tigon3 network driver.

X11 system

Added support for secure keyboard input with Cherry SECURE BOARD 1.0. 
In secure mode all keyboard input devices are suppressed except pre-personalized Cherry SECURE 
BOARD 1.0 devices. For the encrypted communication certificates and keys in directories /wfs/

cherry/ca-certs  and /wfs/cherry/client-certs  are required.     
More...

IGEL Setup User Interface > Input > Keyboard

Parameter Secure keyboard input with Cherry SECURE BOARD

Registry devices.cherry_secureboard.enable

Value enabled / disabled

Parameter Debug messages for Cherry SECURE BOARD

Registry devices.cherry_secureboard.debug

Value enabled / disabled

Added the possibility to configure the screen brightness with registry keys.
More...

Parameter Brightness value

Registry x.xserver0.brightness

x.xserver0.screen[1-7].brightness

Range 0.1 - 1.0 (darker)

1.0 - 3.0 (brighter)

Added new registry keys to be able to configure some modesetting graphics driver options if 
needed.  
More...

Parameter Use DRI3 PageFlip feature

Registry x.drivers.modesetting.use_page_flip

Range Default (normally use page flip feature) / disabled / enabled



Notes for Release 11.03.100

IGEL OS Release Notes   688 / 1492

•

Parameter Use shadow framebuffer layer

Registry x.drivers.modesetting.use_shadow_fb

Range Default (normally use shadow framebuffer) / disabled / enabled

Parameter Use double shadow framebuffer to improve VNC performance

Registry x.drivers.modesetting.use_double_shadow

Range disabled / enabled

Parameter Use software cursor for modesetting driver

Registry x.drivers.modesetting.use_sw_cursor

Range Default (normally disabled)

Parameter Choose acceleration method

Registry x.drivers.modesetting.accel_method

Range Default (normally Glamor is used) / Glamor / None

Parameter Force usage of DRI3 regardless of x.drivers.use_dri3 setting

Registry x.drivers.modesetting.force_dri3

Range disabled / enabled

Misc

Added support for Stratusphere UX from Liquidware.
More...

IGEL Setup Accessories > Connector ID Key Software

Parameter Enable Stratusphere UX CID Key

Registry stratusphere_ux.cid_key_software.enable

IGEL Setup Accessories > Connector ID Key Software

Parameter Stratusphere hub

Registry stratusphere_ux.cid_key_software.hub

IGEL Setup Accessories > Connector ID Key Software

Parameter Stratusphere machine group
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Registry stratusphere_ux.cid_key_software.machine_group

IGEL Setup Accessories > Connector ID Key Software

Parameter Stratusphere user group

Registry stratusphere_ux.cid_key_software.user_group

Added the launcher of Login VSI's monitoring tool Login PI to the IGEL OS which can be configured 
from setup via parameters and started from the UMS.
Besides of specifying the parameters given below, a SSL certificate must be provided and 
deployed via the UMS. This has to be obtained from the Login PI server manually. Given the 
parameters and the certificate, the launcher can be started via job from the UMS.
More...

IGEL Setup Accessories > Login PI

Parameter Server URL

Registry debug.tools.login_pi.server_url

IGEL Setup Accessories > Login PI

Parameter Secret

Registry debug.tools.login_pi.crypt_password

Hardware

Added recognition for IGEL UD2 M250C with 8 GB eMMC with product id UD2-LX 51.
Added support for IGEL UD3 M350C with product id UD3-LX 60.
UD7 with active AMD Secure Processor feature uses new product id UD7-LX 11.
Improved support for ADS-Tec VMT9000 devices:

Enable rs-232 additional power supply without restart.
Enable external wifi antenna without restart.
Enable shutdown by ignition off.
Enable watchdog service.

Added hardware support for LG CL600N.
Added hardware support for LG CL600W.
Added new registry keys to be able to configure some new i915 parameter. 
More...

Parameter Disable the use of limited color range for DisplayPort 1

Registry x.drivers.intel.dp1_no_limited_color_range

Range Default / disabled / enabled

Info: Only for M250C the use of limited color range for DP1 is disabled.
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• Added support for newer Prolific PL2303 USB serial adapters (used in UD3-LX 60).
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Resolved Issues 11.03.100
Citrix

Fixed video playback with enabled Citrix Browser Content Redirection.

RDP/IGEL RDP Client 2

Fixed RDP graphics issues with Windows 2008(R2) Server (when RemoteFX is not enabled).
Fixed RDP Web Access Domain Visibility not working correctly.
Fixed sound glitch while using PulseAudio system. PulseAudio is now the default sound driver.

VMware Horizon

Fixed sound issue in Horizon client 5.x using PCoIP protocol.

Firefox

Fixed: Homepage cannot be set
Fixed: RTSP media stream with enabled apparmor.

Network

Fixed issue with configuration of more then one NTP server.
Fixed network interface device order for Dell Wyse 5070 Thin Client so that the onboard interface 
always is the first one.

Changed minimal allowed MSS size to 750 to avoid problems with some VPN solutions.
Added new registry keys to be able to configure the minimal allowed TCP MSS size. 
More...

Parameter Minimal TCP send MSS size

Registry system.sysctl.tcp_min_snd_mss

Range 750

Smartcard

Fixed not working 90meter in Firefox when apparmor is enabled.
Fixed handling of smartcards in pcsc-lite: Improved transaction locking. A new parameter was 
introduced to control the new behavior (enabled by default).
More...

Parameter Abort stalled transactions

Registry scard.pcscd.abort_stalled_transactions

Range enabled / disabled

Fixed bug in smartcard transaction locking.

When endpoint is updated from a previous firmware version, network interface device order might 
change


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Fixed IGEL Smartcard to be able to handle VoIP client Ekiga sessions.
Fixed smartcard usernames displayed on login screen: non-ASCII characters were not shown 
correctly before.
Fixed error message on login screen, shown when smart card PIN is locked.

Base system

Fixed license handling: Add-on licenses can be used on top of Workspace Edition evaluation 
licenses now.
Fixed warnings when evaluation license is about to expire. In detail, removed warning when 
Enterprise Management Pack is about to expire and WE is already licensed.
Fixed ActiveDirectory/Kerberos password change with Change Password accessory for users 
which are member of many (~300+) AD groups.
Fixed IGEL License retrieval via FTP protocol in IGEL Setup Assistant and Licenses Browser 
tool.
Fixed bug in reboot message where not all available translations were used.
Fixed problems with missing library if using OpenConnect feature.
Changed: Bluetooth is off by default again. It wiil be temporary enabled for auto pairing before 
the initial Setup Assistant runs. Only if a device is paired during this phase, Bluetooth is enabled 
afterwards. To enable Bluetooth support by configuration use this parameter: 
More...

IGEL Setup Devices > Bluetooth  

Parameter Bluetooth

Registry devices.bluetooth.enable

Value enabled / disabled

Fixed license information of Add-On licenses in category evaluation.
Re-fixed broken custom bootsplash when doing a reset to factory defaults via UMS.

Custom Partition

Automatic constrain of minimum size for custom partition to 5MB.

Firmware update

Automatic firmware update is now checked after retrieval of UMS settings.
If there are some not executed changes in the network configuration, these changes are applied 
automatically before performing firmware update.

Storage Devices

Fixed bug: udiskd mounted storage devices on behalf of user processes (e.g. parole) even if 
Storage Hotplug was disabled in the setup.

X11 system

Fixed issue with Wacom Signing Pads not being recognized as displays.
Solved issues with certain monitors on UD2 LX50.
Fixed Multi-GPU NVIDIA setups with Display Switch.
Prevent configuration of Display Switch utility on unlicensed device.
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Fixed an issue with modesetting driver and DisplayLink USB graphic adapters.

X server

Fixed Xorg freezes when usage of modesetting driver and video acceleration.

Shared Workplace

Fixed broken Shared Workplace authentication when ICG is used.

Hardware

Fixed EFI freeze problem after bootcode update on devices like the HP t630 and probably others 
too.
Added: Bluetooth tool shows now a message when no device is connected.
Fixed issue with limited colors on the DisplayPort 1 of UD2-LX50.

Remote Management

Fixed automatic registering in the UMS using DNS entry or DHCP tag during initial rollout.

IGEL Cloud Gateway

Fixed search for an available buddy update server when devices are managed over ICG.

VNC

Fixed sporadic connection failure in VNC server.
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CA Certificates Contained in IGEL OS 11.03
IGEL OS 11.03 contains the following CA certificates:

Certificate name Expiry date File in /etc/ssl/certs

ACCVRAIZ1 Dec 31 09:37:37 
2030 GMT

ACCVRAIZ1.crt

AC RAIZ FNMT-RCM Jan 1 00:00:00 
2030 GMT

AC_RAIZ_FNMT-RCM.crt

Actalis Authentication Root CA Sep 22 11:22:02 
2030 GMT

Actalis_Authentication_Root_CA.

crt

AddTrust External CA Root May 30 10:48:38 
2020 GMT

AddTrust_External_Root.crt

AffirmTrust Commercial Dec 31 14:06:06 
2030 GMT

AffirmTrust_Commercial.crt

AffirmTrust Networking Dec 31 14:08:24 
2030 GMT

AffirmTrust_Networking.crt

AffirmTrust Premium Dec 31 14:10:36 
2040 GMT

AffirmTrust_Premium.crt

AffirmTrust Premium ECC Dec 31 14:20:24 
2040 GMT

AffirmTrust_Premium_ECC.crt

Amazon Root CA 1 Jan 17 00:00:00 
2038 GMT

Amazon_Root_CA_1.crt

Amazon Root CA 2 May 26 00:00:00 
2040 GMT

Amazon_Root_CA_2.crt

Amazon Root CA 3 May 26 00:00:00 
2040 GMT

Amazon_Root_CA_3.crt

Amazon Root CA 4 May 26 00:00:00 
2040 GMT

Amazon_Root_CA_4.crt

Atos TrustedRoot 2011 Dec 31 23:59:59 
2030 GMT

Atos_TrustedRoot_2011.crt

Autoridad de Certificacion 
Firmaprofesional CIF A62634068

Dec 31 08:38:15 
2030 GMT

Autoridad_de_Certificacion_Firm

aprofesional_CIF_A62634068.crt
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Certificate name Expiry date File in /etc/ssl/certs

Baltimore CyberTrust Root May 12 23:59:00 
2025 GMT

Baltimore_CyberTrust_Root.crt

Buypass Class 2 Root CA Oct 26 08:38:03 
2040 GMT

Buypass_Class_2_Root_CA.crt

Buypass Class 3 Root CA Oct 26 08:28:58 
2040 GMT

Buypass_Class_3_Root_CA.crt

CA Disig Root R2 Jul 19 09:15:30 
2042 GMT

CA_Disig_Root_R2.crt

CFCA EV ROOT Dec 31 03:07:01 
2029 GMT

CFCA_EV_ROOT.crt

COMODO Certification Authority Dec 31 23:59:59 
2029 GMT

COMODO_Certification_Authority.

crt

COMODO ECC Certification 
Authority

Jan 18 23:59:59 
2038 GMT

COMODO_ECC_Certification_Author

ity.crt

COMODO RSA Certification 
Authority

Jan 18 23:59:59 
2038 GMT

COMODO_RSA_Certification_Author

ity.crt

Certigna Jun 29 15:13:05 
2027 GMT

Certigna.crt

Certigna Root CA Oct 1 08:32:27 
2033 GMT

Certigna_Root_CA.crt

Certinomis - Root CA Oct 21 09:17:18 
2033 GMT

Certinomis_-_Root_CA.crt

Class 2 Primary CA Jul 6 23:59:59 
2019 GMT

Certplus_Class_2_Primary_CA.crt

Certum Trusted Network CA Dec 31 12:07:37 
2029 GMT

Certum_Trusted_Network_CA.crt

Certum Trusted Network CA 2 Oct 6 08:39:56 
2046 GMT

Certum_Trusted_Network_CA_2.crt

Chambers of Commerce Root - 
2008

Jul 31 12:29:50 
2038 GMT

Chambers_of_Commerce_Root_-

_2008.crt
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Certificate name Expiry date File in /etc/ssl/certs

AAA Certificate Services Dec 31 23:59:59 
2028 GMT

Comodo_AAA_Services_root.crt

Cybertrust Global Root Dec 15 08:00:00 
2021 GMT

Cybertrust_Global_Root.crt

D-TRUST Root Class 3 CA 2 2009 Nov 5 08:35:58 
2029 GMT

D-

TRUST_Root_Class_3_CA_2_2009.crt

D-TRUST Root Class 3 CA 2 EV 
2009

Nov 5 08:50:46 
2029 GMT

D-

TRUST_Root_Class_3_CA_2_EV_2009.

crt

DST Root CA X3 Sep 30 14:01:15 
2021 GMT

DST_Root_CA_X3.crt

Deutsche Telekom Root CA 2 Jul 9 23:59:00 
2019 GMT

Deutsche_Telekom_Root_CA_2.crt

DigiCert Global Root CA Nov 10 00:00:00 
2031 GMT

DigiCertGlobalRootCA.pem

DigiCert Assured ID Root CA Nov 10 00:00:00 
2031 GMT

DigiCert_Assured_ID_Root_CA.crt

DigiCert Assured ID Root G2 Jan 15 12:00:00 
2038 GMT

DigiCert_Assured_ID_Root_G2.crt

DigiCert Assured ID Root G3 Jan 15 12:00:00 
2038 GMT

DigiCert_Assured_ID_Root_G3.crt

DigiCert Global Root CA Nov 10 00:00:00 
2031 GMT

DigiCert_Global_Root_CA.crt

DigiCert Global Root G2 Jan 15 12:00:00 
2038 GMT

DigiCert_Global_Root_G2.crt

DigiCert Global Root G3 Jan 15 12:00:00 
2038 GMT

DigiCert_Global_Root_G3.crt

DigiCert High Assurance EV Root 
CA

Nov 10 00:00:00 
2031 GMT

DigiCert_High_Assurance_EV_Root

_CA.crt

DigiCert Trusted Root G4 Jan 15 12:00:00 
2038 GMT

DigiCert_Trusted_Root_G4.crt
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Certificate name Expiry date File in /etc/ssl/certs

E-Tugra Certification Authority Mar 3 12:09:48 
2023 GMT

E-

Tugra_Certification_Authority.cr

t

EC-ACC Jan 7 22:59:59 
2031 GMT

EC-ACC.crt

EE Certification Centre Root CA Dec 17 23:59:59 
2030 GMT

EE_Certification_Centre_Root_CA

.crt

Entrust.net25 Certification 
Authority (2048)

Jul 24 14:15:12 
2029 GMT

Entrust.net_Premium_2048_Secure

_Server_CA.crt

Entrust Root Certification 
Authority

Nov 27 20:53:42 
2026 GMT

Entrust_Root_Certification_Auth

ority.crt

Entrust Root Certification 
Authority - EC1

Dec 18 15:55:36 
2037 GMT

Entrust_Root_Certification_Auth

ority_-_EC1.crt

Entrust Root Certification 
Authority - G2

Dec 7 17:55:54 
2030 GMT

Entrust_Root_Certification_Auth

ority_-_G2.crt

GDCA TrustAUTH R5 ROOT Dec 31 15:59:59 
2040 GMT

GDCA_TrustAUTH_R5_ROOT.crt

GTS Root R1 Jun 22 00:00:00 
2036 GMT

GTS_Root_R1.crt

GTS Root R2 Jun 22 00:00:00 
2036 GMT

GTS_Root_R2.crt

GTS Root R3 Jun 22 00:00:00 
2036 GMT

GTS_Root_R3.crt

GTS Root R4 Jun 22 00:00:00 
2036 GMT

GTS_Root_R4.crt

GeoTrust Global CA May 21 04:00:00 
2022 GMT

GeoTrust_Global_CA.crt

http://Entrust.net
http://Entrust.net
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Certificate name Expiry date File in /etc/ssl/certs

GeoTrust Primary Certification 
Authority

Jul 16 23:59:59 
2036 GMT

GeoTrust_Primary_Certification_

Authority.crt

GeoTrust Primary Certification 
Authority - G2

Jan 18 23:59:59 
2038 GMT

GeoTrust_Primary_Certification_

Authority_-_G2.crt

GeoTrust Primary Certification 
Authority - G3

Dec 1 23:59:59 
2037 GMT

GeoTrust_Primary_Certification_

Authority_-_G3.crt

GeoTrust Universal CA Mar 4 05:00:00 
2029 GMT

GeoTrust_Universal_CA.crt

GeoTrust Universal CA 2 Mar 4 05:00:00 
2029 GMT

GeoTrust_Universal_CA_2.crt

GlobalSign Jan 19 03:14:07 
2038 GMT

GlobalSign_ECC_Root_CA_-_R4.crt

GlobalSign Jan 19 03:14:07 
2038 GMT

GlobalSign_ECC_Root_CA_-_R5.crt

GlobalSign Root CA Jan 28 12:00:00 
2028 GMT

GlobalSign_Root_CA.crt

GlobalSign Dec 15 08:00:00 
2021 GMT

GlobalSign_Root_CA_-_R2.crt

GlobalSign Mar 18 10:00:00 
2029 GMT

GlobalSign_Root_CA_-_R3.crt

GlobalSign Dec 10 00:00:00 
2034 GMT

GlobalSign_Root_CA_-_R6.crt

Global Chambersign Root - 2008 Jul 31 12:31:40 
2038 GMT

Global_Chambersign_Root_-

_2008.crt

Go Daddy Class 2 Certification 
Authority

Jun 29 17:06:20 
2034 GMT

Go_Daddy_Class_2_CA.crt

Go Daddy Root Certificate 
Authority - G2

Dec 31 23:59:59 
2037 GMT

Go_Daddy_Root_Certificate_Autho

rity_-_G2.crt
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Certificate name Expiry date File in /etc/ssl/certs

Hellenic Academic and Research 
Institutions ECC RootCA 2015

Jun 30 10:37:12 
2040 GMT

Hellenic_Academic_and_Research_

Institutions_ECC_RootCA_2015.crt

Hellenic Academic and Research 
Institutions RootCA 2011

Dec 1 13:49:52 
2031 GMT

Hellenic_Academic_and_Research_

Institutions_RootCA_2011.crt

Hellenic Academic and Research 
Institutions RootCA 2015

Jun 30 10:11:21 
2040 GMT

Hellenic_Academic_and_Research_

Institutions_RootCA_2015.crt

Hongkong Post Root CA 1 May 15 04:52:29 
2023 GMT

Hongkong_Post_Root_CA_1.crt

ISRG Root X1 Jun 4 11:04:38 
2035 GMT

ISRG_Root_X1.crt

IdenTrust Commercial Root CA 1 Jan 16 18:12:23 
2034 GMT

IdenTrust_Commercial_Root_CA_1.

crt

IdenTrust Public Sector Root CA 
1

Jan 16 17:53:32 
2034 GMT

IdenTrust_Public_Sector_Root_CA

_1.crt

Imprivata Embedded Code 
Signing CA

Sep 7 16:20:00 
2033 GMT

Imprivata.crt

Izenpe.com26 Dec 13 08:27:25 
2037 GMT

Izenpe.com27.crt

LuxTrust Global Root 2 Mar 5 13:21:57 
2035 GMT

LuxTrust_Global_Root_2.crt

Microsec e-Szigno Root CA 2009 Dec 30 11:30:18 
2029 GMT

Microsec_e-

Szigno_Root_CA_2009.crt

NetLock Arany (Class Gold) 
FÅ‘tanÃºsÃtvÃ¡ny

Dec 6 15:08:21 
2028 GMT

NetLock_Arany_=Class_Gold=_FÅ‘t

anÃºsÃtvÃ¡ny.crt

Network Solutions Certificate 
Authority

Dec 31 23:59:59 
2029 GMT

Network_Solutions_Certificate_A

uthority.crt

http://Izenpe.com
http://Izenpe.com
http://Izenpe.com
http://Izenpe.com
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Certificate name Expiry date File in /etc/ssl/certs

OISTE WISeKey Global Root GA 
CA

Dec 11 16:09:51 
2037 GMT

OISTE_WISeKey_Global_Root_GA_CA

.crt

OISTE WISeKey Global Root GB 
CA

Dec 1 15:10:31 
2039 GMT

OISTE_WISeKey_Global_Root_GB_CA

.crt

OISTE WISeKey Global Root GC 
CA

May 9 09:58:33 
2042 GMT

OISTE_WISeKey_Global_Root_GC_CA

.crt

QuoVadis Root Certification 
Authority

Mar 17 18:33:33 
2021 GMT

QuoVadis_Root_CA.crt

QuoVadis Root CA 1 G3 Jan 12 17:27:44 
2042 GMT

QuoVadis_Root_CA_1_G3.crt

QuoVadis Root CA 2 Nov 24 18:23:33 
2031 GMT

QuoVadis_Root_CA_2.crt

QuoVadis Root CA 2 G3 Jan 12 18:59:32 
2042 GMT

QuoVadis_Root_CA_2_G3.crt

QuoVadis Root CA 3 Nov 24 19:06:44 
2031 GMT

QuoVadis_Root_CA_3.crt

QuoVadis Root CA 3 G3 Jan 12 20:26:32 
2042 GMT

QuoVadis_Root_CA_3_G3.crt

SSL.com28 EV Root Certification 
Authority ECC

Feb 12 18:15:23 
2041 GMT

SSL.com_EV_Root_Certification_A

uthority_ECC.crt

SSL.com29 EV Root Certification 
Authority RSA R2

May 30 18:14:37 
2042 GMT

SSL.com_EV_Root_Certification_A

uthority_RSA_R2.crt

SSL.com30 Root Certification 
Authority ECC

Feb 12 18:14:03 
2041 GMT

SSL.com_Root_Certification_Auth

ority_ECC.crt

SSL.com31 Root Certification 
Authority RSA

Feb 12 17:39:39 
2041 GMT

SSL.com_Root_Certification_Auth

ority_RSA.crt

http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
http://SSL.com
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Certificate name Expiry date File in /etc/ssl/certs

SZAFIR ROOT CA2 Oct 19 07:43:30 
2035 GMT

SZAFIR_ROOT_CA2.crt

SecureSign RootCA11 Apr 8 04:56:47 
2029 GMT

SecureSign_RootCA11.crt

SecureTrust CA Dec 31 19:40:55 
2029 GMT

SecureTrust_CA.crt

Secure Global CA Dec 31 19:52:06 
2029 GMT

Secure_Global_CA.crt

Security Communication 
RootCA2

May 29 05:00:39 
2029 GMT

Security_Communication_RootCA2.

crt

Security Communication 
RootCA1

Sep 30 04:20:49 
2023 GMT

Security_Communication_Root_CA.

crt

Sonera Class2 CA Apr 6 07:29:40 
2021 GMT

Sonera_Class_2_Root_CA.crt

Staat der Nederlanden EV Root 
CA

Dec 8 11:10:28 
2022 GMT

Staat_der_Nederlanden_EV_Root_C

A.crt

Staat der Nederlanden Root CA - 
G2

Mar 25 11:03:10 
2020 GMT

Staat_der_Nederlanden_Root_CA_-

_G2.crt

Staat der Nederlanden Root CA - 
G3

Nov 13 23:00:00 
2028 GMT

Staat_der_Nederlanden_Root_CA_-

_G3.crt

Starfield Class 2 Certification 
Authority

Jun 29 17:39:16 
2034 GMT

Starfield_Class_2_CA.crt

Starfield Root Certificate 
Authority - G2

Dec 31 23:59:59 
2037 GMT

Starfield_Root_Certificate_Auth

ority_-_G2.crt

Starfield Services Root 
Certificate Authority - G2

Dec 31 23:59:59 
2037 GMT

Starfield_Services_Root_Certifi

cate_Authority_-_G2.crt

SwissSign Gold CA - G2 Oct 25 08:30:35 
2036 GMT

SwissSign_Gold_CA_-_G2.crt
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SwissSign Silver CA - G2 Oct 25 08:32:46 
2036 GMT

SwissSign_Silver_CA_-_G2.crt

T-TeleSec GlobalRoot Class 2 Oct 1 23:59:59 
2033 GMT

T-

TeleSec_GlobalRoot_Class_2.crt

T-TeleSec GlobalRoot Class 3 Oct 1 23:59:59 
2033 GMT

T-

TeleSec_GlobalRoot_Class_3.crt

TUBITAK Kamu SM SSL Kok 
Sertifikasi - Surum 1

Oct 25 08:25:55 
2043 GMT

TUBITAK_Kamu_SM_SSL_Kok_Sertifi

kasi_-_Surum_1.crt

TWCA Global Root CA Dec 31 15:59:59 
2030 GMT

TWCA_Global_Root_CA.crt

TWCA Root Certification 
Authority

Dec 31 15:59:59 
2030 GMT

TWCA_Root_Certification_Authori

ty.crt

Government Root Certification 
Authority

Dec 5 13:23:33 
2032 GMT

Taiwan_GRCA.crt

TeliaSonera Root CA v1 Oct 18 12:00:50 
2032 GMT

TeliaSonera_Root_CA_v1.crt

TrustCor ECA-1 Dec 31 17:28:07 
2029 GMT

TrustCor_ECA-1.crt

TrustCor RootCert CA-1 Dec 31 17:23:16 
2029 GMT

TrustCor_RootCert_CA-1.crt

TrustCor RootCert CA-2 Dec 31 17:26:39 
2034 GMT

TrustCor_RootCert_CA-2.crt

Trustis FPS Root CA Jan 21 11:36:54 
2024 GMT

Trustis_FPS_Root_CA.crt

UCA Extended Validation Root Dec 31 00:00:00 
2038 GMT

UCA_Extended_Validation_Root.cr

t

UCA Global G2 Root Dec 31 00:00:00 
2040 GMT

UCA_Global_G2_Root.crt
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Certificate name Expiry date File in /etc/ssl/certs

USERTrust ECC Certification 
Authority

Jan 18 23:59:59 
2038 GMT

USERTrust_ECC_Certification_Aut

hority.crt

USERTrust RSA Certification 
Authority

Jan 18 23:59:59 
2038 GMT

USERTrust_RSA_Certification_Aut

hority.crt

VeriSign Class 3 Public Primary 
Certification Authority - G4

Jan 18 23:59:59 
2038 GMT

VeriSign_Class_3_Public_Primary

_Certification_Authority_-

_G4.crt

VeriSign Class 3 Public Primary 
Certification Authority - G5

Jul 16 23:59:59 
2036 GMT

VeriSign_Class_3_Public_Primary

_Certification_Authority_-

_G5.crt

VeriSign Universal Root 
Certification Authority

Dec 1 23:59:59 
2037 GMT

VeriSign_Universal_Root_Certifi

cation_Authority.crt

VeriSign Class 3 Public Primary 
Certification Authority - G3

Jul 16 23:59:59 
2036 GMT

Verisign_Class_3_Public_Primary

_Certification_Authority_-

_G3.crt

XRamp Global Certification 
Authority

Jan 1 05:37:19 
2035 GMT

XRamp_Global_CA_Root.crt

certSIGN ROOT CA Jul 4 17:20:04 
2031 GMT

certSIGN_ROOT_CA.crt

ePKI Root Certification Authority Dec 20 02:31:27 
2034 GMT

ePKI_Root_Certification_Authori

ty.crt

thawte Primary Root CA Jul 16 23:59:59 
2036 GMT

thawte_Primary_Root_CA.crt

thawte Primary Root CA - G2 Jan 18 23:59:59 
2038 GMT

thawte_Primary_Root_CA_-_G2.crt

thawte Primary Root CA - G3 Dec 1 23:59:59 
2037 GMT

thawte_Primary_Root_CA_-_G3.crt
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•

IGEL OS Creator (OSC)

Supported Devices
UD2-LX: UD2-LX 51

UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 60

UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 11

UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.

Component Versions 11.03.100 (see page 705)
New Features 11.03.100 (see page 707)
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•

Component Versions 11.03.100
Clients
Product Version

Zulu JRE 8.42.0.23

Smartcard
Reader Driver MUSCLE CCID 1.4.31-1igel6

Resource Manager PC/SC Lite 1.8.23-1igel8

System Components
OpenSSL 1.0.2g-1ubuntu4.15

Bluetooth Stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.2.5-1igel93

VDPAU Library version 1.2-1igel911

Graphics Driver INTEL 2.99.917+git20191117-igel939

Graphics Driver ATI/RADEON 19.0.1-3igel936

Graphics Driver ATI/AMDGPU 19.0.1-5igel924

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 418.56-0ubuntu1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build2-igel925

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.85 #mainline-lxos-r2872
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Xorg X11 Server 1.20.5-1igel914

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

WebKit2Gtk 2.26.2-1igel27

Python2 2.7.12

Python3 3.5.2
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•
•

New Features 11.03.100
Hardware

Added hardware support for LG CL600N.
Added hardware support for LG CL600W.
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•

Notes for Release 11.02.150
Software: Version 11.02.150

Release Date: 2019-09-09

Release Notes: Version RN-1102150-1

Last update: 2019-09-09

Supported Devices 11.02.150 (see page 709)
Component Versions 11.02.150 (see page 710)
General Information 11.02.150 (see page 714)
Security Fixes 11.02.150 (see page 715)
Known Issues 11.02.150 (see page 719)
New Features 11.02.150 (see page 721)
Resolved Issues 11.02.150 (see page 722)
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Supported Devices 11.02.150
IGEL devices:

UD2-LX: UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

For supported IGEL OS 11 third-party devices, see Devices Supported by IGEL OS 11.



Notes for Release 11.02.150

IGEL OS Release Notes   710 / 1492

•

Component Versions 11.02.150
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.6.0.60

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 12.5_x64_20190619_12.5.1.40008

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.6

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.9.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.7.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.40.0.25

Parallels Client (64 bit) 17.0.21282

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Remote Viewer (Red Hat Virtualization) 8.0-1igel49

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Teradici PCoIP Software Client 19.05.5-18.04
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•

ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VNC Viewer 1.9.0+dfsg-3igel8

VMware Horizon Client 5.0.0-12557422  

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech driver 12.7.11

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.3.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35
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Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190724-igel907

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 418.56-0ubuntu1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel635
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Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.65 #mainline-lxos-r2782

Xorg X11 Server 1.19.7-1igel913

Xorg Xephyr 1.19.7-1igel913

CUPS printing daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 18.2.1.128

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / Sane 1.0.27-1

VirtualBox 6.0.10-dfsg-4igel31

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 11.02.150
The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver
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•

Security Fixes 11.02.150
Firefox

Updated Firefox browser to version 60.9.0 ESR.
Including Fixes from Security Advisory 2019-27:
More...

CVE-2019-11746, CVE-2019-11744, CVE-2019-11753, CVE-2019-11752,
CVE-2019-9812, CVE-2019-11743, and CVE-2019-11740.

Fixes for mfsa2019-22, also known as:
More...

CVE-2019-9811, CVE-2019-11711, CVE-2019-11712, CVE-2019-11713,
CVE-2019-11729, CVE-2019-11715, CVE-2019-11717, CVE-2019-11719,
CVE-2019-11730, and CVE-2019-11709.

Fixes for mfsa2019-19, also known as: CVE-2019-11708.
Fixes for mfsa2019-18, also known as: CVE-2019-11707.
Fixes for mfsa2019-08, also known as:
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, and CVE-2019-9788.

Fixes for mfsa2019-05, also known as: CVE-2018-18356, CVE-2019-5785.
Fixes for mfsa2019-02, also known as: CVE-2018-18500, CVE-2018-18505, and CVE-2018-18501.
Added allowance for Firefox to access Yubikey (FIDO/U2F) if apparmor is active.

Base system

Fixed security issue CVE-2019-15902 in 4.19.x kernel.
Set default umask to 0077 for all non-root users.
Remote users home is now /home/ruser.
Fixed policykit-1 security issue CVE-2019-6133.
Fixed tiff security issues:
More...

CVE-2019-7663, CVE-2019-6128, CVE-2018-19210,
CVE-2018-17000, CVE-2018-12900, and CVE-2018-10779.

Fixed lcms2 security issue CVE-2018-16435.
Fixed libpng1.6 security issues CVE-2019-7317 and CVE-2018-13785.
Fixed nss security issues CVE-2018-18508, CVE-2019-11729, and CVE-2019-11719.
Fixed procps security issues:
More...

CVE-2018-1126, CVE-2018-1125, CVE-2018-1124,
CVE-2018-1123 and CVE-2018-1122.

Fixed evince security issues CVE-2019-11459 and CVE-2019-1010006.
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Fixed gdk-pixbuf security issue CVE-2017-12447.
Fixed gst-plugins-base0.10 security issue CVE-2019-9928.
Fixed bind9 security issues CVE-2019-6465, CVE-2018-5745 and CVE-2018-5743.
Fixed libgd2 security issues CVE-2019-6978 and CVE-2019-6977.
Fixed ghostscript security issues CVE-2019-3839, CVE-2019-3838 and CVE-2019-3835. 
Fixed ldb security issue CVE-2019-3824.
Fixed file security issues CVE-2019-8907 and CVE-2019-8905.
Fixed poppler security issues:
More...

CVE-2019-9200, CVE-2019-9903, CVE-2019-9631, CVE-2019-12293,
CVE-2019-10872, CVE-2019-10023, CVE-2019-10021, CVE-2019-10019,
CVE-2019-10018, CVE-2018-20662, CVE-2018-18897, and CVE-2017-9865.

Fixed samba security issues CVE-2019-3880 and CVE-2018-16860.
Fixed openssl security issue CVE-2019-1559.
Fixed libxslt security issue CVE-2019-11068.
Fixed openssh security issue CVE-2019-6111.
Fixed wget security issue CVE-2019-5953.
Fixed wpa security issues:
More...

CVE-2019-9495, CVE-2019-9497, CVE-2019-9498,
CVE-2019-9499, and CVE-2019-11555.

Fixed gtk+2.0 security issue CVE-2013-7447.
Fixed heimdal security issues CVE-2019-12098 and CVE-2018-16860.
Fixed webkit2gtk security issues CVE-2019-8615, CVE-2019-8607, and CVE-2019-8595.
Fixed gimp security issues:
More...

CVE-2017-17786, CVE-2017-17789, CVE-2017-17784,
CVE-2017-17787, CVE-2017-17785, and CVE-2017-17788.

Fixed libtomcrypt security issue CVE-2018-12437.
Fixed unzip security issues CVE-2019-13232, CVE-2018-1000035, CVE-2016-9844, and 
CVE-2014-9913.
Fixed curl security issues:
More...

CVE-2018-16840, CVE-2018-16839, CVE-2019-3823,
CVE-2019-3822, CVE-2018-16890, and CVE-2019-5346.

Fixed gnutls28 security issues CVE-2018-10846, CVE-2018-10845, CVE-2018-10844, and 
CVE-2018-1084.
Fixed db5.3 security issue CVE-2019-8457.
Fixed qtbase-opensource-src security issues CVE-2018-19873, CVE-2018-19870, and 
CVE-2018-15518.
Fixed libssh2 security issues:
More...
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CVE-2019-3863, CVE-2019-3862, CVE-2019-3861, 
CVE-2019-3860, CVE-2019-3859, CVE-2019-3858,
CVE-2019-3857, CVE-2019-3856, and CVE-2019-3855.

Fixed network-manager security issue CVE-2018-15688.
Fixed elfutils security issues:
More...

CVE-2019-7665, CVE-2019-7150, CVE-2019-7149,
CVE-2018-18521, CVE-2018-18520, CVE-2018-18310,
CVE-2018-16403, CVE-2018-16402, and CVE-2018-16062.

Fixed libsndfile security issues:
More...

CVE-2019-3832, CVE-2018-19758, CVE-2018-19662, CVE-2018-19661,
CVE-2018-19432, CVE-2018-13139, CVE-2017-6892, CVE-2017-17457,
CVE-2017-17456, CVE-2017-16942, CVE-2017-14634, CVE-2017-14246,
and CVE-2017-14245.

Fixed dbus security issue CVE-2019-12749.
Fixed vim security issues CVE-2019-12735 and CVE-2017-5953.
Fixed glib2.0 security issue CVE-2019-12450.
Fixed openssl (1.1.x) security issues:
More...

CVE-2019-1543, CVE-2018-0737, CVE-2018-0735,
CVE-2018-0734, and CVE-2018-0732.

Fixed sqlite3 security issues:
More...

CVE-2019-9937, CVE-2019-9936, CVE-2019-8457, CVE-2018-20506,
CVE-2018-20346, CVE-2017-2520, CVE-2017-2519, CVE-2017-2518,
CVE-2017-13685, CVE-2017-10989, and CVE-2016-6153.

Fixed systemd security issues:
More...

CVE-2019-6454, CVE-2019-6454, CVE-2018-1049,
CVE-2018-15686, and CVE-2019-3842.

Fixed libseccomp security issue CVE-2019-9893.
Fixed bzip2 security issues CVE-2019-12900 and CVE-2016-3189.
Fixed imagemagick security issues:
More...

CVE-2019-9956, CVE-2019-7398, CVE-2019-7397, CVE-2019-7396,
CVE-2019-7175, CVE-2019-11598, CVE-2019-11597, CVE-2019-11472,
CVE-2019-11470, CVE-2019-10650, CVE-2019-10131, CVE-2018-20467,
CVE-2018-18025, CVE-2018-18024, CVE-2018-18016, CVE-2018-17966,
CVE-2018-17965, CVE-2018-16413, CVE-2018-16412, CVE-2017-12806,
and CVE-2017-12805.

Fixed expat security issue CVE-2018-20843.
Fixed glib2.0 security issue CVE-2019-13012.



Notes for Release 11.02.150

IGEL OS Release Notes   718 / 1492

•
•
•
•
•
•

•
•
•

•
•

Fixed libvirt security issues CVE-2019-10167 and CVE-2019-10161.
Fixed gvfs security issue CVE-2019-12795.
Fixed libmspack security issue CVE-2019-1010305.
Fixed bash security issue CVE-2019-9924.
Fixed openldap security issues CVE-2019-13565 and CVE-2019-13057.
Updated libwebkit2gtk-4.0-37 to version 2.24.2. 
Security fixes:
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251, 
CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378, 
CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345, 
CVE-2018-4386, and CVE-2018-4372.

Fixed a vulnerability in the custom environment variable framework.
Fixed possible malicious owner change within TC setup configuration.
Fixed kernel TCP vulnerabilities CVE-2019-11477: SACK Panic, CVE-2019-11478: SACK Slowness, 
and CVE-2019-11479: Excess resource consumption due to low MSS values.
Changed minimally allowed MSS size to 1000 to prevent possible Denial of Service attacks.
Fixed a vulnerability in Java configuration script.
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Known Issues 11.02.150
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compressin" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and H264 acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
Furthermore, Horizon Client relies on the OS to mount the storage devicesitself. Enable 
local Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
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Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
once with disabled FIPS support.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The "Console 
Invocation" has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Audio

IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
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New Features 11.02.150
Hardware

Improved support for ADS-Tec VMT9000 devices:
Enable rs-232 additional power supply without restart.
Enable an external Wi-Fi antenna without restart.
Enable shutdown by ignition off.

Added hardware support for Dell WYSE 5020.



Notes for Release 11.02.150

IGEL OS Release Notes   722 / 1492

•
•

•
•

•

•

•

•
•
•

Resolved Issues 11.02.150
DP/IGEL RDP Client 2

Fixed RDP graphics issues with Windows 2008(R2) Server (when RemoteFX is not enabled).
Fixed some smaller graphical RDP issues with Windows 2012 R2 if using Clearcodec.

 Network

Changed minimally allowed MSS size to "750" to avoid problems with some VPN solutions.
Added a new registry key to be able to configure the minimally allowed TCP MSS size. 
A new registry key:
More...

Parameter Minimal TCP send MSS size

Registry system.sysctl.tcp_min_snd_mss

Type Integer

Value 750

Tooltip Minimal TCP send MSS size (configurable value in 
the area from 200 to 1450)

Hardware

Fixed EFI freeze problem after bootcode update on devices like the HP t630 and probably others 
too.
Added support for newer Prolific PL2303 USB serial adapters (used in UD3 LX60).

Firefox

Fixed: Homepage cannot be set.

X11 system

Fixed Multi-GPU NVIDIA setups with Display Switch.
Prevent configuration of Display Switch utility on unlicensed devices.
Added new registry keys to be able to configure some modesetting options if needed. 
New registry keys:
More...

Parameter Use DRI3 PageFlip feature

Registry x.drivers.modesetting.use_page_flip

Range [Default] [False] [True]

Info "Default" (normally use page flip feature)

Parameter Use shadow framebuffer layer
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Registry x.drivers.modesetting.use_shadow_fb

Range [Default] [False] [True]

Info "Default" (normally use shadow framebuffer)

Parameter Use double shadow framebuffer to improve VNC 
performance

Registry x.drivers.modesetting.use_double_shadow

Range [False] [True]

Parameter Use software cursor for modesetting driver

Registry x.drivers.modesetting.use_sw_cursor

Range [Default] [False] [True]

Info "Default" (normally false)

Parameter Choose acceleration method

Registry x.drivers.modesetting.accel_method

Range [Default] [Glamor] [None]  

Info "Default" (normally Glamor is used)

Parameter Force usage of DRI3 regardless of x.drivers.use_dri3 setting

Registry x.drivers.modesetting.force_dri3

Type Bool

Value False
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Notes for Release 11.02.130
Software: Version 11.02.130

Release Date: 2019-08-23

Release Notes: Version RN-1102130-1

Last update: 2019-08-23

Supported Devices 11.02.130 (see page 725)
Component Versions 11.02.130 (see page 726)
General Information 11.02.130 (see page 730)
Security Fixes 11.02.130 (see page 731)
Known Issues 11.02.130 (see page 735)
Resolved Issues 11.02.130 (see page 737)
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Supported Devices 11.02.130
IGEL devices:

UD2-LX: UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

For supported IGEL OS 11 third-party devices, see Devices Supported by IGEL OS 11.
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Component Versions 11.02.130
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.6.0.60

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 12.5_x64_20190619_12.5.1.40008

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.6

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.8.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.7.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.40.0.25

Parallels Client (64 bit) 17.0.21282

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Remote Viewer (Red Hat Virtualization) 8.0-1igel49

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Teradici PCoIP Software Client 19.05.5-18.04
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VNC Viewer 1.9.0+dfsg-3igel8

VMware Horizon Client 5.0.0-12557422  

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech driver 12.7.11

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.3.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35
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Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190724-igel907

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 418.56-0ubuntu1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel635
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Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.65 #mainline-lxos-r2782

Xorg X11 Server 1.19.6-1ubuntu4.3igel910

Xorg Xephyr 1.19.6-1ubuntu4.3igel910

CUPS printing daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 18.2.1.128

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / Sane 1.0.27-1

VirtualBox 6.0.10-dfsg-4igel31

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 11.02.130
The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver.
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Security Fixes 11.02.130
Firefox

Updated Firefox browser to version 60.8.0 ESR.
Fixes for mfsa2019-22, also known as:
More...

CVE-2019-9811, CVE-2019-11711, CVE-2019-11712, CVE-2019-11713,
CVE-2019-11729, CVE-2019-11715, CVE-2019-11717, CVE-2019-11719,
CVE-2019-11730, and CVE-2019-11709.

Fixes for mfsa2019-19, also known as: CVE-2019-11708.
Fixes for mfsa2019-18, also known as: CVE-2019-11707.
Fixes for mfsa2019-08, also known as:
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, and CVE-2019-9788.

Fixes for mfsa2019-05, also known as: CVE-2018-18356, CVE-2019-5785.
Fixes for mfsa2019-02, also known as: CVE-2018-18500, CVE-2018-18505, and CVE-2018-18501.
Added allowance for Firefox to access Yubikey (FIDO/U2F) if apparmor is active.

Base system

Set default umask to 0077 for all non-root users.
Remote users home is now /home/ruser.
Fixed policykit-1 security issue CVE-2019-6133.
Fixed tiff security issues:
More...

CVE-2019-7663, CVE-2019-6128, CVE-2018-19210,
CVE-2018-17000, CVE-2018-12900, and CVE-2018-10779.

Fixed lcms2 security issue CVE-2018-16435.
Fixed libpng1.6 security issues CVE-2019-7317 and CVE-2018-13785.
Fixed nss security issues CVE-2018-18508, CVE-2019-11729, and CVE-2019-11719.
Fixed procps security issues:
More...

CVE-2018-1126, CVE-2018-1125, CVE-2018-1124,
CVE-2018-1123 and CVE-2018-1122.

Fixed evince security issues CVE-2019-11459 and CVE-2019-1010006.
Fixed gdk-pixbuf security issue CVE-2017-12447.
Fixed gst-plugins-base0.10 security issue CVE-2019-9928.
Fixed bind9 security issues CVE-2019-6465, CVE-2018-5745 and CVE-2018-5743.
Fixed libgd2 security issues CVE-2019-6978 and CVE-2019-6977.
Fixed ghostscript security issues CVE-2019-3839, CVE-2019-3838 and CVE-2019-3835. 
Fixed ldb security issue CVE-2019-3824.
Fixed file security issues CVE-2019-8907 and CVE-2019-8905.
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Fixed poppler security issues:
More...

CVE-2019-9200, CVE-2019-9903, CVE-2019-9631, CVE-2019-12293,
CVE-2019-10872, CVE-2019-10023, CVE-2019-10021, CVE-2019-10019,
CVE-2019-10018, CVE-2018-20662, CVE-2018-18897, and CVE-2017-9865.

Fixed samba security issues CVE-2019-3880 and CVE-2018-16860.
Fixed openssl security issue CVE-2019-1559.
Fixed libxslt security issue CVE-2019-11068.
Fixed openssh security issue CVE-2019-6111.
Fixed wget security issue CVE-2019-5953.
Fixed wpa security issues:
More...

CVE-2019-9495, CVE-2019-9497, CVE-2019-9498,
CVE-2019-9499, and CVE-2019-11555.

Fixed gtk+2.0 security issue CVE-2013-7447.
Fixed heimdal security issues CVE-2019-12098 and CVE-2018-16860.
Fixed webkit2gtk security issues CVE-2019-8615, CVE-2019-8607, and CVE-2019-8595.
Fixed gimp security issues:
More...

CVE-2017-17786, CVE-2017-17789, CVE-2017-17784,
CVE-2017-17787, CVE-2017-17785, and CVE-2017-17788.

Fixed libtomcrypt security issue CVE-2018-12437.
Fixed unzip security issues CVE-2019-13232, CVE-2018-1000035, CVE-2016-9844, and 
CVE-2014-9913.
Fixed curl security issues:
More...

CVE-2018-16840, CVE-2018-16839, CVE-2019-3823,
CVE-2019-3822, CVE-2018-16890, and CVE-2019-5346.

Fixed gnutls28 security issues CVE-2018-10846, CVE-2018-10845, CVE-2018-10844, and 
CVE-2018-1084.
Fixed db5.3 security issue CVE-2019-8457.
Fixed qtbase-opensource-src security issues CVE-2018-19873, CVE-2018-19870, and 
CVE-2018-15518.
Fixed libssh2 security issues:
More...

CVE-2019-3863, CVE-2019-3862, CVE-2019-3861, 
CVE-2019-3860, CVE-2019-3859, CVE-2019-3858,
CVE-2019-3857, CVE-2019-3856, and CVE-2019-3855.

Fixed network-manager security issue CVE-2018-15688.
Fixed elfutils security issues:
More...
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CVE-2019-7665, CVE-2019-7150, CVE-2019-7149,
CVE-2018-18521, CVE-2018-18520, CVE-2018-18310,
CVE-2018-16403, CVE-2018-16402, and CVE-2018-16062.

Fixed libsndfile security issues:
More...

CVE-2019-3832, CVE-2018-19758, CVE-2018-19662, CVE-2018-19661,
CVE-2018-19432, CVE-2018-13139, CVE-2017-6892, CVE-2017-17457,
CVE-2017-17456, CVE-2017-16942, CVE-2017-14634, CVE-2017-14246,
and CVE-2017-14245.

Fixed dbus security issue CVE-2019-12749.
Fixed vim security issues CVE-2019-12735 and CVE-2017-5953.
Fixed glib2.0 security issue CVE-2019-12450.
Fixed openssl (1.1.x) security issues:
More...

CVE-2019-1543, CVE-2018-0737, CVE-2018-0735,
CVE-2018-0734, and CVE-2018-0732.

Fixed sqlite3 security issues:
More...

CVE-2019-9937, CVE-2019-9936, CVE-2019-8457, CVE-2018-20506,
CVE-2018-20346, CVE-2017-2520, CVE-2017-2519, CVE-2017-2518,
CVE-2017-13685, CVE-2017-10989, and CVE-2016-6153.

Fixed systemd security issues:
More...

CVE-2019-6454, CVE-2019-6454, CVE-2018-1049,
CVE-2018-15686, and CVE-2019-3842.

Fixed libseccomp security issue CVE-2019-9893.
Fixed bzip2 security issues CVE-2019-12900 and CVE-2016-3189.
Fixed imagemagick security issues:
More...

CVE-2019-9956, CVE-2019-7398, CVE-2019-7397, CVE-2019-7396,
CVE-2019-7175, CVE-2019-11598, CVE-2019-11597, CVE-2019-11472,
CVE-2019-11470, CVE-2019-10650, CVE-2019-10131, CVE-2018-20467,
CVE-2018-18025, CVE-2018-18024, CVE-2018-18016, CVE-2018-17966,
CVE-2018-17965, CVE-2018-16413, CVE-2018-16412, CVE-2017-12806,
and CVE-2017-12805.

Fixed expat security issue CVE-2018-20843.
Fixed glib2.0 security issue CVE-2019-13012.
Fixed libvirt security issues CVE-2019-10167 and CVE-2019-10161.
Fixed gvfs security issue CVE-2019-12795.
Fixed libmspack security issue CVE-2019-1010305.
Fixed bash security issue CVE-2019-9924.
Fixed openldap security issues CVE-2019-13565 and CVE-2019-13057.
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Updated libwebkit2gtk-4.0-37 to version 2.24.2. 
Security fixes:
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251, 
CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378, 
CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345, 
CVE-2018-4386, and CVE-2018-4372.

Fixed a vulnerability in the custom environment variable framework.
Fixed possible malicious owner change within TC setup configuration.
Fixed kernel TCP vulnerabilities CVE-2019-11477: SACK Panic, CVE-2019-11478: SACK Slowness, 
and CVE-2019-11479: Excess resource consumption due to low MSS values.
Changed minimally allowed MSS size to 1000 to prevent possible Denial of Service attacks.
Fixed a vulnerability in Java configuration script.
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Known Issues 11.02.130
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and H264 acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

Sound redirection in PCoIP is broken when the so-called lightweight-client is used, which has 
become the new default.
Sound redirection can still be used by choosing the rollback-client instead. This can be done by 
setting the IGEL Registry key:
More...

Parameter Allow rollback to former client variant

Registry vmware.view.allow-client-rollback

Value enabled / disabled

Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
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It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.

WiFi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
once with disabled FIPS support.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The "Console 
Invocation" has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Audio

IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
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Resolved Issues 11.02.130
Base system

Fixed ActiveDirectory/Kerberos password change with "Change Password" accessory for users 
who are members of many (~300+) AD groups.
Fixed IGEL license retrieval via FTP protocol in IGEL Setup Assistant and integrated license 
browser.

Remote Management

Fixed automatic registering in the UMS using DNS entry or DHCP tag.
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Notes for Release 11.02.100
Software: Version 11.02.100

Release Date: 2019-08-14

Release Notes: Version RN-1102100-1

Last update: 2019-08-14

IGEL OS 11 (see page 739)
IGEL OS Creator (OSC) (see page 796)
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IGEL OS 11
Supported Devices 11.02.100 (see page 740)
Component Versions 11.02.100 (see page 741)
General Information 11.02.100 (see page 745)
Security Fixes 11.02.100 (see page 746)
Known Issues 11.02.100 (see page 750)
New Features 11.02.100 (see page 752)
Resolved Issues 11.02.100 (see page 782)
CA Certificates Contained in IGEL OS 11.02.100 (see page 792)
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Supported Devices 11.02.100
UD2-LX: UD2-LX 40

UD2-LX 50

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.
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Component Versions 11.02.100
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.6.0.60

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Ericom PowerTerm 12.5_x64_20190619_12.5.1.40008

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.6

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.8.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.7.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.40.0.25

Parallels Client (64 bit) 17.0.21282

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Remote Viewer (Red Hat Virtualization) 8.0-1igel49

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Teradici PCoIP Software Client 19.05.5-18.04
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VNC Viewer 1.9.0+dfsg-3igel8

VMware Horizon Client 5.0.0-12557422

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech driver 12.7.11

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.3.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35
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Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190724-igel907

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 418.56-0ubuntu1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel635
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Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.65 #mainline-lxos-r2782

Xorg X11 Server 1.19.6-1ubuntu4.3igel910

Xorg Xephyr 1.19.6-1ubuntu4.3igel910

CUPS printing daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 18.2.1.128

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / Sane 1.0.27-1

VirtualBox 6.0.10-dfsg-4igel31

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 11.02.100
The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver.
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Security Fixes 11.02.100
Firefox

Updated Firefox browser to version 60.8.0 ESR.
Fixes for mfsa2019-22, also known as:
More...

CVE-2019-9811, CVE-2019-11711, CVE-2019-11712, CVE-2019-11713,
CVE-2019-11729, CVE-2019-11715, CVE-2019-11717, CVE-2019-11719,
CVE-2019-11730, and CVE-2019-11709.

Fixes for mfsa2019-19, also known as: CVE-2019-11708.
Fixes for mfsa2019-18, also known as: CVE-2019-11707.
Fixes for mfsa2019-08, also known as:
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, and CVE-2019-9788.

Fixes for mfsa2019-05, also known as: CVE-2018-18356, CVE-2019-5785.
Fixes for mfsa2019-02, also known as: CVE-2018-18500, CVE-2018-18505, and CVE-2018-18501.
Added allowance for Firefox to access Yubikey (FIDO/U2F) if apparmor is active.

Base system

Set default umask to 0077 for all non-root users.
Remote users home is now /home/ruser.
Fixed policykit-1 security issue CVE-2019-6133.
Fixed tiff security issues:
More...

CVE-2019-7663, CVE-2019-6128, CVE-2018-19210,
CVE-2018-17000, CVE-2018-12900, and CVE-2018-10779.

Fixed lcms2 security issue CVE-2018-16435.
Fixed libpng1.6 security issues CVE-2019-7317 and CVE-2018-13785.
Fixed nss security issues CVE-2018-18508, CVE-2019-11729, and CVE-2019-11719.
Fixed procps security issues:
More...

CVE-2018-1126, CVE-2018-1125, CVE-2018-1124,
CVE-2018-1123 and CVE-2018-1122.

Fixed evince security issues CVE-2019-11459 and CVE-2019-1010006.
Fixed gdk-pixbuf security issue CVE-2017-12447.
Fixed gst-plugins-base0.10 security issue CVE-2019-9928.
Fixed bind9 security issues CVE-2019-6465, CVE-2018-5745 and CVE-2018-5743.
Fixed libgd2 security issues CVE-2019-6978 and CVE-2019-6977.
Fixed ghostscript security issues CVE-2019-3839, CVE-2019-3838 and CVE-2019-3835. 
Fixed ldb security issue CVE-2019-3824.



Notes for Release 11.02.100

IGEL OS Release Notes   747 / 1492

•
•

•
•
•
•
•
•

•
•
•
•

•
•

•

•

•
•

•

•
•

Fixed file security issues CVE-2019-8907 and CVE-2019-8905.
Fixed poppler security issues:
More...

CVE-2019-9200, CVE-2019-9903, CVE-2019-9631, CVE-2019-12293,
CVE-2019-10872, CVE-2019-10023, CVE-2019-10021, CVE-2019-10019,
CVE-2019-10018, CVE-2018-20662, CVE-2018-18897, and CVE-2017-9865.

Fixed samba security issues CVE-2019-3880 and CVE-2018-16860.
Fixed openssl security issue CVE-2019-1559.
Fixed libxslt security issue CVE-2019-11068.
Fixed openssh security issue CVE-2019-6111.
Fixed wget security issue CVE-2019-5953.
Fixed wpa security issues:
More...

CVE-2019-9495, CVE-2019-9497, CVE-2019-9498,
CVE-2019-9499, and CVE-2019-11555.

Fixed gtk+2.0 security issue CVE-2013-7447.
Fixed heimdal security issues CVE-2019-12098 and CVE-2018-16860.
Fixed webkit2gtk security issues CVE-2019-8615, CVE-2019-8607, and CVE-2019-8595.
Fixed gimp security issues:
More...

CVE-2017-17786, CVE-2017-17789, CVE-2017-17784,
CVE-2017-17787, CVE-2017-17785, and CVE-2017-17788.

Fixed libtomcrypt security issue CVE-2018-12437.
Fixed unzip security issues CVE-2019-13232, CVE-2018-1000035, CVE-2016-9844, and 
CVE-2014-9913.
Fixed curl security issues:
More...

CVE-2018-16840, CVE-2018-16839, CVE-2019-3823,
CVE-2019-3822, CVE-2018-16890, and CVE-2019-5346.

Fixed gnutls28 security issues CVE-2018-10846, CVE-2018-10845, CVE-2018-10844, and 
CVE-2018-1084.
Fixed db5.3 security issue CVE-2019-8457.
Fixed qtbase-opensource-src security issues CVE-2018-19873, CVE-2018-19870, and 
CVE-2018-15518.
Fixed libssh2 security issues:
More...

CVE-2019-3863, CVE-2019-3862, CVE-2019-3861, 
CVE-2019-3860, CVE-2019-3859, CVE-2019-3858,
CVE-2019-3857, CVE-2019-3856, and CVE-2019-3855.

Fixed network-manager security issue CVE-2018-15688.
Fixed elfutils security issues:
More...
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CVE-2019-7665, CVE-2019-7150, CVE-2019-7149,
CVE-2018-18521, CVE-2018-18520, CVE-2018-18310,
CVE-2018-16403, CVE-2018-16402, and CVE-2018-16062.

Fixed libsndfile security issues:
More...

CVE-2019-3832, CVE-2018-19758, CVE-2018-19662, CVE-2018-19661,
CVE-2018-19432, CVE-2018-13139, CVE-2017-6892, CVE-2017-17457,
CVE-2017-17456, CVE-2017-16942, CVE-2017-14634, CVE-2017-14246,
and CVE-2017-14245.

Fixed dbus security issue CVE-2019-12749.
Fixed vim security issues CVE-2019-12735 and CVE-2017-5953.
Fixed glib2.0 security issue CVE-2019-12450.
Fixed openssl (1.1.x) security issues:
More...

CVE-2019-1543, CVE-2018-0737, CVE-2018-0735,
CVE-2018-0734, and CVE-2018-0732.

Fixed sqlite3 security issues:
More...

CVE-2019-9937, CVE-2019-9936, CVE-2019-8457, CVE-2018-20506,
CVE-2018-20346, CVE-2017-2520, CVE-2017-2519, CVE-2017-2518,
CVE-2017-13685, CVE-2017-10989, and CVE-2016-6153.

Fixed systemd security issues:
More...

CVE-2019-6454, CVE-2019-6454, CVE-2018-1049,
CVE-2018-15686, and CVE-2019-3842.

Fixed libseccomp security issue CVE-2019-9893.
Fixed bzip2 security issues CVE-2019-12900 and CVE-2016-3189.
Fixed imagemagick security issues:
More...

CVE-2019-9956, CVE-2019-7398, CVE-2019-7397, CVE-2019-7396,
CVE-2019-7175, CVE-2019-11598, CVE-2019-11597, CVE-2019-11472,
CVE-2019-11470, CVE-2019-10650, CVE-2019-10131, CVE-2018-20467,
CVE-2018-18025, CVE-2018-18024, CVE-2018-18016, CVE-2018-17966,
CVE-2018-17965, CVE-2018-16413, CVE-2018-16412, CVE-2017-12806,
and CVE-2017-12805.

Fixed expat security issue CVE-2018-20843.
Fixed glib2.0 security issue CVE-2019-13012.
Fixed libvirt security issues CVE-2019-10167 and CVE-2019-10161.
Fixed gvfs security issue CVE-2019-12795.
Fixed libmspack security issue CVE-2019-1010305.
Fixed bash security issue CVE-2019-9924.
Fixed openldap security issues CVE-2019-13565 and CVE-2019-13057.
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Updated libwebkit2gtk-4.0-37 to version 2.24.2. 
Security fixes:
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251, 
CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378, 
CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345, 
CVE-2018-4386, and CVE-2018-4372.

Fixed a vulnerability in the custom environment variable framework.
Fixed possible malicious owner change within TC setup configuration.
Fixed kernel TCP vulnerabilities CVE-2019-11477: SACK Panic, CVE-2019-11478: SACK Slowness, 
and CVE-2019-11479: Excess resource consumption due to low MSS values.
Changed minimally allowed MSS size to 1000 to prevent possible Denial of Service attacks.
Fixed a vulnerability in Java configuration script.
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Known Issues 11.02.100
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and H264 acceleration

Registry ica.workaround-dual-rtme

Range enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
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WiFi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
once with disabled FIPS support.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The "Console 
Invocation" has to allow 'Native' client (auto is also possible) and should be started in fullscreen to 
prevent any opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Audio

IGEL UD2 (D220) fails to restore the volume level of the speaker when the device used firmware 
version 11.01.110 before.
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New Features 11.02.100
Citrix

Integrated Citrix Workspace app 19.06.
Available Citrix Workspace apps in this release: 19.06, 13.10 and 13.5.
Added a new registry key to support 1536-bit RSA keys for client authentication. Factory default 
for this release is "true".
More...

Parameter Enables RSA 1536 cipher suite

Registry ica.allregions.enable_rsa_1536

Range factory default / false / true

Added a new registry key to enable different cipher suites for client authentication. Factory 
default for this release is "ALL".
More...

Parameter Enables different cipher suite

Registry ica.allregions.sslciphers

Range factory default / ALL / GOV / COM

> TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
> TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
> TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA – COM/ALL

Added a new registry key to support keyboard layout synchronization.
More...

Parameter Keyboard layout synchronization

Registry ica.modules.virtualdriver.keyboardsync.enable

Value false/ true

Updated Citrix HDX RTME used for optimization of Skype for Business to version 2.8.0-2235.
Added support for Citrix Workspace Launcher functionality as described at https://
support.citrix.com/article/CTX237727.
Added Citrix Farm Selection, a facility to manually select one of the configured services / farms 
for StoreFront login.
More...

Parameter Citrix store selection

Registry ica.pnlogin.farm_selection.enabled

Value off / on

https://support.citrix.com/article/CTX237727
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Info:
Off: All servers are used in parallel. If switched on, a user has to select the store via a 
dialog box before entering the login data.

Timeout for the selection dialog:
More...

Parameter Timeout

Registry ica.pnlogin.farm_selection.timeout 

Value 0 (no timeout) seconds

Width of the dialog window:
More...

Parameter Selection box window width

Registry ica.pnlogin.farm_selection.win_widt

h

Value   400 pixel

Height of the dialog window:
More...

Parameter Selection box window height

Registry ica.pnlogin.farm_selection.win_heig

ht

Value   400 pixel

Changed the defaults for following parameters:
More...

IGEL Setup Sessions > Citrix > Citrix Global > Window

Parameter Multimonitor full-screen mode

Registry ica.wfclient.usexdgfullscreen

ica.wfclient.spanmonitorenable                              

Range [Restrict full-screen session to one monitor]
[Expand full-screen session across all monitors]
[Expand the session over a self-selected number of monitors]

IGEL Setup Sessions > Citrix > Citrix Global > HDX Multimedia  

Parameter Multimedia redirection
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Registry ica.module.virtualdriver.multimedia.enable

Value enabled / disabled

IGEL Setup Sessions > Citrix > Citrix Global > HDX Multimedia 

Sessions > Citrix > Citrix Global > Unified Communications > 
Skype for Business

Parameter HDX Realtime Media Engine

Registry ica.module.virtualdriver.hdxrtme.enable

Value enabled / disabled

Updated the Nuance virtual channel for ICA to version B301.

RDP/IGEL RDP Client 2

Added a field 'Collection' to RDP session server page.
More...

IGEL Setup > Sessions > RDP > RDP Sessions > RDP Session > Server  

IGEL Setup > Sessions > RDP > RDP Sessions > RDP Session > Options

Parameter Collection

Registry sessions.winconnect<NR>.option.load-balance-

info

VMware Horizon

Added parameters to specify webcam frame size and rate for RTAV.
More...

Parameter Webcam frame width

Registry vmware.view.rtav-frame-width

Value <empty_string>

Parameter Webcam frame height

Registry vmware.view.rtav-frame-height

Value <empty_string>

Parameter Webcam frame rate
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•
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•

Registry vmware.view.rtav-frame-rate

Value <empty_string>

Updated Horizon Client to version 5.0.0-12557422.
Added a possibility to easily evaluate Horizon Blast decoder states. By default, sessions are 
evaluated after usage, and the result is written into the journal log. This can also be used with GUI 
notifications at runtime.
Added new USB classes to Horizon USB Redirection class configuration: Audio (input), Audio 
(Output), Imaging, Video (Input).

Parallels Client

Updated Parallels Client to version 17.0.
Added a possibility to set apps to autostart on Parallels RAS.

PowerTerm

Added Ericom PowerTerm terminal emulation. This feature requires an additional license. 
The following versions are available: 
12.0.1.0.20170219.2-_dev_-34574 
12.5_x64_20190619_12.5.1.40008

IBM_525

Improved startup time of IBM iAccess Client.
Improved configuration of IBM iAccess Client via IGEL Setup.
More...

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Connection > Advanced

Parameter Bypass signon

Registry sessions.iaccess<NR>.options.ssoenabled

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Font

Parameter Antialiasing

Registry sessions.iaccess<NR>.options.textantialiasing

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Allow blinking cursor
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Registry sessions.iaccess<NR>.options.blinkcursor

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Show blinking text with

Registry sessions.iaccess<NR>.options.blinkstate

Value  [Blinking Text] [Host Color] [Mapped Color]

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Blink Color

Registry sessions.iaccess<NR>.options.blinkcolor_fg

Value #ffc800

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Blink Color Background

Registry sessions.iaccess<NR>.options.blinkcolor_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Rule Line

Registry sessions.iaccess<NR>.options.ruleline

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Follow Cursor

Registry sessions.iaccess<NR>.options.rulelinefollows

Value enabled / disabled
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Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Style

Registry sessions.iaccess<NR>.options.rulelinestyle

Value [Crosshair] [Vertical] [Horizontal]

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Green

Registry sessions.iaccess<NR>.options.color_fgn_fg

Value #00ff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Green Background

Registry sessions.iaccess<NR>.options.color_fgn_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter White

Registry sessions.iaccess<NR>.options.color_fwt_fg

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter White Background

Registry sessions.iaccess<NR>.options.color_fwt_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Red

Registry sessions.iaccess<NR>.options.color_frd_fg
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Value #ff0000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Red Background

Registry sessions.iaccess<NR>.options.color_frd_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Turquoise

Registry sessions.iaccess<NR>.options.color_ftq_fg

Value #00ffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Turquoise Background

Registry sessions.iaccess<NR>.options.color_ftq_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Yellow

Registry sessions.iaccess<NR>.options.color_fyw_fg

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Yellow Background

Registry sessions.iaccess<NR>.options.color_fyw_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Pink



Notes for Release 11.02.100

IGEL OS Release Notes   759 / 1492

Registry sessions.iaccess<NR>.options.color_fpk_fg

Value #ff00ff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Pink Background

Registry sessions.iaccess<NR>.options.color_fpk_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Blue

Registry sessions.iaccess<NR>.options.color_fbl_fg

Value #7890f0

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Blue Background

Registry sessions.iaccess<NR>.options.color_fbl_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Status Indicators

Registry sessions.iaccess<NR>.options.color_osi

Value #7890f0

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Information Indicators

Registry sessions.iaccess<NR>.options.color_oii

Value #ffffff
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Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Attention Indicators

Registry sessions.iaccess<NR>.options.color_oai

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Error Indicators

Registry sessions.iaccess<NR>.options.color_oei

Value #ff0000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter OIA Background

Registry sessions.iaccess<NR>.options.color_oob

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Screen Background

Registry sessions.iaccess<NR>.options.color_sbg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Highlight active field

Registry sessions.iaccess<NR>.options.actfieldhilite

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Active Field

Registry sessions.iaccess<NR>.options.color_actf_fg
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Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Active Field Background

Registry sessions.iaccess<NR>.options.color_actf_bg

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Crosshair Ruler Color

Registry sessions.iaccess<NR>.options.color_crc

Value #00ff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Column Separator

Registry sessions.iaccess<NR>.options.color_ccs

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences

Parameter Start window maximized

Registry sessions.iaccess<NR>.options.ismaximized

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Keyboard

Parameter Keyboard Remapping File

Registry sessions.iaccess<NR>.options.keyremapfile

Value IBMi.kmp

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Popup Keypad

Parameter Popup Keypad File
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Registry sessions.iaccess<NR>.options.poppadfile

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Toolbar

Parameter Toolbar File

Registry sessions.iaccess<NR>.options.toolbarfile

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Open new sessions in a new tab

Registry ibm.iaccess.acssm.opensessionintab

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Always display the tab bar

Registry ibm.iaccess.acssm.alwaysshowtabbar

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Switch to new tab when created

Registry ibm.iaccess.acssm.switchtonewtab

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Send a warning when closing multiple tabs

Registry ibm.iaccess.acssm.closemultipletabwarning

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Do not start tabbed sessions until the tab is selected

Registry ibm.iaccess.acssm.tabdelayedstart

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter New Tab Action



Notes for Release 11.02.100

IGEL OS Release Notes   763 / 1492

•

•
•

Registry ibm.iaccess.acssm.newtabaction

Value [Disable and Hide] [Run the Same] [Run Other...] 

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Tab Placement

Registry ibm.iaccess.acssm.tabplacement

Value [Top] [Bottom] [Left] [Right] 

NX client

Updated NoMachine Client to version 6.7.6.

ThinLinc

Updated Cendio ThinLinc to version 4.10.
Added support for all of ThinLinc's login methods: password, public key, smartcard and 
Kerberos. Additional parameters can be set when smartcard is chosen.
More...

IGEL Setup Sessions > ThinLinc > ThinLinc Sessions > ThinLinc Session > Login

Parameter Method of authentication

Registry sessions.thinlinc%.login.authentication_method

Value password / publickey / scpublickey / kerberos

IGEL Setup Sessions > ThinLinc > ThinLinc Sessions > ThinLinc Session > Login

Parameter User

Registry sessions.thinlinc%.options.user

Value

IGEL Setup Sessions > ThinLinc > ThinLinc Sessions > ThinLinc Session > Login

Parameter Password

Registry sessions.thinlinc%.option.crypt_password

Value

IGEL Setup Sessions > ThinLinc > ThinLinc Sessions > ThinLinc Session > Login

Parameter Use certificate subject as name for login
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Registry sessions.thinlinc%.login.smartcard_subject_as_n

ame

Value enabled / disabled

IGEL Setup Sessions > ThinLinc > ThinLinc Sessions > ThinLinc Session > Login

Parameter Connect the client automatically when a smartcard is found

Registry sessions.thinlinc%.login.smartcard_autoconnect

Value enabled / disabled

IGEL Setup Sessions > ThinLinc > ThinLinc Sessions > ThinLinc Session > Login

Parameter Disconnect the client automatically when the smartcard is removed

Registry sessions.thinlinc%.login.smartcard_disconnect

Value enabled / disabled

IGEL Setup Sessions > ThinLinc > ThinLinc Sessions > ThinLinc Session > Login

Parameter Allow transmission of the smartcard's passphrase for logging in

Registry sessions.thinlinc%.login.smartcard_passphrase_s

so

Value enabled / disabled

IGEL Setup Sessions > ThinLinc > ThinLinc Sessions > ThinLinc Session > Login

Parameter Smartcard filter

Registry sessions.thinlinc%.login.smartcard_filter_1

Value

IGEL Setup Sessions > ThinLinc > ThinLinc Sessions > ThinLinc Session > Login

Parameter Smartcard filter

Registry sessions.thinlinc%.login.smartcard_filter_2

Value

IGEL Setup Sessions > ThinLinc > ThinLinc Sessions > ThinLinc Session > Login

Parameter Smartcard filter
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•

Registry sessions.thinlinc%.login.smartcard_filter_3

Value

Teradici PCoIP Client

Added Teradici PCoIP Client version 19.05.5. This feature requires an additional license. 
The following parameters are available:
More...

IGEL Setup System > Firmware Customization > Features

Parameter Teradici PCoIP Client

Registry services.addition_teradici_pcoip_client.enabled 

Value enabled / disabled

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions >
PCoIP Session > Connection settings

Parameter Use IGEL Setup for configuration

Registry sessions.pcoip<NR>.options.igel-connection 

Value disabled / enabled

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions >
PCoIP Session > Connection settings

Parameter Server

Registry sessions.pcoip<NR>.options.address 

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions >
PCoIP Session > Connection settings

Parameter Server certificate verification mode

Registry sessions.pcoip<NR>.options.security-mode 

Range [Not required] [Warn but allow] [Full verification]

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions >
PCoIP Session > Login

Parameter Authentication type

Registry sessions.pcoip<NR>.options.auth-type 

Range [Password authentication] [Smartcard authentication]  
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IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions >
PCoIP Session > Window

Parameter Window mode

Registry sessions.pcoip<NR>.options.window-mode 

Range [User defined] [Fullscreen One Monitor] [Fullscreen All Monitors]
[Window]

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions >
PCoIP Session > Window

Parameter User interface translation

Registry sessions.pcoip<NR>.options.language 

Range [System setting] [English] [German] [French] [Spanish] [Portuguese 
(EU)] [Portuguese (Brazil)] [Italian] [Japanese] [Chinese(Simplified)] 
[Chinese(Traditional)] 

Parameter Log level

Registry sessions.pcoip<NR>.options.log-level 

Range [Global setting] [Critical] [Error] [Info] [Debug]

Added support for global settings:
More...

Parameter Log level

Registry pcoip.log-level

Range [Critical] [Error] [Info] [Debug]

Parameter Show codec indicator

Registry pcoip.codec_indicator

Value disabled / enabled

Info: 
Added small dot in the bottom left corner during the session to indicate which codec is 
being used. Green indicates simple codec; blue indicates tic2 codec.
This is only available as global setting.

UMS option "Save device files for support" now includes Teradici PCoIP client's data.

Firefox
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•

Added new parameters: Allow a custom command before and after browser session.
More...

Parameter init_action

Registry sessions.browser%.init_action

Value <empty_string>

Parameter final_action

Registry sessions.browser%.final_action

Value <empty_string>

Network

New feature regarding lock and logon screen: Network icons are shown on the panel and appear 
under the same conditions as during normal operation. None of them has a context menu though.
Clicking on the Wi-Fi icon directly invokes the Wireless Manager when it is enabled. 
If blocking/unblocking Wi-Fi by the user is enabled, there is an additional button on the Wireless 
Manager for blocking and a preceding dialog for unblocking.
SCEP: Added a registry key for specifiying a suffix for CommonName/SubjectAltName when the 
type is "DNS Name (auto)" or "DNS Name as UPN (auto)".
More...

Parameter CommonName/SubjectAltName Suffix

Registry network.scepclient.cert%.subjectaltnamesuffix

Value <empty>

Info: 
Automatic replacements in the value:

%D -> the system's DNS domain name at the time the CSR is created
%% -> %
Other %X are currently discarded.

Added a mechanism for retrieving the SCEP challenge password with a custom script. Setting 
the following registry key to "true" enables the use of the script. The registry key 
network.scepclient.cert%.crypt_password  will be ignored. (The script may use it for 

its own purpose though.)
More...

Parameter Use Challenge Password Command

Registry network.scepclient.cert%.use_challenge_password_c

ommand



Notes for Release 11.02.100

IGEL OS Release Notes   768 / 1492

•

•

•

•

•

Value enabled / disabled

If the above key is enabled, the value of this key will be passed to bash for execution. It happens 
when the SCEP challenge password is needed for creating a certificate signing request. The script 
is supposed to output the challenge password on its standard output. For convenience, any 
Carriage-Return characters are stripped off the script before execution by bash.
More...

Parameter Challenge Password Command

Registry network.scepclient.cert%.challenge_password_comm

and

Value <empty_string>

Added NCP Secure Enterprise VPN Client version 5.10_rev40552 (configurable under IGEL Setup 
> Network > VPN > NCP VPN Client).

Wi-Fi

Added: Wi-Fi adapters can be turned off and on by the tray icon context menu when the 
following registry key is enabled:
More...

Parameter Enable Wi-Fi switch

Registry network.applet.wireless.enable_wifi_switch

Value enabled / disabled

Added support for Realtek 8821CE wireless cards.

Imprivata

Imprivata Appliance 6.3 or higher is needed now.
Please see the Imprivata Supported Components guide (http://documentation.imprivata.com/
01RefArch/Content/Topics/OSSupportedComponents.htm#ProveID) for support and upgrade 
considerations.
Added a new parameter to Imprivata.conf: "Redirection of Smartcards".
More...

IGEL Setup > Sessions > Appliance Mode > Imprivata  

Parameter Redirection of Smartcards

Registry imprivata.native_smartcard_redirection

Value enabled / disabled

http://documentation.imprivata.com/01RefArch/Content/Topics/OSSupportedComponents.htm#ProveID
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Added a new parameter: "Path to Certificate".
More...

IGEL Setup > Sessions > Appliance Mode > Imprivata  

Parameter Path to Certificate

Registry imprivata.path_to_certificate

Smartcard

Added 90meter smartcard library. This feature requires an additional license.
Use the following parameters to activate:
More...

IGEL Setup System > Firmware Customization > Features

Parameter 90meter Smart Card Support

Registry services.addition_smartcard_90meter.enabled 

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by 90meter library

Registry vmware.view.pkcs11.use_90meter 

Value enabled / disabled

IGEL Setup Sessions > Browser > Browser Global > Smartcard Middleware

Parameter 90meter Security Device

Registry browserglobal.security_device.90meter 

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter 90meter

Registry scard.pkcs11.use_90meter 

Value enabled / disabled

New IGEL Smartcard mode without Locking Desktop (reintroduced feature of Linux 5.x 
firmware).
More...

IGEL Setup > Security > Logon > IGEL Smartcard
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Parameter Enable IGEL Smartcard without Locking Desktop

Registry scard.scardd.enable_nolock

Value enabled / disabled

IGEL Setup > Security > Logon > IGEL Smartcard

Parameter On Smartcard Removal, terminate

Registry scard.scardd.session_termination

Value all / smartcard

Updated SecMaker NetID to version 6.7.2.36: now YubiKey 5 is supported.
Updated CHERRY USB-LAN Proxy to version 3.2.0.3. This version provides enhanced 
configuration.
More...

IGEL Setup > Security > Smartcard > Services

Parameter Bind IP

Registry devices.cherry.usblanproxy.bind-ip

Value auto

IGEL Setup > Security > Smartcard > Services

Parameter Https Server Port

Registry devices.cherry.usblanproxy.https-port

Value 443

IGEL Setup > Security > Smartcard > Services

Parameter SICCT Announce IP

Registry devices.cherry.usblanproxy.sicct-announce-ip

Value broadcast

IGEL Setup > Security > Smartcard > Services

Parameter SICCT Announce Port

Registry devices.cherry.usblanproxy.sicct-announce-port

Value 4742

IGEL Setup > Security > Smartcard > Services
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Parameter SICCT Announce Interval

Registry devices.cherry.usblanproxy.sicct-announce-

interval

Value 30

IGEL Setup > Security > Smartcard > Services

Parameter USB Fast Mode

Registry devices.cherry.usblanproxy.usb-fast-mode

Value enabled /disabled

IGEL Setup > Security > Smartcard > Services

Parameter Alternate Initialization Method for G87-1505

Registry devices.cherry.usblanproxy.usb-1505-alt-setup

Value enabled /disabled

Added a command line tool pcsc_scan for smartcard debugging.
Added configuration parameters for some settings of smartcard library OpenSC.
More...

Parameter Debug level

Registry scard.pkcs11.opensc.default.debug

Value 0

Parameter Debug file

Registry scard.pkcs11.opensc.default.debug_file

Value stderr

Parameter Max. send size

Registry scard.pkcs11.opensc.default.pcsc.max_send_size

Value 255

Parameter Max. receive size

Registry scard.pkcs11.opensc.default.pcsc.max_recv_size

Value 256
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Parameter Connect exclusive

Registry scard.pkcs11.opensc.default.pcsc.connect_exclusiv

e

Value enabled / disabled

Parameter Disconnect action

Registry scard.pkcs11.opensc.default.pcsc.disconnect_actio

n

Value leave / reset / unpower

Parameter Transaction end action

Registry scard.pkcs11.opensc.default.pcsc.transaction_end_a

ction

Value leave / reset / unpower

Parameter Reconnect action

Registry scard.pkcs11.opensc.default.pcsc.reconnect_action

Value leave / reset / unpower

Parameter Enable pinpad

Registry scard.pkcs11.opensc.default.pcsc.enable_pinpad

Value enabled / disabled

Parameter Use PIN caching

Registry scard.pkcs11.opensc.default.pkcs15.use_pin_cachin

g

Value enabled / disabled

Parameter How many times to use a PIN from cache before re-authenticating it

Registry scard.pkcs11.opensc.default.pkcs15.pin_cache_coun

ter

Value 10
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Parameter PIN caching ignores user consent

Registry scard.pkcs11.opensc.default.pkcs15.pin_cache_ignore_

user_consent

Value enabled / disabled

Updated cryptovision sc/interface PKCS#11 smartcard library to version 7.1.20. 
Changes in this revision:

Fixed a possible deadlock in the PKCS#11 module on Linux, if C_Finalize is called during a 
PCSC event, for example C_WaitForSlotEvent.
ROCA check in the Smartcard Manager, based on the "ROCA detection tool", see https://
github.com/crocs-muni/roca.
Renaming of the container label in Smartcard Manager with F2 is now possible.

CUPS Printing

Added SMB Network Print client function.
More...

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter Printer Port

Registry print.cups.printer<NR>.backend

Value smb

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Server

Registry print.cups.printer<NR>.smb_server

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Workgroup

Registry print.cups.printer<NR>.smb_workgroup

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Printer

Registry print.cups.printer<NR>.smb_printer

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Port

https://github.com/crocs-muni/roca
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Registry print.cups.printer<NR>.smb_port

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter Use Kerberos Authentication

Registry print.cups.printer<NR>.smb_kerberos

Value enabled / disabled

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter Use Passthrough Authentication

Registry print.cups.printer<NR>.smb_passthrough

Value enabled /disabled

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB User

Registry print.cups.printer<NR>.smb_user

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Password

Registry print.cups.printer<NR>.crypt_password

Base system

Added a possibility to configure scheduled commands. Registry keys: system.cron.**
Buddy update enhancements:

Automatic load balancing:
A client collects up to eight server candidates from which one is selected randomly. 
Collection stops when the number specified in the following registry key is reached. 
Otherwise collection stops after a timeout.
More...

Parameter Buddy Update Server Candidates

Registry update.ftp.buddy_server_candidates

Value 1

Grouping:
Buddy update servers and clients only interact with each other when they are in the same 
group determined by the following registry key (a non-negative integer number). This 
feature is mainly useful when different firmware versions shall be used in parallel.
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•

More...

Parameter Buddy Group ID

Registry update.ftp.buddy_group_id

Value 0

Added: Firmware update scheduled on shutdown is now invoked on reboot too.
Added package ldap-utils which can be used by custom scripts.
Updated Kernel to mainline version 4.19.65.
Moved the EULA page in IGEL Setup Assistant into the demo activation workflow.
Updated EULA displayed in OSC and IGEL Setup Assistant.
Added: When IGEL Setup Assistant is used to download a demo license via Wi-Fi, the local Wi-Fi 
manager will be enabled by default.
Updated Fluendo multimedia codecs to the following versions:
More...

gst-fluendo-aacdec 21/03/2019 0.10.39

gst-fluendo-asfdemux 21/03/2019 0.10.89

gst-fluendo-h264dec 21/03/2019 0.10.53

gst-fluendo-mp3 21/03/2019 0.10.39

gst-fluendo-mpeg4video 21/03/2019 0.10.43

gst-fluendo-vadec 21/03/2019 0.10.208

gst-fluendo-wmadec 21/03/2019 0.10.68

gst-fluendo-wmvdec 20/03/2019 0.10.65

Replaced timesyncd with chrony NTP. Added a new registry key:
More...

Parameter Use NTP Servers from DNS SRV record

Registry system.time.ntp_use_dnssrv_timeservers

Value enabled / disabled

Updated CA Certificates to version 20190122 (Mozilla authority bundle version 2.30). 
The following authorities were added:
More...

"Certigna Root CA"
"GTS Root R1"
"GTS Root R2"
"GTS Root R3"
"GTS Root R4"
"UCA Extended Validation Root"
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"UCA Global G2 Root"
"GlobalSign Root CA - R6"
"OISTE WISeKey Global Root GC CA"
"GDCA TrustAUTH R5 ROOT"
"SSL.com EV Root Certification Authority ECC" 
"SSL.com EV Root Certification Authority RSA R2"
"SSL.com Root Certification Authority ECC" 
"SSL.com Root Certification Authority RSA"
"TrustCor ECA-1"
"TrustCor RootCert CA-1"
"TrustCor RootCert CA-2"

The following authorities were removed:
More...

"Certplus Root CA G1" 
"Certplus Root CA G2" 
"OpenTrust Root CA G1" 
"OpenTrust Root CA G2" 
"OpenTrust Root CA G3" 
"TÜRKTRUST Elektronik Sertifika Hizmet Sağlayıcısı H5" 
"Visa eCommerce Root" 
"ACEDICOM Root" 
"AddTrust Low-Value Services Root" 
"AddTrust Public Services Root" 
"AddTrust Qualified Certificates Root" 
"CA Disig Root R1" 
"CNNIC ROOT" 
"Camerfirma Chambers of Commerce Root" 
"Camerfirma Global Chambersign Root" 
"Certinomis - Autorité Racine" 
"Certum Root CA" 
"China Internet Network Information Center EV Certificates Root" 
"Comodo Secure Services root" 
"Comodo Trusted Services root" 
"DST ACES CA X6" 
"GeoTrust Global CA 2" 
"PSCProcert" 
"Security Communication EV RootCA1" 
"Swisscom Root CA 1" 
"Swisscom Root CA 2" 
"Swisscom Root EV CA 2" 
"TURKTRUST Certificate Services Provider Root 2007" 
"TUBITAK UEKAE Kok Sertifika Hizmet Saglayicisi - Surum 3" 
"UTN USERFirst Hardware Root CA"
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Driver

Added registry keys to modify the Intel graphic driver usage of framebuffer compression and
power management. 
New registry keys:
More...

Parameter Power saving display C-States to use

Registry x.drivers.intel.dc_setting

Range [Default] [Disable] [Up to DC5] [Up to DC6]

Info: "Default" - driver default 

Parameter Use framebuffer compression

Registry x.drivers.intel.fbc_setting 

Range [Default] [Disable]

Info: "Default" - driver default 

Updated Philips Speech Driver to version 12.7.11.
Updated signotec Citrix Virtual Channel driver to version 8.0.8.
Updated StepOver TCP Client to version 2.3.2.
Updated deviceTRUST Client to version 19.1.200. These are the release notes:
Welcome to the release of the deviceTRUST 19.1.200 IGEL client, providing the context of IGEL thin 
client and UD Pocket devices into your virtual sessions. This release includes support for logical 
disks attached to the IGEL endpoint, plus bug fixes and stability improvements over the previous 
19.1.100 release.

Logical Disks
We’ve added support for real-time properties representing the LOGICAL DISKS attached to the 
IGEL endpoint. This includes:
More...

DEVICE_LOGICALDISK_X_TYPE – Either Fixed or Removable.
DEVICE_LOGICALDISK_X_LABEL – The volume label.
DEVICE_LOGICALDISK_X_FILESYSTEM – The type of file system.
DEVICE_LOGICALDISK_X_PATHS – The paths that the disk is mounted.
DEVICE_LOGICALDISK_X_TOTALMB – The total space available on the disk. This property is only available for 
mounted disks.
DEVICE_LOGICALDISK_X_FREEMB – The free space available on the disk. This property is only available for 
mounted disks.
DEVICE_LOGICALDISK_X_NAME – The name of the underlying physical disk.
DEVICE_LOGICALDISK_X_VENDORID – The vendor identifier uniquely identifying the manufacturer. This 
property is only available for USB or PCI connected devices.
DEVICE_LOGICALDISK_X_PRODUCTID – The product identifier uniquely identifying the product. This 
property is only available for USB or PCI connected devices.
DEVICE_LOGICALDISK_X_SERIALNUMBER – The serial number of the physical disk.
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DEVICE_LOGICALDISK_X_BUSTYPE – The storage bus type linked to the physical disk.
DEVICE_LOGICALDISK_COUNT – The number of logical disks.

X11 system

Added a new parameter to allow configuration of 'Display Switch' confirmation dialog timeout.
More...

IGEL Setup Accessories > Display Switch > Options

Parameter Timeout for confirmation dialog

Registry sessions.user_display0.options.confirm_ti

meout

Value 10

Re-Enable 'Display Switch' session start script to cycle simple modes.
Added new options for lid handling.
More...

Parameter Lid close action while plugged in

Registry system.actions.lid.ac

Range [Turn off display] [Suspend]

Parameter Lid close action while not plugged in

Registry system.actions.lid.battery

Range [Turn off display] [Suspend]

Added new registry keys to change the xorg input driver for an input device class. 
New registry keys:

For keyboards:
More...

Parameter Xorg driver to use

Registry userinterface.keyboard.driver

Range [Evdev] [Libinput]

For touchpads:
More...

Parameter Xorg driver to use

Registry userinterface.touchpad.driver



Notes for Release 11.02.100

IGEL OS Release Notes   779 / 1492

•

Range [Evdev] [Synaptics] [Libinput]

For touchscreens:
More...

Parameter Xorg driver to use

Registry userinterface.touchscreen.xorg_driver

Range [Evdev] [Libinput]

For mouse:
More...

Parameter Xorg driver to use

Registry userinterface.mouse.driver

Range [Evdev] [Libinput]

Added some registry keys to disable loading of DRM kernel modules (graphic).
More...

Parameter Disable the loading of the RADEON DRM driver

Registry x.drivers.ati.disable

Value 0

Parameter Disable the loading of the AMDGPU DRM driver

Registry x.drivers.amdgpu.disable

Value 0

Parameter Disable the loading of the i915 DRM driver

Registry x.drivers.intel.disable

Value 0

Parameter Disable the loading of the NVIDIA kernel driver

Registry x.drivers.nvidia.disable

Value 0

Parameter Disable the loading of the NOUVEAU DRM driver

Registry x.drivers.nouveau.disable

Value 0
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Parameter Disable the loading of the QXL DRM driver

Registry x.drivers.qxl.disable

Value 0

Parameter Disable the loading of the VMGFX DRM driver

Registry x.drivers.vmware.disable

Value 0

Parameter Disable the loading of the VBOXVIDEO DRM driver

Registry x.drivers.vboxvideo.disable

Value 0

Updated DisplayLink driver to version 5.1.26 to solve some startup issues.

Evidian

Updated Evidian rsUserAuth to version 1.5.7116.

Hardware

Added hardware support for Rein Medical Silenio 122CT and 124CT.
Added hardware support for Advantech POC-W213L and POC-W243L.
Added hardware support for ADS-TEC VMT 9000 Serie.
Added hardware support for Fujitsu Esprimo Q957.
Added hardware support for ADS-TEC VMT 9000 Serie.
Added hardware support for LG AiO Cloud Device 38"

Added hardware support for the following headsets:
More...

Jabra Engage 50
Jabra Engage 65
Jabra Engage 75
Jabra Evolve 30 II (Ver. B)
Jabra Evolve 30 II (Ver. C)
Jabra Evolve 40 (Ver. B) - USB-C
Jabra Evolve 40 (Ver. D)
Jabra Evolve 65
Jabra Evolve 75
Plantronics Voyager 5200 UC
Plantronics Voyager 6200 UC
Plantronics Voyager 8200 UC
Plantronics ENCOREPRO 720 + DA70
Plantronics ENCOREPRO 720 + DA80
Plantronics ENCOREPRO 520D + DA90
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Sennheiser SC70
Added hardware support for HP t430.
Added hardware support for HP t420.

Java

Replaced Oracle JRE by AZUL's Zulu JRE.
Updated Zulu JRE to version 8.40.0.25.

Remote Management

Connection order between UMS and ICG can now be configured.
More...

Registry system.remotemanager.icg_try_ums_conne

ct

Value enabled / disabled

When an ICG connection is configured and the parameter is enabled, the device tries to connect 
directly to UMS. If the connection was established successfully, the device is managed by UMS and 
not over ICG until new start of the device or network.

IGEL Cloud Gateway

Added VNC Shadowing support over ICG. To use this feature, UMS 6.02.110 or later and ICG 
2.01.100 or later are required.
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Resolved Issues 11.02.100
Citrix

Improved USB handling of SpaceMouse.
Improved USB redirection handling with Citrix Workspace App 19.06.
Fixed stability issues with Citrix Browser Content Redirection.

OSC Installer

Fixed: OSC Installer does not disable EFI when MSDOS partitioning was chosen.

Citrix Receiver 13

Added a switch to enable the possibility to launch multiple desktop sessions with RTME and 
h.264 acceleration. This switch should not be used when "Enable Secure ICA" is active for 
specific delivery group.
More...

Registry ica.workaround-dual-rtme

Value enabled / disabled

RDP/IGEL RDP Client 2

Added a registry key to use rdpglobal window settings for remote apps.
More...

Parameter Enable global windwos settings for remote app

Registry rdp.winconnect.enable-global-

window-settings-for-remote-app

Value enabled / disabled

Added negotiation: Kerberos as fallback for disabled NTLM authentication. This only works 
when Active Directory/Kerberos Logon is enabled.
Fixed RD Web Access not working with special characters in name or password. This only works 
when Active Directory/Kerberos Logon is enabled.
Fixed smartcard redirection in RDP: SCardGetAttrib was failing if pbAttr was NULL. The fix 
should help running Dutch Zorg-ID applications.

RD Web Access

Fixed not starting RDP Remote Applications.

VMware Horizon

Added recognition for password change and password expired dialog in Horizon local logon 
sessions or appliance mode.
Fixed configuration choice for usage of relative mouse feature.
Added possibility to use the rollback variant of the Horizon Client.
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More...

Parameter Allow rollback to former client variant

Registry vmware.view.allow-client-

rollback

Value enabled / disabled

Fixed a problem with the client where connection to the remote desktop using PCoIP protocol 
failed occasionally.

Teradici PCoIP Client

Fixed unwanted restart of login window after session logoff or disconnect.

Firefox

Fixed Firefox not accepting proxy credentials from setup.
Fixed print hotkey disable option not working with Firefox 60.
Fixed browserglobal.app.local_subdirs_whitelist not working.

Network

Fixed: Failure to reach SCEP server in the client certificate renewal phase resulted in loss of SCEP 
server and client certificates.
Changed e1000e driver to out of tree version 3.4.2.3 directly from Intel.
Changed igb driver to out of tree version 5.3.5.22 directly from Intel.
Added possibility to switch between third-party and kernel Intel IGB network driver. 
New registry key:
More...

Parameter Use thirdparty igb kernel module

Registry network.drivers.igb.prefer_thirdparty

Range [Auto] [Yes] [No]

Info: "Auto" (use thirdparty in most cases)

Added possibility to switch between third-party and kernel intel E1000E network driver.
New registry key:
More...

Parameter Use thirdparty e1000e kernel module

Registry network.drivers.e1000e.prefer_thirdparty

Range [Auto] [Yes] [No]

Info: "Auto" (use thirdparty in most cases)

Fixed instability of netmounts with static IP configuration.
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Added possibility to switch between third-party r8168 and kernel r8169 realtek network 
driver.
New registry key:
More...

Parameter Use thirdparty r8168 kernel module

Registry network.drivers.r8169.prefer_r8168

Range [Auto] [Yes] [No]

Info: "Auto" (use r8168 in most cases)

Added a possibility to choose the variant of the realtek r8168 driver. 
A new registry key:
More...

Parameter Choose realtek r8168 variant (only if "prefer r8168" is chosen)

Registry network.drivers.r8169.r8168_variant

Range [Default] [No NAPI] [NAPI]

Info: "Dafault" (use NAPI in most cases)

Fixed: Second Ethernet interface did not get configured when the first one was disabled.
Fixed: 802.1X Ethernet configuration with user interaction was broken.

Wi-Fi

Fixed not working TP Link Archer T2UH.
Fixed not working Broadcom SDIO WLAN cards as present in Advantech AIM8IAC device for 
example.

Smartcard

Updated cryptovision sc/interface PKCS#11 smartcard library to version 7.1.20.
Fixed a possible deadlock in the PKCS#11 module on Linux if C_Finalize is called during a PCSC 
event, for example C_WaitForSlotEvent.
Fixed OpenSC setting max_send_size for reader driver pcsc in /etc/opensc/opensc.conf.
Fixed Dell KB813 Smartcard Keyboard in combination with certain smartcards driven by OpenSC 
PKCS#11 module. Before this fix, authentication to Citrix StoreFront and VMWare Horizon 
failed.

Base system

Improved: Ensured that the Unit ID for IGEL devices is the MAC address of the onboard network 
card.
Fixed license expiry warning at boot. Before this fix, in some cases the warning wrongly 
appeared at every boot.
Fixed unmounting storage devices via In-session control bar.
Fixed server-dependent crash when installing license via FTP.
Fixed retrieving of serial number of a connected screen.
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Fixed random 90 seconds shutdown delay (systemd).
Fixed wrong behavior with expired evaluation licenses in some cases.
Added message in bootsplash when a custom partition will get created.
Fixed bug in the screenlock countdown that occurred, when display of remaining seconds was 
not desired.
Fixed shortcut configuration for shutdown, restart and icon sort to be applied without reboot.
Added apparmor rule to allow tcpdump to write to /debuglog.
Fixed hotkey configuration to be applied without reboot.
Fixed: UD2 screen goes black with certain multimonitor configurations.
Improved new license detection in IGEL Setup Assistant.
Fixed AD/Kerberos logon in case parameter auth.login.krb5_enterprise is set to false.
Fixed: System logoff waits for Citrix logoff now.
Fixed NTP synchronization problems when changing the NTP client from timesyncd to chrony.
Added switch to enable DNS hostname lookup for SSH server:
More...

Parameter Use DNS to resolve client hostnames

Registry network.ssh_server.use_dns

Value enabled / disabled

Fixed USB printer aliases.
Fixed gtk-3 icon sizes for High DPI configurations.
Enhanced bootloader to allow the setting of some kernel command line parameters with registry 
keys.
New registry keys:
More...

Parameter Disable use of APIC controller.

Registry system.kernel.bootparams.noapic

Value enabled / disabled

Parameter Disable use of ACPI.

Registry system.kernel.bootparams.noacpi

Value enabled / disabled

Parameter Use only one CPU core and disable all others.

Registry system.kernel.bootparams.nosmp

Value enabled / disabled

Parameter Enable debug console on serial port 1.
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Registry system.kernel.bootparams.serial_console_

debug

Value enabled / disabled

Parameter Limit CPU core usage (0 means no limit).

Registry system.kernel.bootparams.maxcpus

Value "0"

Parameter Set maximum allowed cstate on intel cpus.

Registry system.kernel.bootparams.max_cstate

Range [No limit] [1] [2] [3] [4] [5] [6]

Info: do not limit intel cstate

Parameter IOMMU usage setting.

Registry system.kernel.bootparams.iommu

Range [On] [Off] [Passthrough] [Force]

Info: Use IOMMU passthrough possible

Parameter IOMMU usage setting for AMD systems.

Registry system.kernel.bootparams.amd_iommu

Range [On] [Off]

Info: Use IOMMU if possible

Parameter IOMMU usage setting for Intel systems.

Registry system.kernel.bootparams.intel_iommu

Range [On] [Off]

Info: Use IOMMU if possible

Added a new registry key to set USB quirks:
More...

Parameter Set XHCI USB quirks to fix some hardware issues

Registry system.kernel.bootparams.xhci-hcd_quirks
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Range [No quirk] [Spurious Reboot quirk] [Spurious Wakeup quirk] 
[Spurious Reboot Wakeup quirk]

Lenovo ThinkCentre M73 needs the system.kernel.bootparams.xhci-hcd_quirks registry key 
set to `Spurious Reboot quirk` to fix reboot after shutdown problem.
Added column "Syslog style template" to Remote Syslog setup page. This allows to change 
rsyslog output style e.g. to newer SyslogProtocol23Format which is supported by graylog.
Disable martian packet logging.

Driver

Updated deviceTRUST Client to version 19.1.200.
Fixed an issue reading the DEVICE_IGEL_ICG_SERVER property.
Fixed an issue where the NETWORK and LOCATION property providers could cause the 
client to freeze if a disconnection occurred whilst these property providers were checking 
for changes.
Fixed an open file handle leak which led to the client process reaching its file handle limits 
when left running for a long period of time.

Fixed not working WACOM device DTU-1141B.

Custom Partition

Added message in bootsplash when a custom partition will get created.
Fixed ownership of extracted data: don't preserve original owner while extracting data into 
custom partition.

Storage Devices

Fixed automounting of storage devices inside of Olympus DS-9500 Digital Voice Recorder.

Appliance Mode

Fixed: In-session control bar could not be deactivated in Citrix SelfService appliance mode.

X11 system

There is now a registry key to ignore a 3Dconnexion SpaceMouse for IGEL graphical use (X11). If 
activated, the SpaceMouse is only passed through to the desktop session. If disabled, it acts like a 
standard mouse.
More...

IGEL Setup System > Registry

Parameter Deactivates a 3Dconnexion SpaceMouse as a standard mouse

Registry userinterface.mouse.spacemouse.x11_ignore

Value enabled / disabled

The following SpaceMouse products are included:
More...
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VID PID Vendor Product

0x046D 0xC603 Logitech, Inc. 3Dconnexion SpaceMouse Plus XT

0x046D 0xC605 Logitech, Inc. 3Dconnexion CADman

0x046D 0xC606 Logitech, Inc. 3Dconnexion SpaceMouse Classic

0x046D 0xC621 Logitech, Inc. 3Dconnexion SpaceBall 5000

0x046D 0xC623 Logitech, Inc. 3Dconnexion SpaceTraveller 3D Mouse

0x046D 0xC625 Logitech, Inc. 3Dconnexion SpacePilot 3D Mouse

0x046D 0xC626 Logitech, Inc. 3Dconnexion SpaceNavigator 3D Mouse

0x046D 0xC627 Logitech, Inc. 3Dconnexion SpaceExplorer 3D Mouse

0x046D 0xC628 Logitech, Inc. 3Dconnexion SpaceNavigator for Notebooks

0x046D 0xC629 Logitech, Inc. 3Dconnexion SpacePilot Pro 3D Mouse

0x046D 0xC62B Logitech, Inc. 3Dconnexion SpaceMouse Pro

0x256F ** 3Dconnexion SpaceMouse

USB device reset via USB powercycle is now available on UD6/UD7.
Fixed: Problems with internal graphic cards and Nvidia graphic cards.
Display Switch application will now use some settings from 'Advanced' dialog in 'Simple' mode.
Fixed display hotplug failing on initial lock screen with Active Directory logon.
Fixed screen corruption with DPMS and enabled composite manager.
Fixed screen flickering in some cases when "Force NumLock On" (x.global.forcenumlock) is 
active.
Fixed Display Switch utility not starting with some translations.
Fixed an issue with the noDDC mode which was not always working as expected.
Fixed wrongly detected embedded DisplayPort on Dell Wyse 5070 Extended hardware.
Added the possibility to change an embedded DisplayPort to a normal DisplayPort.
More...

Parameter Use embedded displayport as normal displayport (reboot 
required)

Registry x.drivers.intel.edp_is_dp

Range [default] [enable] [disable]

Fixed some multimonitor (>4) issues with Nvidia graphic cards.
Fixed monitor screen ID shown with Nvidia nvs810 GPU.
Added consideration of hardware limits for choosing automatic resolution in Xorg config
(currently only for IGEL hardware).
Fixed problem with modesetting driver and two 2160x1440 monitors in extended configuration.
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Added a new registry key to enable use of linear framebuffer for modesetting driver.
New registry key:
More...

Parameter Use linear instead of tiled framebuffer

Registry x.drivers.modesetting.use_linear_framebuffer

Range [Default] [False] [True]

Info:

Use linear framebuffer only in special cases.

Fixed configuration where old Display Switch took precedence over configuration from new 
Display Switch and preventing changes.

X Server

Fixed issue with primary / secondary screens were switched in some cases.

Audio

Fixed bad quality sound over DisplayPort in a Citrix ICA session or other applications using ALSA 
API.
Fixed jack detection of the headphone port in Dell Wyse 3040.
Fixed configuration of default audio output and input.

Media Player (Parole)

Fixed a problem where parole media player would hang instead of playing audio while audio-
visualization is enabled.
Fixed parole media player not handling audio hotkeys in fullscreen mode.

Misc

Monitoring Agent uses now only the half size of the debuglog partition. 
When the setup option log_max_size with the option log_rotation creates an overall 
consumption that is bigger than 50% of the debuglog partition size, the size for each log 
automatically will be decreased to a value that allows a full rotation which occupies exactly 50% of 
the partition size.

Hardware

Fixed not working network on Beckhoff CB3163, CB6263 and CB6363 systems.
Fixed not working network on Lex 3I380D.
Fixed shutdown issue of Lenovo ThinkCentre M73 (rebooted 2 - 3 seconds after power off).
Added a possibility to change some DRM settings and limit the DisplayPort lane bandwidth on 
Intel devices.
Added new registry keys:
More...

Parameter Use best graphic mode for all screens on console.
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Registry x.drivers.kms.best_console_mode

Range [Default] [Enabled] [Disabled]

Info: "Default" is enabled in most cases.

Parameter Limit the maximum console resolution width to this value.

Registry x.drivers.kms.max_console_width

Type Integer

Value "0"

Info: "0" means default setting. Use the default setting.

Parameter Limit the maximum console resolution height to this value.

Registry x.drivers.kms.max_console_height

Type Integer

Value "0"

Info: "0" means default setting. Use the default setting.

Parameter Set graphic kernel driver debug level.

Registry x.drivers.kms.debug_level

Range [No debug] [Basic] [Basic + core] [Basic + core + atomic] [Full]

Info: Warning log will grow very fast.

Only for Intel i915 driver:

Parameter Limit the maximum DisplayPort lane link rate.

Registry x.drivers.intel.max_dp_link_rate

Range [default] [1.62Gbps] [2.16Gbps] [2.7Gbps] [3.24Gbps]
[4.32Gbps] [5.4Gbps] [6.48Gbps] [8.1Gbps]  

Info: "Default" means hardware default limit.

Parameter Disable the DP audio support in the i915 DRM driver.

Registry x.drivers.intel.disable_dp_audio

Range [Default][No][Yes]

Info: "Default" - support is enabled.
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Parameter Disable the HDMI audio support in the i915 DRM driver.

Registry x.drivers.intel.disable_hdmi_audio

Range [Default][No][Yes]

Info: "Default" - support is enabled.

Fixed black screen issue with some monitors and 2560x1440 resolution - occurred on UD2 LX50
and other Intel GPUs.
Fixed detection of Dell Wyse 5070 for the non-extended version.
Fixed issues with not working Touchpad and Trackpoint on Lenovo laptops.
Fixed vanishing mouse cursor on Ryzen 3 devices.
Fixed problems with 2 or more monitors on a DisplayLink adapter.
Added possibility to use AMDGPU PRO driver instead of the kernel integrated driver.
Ryzen 3 devices (1200, 1300X, 2200G, 2200U and 2300U) will use the AMDGPU PRO driver if 
registry key x.drivers.amdgpu.use_amdgpu_pro is set to auto (default).
A new registry key (settings to this key will only work after reboot):
More...

Parameter Use AMDGPU PRO driver

Registry x.drivers.amdgpu.use_amdgpu_pro

Range [Auto] [True] [False]

Remote Management

When TC is managed over ICG, settings received in the connection stage does not apply 
immediately. The settings must be applied after user prompt dialog.
Fixed UMS synchronization of configuration changes made in "Emergency mode". Fixed 
sporadically failures while sending data over ICG.
Fixed wallpaper configuration if ICG protocol is used.
Fixed releasing from UMS when the device was offline during removal from UMS.
Added: The endpoint can now report up to 8 monitors in UMS information.
Fixed UMS jobs have not been executed when delivered at the next system boot.
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CA Certificates Contained in IGEL OS 11.02.100
Contained CA certificates:
- ACCVRAIZ1, expires Dec 31 09:37:37 2030 GMT (ACCVRAIZ1.crt)
- AC RAIZ FNMT-RCM, expires Jan 1 00:00:00 2030 GMT (AC_RAIZ_FNMT-RCM.crt)
- Actalis Authentication Root CA, expires Sep 22 11:22:02 2030 GMT (Actalis_Authentication_Root_CA.crt)
- AddTrust External CA Root, expires May 30 10:48:38 2020 GMT (AddTrust_External_Root.crt)
- AffirmTrust Commercial, expires Dec 31 14:06:06 2030 GMT (AffirmTrust_Commercial.crt)
- AffirmTrust Networking, expires Dec 31 14:08:24 2030 GMT (AffirmTrust_Networking.crt)
- AffirmTrust Premium, expires Dec 31 14:10:36 2040 GMT (AffirmTrust_Premium.crt)
- AffirmTrust Premium ECC, expires Dec 31 14:20:24 2040 GMT (AffirmTrust_Premium_ECC.crt)
- Amazon Root CA 1, expires Jan 17 00:00:00 2038 GMT (Amazon_Root_CA_1.crt)
- Amazon Root CA 2, expires May 26 00:00:00 2040 GMT (Amazon_Root_CA_2.crt)
- Amazon Root CA 3, expires May 26 00:00:00 2040 GMT (Amazon_Root_CA_3.crt)
- Amazon Root CA 4, expires May 26 00:00:00 2040 GMT (Amazon_Root_CA_4.crt)
- Atos TrustedRoot 2011, expires Dec 31 23:59:59 2030 GMT (Atos_TrustedRoot_2011.crt)
- Autoridad de Certificacion Firmaprofesional CIF A62634068, expires Dec 31 08:38:15 2030 GMT 
(Autoridad_de_Certificacion_Firmaprofesional_CIF_A62634068.crt)
- Baltimore CyberTrust Root, expires May 12 23:59:00 2025 GMT (Baltimore_CyberTrust_Root.crt)
- Buypass Class 2 Root CA, expires Oct 26 08:38:03 2040 GMT (Buypass_Class_2_Root_CA.crt)
- Buypass Class 3 Root CA, expires Oct 26 08:28:58 2040 GMT (Buypass_Class_3_Root_CA.crt)
- CA Disig Root R2, expires Jul 19 09:15:30 2042 GMT (CA_Disig_Root_R2.crt)
- CFCA EV ROOT, expires Dec 31 03:07:01 2029 GMT (CFCA_EV_ROOT.crt)
- COMODO Certification Authority, expires Dec 31 23:59:59 2029 GMT (COMODO_Certification_Authority.crt)
- COMODO ECC Certification Authority, expires Jan 18 23:59:59 2038 GMT 
(COMODO_ECC_Certification_Authority.crt)
- COMODO RSA Certification Authority, expires Jan 18 23:59:59 2038 GMT 
(COMODO_RSA_Certification_Authority.crt)
- Certigna, expires Jun 29 15:13:05 2027 GMT (Certigna.crt)
- Certigna Root CA, expires Oct 1 08:32:27 2033 GMT (Certigna_Root_CA.crt)
- Certinomis - Root CA, expires Oct 21 09:17:18 2033 GMT (Certinomis_-_Root_CA.crt)
- Class 2 Primary CA, expires Jul 6 23:59:59 2019 GMT (Certplus_Class_2_Primary_CA.crt)
- Certum Trusted Network CA, expires Dec 31 12:07:37 2029 GMT (Certum_Trusted_Network_CA.crt)
- Certum Trusted Network CA 2, expires Oct 6 08:39:56 2046 GMT (Certum_Trusted_Network_CA_2.crt)
- Chambers of Commerce Root - 2008, expires Jul 31 12:29:50 2038 GMT (Chambers_of_Commerce_Root_-_2008.crt)
- AAA Certificate Services, expires Dec 31 23:59:59 2028 GMT (Comodo_AAA_Services_root.crt)
- Cybertrust Global Root, expires Dec 15 08:00:00 2021 GMT (Cybertrust_Global_Root.crt)
- D-TRUST Root Class 3 CA 2 2009, expires Nov 5 08:35:58 2029 GMT (D-TRUST_Root_Class_3_CA_2_2009.crt)
- D-TRUST Root Class 3 CA 2 EV 2009, expires Nov 5 08:50:46 2029 GMT (D-TRUST_Root_Class_3_CA_2_EV_2009.crt)
- DST Root CA X3, expires Sep 30 14:01:15 2021 GMT (DST_Root_CA_X3.crt)
- Deutsche Telekom Root CA 2, expires Jul 9 23:59:00 2019 GMT (Deutsche_Telekom_Root_CA_2.crt)
- DigiCert Global Root CA, expires Nov 10 00:00:00 2031 GMT (DigiCertGlobalRootCA.pem)
- DigiCert Assured ID Root CA, expires Nov 10 00:00:00 2031 GMT (DigiCert_Assured_ID_Root_CA.crt)
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- DigiCert Assured ID Root G2, expires Jan 15 12:00:00 2038 GMT (DigiCert_Assured_ID_Root_G2.crt)
- DigiCert Assured ID Root G3, expires Jan 15 12:00:00 2038 GMT (DigiCert_Assured_ID_Root_G3.crt)
- DigiCert Global Root CA, expires Nov 10 00:00:00 2031 GMT (DigiCert_Global_Root_CA.crt)
- DigiCert Global Root G2, expires Jan 15 12:00:00 2038 GMT (DigiCert_Global_Root_G2.crt)
- DigiCert Global Root G3, expires Jan 15 12:00:00 2038 GMT (DigiCert_Global_Root_G3.crt)
- DigiCert High Assurance EV Root CA, expires Nov 10 00:00:00 2031 GMT (DigiCert_High_Assurance_EV_Root_CA.crt)
- DigiCert Trusted Root G4, expires Jan 15 12:00:00 2038 GMT (DigiCert_Trusted_Root_G4.crt)
- E-Tugra Certification Authority, expires Mar 3 12:09:48 2023 GMT (E-Tugra_Certification_Authority.crt)
- EC-ACC, expires Jan 7 22:59:59 2031 GMT (EC-ACC.crt)
- EE Certification Centre Root CA, expires Dec 17 23:59:59 2030 GMT (EE_Certification_Centre_Root_CA.crt)
- Entrust.net32 Certification Authority (2048), expires Jul 24 14:15:12 2029 GMT 
(Entrust.net_Premium_2048_Secure_Server_CA.crt)
- Entrust Root Certification Authority, expires Nov 27 20:53:42 2026 GMT (Entrust_Root_Certification_Authority.crt)
- Entrust Root Certification Authority - EC1, expires Dec 18 15:55:36 2037 GMT 
(Entrust_Root_Certification_Authority_-_EC1.crt)
- Entrust Root Certification Authority - G2, expires Dec 7 17:55:54 2030 GMT (Entrust_Root_Certification_Authority_-
_G2.crt)
- GDCA TrustAUTH R5 ROOT, expires Dec 31 15:59:59 2040 GMT (GDCA_TrustAUTH_R5_ROOT.crt)
- GTS Root R1, expires Jun 22 00:00:00 2036 GMT (GTS_Root_R1.crt)
- GTS Root R2, expires Jun 22 00:00:00 2036 GMT (GTS_Root_R2.crt)
- GTS Root R3, expires Jun 22 00:00:00 2036 GMT (GTS_Root_R3.crt)
- GTS Root R4, expires Jun 22 00:00:00 2036 GMT (GTS_Root_R4.crt)
- GeoTrust Global CA, expires May 21 04:00:00 2022 GMT (GeoTrust_Global_CA.crt)
- GeoTrust Primary Certification Authority, expires Jul 16 23:59:59 2036 GMT 
(GeoTrust_Primary_Certification_Authority.crt)
- GeoTrust Primary Certification Authority - G2, expires Jan 18 23:59:59 2038 GMT 
(GeoTrust_Primary_Certification_Authority_-_G2.crt)
- GeoTrust Primary Certification Authority - G3, expires Dec 1 23:59:59 2037 GMT 
(GeoTrust_Primary_Certification_Authority_-_G3.crt)
- GeoTrust Universal CA, expires Mar 4 05:00:00 2029 GMT (GeoTrust_Universal_CA.crt)
- GeoTrust Universal CA 2, expires Mar 4 05:00:00 2029 GMT (GeoTrust_Universal_CA_2.crt)
- GlobalSign, expires Jan 19 03:14:07 2038 GMT (GlobalSign_ECC_Root_CA_-_R4.crt)
- GlobalSign, expires Jan 19 03:14:07 2038 GMT (GlobalSign_ECC_Root_CA_-_R5.crt)
- GlobalSign Root CA, expires Jan 28 12:00:00 2028 GMT (GlobalSign_Root_CA.crt)
- GlobalSign, expires Dec 15 08:00:00 2021 GMT (GlobalSign_Root_CA_-_R2.crt)
- GlobalSign, expires Mar 18 10:00:00 2029 GMT (GlobalSign_Root_CA_-_R3.crt)
- GlobalSign, expires Dec 10 00:00:00 2034 GMT (GlobalSign_Root_CA_-_R6.crt)
- Global Chambersign Root - 2008, expires Jul 31 12:31:40 2038 GMT (Global_Chambersign_Root_-_2008.crt)
- Go Daddy Class 2 Certification Authority, expires Jun 29 17:06:20 2034 GMT (Go_Daddy_Class_2_CA.crt)
- Go Daddy Root Certificate Authority - G2, expires Dec 31 23:59:59 2037 GMT 
(Go_Daddy_Root_Certificate_Authority_-_G2.crt)
- Hellenic Academic and Research Institutions ECC RootCA 2015, expires Jun 30 10:37:12 2040 GMT 
(Hellenic_Academic_and_Research_Institutions_ECC_RootCA_2015.crt)
- Hellenic Academic and Research Institutions RootCA 2011, expires Dec 1 13:49:52 2031 GMT 
(Hellenic_Academic_and_Research_Institutions_RootCA_2011.crt)
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- Hellenic Academic and Research Institutions RootCA 2015, expires Jun 30 10:11:21 2040 GMT 
(Hellenic_Academic_and_Research_Institutions_RootCA_2015.crt)
- Hongkong Post Root CA 1, expires May 15 04:52:29 2023 GMT (Hongkong_Post_Root_CA_1.crt)
- ISRG Root X1, expires Jun 4 11:04:38 2035 GMT (ISRG_Root_X1.crt)
- IdenTrust Commercial Root CA 1, expires Jan 16 18:12:23 2034 GMT (IdenTrust_Commercial_Root_CA_1.crt)
- IdenTrust Public Sector Root CA 1, expires Jan 16 17:53:32 2034 GMT (IdenTrust_Public_Sector_Root_CA_1.crt)
- Imprivata Embedded Code Signing CA, expires Sep 7 16:20:00 2033 GMT (Imprivata.crt)
- Izenpe.com33, expires Dec 13 08:27:25 2037 GMT (Izenpe.com34.crt)
- LuxTrust Global Root 2, expires Mar 5 13:21:57 2035 GMT (LuxTrust_Global_Root_2.crt)
- Microsec e-Szigno Root CA 2009, expires Dec 30 11:30:18 2029 GMT (Microsec_e-Szigno_Root_CA_2009.crt)
- NetLock Arany (Class Gold) Főtanúsítvány, expires Dec 6 15:08:21 2028 GMT 
(NetLock_Arany_=Class_Gold=_Főtanúsítvány.crt)
- Network Solutions Certificate Authority, expires Dec 31 23:59:59 2029 GMT 
(Network_Solutions_Certificate_Authority.crt)
- OISTE WISeKey Global Root GA CA, expires Dec 11 16:09:51 2037 GMT (OISTE_WISeKey_Global_Root_GA_CA.crt)
- OISTE WISeKey Global Root GB CA, expires Dec 1 15:10:31 2039 GMT (OISTE_WISeKey_Global_Root_GB_CA.crt)
- OISTE WISeKey Global Root GC CA, expires May 9 09:58:33 2042 GMT (OISTE_WISeKey_Global_Root_GC_CA.crt)
- QuoVadis Root Certification Authority, expires Mar 17 18:33:33 2021 GMT (QuoVadis_Root_CA.crt)
- QuoVadis Root CA 1 G3, expires Jan 12 17:27:44 2042 GMT (QuoVadis_Root_CA_1_G3.crt)
- QuoVadis Root CA 2, expires Nov 24 18:23:33 2031 GMT (QuoVadis_Root_CA_2.crt)
- QuoVadis Root CA 2 G3, expires Jan 12 18:59:32 2042 GMT (QuoVadis_Root_CA_2_G3.crt)
- QuoVadis Root CA 3, expires Nov 24 19:06:44 2031 GMT (QuoVadis_Root_CA_3.crt)
- QuoVadis Root CA 3 G3, expires Jan 12 20:26:32 2042 GMT (QuoVadis_Root_CA_3_G3.crt)
- SSL.com35 EV Root Certification Authority ECC, expires Feb 12 18:15:23 2041 GMT 
(SSL.com_EV_Root_Certification_Authority_ECC.crt)
- SSL.com36 EV Root Certification Authority RSA R2, expires May 30 18:14:37 2042 GMT 
(SSL.com_EV_Root_Certification_Authority_RSA_R2.crt)
- SSL.com37 Root Certification Authority ECC, expires Feb 12 18:14:03 2041 GMT 
(SSL.com_Root_Certification_Authority_ECC.crt)
- SSL.com38 Root Certification Authority RSA, expires Feb 12 17:39:39 2041 GMT 
(SSL.com_Root_Certification_Authority_RSA.crt)
- SZAFIR ROOT CA2, expires Oct 19 07:43:30 2035 GMT (SZAFIR_ROOT_CA2.crt)
- SecureSign RootCA11, expires Apr 8 04:56:47 2029 GMT (SecureSign_RootCA11.crt)
- SecureTrust CA, expires Dec 31 19:40:55 2029 GMT (SecureTrust_CA.crt)
- Secure Global CA, expires Dec 31 19:52:06 2029 GMT (Secure_Global_CA.crt)
- Security Communication RootCA2, expires May 29 05:00:39 2029 GMT (Security_Communication_RootCA2.crt)
- Security Communication RootCA1, expires Sep 30 04:20:49 2023 GMT (Security_Communication_Root_CA.crt)
- Sonera Class2 CA, expires Apr 6 07:29:40 2021 GMT (Sonera_Class_2_Root_CA.crt)
- Staat der Nederlanden EV Root CA, expires Dec 8 11:10:28 2022 GMT (Staat_der_Nederlanden_EV_Root_CA.crt)
- Staat der Nederlanden Root CA - G2, expires Mar 25 11:03:10 2020 GMT (Staat_der_Nederlanden_Root_CA_-
_G2.crt)
- Staat der Nederlanden Root CA - G3, expires Nov 13 23:00:00 2028 GMT (Staat_der_Nederlanden_Root_CA_-
_G3.crt)
- Starfield Class 2 Certification Authority, expires Jun 29 17:39:16 2034 GMT (Starfield_Class_2_CA.crt)
- Starfield Root Certificate Authority - G2, expires Dec 31 23:59:59 2037 GMT (Starfield_Root_Certificate_Authority_-
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_G2.crt)
- Starfield Services Root Certificate Authority - G2, expires Dec 31 23:59:59 2037 GMT 
(Starfield_Services_Root_Certificate_Authority_-_G2.crt)
- SwissSign Gold CA - G2, expires Oct 25 08:30:35 2036 GMT (SwissSign_Gold_CA_-_G2.crt)
- SwissSign Silver CA - G2, expires Oct 25 08:32:46 2036 GMT (SwissSign_Silver_CA_-_G2.crt)
- T-TeleSec GlobalRoot Class 2, expires Oct 1 23:59:59 2033 GMT (T-TeleSec_GlobalRoot_Class_2.crt)
- T-TeleSec GlobalRoot Class 3, expires Oct 1 23:59:59 2033 GMT (T-TeleSec_GlobalRoot_Class_3.crt)
- TUBITAK Kamu SM SSL Kok Sertifikasi - Surum 1, expires Oct 25 08:25:55 2043 GMT 
(TUBITAK_Kamu_SM_SSL_Kok_Sertifikasi_-_Surum_1.crt)
- TWCA Global Root CA, expires Dec 31 15:59:59 2030 GMT (TWCA_Global_Root_CA.crt)
- TWCA Root Certification Authority, expires Dec 31 15:59:59 2030 GMT (TWCA_Root_Certification_Authority.crt)
- Government Root Certification Authority, expires Dec 5 13:23:33 2032 GMT (Taiwan_GRCA.crt)
- TeliaSonera Root CA v1, expires Oct 18 12:00:50 2032 GMT (TeliaSonera_Root_CA_v1.crt)
- TrustCor ECA-1, expires Dec 31 17:28:07 2029 GMT (TrustCor_ECA-1.crt)
- TrustCor RootCert CA-1, expires Dec 31 17:23:16 2029 GMT (TrustCor_RootCert_CA-1.crt)
- TrustCor RootCert CA-2, expires Dec 31 17:26:39 2034 GMT (TrustCor_RootCert_CA-2.crt)
- Trustis FPS Root CA, expires Jan 21 11:36:54 2024 GMT (Trustis_FPS_Root_CA.crt)
- UCA Extended Validation Root, expires Dec 31 00:00:00 2038 GMT (UCA_Extended_Validation_Root.crt)
- UCA Global G2 Root, expires Dec 31 00:00:00 2040 GMT (UCA_Global_G2_Root.crt)
- USERTrust ECC Certification Authority, expires Jan 18 23:59:59 2038 GMT 
(USERTrust_ECC_Certification_Authority.crt)
- USERTrust RSA Certification Authority, expires Jan 18 23:59:59 2038 GMT 
(USERTrust_RSA_Certification_Authority.crt)
- VeriSign Class 3 Public Primary Certification Authority - G4, expires Jan 18 23:59:59 2038 GMT 
(VeriSign_Class_3_Public_Primary_Certification_Authority_-_G4.crt)
- VeriSign Class 3 Public Primary Certification Authority - G5, expires Jul 16 23:59:59 2036 GMT 
(VeriSign_Class_3_Public_Primary_Certification_Authority_-_G5.crt)
- VeriSign Universal Root Certification Authority, expires Dec 1 23:59:59 2037 GMT 
(VeriSign_Universal_Root_Certification_Authority.crt)
- VeriSign Class 3 Public Primary Certification Authority - G3, expires Jul 16 23:59:59 2036 GMT 
(Verisign_Class_3_Public_Primary_Certification_Authority_-_G3.crt)
- XRamp Global Certification Authority, expires Jan 1 05:37:19 2035 GMT (XRamp_Global_CA_Root.crt)
- certSIGN ROOT CA, expires Jul 4 17:20:04 2031 GMT (certSIGN_ROOT_CA.crt)
- ePKI Root Certification Authority, expires Dec 20 02:31:27 2034 GMT (ePKI_Root_Certification_Authority.crt)
- thawte Primary Root CA, expires Jul 16 23:59:59 2036 GMT (thawte_Primary_Root_CA.crt)
- thawte Primary Root CA - G2, expires Jan 18 23:59:59 2038 GMT (thawte_Primary_Root_CA_-_G2.crt)
- thawte Primary Root CA - G3, expires Dec 1 23:59:59 2037 GMT (thawte_Primary_Root_CA_-_G3.crt)
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•
•

IGEL OS Creator (OSC)

Supported Devices
UD2-LX: UD2-LX 40

UD2-LX 50

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Third-Party Devices Supported by IGEL OS 11.

Component Versions 11.02.100 (see page 796)
New Features 11.02.100 (see page 796)
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•

•

•

Component Versions 11.02.100
Clients
Product Version

Zulu JRE 8.40.0.25

Smartcard
Reader Driver MUSCLE CCID 1.4.30-1igel3

Resource Manager PC/SC Lite 1.8.23-1igel1

System Components
OpenSSL 1.0.2g-1ubuntu4.15

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190724-igel907

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 418.56-0ubuntu1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMMouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.65 #mainline-lxos-r2782
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Xorg X11 Server 1.19.6-1ubuntu4.3igel910

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2
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•
•
•
•
•
•
•
•

New Features 11.02.100
Hardware

Added hardware support for Rein Medical Silenio 122CT and 124CT.
Added hardware support for Advantech POC-W213L and POC-W243L.
Added hardware support for ADS-TEC VMT 9000 Serie.
Added hardware support for Fujitsu Esprimo Q957.
Added hardware support for ADS-TEC VMT 9000 Serie.
Added hardware support for LG AiO Cloud Device 38".
Added hardware support for HP t430.
Added hardware support for HP t420.
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•
•
•
•
•
•
•

Notes for Release 11.01.130
Software: Version 11.01.130

Release Date: 2019-07-24

Release Notes: Version RN-1101130-1

Last update: 2019-07-23

Supported Devices 11.01.130 (see page 800)
Component Versions 11.01.130 (see page 800)
General Information 11.01.130 (see page 806)
Known Issues 11.01.130 (see page 807)
Security Fixes 11.01.130 (see page 809)
New Features 11.01.130 (see page 810)
Resolved Issues 11.01.130 (see page 811)
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Supported Devices 11.01.130
IGEL devices:

UD2-LX: UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Devices Supported by IGEL OS 11.
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•

Component Versions 11.01.130
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.3.0.5

deviceTRUST Citrix Channel 19.1.200.2

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.8.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.2.20595

Remote Viewer (Red Hat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0

Teradici PCoIP Software Client 19.05.4-18.04

ThinLinc Client 4.9.0-5775

ThinPrint Client 7.5.88
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•

•

•

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel16

VNC Viewer 1.8.0+git20180123-igel1

VMware Horizon Client 5.0.0-12557422

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.6.36

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.0.23

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.30-1igel3
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•

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.14

OpenSSH Client 7.2p2-4ubuntu2.7

OpenSSH Server 7.2p2-4ubuntu2.7

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.3.3-1igel57

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190301-igel870

Graphics Driver ATI/RADEON 18.1.0-1igel854

Graphics Driver ATI/AMDGPU 18.1.0-1igel853

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2igel775

Graphics Driver Nvidia 410.93-0ubuntu1

Graphics Driver Vboxvideo 5.2.18-dfsg-2igel17

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver VMMouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-udos-r2755

Xorg X11 Server 1.19.6-1ubuntu4.2igel842
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•

•

Xorg Xephyr 1.19.6-1ubuntu4.2igel842

CUPS Printing Daemon 2.1.3-4ubuntu0.7igel23

PrinterLogic 18.2.1.128

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2ubuntu1igel2

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.4-1ubuntu1igel203

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client
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General Information 11.01.130
The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
Ericom PowerTerm
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver.
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Known Issues 11.01.130
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
When using Citrix Workspace App 19.03 in combination with Philips Speech driver, the session 
occasionally terminates improperly at logout and hangs.
As a workaround, the usage of Citrix Receiver 13.10 is recommended when Philips Speech driver is 
needed.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and H264 acceleration

Registry ica.workaround-dual-rtme

Range enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: mapping the directory / media as a drive on desktop. The external devices will show 
up within the media drive then.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
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On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
Furthermore, Horizon Client relies on the OS to mount the storage devices itself. Enable 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug. The 
Number of storage hotplug devices has to be set to at least 1.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
once with disabled FIPS support.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Base system

On NVIDIA GPU drivers, the reported resolutions of a display may contain unsupported 
resolutions. When any of those are configured, there are visual bugs (e.g. the desktop does not 
render properly).
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Security Fixes 11.01.130
Firefox

Updated Firefox browser to version 60.8.0 ESR.
Fixed mfsa2019-22 security issues:
More...

CVE-2019-9811, CVE-2019-11711, CVE-2019-11712, CVE-2019-11713,
CVE-2019-11729, CVE-2019-11715, CVE-2019-11717, CVE-2019-11719,
CVE-2019-11730 and CVE-2019-11709.

Fixed mfsa2019-19 security issue CVE-2019-11708.
Fixed mfsa2019-18 security issue CVE-2019-11707.
Fixed mfsa2019-08 security issues:
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792,
CVE-2019-9793, CVE-2019-9795, CVE-2019-9796,
CVE-2018-18506 and CVE-2019-9788.

Fixed mfsa2019-05 security issues CVE-2018-18356 and CVE-2019-5785.
Fixed mfsa2019-02 security issues CVE-2018-18500, CVE-2018-18505 and CVE-2018-18501.
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New Features 11.01.130
Citrix

Added support for Citrix Workspace Launcher functionality as described at https://
support.citrix.com/article/CTX237727.

Base system

Replaced timesyncd with chrony NTP. 
A new registry key:
More...

Parameter Use NTP Servers from DNS SRV record

Registry system.time.ntp_use_dnssrv_timeservers

Value enabled / disabled

Evidian

Integrated Evidian AuthMgr version 1.5.7116.

https://support.citrix.com/article/CTX237727
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Resolved Issues 11.01.130
VMware Horizon

Added a possibility to use the rollback variant of the Horizon Client.
More...

Parameter Allow rollback to former client variant

Registry vmware.view.allow-client-rollback

Value enabled / disabled

Base system

Fixed NTP synchronization problems with changing the NTP client from timesyncd to chrony.
Fixed USB printer aliases.

X11 system

Fixed screen corruption with DPMS and enabled composite manager.
Added consideration of hardware limits for choosing automatic resolution in Xorg config
(currently only for IGEL hardware).

Hardware

Fixed black screen issue with some monitors and 2560x1440 resolution (occurred on UD2 LX50
and other Intel GPUs).
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Notes for Release 11.01.120
Software: Version 11.01.120

Release Date: 2019-07-05

Release Notes: Version RN-1101120-1

Last update: 2019-07-05

Supported Devices 11.01.120 (see page 813)
Component Versions 11.01.120 (see page 814)
General Information 11.01.120 (see page 818)
Security Fixes 11.01.120 (see page 819)
New Features 11.01.120 (see page 820)
Resolved Issues 11.01.120 (see page 821)
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Supported Devices 11.01.120
IGEL devices:

UD2-LX: UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

See also Devices Supported by IGEL OS 11.
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Component Versions 11.01.120
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.3.0.5

deviceTRUST Citrix Channel 19.1.200.2

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.7.2

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.2.20595

Remote Viewer (Red Hat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0

Teradici PCoIP Software Client 19.05.4-18.04

ThinLinc Client 4.9.0-5775

ThinPrint Client 7.5.88
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Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel16

VNC Viewer 1.8.0+git20180123-igel1

VMware Horizon Client 5.0.0-12557422

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.6.36

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.0.23

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.30-1igel3
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Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.14

OpenSSH Client 7.2p2-4ubuntu2.7

OpenSSH Server 7.2p2-4ubuntu2.7

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.3.3-1igel57

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190301-igel870

Graphics Driver ATI/RADEON 18.1.0-1igel854

Graphics Driver ATI/AMDGPU 18.1.0-1igel853

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2igel775

Graphics Driver Nvidia 410.93-0ubuntu1

Graphics Driver Vboxvideo 5.2.18-dfsg-2igel17

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver VMMouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-udos-r2755

Xorg X11 Server 1.19.6-1ubuntu4.2igel842
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Xorg Xephyr 1.19.6-1ubuntu4.2igel842

CUPS Printing Daemon 2.1.3-4ubuntu0.7igel23

PrinterLogic 18.2.1.128

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2ubuntu1igel2

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.4-1ubuntu1igel203

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.1
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General Information 11.01.120
The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
Ericom PowerTerm
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver
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Security Fixes 11.01.120
Firefox

Updated Firefox browser to version 60.7.2 ESR.
Fixed mfsa2019-19 security issue CVE-2019-11708.
Fixed mfsa2019-18 security issue CVE-2019-11707.
Fixed mfsa2019-08 security issues.
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793, 
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, CVE-2019-9788.

Fixed mfsa2019-05 security issues CVE-2018-18356 and CVE-2019-5785.
Fixed mfsa2019-02 security issues CVE-2018-18500, CVE-2018-18505 and CVE-2018-18501.

Base system

Fixed kernel TCP vulnerabilities CVE-2019-11477: SACK Panic, CVE-2019-11478: SACK Slowness 
and CVE-2019-11479: Excess Resource Consumption Due to Low MSS Values.
Changed minimally allowed MSS size to '1000' to prevent possible Denial-of-Service attacks.
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New Features 11.01.120
Citrix

Added support for Citrix Workspace Launcher functionality as described at https://
support.citrix.com/article/CTX237727.

Teradici PCoIP Client

Updated Teradici PCoIP Client to version 19.05.4.

https://support.citrix.com/article/CTX237727
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Resolved Issues 11.01.120
Citrix

SpaceMouse: Improved USB handling.
Citrix Workspace App 19.03: Improved USB redirection handling.

Network

Fixed: The second Ethernet interface did not get configured when the first one was disabled.

Base system

Fixed license expiry warning at boot. Before this fix, in some cases the warning wrongly appeared 
at every boot.
Fixed: System logout waits for Citrix logout now.

Appliance Mode

Fixed: In-session control bar could not be deactivated in Citrix Self-Service appliance mode.

X11 system

Fixed: Problems with internal graphic cards and Nvidia graphic cards.

RD Web Access

Fixed not starting RDP Remote Applications.

Hardware

Fixed not working network on Beckhoff CB3163, CB6263 and CB6363 systems.
Fixed not working network on Lex 3I380D.
Fixed black screen issue with some monitors and 2560x1440 resolution (occurred on UD2 LX50).
Added possibility to change some DRM settings and limit the DisplayPort lane bandwidth on 
Intel devices.
Added new registry keys:
More...

Parameter Use best graphic mode for all screens on console.

Registry x.drivers.kms.best_console_mode

Range [Default] [Enabled] [Disabled]

Info: "Default" is enabled in most cases.

Parameter Limit the maximum console resolution width to this value.

Registry x.drivers.kms.max_console_width

Type Integer

Value "0"
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Info: "0" means default setting. Use the default setting.

Parameter Limit the maximum console resolution height to this value.

Registry x.drivers.kms.max_console_height

Type Integer

Value "0"

Info: "0" means default setting. Use the default setting.

Parameter Set graphic kernel driver debug level.

Registry x.drivers.kms.debug_level

Range [No debug] [Basic] [Basic + core] [Basic + core + atomic] [Full]

Info: Warning log will grow very fast.

Only for Intel i915 driver:

Parameter Limit the maximum DisplayPort lane link rate.

Registry x.drivers.intel.max_dp_link_rate

Range [default] [1.62Gbps] [2.16Gbps] [2.7Gbps] [3.24Gbps]
[4.32Gbps] [5.4Gbps] [6.48Gbps] [8.1Gbps]  

Info: "Default" means hardware default limit.
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Notes for Release 11.01.110
Software: Version 11.01.110

Release Date: 2019-06-06

Release Notes: Version RN-1101110-1

Last update: 2019-06-06

Supported Devices 11.01.110 (see page 824)
Component Versions 11.01.110 (see page 825)
General Information 11.01.110 (see page 829)
Security Fixes 11.01.110 (see page 830)
Known Issues 11.01.110 (see page 831)
New Features 11.01.110 (see page 833)
Resolved Issues 11.01.110 (see page 841)
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Supported Devices 11.01.110
IGEL devices:

UD2-LX: UD2-LX 50

UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

For supported IGEL OS 11 third-party devices, see Devices Supported by IGEL OS 11.
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Component Versions 11.01.110
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.3.0.5

deviceTRUST Citrix Channel 19.1.200.2

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.7.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

deviceTRUST RDP Channel 19.1.200.2

NCP Secure Enterprise Client 5.10_rev40552

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Zulu JRE 8.36.0.1

Parallels Client (64 bit) 16.5.2.20595

Remote Viewer (Red Hat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0

Teradici PCoIP Software Client 19.05.1-18.04

ThinLinc Client 4.9.0-5775

ThinPrint Client 7.5.88
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Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel16

VNC Viewer 1.8.0+git20180123-igel1

VMware Horizon Client 5.0.0-12557422

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.6.36

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.0.23

PKCS#11 Library 90meter 20190522

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.30-1igel3
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Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.14

OpenSSH Client 7.2p2-4ubuntu2.7

OpenSSH Server 7.2p2-4ubuntu2.7

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.3.3-1igel57

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190301-igel870

Graphics Driver ATI/RADEON 18.1.0-1igel854

Graphics Driver ATI/AMDGPU 18.1.0-1igel853

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2igel775

Graphics Driver Nvidia 410.93-0ubuntu1

Graphics Driver Vboxvideo 5.2.18-dfsg-2igel17

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver VMMouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-udos-r2519

Xorg X11 Server 1.19.6-1ubuntu4.2igel842
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Xorg Xephyr 1.19.6-1ubuntu4.2igel842

CUPS Printing Daemon 2.1.3-4ubuntu0.7igel23

PrinterLogic 18.2.1.128

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2ubuntu1igel2

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.4-1ubuntu1igel203

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.1
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General Information 11.01.110
The following clients and features are not supported anymore

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
Ericom PowerTerm
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver
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Security Fixes 11.01.110
Firefox

Updated Mozilla Firefox to version 60.7.0esr.
Fixed mfsa2019-08 security issues.
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,

CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, CVE-2019-9788.

Fixed mfsa2019-05 security issues CVE-2018-18356 and CVE-2019-5785.
Fixed mfsa2019-02 security issues CVE-2018-18500, CVE-2018-18505 and CVE-2018-18501.
Firefox is now allowed to access YubiKey (FIDO/U2F) if AppArmor is active.

Base system

Updated libwebkit2gtk-4.0-37 to version 1.24.2.
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251,

CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378,

CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345,

CVE-2018-4386 and CVE-2018-4372.
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Known Issues 11.01.110
Citrix

With an activated DRI3 and an AMD GPU, Citrix H.264 acceleration plugin could freeze. A 
selective H.264 mode (API v2) is not affected by this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H.264, MPEG1 and MPEG2. GStreamer1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront Login with Gemalto smartcard middleware does not detect smartcard 
correctly if the card is inserted after the start of Login.
As a workaround, insert the smartcard before starting StoreFront Login.
When using Citrix Workspace App 18.10 in combination with Philips Speech driver, the session 
occasionally does not properly terminate at logoff and hangs.
As a workaround, the usage of Citrix Receiver 13.10 is recommended when Philips Speech driver is 
needed. 
Citrix H.264 acceleration plugin does not work with the enabled server policy Optimize for 3D 
graphics workload in combination with the server policy Use video codec compression > For the 
entire screen.

VMware Horizon

External drives are mounted already before connection, do not appear in the remote desktop. 
Workaround: Mapping the directory/media as a drive on desktop. The external devices will show 
up within the media drive then.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended either to switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Storage Hotplug on setup page Devices > Storage Devices > Storage Hotplug has to be 
enabled and the Number of storage hotplug devices has to be set to at least 1.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
once with disabled FIPS support.

Smartcard

In seldom cases, the authentication hung when using A.E.T. SafeSign smartcards.
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Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Base system

On NVIDIA GPU drivers, the reported resolutions of a display may contain unsupported 
resolutions. When any of those are configured, there are visual bugs (e.g. the desktop does not 
render properly).
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New Features 11.01.110
Citrix

Integrated Citrix Workspace app 19.03.
Added new registry key to support 1536-bit RSA keys for client authentication. 
More...

Parameter Enable RSA 1536 cipher suit

Registry ica.allregions.enabl_rsa_1536

Range factory default / false / true

Added new registry key to enable different cipher suites for client authentication.
More...

Parameter Enables different cipher suites

Registry ica.allregions.sslciphers

Range factory default / ALL / GOV / COM

TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA – COM/ALL
Added new registry key to support keyboard layout syncroniyation.

More...

Parameter Keyboard layout synchronization

Registry ica.modules.virtualdriver.keyboardsync.enab

le

Value enabled / disabled

Updated Citrix HDX RTME, used for optimization of Skype for Business, to version  2.8.0-2235

RDP/IGEL RDP Client 2

Added Field Collection to RDP session server page

VMware Horizon

Added parameters to specify webcam frame size and rate for RTAV.
More...

Parameter Webcam frame width

Registry vmware.view.rtav-frame-width
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Value <empty_string>

Parameter Webcam frame height

Registry vmware.view.rtav-frame-height

Value <empty_string>

Parameter Webcam frame rate

Registry vmware.view.rtav-frame-rate

Value <empty_string>

Updated Horizon Client to version 5.0.0-12557422
Added possibility to easily evaluate Horizon Blast decoder states. By default sessions are 
evaluated after usage and the result is written into the journal log.
This can also be used with GUI notifications at runtime.

Teradici PCoIP Client

Added Teradici PCoIP Client version 19.05.1. This feature requires an additional license. 
More...

IGEL Setup System > Firmware Customization > Features

Parameter Teradici PCoIP Client

Registry services.addition_teradici_pcoip_client.enabled

Value enabled / disabled

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions > PCoIP Session > 
Connection settings

Parameter Use IGEL Setup for configuration

Registry sessions.pcoip<NR>.options.igel-connection

Value enabled / disabled

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions > PCoIP Session > 
Connection settings

Parameter Server

Registry sessions.pcoip<NR>.options.address

Value <empty_string>

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions > PCoIP Session > 
Connection settings
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Parameter Server certificate verification mode

Registry sessions.pcoip<NR>.options.security-mode

Range [Not required][Warn but allow][Full verification]

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions > PCoIP Session > 
Login

Parameter Authentication type

Registry sessions.pcoip<NR>.options.auth-type

Range [Password authentication][Smartcard authentication]

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions > PCoIP Session > 
Window

Parameter Window mode

Registry sessions.pcoip<NR>.options.window-mode

Range [User defined][Fullscreen One Monitor][Fullscreen All Monitors]
[Window]

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions > PCoIP Session > 
Window

Parameter User interface translation

Registry sessions.pcoip<NR>.options.language 

Range [System setting][English] [German] [French][Spanish] [Portuguese (EU)] 
[Portuguese (Brazil)] [Italian][Japanese] [Chinese(Simplified)] 
[Chinese(Traditional)]

IGEL Setup Sessions > Teradici PCoIP Client > PCoIP Sessions > PCoIP Session > 
Window

Parameter Log level

Registry sessions.pcoip<NR>.options.log-level 

Range [Critical][Error][ Info][Debug]

Network

Added a mechanism for retrieving the SCEP challenge password with a custom script. 
Setting the following registry key to true enables the use of the script. The registry key 
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network.scepclient.cert%.crypt_password  will be ignored. (The script may use it for 
its own purpose though.)
More...

Parameter Use Challenge Password Command

Registry network.scepclient.cert%.use_challenge_password_com

mand

Value enabled / disabled

If the above key is true, the value of this key will be passed to bash for execution. It happens 
when the SCEP challenge password is needed for creating a certificate signing request. The script 
is supposed to output the challenge password on its standard output. For convenience any 
carriage return characters are stripped off the script before execution by bash.
More...

Parameter Challenge Password Command

Registry network.scepclient.cert%.challenge_password_comma

nd

Value <empty_string>

Wi-Fi

Added support for Realtek 8821CE wireless cards.

Smartcard

Added 90meter smart card library. This feature requires an additional license. 
More...

IGEL Setup System > Firmware Customization > Features

Parameter 90meter Smart Card Support

Registry services.addition_smartcard_90meter.enabled

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by 90meter library

Registry vmware.view.pkcs11.use_90meter

Value enabled / disabled

IGEL Setup Sessions > Browser > Browser Global > Smartcard Middleware
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Parameter 90meter Security Device

Registry browserglobal.security_device.90meter

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter 90meter 

Registry scard.pkcs11.use_90meter

Value enabled / disabled

Base System

Added package ldap-utils which can be used by custom scripts.
Updated libwebkit2gtk-4.0-37 to version 1.24.2.
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251,

CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378,

CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345,

CVE-2018-4386, CVE-2018-4372

Updated EULA displayed in OSC and IGEL Setup Assistant.
When the IGEL Setup Assistant is used to download a demo license via WiFi, the local WiFi 
manager will be enabled by default.
Added possibility to configure scheduled commands. Registry keys: system.cron.*

Driver

Updated deviceTRUST Client to version 19.1.200.  This release includes support for logical disks 
attached to the IGEL endpoint, plus bug fixes and stability improvements over the previous 
19.1.100 release.
Logical Disks
Added support for real-time properties representing the LOGICAL DISKS  attached to the IGEL 
endpoint. 
This includes...

DEVICE_LOGICALDISK_X_TYPE – Either Fixed or Removable.
DEVICE_LOGICALDISK_X_LABEL – The volume label.
DEVICE_LOGICALDISK_X_FILESYSTEM – The type of file system.
DEVICE_LOGICALDISK_X_PATHS – The paths that the disk is mounted.
DEVICE_LOGICALDISK_X_TOTALMB – The total space available on the disk. This property is 
only available for mounted disks.
DEVICE_LOGICALDISK_X_FREEMB – The free space available on the disk. This  property is 
only available for mounted disks.
DEVICE_LOGICALDISK_X_NAME – The name of the underlying physical disk.
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DEVICE_LOGICALDISK_X_VENDORID – The vendor identifier uniquely identifying the  
manufacturer. This property is only available for USB or PCI connected  devices.
DEVICE_LOGICALDISK_X_PRODUCTID – The product identifier uniquely identifying  the 
product. This property is only available for USB or PCI connected devices.
DEVICE_LOGICALDISK_X_SERIALNUMBER – The serial number of the physical disk.
DEVICE_LOGICALDISK_X_BUSTYPE – The storage bus type linked to the physical  disk.
DEVICE_LOGICALDISK_COUNT – The number of logical disks.

Added registry keys to modify the intel graphic driver usage of framebuffer compression and 
power management.
More...

Parameter Power saving display C-States to use. 

Registry x.drivers.intel.dc_setting

Range [Default][Disable][Up to DC5][Up to DC6]

Parameter Use framebuffer compression.

Registry x.drivers.intel.fbc_setting

Range [Default][Disable]

X11 System

Added new registry keys to change the xorg input driver for a input device class.
More...

For keyboards:

Parameter Xorg driver to use

Registry userinterface.keyboard.driver

Range [Evdev] [Libinput]

For touchpads:

Parameter Xorg driver to use

Registry userinterface.touchpad.driver

Range [Evdev] [Synaptics] [Libinput]

For touchscreens:

Parameter Xorg driver to use

Registry userinterface.touchscreen.xorg_driver

Range [Evdev][Libinput]
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For mouse:

Parameter Xorg driver to use

Registry userinterface.mouse.driver

Range [Evdev][Libinput]

Added some registry keys to disable loading of DRM kernel modules (graphic).
More...

Parameter Disable the loading of the RADEON DRM driver.

Registry x.drivers.ati.disable

Value enabled / disabled

Parameter Disable the loading of the AMDGPU DRM driver.

Registry x.drivers.amdgpu.disable

Value enabled / disabled

Parameter Disable the loading of the i915 DRM driver.

Registry x.drivers.intel.disable

Value enabled / disabled

Parameter Disable the loading of the NVIDIA kernel driver.

Registry x.drivers.nvidia.disable

Value enabled / disabled

Parameter Disable the loading of the NOUVEAU DRM driver.

Registry x.drivers.nouveau.disable

Value enabled / disabled

Parameter Disable the loading of the QXL DRM driver.

Registry x.drivers.qxl.disable

Value enabled / disabled

Parameter Disable the loading of the VMGFX DRM driver.

Registry x.drivers.vmware.disable

Value enabled / disabled
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Parameter Disable the loading of the VBOXVIDEO DRM driver.

Registry x.drivers.vboxvideo.disable

Value enabled / disabled

Java

Replaced Oracle JRE by AZUL's Zulu JRE version 8.36.0.1.
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Resolved Issues 11.01.110
OSC Installer

Fixed OSC Installer to not disable EFI, if MSDOS partitioning was choosen.

Citrix

Fixed stability issues with Citrix Browser Content Redirection.
Fixed crash when H264 acceleration and RTME will be used on two or more concurrent VDI 
sessions.

RDP/IGEL RDP Client 2

Added registry key to use rdpglobal window settings for remote apps.
More...

Parameter Enable global windows settings for remote app

Registry rdp.winconnect.enable-global-window-settings-for-

remote-app

Value enabled / disabled

VMware Horizon

Added recognition for password change and password expired dialog in Horizon local logon 
sessions or appliance mode
Fixed the configuration choice to use the relative mouse feature

Firefox

Fixed firefox not accepting proxy credentials from setup.
Fixed print hotkey disable option not working with Firefox 60.
Fixed browserglobal.app.local_subdirs_whitelist  not working.
Updated Firefox browser to version 60.7.0esr.
Fixes for mfsa2019-08. 
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, CVE-2019-9788.

Fixes for mfsa2019-05, also known as: CVE-2018-18356, CVE-2019-5785.
Fixes for mfsa2019-02, also known as: CVE-2018-18500, CVE-2018-18505, CVE-2018-18501.

Network

Fixed: Failure to reach SCEP server in the client certificate renewal phase resulted in loss of SCEP 
server and client certificates.
Changed e1000e driver to out of tree version 3.4.2.3 - directly from Intel.
Changed igb driver to out of tree version 5.3.5.22 - directly from Intel.
Added possibility to switch between thirdparty and kernel intel IGB network driver.
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More...

Parameter Use thirdparty igb kernel module.

Registry network.drivers.igb.prefer_thirdparty

Value [Auto] [Yes] [No]

Info: "Auto" uses thirdparty in most cases

Added possibility to switch between thirdparty and kernel intel E1000E network driver.
More...

Parameter Use thirdparty e1000e kernel module.

Registry network.drivers.e1000e.prefer_thirdpart

y

Value [Auto] [Yes] [No]

Info: "Auto" uses thirdparty in most cases

Fixed instability with netmounts with static ip configuration.
Added possibility to switch between thirdparty r8168 and kernel r8169 realtek network driver.
More...

Parameter Use thirdparty r8168 kernel module.

Registry network.drivers.r8169.prefer_r8168

Value [Auto] [Yes] [No]

Info: "Auto" uses r8169 in most cases

Added possibility to choose the variant of the realtek r8168 driver.
More...

Parameter Choose realtek r8168 variant (only if prefer r8168 is chosen).

Registry network.drivers.r8169.r8168_variant

Value [Default][No NAPI][NAPI]

Info: "Auto" uses NAPI in most cases

Wi-Fi

Fixed non working TP Link Archer T2UH.

Imprivata

Fixed Fast User Switching with Citrix connections.

Smartcard
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Fixed OpenSC setting max_send_size  for reader driver pcsc in  /etc/opensc/

opensc.conf .
Fixed Dell KB813 smartcard keyboard in combination with certain smartcards driven by OpenSC 
PKCS#11 module. Before this fix authentication to Citrix StoreFront and VMWare Horizon failed.

Base system

Fixed retrieving of serial number from display.
Fixed random 90 seconds shutdown delay (systemd).
Fixed wrong behavior with expired evaluation licenses in some cases.
Fixed a bug in the screenlock countdown that occurred when display of remaining seconds was 
not desired.
Added apparmor rule to allow tcpdump to write to /debuglog .
Bugfix hotkey setting need reboot.
Fixed UD2 screen goes black problem with certain multimonitor configurations.
Fixed gtk-3 icon sizes for High-DPI configurations.
Enhanced bootloader to allow the setting of some kernel commandline parameters with registry 
keys.
More...

Parameter Disable use of APIC controller.

Registry system.kernel.bootparams.noapic

Value enabled / disabled

Parameter Disable use of ACPI.

Registry system.kernel.bootparams.noacpi

Value enabled / disabled

Parameter Use only one CPU core and disable all others.

Registry system.kernel.bootparams.nosmp

Value enabled / disabled

Parameter Enable debug console on serial port 1.

Registry system.kernel.bootparams.serial_console_deb

ug

Value enabled / disabled

Parameter Limit CPU core usage (0 means no limit).

Registry system.kernel.bootparams.maxcpus
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Value "0"

Parameter Set maximum allowed cstate on intel cpus.

Registry system.kernel.bootparams.max_cstate

Range [No limit] [1] [2] [3] [4] [5] [6]

Info: Do not limit intel cstate

Parameter IOMMU usage setting.

Registry system.kernel.bootparams.iommu

Range [On] [Off] [Passthrough] [Force]

Info: Use IOMMU if possible

Parameter IOMMU usage setting for AMD systems.

Registry system.kernel.bootparams.amd_iommu

Range [On] [Off]

Info: Use IOMMU if possible

Parameter IOMMU usage setting for Intel systems.

Registry system.kernel.bootparams.intel_iommu

Range [On] [Off]

Info: Use IOMMU if possible

Moved the EULA page in IGEL Setup Assistant into the demo activation workflow.
Added new registry key to set USB quirks. 
More...

Parameter Set XHCI USB quirks to fix some hardware issues.

Registry system.kernel.bootparams.xhci-hcd_quirks

Range [No quirk] [Spurious Reboot quirk] [Spurious Wakeup 
quirk][Spurious Reboot Wakeup quirk]

Lenovo ThinkCentre M73 needs the system.kernel.bootparams.xhci-hcd_quirks  re
gistry key set to Spurious Reboot quirk to fix reboot after shutdown problem.

Driver

Updated deviceTRUST Client to version 19.1.200.
Bug Fixes:

Fixed an issue reading the DEVICE_IGEL_ICG_SERVER property.
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Fixed an issue where the NETWORK and LOCATION property providers could cause the 
client to freeze if a disconnection occurred whilst these property providers were checking 
for changes.
Fixed an open file handle leak which lead to the client process reaching its file handle 
limits when left running for a long period of time.
Fixed non working WACOM device DTU-1141B.

Custom Partition

Fixed ownership of extracted data: don't preserve original owner while extracting data into 
custom partition.

Storage Devices

Fixed auto mounting of storage devices inside of Olympus DS-9500 Digital Voice Recorder.

X11 system

There is now a registry key to ignore a 3Dconnexion SpaceMouse for IGEL graphical use (X11). If 
activated, the SpaceMouse is only passed through to the desktop session. If false, it acts also as 
the standard mouse.
More...

Parameter Deactivates a 3Dconnexion SpaceMouse as a standard mouse.

Registry userinterface.mouse.spacemouse.x11_ignore

Value enabled / disabled

The following SpaceMouse products are included (VID, PID, Vendor, Product). 
More...

0x046D; 0xC603; Logitech, Inc.; 3Dconnexion Spacemouse Plus XT

0x046D; 0xC605; Logitech, Inc.; 3Dconnexion CADman

0x046D; 0xC606; Logitech, Inc.; 3Dconnexion Spacemouse Classic

0x046D; 0xC621; Logitech, Inc.; 3Dconnexion Spaceball 5000

0x046D; 0xC623; Logitech, Inc.; 3Dconnexion Space Traveller 3D Mouse

0x046D; 0xC625; Logitech, Inc.; 3Dconnexion Space Pilot 3D Mouse

0x046D; 0xC626; Logitech, Inc.; 3Dconnexion Space Navigator 3D Mouse

0x046D; 0xC627; Logitech, Inc.; 3Dconnexion Space Explorer 3D Mouse

0x046D; 0xC628; Logitech, Inc.; 3Dconnexion Space Navigator for Notebooks

0x046D; 0xC629; Logitech, Inc.; 3Dconnexion SpacePilot Pro 3D Mouse

0x046D; 0xC62B; Logitech, Inc.; 3Dconnexion Space Mouse Pro

0x256F; **; 3Dconnexion; SpaceMouse

USB device reset via USB powercycle on UD6/UD7 available.
Fixed screen flicker in some cases if "Force NumLock On" (x.global.forcenumlock) is active.
Fixed Display Switch utility not starting with some translations.
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Fixed an issue with the noDDC mode not always working as expected.
Fixed wrongly detected embedded DisplayPort on Dell Wyse 5070 Extended hardware.
Added the possibility to change an embedded DisplayPort to a normal DisplayPort.
More...

Parameter Use embedded displayport as normal displayport 
(reboot required).

Registry x.drivers.intel.edp_is_dp

Range [default][enable][disable]

Fixed some multimonitor (>4) issues with Nvidia graphic cards.
Updated DisplayLink driver to version 5.1.26 to solve some startup issues.
Fixed configuration from the old Display Switch taking precedence over
configuration from new Display Switch and preventing changes.

Audio

Fixed bad quality sound over DisplayPort in a Citrix ICA session or other applications using ALSA 
API.
Fixed jack detection of the headphone port in Dell Wyse 3040.
Fixed configuration of default audio output and input.

Media Player (Parole)

Fixed a problem where parole media player would hang instead of playing audio while audio-
visualization is enabled.

Hardware

Fixed vanishing mouse cursor on Ryzen 3 devices.
Fixed issues with non working Touchpad and Trackpoint on Lenovo laptops.
Hardware detect HP t430.
Added possibility to use AMDGPU PRO driver instead of the kernel integrated driver.
Ryzen 3 devices (1200, 1300X, 2200G, 2200U and 2300U) will use the AMDGPU PRO  driver if registry 
key x.drivers.amdgpu.use_amdgpu_pro is set to auto  (default).
New registry key (settings to this key will only work after reboot):
More...

Parameter Use AMDGPU PRO driver.

Registry x.drivers.amdgpu.use_amdgpu_pro

Range [Auto] [True] [False]

Remote Management

If TC is managed over ICG, then settings do not apply immediately when received in connection 
stage. The settings must be applied after user prompt dialog.
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Notes for Release 11.01.100
Software: Version 11.01.100

Release Date: 2019-02-15

Release Notes: RN-1101100-1

Last update: 2019-02-15

IGEL OS 11 (see page 848)
IGEL OS Creator (OSC) (see page 865)
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IGEL OS 11

Supported Devices
IGEL devices:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

For supported IGEL OS 11 third-party devices, see Devices Supported by IGEL OS 11.

Component Versions 11.01.100 (see page 849)
General Information 11.01.100 (see page 853)
Known Issues 11.01.100 (see page 854)
New Features 11.01.100 (see page 856)
CA Certificates Contained in IGEL OS 11.01.100 (see page 861)
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Component Versions 11.01.100
Clients
Product Version

Citrix HDX Realtime Media Engine 2.7.0-2113

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 18.10.0.11

deviceTRUST Citrix Channel 19.1.100.0

deviceTRUST RDP Channel 19.1.100.0

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.4.0

IBM iAccess Client Solutions 1.1.8.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_202

Parallels Client (32 bit) 16.5.2.20595

Parole Media Player 1.0.1-0ubuntu1igel16

Remote Viewer (RedHat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0

Thinlinc Client 4.9.0-5775

ThinPrint Client 7.5.88

Totem Media Player 2.30.2
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VMware Horizon Client 4.10.0-11053294

VNC Viewer 1.8.0+git20180123-igel1

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.6.36

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.0.23

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1
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Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.14

OpenSSH Client 7.2p2-4ubuntu2.7

OpenSSH Server 7.2p2-4ubuntu2.7

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.3.3-1igel57

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20181113-igel856

Graphics Driver ATI/RADEON 18.1.0-1igel854

Graphics Driver ATI/AMDGPU 18.1.0-1igel853

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2igel775

Graphics Driver Nvidia 410.93-0ubuntu1

Graphics Driver Vboxvideo 5.2.18-dfsg-2igel17

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver Vmmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-udos-r2517

Xorg X11 Server 1.19.6-1ubuntu4.2igel842

Xorg Xephyr 1.19.6-1ubuntu4.2igel842

CUPS printing daemon 2.1.3-4ubuntu0.7igel23
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PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel675

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2ubuntu1igel2

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.4-1ubuntu1igel203

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.1
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General Information 11.01.100
The following clients and features are not supported anymore:

Caradigm
Citrix Legacy Sessions
Citrix Web Interface
Citrix StoreFront Legacy
Citrix HDX Flash Redirection
Citrix XenDesktop Appliance Mode
Flash Player Download
Ericom PowerTerm
JAVA Web Start
Leostream Java Connect
Systancia AppliDis
VIA graphics driver
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Known Issues 11.01.100
Citrix

With activated DRI3 and an AMD GPU Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.

Citrix has known issues with GStreamer1.0 which describe problems with multimedia redirection 
of H.264, MPEG1 and MPEG2. GStreamer1.0 is used if browser content redirection is active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront Login with Gemalto smartcard middleware does not detect smartcard 
correctly if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront Login.
When using Citrix Workspace App 18.10 in combination with Philips Speech driver, the session 
occasionally does not properly terminate at logoff and hangs. 
As a workaround, usage of Citrix Receiver 13.10 is recommended when Philips Speech driver is 
needed.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > For the 
entire screen.

VMware Horizon

External drives are mounted already before connection, do not appear in the remote desktop. 
Workaround: Mapping the directory/media as a drive on desktop. The external devices will show 
up within the media drive then.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Storage Hotplug on setup page Devices > Storage Devices > Storage Hotplug has to be 
enabled and the Number of storage hotplug devices has to set to at least 1.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
once with disabled FIPS support.

Smartcard

In seldom cases, the authentication hung when using A.E.T. SafeSign smartcards.
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Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Base system

On NVIDIA GPU drivers, the reported resolutions of a display may contain unsupported 
resolutions. When any of those are configured, there are visual bugs (e.g. the desktop does not 
render properly).
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New Features 11.01.100
Base system

Support for IGEL OS 11 license deployment with IGEL UMS 6 (via 'Automatic License 
Deployment')
Support for manual license deployment in IGEL Setup Assistant
Support for demo license registration in IGEL Setup Assistant
Unified IGEL OS 11 firmware for IGEL and third-party hardware (New update file prefix: lxos)
Writable partitions are encrypted now
Use IGEL OS Creator for IGEL OS 11 installation and recovery (Download file: OSC_11.01.100.zip)

X11 system

Reworked user interface
New wallpapers have been added with transparent background so that the custom desktop 
color shows through. Selection of one of the new Desktop Color wallpapers in combination with 
an adjustment of desktop colors will provide this individual effect. The 2nd desktop color and the 
gradients also work with that.
The new Display Switch tool can use multiple different profiles, automatically chosen at 
runtime depending on the currently connected monitors. A profile is created, when the current 
monitor layout/resolution is configured via the Display Switch utility. The profile will be associated 
with the currently connected displays automatically (manufacturer, model and used connector are 
used for allocation) and if applicable, the state of the laptop lid. The setup will be restored by hot-
(un)plugging known displays, means the system will automatically switch to the already 
configured profile. The Display Switch utility itself got a new interface. All base functionality can be 
configured via Drag&Drop.
An example workflow:

Connect the hardware and close/open lid
Open the Display Switch Utility

- A quick (simple) setting can be selected directly.

- Should the desired use case be different from the provided choices, the Advanced button opens a 
drag and drop interface for further settings.

In this interface, the displays can be dragged and dropped for the intended configuration. 
The display will snap adjacent to others.
If a display should not be used, it can be dragged to the Disabled area on the top right - the 
screen will be reactivated when it is dragged back to the active area.
To show the same content on multiple displays, one display should be dragged onto an 
other active screen. The interface will show Mirror. The mirroring monitor will be displayed 
on the lower right.
With the Apply button the current state will be set, with ‘Yes’ on the “Keep configuration” 
dialog the current settings will be saved to persistent storage and associated with the 
profile.
Advanced functionality (panning/scaling/resolutions) can be configured in drop-down 
boxes, hidden in a drawer on the right side. The drawer can be expanded by clicking the ‘<’ 
button on the right edge.
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For the Display Switch functionality the following parameters should be enabled for proper 
usage. 
More...

IGEL Setup Accessories > Display Switch > Options

Parameter Preserve settings over reboot

Registry sessions.user_display0.options.preserve_settin

gs

Value enabled / disabled

IGEL Setup Accessories > Display Switch > Options

Parameter Smart display configuration

Registry x.auto_associate

Value enabled / disabled

The IGEL Display Switch utility is now used for NVIDIA graphics devices as well.
Automatic DPI detection has been added by the following parameter.
More...

IGEL Setup User Interface > Display > Options

Parameter Monitor DPI Detection

Registry x.xserver0.auto_dpi

Value Off / Smart / Pixel-Precise

With the Smart automatic DPI detection the user interface is now usable out of the box on 4k displays.

Smart: Auto detect the DPI but only use a few values whichever is closest to the calculated DPI value. Used 
DPI values: 96, 125, 150, 175, 200, 225, 250, 275, 300.

Off: No auto DPI detection, fixed Monitor DPI value is used.

Pixel-Precise: Auto detect the DPI value and use it when it is within 65-300 DPI. Otherwise, 96 DPI is used.

Improved High DPI support for various applications.
Added xprintidle tool to firmware.
Added a parameter to delay DisplayPort handling by a certain number of seconds to mitigate 
disabled outputs causing a reconfiguration.
More...

Parameter Delay DisplayPort disconnect events by N seconds to prevent 
reconfiguration with weird monitors
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Registry sessions.user_display0.options.delay_dp_hotplu

g

Value 2

Firefox

The Firefox configuration is now only done by global parameters found at setup pages: IGEL Setup 
> Sessions > Browser > Browser Global
Session specific parameters are: startup page, start monitor and autostart

Audio

Added support for deployment of Jabra Xpress packages with IGEL UMS 6.
More...

IGEL Setup Devices > Unified Communications > Jabra > Jabra Xpress

Parameter Device Dashboard URL

Registry jabra.xpress.device_dashboard.server_url

IGEL Setup Devices > Unified Communications > Jabra > Jabra Xpress

Parameter Package

Registry jabra.xpress.package_name

IGEL Setup Devices > Unified Communications > Jabra > Jabra Xpress

Parameter Source URL

Registry jabra.xpress.package_url

IGEL Setup Devices > Unified Communications > Jabra > Jabra Xpress

Parameter Check SSL certificate

Registry jabra.xpress.package_url_ssl_cert_check

Value enabled / disabled

IGEL Setup Devices > Unified Communications > Jabra > Jabra Xpress

Parameter Password

Registry jabra.xpress.package_url_crypt_password

Added support of automatic suspend for wireless Jabra USB audio devices. A device will be 
suspended after idle time over 5 seconds and automatically resumed again, when an application 
wants to playback or record audio data over the device.
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More...

IGEL Setup Devices > Unified Communications > Jabra > Options

Parameter Suspend on idle

Registry devices.jabra.suspend_on_idle

Value enabled / disabled

TC Setup (Java)

Local TC setup theme can be configured now.
More...

Parameter Color Theme

Registry userinterface.setup.theme

Value Auto / Dark / Dark & Light / Light / Ocean

Added High DPI scaling

On-screen keyboard

Added new parameters to auto show and hide the on-screen keyboard. To use this feature, the 
on-screen keyboard should be set to autostart and restart. The on-screen keyboard will start in a 
hidden state and automatically appears when a text field is selected. Confirmed to work within 
Firefox and on lockscreen.
More...

IGEL Setup Accessories > On-Screen Keyboard > Application Integration

Parameter Automatically show On-Screen Keyboard when text field is selected

Registry userinterface.softkeyboard.autoshow

Value enabled / disabled

Parameter Automatically hide On-Screen Keyboard when text field is deselected

Registry userinterface.softkeyboard.autohide

Value enabled / disabled

Appliance Mode

Streamlined the on-screen keyboard settings for appliance mode.
Add new parameter to enable the on-screen keyboard in appliance mode. With enabled 
Appliance Mode Access the on-screen keyboard should set to auto start.
More...

IGEL Setup Accessories > On-Screen Keyboard
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Parameter Appliance Mode Access

Registry sessions.gtkeyboard0.appliance_mode_acces

s

Value enabled / disabled

Alternatively, the button to show/hide the on-screen keyboard can be displayed in appliance 
mode, to provide a quick method to turn the keyboard on or off.
More...

IGEL Setup Accessories > On-Screen Keyboard > Application Integration > 
On-Screen Keyboard Toggle Button

Parameter Show button

Registry userinterface.touchscreen.keyboard.touchkey.en

able

Value enabled / disabled

Removed the old options to individually enable/disable and position the on-screen keyboard for 
various appliance mode settings.

Hardware

Added hardware support for HP t530.
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CA Certificates Contained in IGEL OS 11.01.100
Contained CA certificates:
- ACCVRAIZ1, expires Dec 31 09:37:37 2030 GMT (ACCVRAIZ1.crt)
- ACEDICOM Root, expires Apr 13 16:24:22 2028 GMT (ACEDICOM_Root.crt)
- AC RAIZ FNMT-RCM, expires Jan 1 00:00:00 2030 GMT (AC_RAIZ_FNMT-RCM.crt)
- Actalis Authentication Root CA, expires Sep 22 11:22:02 2030 GMT (Actalis_Authentication_Root_CA.crt)
- AddTrust External CA Root, expires May 30 10:48:38 2020 GMT (AddTrust_External_Root.crt)
- AddTrust Class 1 CA Root, expires May 30 10:38:31 2020 GMT (AddTrust_Low-Value_Services_Root.crt)
- AddTrust Public CA Root, expires May 30 10:41:50 2020 GMT (AddTrust_Public_Services_Root.crt)
- AddTrust Qualified CA Root, expires May 30 10:44:50 2020 GMT (AddTrust_Qualified_Certificates_Root.crt)
- AffirmTrust Commercial, expires Dec 31 14:06:06 2030 GMT (AffirmTrust_Commercial.crt)
- AffirmTrust Networking, expires Dec 31 14:08:24 2030 GMT (AffirmTrust_Networking.crt)
- AffirmTrust Premium, expires Dec 31 14:10:36 2040 GMT (AffirmTrust_Premium.crt)
- AffirmTrust Premium ECC, expires Dec 31 14:20:24 2040 GMT (AffirmTrust_Premium_ECC.crt)
- Amazon Root CA 1, expires Jan 17 00:00:00 2038 GMT (Amazon_Root_CA_1.crt)
- Amazon Root CA 2, expires May 26 00:00:00 2040 GMT (Amazon_Root_CA_2.crt)
- Amazon Root CA 3, expires May 26 00:00:00 2040 GMT (Amazon_Root_CA_3.crt)
- Amazon Root CA 4, expires May 26 00:00:00 2040 GMT (Amazon_Root_CA_4.crt)
- Atos TrustedRoot 2011, expires Dec 31 23:59:59 2030 GMT (Atos_TrustedRoot_2011.crt)
- Autoridad de Certificacion Firmaprofesional CIF A62634068, expires Dec 31 08:38:15 2030 GMT 
(Autoridad_de_Certificacion_Firmaprofesional_CIF_A62634068.crt)
- Baltimore CyberTrust Root, expires May 12 23:59:00 2025 GMT (Baltimore_CyberTrust_Root.crt)
- Buypass Class 2 Root CA, expires Oct 26 08:38:03 2040 GMT (Buypass_Class_2_Root_CA.crt)
- Buypass Class 3 Root CA, expires Oct 26 08:28:58 2040 GMT (Buypass_Class_3_Root_CA.crt)
- CA Disig Root R1, expires Jul 19 09:06:56 2042 GMT (CA_Disig_Root_R1.crt)
- CA Disig Root R2, expires Jul 19 09:15:30 2042 GMT (CA_Disig_Root_R2.crt)
- CFCA EV ROOT, expires Dec 31 03:07:01 2029 GMT (CFCA_EV_ROOT.crt)
- CNNIC ROOT, expires Apr 16 07:09:14 2027 GMT (CNNIC_ROOT.crt)
- COMODO Certification Authority, expires Dec 31 23:59:59 2029 GMT (COMODO_Certification_Authority.crt)
- COMODO ECC Certification Authority, expires Jan 18 23:59:59 2038 GMT 
(COMODO_ECC_Certification_Authority.crt)
- COMODO RSA Certification Authority, expires Jan 18 23:59:59 2038 GMT 
(COMODO_RSA_Certification_Authority.crt)
- Chambers of Commerce Root, expires Sep 30 16:13:44 2037 GMT (Camerfirma_Chambers_of_Commerce_Root.crt)
- Global Chambersign Root, expires Sep 30 16:14:18 2037 GMT (Camerfirma_Global_Chambersign_Root.crt)
- Certigna, expires Jun 29 15:13:05 2027 GMT (Certigna.crt)
- Certinomis - Autorité Racine, expires Sep 17 08:28:59 2028 GMT (Certinomis_-_Autorité_Racine.crt)
- Certinomis - Root CA, expires Oct 21 09:17:18 2033 GMT (Certinomis_-_Root_CA.crt)
- Class 2 Primary CA, expires Jul 6 23:59:59 2019 GMT (Certplus_Class_2_Primary_CA.crt)
- Certplus Root CA G1, expires Jan 15 00:00:00 2038 GMT (Certplus_Root_CA_G1.crt)
- Certplus Root CA G2, expires Jan 15 00:00:00 2038 GMT (Certplus_Root_CA_G2.crt)
- Certum CA, expires Jun 11 10:46:39 2027 GMT (Certum_Root_CA.crt)
- Certum Trusted Network CA, expires Dec 31 12:07:37 2029 GMT (Certum_Trusted_Network_CA.crt)
- Certum Trusted Network CA 2, expires Oct 6 08:39:56 2046 GMT (Certum_Trusted_Network_CA_2.crt)
- Chambers of Commerce Root - 2008, expires Jul 31 12:29:50 2038 GMT (Chambers_of_Commerce_Root_-_2008.crt)
- China Internet Network Information Center EV Certificates Root, expires Aug 31 07:11:25 2030 GMT 
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(China_Internet_Network_Information_Center_EV_Certificates_Root.crt)
- AAA Certificate Services, expires Dec 31 23:59:59 2028 GMT (Comodo_AAA_Services_root.crt)
- Secure Certificate Services, expires Dec 31 23:59:59 2028 GMT (Comodo_Secure_Services_root.crt)
- Trusted Certificate Services, expires Dec 31 23:59:59 2028 GMT (Comodo_Trusted_Services_root.crt)
- Cybertrust Global Root, expires Dec 15 08:00:00 2021 GMT (Cybertrust_Global_Root.crt)
- D-TRUST Root Class 3 CA 2 2009, expires Nov 5 08:35:58 2029 GMT (D-TRUST_Root_Class_3_CA_2_2009.crt)
- D-TRUST Root Class 3 CA 2 EV 2009, expires Nov 5 08:50:46 2029 GMT (D-TRUST_Root_Class_3_CA_2_EV_2009.crt)
- DST ACES CA X6, expires Nov 20 21:19:58 2017 GMT (DST_ACES_CA_X6.crt)
- DST Root CA X3, expires Sep 30 14:01:15 2021 GMT (DST_Root_CA_X3.crt)
- Deutsche Telekom Root CA 2, expires Jul 9 23:59:00 2019 GMT (Deutsche_Telekom_Root_CA_2.crt)
- DigiCert Assured ID Root CA, expires Nov 10 00:00:00 2031 GMT (DigiCert_Assured_ID_Root_CA.crt)
- DigiCert Assured ID Root G2, expires Jan 15 12:00:00 2038 GMT (DigiCert_Assured_ID_Root_G2.crt)
- DigiCert Assured ID Root G3, expires Jan 15 12:00:00 2038 GMT (DigiCert_Assured_ID_Root_G3.crt)
- DigiCert Global Root CA, expires Nov 10 00:00:00 2031 GMT (DigiCert_Global_Root_CA.crt)
- DigiCert Global Root G2, expires Jan 15 12:00:00 2038 GMT (DigiCert_Global_Root_G2.crt)
- DigiCert Global Root G3, expires Jan 15 12:00:00 2038 GMT (DigiCert_Global_Root_G3.crt)
- DigiCert High Assurance EV Root CA, expires Nov 10 00:00:00 2031 GMT (DigiCert_High_Assurance_EV_Root_CA.crt)
- DigiCert Trusted Root G4, expires Jan 15 12:00:00 2038 GMT (DigiCert_Trusted_Root_G4.crt)
- E-Tugra Certification Authority, expires Mar 3 12:09:48 2023 GMT (E-Tugra_Certification_Authority.crt)
- EC-ACC, expires Jan 7 22:59:59 2031 GMT (EC-ACC.crt)
- EE Certification Centre Root CA, expires Dec 17 23:59:59 2030 GMT (EE_Certification_Centre_Root_CA.crt)
- Entrust.net39 Certification Authority (2048), expires Jul 24 14:15:12 2029 GMT 
(Entrust.net_Premium_2048_Secure_Server_CA.crt)
- Entrust Root Certification Authority, expires Nov 27 20:53:42 2026 GMT (Entrust_Root_Certification_Authority.crt)
- Entrust Root Certification Authority - EC1, expires Dec 18 15:55:36 2037 GMT 
(Entrust_Root_Certification_Authority_-_EC1.crt)
- Entrust Root Certification Authority - G2, expires Dec 7 17:55:54 2030 GMT (Entrust_Root_Certification_Authority_-
_G2.crt)
- GeoTrust Global CA, expires May 21 04:00:00 2022 GMT (GeoTrust_Global_CA.crt)
- GeoTrust Global CA 2, expires Mar 4 05:00:00 2019 GMT (GeoTrust_Global_CA_2.crt)
- GeoTrust Primary Certification Authority, expires Jul 16 23:59:59 2036 GMT 
(GeoTrust_Primary_Certification_Authority.crt)
- GeoTrust Primary Certification Authority - G2, expires Jan 18 23:59:59 2038 GMT 
(GeoTrust_Primary_Certification_Authority_-_G2.crt)
- GeoTrust Primary Certification Authority - G3, expires Dec 1 23:59:59 2037 GMT 
(GeoTrust_Primary_Certification_Authority_-_G3.crt)
- GeoTrust Universal CA, expires Mar 4 05:00:00 2029 GMT (GeoTrust_Universal_CA.crt)
- GeoTrust Universal CA 2, expires Mar 4 05:00:00 2029 GMT (GeoTrust_Universal_CA_2.crt)
- GlobalSign, expires Jan 19 03:14:07 2038 GMT (GlobalSign_ECC_Root_CA_-_R4.crt)
- GlobalSign, expires Jan 19 03:14:07 2038 GMT (GlobalSign_ECC_Root_CA_-_R5.crt)
- GlobalSign Root CA, expires Jan 28 12:00:00 2028 GMT (GlobalSign_Root_CA.crt)
- GlobalSign, expires Dec 15 08:00:00 2021 GMT (GlobalSign_Root_CA_-_R2.crt)
- GlobalSign, expires Mar 18 10:00:00 2029 GMT (GlobalSign_Root_CA_-_R3.crt)
- Global Chambersign Root - 2008, expires Jul 31 12:31:40 2038 GMT (Global_Chambersign_Root_-_2008.crt)
- Go Daddy Class 2 Certification Authority, expires Jun 29 17:06:20 2034 GMT (Go_Daddy_Class_2_CA.crt)
- Go Daddy Root Certificate Authority - G2, expires Dec 31 23:59:59 2037 GMT 
(Go_Daddy_Root_Certificate_Authority_-_G2.crt)
- Hellenic Academic and Research Institutions ECC RootCA 2015, expires Jun 30 10:37:12 2040 GMT 

http://Entrust.net
http://Entrust.net
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(Hellenic_Academic_and_Research_Institutions_ECC_RootCA_2015.crt)
- Hellenic Academic and Research Institutions RootCA 2011, expires Dec 1 13:49:52 2031 GMT 
(Hellenic_Academic_and_Research_Institutions_RootCA_2011.crt)
- Hellenic Academic and Research Institutions RootCA 2015, expires Jun 30 10:11:21 2040 GMT 
(Hellenic_Academic_and_Research_Institutions_RootCA_2015.crt)
- Hongkong Post Root CA 1, expires May 15 04:52:29 2023 GMT (Hongkong_Post_Root_CA_1.crt)
- ISRG Root X1, expires Jun 4 11:04:38 2035 GMT (ISRG_Root_X1.crt)
- IdenTrust Commercial Root CA 1, expires Jan 16 18:12:23 2034 GMT (IdenTrust_Commercial_Root_CA_1.crt)
- IdenTrust Public Sector Root CA 1, expires Jan 16 17:53:32 2034 GMT (IdenTrust_Public_Sector_Root_CA_1.crt)
- Imprivata Embedded Code Signing CA, expires Sep 7 16:20:00 2033 GMT (Imprivata.crt)
- Izenpe.com40, expires Dec 13 08:27:25 2037 GMT (Izenpe.com41.crt)
- LuxTrust Global Root 2, expires Mar 5 13:21:57 2035 GMT (LuxTrust_Global_Root_2.crt)
- Microsec e-Szigno Root CA 2009, expires Dec 30 11:30:18 2029 GMT (Microsec_e-Szigno_Root_CA_2009.crt)
- NetLock Arany (Class Gold) Főtanúsítvány, expires Dec 6 15:08:21 2028 GMT 
(NetLock_Arany_=Class_Gold=_Főtanúsítvány.crt)
- Network Solutions Certificate Authority, expires Dec 31 23:59:59 2029 GMT 
(Network_Solutions_Certificate_Authority.crt)
- OISTE WISeKey Global Root GA CA, expires Dec 11 16:09:51 2037 GMT (OISTE_WISeKey_Global_Root_GA_CA.crt)
- OISTE WISeKey Global Root GB CA, expires Dec 1 15:10:31 2039 GMT (OISTE_WISeKey_Global_Root_GB_CA.crt)
- OpenTrust Root CA G1, expires Jan 15 00:00:00 2038 GMT (OpenTrust_Root_CA_G1.crt)
- OpenTrust Root CA G2, expires Jan 15 00:00:00 2038 GMT (OpenTrust_Root_CA_G2.crt)
- OpenTrust Root CA G3, expires Jan 15 00:00:00 2038 GMT (OpenTrust_Root_CA_G3.crt)
- Autoridad de Certificacion Raiz del Estado Venezolano, expires Dec 25 23:59:59 2020 GMT (PSCProcert.crt)
- QuoVadis Root Certification Authority, expires Mar 17 18:33:33 2021 GMT (QuoVadis_Root_CA.crt)
- QuoVadis Root CA 1 G3, expires Jan 12 17:27:44 2042 GMT (QuoVadis_Root_CA_1_G3.crt)
- QuoVadis Root CA 2, expires Nov 24 18:23:33 2031 GMT (QuoVadis_Root_CA_2.crt)
- QuoVadis Root CA 2 G3, expires Jan 12 18:59:32 2042 GMT (QuoVadis_Root_CA_2_G3.crt)
- QuoVadis Root CA 3, expires Nov 24 19:06:44 2031 GMT (QuoVadis_Root_CA_3.crt)
- QuoVadis Root CA 3 G3, expires Jan 12 20:26:32 2042 GMT (QuoVadis_Root_CA_3_G3.crt)
- SZAFIR ROOT CA2, expires Oct 19 07:43:30 2035 GMT (SZAFIR_ROOT_CA2.crt)
- SecureSign RootCA11, expires Apr 8 04:56:47 2029 GMT (SecureSign_RootCA11.crt)
- SecureTrust CA, expires Dec 31 19:40:55 2029 GMT (SecureTrust_CA.crt)
- Secure Global CA, expires Dec 31 19:52:06 2029 GMT (Secure_Global_CA.crt)
- Security Communication EV RootCA1, expires Jun 6 02:12:32 2037 GMT 
(Security_Communication_EV_RootCA1.crt)
- Security Communication RootCA2, expires May 29 05:00:39 2029 GMT (Security_Communication_RootCA2.crt)
- Security Communication RootCA1, expires Sep 30 04:20:49 2023 GMT (Security_Communication_Root_CA.crt)
- Sonera Class2 CA, expires Apr 6 07:29:40 2021 GMT (Sonera_Class_2_Root_CA.crt)
- Staat der Nederlanden EV Root CA, expires Dec 8 11:10:28 2022 GMT (Staat_der_Nederlanden_EV_Root_CA.crt)
- Staat der Nederlanden Root CA - G2, expires Mar 25 11:03:10 2020 GMT (Staat_der_Nederlanden_Root_CA_-
_G2.crt)
- Staat der Nederlanden Root CA - G3, expires Nov 13 23:00:00 2028 GMT (Staat_der_Nederlanden_Root_CA_-
_G3.crt)
- Starfield Class 2 Certification Authority, expires Jun 29 17:39:16 2034 GMT (Starfield_Class_2_CA.crt)
- Starfield Root Certificate Authority - G2, expires Dec 31 23:59:59 2037 GMT (Starfield_Root_Certificate_Authority_-
_G2.crt)
- Starfield Services Root Certificate Authority - G2, expires Dec 31 23:59:59 2037 GMT 
(Starfield_Services_Root_Certificate_Authority_-_G2.crt)
- SwissSign Gold CA - G2, expires Oct 25 08:30:35 2036 GMT (SwissSign_Gold_CA_-_G2.crt)

http://Izenpe.com
http://Izenpe.com
http://Izenpe.com
http://Izenpe.com
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- SwissSign Silver CA - G2, expires Oct 25 08:32:46 2036 GMT (SwissSign_Silver_CA_-_G2.crt)
- Swisscom Root CA 1, expires Aug 18 22:06:20 2025 GMT (Swisscom_Root_CA_1.crt)
- Swisscom Root CA 2, expires Jun 25 07:38:14 2031 GMT (Swisscom_Root_CA_2.crt)
- Swisscom Root EV CA 2, expires Jun 25 08:45:08 2031 GMT (Swisscom_Root_EV_CA_2.crt)
- T-TeleSec GlobalRoot Class 2, expires Oct 1 23:59:59 2033 GMT (T-TeleSec_GlobalRoot_Class_2.crt)
- T-TeleSec GlobalRoot Class 3, expires Oct 1 23:59:59 2033 GMT (T-TeleSec_GlobalRoot_Class_3.crt)
- TUBITAK Kamu SM SSL Kok Sertifikasi - Surum 1, expires Oct 25 08:25:55 2043 GMT 
(TUBITAK_Kamu_SM_SSL_Kok_Sertifikasi_-_Surum_1.crt)
- TÜRKTRUST Elektronik Sertifika Hizmet Sağlayıcısı, expires Dec 22 18:37:19 2017 GMT 
(TURKTRUST_Certificate_Services_Provider_Root_2007.crt)
- TWCA Global Root CA, expires Dec 31 15:59:59 2030 GMT (TWCA_Global_Root_CA.crt)
- TWCA Root Certification Authority, expires Dec 31 15:59:59 2030 GMT (TWCA_Root_Certification_Authority.crt)
- Government Root Certification Authority, expires Dec 5 13:23:33 2032 GMT (Taiwan_GRCA.crt)
- TeliaSonera Root CA v1, expires Oct 18 12:00:50 2032 GMT (TeliaSonera_Root_CA_v1.crt)
- Trustis FPS Root CA, expires Jan 21 11:36:54 2024 GMT (Trustis_FPS_Root_CA.crt)
- TÜBİTAK UEKAE Kök Sertifika Hizmet Sağlayıcısı - Sürüm 3, expires Aug 21 11:37:07 2017 GMT 
(TÜBİTAK_UEKAE_Kök_Sertifika_Hizmet_Sağlayıcısı_-_Sürüm_3.crt)
- TÜRKTRUST Elektronik Sertifika Hizmet Sağlayıcısı H5, expires Apr 28 08:07:01 2023 GMT 
(TÜRKTRUST_Elektronik_Sertifika_Hizmet_Sağlayıcısı_H5.crt)
- USERTrust ECC Certification Authority, expires Jan 18 23:59:59 2038 GMT 
(USERTrust_ECC_Certification_Authority.crt)
- USERTrust RSA Certification Authority, expires Jan 18 23:59:59 2038 GMT 
(USERTrust_RSA_Certification_Authority.crt)
- UTN-USERFirst-Hardware, expires Jul 9 18:19:22 2019 GMT (UTN_USERFirst_Hardware_Root_CA.crt)
- VeriSign Class 3 Public Primary Certification Authority - G4, expires Jan 18 23:59:59 2038 GMT 
(VeriSign_Class_3_Public_Primary_Certification_Authority_-_G4.crt)
- VeriSign Class 3 Public Primary Certification Authority - G5, expires Jul 16 23:59:59 2036 GMT 
(VeriSign_Class_3_Public_Primary_Certification_Authority_-_G5.crt)
- VeriSign Universal Root Certification Authority, expires Dec 1 23:59:59 2037 GMT 
(VeriSign_Universal_Root_Certification_Authority.crt)
- VeriSign Class 3 Public Primary Certification Authority - G3, expires Jul 16 23:59:59 2036 GMT 
(Verisign_Class_3_Public_Primary_Certification_Authority_-_G3.crt)
- Visa eCommerce Root, expires Jun 24 00:16:12 2022 GMT (Visa_eCommerce_Root.crt)
- XRamp Global Certification Authority, expires Jan 1 05:37:19 2035 GMT (XRamp_Global_CA_Root.crt)
- certSIGN ROOT CA, expires Jul 4 17:20:04 2031 GMT (certSIGN_ROOT_CA.crt)
- ePKI Root Certification Authority, expires Dec 20 02:31:27 2034 GMT (ePKI_Root_Certification_Authority.crt)
- thawte Primary Root CA, expires Jul 16 23:59:59 2036 GMT (thawte_Primary_Root_CA.crt)
- thawte Primary Root CA - G2, expires Jan 18 23:59:59 2038 GMT (thawte_Primary_Root_CA_-_G2.crt)
- thawte Primary Root CA - G3, expires Dec 1 23:59:59 2037 GMT (thawte_Primary_Root_CA_-_G3.crt)
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IGEL OS Creator (OSC)

Supported Devices
IGEL devices:

UD2-LX 40

UD3-LX 51

UD3-LX 50

UD5-LX 50

UD6-LX 51

UD7-LX 10

UD9-LX Touch 41

UD9-LX 40

For supported devices, see Devices Supported by IGEL OS 11.

General Information 11.01.100 (see page 866)
Component Versions 11.01.100 (see page 867)
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General Information 11.01.100
IGEL OS Creator is used for IGEL OS 11 installation and recovery on:

Supported IGEL hardware
IGEL UD Pocket
Supported x86 hardware

Find details in the IGEL OS Creator manual at https://kb.igel.com/osc-manual
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Component Versions 11.01.100
Clients
Product Version

Oracle JRE 1.8.0_202

Smartcard
Product Version

Reader Driver MUSCLE CCID 1.4.30-1igel3

Resource Manager PC/SC Lite 1.8.23-1igel1 

System Components
OpenSSL 1.0.2g-1ubuntu4.14

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.3.3-1igel57

VDPAU Library Version 1.1.1-3ubuntu1 

Graphics Driver INTEL 2.99.917+git20181113-igel856

Graphics Driver ATI/RADEON 18.1.0-1igel854

Graphics Driver ATI/AMDGPU 18.1.0-1igel853

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2igel775

Graphics Driver Vboxvideo 5.2.18-dfsg-2igel17

Graphics Driver VMware 13.3.0-2igel857  

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver Vmmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-udos-r2517  

Xorg X11 Server 1.19.6-1ubuntu4.2igel842
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Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel675 

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

Python2 2.7.12

Python3 3.5.2
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Notes for Release 10.06.190
Currently, the Release Notes for IGEL OS 10.06.190 are available only in plain text format, see lx_10.06.190.txt42.

https://www.igel.com/wp-content/uploads/2020/06/lx_10.06.190.txt
https://www.igel.com/wp-content/uploads/2020/06/lx_10.06.190.txt
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Notes for Release 10.06.170
Software: Version 10.06.170

Release Date: 2020-01-24

Release Notes: Version RN-106170-1

Last update: 2020-01-23

IGEL Linux Universal Desktop (see page 871)
IGEL Universal Desktop OS 3 (see page 884)
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IGEL Linux Universal Desktop

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Component Versions 10.06.170 (see page 872)
General Information 10.06.170 (see page 876)
Security Fixes 10.06.170 (see page 877)
Known Issues 10.06.170 (see page 878)
New Features 10.06.170 (see page 880)
Resolved Issues 10.06.170 (see page 882)
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Component Versions 10.06.170
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Workspace App 18.10.0.11

Citrix Workspace App 19.10.0.15

Citrix Workspace App 19.12.0.19

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.5

FabulaTech USB for Remote Desktop 5.2.29

Firefox 68.4.1

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64
Qualification in progress

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.5.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.3.20735

Remote Viewer (RedHat Virtualization) 8.0-1igel49

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Systancia AppliDis 4.0.0.17
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VMware Horizon Client 5.0.0-12557422

VNC Viewer 1.9.0+dfsg-3igel8

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech Driver 12.8.5

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.3.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.8.1.31

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel8

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20191117-igel939

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver VIA 5.76.52.92-opensource-009-005f78-20150730igel871

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.65 #mainline-ud-r2788

Xorg X11 Server 1.20.5-1igel914

Xorg Xephyr 1.20.5-1igel914

CUPS printing daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 25.1.0.303
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Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel656

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.26.1-3igel25

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / SANE 1.0.27-1

VirtualBox 6.0.8-dfsg-4igel25

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 10.06.170
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4;
Citrix Access Gateway Standard Plug-in;
Dell vWorkspace Connector for Linux;
Ericom PowerTerm Emulation 9 and 11;
Ericom Webconnect;
IGEL Legacy RDP Client (rdesktop);
Virtual Bridges VERDE Client;
PPTP VPN Support;
IGEL Upgrade License Tool with IGEL Smartcard Token;
Remote Management by setup.ini file transfer (TFTP);
Remote Access via RSH;
Legacy Philips Speech Driver;
T-Systems TCOS Smartcard Support;
DUS Series touchscreens;
Elo serial touchscreens;
Video hardware acceleration support is discontinued on UD10-LX Touch 10 and UD10-LX 10;
H.264 hardware acceleration support is discontinued on UD10-LX Touch 10 and UD10-LX 10;
Java WebStart;
Storage hotplug devices are not automatically removed anymore, instead they must always be 
ejected manually:

by a panel tray icon;
by an icon in the In-Session Control Bar (configurable under IGEL Setup > User Interface > 
Desktop);
by a Safely Remove Hardware session (configurable under IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel;
Open VPN Smartcard Support;
Asian Input Methods;
Composite Manager.
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Security Fixes 10.06.170
Firefox

Updated Mozilla Firefox to 68.4.1esr.
Fix for mfsa2020-03, also known as CVE-2019-17026.
Fixes for mfsa2020-02, also known as: CVE-2019-17016, CVE-2019-17017, CVE-2019-17022, and 
CVE-2019-17024.
Fixes for mfsa2019-37, also known as:
More...

CVE-2019-17008, CVE-2019-11745, CVE-2019-17010,
CVE-2019-17005, CVE-2019-17011, and CVE-2019-17012.

Fixes for mfsa2019-33, also known as:
More...

CVE-2019-15903, CVE-2019-11757, CVE-2019-11758,
CVE-2019-11759, CVE-2019-11760, CVE-2019-11761,
CVE-2019-11762, CVE-2019-11763, and CVE-2019-11764.
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Known Issues 10.06.170
Firefox

As the behavior of Firefox has changed, following settings for “Start in full-screen mode” and 
“Disable Hotkeys for open new window/tab" can be configured in first browser session only – 
these are handled like a usual global setting, means the configuration within another browser 
session does not has an effect for these two parameters.

Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and H264 acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
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It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Base system

Due to the removal of the Oracle JRE, Java WebStart is not supported anymore.

Hardware

Suspend on UD10 is disabled.
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New Features 10.06.170
Citrix

Integrated Citrix Workspace App 19.12
Available Citrix Workspace Apps in this release: 19.12 (default), 19.10, and 18.10
New registry keys:

Added a registry key for enabling full-screen banner "Citrix Desktop Viewer" when 
starting a Desktop or Application session.
More...

Parameter Show Citrix Desktop Viewer screen

Registry ica.module.cdviewerscreen

Value off / on

Added a registry key to enable usage of Chromium Embedded Framework (CEF) for 
Browser Content Redirection (BCR) [Experimental].
More...

Parameter Use Chromium Embedded Framework (CEF)

Registry ica.allregions.usecefbrowser

Value factory default / false / true

"Factory default" means that can be set by config file.
Added a registry key to enable/disable Transparent User Interface [TUI] Virtual Channel 
[VC] protocol. The VDTUI protocol is enabled by default.
More...

Parameter Enable VDTUI protocol

Registry ica.module.virtualdriver.vdtui.enable

Value off / on

Updated libwebkit2gtk-4.0-37 to version 2.26.1. It is now possible to enable debug output 
for Citrix Browser Content Redirection by running the script /config/bin/install-

webkit-debug . The debug output is written to /var/log/user/

webcontainer.debug . CAUTION: You can run only short sessions with enabled 
debug output because a lot of debugging data is written to the log file.

Firefox

Updated Fluendo multimedia codecs to the following versions: 
gst-fluendo-h264dec - 18/09/2019 0.10.54
gst-fluendo-vadec - 16/10/2019 0.10.210
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Imprivata

Usage of 500 MB for the Imprivata data partition when flash is bigger than 2 GB.

OS 11 Upgrade

Add parameter to skip battery checking in OS 11 Upgrade.
More...

Parameter Use at your own risk! Turns Battery safety check into warning only. 
Any unbootable systems are on you.

Registry update.battery_is_only_warning

Value enabled / disabled

IGEL Cloud Gateway

Added support for shadowing via ICG.
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Resolved Issues 10.06.170
Imprivata

Fixed race condition that may lead to unexpected behavior with RDP connections.
Fixed VMware Horizon session disconnect.
Fixed Lock-key and Tap-out behavior.
Fixed MS RDSH session.

VMware Horizon

Fixed sound in Horizon client 5.x using PCoIP protocol.

Caradigm

Caradigm restart loops fixed.

Base system

Fixed potential temporary settings loss when resuming from standby.
Automatic firmware update is now checked after retrieval of UMS settings.
When there are any non-applied changes in the network configuration, the network will be 
reconfigured before the firmware update starts.
Re-fixed broken custom bootsplash when doing a reset to factory defaults via UMS.

Smartcard

Updated SecMaker Net iD smartcard library to version 6.8.1.31. The changes are:
More...

Support for Gemalto IDPrime 940 and 3940.
Support for new VRK card (IDEMIA IAS ECC, spec: FINEID S1 - FINEID S1 Electronic ID 
Application v4.0).
Support for Aventra MyEID v4.0 (customer specific card profile with read support only).
Fixed problem with detection of cards in Net iD Card Portal.
Other fixes, see release notes at SecMaker.

Fixed smartcard user names displayed on login screen: non-ASCII characters were not shown 
correctly before.
Fixed error message on login screen shown when smartcard PIN is locked.
Fixed handling of smartcards in pcsc-lite: improved transaction locking.
A new parameter was introduced to control the new behavior (enabled by default):
More...

Parameter Abort stalled transactions

Registry scard.pcscd.abort_stalled_transactions

Value enabled / disabled

Fixed IGEL Smartcard to be able to handle VoIP client Ekiga sessions.

Driver

Updated Philips Speech Driver to version 12.8.5.
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Updated StepOver TCP Client to version 2.3.2.

CUPS Printing

Updated Printer Installer client to version 25.1.0.303.
Added missing CUPS model names for some CUPS printers.

X11 system

Fixed an issue with modesetting driver and DisplayLink USB graphic adapters.
Removed registry key x.drivers.glamor.use_dri3  as it is of no real use.
Updated Intel Xorg driver to work fix issues with DisplayLink USB adapters.
Fixed issue with Wacom Signing Pads not being recognized as displays.

X server

Fix HP Elitebook Display issue with HP Ultraslim Docking Station.

Network

Fixed issue when configuring more then one NTP server.
Fixed missing library with openconnect feature.

OS 11 Upgrade

Add special warning when not connected to power line in upgrade boot.

RDP/IGEL RDP Client 2

Fixed RDP Web Access Domain Visibility not working correctly.

Remote Management

Fixed broken logon into Shared Workplace on devices that are managed over ICG.
Fixed responding to requests searching an available buddy update server.

VNC

Fixed sporadic connection failure in the VNC server.
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IGEL Universal Desktop OS 3

Supported Hardware
https://kb.igel.com/udc3-supported-devices

Component Versions 10.06.170 (see page 885)
General Information 10.06.170 (see page 889)
Security Fixes 10.06.170 (see page 890)
Known Issues 10.06.170 (see page 891)
New Features 10.06.170 (see page 893)
Resolved Issues 10.06.170 (see page 895)
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Component Versions 10.06.170
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Workspace App 18.10.0.11

Citrix Workspace App 19.10.0.15

Citrix Workspace App 19.12.0.19

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.5

FabulaTech USB for Remote Desktop 5.2.29

Firefox 68.4.1

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64
Qualification in progress

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.5.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.3.20735

Remote Viewer (RedHat Virtualization) 8.0-1igel49

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Systancia AppliDis 4.0.0.17
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VMware Horizon Client 5.0.0-12557422

VNC Viewer 1.9.0+dfsg-3igel8

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech Driver 12.8.5

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.3.2

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.8.1.31

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel8

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20191117-igel939

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 390.116-0ubuntu0.18.10.1

Graphics Driver VIA 5.76.52.92-
opensource-009-005f78-20150730igel871

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMmouse 13.1.0-1ubuntu2igel635
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Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.65 #mainline-udos-r2788

Xorg X11 Server 1.20.5-1igel914

Xorg Xephyr 1.20.5-1igel914

CUPS Printing Daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 25.1.0.303

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel656

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.26.1-3igel25

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / SANE 1.0.27-1

VirtualBox 6.0.8-dfsg-4igel25

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 10.06.170
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4;
Citrix Access Gateway Standard Plug-in;
Dell vWorkspace Connector for Linux;
Ericom PowerTerm Emulation 9 and 11;
Ericom Webconnect;
IGEL Legacy RDP Client (rdesktop);
Virtual Bridges VERDE Client;
PPTP VPN Support;
IGEL Upgrade License Tool with IGEL Smartcard Token;
Remote Management by setup.ini  file transfer (TFTP);
Remote Access via RSH;
Legacy Philips Speech Driver;
T-Systems TCOS Smartcard Support;
DUS Series touchscreens;
Elo serial touchscreens;
VIA Graphics support;
Java WebStart;
Storage hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon;
by an icon in the In-Session Control Bar (configurable under IGEL Setup > User Interface > 
Desktop);
by a Safely Remove Hardware session (configurable under IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel;
Open VPN Smartcard Support;
Asian Input Methods;
Composite Manager.
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Security Fixes 10.06.170
Firefox

Updated Mozilla Firefox to 68.4.1esr.
Fix for mfsa2020-03, also known as CVE-2019-17026.
Fixes for mfsa2020-02, also known as: CVE-2019-17016, CVE-2019-17017, CVE-2019-17022, and 
CVE-2019-17024.
Fixes for mfsa2019-37, also known as:
More...

CVE-2019-17008, CVE-2019-11745, CVE-2019-17010,
CVE-2019-17005, CVE-2019-17011, and CVE-2019-17012.

Fixes for mfsa2019-33, also known as:
More...

CVE-2019-15903, CVE-2019-11757, CVE-2019-11758,
CVE-2019-11759, CVE-2019-11760, CVE-2019-11761,
CVE-2019-11762, CVE-2019-11763, and CVE-2019-11764.
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Known Issues 10.06.170
Firefox

As the behavior of Firefox has changed, following settings for “Start in full-screen mode” and 
“Disable Hotkeys for open new window/tab" can be configured in first browser session only – 
these are handled like a usual global setting, means the configuration within another browser 
session does not has an effect for these two parameters.

Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and H264 acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
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It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Base system

Due to the removal of the Oracle JRE, Java WebStart is not supported anymore.
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New Features 10.06.170
Citrix

Integrated Citrix Workspace App 19.12
Available Citrix Workspace Apps in this release: 19.12 (default), 19.10, and 18.10
New registry keys:

Added a registry key for enabling full-screen banner "Citrix Desktop Viewer" when 
starting a Desktop or Application session.
More...

Parameter Show Citrix Desktop Viewer screen

Registry ica.module.cdviewerscreen

Value off / on

Added a registry key to enable usage of Chromium Embedded Framework (CEF) for 
Browser Content Redirection (BCR) [Experimental].
More...

Parameter Use Chromium Embedded Framework (CEF)

Registry ica.allregions.usecefbrowser

Value factory default / false / true

"Factory default" means that can be set by config file.
Added a registry key to enable/disable Transparent User Interface [TUI] Virtual Channel 
[VC] protocol. The VDTUI protocol is enabled by default.
More...

Parameter Enable VDTUI protocol

Registry ica.module.virtualdriver.vdtui.enabl

e

Value off / on

Updated libwebkit2gtk-4.0-37 to version 2.26.1. It is now possible to enable debug output 
for Citrix Browser Content Redirection by running the script /config/bin/install-

webkit-debug . The debug output is written to /var/log/user/

webcontainer.debug . CAUTION: You can run only short sessions with enabled 
debug output because a lot of debugging data is written to the log file.

Firefox
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Updated Fluendo multimedia codecs to the following versions: 
gst-fluendo-h264dec - 18/09/2019 0.10.54
gst-fluendo-vadec - 16/10/2019 0.10.210

Imprivata

Usage of 500 MB for the Imprivata data partition when flash is bigger than 2 GB.

OS 11 Upgrade

Add parameter to skip battery checking in OS 11 Upgrade.
More...

Parameter Use at your own risk! Turns Battery safety check into warning 
only. Any unbootable systems are on you.

Registry update.battery_is_only_warning

Value enabled / disabled

IGEL Cloud Gateway

Added support for shadowing via ICG.
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Resolved Issues 10.06.170
Imprivata

Fixed race condition that may lead to unexpected behavior with RDP connections.
Fixed VMware Horizon session disconnect.
Fixed Lock-key and Tap-out behavior.
Fixed MS RDSH session.

VMware Horizon

Fixed sound in Horizon client 5.x using PCoIP protocol.

Caradigm

Caradigm restart loops fixed.

Base system

Fixed potential temporary settings loss when resuming from standby.
Automatic firmware update is now checked after retrieval of UMS settings.
When there are any non-applied changes in the network configuration, the network will be 
reconfigured before the firmware update starts.
Re-fixed broken custom bootsplash when doing a reset to factory defaults via UMS.

Smartcard

Updated SecMaker Net iD smartcard library to version 6.8.1.31. The changes are:
More...

Support for Gemalto IDPrime 940 and 3940.
Support for new VRK card (IDEMIA IAS ECC, spec: FINEID S1 - FINEID S1 Electronic ID 
Application v4.0).
Support for Aventra MyEID v4.0 (customer specific card profile with read support only).
Fixed problem with detection of cards in Net iD Card Portal.
Other fixes, see release notes at SecMaker.

Fixed smartcard user names displayed on login screen: non-ASCII characters were not shown 
correctly before.
Fixed error message on login screen shown when smartcard PIN is locked.
Fixed handling of smartcards in pcsc-lite: improved transaction locking.
A new parameter was introduced to control the new behavior (enabled by default):
More...

Parameter Abort stalled transactions

Registry scard.pcscd.abort_stalled_transactions

Value enabled / disabled

Fixed IGEL Smartcard to be able to handle VoIP client Ekiga sessions.

Driver

Updated Philips Speech Driver to version 12.8.5.
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Updated StepOver TCP Client to version 2.3.2.

CUPS Printing

Updated Printer Installer client to version 25.1.0.303.
Added missing CUPS model names for some CUPS printers.

X11 system

Fixed an issue with modesetting driver and DisplayLink USB graphic adapters.
Removed registry key x.drivers.glamor.use_dri3  as it is of no real use.
Updated Intel Xorg driver to work fix issues with DisplayLink USB adapters.
Fixed issue with Wacom Signing Pads not being recognized as displays.

X server

Fix HP Elitebook Display issue with HP Ultraslim Docking Station.

Network

Fixed issue when configuring more then one NTP server.
Fixed missing library with openconnect feature.

OS 11 Upgrade

Add special warning when not connected to power line in upgrade boot.

RDP/IGEL RDP Client 2

Fixed RDP Web Access Domain Visibility not working correctly.

Remote Management

Fixed broken logon into Shared Workplace on devices that are managed over ICG.
Fixed responding to requests searching an available buddy update server.

VNC

Fixed sporadic connection failure in the VNC server.
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Notes for Release 10.06.130
Software: Version 10.06.130

Release Date: 2019-09-09

Release Notes: Version RN-106130-1

Last update: 2019-09-09

IGEL Linux Universal Desktop (see page 898)
IGEL Universal Desktop OS 3 (see page 910)
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IGEL Linux Universal Desktop

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Component Versions 10.06.130 (see page 899)
General Information 10.06.130 (see page 903)
Security Fixes 10.06.130 (see page 904)
Known Issues 10.06.130 (see page 905)
Resolved Issues 10.06.130 (see page 907)
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Component Versions 10.06.130
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Workspace App 19.3.0.5

Citrix Workspace App 19.6.0.60

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.5

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.9.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.5.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.3.20735

Remote Viewer (RedHat Virtualization) 8.0-1igel49

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Systancia AppliDis 4.0.0.17
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VMware Horizon Client 5.0.0-12557422

VNC Viewer 1.9.0+dfsg-3igel8

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech Driver 12.7.11

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190301-igel870

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver VIA 5.76.52.92-opensource-009-005f78-20150730igel871

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.65 #mainline-ud-r2788

Xorg X11 Server 1.20.5-1igel914

Xorg Xephyr 1.20.5-1igel914

CUPS printing daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 18.2.1.128
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Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel656

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / SANE 1.0.27-1

VirtualBox 6.0.8-dfsg-4igel25

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 10.06.130
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4;
Citrix Access Gateway Standard Plug-in;
Dell vWorkspace Connector for Linux;
Ericom PowerTerm Emulation 9 and 11;
Ericom Webconnect;
IGEL Legacy RDP Client (rdesktop);
Virtual Bridges VERDE Client;
PPTP VPN Support;
IGEL Upgrade License Tool with IGEL Smartcard Token;
Remote Management by setup.ini file transfer (TFTP);
Remote Access via RSH;
Legacy Philips Speech Driver;
T-Systems TCOS Smartcard Support;
DUS Series touchscreens;
Elo serial touchscreens;
Video hardware acceleration support is discontinued on UD10-LX Touch 10 and UD10-LX 10;
H.264 hardware acceleration support is discontinued on UD10-LX Touch 10 and UD10-LX 10;
Java WebStart;
Storage hotplug devices are not automatically removed anymore, instead they must always be 
ejected manually:

by a panel tray icon;
by an icon in the In-Session Control Bar (configurable under IGEL Setup > User Interface > 
Desktop);
by a Safely Remove Hardware session (configurable under IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel;
Open VPN Smartcard Support;
Asian Input Methods;
Composite Manager.
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Security Fixes 10.06.130
Firefox

Updated Mozilla Firefox to version 60.9.0 ESR.
Including fixes from Security Advisory 2019-27:
More...

CVE-2019-11746, CVE-2019-11744, CVE-2019-11753, CVE-2019-11752,
CVE-2019-9812, CVE-2019-11743, and CVE-2019-11740.
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Known Issues 10.06.130
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and 
H264 acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
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Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Base system

Due to the removal of the Oracle JRE, Java WebStart is not supported anymore.

Hardware

Suspend on UD10 is disabled.
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Resolved Issues 10.06.130
RDP/IGEL RDP Client 2

Fixed RDP graphics issues with Windows 2008(R2) Server (when RemoteFX is not enabled).
Fixed some smaller graphical RDP issues with Windows 2012 R2 if using Clearcodec.

Network

Changed minimally allowed MSS size to '750' to avoid problems with some VPN solutions.
Added a new registry key to be able to configure the minimally allowed TCP MSS size.
A new registry key:
More...

Parameter Minimal TCP send MSS size

Registry system.sysctl.tcp_min_snd_mss

Type Integer

Value 750

Tooltip Minimal TCP send MSS size (configurable value in the area 
from 200 to 1450)

OS 11 Upgrade

Fixed OS11 Upgrade failing when IGEL Setup Assistant is auto started.

Base system

Removed deprecated registry keys system.idlecommand...  .

X11 system

Fixed problem with modesetting driver and 2 x 2160x1440 monitors in extended configuration.
Added a new registry key to enable the use of linear framebuffer for modesetting driver.
A new registry key:
Parameter Use linear instead of tiled framebuffer

Registry x.drivers.modesetting.use_linear_framebuffer

Range [Default] [False] [True]

Value "Default" (use linear framebuffer only in special cases)

Added a new registry key to disable/enable the use of DRI3 with GLAMOR acceleration.
A new registry key:
Parameter Disable/Enable usage of DRI3 in GLAMOR acceleration

Registry x.drivers.glamor.use_dri3
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Range [Auto] [False] [True]

Value "Auto" (use no DRI3 functions for modesetting driver with only 
DRI2 active)

Added new registry keys to be able to configure some modesetting options if needed. 
New registry keys:
More...

Parameter Use DRI3 PageFlip feature

Registry x.drivers.modesetting.use_page_flip

Range [Default] [False] [True]

Info "Default" (normally use page flip feature)

Parameter Use shadow framebuffer layer

Registry x.drivers.modesetting.use_shadow_fb

Range [Default] [False] [True]

Info "Default" (normally use shadow framebuffer)

Parameter Use double shadow framebuffer to improve VNC performance

Registry x.drivers.modesetting.use_double_shadow

Range [False] [True]

Parameter Use software cursor for modesetting driver

Registry x.drivers.modesetting.use_sw_cursor

Range [Default] [False] [True]

Info "Default" (normally false)

Parameter Choose acceleration method

Registry x.drivers.modesetting.accel_method

Range [Default] [Glamor] [None]  

Info "Default" (normally Glamor is used)

Parameter Force usage of DRI3 regardless of x.drivers.use_dri3 setting

Registry x.drivers.modesetting.force_dri3

Type Bool
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Value False

X server

Fixed Xorg freezes if using modesetting driver and video acceleration.

Hardware

Fixed EFI freeze problem after bootcode update on devices like the HP t630 and probably others 
too.
Added support for newer Prolific PL2303 USB serial adapters.
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IGEL Universal Desktop OS 3
Supported Hardware:

https://kb.igel.com/udc3-supported-devices

Component Versions 10.06.130 (see page 911)
General Information 10.06.130 (see page 915)
Security Fixes 10.06.130 (see page 916)
Known Issues 10.06.130 (see page 917)
New Features 10.06.130 (see page 919)
Resolved Issues 10.06.130 (see page 920)
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Component Versions 10.06.130
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Workspace App 19.3.0.5

Citrix Workspace App 19.6.0.60

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.5

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.9.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.5.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.3.20735

Remote Viewer (RedHat Virtualization) 8.0-1igel49

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Systancia AppliDis 4.0.0.17
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VMware Horizon Client 5.0.0-12557422

VNC Viewer 1.9.0+dfsg-3igel8

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech Driver 12.7.11

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190301-igel870

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 390.116-0ubuntu0.18.10.1

Graphics Driver VIA 5.76.52.92-
opensource-009-005f78-20150730igel871

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMmouse 13.1.0-1ubuntu2igel635
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Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.65 #mainline-udos-r2788

Xorg X11 Server 1.20.5-1igel914

Xorg Xephyr 1.20.5-1igel914

CUPS Printing Daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel656

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / SANE 1.0.27-1

VirtualBox 6.0.8-dfsg-4igel25

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 10.06.130
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4;
Citrix Access Gateway Standard Plug-in;
Dell vWorkspace Connector for Linux;
Ericom PowerTerm Emulation 9 and 11;
Ericom Webconnect;
IGEL Legacy RDP Client (rdesktop);
Virtual Bridges VERDE Client;
PPTP VPN Support;
IGEL Upgrade License Tool with IGEL Smartcard Token;
Remote Management by setup.ini  file transfer (TFTP);
Remote Access via RSH;
Legacy Philips Speech Driver;
T-Systems TCOS Smartcard Support;
DUS Series touchscreens;
Elo serial touchscreens;
VIA Graphics support;
Java WebStart;
Storage hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon;
by an icon in the In-Session Control Bar (configurable under IGEL Setup > User Interface > 
Desktop);
by a Safely Remove Hardware session (configurable under IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel;
Open VPN Smartcard Support;
Asian Input Methods;
Composite Manager.
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Security Fixes 10.06.130
Firefox

Updated Mozilla Firefox to version 60.9.0 ESR.
Including fixes from Security Advisory 2019-27:
More...

CVE-2019-11746, CVE-2019-11744, CVE-2019-11753, CVE-2019-11752,
CVE-2019-9812, CVE-2019-11743, and CVE-2019-11740.
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Known Issues 10.06.130
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and 
H264 acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
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Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Wi-Fi

TP-Link Archer T2UH Wi-Fi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Base system

Due to the removal of the Oracle JRE, Java WebStart is not supported anymore.
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New Features 10.06.130
Hardware

Added basic support for HP t510 devices.
Re-added VIA driver for HP t510 to OS firmware (only limited support; provided "as is", without 
the guarantee of correct functionality).
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Resolved Issues 10.06.130
RDP/IGEL RDP Client 2

Fixed RDP graphics issues with Windows 2008(R2) Server (when RemoteFX is not enabled).
Fixed some smaller graphical RDP issues with Windows 2012 R2 if using Clearcodec.

Network

Changed minimally allowed MSS size to '750' to avoid problems with some VPN solutions.
Added a new registry key to be able to configure the minimally allowed TCP MSS size.
A new registry key:
More...

Parameter Minimal TCP send MSS size

Registry system.sysctl.tcp_min_snd_mss

Type Integer

Value 750

Tooltip Minimal TCP send MSS size (configurable value in the 
area from 200 to 1450)

OS 11 Upgrade

Fixed OS11 Upgrade failing when IGEL Setup Assistant is auto started.

Base system

Removed deprecated registry keys system.idlecommand...  .

X11 system

Fixed problem with modesetting driver and 2 x 2160x1440 monitors in extended configuration.
Added a new registry key to enable the use of linear framebuffer for modesetting driver.
A new registry key:
Parameter Use linear instead of tiled framebuffer

Registry x.drivers.modesetting.use_linear_framebuffe

r

Range [Default] [False] [True]

Value "Default" (use linear framebuffer only in special cases)

Added a new registry key to disable/enable the use of DRI3 with GLAMOR acceleration.
A new registry key:
Parameter Disable/Enable usage of DRI3 in GLAMOR acceleration
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Registry x.drivers.glamor.use_dri3

Range [Auto] [False] [True]

Value "Auto" (use no DRI3 functions for modesetting driver with only 
DRI2 active)

Added new registry keys to be able to configure some modesetting options if needed. 
New registry keys:
More...

Parameter Use DRI3 PageFlip feature

Registry x.drivers.modesetting.use_page_flip

Range [Default] [False] [True]

Info "Default" (normally use page flip feature)

Parameter Use shadow framebuffer layer

Registry x.drivers.modesetting.use_shadow_fb

Range [Default] [False] [True]

Info "Default" (normally use shadow framebuffer)

Parameter Use double shadow framebuffer to improve VNC performance

Registry x.drivers.modesetting.use_double_shadow

Range [False] [True]

Parameter Use software cursor for modesetting driver

Registry x.drivers.modesetting.use_sw_cursor

Range [Default] [False] [True]

Info "Default" (normally false)

Parameter Choose acceleration method

Registry x.drivers.modesetting.accel_method

Range [Default] [Glamor] [None]  

Info "Default" (normally Glamor is used)

Parameter Force usage of DRI3 regardless of x.drivers.use_dri3 setting
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Registry x.drivers.modesetting.force_dri3

Type Bool

Value False

X server

Fixed Xorg freezes if using modesetting driver and video acceleration.

Hardware

Fixed EFI freeze problem after bootcode update on devices like the HP t630 and probably others 
too.
Added support for newer Prolific PL2303 USB serial adapters.
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Notes for Release 10.06.120
Software: Version 10.06.120

Release Date: 2019-08-23

Release Notes: Version RN-106120-1

Last update: 2019-08-23

IGEL Linux Universal Desktop (see page 924)
IGEL Universal Desktop OS 3 (see page 939)
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IGEL Linux Universal Desktop

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Component Versions 10.06.120 (see page 925)
General Information 10.06.120 (see page 929)
Security Fixes 10.06.120 (see page 930)
Known Issues 10.06.120 (see page 935)
New Features 10.06.120 (see page 937)
Resolved Issues 10.06.120 (see page 938)
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Component Versions 10.06.120
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Workspace App 19.3.0.5

Citrix Workspace App 19.6.0.60

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.5

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.8.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.5.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.3.20735

Remote Viewer (RedHat Virtualization) 8.0-1igel49

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Systancia AppliDis 4.0.0.17
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VMware Horizon Client 5.0.0-12557422

VNC Viewer 1.9.0+dfsg-3igel8

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech Driver 12.7.11

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190301-igel870

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver VIA 5.76.52.92-opensource-009-005f78-20150730igel871

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.65 #mainline-ud-r2782

Xorg X11 Server 1.20.5-1igel891

Xorg Xephyr 1.20.5-1igel891

CUPS printing daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 18.2.1.128
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Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel656

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / SANE 1.0.27-1

VirtualBox 6.0.8-dfsg-4igel25

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 10.06.120
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4;
Citrix Access Gateway Standard Plug-in;
Dell vWorkspace Connector for Linux;
Ericom PowerTerm Emulation 9 and 11;
Ericom Webconnect;
IGEL Legacy RDP Client (rdesktop);
Virtual Bridges VERDE Client;
PPTP VPN Support;
IGEL Upgrade License Tool with IGEL Smartcard Token;
Remote Management by setup.ini file transfer (TFTP);
Remote Access via RSH;
Legacy Philips Speech Driver;
T-Systems TCOS Smartcard Support;
DUS Series touch screens;
Elo serial touchscreens;
Video hardware acceleration support is discontinued on UD10-LX Touch 10 and UD10-LX 10;
H.264 hardware acceleration support is discontinued on UD10-LX Touch 10 and UD10-LX 10;
Java WebStart;
Storage hotplug devices are not automatically removed anymore, instead they must always be 
ejected manually:

by panel tray icon;
by an icon in the In-Session Control Bar (configurable under IGEL Setup > User Interface > 
Desktop);
by a Safely Remove Hardware session (configurable under IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel;
Open VPN Smartcard Support;
Asian Input Methods;
Composite Manager.
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Security Fixes 10.06.120
Firefox

Updated Firefox browser to version 60.8.0 ESR.
Fixed mfsa2019-22 security issues:
More...

CVE-2019-9811, CVE-2019-11711, CVE-2019-11712, CVE-2019-11713,
CVE-2019-11729, CVE-2019-11715, CVE-2019-11717, CVE-2019-11719,
CVE-2019-11730 and CVE-2019-11709.

Fixed mfsa2019-19 security issue CVE-2019-11708.
Fixed mfsa2019-18 security issue CVE-2019-11707.
Fixed mfsa2019-08 security issues:
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506 and CVE-2019-9788.

Fixed mfsa2019-05 security issues CVE-2018-18356 and CVE-2019-5785.
Fixed mfsa2019-02 security issues CVE-2018-18500, CVE-2018-18505 and CVE-2018-18501.

Shared Workplace

Fixed login in Shared Workplace which accepts any user credentials in the 10.06.100 release. 
However, no user settings were applied to the device.

Base system

Updated kernel to version 4.19.65.
Fixed security issue CVE-2019-1125 aka Spectre SWAPGS gadget vulnerability.
Fixed a vulnerability in Java configuration script.
Fixed possibly malicious owner change with TC setup configuration.
Fixed policykit-1 security issues CVE-2018-19788 and CVE-2019-6133.
Fixed NSS security issues CVE-2018-18508, CVE-2018-12404, CVE-2018-12384 and CVE-2018-0495.
Fixed PPP security issue CVE-2018-11574.
Fixed imagemagick security issues.
More...

CVE-2018-16750, CVE-2018-16749, CVE-2018-16645, CVE-2018-16644,
CVE-2018-16643, CVE-2018-16642, CVE-2018-16640, CVE-2018-16323,
CVE-2018-14437, CVE-2018-14436, CVE-2018-14435, CVE-2018-14434,
CVE-2017-13144, CVE-2017-12430, CVE-2019-9956, CVE-2019-7398,
CVE-2019-7397, CVE-2019-7396, CVE-2019-7175, CVE-2019-11598,
CVE-2019-11597, CVE-2019-11472, CVE-2019-11470, CVE-2019-10650,
CVE-2019-10131, CVE-2018-20467, CVE-2018-18025, CVE-2018-18024,
CVE-2018-18016, CVE-2018-17966, CVE-2018-17965, CVE-2018-16413,
CVE-2018-16412, CVE-2017-12806, and CVE-2017-12805.

Fixed systemd security issues.
More...
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CVE-2018-16866, CVE-2018-16865, CVE-2018-16864, CVE-2018-15688,
CVE-2019-6454, CVE-2018-1049, CVE-2018-15686 and CVE-2019-3842.

Fixed CUPS security issue CVE-2018-4700.
Fixed libarchive security issues.
More...

CVE-2019-1000020, CVE-2019-1000019, CVE-2018-1000878,
CVE-2018-1000877, and CVE-2017-14502.

Fixed avahi security issues CVE-2018-1000845 and CVE-2017-6519.
Fixed bind9 security issues CVE-2019-6465, CVE-2018-5745, and CVE-2018-5743.
Fixed libcaca security issues.
More...

CVE-2018-20549, CVE-2018-20548, CVE-2018-20547,
CVE-2018-20546, CVE-2018-20545, and CVE-2018-20544.

Fixed libgd2 security issues CVE-2019-6978 and CVE-2019-6977.
Fixed ghostscript security issues.
More...

CVE-2019-6116, CVE-2018-19477, CVE-2018-19476, CVE-2018-19475,
CVE-2018-19409, CVE-2018-18284, CVE-2018-18073, CVE-2018-17961,
CVE-2019-3838, and CVE-2019-3835.

Fixed krb5 security issues.
More...

CVE-2018-5730, CVE-2018-5729, CVE-2017-11462,
CVE-2017-11368, CVE-2016-3120, and CVE-2016-3119.

Fixed texlive-bin security issue CVE-2018-17407.
Fixed LDB security issue CVE-2019-3824.
Fixed libmspack security issues CVE-2018-18585 and CVE-2018-18584.
Fixed Perl security issues CVE-2018-18314, CVE-2018-18313, CVE-2018-18312 and CVE-2018-18311.
Fixed poppler security issues.
More...

CVE-2019-7310, CVE-2018-20650, CVE-2018-20551, CVE-2018-20481,
CVE-2018-19149, CVE-2018-19060, CVE-2018-19059, CVE-2018-19058,
CVE-2018-16646, and CVE-2019-9200.

Fixed Python 3.5 security issues CVE-2018-14647, CVE-2018-1061, CVE-2018-1060 and 
CVE-2018-106.
Fixed Net-SNMP security issue CVE-2018-18065.
Fixed OpenSSL security issues CVE-2019-1559, CVE-2018-5407 and CVE-2018-0734.
Fixed TIFF security issues.
More...

CVE-2018-8905, CVE-2018-7456, CVE-2018-18661, CVE-2018-18557,
CVE-2018-17101, CVE-2018-17100, CVE-2018-1710, CVE-2018-10963,
CVE-2019-7663, CVE-2019-6128, CVE-2018-19210, CVE-2018-17000,
CVE-2018-12900, and CVE-2018-10779.
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Fixed libvncserver security issues.
More...

CVE-2018-6307, CVE-2018-20750, CVE-2018-20749, CVE-2018-20748,
CVE-2018-20024, CVE-2018-20023, CVE-2018-20022, CVE-2018-20021,
CVE-2018-20020, CVE-2018-20019, CVE-2018-15127, and CVE-2018-15126.

Fixed WavPack security issue CVE-2018-19840.
Fixed Samba security issues.
More...

CVE-2018-16851, CVE-2018-16841, CVE-2018-14629,
CVE-2019-3880, and CVE-2018-16860.

Fixed libxkbcommon security issues.
More...

CVE-2018-15864, CVE-2018-15863, CVE-2018-15862, CVE-2018-15861,
CVE-2018-15859, CVE-2018-15858, CVE-2018-15857, CVE-2018-15856,
CVE-2018-15855, CVE-2018-15854, and CVE-2018-15853.

Fixed OpenSSH security issues.
More...

CVE-2019-6111, CVE-2019-6109, CVE-2018-20685,
CVE-2018-15473, and CVE-2016-10708.

Fixed Python 2.7 security issues.
More...

CVE-2018-14647, CVE-2018-1061, CVE-2018-1060,
CVE-2018-106, CVE-2018-1000802, and CVE-2018-1000030.

Fixed lxml security issue CVE-2018-19787.
Fixed gdk-pixbuf security issues.
More...

CVE-2017-6314, CVE-2017-6313, CVE-2017-6312,
CVE-2017-6311, CVE-2017-2870, CVE-2017-2862,
CVE-2017-1000422, CVE-2016-6352, and CVE-2017-12447.

Fixed file security issues CVE-2019-8907 and CVE-2019-8905.
Fixed wget security issue CVE-2019-5953.
Fixed libxslt security issue CVE-2019-11068.
Fixed Evince security issue CVE-2019-11459.
Fixed webkit2gtk security issues.
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251,
CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378,
CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345,
CVE-2018-4386, and CVE-2018-4372.

Fixed gst-plugins-base0.10 security issue CVE-2019-9928.
Fixed WPA security issues.
More...
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CVE-2019-9495, CVE-2019-9497, CVE-2019-9498,
CVE-2019-9499, and CVE-2019-11555.

Fixed Heimdal security issues CVE-2019-12098 and CVE-2018-16860.
Fixed libimobiledevice security issue CVE-2016-5104.
Fixed libpng1.6 security issues CVE-2019-7317 and CVE-2018-13785.
Fixed GIMP security issues.
More...

CVE-2017-17786, CVE-2017-17789, CVE-2017-17784,
CVE-2017-17787, CVE-2017-17785, and CVE-2017-17788

Fixed libtomcrypt security issue CVE-2018-12437.
Fixed curl security issues.
More...

CVE-2018-16840, CVE-2018-16839, CVE-2019-3823,
CVE-2019-3822, CVE-2018-16890, CVE-2019-5346.

Fixed gnutls28 security issues CVE-2018-10846, CVE-2018-10845, CVE-2018-10844 and 
CVE-2018-1084.
Fixed qtbase-opensource-src security issues CVE-2018-19873, CVE-2018-19870 and 
CVE-2018-15518.
Fixed db5.3 security issue CVE-2019-8457.
Fixed libssh2 security issues.
More...

CVE-2019-3863, CVE-2019-3862, CVE-2019-3861,
CVE-2019-3860, CVE-2019-3859, CVE-2019-3858, 
CVE-2019-3857, CVE-2019-3856, and CVE-2019-3855.

Fixed network-manager security issue CVE-2018-15688.
Fixed elfutils security issues.
More...

CVE-2019-7665, CVE-2019-7150, CVE-2019-7149,
CVE-2018-18521, CVE-2018-18520, CVE-2018-18310,
CVE-2018-16403, CVE-2018-16402, and CVE-2018-16062.

Fixed libsndfile security issues.
More...

CVE-2019-3832, CVE-2018-19758, CVE-2018-19662, CVE-2018-19661, CVE-2018-19432, 
CVE-2018-13139, CVE-2017-6892, CVE-2017-17457, CVE-2017-17456, CVE-2017-16942,
CVE-2017-14634, CVE-2017-14246, and CVE-2017-14245.

Fixed dbus security issue CVE-2019-12749.
Fixed Vim security issues CVE-2019-12735 and CVE-2017-5953.
Fixed sqlite3 security issues.
More...

CVE-2019-9937, CVE-2019-9936, CVE-2019-8457, CVE-2018-20506,
CVE-2018-20346, CVE-2017-2520, CVE-2017-2519, CVE-2017-2518,
CVE-2017-13685, CVE-2017-10989, and CVE-2016-6153.
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Fixed libseccomp security issue CVE-2019-9893.
Fixed bzip2 security issues CVE-2019-12900 and CVE-2016-3189.
Fixed Expat security issue CVE-2018-20843.
Fixed unzip security issues CVE-2019-13232, CVE-2018-1000035, CVE-2016-9844 and 
CVE-2014-9913.
Mount partitions with "nodev" flag option.
The home directory of the remote users is now /home/ruser.
Default umask is set to 0077 for all non-root users.
Fixed a vulnerability in the custom environment variable framework.
Fixed kernel TCP vulnerabilities CVE-2019-11477: SACK Panic, CVE-2019-11478: SACK Slowness
and CVE-2019-11479: Excess Resource Consumption Due to Low MSS Values.
Changed minimally allowed MSS size to "1000" to prevent possible denial-of-service attacks.
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Known Issues 10.06.120
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and 
H264 acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

Sound redirection in PCoIP is broken when the so-called lightweight-client is used, which has 
become the new default.
But Sound redirection can still be used by choosing the rollback-client instead. This can be done 
by setting the IGEL Registry key:
More...

Parameter Allow rollback to former client variant

Registry vmware.view.allow-client-rollback

Value enabled / disabled

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
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Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Wi-Fi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Base system

Due to the removal of the Oracle JRE, Java WebStart is not supported anymore.

Hardware

Suspend on UD10 is disabled.
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New Features 10.06.120
Citrix

Integrated Citrix Workspace app 19.06. 
Available Citrix Workspace apps in this release: 19.06, 19.03 and 13.10.
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Resolved Issues 10.06.120
VMware Horizon

Fixed: Client connection to the remote desktop using PCoIP protocol failed occasionally.

OS 11 Upgrade

Fixed major upgrade problem with Intel network drivers.
Make OS 11 Upgrade VPN detection more lenient to allow blocked upgrade on some devices with 
integrated mobile broadband modem.

Base system

Fixed ActiveDirectory/Kerberos password change with "Change Password" accessory for users 
who are members of many (~300+) AD groups.

Bluetooth

Fixed not working bluetooth for some Intel Wi-Fi cards.

Remote Management

Fixed: UMS jobs have not been executed when delivered at the next system boot.
Fixed automatic registering in the UMS using DNS entry or DHCP tag.

Caradigm

Updated firmware 7.3.3 of RFIDeas pcProx readers.
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IGEL Universal Desktop OS 3
Supported Hardware:

https://kb.igel.com/igelos/en/devices-supported-by-udc3-and-ud-pocket-3117174.html

Component Versions 10.06.120 (see page 940)
General Information 10.06.120 (see page 944)
Security Fixes 10.06.120 (see page 945)
Known Issues 10.06.120 (see page 950)
New Features 10.06.120 (see page 952)
Resolved Issues 10.06.120 (see page 953)
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Component Versions 10.06.120
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Workspace App 19.3.0.5

Citrix Workspace App 19.6.0.60

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.5

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.8.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.5.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.3.20735

Remote Viewer (RedHat Virtualization) 8.0-1igel49

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Systancia AppliDis 4.0.0.17
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VMware Horizon Client 5.0.0-12557422

VNC Viewer 1.9.0+dfsg-3igel8

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech Driver 12.7.11

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24



Notes for Release 10.06.120

IGEL OS Release Notes   942 / 1492

•

Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190301-igel870

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 390.116-0ubuntu0.18.10.1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.65 #mainline-udos-r2782
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Xorg X11 Server 1.20.5-1igel891

Xorg Xephyr 1.20.5-1igel891

CUPS printing daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel656

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / SANE 1.0.27-1

VirtualBox 6.0.8-dfsg-4igel25

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 10.06.120
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4;
Citrix Access Gateway Standard Plug-in;
Dell vWorkspace Connector for Linux;
Ericom PowerTerm Emulation 9 and 11;
Ericom Webconnect;
IGEL Legacy RDP Client (rdesktop);
Virtual Bridges VERDE Client;
PPTP VPN Support;
IGEL Upgrade License Tool with IGEL Smartcard Token;
Remote Management by setup.ini  file transfer (TFTP);
Remote Access via RSH;
Legacy Philips Speech Driver;
T-Systems TCOS Smartcard Support;
DUS Series touch screens;
Elo serial touchscreens;
VIA Graphics support;
Java WebStart;
Storage hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon;
by an icon in the In-Session Control Bar (configurable under IGEL Setup > User Interface > 
Desktop);
by a Safely Remove Hardware session (configurable under IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel;
Open VPN Smartcard Support;
Asian Input Methods;
Composite Manager.
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Security Fixes 10.06.120
Firefox

Updated Firefox browser to version 60.8.0 ESR.
Fixed mfsa2019-22 security issues:
More...

CVE-2019-9811, CVE-2019-11711, CVE-2019-11712, CVE-2019-11713,
CVE-2019-11729, CVE-2019-11715, CVE-2019-11717, CVE-2019-11719,
CVE-2019-11730 and CVE-2019-11709.

Fixed mfsa2019-19 security issue CVE-2019-11708.
Fixed mfsa2019-18 security issue CVE-2019-11707.
Fixed mfsa2019-08 security issues:
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506 and CVE-2019-9788.

Fixed mfsa2019-05 security issues CVE-2018-18356 and CVE-2019-5785.
Fixed mfsa2019-02 security issues CVE-2018-18500, CVE-2018-18505 and CVE-2018-18501.

Shared Workplace

Fixed login in Shared Workplace which accepts any user credentials in the 10.06.100 release. 
However, no user settings were applied to the device.

Base system

Updated kernel to version 4.19.65.
Fixed security issue CVE-2019-1125 aka Spectre SWAPGS gadget vulnerability.
Fixed a vulnerability in Java configuration script.
Fixed possibly malicious owner change with TC setup configuration.
Fixed policykit-1 security issues CVE-2018-19788 and CVE-2019-6133.
Fixed NSS security issues CVE-2018-18508, CVE-2018-12404, CVE-2018-12384 and CVE-2018-0495.
Fixed PPP security issue CVE-2018-11574.
Fixed imagemagick security issues.
More...

CVE-2018-16750, CVE-2018-16749, CVE-2018-16645, CVE-2018-16644,
CVE-2018-16643, CVE-2018-16642, CVE-2018-16640, CVE-2018-16323,
CVE-2018-14437, CVE-2018-14436, CVE-2018-14435, CVE-2018-14434,
CVE-2017-13144, CVE-2017-12430, CVE-2019-9956, CVE-2019-7398,
CVE-2019-7397, CVE-2019-7396, CVE-2019-7175, CVE-2019-11598,
CVE-2019-11597, CVE-2019-11472, CVE-2019-11470, CVE-2019-10650,
CVE-2019-10131, CVE-2018-20467, CVE-2018-18025, CVE-2018-18024,
CVE-2018-18016, CVE-2018-17966, CVE-2018-17965, CVE-2018-16413,
CVE-2018-16412, CVE-2017-12806, and CVE-2017-12805.

Fixed systemd security issues.
More...
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CVE-2018-16866, CVE-2018-16865, CVE-2018-16864, CVE-2018-15688,
CVE-2019-6454, CVE-2018-1049, CVE-2018-15686 and CVE-2019-3842.

Fixed CUPS security issue CVE-2018-4700.
Fixed libarchive security issues.
More...

CVE-2019-1000020, CVE-2019-1000019, CVE-2018-1000878,
CVE-2018-1000877, and CVE-2017-14502.

Fixed avahi security issues CVE-2018-1000845 and CVE-2017-6519.
Fixed bind9 security issues CVE-2019-6465, CVE-2018-5745, and CVE-2018-5743.
Fixed libcaca security issues.
More...

CVE-2018-20549, CVE-2018-20548, CVE-2018-20547,
CVE-2018-20546, CVE-2018-20545, and CVE-2018-20544.

Fixed libgd2 security issues CVE-2019-6978 and CVE-2019-6977.
Fixed ghostscript security issues.
More...

CVE-2019-6116, CVE-2018-19477, CVE-2018-19476, CVE-2018-19475,
CVE-2018-19409, CVE-2018-18284, CVE-2018-18073, CVE-2018-17961,
CVE-2019-3838, and CVE-2019-3835.

Fixed krb5 security issues.
More...

CVE-2018-5730, CVE-2018-5729, CVE-2017-11462,
CVE-2017-11368, CVE-2016-3120, and CVE-2016-3119.

Fixed texlive-bin security issue CVE-2018-17407.
Fixed LDB security issue CVE-2019-3824.
Fixed libmspack security issues CVE-2018-18585 and CVE-2018-18584.
Fixed Perl security issues CVE-2018-18314, CVE-2018-18313, CVE-2018-18312 and CVE-2018-18311.
Fixed poppler security issues.
More...

CVE-2019-7310, CVE-2018-20650, CVE-2018-20551, CVE-2018-20481,
CVE-2018-19149, CVE-2018-19060, CVE-2018-19059, CVE-2018-19058,
CVE-2018-16646, and CVE-2019-9200.

Fixed Python 3.5 security issues CVE-2018-14647, CVE-2018-1061, CVE-2018-1060 and 
CVE-2018-106.
Fixed Net-SNMP security issue CVE-2018-18065.
Fixed OpenSSL security issues CVE-2019-1559, CVE-2018-5407 and CVE-2018-0734.
Fixed TIFF security issues.
More...

CVE-2018-8905, CVE-2018-7456, CVE-2018-18661, CVE-2018-18557,
CVE-2018-17101, CVE-2018-17100, CVE-2018-1710, CVE-2018-10963,
CVE-2019-7663, CVE-2019-6128, CVE-2018-19210, CVE-2018-17000,
CVE-2018-12900, and CVE-2018-10779.
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Fixed libvncserver security issues.
More...

CVE-2018-6307, CVE-2018-20750, CVE-2018-20749, CVE-2018-20748,
CVE-2018-20024, CVE-2018-20023, CVE-2018-20022, CVE-2018-20021,
CVE-2018-20020, CVE-2018-20019, CVE-2018-15127, and CVE-2018-15126.

Fixed WavPack security issue CVE-2018-19840.
Fixed Samba security issues.
More...

CVE-2018-16851, CVE-2018-16841, CVE-2018-14629,
CVE-2019-3880, and CVE-2018-16860.

Fixed libxkbcommon security issues.
More...

CVE-2018-15864, CVE-2018-15863, CVE-2018-15862, CVE-2018-15861,
CVE-2018-15859, CVE-2018-15858, CVE-2018-15857, CVE-2018-15856,
CVE-2018-15855, CVE-2018-15854, and CVE-2018-15853.

Fixed OpenSSH security issues.
More...

CVE-2019-6111, CVE-2019-6109, CVE-2018-20685,
CVE-2018-15473, and CVE-2016-10708.

Fixed Python 2.7 security issues.
More...

CVE-2018-14647, CVE-2018-1061, CVE-2018-1060,
CVE-2018-106, CVE-2018-1000802, and CVE-2018-1000030.

Fixed lxml security issue CVE-2018-19787.
Fixed gdk-pixbuf security issues.
More...

CVE-2017-6314, CVE-2017-6313, CVE-2017-6312,
CVE-2017-6311, CVE-2017-2870, CVE-2017-2862,
CVE-2017-1000422, CVE-2016-6352, and CVE-2017-12447.

Fixed file security issues CVE-2019-8907 and CVE-2019-8905.
Fixed wget security issue CVE-2019-5953.
Fixed nvidia-graphic-drivers-390 security issue CVE‑2018‑6260.
Fixed libxslt security issue CVE-2019-11068.
Fixed Evince security issue CVE-2019-11459.
Fixed webkit2gtk security issues.
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251,
CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378,
CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345,
CVE-2018-4386, and CVE-2018-4372.

Fixed gst-plugins-base0.10 security issue CVE-2019-9928.
Fixed WPA security issues.
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More...

CVE-2019-9495, CVE-2019-9497, CVE-2019-9498,
CVE-2019-9499, and CVE-2019-11555.

Fixed Heimdal security issues CVE-2019-12098 and CVE-2018-16860.
Fixed libimobiledevice security issue CVE-2016-5104.
Fixed libpng1.6 security issues CVE-2019-7317 and CVE-2018-13785.
Fixed GIMP security issues.
More...

CVE-2017-17786, CVE-2017-17789, CVE-2017-17784,
CVE-2017-17787, CVE-2017-17785, and CVE-2017-17788

Fixed libtomcrypt security issue CVE-2018-12437.
Fixed curl security issues.
More...

CVE-2018-16840, CVE-2018-16839, CVE-2019-3823,
CVE-2019-3822, CVE-2018-16890, CVE-2019-5346.

Fixed gnutls28 security issues CVE-2018-10846, CVE-2018-10845, CVE-2018-10844 and 
CVE-2018-1084.
Fixed qtbase-opensource-src security issues CVE-2018-19873, CVE-2018-19870 and 
CVE-2018-15518.
Fixed db5.3 security issue CVE-2019-8457.
Fixed libssh2 security issues.
More...

CVE-2019-3863, CVE-2019-3862, CVE-2019-3861,
CVE-2019-3860, CVE-2019-3859, CVE-2019-3858, 
CVE-2019-3857, CVE-2019-3856, and CVE-2019-3855.

Fixed network-manager security issue CVE-2018-15688.
Fixed elfutils security issues.
More...

CVE-2019-7665, CVE-2019-7150, CVE-2019-7149,
CVE-2018-18521, CVE-2018-18520, CVE-2018-18310,
CVE-2018-16403, CVE-2018-16402, and CVE-2018-16062.

Fixed libsndfile security issues.
More...

CVE-2019-3832, CVE-2018-19758, CVE-2018-19662, CVE-2018-19661, CVE-2018-19432, 
CVE-2018-13139, CVE-2017-6892, CVE-2017-17457, CVE-2017-17456, CVE-2017-16942,
CVE-2017-14634, CVE-2017-14246, and CVE-2017-14245.

Fixed dbus security issue CVE-2019-12749.
Fixed Vim security issues CVE-2019-12735 and CVE-2017-5953.
Fixed sqlite3 security issues.
More...
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CVE-2019-9937, CVE-2019-9936, CVE-2019-8457, CVE-2018-20506,
CVE-2018-20346, CVE-2017-2520, CVE-2017-2519, CVE-2017-2518,
CVE-2017-13685, CVE-2017-10989, and CVE-2016-6153.

Fixed libseccomp security issue CVE-2019-9893.
Fixed bzip2 security issues CVE-2019-12900 and CVE-2016-3189.
Fixed Expat security issue CVE-2018-20843.
Fixed unzip security issues CVE-2019-13232, CVE-2018-1000035, CVE-2016-9844 and 
CVE-2014-9913.
Mount partitions with "nodev" flag option.
The home directory of the remote users is now /home/ruser.
Default umask is set to 0077 for all non-root users.
Fixed a vulnerability in the custom environment variable framework.
Fixed kernel TCP vulnerabilities CVE-2019-11477: SACK Panic, CVE-2019-11478: SACK Slowness
and CVE-2019-11479: Excess Resource Consumption Due to Low MSS Values.
Changed minimally allowed MSS size to "1000" to prevent possible denial-of-service attacks.
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Known Issues 10.06.120
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and 
H264 acceleration

Registry ica.workaround-dual-rtme

Value enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

Sound redirection in PCoIP is broken when the so-called lightweight-client is used, which has 
become the new default.
But Sound redirection can still be used by choosing the rollback-client instead. This can be done 
by setting the IGEL Registry key:
More...

Parameter Allow rollback to former client variant

Registry vmware.view.allow-client-rollback

Value enabled / disabled

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
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Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

Wi-Fi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Base system

Due to the removal of the Oracle JRE, Java WebStart is not supported anymore.
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New Features 10.06.120
Citrix

Integrated Citrix Workspace app 19.06. 
Available Citrix Workspace apps in this release: 19.06, 19.03, and 13.10.
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Resolved Issues 10.06.120
VMware Horizon

Fixed: Client connection to the remote desktop using PCoIP protocol failed occasionally.

OS 11 Upgrade

Fixed UD Pocket upgrade process with Wi-Fi connection.
Fixed major upgrade problem with Intel network drivers.
Make OS 11 Upgrade VPN detection more lenient to allow blocked upgrade on some devices with 
integrated mobile broadband modem.

Base system

Fixed ActiveDirectory/Kerberos password change with "Change Password" accessory for users 
who are members of many (~300+) AD groups.

Bluetooth

Fixed not working bluetooth for some Intel Wi-Fi cards.

Remote Management

Fixed: UMS jobs have not been executed when delivered at next system boot.
Fixed automatic registering in the UMS using DNS entry or DHCP tag.

Caradigm

Updated firmware 7.3.3 of RFIDeas pcProx readers.
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Notes for Release 10.06.110
Software: Version 10.06.110

Release Date: 2019-07-24

Release Notes: Version RN-106110-1

Last update: 2019-07-24

IGEL Linux Universal Desktop (see page 955)
IGEL Universal Desktop OS 3 (see page 966)
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IGEL Linux Universal Desktop

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Component Versions 10.06.110 (see page 956)
General Information 10.06.110 (see page 960)
Known Issues 10.06.110 (see page 961)
Security Fixes 10.06.110 (see page 963)
New Features 10.06.110 (see page 964)
Resolved Issues 10.06.110 (see page 965)
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Component Versions 10.06.110
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.3.0.5

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.5

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.8.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.5.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.3.20735

Remote Viewer (RedHat Virtualization) 8.0-1igel49

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Systancia AppliDis 4.0.0.17
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VMware Horizon Client 5.0.0-12557422

VNC Viewer 1.9.0+dfsg-3igel8

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech Driver 12.7.11

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190301-igel870

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver VIA 5.76.52.92-opensource-009-005f78-20150730igel871

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.57 #mainline-ud-r2762

Xorg X11 Server 1.20.5-1igel891

Xorg Xephyr 1.20.5-1igel891

CUPS printing daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 18.2.1.128
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Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel656

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / SANE 1.0.27-1

VirtualBox 6.0.8-dfsg-4igel25

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 10.06.110
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4;
Citrix Access Gateway Standard Plug-in;
Dell vWorkspace Connector for Linux;
Ericom PowerTerm Emulation 9 and 11;
Ericom Webconnect;
IGEL Legacy RDP Client (rdesktop);
Virtual Bridges VERDE Client;
PPTP VPN Support;
IGEL Upgrade License Tool with IGEL Smartcard Token;
Remote Management by setup.ini file transfer (TFTP);
Remote Access via RSH;
Legacy Philips Speech Driver;
T-Systems TCOS Smartcard Support;
DUS Series touch screens;
Elo serial touchscreens;
Video hardware acceleration support is discontinued on UD10-LX Touch 10 and UD10-LX 10;
H.264 hardware acceleration support is discontinued on UD10-LX Touch 10 and UD10-LX 10;
Java WebStart;
Storage hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon;
by an icon in the In-Session Control Bar (configurable under IGEL Setup > User Interface > 
Desktop);
by a Safely Remove Hardware session (configurable under IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel;
Open VPN Smartcard Support;
Asian Input Methods;
Composite Manager.



Notes for Release 10.06.110

IGEL OS Release Notes   961 / 1492

•

•

•

•

•

•

•

•

•

•

Known Issues 10.06.110
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and 
H264 acceleration

Registry ica.workaround-dual-rtme

Range enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
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Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

WiFi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Base system

Due to the removal of the Oracle JRE, Java WebStart is not supported anymore.

Hardware

Suspend on UD10 is disabled.
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Security Fixes 10.06.110
Firefox

Updated Firefox browser to version 60.8.0 ESR.
Fixed mfsa2019-22 security issues:
More...

CVE-2019-9811, CVE-2019-11711, CVE-2019-11712, CVE-2019-11713,
CVE-2019-11729, CVE-2019-11715, CVE-2019-11717, CVE-2019-11719,
CVE-2019-11730 and CVE-2019-11709.

Fixed mfsa2019-19 security issue CVE-2019-11708.
Fixed mfsa2019-18 security issue CVE-2019-11707.
Fixed mfsa2019-08 security issues:
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506 and CVE-2019-9788.

Fixed mfsa2019-05 security issues CVE-2018-18356 and CVE-2019-5785.
Fixed mfsa2019-02 security issues CVE-2018-18500, CVE-2018-18505 and CVE-2018-18501.

Shared Workplace

Fixed login in Shared Workplace which accepts any user credentials in the 10.06.100 release. 
However, no user settings were applied to the device.
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New Features 10.06.110
Base system

Replaced timesyncd with chrony NTP. 
A new registry key:
More...

Parameter Use NTP Servers from DNS SRV record

Registry system.time.ntp_use_dnssrv_timeservers

Value enabled / disabled

Evidian

Integrated Evidian AuthMgr version 1.5.7116.

Hardware

Hardware support for HP EliteBook 840 G3.
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Resolved Issues 10.06.110
Base system

Fixed NTP synchronization problems with changing the NTP client from timesyncd to chrony.
Fixed USB printer aliases.

X11 system

Fixed screen corruption with DPMS and enabled composite manager.
Added consideration of hardware limits for choosing automatic resolution in Xorg config
(currently only for IGEL hardware).

Hardware

Fixed black screen issue with some monitors and 2560x1440 resolution (occurred on UD2 LX50).

Caradigm

Updated RF IDeas reader tool for the usage with Caradigm.



Notes for Release 10.06.110

IGEL OS Release Notes   966 / 1492

•
•
•
•
•
•

IGEL Universal Desktop OS 3
Supported Hardware:

https://kb.igel.com/igelos/en/devices-supported-by-udc3-and-ud-pocket-3117174.html

Component Versions 10.06.110 (see page 967)
General Information 10.06.110 (see page 971)
Known Issues 10.06.110 (see page 972)
Security Fixes 10.06.110 (see page 974)
New Features 10.06.110 (see page 975)
Resolved Issues 10.06.110 (see page 976)
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Component Versions 10.06.110
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.3.0.5

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.7116

Evince PDF Viewer 3.18.2-1ubuntu4.5

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.8.0

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.5.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.3.20735

Remote Viewer (RedHat Virtualization) 8.0-1igel49

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Systancia AppliDis 4.0.0.17
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VMware Horizon Client 5.0.0-12557422

VNC Viewer 1.9.0+dfsg-3igel8

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech Driver 12.7.11

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190301-igel870

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 390.116-0ubuntu0.18.10.1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.57 #mainline-udos-r2762
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Xorg X11 Server 1.20.5-1igel891

Xorg Xephyr 1.20.5-1igel891

CUPS printing daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel656

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / SANE 1.0.27-1

VirtualBox 6.0.8-dfsg-4igel25

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 10.06.110
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4;
Citrix Access Gateway Standard Plug-in;
Dell vWorkspace Connector for Linux;
Ericom PowerTerm Emulation 9 and 11;
Ericom Webconnect;
IGEL Legacy RDP Client (rdesktop);
Virtual Bridges VERDE Client;
PPTP VPN Support;
IGEL Upgrade License Tool with IGEL Smartcard Token;
Remote Management by setup.ini file transfer (TFTP);
Remote Access via RSH;
Legacy Philips Speech Driver;
T-Systems TCOS Smartcard Support;
DUS Series touch screens;
Elo serial touchscreens;
VIA Graphics support;
Java WebStart;
Storage hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon;
by an icon in the In-Session Control Bar (configurable under IGEL Setup > User Interface > 
Desktop);
by a Safely Remove Hardware session (configurable under IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel;
Open VPN Smartcard Support;
Asian Input Methods;
Composite Manager.



Notes for Release 10.06.110

IGEL OS Release Notes   972 / 1492

•

•

•

•

•

•

•

•

•

•

Known Issues 10.06.110
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and 
H264 acceleration

Registry ica.workaround-dual-rtme

Range enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
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Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

WiFi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Base system

Due to the removal of the Oracle JRE, Java WebStart is not supported anymore.
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Security Fixes 10.06.110
Firefox

Updated Firefox browser to version 60.8.0 ESR.
Fixed mfsa2019-22 security issues:
More...

CVE-2019-9811, CVE-2019-11711, CVE-2019-11712, CVE-2019-11713,
CVE-2019-11729, CVE-2019-11715, CVE-2019-11717, CVE-2019-11719,
CVE-2019-11730 and CVE-2019-11709.

Fixed mfsa2019-19 security issue CVE-2019-11708.
Fixed mfsa2019-18 security issue CVE-2019-11707.
Fixed mfsa2019-08 security issues:
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506 and CVE-2019-9788.

Fixed mfsa2019-05 security issues CVE-2018-18356 and CVE-2019-5785.
Fixed mfsa2019-02 security issues CVE-2018-18500, CVE-2018-18505 and CVE-2018-18501.

Shared Workplace

Fixed login in Shared Workplace which accepts any user credentials in the 10.06.100 release. 
However, no user settings were applied to the device.
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New Features 10.06.110
Base system

Replaced timesyncd with chrony NTP. 
A new registry key:
More...

Parameter Use NTP Servers from DNS SRV record

Registry system.time.ntp_use_dnssrv_timeservers

Value enabled / disabled

Evidian

Integrated Evidian AuthMgr version 1.5.7116.

Hardware

Hardware support for HP EliteBook 840 G3.



Notes for Release 10.06.110

IGEL OS Release Notes   976 / 1492

•
•

•

•

•

Resolved Issues 10.06.110
Base system

Fixed NTP synchronization problems with changing the NTP client from timesyncd to chrony.
Fixed USB printer aliases.

X11 system

Fixed screen corruption with DPMS and enabled composite manager.

Hardware

Fixed black screen issue with some monitors and 2560x1440 resolution on Intel GPUs.

Caradigm

Updated RF IDeas reader tool for the usage with Caradigm.
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Notes for Release 10.06.100
Software: Version 10.06.100

Release Date: 2019-07-16

Release Notes: Version RN-106100-1

Last update: 2019-07-16

IGEL Linux Universal Desktop (see page 978)
IGEL Universal Desktop OS 3 (see page 1025)
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IGEL Linux Universal Desktop

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Component Versions 10.06.100 (see page 979)
General Information 10.06.100 (see page 983)
Security Fixes 10.06.100 (see page 984)
Known Issues 10.06.100 (see page 989)
New Features 10.06.100 (see page 991)
Resolved Issues 10.06.100 (see page 1017)
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Component Versions 10.06.100
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.3.0.5

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 2.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.5

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.7.2

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.5.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.3.20735

Remote Viewer (RedHat Virtualization) 8.0-1igel49

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Systancia AppliDis 4.0.0.17
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VMware Horizon Client 5.0.0-12557422

VNC Viewer 1.9.0+dfsg-3igel8

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech Driver 12.7.11

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190301-igel870

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver VIA 5.76.52.92-
opensource-009-005f78-20150730igel871

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.57 #mainline-ud-r2762

Xorg X11 Server 1.20.5-1igel891

Xorg Xephyr 1.20.5-1igel891

CUPS printing daemon 2.1.3-4ubuntu0.9igel27



Notes for Release 10.06.100

IGEL OS Release Notes   982 / 1492

•

•

PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel656

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / SANE 1.0.27-1

VirtualBox 6.0.8-dfsg-4igel25

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 10.06.100
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4;
Citrix Access Gateway Standard Plug-in;
Dell vWorkspace Connector for Linux;
Ericom PowerTerm Emulation 9 and 11;
Ericom Webconnect;
IGEL Legacy RDP Client (rdesktop);
Virtual Bridges VERDE Client;
PPTP VPN Support;
IGEL Upgrade License Tool with IGEL Smartcard Token;
Remote Management by setup.ini file transfer (TFTP);
Remote Access via RSH;
Legacy Philips Speech Driver;
T-Systems TCOS Smartcard Support;
DUS Series touch screens;
Elo serial touchscreens;
Video hardware acceleration support is discontinued on UD10-LX Touch 10 and UD10-LX 10;
H.264 hardware acceleration support is discontinued on UD10-LX Touch 10 and UD10-LX 10;
Java WebStart;
Storage hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon;
by an icon in the In-Session Control Bar (configurable under IGEL Setup > User Interface > 
Desktop);
by a Safely Remove Hardware session (configurable under IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel;
Open VPN Smartcard Support;
Asian Input Methods;
Composite Manager.
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Security Fixes 10.06.100
Firefox

Updated Mozilla Firefox to version 60.7.2 ESR.
Fixed mfsa2019-19 security issue CVE-2019-11708.
Fixed mfsa2019-18 security issue CVE-2019-11707.
Fixed mfsa2019-10 security issues CVE-2019-9810 and CVE-2019-9813.
Fixed mfsa2019-08 security issues.
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, CVE-2019-9788.

Fixed mfsa2019-05 security issues CVE-2018-18356 and CVE-2019-5785.
Fixed mfsa2019-02 security issues CVE-2018-18500, CVE-2018-18505 and CVE-2018-18501.
Fixed mfsa2018-30 security issues.
More...

CVE-2018-17466, CVE-2018-18492, CVE-2018-18493,
CVE-2018-18494, CVE-2018-18498, CVE-2018-12405.

Allow Firefox to access YubiKey (FIDO/U2F) when AppArmor is active.

Base system

Fixed a vulnerability in Java configuration script.
Fixed possibly malicious owner change with TC setup configuration.
Fixed policykit-1 security issues CVE-2018-19788 and CVE-2019-6133.
Fixed NSS security issues CVE-2018-18508, CVE-2018-12404, CVE-2018-12384 and CVE-2018-0495.
Fixed PPP security issue CVE-2018-11574.
Fixed imagemagick security issues.
More...

CVE-2018-16750, CVE-2018-16749, CVE-2018-16645, CVE-2018-16644,
CVE-2018-16643, CVE-2018-16642, CVE-2018-16640, CVE-2018-16323,
CVE-2018-14437, CVE-2018-14436, CVE-2018-14435, CVE-2018-14434,
CVE-2017-13144, CVE-2017-12430, CVE-2019-9956, CVE-2019-7398,
CVE-2019-7397, CVE-2019-7396, CVE-2019-7175, CVE-2019-11598,
CVE-2019-11597, CVE-2019-11472, CVE-2019-11470, CVE-2019-10650,
CVE-2019-10131, CVE-2018-20467, CVE-2018-18025, CVE-2018-18024,
CVE-2018-18016, CVE-2018-17966, CVE-2018-17965, CVE-2018-16413,
CVE-2018-16412, CVE-2017-12806, and CVE-2017-12805.

Fixed systemd security issues.
More...

CVE-2018-16866, CVE-2018-16865, CVE-2018-16864, CVE-2018-15688,
CVE-2019-6454, CVE-2018-1049, CVE-2018-15686 and CVE-2019-3842.

Fixed CUPS security issue CVE-2018-4700.
Fixed libarchive security issues.
More...
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CVE-2019-1000020, CVE-2019-1000019, CVE-2018-1000878,
CVE-2018-1000877, and CVE-2017-14502.

Fixed Avahi security issues CVE-2018-1000845 and CVE-2017-6519.
Fixed bind9 security issues CVE-2019-6465, CVE-2018-5745, and CVE-2018-5743.
Fixed libcaca security issues.
More...

CVE-2018-20549, CVE-2018-20548, CVE-2018-20547,
CVE-2018-20546, CVE-2018-20545, and CVE-2018-20544.

Fixed libgd2 security issues CVE-2019-6978 and CVE-2019-6977.
Fixed ghostscript security issues.
More...

CVE-2019-6116, CVE-2018-19477, CVE-2018-19476, CVE-2018-19475,
CVE-2018-19409, CVE-2018-18284, CVE-2018-18073, CVE-2018-17961,
CVE-2019-3838, and CVE-2019-3835.

Fixed krb5 security issues.
More...

CVE-2018-5730, CVE-2018-5729, CVE-2017-11462,
CVE-2017-11368, CVE-2016-3120, and CVE-2016-3119.

Fixed texlive-bin security issue CVE-2018-17407.
Fixed LDB security issue CVE-2019-3824.
Fixed libmspack security issues CVE-2018-18585 and CVE-2018-18584.
Fixed Perl security issues CVE-2018-18314, CVE-2018-18313, CVE-2018-18312 and CVE-2018-18311.
Fixed poppler security issues.
More...

CVE-2019-7310, CVE-2018-20650, CVE-2018-20551, CVE-2018-20481,
CVE-2018-19149, CVE-2018-19060, CVE-2018-19059, CVE-2018-19058,
CVE-2018-16646, and CVE-2019-9200.

Fixed Python 3.5 security issues CVE-2018-14647, CVE-2018-1061, CVE-2018-1060 and 
CVE-2018-106.
Fixed Net-SNMP security issue CVE-2018-18065.
Fixed OpenSSL security issues CVE-2019-1559, CVE-2018-5407 and CVE-2018-0734.
Fixed TIFF security issues.
More...

CVE-2018-8905, CVE-2018-7456, CVE-2018-18661, CVE-2018-18557,
CVE-2018-17101, CVE-2018-17100, CVE-2018-1710, CVE-2018-10963,
CVE-2019-7663, CVE-2019-6128, CVE-2018-19210, CVE-2018-17000,
CVE-2018-12900, and CVE-2018-10779.

Fixed libvncserver security issues.
More...

CVE-2018-6307, CVE-2018-20750, CVE-2018-20749, CVE-2018-20748,
CVE-2018-20024, CVE-2018-20023, CVE-2018-20022, CVE-2018-20021,
CVE-2018-20020, CVE-2018-20019, CVE-2018-15127, and CVE-2018-15126.
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Fixed WavPack security issue CVE-2018-19840.
Fixed Samba security issues.
More...

CVE-2018-16851, CVE-2018-16841, CVE-2018-14629,
CVE-2019-3880, and CVE-2018-16860.

Fixed libxkbcommon security issues.
More...

CVE-2018-15864, CVE-2018-15863, CVE-2018-15862, CVE-2018-15861,
CVE-2018-15859, CVE-2018-15858, CVE-2018-15857, CVE-2018-15856,
CVE-2018-15855, CVE-2018-15854, and CVE-2018-15853.

Fixed OpenSSH security issues.
More...

CVE-2019-6111, CVE-2019-6109, CVE-2018-20685,
CVE-2018-15473, and CVE-2016-10708.

Fixed Python 2.7 security issues.
More...

CVE-2018-14647, CVE-2018-1061, CVE-2018-1060,
CVE-2018-106, CVE-2018-1000802, and CVE-2018-1000030.

Fixed lxml security issue CVE-2018-19787.
Fixed gdk-pixbuf security issues.
More...

CVE-2017-6314, CVE-2017-6313, CVE-2017-6312,
CVE-2017-6311, CVE-2017-2870, CVE-2017-2862,
CVE-2017-1000422, CVE-2016-6352, and CVE-2017-12447.

Fixed file security issues CVE-2019-8907 and CVE-2019-8905.
Fixed wget security issue CVE-2019-5953.
Fixed libxslt security issue CVE-2019-11068.
Fixed Evince security issue CVE-2019-11459.
Fixed webkit2gtk security issues.
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251,
CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378,
CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345,
CVE-2018-4386, and CVE-2018-4372.

Fixed gst-plugins-base0.10 security issue CVE-2019-9928.
Fixed WPA security issues.
More...

CVE-2019-9495, CVE-2019-9497, CVE-2019-9498,
CVE-2019-9499, and CVE-2019-11555.

Fixed Heimdal security issues CVE-2019-12098 and CVE-2018-16860.
Fixed libimobiledevice security issue CVE-2016-5104.
Fixed libpng1.6 security issues CVE-2019-7317 and CVE-2018-13785.
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Fixed GIMP security issues.
More...

CVE-2017-17786, CVE-2017-17789, CVE-2017-17784,
CVE-2017-17787, CVE-2017-17785, and CVE-2017-17788

Fixed libtomcrypt security issue CVE-2018-12437.
Fixed curl security issues.
More...

CVE-2018-16840, CVE-2018-16839, CVE-2019-3823,
CVE-2019-3822, CVE-2018-16890, CVE-2019-5346.

Fixed gnutls28 security issues CVE-2018-10846, CVE-2018-10845, CVE-2018-10844 and 
CVE-2018-1084.
Fixed qtbase-opensource-src security issues CVE-2018-19873, CVE-2018-19870 and 
CVE-2018-15518.
Fixed db5.3 security issue CVE-2019-8457.
Fixed libssh2 security issues.
More...

CVE-2019-3863, CVE-2019-3862, CVE-2019-3861,
CVE-2019-3860, CVE-2019-3859, CVE-2019-3858, 
CVE-2019-3857, CVE-2019-3856, and CVE-2019-3855.

Fixed network-manager security issue CVE-2018-15688.
Fixed elfutils security issues.
More...

CVE-2019-7665, CVE-2019-7150, CVE-2019-7149,
CVE-2018-18521, CVE-2018-18520, CVE-2018-18310,
CVE-2018-16403, CVE-2018-16402, and CVE-2018-16062.

Fixed libsndfile security issues.
More...

CVE-2019-3832, CVE-2018-19758, CVE-2018-19662, CVE-2018-19661, CVE-2018-19432, 
CVE-2018-13139, CVE-2017-6892, CVE-2017-17457, CVE-2017-17456, CVE-2017-16942,
CVE-2017-14634, CVE-2017-14246, and CVE-2017-14245.

Fixed dbus security issue CVE-2019-12749.
Fixed Vim security issues CVE-2019-12735 and CVE-2017-5953.
Fixed sqlite3 security issues.
More...

CVE-2019-9937, CVE-2019-9936, CVE-2019-8457, CVE-2018-20506,
CVE-2018-20346, CVE-2017-2520, CVE-2017-2519, CVE-2017-2518,
CVE-2017-13685, CVE-2017-10989, and CVE-2016-6153.

Fixed libseccomp security issue CVE-2019-9893.
Fixed bzip2 security issues CVE-2019-12900 and CVE-2016-3189.
Fixed Expat security issue CVE-2018-20843.
Fixed unzip security issues CVE-2019-13232, CVE-2018-1000035, CVE-2016-9844 and 
CVE-2014-9913.
Mount partitions with "nodev" flag option.
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The home directory of the remote users is now /home/ruser.
Default umask is set to 0077 for all non-root users.
Fixed a vulnerability in the custom environment variable framework.
Fixed kernel TCP vulnerabilities CVE-2019-11477: SACK Panic, CVE-2019-11478: SACK Slowness
and CVE-2019-11479: Excess Resource Consumption Due to Low MSS Values.
Changed minimally allowed MSS size to "1000" to prevent possible denial-of-service attacks.
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Known Issues 10.06.100
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and 
H264 acceleration

Registry ica.workaround-dual-rtme

Range enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
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Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

WiFi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Base system

Due to the removal of the Oracle JRE, Java WebStart is not supported anymore.

Hardware

Suspend on UD10 is disabled.
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New Features 10.06.100
OS 11 Upgrade

It is now possible to upgrade to IGEL OS 11. For more information, see the how-to Upgrading IGEL 
Devices from IGEL OS 10 to IGEL OS 11.
The parameters for the upgrade:
More...

IGEL Setup > System > Update > OS 11 Upgrade

Parameter Upgrade to OS 11

Registry update.firmware_migrate_to_11

Value enabled / disabled

Parameter Upgrade to OS 11 even if a previous upgrade attempt failed

Registry update.force_firmware_migrate_to_11

Value enabled / disabled

Parameter Upgrade to OS 11 even if PowerTerm is enabled

Registry update.migrate_to_11_with_powerterm

Value enabled / disabled

Parameter Require an Enterprise Management Pack license to upgrade to OS 11

Registry update.migrate_to_11_enterprise_required

Range [Smart] [Always] [Never]

Parameter Timeout waiting for OS 11 license to start automatic upgrade

Registry update.migrate_to_11_license_timeout

Range [Disabled] [10 Minutes] [15 Minutes] [30 Minutes] [60 Minutes]

The parameters for configuring the desktop integration of the IGEL OS 11 Upgrade tool are:
More...

IGEL Setup > Accessories > OS 11 Upgrade 

Registry sessions.os11_migration0.startmenu

Value enabled / disabled
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Registry sessions.os11_migration0.applaunch

Value enabled / disabled

Registry sessions.os11_migration0.startmenu_system

Value enabled / disabled

Registry sessions.os11_migration0.applaunch_system

Value enabled / disabled

Registry sessions.os11_migration0.menu_path

Registry sessions.os11_migration0.desktop_path

Registry sessions.os11_migration0.applaunch_path

Registry sessions.os11_migration0.quick_start

Value enabled / disabled

Registry sessions.os11_migration0.pwprotected

Range [None] [Administrator] [User] [Setup user]

Registry sessions.os11_migration0.desktop

Value enabled / disabled

Registry sessions.os11_migration0.pulldown

Value enabled / disabled

Citrix

Integrated Citrix Workspace app 19.03.
Added a new registry key to support 1536-bit RSA keys for client authentication. Factory default 
for this release is "true".
More...

Parameter Enables RSA 1536 cipher suite

Registry ica.allregions.enable_rsa_1536

Range factory default / false / true

Added a new registry key to enable different cipher suites. Factory default for this release is 
"ALL".
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More...

Parameter Enables different cipher suite

Registry ica.allregions.sslciphers

Range factory default / ALL / GOV / COM

> TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
> TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
> TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA – COM/ALL

Added a new registry key to support keyboard layout synchronization.
More...

Parameter Keyboard layout synchronization

Registry ica.modules.virtualdriver.keyboardsync.enable

Value disabled / enabled

Updated Citrix HDX RTME used for optimization of Skype for Business to version 2.8.0-2235.
Added support for Citrix Workspace Launcher functionality as described at https://
support.citrix.com/article/CTX237727.
Added a Citrix plugin for hardware accelerated VDPAU based H.264 decoding on AMD graphics 
chipsets:
More...

Parameter Enable HW accelerated H264 vdpau codec (experimental)

Registry ica.hw-accelerated-h264-vdpau-codec

Value enabled/ disabled 

RDP/IGEL RDP Client 2

Added a field 'Collection' to RDP session server page.
More...

IGEL Setup > Sessions > RDP > RDP Sessions > RDP Session > Server  

IGEL Setup > Sessions > RDP > RDP Sessions > RDP Session > Options

Parameter Collection

Registry sessions.winconnect<NR>.option.load-balance-

info

VMware Horizon

Updated Horizon Client to version 5.0.0-12557422.
Added parameters to specify webcam frame size and rate for RTAV.

https://support.citrix.com/article/CTX237727
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More...

Parameter Webcam frame width

Registry vmware.view.rtav-frame-width

Value <empty_string>

Parameter Webcam frame height

Registry vmware.view.rtav-frame-height

Value <empty_string>

Parameter Webcam frame rate

Registry vmware.view.rtav-frame-rate

Value <empty_string>

Added a possibility to easily evaluate Horizon Blast decoder states. By default, sessions are 
evaluated after use and the result is written to the journal log.
Added continuous run mode for USB-Arbitrator.
More...

Parameter USB-Arbitrator continuous run mode

Registry vmware.view.usb.arbitrator-continuous-runmode

Value enabled / disabled

Added recognition for password change and password expired dialog in Horizon local logon 
sessions or appliance mode.
Added switch for Blast H.264 decoding for VMware Horizon Client.
More...

Parameter Blast H.264 decoding

Registry vmware.view.blast-h264

Value enabled / disabled

Added switch to use systemwide proxy in VMware Horizon appliance mode.
More...

Parameter Use the systemwide proxy

Registry vmwarevdmapp.use_proxy

Value enabled / disabled

Parallels Client
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Updated Parallels Client to version 16.5.3 (64-Bit).
Added a possibility to set apps to autostart on Parallels RAS.

ThinLinc

Updated Cendio ThinLinc to version 4.10.

RedHat Enterprise Virtualization Client.

Updated Remote Viewer (RedHat Virtualization) to version 8.0.
Updated Spice GTK (RedHat Virtualization) to version 0.36.

IBM_5250

Updated IBM iAccess Client Solutions to version 1.1.8.1.
Improved startup time of IBM iAccess Client.
Improved configuration of IBM iAccess Client via IGEL Setup.
More...

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Connection > Advanced

Parameter Bypass signon

Registry sessions.iaccess<NR>.options.ssoenabled

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Font

Parameter Antialiasing

Registry sessions.iaccess<NR>.options.textantialiasing

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Allow blinking cursor

Registry sessions.iaccess<NR>.options.blinkcursor

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Show blinking text with

Registry sessions.iaccess<NR>.options.blinkstate
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Value  [Blinking Text] [Host Color] [Mapped Color]

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Blink Color

Registry sessions.iaccess<NR>.options.blinkcolor_fg

Value #ffc800

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Blink Color Background

Registry sessions.iaccess<NR>.options.blinkcolor_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Rule Line

Registry sessions.iaccess<NR>.options.ruleline

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Follow Cursor

Registry sessions.iaccess<NR>.options.rulelinefollows

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Style

Registry sessions.iaccess<NR>.options.rulelinestyle

Value [Crosshair] [Vertical] [Horizontal]

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Green



Notes for Release 10.06.100

IGEL OS Release Notes   997 / 1492

Registry sessions.iaccess<NR>.options.color_fgn_fg

Value #00ff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Green Background

Registry sessions.iaccess<NR>.options.color_fgn_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter White

Registry sessions.iaccess<NR>.options.color_fwt_fg

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter White Background

Registry sessions.iaccess<NR>.options.color_fwt_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Red

Registry sessions.iaccess<NR>.options.color_frd_fg

Value #ff0000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Red Background

Registry sessions.iaccess<NR>.options.color_frd_bg

Value #000000
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Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Turquoise

Registry sessions.iaccess<NR>.options.color_ftq_fg

Value #00ffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Turquoise Background

Registry sessions.iaccess<NR>.options.color_ftq_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Yellow

Registry sessions.iaccess<NR>.options.color_fyw_fg

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Yellow Background

Registry sessions.iaccess<NR>.options.color_fyw_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Pink

Registry sessions.iaccess<NR>.options.color_fpk_fg

Value #ff00ff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Pink Background

Registry sessions.iaccess<NR>.options.color_fpk_bg
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Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Blue

Registry sessions.iaccess<NR>.options.color_fbl_fg

Value #7890f0

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Blue Background

Registry sessions.iaccess<NR>.options.color_fbl_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Status Indicators

Registry sessions.iaccess<NR>.options.color_osi

Value #7890f0

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Information Indicators

Registry sessions.iaccess<NR>.options.color_oii

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Attention Indicators

Registry sessions.iaccess<NR>.options.color_oai

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Error Indicators
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Registry sessions.iaccess<NR>.options.color_oei

Value #ff0000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter OIA Background

Registry sessions.iaccess<NR>.options.color_oob

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Screen Background

Registry sessions.iaccess<NR>.options.color_sbg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Highlight active field

Registry sessions.iaccess<NR>.options.actfieldhilite

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Active Field

Registry sessions.iaccess<NR>.options.color_actf_fg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Active Field Background

Registry sessions.iaccess<NR>.options.color_actf_bg

Value #ffff00
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Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Crosshair Ruler Color

Registry sessions.iaccess<NR>.options.color_crc

Value #00ff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Column Separator

Registry sessions.iaccess<NR>.options.color_ccs

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences

Parameter Start window maximized

Registry sessions.iaccess<NR>.options.ismaximized

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Keyboard

Parameter Keyboard Remapping File

Registry sessions.iaccess<NR>.options.keyremapfile

Value IBMi.kmp

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Popup Keypad

Parameter Popup Keypad File

Registry sessions.iaccess<NR>.options.poppadfile

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Toolbar

Parameter Toolbar File

Registry sessions.iaccess<NR>.options.toolbarfile
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Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Open new sessions in a new tab

Registry ibm.iaccess.acssm.opensessionintab

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Always display the tab bar

Registry ibm.iaccess.acssm.alwaysshowtabbar

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Switch to new tab when created

Registry ibm.iaccess.acssm.switchtonewtab

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Send a warning when closing multiple tabs

Registry ibm.iaccess.acssm.closemultipletabwarning

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Do not start tabbed sessions until the tab is selected

Registry ibm.iaccess.acssm.tabdelayedstart

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter New Tab Action

Registry ibm.iaccess.acssm.newtabaction

Value [Disable and Hide] [Run the Same] [Run Other...] 

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Tab Placement
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Registry ibm.iaccess.acssm.tabplacement

Value [Top] [Bottom] [Left] [Right] 

Firefox

Updated Mozilla Firefox to version 60.7.2 ESR.
Added new keys to auto show and hide the on-screen software keyboard. To use this feature, 
the keyboard should be set to autostart. After a restart is is activated, the keyboard will appear 
automatically when an input box is selected. Confirmed to work in Firefox and on lockscreen.
More...

Parameter Automatically hide software keyboard depending on focused widget

Registry userinterface.softkeyboard.autohide

Value enabled / disabled

Parameter Automatically show software keyboard depending on focused widget

Registry userinterface.softkeyboard.autoshow

Value enabled / disabled

Added new parameters: Allow a custom command before and after browser session.
More...

Parameter init_action

Registry sessions.browser%.init_action

Value <empty_string>

Parameter final_action

Registry sessions.browser%.final_action

Value <empty_string>

Added options to customize Firefox overflow menu and hide navigation buttons.
More...

Parameter Hide Navigation buttons

Registry sessions.browser<NR>.app.navigation_buttons_hidd

en

Value enabled / disabled
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Parameter Overflow Menu

Registry sessions.browser<NR>.app.custom_toolbar.overflow

-menu

Value open-file-button,feed-button,characterencoding-button

Imprivata

Imprivata Appliance 6.3 or higher is needed now.
Added a new parameter to Imprivata.conf: "Redirection of Smartcards".
More...

IGEL Setup > Sessions > Appliance Mode > Imprivata  

Parameter Redirection of Smartcards

Registry imprivata.native_smartcard_redirection

Value enabled / disabled

Added a new parameter: "Path to Certificate".
More...

IGEL Setup > Sessions > Appliance Mode > Imprivata  

Parameter Path to Certificate

Registry imprivata.path_to_certificate

Network

Added NCP Secure Enterprise VPN Client version 5.10_rev40552 (configurable under IGEL Setup 
> Network > VPN > NCP VPN Client).
Added a new feature: Network status icons are shown on the lock and logon screens.
Added a mechanism for retrieving the SCEP challenge password with a custom script. Setting 
the following registry key to "true" enables the use of the script. The registry key 
network.scepclient.cert%.crypt_password  will be ignored. (The script may use it for 

its own purpose though.)
More...

Parameter Use Challenge Password Command

Registry network.scepclient.cert%.use_challenge_password_c

ommand

Value enabled / disabled

If the above key is enabled, the value of this key will be passed to bash for execution. It happens 
when the SCEP challenge password is needed for creating a certificate signing request. The script 
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is supposed to output the challenge password on its standard output. For convenience, any 
Carriage-Return characters are stripped off the script before execution by bash.
More...

Parameter Challenge Password Command

Registry network.scepclient.cert%.challenge_password_comm

and

Value <empty_string>

Wi-Fi

Added support for Realtek 8821CE wireless cards.
Added switch to determine the source of WiFi scan results for Wireless Manager. Selecting 
default is currently identical with the old mechanism (using the iwlist command). This may change 
in the future. When iwlist fails, NetworkManager is automatically used as a fallback.
More...

Parameter WiFi Scanner

Registry network.interfaces.wirelesslan.device0.mssid_sca

nner

Range [default][iwlist][NetworkManager]

Smartcard

New IGEL Smartcard mode without Locking Desktop (reintroduced feature of Linux 5.x 
firmware).
More...

IGEL Setup > Security > Logon > IGEL Smartcard

Parameter Enable IGEL Smartcard without Locking Desktop

Registry scard.scardd.enable_nolock

Value enabled / disabled

IGEL Setup > Security > Logon > IGEL Smartcard

Parameter On Smartcard Removal, terminate

Registry scard.scardd.session_termination

Value all / smartcard

Updated MUSCLE CCID smartcard reader driver to version 1.4.30.
Updated ACS CCID smartcard driver to version 1.1.6.
Updated REINER SCT smartcard reader driver to version 3.99.5final.sp13.
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Updated SecMaker NetID to version 6.7.2.36: now YubiKey 5 is supported.
Updated cryptovision sc/interface PKCS#11 smartcard library to version 7.1.20.
Added configuration parameters for some settings of smartcard library OpenSC.
More...

Parameter Debug level

Registry scard.pkcs11.opensc.default.debug

Value 0

Parameter Debug file

Registry scard.pkcs11.opensc.default.debug_file

Value stderr

Parameter Max. send size

Registry scard.pkcs11.opensc.default.pcsc.max_send_size

Value 255

Parameter Max. receive size

Registry scard.pkcs11.opensc.default.pcsc.max_recv_size

Value 256

Parameter Connect exclusive

Registry scard.pkcs11.opensc.default.pcsc.connect_exclusiv

e

Value enabled / disabled

Parameter Disconnect action

Registry scard.pkcs11.opensc.default.pcsc.disconnect_actio

n

Value leave / reset / unpower

Parameter Transaction end action

Registry scard.pkcs11.opensc.default.pcsc.transaction_end_a

ction

Value leave / reset / unpower
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Parameter Reconnect action

Registry scard.pkcs11.opensc.default.pcsc.reconnect_action

Value leave / reset / unpower

Parameter Enable pinpad

Registry scard.pkcs11.opensc.default.pcsc.enable_pinpad

Value enabled / disabled

Parameter Use PIN caching

Registry scard.pkcs11.opensc.default.pkcs15.use_pin_cachin

g

Value enabled / disabled

Parameter How many times to use a PIN from cache before re-authenticating it

Registry scard.pkcs11.opensc.default.pkcs15.pin_cache_coun

ter

Value 10

Parameter PIN caching ignores user consent

Registry scard.pkcs11.opensc.default.pkcs15.pin_cache_ignore_

user_consent

Value enabled / disabled

Updated CHERRY USB-LAN Proxy to version 3.2.0.3. This version provides enhanced 
configuration.
More...

IGEL Setup > Security > Smartcard > Services

Parameter Bind IP

Registry devices.cherry.usblanproxy.bind-ip

Value auto

IGEL Setup > Security > Smartcard > Services

Parameter Https Server Port
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Registry devices.cherry.usblanproxy.https-port

Value 443

IGEL Setup > Security > Smartcard > Services

Parameter SICCT Announce IP

Registry devices.cherry.usblanproxy.sicct-announce-ip

Value broadcast

IGEL Setup > Security > Smartcard > Services

Parameter SICCT Announce Port

Registry devices.cherry.usblanproxy.sicct-announce-port

Value 4742

IGEL Setup > Security > Smartcard > Services

Parameter SICCT Announce Interval

Registry devices.cherry.usblanproxy.sicct-announce-

interval

Value 30

IGEL Setup > Security > Smartcard > Services

Parameter USB Fast Mode

Registry devices.cherry.usblanproxy.usb-fast-mode

Value enabled /disabled

IGEL Setup > Security > Smartcard > Services

Parameter Alternate Initialization Method for G87-1505

Registry devices.cherry.usblanproxy.usb-1505-alt-setup

Value enabled /disabled

CUPS Printing

Added SMB Network Print client function.
More...

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog
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Parameter Printer Port

Registry print.cups.printer<NR>.backend

Value smb

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Server

Registry print.cups.printer<NR>.smb_server

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Workgroup

Registry print.cups.printer<NR>.smb_workgroup

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Printer

Registry print.cups.printer<NR>.smb_printer

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Port

Registry print.cups.printer<NR>.smb_port

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter Use Kerberos Authentication

Registry print.cups.printer<NR>.smb_kerberos

Value enabled / disabled

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter Use Passthrough Authentication

Registry print.cups.printer<NR>.smb_passthrough

Value enabled /disabled

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB User

Registry print.cups.printer<NR>.smb_user



Notes for Release 10.06.100

IGEL OS Release Notes   1010 / 1492

•
•

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Password

Registry print.cups.printer<NR>.crypt_password

Base system

Updated kernel from 4.18.20 to 4.19.57 version.
Enhanced bootloader to allow the set of some kernel commandline parameters with registry keys:
More...

Parameter Disable use of APIC controller

Registry system.kernel.bootparams.noapic

Value enabled /disabled

Parameter Disable use of ACPI

Registry system.kernel.bootparams.noacpi

Value enabled /disabled

Parameter Use only one CPU core and disable all others

Registry system.kernel.bootparams.nosmp

Value enabled /disabled

Parameter Enable debug console on serial port 1

Registry system.kernel.bootparams.serial_console_debug

Value enabled /disabled

Parameter Limit CPU core usage (0 means no limit)

Registry system.kernel.bootparams.maxcpus

Type Integer

Value 0

Parameter Set maximum allowed cstate on intel cpus

Registry system.kernel.bootparams.max_cstate

Range [No limit] [1] [2] [3] [4] [5] [6]

Info: Do not limit Intel cstate.



Notes for Release 10.06.100

IGEL OS Release Notes   1011 / 1492

•
•

•

•

Parameter IOMMU usage setting

Registry system.kernel.bootparams.iommu

Range [On] [Off] [Passthrough] [Force]

Info: Use IOMMU if possible.

Parameter IOMMU usage setting for AMD systems

Registry system.kernel.bootparams.amd_iommu

Range [On] [Off]

Info: Use IOMMU if possible.

Parameter IOMMU usage setting for Intel systems

Registry system.kernel.bootparams.intel_iommu

Range [On] [Off]

Info: Use IOMMU if possible.

Added a possibility to configure scheduled commands. Registry keys: system.cron.**
Buddy update enhancements:

Automatic load balancing:
A client collects up to eight server candidates from which one is selected randomly. 
Collection stops when the number specified in the following registry key is reached. 
Otherwise collection stops after a timeout.
More...

Parameter Buddy Update Server Candidates

Registry update.ftp.buddy_server_candidates

Value 1

Grouping:
Buddy update servers and clients only interact with each other when they are in the same 
group determined by the following registry key (a non-negative integer number). This 
feature is mainly useful when different firmware versions shall be used in parallel.
More...

Parameter Buddy Group ID

Registry update.ftp.buddy_group_id

Value 0
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Updated libwebkit2gtk-4.0-37 to version 1.24.2. 
Security fixes:
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251,
CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378,
CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345,
CVE-2018-4386, CVE-2018-4372

Updated Fluendo multimedia codecs to the following versions:
More...

gst-fluendo-aacdec 21/03/2019 0.10.39

gst-fluendo-asfdemux 21/03/2019 0.10.89

gst-fluendo-h264dec 21/03/2019 0.10.53

gst-fluendo-mp3 21/03/2019 0.10.39

gst-fluendo-mpeg4video 21/03/2019 0.10.43

gst-fluendo-vadec 21/03/2019 0.10.208

gst-fluendo-wmadec 21/03/2019 0.10.68

gst-fluendo-wmvdec 20/03/2019 0.10.65

Added a package ldap-utils which can be used by custom scripts.

Driver

Updated DisplayLink driver to version 5.1.26.
Updated Philips Speech Driver to version 12.7.11 - added support for Philips AirBridge.
Added registry keys to modify the Intel graphic driver usage of framebuffer compression and
power management. 
New registry keys:
More...

Parameter Power saving display C-States to use

Registry x.drivers.intel.dc_setting

Range [Default] [Disable] [Up to DC5] [Up to DC6]

Info: "Default" - driver default 

Parameter Use framebuffer compression

Registry x.drivers.intel.fbc_setting 

Range [Default] [Disable]
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Info: "Default" - driver default 

Updated signotec Citrix Virtual Channel driver to version 8.0.8.
Updated deviceTRUST Client to version 19.1.200. These are the release notes:
Welcome to the release of the deviceTRUST 19.1.200 IGEL client, providing the context of IGEL thin 
client and UD Pocket devices into your virtual sessions. This release includes support for logical 
disks attached to the IGEL endpoint, plus bug fixes and stability improvements over the previous 
19.1.100 release.

Logical Disks
We’ve added support for real-time properties representing the LOGICAL DISKS attached to the 
IGEL endpoint. This includes:
More...

DEVICE_LOGICALDISK_X_TYPE – Either Fixed or Removable.
DEVICE_LOGICALDISK_X_LABEL – The volume label.
DEVICE_LOGICALDISK_X_FILESYSTEM – The type of file system.
DEVICE_LOGICALDISK_X_PATHS – The paths that the disk is mounted.
DEVICE_LOGICALDISK_X_TOTALMB – The total space available on the disk. This property is only available for 
mounted disks.
DEVICE_LOGICALDISK_X_FREEMB – The free space available on the disk. This property is only available for 
mounted disks.
DEVICE_LOGICALDISK_X_NAME – The name of the underlying physical disk.
DEVICE_LOGICALDISK_X_VENDORID – The vendor identifier uniquely identifying the manufacturer. This 
property is only available for USB or PCI connected devices.
DEVICE_LOGICALDISK_X_PRODUCTID – The product identifier uniquely identifying the product. This 
property is only available for USB or PCI connected devices.
DEVICE_LOGICALDISK_X_SERIALNUMBER – The serial number of the physical disk.
DEVICE_LOGICALDISK_X_BUSTYPE – The storage bus type linked to the physical disk.
DEVICE_LOGICALDISK_COUNT – The number of logical disks.

X11 system

Updated Xorg server from 1.19.6 to 1.20.5 version.
Updated Virtualbox from 5.2.18 to 6.0.8 version.
Updated Mesa from 18.2.1 to 19.0.8 version.
Updated Xorg video and input driver to current upstream versions.
Added new options for laptop lid handling dependent on power supply:
More...

Parameter Lid close action while plugged in

Registry system.actions.lid.ac

Range [Turn off display] [Suspend]

Parameter Lid close action while not plugged in

Registry system.actions.lid.battery
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Range [Turn off display] [Suspend]

The new Display Switch tool can use multiple different profiles, automatically chosen at runtime 
depending on the currently connected monitors.
A profile is created, when the current monitor layout/resolution is configured via the Display 
Switch utility. The profile will be associated with the current connected displays automatically 
(manufacturer, model and used connector are used for allocation) and if applicable, the state of 
the laptop lid. The setup will be restored by hot-(un)plugging known displays, means the system 
will automatically switch to the already configured profile.
The Display Switch utility itself got a new interface. All base functionalitycan be configured via 
Drag&Drop.
An example workflow:

Connect the hardware and close/open the lid.
Open the Display Switch Utility:
- A quick (simple) setting can be selected directly.
- Should the desired use case be different from the provided choices, the `Advanced´ 
button opens a drag&drop interface for further settings.
In this interface the displays can be dragged and dropped for the intended configuration. 
The display will snap adjacent to others.
If a display should not be used, it can be dragged to the `Disabled´ area on the top right - 
the screen will be reactivated when it is dragged back to the active area.
To show the same content on multiple displays, one display should be dragged onto 
another active screen. The interface will show "Mirror". The mirroring monitor will be 
displayed on the lower right.
With the 'Apply' button the current state will be set, with `Yes´ on the "Keep configuration" 
dialog the current settings will be saved to persistent storage and associated with the 
profile.
Advanced functionality (panning/scaling/resolutions) can be configured in drop-down 
boxes, hidden in a drawer on the right side. The drawer can be expanded by clicking the '<' 
button on the right edge.
For the Display Switch functionality the following parameters should be enabled for proper 
usage:
More...

IGEL Setup > Accessories > Display Switch > Options

Parameter Preserve settings over reboot

Registry sessions.user_display0.options.preserve_setti

ngs

Value enabled / disabled

IGEL Setup > Accessories > Display Switch > Options

Parameter Smart display configuration
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Registry x.auto_associate

Value enabled / disabled

Added a new parameter to optionally start with opened 'Advanced' drawer in Display Switch.
More...

IGEL Setup > Accessories > Display Switch > Options

Parameter Preserve settings over reboot

Registry sessions.user_display0.options.preserve_setti

ngs

Value enabled / disabled

IGEL Setup > Accessories > Display Switch > Options

Parameter Start with the advanced drawer opened

Registry sessions.user_display0.options.start_open

Value enabled / disabled

Added xprintidle tool to firmware.
Added some registry keys to disable loading of DRM kernel modules (graphic).
More...

Parameter Disable the loading of the RADEON DRM driver

Registry x.drivers.ati.disable

Value 0

Parameter Disable the loading of the AMDGPU DRM driver

Registry x.drivers.amdgpu.disable

Value 0

Parameter Disable the loading of the i915 DRM driver

Registry x.drivers.intel.disable

Value 0

Added the possibility to change an embedded DisplayPort to a normal DisplayPort.
More...

Parameter Use embedded displayport as normal displayport
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Registry x.drivers.intel.edp_is_dp

Range [default][enable][disable]

Info: Reboot required

Java

Replaced Oracle JRE by AZUL's Zulu JRE.
Removed deprecated Java WebStart since it is not supported with non-Oracle JRE's.

X server

Updated Xephyr x session to version 1.20.5.

Hardware

Added hardware support for the following headsets:
More...

Jabra Engage 50;
Jabra Engage 65;
Jabra Engage 75;
Jabra Evolve 30 II (Ver. B);
Jabra Evolve 30 II (Ver. C);
Jabra Evolve 40 (Ver. B) - USB-C;
Jabra Evolve 40 (Ver. D);
Jabra Evolve 65; 
Jabra Evolve 75;
Plantronics Voyager 5200 UC;
Plantronics Voyager 6200 UC;
Plantronics Voyager 8200 UC;
Sennheiser SC70.

Remote Management / IGEL Cloud Gateway

Connection order between UMS and ICG can now be configured.
More...

Parameter Prefer UMS over ICG

Registry system.remotemanager.icg_try_ums_connect

Value enabled / disabled

When an ICG connection is configured and the parameter is enabled, the device tries to connect 
directly to UMS. If the connection was established successfully, the device is managed by UMS and 
not over ICG until new start of the device or networking.

Firmware update scheduled on shutdown is now invoked on reboot as well.
Added some adaptations in UMS Agent concerning migration to IGEL OS11.
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Resolved Issues 10.06.100
Citrix

Now ica.pnlogin.syncpasswordwithxscrnsvr is removed, ica.pnlogin.syncpasswordwithxlock
should be used, this provides the same functionality.
Fixed online meeting in VDI: An enabled webcam will not cut the audio streaming anymore.
Citrix Workspace App 19.03: Improved USB redirection handling.
Custom icons now are visible after StoreFront logon using Citrix authentication method.
Appropriate icons arise with IGEL and Citrix authentication.
Fixed stability issues with Citrix Browser Content Redirection.
Updated the Nuance virtual channel for ICA up to version B301.

RDP/IGEL RDP Client 2

Added Negotiate:Kerberos as fallback if NTLM is disabled. This only works if Active Directory/
Kerberos Logon is enabled.
Added registry key to use rdpglobal window settings for remote apps.
More...

Parameter Enable global windwos settings for remote app

Registry rdp.winconnect.enable-global-

window-settings-for-remote-app

Value enabled / disabled

Fixed empty warning window being shown when closing RDP Web Applications started from 
browser.
Fixed smartcard redirection in RDP: SCardGetAttrib was failing if pbAttr was NULL. The fix should 
help running Dutch Zorg-ID applications.

RD Web Access

Fixed RD Web Access not woking with special characters in name or password. This only works if 
Active Directory/Kerberos Logon is enabled.
Fixed empty warning dialogs appearing when opening RD Web Application in the browser.
Fixed not starting RDP Remote Applications.

VMware Horizon

Fixed Optimization for Skype for Business.
Fixed the configuration choice to use the relative mouse feature.

Parallels Client

Updated Parallels Client to version 16.5.3 (64-Bit).
Fixed: Maximized windows for published applications can be displayed incorrectly.
Fixed: Incorrect user credentials can be picked up during connection if the same farm is 
registered in the client multiple times and with different user credentials.
Fixed: Client did not accept universal printing policies set from the server.
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Fixed: Module opened in the background and blocked the launcher in some cases.
Fixed: Redirected smartcard did not work in a remote session.
Fixed: Printers would not redirect to a remote session when redirection is enforced via policies.

PowerTerm

Fixed editing of parameter sessions.powerterm\<INST>.logindialog.loginscript in Setup 
Registry: now multiple lines are possible.
PowerTerm Terminal Emulation: remove obsolete SSH type SSH1 and obsolete SSH cipher DES
from parameter ranges.

Firefox

Fixed an issue where Firefox does not accept proxy credentials from setup.
Fixed the print hotkey disable option with Firefox 60+.
Fixed browserglobal.app.local_subdirs_whitelist not working.
Fixed Adobe Flash Player download possibility.

Network

Improved SCEP client robustness:
- The cert_agent script doesn't terminate anymore when a problem occurs (e.g. the SCEP server is 
unreachable) but tries again after the expiry check interval.
- When the client certificate has expired, there is still one attempt at renewing it. However, when 
that fails, a new one is requested. That obviously will fail if the client presents a challenge 
password that is not valid anymore.
Restoring WLAN/WWAN Modem state after wakeup from standby or reboot.
Improved expire time of Ethernet no-link notification.
Added all Ethernet network drivers from OS to LX version.
Changed e1000e driver to out of tree version 3.4.2.3 directly from Intel.
Changed igb driver to out of tree version 5.3.5.22 directly from Intel.
Fixed bug: Failure to reach SCEP server in the client certificate renewal phase resulted in loss of 
SCEP server and client certificates.
SCEP: A change of the CA fingerprint setting does not result in discarding all SCEP data 
anymore if the fingerprint matches that of the current CA certificate. Firmware versions before 
10.05.100 allowed an empty fingerprint. So, this is meant for users who must belatedly configure 
the fingerprint in order for client certificate renewal to work. 
A change of the CAIdentifier setting is not detected immediately and does not result in discarding 
all current data anymore. The new CAIdentifier will, however, be used in future SCEP operations.
Fixed instability with netmounts with static ip configuration.
Fixed problems with windows share mounts.
Fixed MBB router configuration (broken since 10.05.500).
Added a possibility to switch between third-party and kernel Intel IGB network driver. 
A new registry key:
More...

Parameter Use thirdparty igb kernel module

Registry network.drivers.igb.prefer_thirdparty
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Range [Auto] [Yes] [No]

Info: "Auto" (use thirdparty in most cases)

Added a possibility to switch between thirdparty and kernel Intel E1000E network driver.
A new registry key:
More...

Parameter Use thirdparty e1000e kernel module

Registry network.drivers.e1000e.prefer_thirdpar

ty

Range [Auto] [Yes] [No]

Info: "Auto" (use thirdparty in most cases)

Added a possibility to switch between thirdparty r8168 and kernel r8169 realtek network 
driver. 
A new registry key:
More...

Parameter Use thirdparty r8168 kernel module

Registry network.drivers.r8169.prefer_r8168

Range [Auto] [Yes] [No]

Info: "Auto" (use r8168 in most cases)

Added a possibilty to choose the variant of the realtek r8168 driver. 
A new registry key:
More...

Parameter Choose realtek r8168 variant (only if "prefer r8168" is choosen)

Registry network.drivers.r8169.r8168_variant

Range [Default] [No NAPI] [NAPI]

Info: "Dafault" (use NAPI in most cases)

Fixed bug: Second Ethernet interface did not get configured when the first one was disabled.
Fixed 802.1X Ethernet configuration with user interaction.

WiFi

Fixed bug: WiFi connection to hidden SSID did not work anymore after reediting with the Wireless 
Manager.
Fixed not working Broadcom SDIO WLAN cards as present in Advantech AIM8IAC device for 
example.

Smartcard
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Fixed Dell KB813 Smartcard Keyboard in combination with certain smart cards driven by OpenSC 
PKCS#11 module. Before this fix, authentication to Citrix StoreFront and VMWare Horizon failed.
Improved handling of PIV/CAC smart cards in OpenSC.
Updated cryptovision sc/interface PKCS#11 smart card library to version 7.1.20. 
Changes in this revision:
- Fixed a possible deadlock in the PKCS#11 module on Linux if C_Finalize is called during a PCSC 
event, for example C_WaitForSlotEvent.
- ROCA check in the Smartcard Manager, based on the "ROCA detection tool", see https://
github.com/crocs-muni/roca.
- Renaming container label in Smartcard Manager with F2 now possible.
Fixed OpenSC setting max_send_size for reader driver pcsc in /etc/opensc/opensc.conf.

Application Launcher

Fixed confusion in nameserver list caused by comments in /etc/resolv.conf.

Base system

Fixed issues with gen4/5 Intel graphic driver in kernel 4.18.20.
Fixed Screensaver and Screenlock timeouts to be independent. This means, if both timeouts are 
set, the start of Screenlock will not reset the Screensaver timeout any more.
Fixed retrieving of serial number of a display.
Fixed playback of AAC coded audio streams on IGEL Zero products.
Added possibility to set intel_idle.max_cstate kernel cmdline parameter with registry keys to 
work against Intel CPU freezes.
Ensure that the Unit ID for IGEL devices is the MAC address of the onboard network card.
Enhanced handling of Unit ID. On IGEL hardware the Unit ID isn't stored persistently any more by 
default. The persistent Unit ID can be removed with command get_unit_id -r . The 

persistent Unit ID storage can be forced with get_unit_id -i -f -p  or with 

get_unit_id -m  to manually choose a Unit ID from several network interfaces found on the 
device. Handle with extreme care since the Unit ID is the key for handling the endpoint in UMS.
Replaced MIT Kerberos clients by Heimdal Kerberos clients.
Improved the buddy update server performance for multiple simultaneous update clients.
Fixed handling of an "update on shutdown" during suspend/resume.
Fixed shutdown while IGEL Setup Assistant is shown.
Fixed delay in logon as local user when logon with IGEL Smartcard is also active.
Fixed sporadic bootsplash issue.
Fixed suspend/resume hangs when logged into Citrix sessions.
Fixed CPU scaler and volume control applet suspend/resume issue.
Added AppArmor rule to allow tcpdump to write to /debuglog.
Fixed random 90 seconds shutdown delay (systemd).
Fixed Custom Bootsplash installation.
Bugfix: Create shortcuts for terminal shutdown, terminal restart and icon sort directly after 
reconfiguration. A reboot is not needed anymore.
Fixed: System logoff waits for Citrix logoff now.
Fixed broken custom bootsplash when doing a reset to factory defaults via UMS.
Bugfix: hotkey setting needs restart.

https://github.com/crocs-muni/roca
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IGEL Setup Assistant will persistently activate WiFi when a connection is enabled instead of after 
finishing it, to preserve settings when UMS sends license and stops it.
Fixed AD/Kerberos logon in case parameter auth.login.krb5_enterprise is set to 'false'.
Added a new registry key to set USB quirks:
More...

Parameter Set XHCI USB quirks to fix some hardware issues

Registry system.kernel.bootparams.xhci-

hcd_quirks

Range [No quirk] [Spurious Reboot quirk] [Spurious Wakeup 
quirk] [Spurious Reboot Wakeup quirk] 

Fixed: Migration tool did not start with Spanish language setting.
Disabled martian packet logging.

Driver

Updated deviceTRUST Client to version 19.1.200.
Bug Fixes:

Fixed an issue reading the DEVICE_IGEL_ICG_SERVER property.
Fixed an issue where the NETWORK and LOCATION property providers could cause the 
client to freeze if a disconnection occurred while these property providers were checking 
for changes.
Fixed an open file handle leak which lead to the client process reaching its file handle 
limits when left running for a long period of time.

Fixed not working WACOM device DTU-1141B.

Custom Partition

Fixed ownership of extracted data: Do not preserve owner information while extracting data into 
custom partition.

Storage Devices

Fixed auto mounting of storage devices inside of Olympus DS-9500 Digital Voice Recorder.

Appliance Mode

Fixed bug: In-session control bar could not be deactivated in Citrix SelfService appliance mode.

X11 system

Fixed Microsoft Surface Pro 4 screen resolution issue.
Fixed the missing volume control in the panel when the panel is configured to disappear while 
the login/lock screen is shown.
There is now a registry key to ignore a 3Dconnexion SpaceMouse for IGEL graphical use (X11). If 
activated, the SpaceMouse is only passed through to the desktop session. If false, it acts also as the 
standard mouse.
More...

Parameter Deactivates a 3Dconnexion SpaceMouse as a standard mouse
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Registry userinterface.mouse.spacemouse.x11_ignore

Value enabled / disabled

The following SpaceMouse products are included:
More...

VID PID Vendor Product

0x046D 0xC603 Logitech, Inc. 3Dconnexion SpaceMouse Plus XT

0x046D 0xC605 Logitech, Inc. 3Dconnexion CADman

0x046D 0xC606 Logitech, Inc. 3Dconnexion SpaceMouse Classic

0x046D 0xC621 Logitech, Inc. 3Dconnexion SpaceBall 5000

0x046D 0xC623 Logitech, Inc. 3Dconnexion SpaceTraveller 3D Mouse

0x046D 0xC625 Logitech, Inc. 3Dconnexion SpacePilot 3D Mouse

0x046D 0xC626 Logitech, Inc. 3Dconnexion SpaceNavigator 3D Mouse

0x046D 0xC627 Logitech, Inc. 3Dconnexion SpaceExplorer 3D Mouse

0x046D 0xC628 Logitech, Inc. 3Dconnexion SpaceNavigator for Notebooks

0x046D 0xC629 Logitech, Inc. 3Dconnexion SpacePilot Pro 3D Mouse

0x046D 0xC62B Logitech, Inc. 3Dconnexion SpaceMouse Pro

0x256F ** 3Dconnexion SpaceMouse

USB device reset via USB powercycle is now available on UD6/UD7.
Fixed screen flicker in some cases if Force NumLock On (x.global.forcenumlock) is active.
Fixed not working x.xserver0.screen1.flipscreens registry key.
Use Index and Mode from Advanced mode in Simple Mode for Display Switch.
Fixed display hotplug failing on initial lock screen with Active Directory logon.
The in-session control bar now scales with the current DPI setting.
Fixed Display Switch utility not starting with some translations.
Fixed an issue with the noDDC mode not always working as expected.
Fixed a bug with thin clients reporting the wrong monitor serial number.

Window manager

Fixed the option to disable the local window manager.

Audio

Fixed bad quality sound over DisplayPort in a Citrix ICA session or other applications using ALSA 
API.
Fixed configuration of default audio output and input.

Media Player (Parole)
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Fixed a problem where parole media player would hang instead of playing audio while audio-
visualization is enabled.
Fixed parole media player not handling audio hotkeys in fullscreen mode.

Multimedia

Updated multimedia codecs to fix freeze when audio visualization is used.

Misc

Monitoring Agent uses now only the half size of the debuglog partition. 
When the setup option log_max_size with the option log_rotation creates an overall 
consumption that is bigger than 50% of the debuglog partition size, the size for each log 
automatically will be decreased to a value that allows a full rotation which occupies exactly 50% of 
the partition size.

Hardware

Fixed problems with mouse cursor on Intel cherryview devices.
Added a possibility to change some DRM settings and limit the DisplayPort lane bandwidth on 
Intel devices.
Added new registry keys:
More...

Parameter Use best graphic mode for all screens on console.

Registry x.drivers.kms.best_console_mode

Range [Default] [Enabled] [Disabled]

Info: "Default" is enabled in most cases.

Parameter Limit the maximum console resolution width to this value.

Registry x.drivers.kms.max_console_width

Type Integer

Value "0"

Info: "0" means default setting. Use the default setting.

Parameter Limit the maximum console resolution height to this value.

Registry x.drivers.kms.max_console_height

Type Integer

Value "0"

Info: "0" means default setting. Use the default setting.

Parameter Set graphic kernel driver debug level.
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Registry x.drivers.kms.debug_level

Range [No debug] [Basic] [Basic + core] [Basic + core + atomic] [Full]

Info: Warning log will grow very fast.

Only for Intel i915 driver:

Parameter Limit the maximum DisplayPort lane link rate.

Registry x.drivers.intel.max_dp_link_rate

Range [default] [1.62Gbps] [2.16Gbps] [2.7Gbps] [3.24Gbps]
[4.32Gbps] [5.4Gbps] [6.48Gbps] [8.1Gbps]  

Info: "Default" means hardware default limit.

Remote Management / IGEL Cloud Gateway

Fixed wallpaper configuration when ICG protocol is used.
Fixed UMS synchronization of configuration when changes were made in "Emergency mode".
Fixed sporadic failures while sending data over ICG.
Fixed removal from UMS when the device was offline.
Added: IGEL UMS agent sends monitor information for maximum eight monitors now.

Caradigm

Fixed Horizon session crash.

IGEL Linux 10 Recovery

Fixed problem with forced no EFI installation.
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IGEL Universal Desktop OS 3
Supported Hardware:

https://kb.igel.com/igelos/en/devices-supported-by-udc3-and-ud-pocket-3117174.html

Component Versions 10.06.100 (see page 1026)
General Information 10.06.100 (see page 1030)
Security Fixes 10.06.100 (see page 1031)
Known Issues 10.06.100 (see page 1036)
New Features 10.06.100 (see page 1038)
Resolved Issues 10.06.100 (see page 1065)
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Component Versions 10.06.100
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.3.0.5

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 2.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.5

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.7.2

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded onesign-bootstrap-
loader_1.0.523630_amd64

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 6.5.6

Open VPN 2.3.10-1ubuntu2.2

Zulu JRE 8.38.0.13

Parallels Client (64 bit) 16.5.3.20735

Remote Viewer (RedHat Virtualization) 8.0-1igel49

Spice GTK (Red Hat Virtualization) 0.36-1~git20190601igel61

Usbredir (Red Hat Virtualization) 0.8.0-1igel49

Systancia AppliDis 4.0.0.17
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ThinLinc Client 4.10.0-6068

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel18

VMware Horizon Client 5.0.0-12557422

VNC Viewer 1.9.0+dfsg-3igel8

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B301

Olympus driver for dictation 20180621

Philips Speech Driver 12.7.11

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.8

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.20

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.6-1igel1

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.30-1igel3

Reader Driver REINER SCT cyberJack 3.99.5final.sp13igel15

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.2.0.3

System Components
OpenSSL 1.0.2g-1ubuntu4.15

OpenSSH Client 7.2p2-4ubuntu2.8

OpenSSH Server 7.2p2-4ubuntu2.8

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 19.0.8-1igel73

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20190301-igel870

Graphics Driver ATI/RADEON 19.0.1-2igel890

Graphics Driver ATI/AMDGPU 19.0.1-4igel894

Graphics Driver Nouveau (Nvidia Legacy) 1.0.16-1igel867

Graphics Driver Nvidia 390.116-0ubuntu0.18.10.1

Graphics Driver Vboxvideo 1.0.0-igel798

Graphics Driver VMware 13.3.0-2igel857

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.4.0-1igel855

Input Driver Evdev 2.10.6-1igel888

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.1-1ubuntu1igel866

Input Driver VMmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu2igel888

Kernel 4.19.57 #mainline-udos-r2762
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Xorg X11 Server 1.20.5-1igel891

Xorg Xephyr 1.20.5-1igel891

CUPS printing daemon 2.1.3-4ubuntu0.9igel27

PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel656

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.3igel74

ModemManager 1.10.0-1~ubuntu18.04.2igel3

GStreamer 0.10 0.10.36-2ubuntu0.2

GStreamer 1.x 1.16.0-1igel214

WebKit2Gtk 2.24.2-0ubuntu0.19.04.1igel18

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB (MTP) 1.1.16-2igel1

Mobile Device Access USB (imobile) 1.2.1~git20181030.92c5462-1igel5

Mobile Device Access USB (gphoto) 2.5.22-3igel1

VPN OpenConnect 7.08-1

Scanner support / SANE 1.0.27-1

VirtualBox 6.0.8-dfsg-4igel25

Features with Limited Functionality
Cisco JVDI Client 12.1.0
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General Information 10.06.100
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4;
Citrix Access Gateway Standard Plug-in;
Dell vWorkspace Connector for Linux;
Ericom PowerTerm Emulation 9 and 11;
Ericom Webconnect;
IGEL Legacy RDP Client (rdesktop);
Virtual Bridges VERDE Client;
PPTP VPN Support;
IGEL Upgrade License Tool with IGEL Smartcard Token;
Remote Management by setup.ini file transfer (TFTP);
Remote Access via RSH;
Legacy Philips Speech Driver;
T-Systems TCOS Smartcard Support;
DUS Series touch screens;
Elo serial touchscreens;
VIA graphics support;
Java WebStart;
Storage hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon;
by an icon in the In-Session Control Bar (configurable under IGEL Setup > User Interface > 
Desktop);
by a Safely Remove Hardware session (configurable under IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel;
Open VPN Smartcard Support;
Asian Input Methods;
Composite Manager.
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Security Fixes 10.06.100
Firefox

Updated Mozilla Firefox to version 60.7.2 ESR.
Fixed mfsa2019-19 security issue CVE-2019-11708.
Fixed mfsa2019-18 security issue CVE-2019-11707.
Fixed mfsa2019-10 security issues CVE-2019-9810 and CVE-2019-9813.
Fixed mfsa2019-08 security issues.
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, CVE-2019-9788.

Fixed mfsa2019-05 security issues CVE-2018-18356 and CVE-2019-5785.
Fixed mfsa2019-02 security issues CVE-2018-18500, CVE-2018-18505 and CVE-2018-18501.
Fixed mfsa2018-30 security issues.
More...

CVE-2018-17466, CVE-2018-18492, CVE-2018-18493,
CVE-2018-18494, CVE-2018-18498, CVE-2018-12405.

Allow Firefox to access YubiKey (FIDO/U2F) when AppArmor is active.

Base system

Fixed a vulnerability in Java configuration script.
Fixed possibly malicious owner change with TC setup configuration.
Fixed policykit-1 security issues CVE-2018-19788 and CVE-2019-6133.
Fixed NSS security issues CVE-2018-18508, CVE-2018-12404, CVE-2018-12384 and CVE-2018-0495.
Fixed PPP security issue CVE-2018-11574.
Fixed imagemagick security issues.
More...

CVE-2018-16750, CVE-2018-16749, CVE-2018-16645, CVE-2018-16644,
CVE-2018-16643, CVE-2018-16642, CVE-2018-16640, CVE-2018-16323,
CVE-2018-14437, CVE-2018-14436, CVE-2018-14435, CVE-2018-14434,
CVE-2017-13144, CVE-2017-12430, CVE-2019-9956, CVE-2019-7398,
CVE-2019-7397, CVE-2019-7396, CVE-2019-7175, CVE-2019-11598,
CVE-2019-11597, CVE-2019-11472, CVE-2019-11470, CVE-2019-10650,
CVE-2019-10131, CVE-2018-20467, CVE-2018-18025, CVE-2018-18024,
CVE-2018-18016, CVE-2018-17966, CVE-2018-17965, CVE-2018-16413,
CVE-2018-16412, CVE-2017-12806, and CVE-2017-12805.

Fixed systemd security issues.
More...

CVE-2018-16866, CVE-2018-16865, CVE-2018-16864, CVE-2018-15688,
CVE-2019-6454, CVE-2018-1049, CVE-2018-15686 and CVE-2019-3842.

Fixed CUPS security issue CVE-2018-4700.
Fixed libarchive security issues.
More...
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CVE-2019-1000020, CVE-2019-1000019, CVE-2018-1000878,
CVE-2018-1000877, and CVE-2017-14502.

Fixed Avahi security issues CVE-2018-1000845 and CVE-2017-6519.
Fixed bind9 security issues CVE-2019-6465, CVE-2018-5745, and CVE-2018-5743.
Fixed libcaca security issues.
More...

CVE-2018-20549, CVE-2018-20548, CVE-2018-20547,
CVE-2018-20546, CVE-2018-20545, and CVE-2018-20544.

Fixed libgd2 security issues CVE-2019-6978 and CVE-2019-6977.
Fixed ghostscript security issues.
More...

CVE-2019-6116, CVE-2018-19477, CVE-2018-19476, CVE-2018-19475,
CVE-2018-19409, CVE-2018-18284, CVE-2018-18073, CVE-2018-17961,
CVE-2019-3838, and CVE-2019-3835.

Fixed krb5 security issues.
More...

CVE-2018-5730, CVE-2018-5729, CVE-2017-11462,
CVE-2017-11368, CVE-2016-3120, and CVE-2016-3119.

Fixed texlive-bin security issue CVE-2018-17407.
Fixed LDB security issue CVE-2019-3824.
Fixed libmspack security issues CVE-2018-18585 and CVE-2018-18584.
Fixed Perl security issues CVE-2018-18314, CVE-2018-18313, CVE-2018-18312 and CVE-2018-18311.
Fixed poppler security issues.
More...

CVE-2019-7310, CVE-2018-20650, CVE-2018-20551, CVE-2018-20481,
CVE-2018-19149, CVE-2018-19060, CVE-2018-19059, CVE-2018-19058,
CVE-2018-16646, and CVE-2019-9200.

Fixed Python 3.5 security issues CVE-2018-14647, CVE-2018-1061, CVE-2018-1060 and 
CVE-2018-106.
Fixed Net-SNMP security issue CVE-2018-18065.
Fixed OpenSSL security issues CVE-2019-1559, CVE-2018-5407 and CVE-2018-0734.
Fixed TIFF security issues.
More...

CVE-2018-8905, CVE-2018-7456, CVE-2018-18661, CVE-2018-18557,
CVE-2018-17101, CVE-2018-17100, CVE-2018-1710, CVE-2018-10963,
CVE-2019-7663, CVE-2019-6128, CVE-2018-19210, CVE-2018-17000,
CVE-2018-12900, and CVE-2018-10779.

Fixed libvncserver security issues.
More...

CVE-2018-6307, CVE-2018-20750, CVE-2018-20749, CVE-2018-20748,
CVE-2018-20024, CVE-2018-20023, CVE-2018-20022, CVE-2018-20021,
CVE-2018-20020, CVE-2018-20019, CVE-2018-15127, and CVE-2018-15126.



Notes for Release 10.06.100

IGEL OS Release Notes   1033 / 1492

•
•

•

•

•

•
•

•
•
•
•
•
•

•
•

•
•

Fixed WavPack security issue CVE-2018-19840.
Fixed Samba security issues.
More...

CVE-2018-16851, CVE-2018-16841, CVE-2018-14629,
CVE-2019-3880, and CVE-2018-16860.

Fixed libxkbcommon security issues.
More...

CVE-2018-15864, CVE-2018-15863, CVE-2018-15862, CVE-2018-15861,
CVE-2018-15859, CVE-2018-15858, CVE-2018-15857, CVE-2018-15856,
CVE-2018-15855, CVE-2018-15854, and CVE-2018-15853.

Fixed OpenSSH security issues.
More...

CVE-2019-6111, CVE-2019-6109, CVE-2018-20685,
CVE-2018-15473, and CVE-2016-10708.

Fixed Python 2.7 security issues.
More...

CVE-2018-14647, CVE-2018-1061, CVE-2018-1060,
CVE-2018-106, CVE-2018-1000802, and CVE-2018-1000030.

Fixed lxml security issue CVE-2018-19787.
Fixed gdk-pixbuf security issues.
More...

CVE-2017-6314, CVE-2017-6313, CVE-2017-6312,
CVE-2017-6311, CVE-2017-2870, CVE-2017-2862,
CVE-2017-1000422, CVE-2016-6352, and CVE-2017-12447.

Fixed file security issues CVE-2019-8907 and CVE-2019-8905.
Fixed wget security issue CVE-2019-5953.
Fixed nvidia-graphic-drivers-390 security issue CVE‑2018‑6260.
Fixed libxslt security issue CVE-2019-11068.
Fixed Evince security issue CVE-2019-11459.
Fixed webkit2gtk security issues.
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251,
CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378,
CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345,
CVE-2018-4386, and CVE-2018-4372.

Fixed gst-plugins-base0.10 security issue CVE-2019-9928.
Fixed WPA security issues.
More...

CVE-2019-9495, CVE-2019-9497, CVE-2019-9498,
CVE-2019-9499, and CVE-2019-11555.

Fixed Heimdal security issues CVE-2019-12098 and CVE-2018-16860.
Fixed libimobiledevice security issue CVE-2016-5104.
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Fixed libpng1.6 security issues CVE-2019-7317 and CVE-2018-13785.
Fixed GIMP security issues.
More...

CVE-2017-17786, CVE-2017-17789, CVE-2017-17784,
CVE-2017-17787, CVE-2017-17785, and CVE-2017-17788

Fixed libtomcrypt security issue CVE-2018-12437.
Fixed curl security issues.
More...

CVE-2018-16840, CVE-2018-16839, CVE-2019-3823,
CVE-2019-3822, CVE-2018-16890, CVE-2019-5346.

Fixed gnutls28 security issues CVE-2018-10846, CVE-2018-10845, CVE-2018-10844 and 
CVE-2018-1084.
Fixed qtbase-opensource-src security issues CVE-2018-19873, CVE-2018-19870 and 
CVE-2018-15518.
Fixed db5.3 security issue CVE-2019-8457.
Fixed libssh2 security issues.
More...

CVE-2019-3863, CVE-2019-3862, CVE-2019-3861,
CVE-2019-3860, CVE-2019-3859, CVE-2019-3858, 
CVE-2019-3857, CVE-2019-3856, and CVE-2019-3855.

Fixed network-manager security issue CVE-2018-15688.
Fixed elfutils security issues.
More...

CVE-2019-7665, CVE-2019-7150, CVE-2019-7149,
CVE-2018-18521, CVE-2018-18520, CVE-2018-18310,
CVE-2018-16403, CVE-2018-16402, and CVE-2018-16062.

Fixed libsndfile security issues.
More...

CVE-2019-3832, CVE-2018-19758, CVE-2018-19662, CVE-2018-19661, CVE-2018-19432, 
CVE-2018-13139, CVE-2017-6892, CVE-2017-17457, CVE-2017-17456, CVE-2017-16942,
CVE-2017-14634, CVE-2017-14246, and CVE-2017-14245.

Fixed dbus security issue CVE-2019-12749.
Fixed Vim security issues CVE-2019-12735 and CVE-2017-5953.
Fixed sqlite3 security issues.
More...

CVE-2019-9937, CVE-2019-9936, CVE-2019-8457, CVE-2018-20506,
CVE-2018-20346, CVE-2017-2520, CVE-2017-2519, CVE-2017-2518,
CVE-2017-13685, CVE-2017-10989, and CVE-2016-6153.

Fixed libseccomp security issue CVE-2019-9893.
Fixed bzip2 security issues CVE-2019-12900 and CVE-2016-3189.
Fixed Expat security issue CVE-2018-20843.
Fixed unzip security issues CVE-2019-13232, CVE-2018-1000035, CVE-2016-9844 and 
CVE-2014-9913.
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Mount partitions with "nodev" flag option.
The home directory of the remote users is now /home/ruser.
Default umask is set to 0077 for all non-root users.
Fixed a vulnerability in the custom environment variable framework.
Fixed kernel TCP vulnerabilities CVE-2019-11477: SACK Panic, CVE-2019-11478: SACK Slowness
and CVE-2019-11479: Excess Resource Consumption Due to Low MSS Values.
Changed minimally allowed MSS size to "1000" to prevent possible denial-of-service attacks.
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Known Issues 10.06.100
Citrix

With activated DRI3 and AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective H.264 
mode (API v2) is not affected by this issue.
Citrix has known issues with GStreamer1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions 
and H264 acceleration

Registry ica.workaround-dual-rtme

Range enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
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Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In seldom cases, the authentication hung when using  A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Multimedia

Multimedia redirection with GStreamer could fail with the Nouveau GPU driver.

WiFi

TP-Link Archer T2UH WiFi adapters do not work after system suspend/resume.
Workaround: Disable system suspend under IGEL Setup > System > Power Options > Shutdown.

Base system

Due to the removal of the Oracle JRE, Java WebStart is not supported anymore.
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New Features 10.06.100
OS 11 Upgrade

It is now possible to upgrade to IGEL OS 11. For more information, see the how-to Upgrading IGEL 
Devices from IGEL OS 10 to IGEL OS 11.
The parameters for the upgrade:
More...

IGEL Setup > System > Update > OS 11 Upgrade

Parameter Upgrade to OS 11

Registry update.firmware_migrate_to_11

Value enabled / disabled

Parameter Upgrade to OS 11 even if a previous upgrade attempt failed

Registry update.force_firmware_migrate_to_11

Value enabled / disabled

Parameter Upgrade to OS 11 even if PowerTerm is enabled

Registry update.migrate_to_11_with_powerterm

Value enabled / disabled

Parameter Require an Enterprise Management Pack license to upgrade to OS 11

Registry update.migrate_to_11_enterprise_required

Range [Smart] [Always] [Never]

Parameter Timeout waiting for OS 11 license to start automatic upgrade

Registry update.migrate_to_11_license_timeout

Range [Disabled] [10 Minutes] [15 Minutes] [30 Minutes] [60 Minutes]

The parameters for configuring the desktop integration of the IGEL OS 11 Upgrade tool are:
More...

IGEL Setup > Accessories > OS 11 Upgrade 

Registry sessions.os11_migration0.startmenu

Value enabled / disabled



Notes for Release 10.06.100

IGEL OS Release Notes   1039 / 1492

•
•

•

Registry sessions.os11_migration0.applaunch

Value enabled / disabled

Registry sessions.os11_migration0.startmenu_system

Value enabled / disabled

Registry sessions.os11_migration0.applaunch_system

Value enabled / disabled

Registry sessions.os11_migration0.menu_path

Registry sessions.os11_migration0.desktop_path

Registry sessions.os11_migration0.applaunch_path

Registry sessions.os11_migration0.quick_start

Value enabled / disabled

Registry sessions.os11_migration0.pwprotected

Range [None] [Administrator] [User] [Setup user]

Registry sessions.os11_migration0.desktop

Value enabled / disabled

Registry sessions.os11_migration0.pulldown

Value enabled / disabled

Citrix

Integrated Citrix Workspace app 19.03.
Added a new registry key to support 1536-bit RSA keys for client authentication. Factory default 
for this release is "true".
More...

Parameter Enables RSA 1536 cipher suite

Registry ica.allregions.enable_rsa_1536

Range factory default / false / true

Added a new registry key to enable different cipher suites. Factory default for this release is 
"ALL".
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More...

Parameter Enables different cipher suite

Registry ica.allregions.sslciphers

Range factory default / ALL / GOV / COM

> TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
> TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
> TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA – COM/ALL

Added a new registry key to support keyboard layout synchronization.
More...

Parameter Keyboard layout synchronization

Registry ica.modules.virtualdriver.keyboardsync.enable

Value disabled / enabled

Updated Citrix HDX RTME used for optimization of Skype for Business to version 2.8.0-2235.
Added support for Citrix Workspace Launcher functionality as described at https://
support.citrix.com/article/CTX237727.
Added a Citrix plugin for hardware accelerated VDPAU based H.264 decoding on AMD graphics 
chipsets:
More...

Parameter Enable HW accelerated H264 vdpau codec (experimental)

Registry ica.hw-accelerated-h264-vdpau-codec

Value enabled/ disabled 

RDP/IGEL RDP Client 2

Added a field 'Collection' to RDP session server page.
More...

IGEL Setup > Sessions > RDP > RDP Sessions > RDP Session > Server  

IGEL Setup > Sessions > RDP > RDP Sessions > RDP Session > Options

Parameter Collection

Registry sessions.winconnect<NR>.option.load-balance-

info

VMware Horizon

Updated Horizon Client to version 5.0.0-12557422.
Added parameters to specify webcam frame size and rate for RTAV.

https://support.citrix.com/article/CTX237727
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More...

Parameter Webcam frame width

Registry vmware.view.rtav-frame-width

Value <empty_string>

Parameter Webcam frame height

Registry vmware.view.rtav-frame-height

Value <empty_string>

Parameter Webcam frame rate

Registry vmware.view.rtav-frame-rate

Value <empty_string>

Added a possibility to easily evaluate Horizon Blast decoder states. By default, sessions are 
evaluated after use and the result is written to the journal log.
Added continuous run mode for USB-Arbitrator.
More...

Parameter USB-Arbitrator continuous run mode

Registry vmware.view.usb.arbitrator-continuous-runmode

Value enabled / disabled

Added recognition for password change and password expired dialog in Horizon local logon 
sessions or appliance mode.
Added switch for Blast H.264 decoding for VMware Horizon Client.
More...

Parameter Blast H.264 decoding

Registry vmware.view.blast-h264

Value enabled / disabled

Added switch to use systemwide proxy in VMware Horizon appliance mode.
More...

Parameter Use the systemwide proxy

Registry vmwarevdmapp.use_proxy

Value enabled / disabled

Parallels Client
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Updated Parallels Client to version 16.5.3 (64-Bit).
Added a possibility to set apps to autostart on Parallels RAS.

ThinLinc

Updated Cendio ThinLinc to version 4.10.

RedHat Enterprise Virtualization Client.

Updated Remote Viewer (RedHat Virtualization) to version 8.0.
Updated Spice GTK (RedHat Virtualization) to version 0.36.

IBM_5250

Updated IBM iAccess Client Solutions to version 1.1.8.1.
Improved startup time of IBM iAccess Client.
Improved configuration of IBM iAccess Client via IGEL Setup.
More...

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Connection > Advanced

Parameter Bypass signon

Registry sessions.iaccess<NR>.options.ssoenabled

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Font

Parameter Antialiasing

Registry sessions.iaccess<NR>.options.textantialiasing

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Allow blinking cursor

Registry sessions.iaccess<NR>.options.blinkcursor

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Show blinking text with

Registry sessions.iaccess<NR>.options.blinkstate
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Value  [Blinking Text] [Host Color] [Mapped Color]

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Blink Color

Registry sessions.iaccess<NR>.options.blinkcolor_fg

Value #ffc800

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Blink Color Background

Registry sessions.iaccess<NR>.options.blinkcolor_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Rule Line

Registry sessions.iaccess<NR>.options.ruleline

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Follow Cursor

Registry sessions.iaccess<NR>.options.rulelinefollows

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Style

Registry sessions.iaccess<NR>.options.rulelinestyle

Value [Crosshair] [Vertical] [Horizontal]

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Green
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Registry sessions.iaccess<NR>.options.color_fgn_fg

Value #00ff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Green Background

Registry sessions.iaccess<NR>.options.color_fgn_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter White

Registry sessions.iaccess<NR>.options.color_fwt_fg

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter White Background

Registry sessions.iaccess<NR>.options.color_fwt_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Red

Registry sessions.iaccess<NR>.options.color_frd_fg

Value #ff0000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Red Background

Registry sessions.iaccess<NR>.options.color_frd_bg

Value #000000
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Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Turquoise

Registry sessions.iaccess<NR>.options.color_ftq_fg

Value #00ffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Turquoise Background

Registry sessions.iaccess<NR>.options.color_ftq_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Yellow

Registry sessions.iaccess<NR>.options.color_fyw_fg

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Yellow Background

Registry sessions.iaccess<NR>.options.color_fyw_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Pink

Registry sessions.iaccess<NR>.options.color_fpk_fg

Value #ff00ff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Pink Background

Registry sessions.iaccess<NR>.options.color_fpk_bg
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Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Blue

Registry sessions.iaccess<NR>.options.color_fbl_fg

Value #7890f0

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Blue Background

Registry sessions.iaccess<NR>.options.color_fbl_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Status Indicators

Registry sessions.iaccess<NR>.options.color_osi

Value #7890f0

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Information Indicators

Registry sessions.iaccess<NR>.options.color_oii

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Attention Indicators

Registry sessions.iaccess<NR>.options.color_oai

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Error Indicators
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Registry sessions.iaccess<NR>.options.color_oei

Value #ff0000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter OIA Background

Registry sessions.iaccess<NR>.options.color_oob

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Screen Background

Registry sessions.iaccess<NR>.options.color_sbg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Highlight active field

Registry sessions.iaccess<NR>.options.actfieldhilite

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Active Field

Registry sessions.iaccess<NR>.options.color_actf_fg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Active Field Background

Registry sessions.iaccess<NR>.options.color_actf_bg

Value #ffff00
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Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Crosshair Ruler Color

Registry sessions.iaccess<NR>.options.color_crc

Value #00ff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Column Separator

Registry sessions.iaccess<NR>.options.color_ccs

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences

Parameter Start window maximized

Registry sessions.iaccess<NR>.options.ismaximized

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Keyboard

Parameter Keyboard Remapping File

Registry sessions.iaccess<NR>.options.keyremapfile

Value IBMi.kmp

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Popup Keypad

Parameter Popup Keypad File

Registry sessions.iaccess<NR>.options.poppadfile

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Toolbar

Parameter Toolbar File

Registry sessions.iaccess<NR>.options.toolbarfile
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Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Open new sessions in a new tab

Registry ibm.iaccess.acssm.opensessionintab

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Always display the tab bar

Registry ibm.iaccess.acssm.alwaysshowtabbar

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Switch to new tab when created

Registry ibm.iaccess.acssm.switchtonewtab

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Send a warning when closing multiple tabs

Registry ibm.iaccess.acssm.closemultipletabwarning

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Do not start tabbed sessions until the tab is selected

Registry ibm.iaccess.acssm.tabdelayedstart

Value enabled / disabled

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter New Tab Action

Registry ibm.iaccess.acssm.newtabaction

Value [Disable and Hide] [Run the Same] [Run Other...] 

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Tab Placement
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Registry ibm.iaccess.acssm.tabplacement

Value [Top] [Bottom] [Left] [Right] 

Firefox

Updated Mozilla Firefox to version 60.7.2 ESR.
Added new keys to auto show and hide the on-screen software keyboard. To use this feature, 
the keyboard should be set to autostart. After a restart is is activated, the keyboard will appear 
automatically when an input box is selected. Confirmed to work in Firefox and on lockscreen.
More...

Parameter Automatically hide software keyboard depending on focused widget

Registry userinterface.softkeyboard.autohide

Value enabled / disabled

Parameter Automatically show software keyboard depending on focused widget

Registry userinterface.softkeyboard.autoshow

Value enabled / disabled

Added new parameters: Allow a custom command before and after browser session.
More...

Parameter init_action

Registry sessions.browser%.init_action

Value <empty_string>

Parameter final_action

Registry sessions.browser%.final_action

Value <empty_string>

Added options to customize Firefox overflow menu and hide navigation buttons.
More...

Parameter Hide Navigation buttons

Registry sessions.browser<NR>.app.navigation_buttons_hidd

en

Value enabled / disabled
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Parameter Overflow Menu

Registry sessions.browser<NR>.app.custom_toolbar.overflow

-menu

Value open-file-button,feed-button,characterencoding-button

Imprivata

Imprivata Appliance 6.3 or higher is needed now.
Added a new parameter to Imprivata.conf: "Redirection of Smartcards".
More...

IGEL Setup > Sessions > Appliance Mode > Imprivata  

Parameter Redirection of Smartcards

Registry imprivata.native_smartcard_redirection

Value enabled / disabled

Added a new parameter: "Path to Certificate".
More...

IGEL Setup > Sessions > Appliance Mode > Imprivata  

Parameter Path to Certificate

Registry imprivata.path_to_certificate

Network

Added NCP Secure Enterprise VPN Client version 5.10_rev40552 (configurable under IGEL Setup 
> Network > VPN > NCP VPN Client).
Added a new feature: Network status icons are shown on the lock and logon screens.
Added a mechanism for retrieving the SCEP challenge password with a custom script. Setting 
the following registry key to "true" enables the use of the script. The registry key 
network.scepclient.cert%.crypt_password  will be ignored. (The script may use it for 

its own purpose though.)
More...

Parameter Use Challenge Password Command

Registry network.scepclient.cert%.use_challenge_password_c

ommand

Value enabled / disabled

If the above key is enabled, the value of this key will be passed to bash for execution. It happens 
when the SCEP challenge password is needed for creating a certificate signing request. The script 
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is supposed to output the challenge password on its standard output. For convenience, any 
Carriage-Return characters are stripped off the script before execution by bash.
More...

Parameter Challenge Password Command

Registry network.scepclient.cert%.challenge_password_com

mand

Value <empty_string>

WiFi

Added support for Realtek 8821CE wireless cards.
Added switch to determine the source of WiFi scan results for Wireless Manager. Selecting 
default is currently identical with the old mechanism (using the iwlist command). This may change 
in the future. When iwlist fails, NetworkManager is automatically used as a fallback.
More...

Parameter WiFi Scanner

Registry network.interfaces.wirelesslan.device0.mssid_sc

anner

Range [default][iwlist][NetworkManager]

Smartcard

New IGEL Smartcard mode without Locking Desktop (reintroduced feature of Linux 5.x 
firmware).
More...

IGEL Setup > Security > Logon > IGEL Smartcard

Parameter Enable IGEL Smartcard without Locking Desktop

Registry scard.scardd.enable_nolock

Value enabled / disabled

IGEL Setup > Security > Logon > IGEL Smartcard

Parameter On Smartcard Removal, terminate

Registry scard.scardd.session_termination

Value all / smartcard

Updated MUSCLE CCID smartcard reader driver to version 1.4.30.
Updated ACS CCID smartcard driver to version 1.1.6.
Updated REINER SCT smartcard reader driver to version 3.99.5final.sp13.
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Updated SecMaker NetID to version 6.7.2.36: now YubiKey 5 is supported.
Updated cryptovision sc/interface PKCS#11 smartcard library to version 7.1.20.
Added configuration parameters for some settings of smartcard library OpenSC.
More...

Parameter Debug level

Registry scard.pkcs11.opensc.default.debug

Value 0

Parameter Debug file

Registry scard.pkcs11.opensc.default.debug_file

Value stderr

Parameter Max. send size

Registry scard.pkcs11.opensc.default.pcsc.max_send_size

Value 255

Parameter Max. receive size

Registry scard.pkcs11.opensc.default.pcsc.max_recv_size

Value 256

Parameter Connect exclusive

Registry scard.pkcs11.opensc.default.pcsc.connect_exclusiv

e

Value enabled / disabled

Parameter Disconnect action

Registry scard.pkcs11.opensc.default.pcsc.disconnect_actio

n

Value leave / reset / unpower

Parameter Transaction end action

Registry scard.pkcs11.opensc.default.pcsc.transaction_end_a

ction

Value leave / reset / unpower
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Parameter Reconnect action

Registry scard.pkcs11.opensc.default.pcsc.reconnect_action

Value leave / reset / unpower

Parameter Enable pinpad

Registry scard.pkcs11.opensc.default.pcsc.enable_pinpad

Value enabled / disabled

Parameter Use PIN caching

Registry scard.pkcs11.opensc.default.pkcs15.use_pin_cachin

g

Value enabled / disabled

Parameter How many times to use a PIN from cache before re-authenticating it

Registry scard.pkcs11.opensc.default.pkcs15.pin_cache_coun

ter

Value 10

Parameter PIN caching ignores user consent

Registry scard.pkcs11.opensc.default.pkcs15.pin_cache_ignore_

user_consent

Value enabled / disabled

Updated CHERRY USB-LAN Proxy to version 3.2.0.3. This version provides enhanced 
configuration.
More...

IGEL Setup > Security > Smartcard > Services

Parameter Bind IP

Registry devices.cherry.usblanproxy.bind-ip

Value auto

IGEL Setup > Security > Smartcard > Services

Parameter Https Server Port
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Registry devices.cherry.usblanproxy.https-port

Value 443

IGEL Setup > Security > Smartcard > Services

Parameter SICCT Announce IP

Registry devices.cherry.usblanproxy.sicct-announce-ip

Value broadcast

IGEL Setup > Security > Smartcard > Services

Parameter SICCT Announce Port

Registry devices.cherry.usblanproxy.sicct-announce-

port

Value 4742

IGEL Setup > Security > Smartcard > Services

Parameter SICCT Announce Interval

Registry devices.cherry.usblanproxy.sicct-announce-

interval

Value 30

IGEL Setup > Security > Smartcard > Services

Parameter USB Fast Mode

Registry devices.cherry.usblanproxy.usb-fast-mode

Value enabled /disabled

IGEL Setup > Security > Smartcard > Services

Parameter Alternate Initialization Method for G87-1505

Registry devices.cherry.usblanproxy.usb-1505-alt-

setup

Value enabled /disabled

CUPS Printing

Added SMB Network Print client function.
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More...

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter Printer Port

Registry print.cups.printer<NR>.backend

Value smb

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Server

Registry print.cups.printer<NR>.smb_server

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Workgroup

Registry print.cups.printer<NR>.smb_workgroup

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Printer

Registry print.cups.printer<NR>.smb_printer

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Port

Registry print.cups.printer<NR>.smb_port

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter Use Kerberos Authentication

Registry print.cups.printer<NR>.smb_kerberos

Value enabled / disabled

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter Use Passthrough Authentication

Registry print.cups.printer<NR>.smb_passthrough

Value enabled /disabled

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog
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Parameter SMB User

Registry print.cups.printer<NR>.smb_user

IGEL Setup > Devices > Printer > CUPS > Printers > Dialog

Parameter SMB Password

Registry print.cups.printer<NR>.crypt_password

Base system

Updated kernel from 4.18.20 to 4.19.57 version.
Enhanced bootloader to allow the set of some kernel commandline parameters with registry keys:
More...

Parameter Disable use of APIC controller

Registry system.kernel.bootparams.noapic

Value enabled /disabled

Parameter Disable use of ACPI

Registry system.kernel.bootparams.noacpi

Value enabled /disabled

Parameter Use only one CPU core and disable all others

Registry system.kernel.bootparams.nosmp

Value enabled /disabled

Parameter Enable debug console on serial port 1

Registry system.kernel.bootparams.serial_console_deb

ug

Value enabled /disabled

Parameter Limit CPU core usage (0 means no limit)

Registry system.kernel.bootparams.maxcpus

Type Integer

Value 0

Parameter Set maximum allowed cstate on intel cpus
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Registry system.kernel.bootparams.max_cstate

Range [No limit] [1] [2] [3] [4] [5] [6]

Info: Do not limit Intel cstate.

Parameter IOMMU usage setting

Registry system.kernel.bootparams.iommu

Range [On] [Off] [Passthrough] [Force]

Info: Use IOMMU if possible.

Parameter IOMMU usage setting for AMD systems

Registry system.kernel.bootparams.amd_iommu

Range [On] [Off]

Info: Use IOMMU if possible.

Parameter IOMMU usage setting for Intel systems

Registry system.kernel.bootparams.intel_iommu

Range [On] [Off]

Info: Use IOMMU if possible.

Added a possibility to configure scheduled commands. Registry keys: system.cron.**
Buddy update enhancements:

Automatic load balancing:
A client collects up to eight server candidates from which one is selected randomly. 
Collection stops when the number specified in the following registry key is reached. 
Otherwise collection stops after a timeout.
More...

Parameter Buddy Update Server Candidates

Registry update.ftp.buddy_server_candidates

Value 1

Grouping:
Buddy update servers and clients only interact with each other when they are in the same 
group determined by the following registry key (a non-negative integer number). This 
feature is mainly useful when different firmware versions shall be used in parallel.
More...

Parameter Buddy Group ID
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Registry update.ftp.buddy_group_id

Value 0

Updated libwebkit2gtk-4.0-37 to version 1.24.2. 
Security fixes:
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251,
CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378,
CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345,
CVE-2018-4386, CVE-2018-4372

Updated Fluendo multimedia codecs to the following versions:
More...

gst-fluendo-aacdec 21/03/2019 0.10.39

gst-fluendo-asfdemux 21/03/2019 0.10.89

gst-fluendo-h264dec 21/03/2019 0.10.53

gst-fluendo-mp3 21/03/2019 0.10.39

gst-fluendo-mpeg4video 21/03/2019 0.10.43

gst-fluendo-vadec 21/03/2019 0.10.208

gst-fluendo-wmadec 21/03/2019 0.10.68

gst-fluendo-wmvdec 20/03/2019 0.10.65

Added a package ldap-utils which can be used by custom scripts.

Driver

Updated DisplayLink driver to version 5.1.26.
Updated Philips Speech Driver to version 12.7.11 - added support for Philips AirBridge.
Added registry keys to modify the Intel graphic driver usage of framebuffer compression and
power management. 
New registry keys:
More...

Parameter Power saving display C-States to use

Registry x.drivers.intel.dc_setting

Range [Default] [Disable] [Up to DC5] [Up to DC6]

Info: "Default" - driver default 

Parameter Use framebuffer compression
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Registry x.drivers.intel.fbc_setting 

Range [Default] [Disable]

Info: "Default" - driver default 

Updated signotec Citrix Virtual Channel driver to version 8.0.8.
Updated deviceTRUST Client to version 19.1.200. These are the release notes:
Welcome to the release of the deviceTRUST 19.1.200 IGEL client, providing the context of IGEL thin 
client and UD Pocket devices into your virtual sessions. This release includes support for logical 
disks attached to the IGEL endpoint, plus bug fixes and stability improvements over the previous 
19.1.100 release.

Logical Disks
We’ve added support for real-time properties representing the LOGICAL DISKS attached to the 
IGEL endpoint. This includes:
More...

DEVICE_LOGICALDISK_X_TYPE – Either Fixed or Removable.
DEVICE_LOGICALDISK_X_LABEL – The volume label.
DEVICE_LOGICALDISK_X_FILESYSTEM – The type of file system.
DEVICE_LOGICALDISK_X_PATHS – The paths that the disk is mounted.
DEVICE_LOGICALDISK_X_TOTALMB – The total space available on the disk. This property is only available for 
mounted disks.
DEVICE_LOGICALDISK_X_FREEMB – The free space available on the disk. This property is only available for 
mounted disks.
DEVICE_LOGICALDISK_X_NAME – The name of the underlying physical disk.
DEVICE_LOGICALDISK_X_VENDORID – The vendor identifier uniquely identifying the manufacturer. This 
property is only available for USB or PCI connected devices.
DEVICE_LOGICALDISK_X_PRODUCTID – The product identifier uniquely identifying the product. This 
property is only available for USB or PCI connected devices.
DEVICE_LOGICALDISK_X_SERIALNUMBER – The serial number of the physical disk.
DEVICE_LOGICALDISK_X_BUSTYPE – The storage bus type linked to the physical disk.
DEVICE_LOGICALDISK_COUNT – The number of logical disks.

X11 system

Updated Xorg server from 1.19.6 to 1.20.5 version.
Updated Virtualbox from 5.2.18 to 6.0.8 version.
Updated Mesa from 18.2.1 to 19.0.8 version.
Updated Nvidia driver from 410.93 to 418.56 version.
Updated Xorg video and input driver to current upstream versions.
Added new options for laptop lid handling dependent on power supply:
More...

Parameter Lid close action while plugged in
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Registry system.actions.lid.ac43

Range [Turn off display] [Suspend]

Parameter Lid close action while not plugged in

Registry system.actions.lid.battery

Range [Turn off display] [Suspend]

The new Display Switch tool can use multiple different profiles, automatically chosen at runtime 
depending on the currently connected monitors.
A profile is created, when the current monitor layout/resolution is configured via the Display 
Switch utility. The profile will be associated with the current connected displays automatically 
(manufacturer, model and used connector are used for allocation) and if applicable, the state of 
the laptop lid. The setup will be restored by hot-(un)plugging known displays, means the system 
will automatically switch to the already configured profile.
The Display Switch utility itself got a new interface. All base functionalitycan be configured via 
Drag&Drop.
An example workflow:

Connect the hardware and close/open the lid.
Open the Display Switch Utility:
- A quick (simple) setting can be selected directly.
- Should the desired use case be different from the provided choices, the `Advanced´ 
button opens a drag&drop interface for further settings.
In this interface the displays can be dragged and dropped for the intended configuration. 
The display will snap adjacent to others.
If a display should not be used, it can be dragged to the `Disabled´ area on the top right - 
the screen will be reactivated when it is dragged back to the active area.
To show the same content on multiple displays, one display should be dragged onto 
another active screen. The interface will show "Mirror". The mirroring monitor will be 
displayed on the lower right.
With the 'Apply' button the current state will be set, with `Yes´ on the "Keep configuration" 
dialog the current settings will be saved to persistent storage and associated with the 
profile.
Advanced functionality (panning/scaling/resolutions) can be configured in drop-down 
boxes, hidden in a drawer on the right side. The drawer can be expanded by clicking the '<' 
button on the right edge.
For the Display Switch functionality the following parameters should be enabled for proper 
usage:
More...

IGEL Setup > Accessories > Display Switch > Options

Parameter Preserve settings over reboot

http://system.actions.lid.ac
http://system.actions.lid.ac
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Registry sessions.user_display0.options.preserve_sett

ings

Value enabled / disabled

IGEL Setup > Accessories > Display Switch > Options

Parameter Smart display configuration

Registry x.auto_associate

Value enabled / disabled

The IGEL Display Switch utility is now usable for NVIDIA graphics devices as well.
Added a new parameter to optionally start with opened 'Advanced' drawer in Display Switch.
More...

IGEL Setup > Accessories > Display Switch > Options

Parameter Preserve settings over reboot

Registry sessions.user_display0.options.preserve_settin

gs

Value enabled / disabled

IGEL Setup > Accessories > Display Switch > Options

Parameter Start with the advanced drawer opened

Registry sessions.user_display0.options.start_open

Value enabled / disabled

Added xprintidle tool to firmware.
Added some registry keys to disable loading of DRM kernel modules (graphic).
More...

Parameter Disable the loading of the RADEON DRM driver.

Registry x.drivers.ati.disable 

Value "0"

Parameter Disable the loading of the AMDGPU DRM driver.

Registry x.drivers.amdgpu.disable

Value "0"
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Parameter Disable the loading of the i915 DRM driver.

Registry x.drivers.intel.disable

Value "0"

Parameter Disable the loading of the NVIDIA kernel driver.

Registry x.drivers.nvidia.disable

Value "0"

Parameter Disable the loading of the NOUVEAU DRM driver.

Registry x.drivers.nouveau.disable

Value "0"

Parameter Disable the loading of the QXL DRM driver.

Registry x.drivers.qxl.disable

Value "0"

Parameter Disable the loading of the VMGFX DRM driver.

Registry x.drivers.vmware.disable

Value "0"

Parameter Disable the loading of the VBOXVIDEO DRM driver.

Registry x.drivers.vboxvideo.disable

Value "0"

Added the possibility to change an embedded DisplayPort to a normal DisplayPort.
More...

Parameter Use embedded displayport as normal displayport

Registry x.drivers.intel.edp_is_dp

Range [default][enable][disable]

Info: Reboot required

Java

Replaced Oracle JRE by AZUL's Zulu JRE.
Removed deprecated Java WebStart since it is not supported with non-Oracle JRE's.

X server
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Updated Xephyr x session to version 1.20.5.

Hardware

Added hardware support for HP t530.
Added hardware support for HP Compaq Elite 8300.
Added hardware support for HP EliteDesk 800 G3 mini.
Added hardware support for HP EliteDesk 800 G3 SFF.
Added hardware support for HP EliteDesk 800 G1 SFF.
Added hardware support for Fujitsu Esprimo Q957.
Added hardware support for Dell OptiPlex 9020.
Added hardware support for Dell Latitude E6440.
Added hardware support for the following headsets:
More...

Jabra Engage 50;
Jabra Engage 65;
Jabra Engage 75;
Jabra Evolve 30 II (Ver. B);
Jabra Evolve 30 II (Ver. C);
Jabra Evolve 40 (Ver. B) - USB-C;
Jabra Evolve 40 (Ver. D);
Jabra Evolve 65; 
Jabra Evolve 75;
Plantronics Voyager 5200 UC;
Plantronics Voyager 6200 UC;
Plantronics Voyager 8200 UC;
Sennheiser SC70.

Remote Management / IGEL Cloud Gateway

Connection order between UMS and ICG can now be configured.
More...

Parameter Prefer UMS over ICG

Registry system.remotemanager.icg_try_ums_conne

ct

Value enabled / disabled

When an ICG connection is configured and the parameter is enabled, the device tries to connect 
directly to UMS. If the connection was established successfully, the device is managed by UMS and 
not over ICG until new start of the device or networking.

Firmware update scheduled on shutdown is now invoked on reboot as well.
Added some adaptations in UMS Agent concerning migration to IGEL OS11.
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Resolved Issues 10.06.100
Citrix

Now ica.pnlogin.syncpasswordwithxscrnsvr is removed, ica.pnlogin.syncpasswordwithxlock
should be used, this provides the same functionality.
Fixed online meeting in VDI: An enabled webcam will not cut the audio streaming anymore.
Citrix Workspace App 19.03: Improved USB redirection handling.
Custom icons now are visible after StoreFront logon using Citrix authentication method.
Appropriate icons arise with IGEL and Citrix authentication.
Fixed stability issues with Citrix Browser Content Redirection.
Updated the Nuance virtual channel for ICA up to version B301.

RDP/IGEL RDP Client 2

Added Negotiate:Kerberos as fallback if NTLM is disabled. This only works if Active Directory/
Kerberos Logon is enabled.
Added registry key to use rdpglobal window settings for remote apps.
More...

Parameter Enable global window settings for remote app

Registry rdp.winconnect.enable-global-window-settings-for-

remote-app

Value enabled / disabled

Fixed empty warning window being shown when closing RDP Web Applications started from 
browser.
Fixed smartcard redirection in RDP: SCardGetAttrib was failing if pbAttr was NULL. The fix should 
help running Dutch Zorg-ID applications.

RD Web Access

Fixed RD Web Access not working with special characters in name or password. This only works 
if Active Directory/Kerberos Logon is enabled.
Fixed empty warning dialogs appearing when opening RD Web Application in the browser.
Fixed not starting RDP Remote Applications.

VMware Horizon

Fixed Optimization for Skype for Business.
Fixed the configuration choice to use the relative mouse feature.

Parallels Client

Updated Parallels Client to version 16.5.3 (64-Bit).
Fixed: Maximized windows for published applications can be displayed incorrectly.
Fixed: Incorrect user credentials can be picked up during connection if the same farm is 
registered in the client multiple times and with different user credentials.
Fixed: Client did not accept universal printing policies set from the server.
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Fixed: Module opened in the background and blocked the launcher in some cases.
Fixed: Redirected smartcard did not work in a remote session.
Fixed: Printers would not redirect to a remote session when redirection is enforced via policies.

PowerTerm

Fixed editing of parameter sessions.powerterm\<INST>.logindialog.loginscript in Setup 
Registry: now multiple lines are possible.
PowerTerm Terminal Emulation: remove obsolete SSH type SSH1 and obsolete SSH cipher DES
from parameter ranges.

Firefox

Fixed an issue where Firefox does not accept proxy credentials from setup.
Fixed the print hotkey disable option with Firefox 60+.
Fixed browserglobal.app.local_subdirs_whitelist not working.
Fixed Adobe Flash Player download possibility.

Network

Improved SCEP client robustness:
- The cert_agent script doesn't terminate anymore when a problem occurs (e.g. the SCEP server is 
unreachable) but tries again after the expiry check interval.
- When the client certificate has expired, there is still one attempt at renewing it. However, when 
that fails, a new one is requested. That obviously will fail if the client presents a challenge 
password that is not valid anymore.
Restoring WLAN/WWAN Modem state after wakeup from standby or reboot.
Improved expire time of Ethernet no-link notification.
Added all Ethernet network drivers from OS to LX version.
Changed e1000e driver to out of tree version 3.4.2.3 directly from Intel.
Changed igb driver to out of tree version 5.3.5.22 directly from Intel.
Fixed bug: Failure to reach SCEP server in the client certificate renewal phase resulted in loss of 
SCEP server and client certificates.
SCEP: A change of the CA fingerprint setting does not result in discarding all SCEP data 
anymore if the fingerprint matches that of the current CA certificate. Firmware versions before 
10.05.100 allowed an empty fingerprint. So, this is meant for users who must belatedly configure 
the fingerprint in order for client certificate renewal to work. 
A change of the CAIdentifier setting is not detected immediately and does not result in discarding 
all current data anymore. The new CAIdentifier will, however, be used in future SCEP operations.
Fixed instability with netmounts with static ip configuration.
Fixed problems with windows share mounts.
Fixed MBB router configuration (broken since 10.05.500).
Added a possibility to switch between third-party and kernel Intel IGB network driver. 
A new registry key:
More...

Parameter Use thirdparty igb kernel module

Registry network.drivers.igb.prefer_thirdparty
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Range [Auto] [Yes] [No]

Info: "Auto" (use thirdparty in most cases)

Added a possibility to switch between thirdparty and kernel Intel E1000E network driver.
A new registry key:
More...

Parameter Use thirdparty e1000e kernel module

Registry network.drivers.e1000e.prefer_thirdpar

ty

Range [Auto] [Yes] [No]

Info: "Auto" (use thirdparty in most cases)

Added a possibility to switch between thirdparty r8168 and kernel r8169 realtek network 
driver. 
A new registry key:
More...

Parameter Use thirdparty r8168 kernel module

Registry network.drivers.r8169.prefer_r8168

Range [Auto] [Yes] [No]

Info: "Auto" (use r8168 in most cases)

Added a possibility to choose the variant of the realtek r8168 driver. 
A new registry key:
More...

Parameter Choose realtek r8168 variant (only if "prefer r8168" is chosen)

Registry network.drivers.r8169.r8168_variant

Range [Default] [No NAPI] [NAPI]

Info: "Dafault" (use NAPI in most cases)

Fixed bug: Second Ethernet interface did not get configured when the first one was disabled.
Fixed 802.1X Ethernet configuration with user interaction.

WiFi

Fixed bug: WiFi connection to hidden SSID did not work anymore after re-editing with the 
Wireless Manager.
Fixed not working Broadcom SDIO WLAN cards as present in Advantech AIM8IAC device for 
example.

Smartcard
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Fixed Dell KB813 Smartcard Keyboard in combination with certain smart cards driven by OpenSC 
PKCS#11 module. Before this fix, authentication to Citrix StoreFront and VMWare Horizon failed.
Improved handling of PIV/CAC smart cards in OpenSC.
Updated cryptovision sc/interface PKCS#11 smart card library to version 7.1.20. 
Changes in this revision:
- Fixed a possible deadlock in the PKCS#11 module on Linux if C_Finalize is called during a PCSC 
event, for example, C_WaitForSlotEvent.
- ROCA check in the Smartcard Manager, based on the "ROCA detection tool", see https://
github.com/crocs-muni/roca.
- Renaming container label in Smartcard Manager with F2 now possible.
Fixed OpenSC setting max_send_size for reader driver pcsc in /etc/opensc/opensc.conf.

Application Launcher

Fixed confusion in nameserver list caused by comments in /etc/resolv.conf.

Base system

Fixed: Zotac Zbox will not shutdown.
Fixed issues with gen4/5 Intel graphic driver in kernel 4.18.20.
Fixed Screensaver and Screenlock timeouts to be independent. This means, if both timeouts are 
set, the start of Screenlock will not reset the Screensaver timeout any more.
Fixed retrieving of serial number of a display.
Fixed playback of AAC coded audio streams on IGEL Zero products.
Do not auto-start UD-Pocket license browser when the device has a proper license.
Added possibility to set intel_idle.max_cstate kernel cmdline parameter with registry keys to 
work against Intel CPU freezes.
Enhanced handling of Unit ID. The persistent Unit ID can be removed with command 
get_unit_id -r . The persistent Unit ID storage can be forced with get_unit_id -i -f 

-p  or with get_unit_id -m  to manually choose a Unit ID from several network interfaces 
found on the device. Handle with extreme care since the Unit ID is the key for handling the 
endpoint in UMS.
Replaced MIT Kerberos clients by Heimdal Kerberos clients.
Improved the buddy update server performance for multiple simultaneous update clients.
Fixed handling of an "update on shutdown" during suspend/resume.
Fixed NVIDIA driver kernel warning messages.
Allow to configure NVIDIA graphics cards (rotation/resolution) via Setup again.
Fixed shutdown while IGEL Setup Assistant is shown.
Fixed delay in logon as local user when logon with IGEL Smartcard is also active.
Fixed sporadic bootsplash issue.
Fixed suspend/resume hangs when logged into Citrix sessions.
Fixed CPU scaler and volume control applet suspend/resume issue.
Added AppArmor rule to allow tcpdump to write to /debuglog.
Fixed random 90 seconds shutdown delay (systemd).
Fixed Custom Bootsplash installation.
Bugfix: Create shortcuts for terminal shutdown, terminal restart and icon sort directly after 
reconfiguration. A reboot is not needed anymore.
Fixed: System logoff waits for Citrix logoff now.

https://github.com/crocs-muni/roca
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Fixed broken custom bootsplash when doing a reset to factory defaults via UMS.
Bugfix: hotkey setting needs restart.
IGEL Setup Assistant will persistently activate WiFi when a connection is enabled instead of after 
finishing it, to preserve settings when UMS sends license and stops it.
Fixed AD/Kerberos logon in case parameter auth.login.krb5_enterprise is set to 'false'.
Added a new registry key to set USB quirks:
More...

Parameter Set XHCI USB quirks to fix some hardware issues

Registry system.kernel.bootparams.xhci-hcd_quirks

Range [No quirk] [Spurious Reboot quirk] [Spurious Wakeup quirk] 
[Spurious Reboot Wakeup quirk] 

Lenovo ThinkCentre M73 needs the system.kernel.bootparams.xhci-hcd_quirks
registry key set to "Spurious Reboot quirk" to fix reboot after shutdown problem.
Fixed: Migration tool did not start with Spanish language setting.
Disabled martian packet logging.

Driver

Updated deviceTRUST Client to version 19.1.200.
Bug Fixes:

Fixed an issue reading the DEVICE_IGEL_ICG_SERVER property.
Fixed an issue where the NETWORK and LOCATION property providers could cause the 
client to freeze if a disconnection occurred while these property providers were checking 
for changes.
Fixed an open file handle leak which lead to the client process reaching its file handle 
limits when left running for a long period of time.

Fixed not working WACOM device DTU-1141B.

Custom Partition

Fixed ownership of extracted data: Do not preserve owner information while extracting data into 
custom partition.

Storage Devices

Fixed auto mounting of storage devices inside of Olympus DS-9500 Digital Voice Recorder.

Appliance Mode

Fixed bug: In-session control bar could not be deactivated in Citrix SelfService appliance mode.

X11 system

Fixed Microsoft Surface Pro 4 screen resolution issue.
Fixed the missing volume control in the panel when the panel is configured to disappear while 
the login/lock screen is shown.
There is now a registry key to ignore a 3Dconnexion SpaceMouse for IGEL graphical use (X11). If 
activated, the SpaceMouse is only passed through to the desktop session. If false, it acts also as the 
standard mouse.
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More...

Parameter Deactivates a 3Dconnexion SpaceMouse as a standard mouse

Registry userinterface.mouse.spacemouse.x11_ignore

Value enabled / disabled

The following SpaceMouse products are included:
More...

VID PID Vendor Product

0x046D 0xC603 Logitech, Inc. 3Dconnexion SpaceMouse Plus XT

0x046D 0xC605 Logitech, Inc. 3Dconnexion CADman

0x046D 0xC606 Logitech, Inc. 3Dconnexion SpaceMouse Classic

0x046D 0xC621 Logitech, Inc. 3Dconnexion SpaceBall 5000

0x046D 0xC623 Logitech, Inc. 3Dconnexion SpaceTraveller 3D Mouse

0x046D 0xC625 Logitech, Inc. 3Dconnexion SpacePilot 3D Mouse

0x046D 0xC626 Logitech, Inc. 3Dconnexion SpaceNavigator 3D Mouse

0x046D 0xC627 Logitech, Inc. 3Dconnexion SpaceExplorer 3D Mouse

0x046D 0xC628 Logitech, Inc. 3Dconnexion SpaceNavigator for Notebooks

0x046D 0xC629 Logitech, Inc. 3Dconnexion SpacePilot Pro 3D Mouse

0x046D 0xC62B Logitech, Inc. 3Dconnexion SpaceMouse Pro

0x256F ** 3Dconnexion SpaceMouse

Fixed screen flicker in some cases if Force NumLock On (x.global.forcenumlock) is active.
Fixed not working x.xserver0.screen1.flipscreens registry key.
Fixed problems with internal graphic cards and NVIDIA graphic cards.
Use Index and Mode from Advanced mode in Simple Mode for Display Switch.
Fixed display hotplug failing on initial lock screen with Active Directory logon.
The in-session control bar now scales with the current DPI setting.
Fixed Display Switch utility not starting with some translations.
Fixed an issue with the noDDC mode not always working as expected.
Fixed some multimonitor (>4) issues with NVIDIA graphic cards.
Fixed monitor screen ID shown with NVIDIA NV810 GPU.
Fixed a bug with thin clients reporting the wrong monitor serial number.

Window manager

Fixed the option to disable the local window manager.

Audio
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Fixed bad quality sound over DisplayPort in a Citrix ICA session or other applications using ALSA 
API.
Fixed jack detection of the headphone port in Dell Wyse 3040.
Fixed configuration of default audio output and input.

Media Player (Parole)

Fixed a problem where parole media player would hang instead of playing audio while audio-
visualization is enabled.
Fixed parole media player not handling audio hotkeys in fullscreen mode.

Multimedia

Updated multimedia codecs to fix freeze when audio visualization is used.

Misc

Monitoring Agent uses now only the half size of the debuglog partition. 
When the setup option log_max_size with the option log_rotation creates an overall 
consumption that is bigger than 50% of the debuglog partition size, the size for each log 
automatically will be decreased to a value that allows a full rotation which occupies exactly 50% of 
the partition size.

Hardware

Fixed wrongly detected embedded DisplayPort on Dell Wyse 5070 Extended hardware.
Fixed wakeup from suspend for Lenovo Ideapad 320-15IAP.
Fixed not working network on Beckhoff CB3163, CB6263 and CB6363 systems.
Fixed not working network on Lex 3I380D.
Fixed shutdown issue of Lenovo ThinkCentre M73 (rebooted 2 - 3 seconds after power off).
Fixed problems with mouse cursor on Intel cherryview devices.
Fixed detection of Dell Wyse 5070 for the non-extended version.
Fixed not working Laptop Display for Dell Latitude E5510.
Added a possibility to change some DRM settings and limit the DisplayPort lane bandwidth on 
Intel devices.
Added new registry keys:
More...

Parameter Use best graphic mode for all screens on console.

Registry x.drivers.kms.best_console_mode

Range [Default] [Enabled] [Disabled]

Info: "Default" is enabled in most cases.

Parameter Limit the maximum console resolution width to this value.

Registry x.drivers.kms.max_console_width

Type Integer

Value "0"
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Info: "0" means default setting. Use the default setting.

Parameter Limit the maximum console resolution height to this value.

Registry x.drivers.kms.max_console_height

Type Integer

Value "0"

Info: "0" means default setting. Use the default setting.

Parameter Set graphic kernel driver debug level.

Registry x.drivers.kms.debug_level

Range [No debug] [Basic] [Basic + core] [Basic + core + atomic] [Full]

Info: Warning log will grow very fast.

Only for Intel i915 driver:

Parameter Limit the maximum DisplayPort lane link rate.

Registry x.drivers.intel.max_dp_link_rate

Range [default] [1.62Gbps] [2.16Gbps] [2.7Gbps] [3.24Gbps]
[4.32Gbps] [5.4Gbps] [6.48Gbps] [8.1Gbps]  

Info: "Default" means hardware default limit.

Remote Management / IGEL Cloud Gateway

Fixed wallpaper configuration when ICG protocol is used.
Fixed UMS synchronization of configuration when changes were made in "Emergency mode".
Fixed sporadic failures while sending data over ICG.
Fixed removal from UMS when the device was offline.
Added: IGEL UMS agent sends monitor information for maximum eight monitors now.

Caradigm

Fixed Horizon session crash.
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Notes for Release 10.05.830
Software: Version 10.05.830

Release Date: 2019-07-05

Release Notes: Version RN-105830-1

Last update: 2019-07-05

IGEL Linux Universal Desktop (see page 1074)
IGEL Universal Desktop OS 3 (see page 1098)



Notes for Release 10.05.830

IGEL OS Release Notes   1074 / 1492

•
•
•
•
•

IGEL Linux Universal Desktop

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD3-LX 42

UD3-LX 41

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Component Versions 10.05.830 (see page 1076)
General Information 10.05.830 (see page 1080)
Known Issues 10.05.830 (see page 1081)
New Features 10.05.830 (see page 1083)
Resolved Issues 10.05.830 (see page 1093)
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Component Versions 10.05.830
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.3.0.5

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.7.2

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_202

Parallels Client (64 bit) 16.5.2.20595

Remote Viewer (RedHat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0

Systancia AppliDis 4.0.0.17
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Thinlinc Client 4.9.0-5775

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel16

VMware Horizon Client 4.10.0-11053294

VNC Viewer 1.8.0+git20180123-igel1

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.6.36

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.5

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5
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Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.28

Reader Driver REINER SCT cyberJack 3.99.5final.SP11

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.13

OpenSSH Client 7.2p2-4ubuntu2.4

OpenSSH Server 7.2p2-4ubuntu2.4

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.2.1-1igel51

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20181113-igel846

Graphics Driver ATI/RADEON 18.0.1-1igel831

Graphics Driver ATI/AMDGPU 18.0.1-1igel831

Graphics Driver VIA 5.76.52.92-009-005f78-20150730

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.3.4-1build2igel639

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver VMmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-ud-r2755

Xorg X11 Server 1.19.6-1ubuntu4igel838

Xorg Xephyr 1.19.6-1ubuntu4igel832

CUPS printing daemon 2.1.3-4ubuntu0.7igel23
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PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel653

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2igel1

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.2-1ubuntu1igel192

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.1
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General Information 10.05.830
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4;
Citrix Access Gateway Standard Plug-in;
Dell vWorkspace Connector for Linux;
Ericom PowerTerm Emulation 9 and 11;
Ericom Webconnect;
IGEL Legacy RDP Client (rdesktop);
Virtual Bridges VERDE Client;
PPTP VPN Support;
IGEL Upgrade License Tool with IGEL Smartcard Token;
Remote Management by setup.ini file transfer (TFTP);
Remote Access via RSH;
Legacy Philips Speech Driver;
t-Systems TCOS Smartcard Support;
DUS Series touchscreens;
Elo serial touchscreens;
IGEL smartcard without locking desktop;
Video Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10;
H.264 Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10;
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon;
by an icon in the 'In-Session Control Bar' (configurable at IGEL Setup > User Interface > 
Desktop);
by a 'Safely Remove Hardware' session (configurable at IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel;
Open VPN Smartcard Support;
Asian Input Methods;
Composite Manager.
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Known Issues 10.05.830
Citrix

With activated DRI3 and an AMD GPU, Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with gstreamer1.0 which describe problems with multimedia redirection 
of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
When using Citrix Workspace App 18.10 in combination with Philips Speech driver, the session 
occasionally terminates improperly at logout and hangs. 
As a workaround, the usage of Citrix Receiver 13.10 is recommended when Philips Speech driver 
is needed.
Citrix H.264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
When Expand the session over a self-selected number of monitors (for Multimonitor full-
screen mode) is used and Setup is restarted, Restrict full-screen session to one monitor is 
indicated and the monitor selection is greyed out. The functionality is available, only the 
notification in setup is broken.
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration 
plugin, the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and H264 acceleration

Registry ica.workaround-dual-rtme

Range enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory / media as a drive. Then the external devices will show up inside 
the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client, drive mapping can be found under Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable drive mapping.
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It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug.
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. 
Furthermore, Horizon Client relies on the OS to mount the storage device itself. Enable local 
Storage Hotplug under Setup >Devices > Storage Devices > Storage Hotplug.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In some cases, there are instabilities when using A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Hardware

Suspend on UD10 is disabled.
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New Features 10.05.830
Citrix

Added support for Citrix Workspace Launcher functionality as described at https://
support.citrix.com/article/CTX237727.
Updated Citrix HDX RTME used for optimization of Skype for Business to version 2.8.0-2235.
Integrated Citrix Workspace App 19.03.
Added: new registry key supports 1536-bit RSA keys for client authentication.
More...

Parameter Enable RSA 1536 cipher suite

Registry ica.allregions.enabl_rsa_1536

Range factory default / false / true

Added: new registry key to enable different cipher suites client authentication.
More...

Parameter Enables different cipher suites

Registry ica.allregions.sslciphers

Range factory default / ALL / GOV / COM

Info:
TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA – COM/ALL

VMware Horizon

Added possibility to easily evaluate Horizon Blast decoder states. By default, sessions are 
evaluated after the use and the result is put to the journal log. But it can also be used with GUI 
notifications at runtime.

Driver

Added registry keys to modify the Intel graphic driver usage of framebuffer compression and 
power management. 
New registry keys:
More...

Parameter Power saving display C-States to use.

Registry x.drivers.intel.dc_setting

Range [Default] [Disable] [Up to DC5] [Up to DC6]

Info: "Default" - driver default 

https://support.citrix.com/article/CTX237727
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Parameter Use framebuffer compression.

Registry x.drivers.intel.fbc_setting 

Range [Default] [Disable]

Info: "Default" - driver default 

X11 system

Added some registry keys to disable loading of DRM kernel modules (graphic).
New registry keys:
More...

Parameter Disable the loading of the RADEON DRM driver.

Registry x.drivers.ati.disable 

Value "0"

Parameter Disable the loading of the AMDGPU DRM driver.

Registry x.drivers.amdgpu.disable

Value "0"

Parameter Disable the loading of the i915 DRM driver.

Registry x.drivers.intel.disable

Value "0"

Parameter Disable the loading of the NVIDIA kernel driver.

Registry x.drivers.nvidia.disable

Value "0"

Parameter Disable the loading of the NOUVEAU DRM driver.

Registry x.drivers.nouveau.disable

Value "0"

Parameter Disable the loading of the QXL DRM driver.

Registry x.drivers.qxl.disable

Value "0"

Parameter Disable the loading of the VMGFX DRM driver.
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Registry x.drivers.vmware.disable

Value "0"

Parameter Disable the loading of the VBOXVIDEO DRM driver.

Registry x.drivers.vboxvideo.disable

Value "0"

IBM_5250

Improved startup time of IBM iAccess Client.
Improved configuration of IBM iAccess Client via IGEL Setup.
More...

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Connection > Advanced

Parameter Bypass signon

Registry sessions.iaccess<NR>.options.ssoenabled

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Font

Parameter Antialiasing

Registry sessions.iaccess<NR>.options.textantialiasing

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Allow blinking cursor

Registry sessions.iaccess<NR>.options.blinkcursor

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Show blinking text with

Registry sessions.iaccess<NR>.options.blinkstate

Value  [Blinking Text] [Host Color] [Mapped Color]
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Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Blink Color

Registry sessions.iaccess<NR>.options.blinkcolor_fg

Value #ffc800

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Blink Color Background

Registry sessions.iaccess<NR>.options.blinkcolor_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Rule Line

Registry sessions.iaccess<NR>.options.ruleline

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Follow Cursor

Registry sessions.iaccess<NR>.options.rulelinefollows

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Style

Registry sessions.iaccess<NR>.options.rulelinestyle

Value [Crosshair] [Vertical] [Horizontal]

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Green

Registry sessions.iaccess<NR>.options.color_fgn_fg
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Value #00ff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Green Background

Registry sessions.iaccess<NR>.options.color_fgn_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter White

Registry sessions.iaccess<NR>.options.color_fwt_fg

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter White Background

Registry sessions.iaccess<NR>.options.color_fwt_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Red

Registry sessions.iaccess<NR>.options.color_frd_fg

Value #ff0000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Red Background

Registry sessions.iaccess<NR>.options.color_frd_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Turquoise
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Registry sessions.iaccess<NR>.options.color_ftq_fg

Value #00ffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Turquoise Background

Registry sessions.iaccess<NR>.options.color_ftq_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Yellow

Registry sessions.iaccess<NR>.options.color_fyw_fg

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Yellow Background

Registry sessions.iaccess<NR>.options.color_fyw_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Pink

Registry sessions.iaccess<NR>.options.color_fpk_fg

Value #ff00ff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Pink Background

Registry sessions.iaccess<NR>.options.color_fpk_bg

Value #000000
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Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Blue

Registry sessions.iaccess<NR>.options.color_fbl_fg

Value #7890f0

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Blue Background

Registry sessions.iaccess<NR>.options.color_fbl_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Status Indicators

Registry sessions.iaccess<NR>.options.color_osi

Value #7890f0

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Information Indicators

Registry sessions.iaccess<NR>.options.color_oii

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Attention Indicators

Registry sessions.iaccess<NR>.options.color_oai

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Error Indicators

Registry sessions.iaccess<NR>.options.color_oei
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Value #ff0000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter OIA Background

Registry sessions.iaccess<NR>.options.color_oob

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Screen Background

Registry sessions.iaccess<NR>.options.color_sbg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Highlight active field

Registry sessions.iaccess<NR>.options.actfieldhilite

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Active Field

Registry sessions.iaccess<NR>.options.color_actf_fg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Active Field Background

Registry sessions.iaccess<NR>.options.color_actf_bg

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Crosshair Ruler Color
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Registry sessions.iaccess<NR>.options.color_crc

Value #00ff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Column Separator

Registry sessions.iaccess<NR>.options.color_ccs

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences

Parameter Start window maximized

Registry sessions.iaccess<NR>.options.ismaximized

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Keyboard

Parameter Keyboard Remapping File

Registry sessions.iaccess<NR>.options.keyremapfile

Value IBMi.kmp

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Popup Keypad

Parameter Popup Keypad File

Registry sessions.iaccess<NR>.options.poppadfile

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Toolbar

Parameter Toolbar File

Registry sessions.iaccess<NR>.options.toolbarfile

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Open new sessions in a new tab

Registry ibm.iaccess.acssm.opensessionintab
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Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Always display the tab bar

Registry ibm.iaccess.acssm.alwaysshowtabbar

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Switch to new tab when created

Registry ibm.iaccess.acssm.switchtonewtab

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Send a warning when closing multiple tabs

Registry ibm.iaccess.acssm.closemultipletabwarning

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Do not start tabbed sessions until the tab is selected

Registry ibm.iaccess.acssm.tabdelayedstart

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter New Tab Action

Registry ibm.iaccess.acssm.newtabaction

Value [Disable and Hide] [Run the Same] [Run Other...] 

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Tab Placement

Registry ibm.iaccess.acssm.tabplacement

Value [Top] [Bottom] [Left] [Right] 
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Resolved Issues 10.05.830
Firefox

Fixed not working browserglobal.app.local_subdirs_whitelist.
Fixed print hotkey disable option with Firefox 60+.

RDP/IGEL RDP Client 2

Fixed smart card redirection in RDP: SCardGetAttrib was failing if pbAttr was NULL. The fix 
should help running Dutch Zorg-ID applications.

VMware Horizon

Fixed: the configuration choice to use the relative mouse feature.

Citrix

Citrix Workspace App 19.03: Improved USB redirection handling.
Issue solved: Online meeting in VDI: "enable webcam will cut the audio streaming".
Fixed stability issues with Citrix Browser Content Redirection.

Citrix Receiver 13

Added a switch to enable the possibility to launch multiple desktop sessions with RTME and 
H264 acceleration. This switch should not be used when "Enable Secure ICA" is active for the 
specific delivery group.
More...

Registry ica.workaround-dual-rtme

Value enabled / disabled

Network

Fixed: The second Ethernet interface did not get configured when the first one was disabled.
Added a possibility to switch between the third party r8168 and kernel r8169 realtek network 
driver.
New registry key:
More...

Parameter Use thirdparty r8168 kernel module.

Registry network.drivers.r8169.prefer_r8168

Range [Auto] [Yes] [No]

Info: "Auto" (use r8169 in most cases)

Added a possibilty to choose the variant of the realtek r8168 driver.
New registry key:
More...
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Parameter Choose realtek r8168 variant (only if prefer r8168 is choosen).

Registry network.drivers.r8169.r8168_variant

Range [Default] [No NAPI] [NAPI]

Info: "Default" (use NAPI in most cases)

Base system

Fixed: System logout waits for Citrix logout now.
Fixed: Migration tool did not start with the Spanish language setting.
Added new registry key to set USB quirks.
More...

Parameter Set XHCI USB quirks to fix some hardware issues.

Registry system.kernel.bootparams.xhci-hcd_quirks

Range [No quirk] [Spurious Reboot quirk] [Spurious Wakeup quirk] 
[Spurious Reboot Wakeup quirk] 

Lenovo ThinkCentre M73 needs the system.kernel.bootparams.xhci-hcd_quirks registry key set 
to "Spurious Reboot quirk" to fix reboot after shutdown problem.

X11 system

There is now a registry key to ignore a 3Dconnexion SpaceMouse for IGEL graphical use (X11). If 
activated, the SpaceMouse is only passed through to the desktop session. If disabled, it acts also 
as the standard mouse.
More...

Parameter Deactivates a 3Dconnexion SpaceMouse as a standard mouse.

Registry userinterface.mouse.spacemouse.x11_ignore

Value enabled / disabled

The following SpaceMouse products are included:
More...

VID PID Vendor Product

0x046D 0xC603 Logitech, Inc. 3Dconnexion SpaceMouse Plus XT

0x046D 0xC605 Logitech, Inc. 3Dconnexion CADman

0x046D 0xC606 Logitech, Inc. 3Dconnexion SpaceMouse Classic

0x046D 0xC621 Logitech, Inc. 3Dconnexion SpaceBall 5000

0x046D 0xC623 Logitech, Inc. 3Dconnexion SpaceTraveller 3D Mouse

0x046D 0xC625 Logitech, Inc. 3Dconnexion SpacePilot 3D Mouse
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VID PID Vendor Product

0x046D 0xC626 Logitech, Inc. 3Dconnexion SpaceNavigator 3D Mouse

0x046D 0xC627 Logitech, Inc. 3Dconnexion SpaceExplorer 3D Mouse

0x046D 0xC628 Logitech, Inc. 3Dconnexion SpaceNavigator for Notebooks

0x046D 0xC629 Logitech, Inc. 3Dconnexion SpacePilot Pro 3D Mouse

0x046D 0xC62B Logitech, Inc. 3Dconnexion SpaceMouse Pro

0x256F ** 3Dconnexion SpaceMouse

USB device reset via USB powercycle is now available on UD6/UD7.
Fixed problems with internal graphic cards and NVIDIA graphic cards.
Fixed Display Switch utility not starting with some translations.
Fixed an issue with the noDDC mode not always working as expected.
Fixed some multimonitor (>4) issues with Nvidia graphic cards.
Updated DisplayLink driver to version 5.1.26 to solve some startup issues.

Driver

Fixed not working WACOM device DTU-1141B.

Hardware

Fixed not working network on Beckhoff CB3163, CB6263 and CB6363 systems.
Fixed not working network on Lex 3I380D.
Fixed black screen issue with some monitors and 2560x1440 resolution (occurred on UD2 LX50).
Added possibility to change some DRM settings and limit the DisplayPort lane bandwidth on 
Intel devices.
Added new registry keys:
More...

Parameter Use best graphic mode for all screens on console.

Registry x.drivers.kms.best_console_mode

Range [Default] [Enabled] [Disabled]

Info: "Default" is enabled in most cases.

Parameter Limit the maximum console resolution width to this value.

Registry x.drivers.kms.max_console_width

Type Integer

Value "0"

Info: "0" means default setting. Use the default setting.

Parameter Limit the maximum console resolution height to this value.
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Registry x.drivers.kms.max_console_height

Type Integer

Value "0"

Info: "0" means default setting. Use the default setting.

Parameter Set graphic kernel driver debug level.

Registry x.drivers.kms.debug_level

Range [No debug] [Basic] [Basic + core] [Basic + core + atomic] [Full]

Info: Warning log will grow very fast.

Only for Intel i915 driver:

Parameter Limit the maximum DisplayPort lane link rate.

Registry x.drivers.intel.max_dp_link_rate

Range [default] [1.62Gbps] [2.16Gbps] [2.7Gbps] [3.24Gbps]
[4.32Gbps] [5.4Gbps] [6.48Gbps] [8.1Gbps]  

Info: "Default" means hardware default limit.
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Security Fixes 10.05.830
Firefox

Updated Mozilla Firefox to version 60.7.2 ESR.
Fixed mfsa2019-19 security issue CVE-2019-11708.
Fixed mfsa2019-18 security issue CVE-2019-11707.
Fixed mfsa2019-10 security issues CVE-2019-9810 and CVE-2019-9813.
Fixed mfsa2019-08 security issues.
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, CVE-2019-9788.

Fixed mfsa2019-05 security issues CVE-2018-18356 and CVE-2019-5785.
Fixed mfsa2019-02 security issues CVE-2018-18500, CVE-2018-18505 and CVE-2018-18501.
Fixed mfsa2018-30 security issues.
More...

CVE-2018-17466, CVE-2018-18492, CVE-2018-18493,
CVE-2018-18494, CVE-2018-18498, CVE-2018-12405.

Base system

Fixed kernel TCP vulnerabilities CVE-2019-11477: SACK Panic, CVE-2019-11478: SACK Slowness 
and CVE-2019-11479: Excess Resource Consumption Due to Low MSS Values.
Changed minimally allowed MSS size to '1000' to prevent possible Denial-of-Service attacks.
Updated libwebkit2gtk-4.0-37 to version 1.24.2.
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251,
CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378,
CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345,
CVE-2018-4386, CVE-2018-4372
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IGEL Universal Desktop OS 3
Supported Hardware:

https://kb.igel.com/igelos/en/devices-supported-by-udc3-and-ud-pocket-3117174.html

Component Versions 10.05.830 (see page 1099)
General Information 10.05.830 (see page 1103)
Known Issues 10.05.830 (see page 1104)
New Features 10.05.830 (see page 1106)
Resolved Issues 10.05.830 (see page 1116)
Security Fixes 10.05.830 (see page 1120)
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Component Versions 10.05.830
Clients
Product Version

Citrix HDX Realtime Media Engine 2.8.0-2235

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 19.3.0.5

deviceTRUST Citrix Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.7.2

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_202

Parallels Client (64 bit) 16.5.2.20595

Remote Viewer (RedHat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0

Systancia AppliDis 4.0.0.17
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ThinLinc Client 4.9.0-5775

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel16

VNC Viewer 1.8.0+git20180123-igel1

VMware Horizon Client 4.10.0-11053294

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Grundig Business Systems dictation driver

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.6.36

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.5

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5
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Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.28

Reader Driver REINER SCT cyberJack 3.99.5final.sp11

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.13

OpenSSH Client 7.2p2-4ubuntu2.4

OpenSSH Server 7.2p2-4ubuntu2.4

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.2.1-1igel51

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20181113-igel846

Graphics Driver ATI/RADEON 18.0.1-1igel831

Graphics Driver ATI/AMDGPU 18.0.1-1igel83

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2igel775

Graphics Driver Nvidia 390.87-0ubuntu1

Graphics Driver Vboxvideo 5.2.18-dfsg-2igel17

Graphics Driver VMware 13.3.0-2igel812

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.3.4-1build2igel639

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver VMMouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813
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Kernel 4.18.20 #mainline-udos-r2755

Xorg X11 Server 1.19.6-1ubuntu4igel838

Xorg Xephyr 1.19.6-1ubuntu4igel832

CUPS Printing Daemon 2.1.3-4ubuntu0.7igel23

PrinterLogic 18.2.1.128

Lightdm Graphical Login Manager 1.18.3-0ubuntu1.1

XFCE4 Window Manager 4.12.3-1ubuntu2igel653

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2igel1

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.2-1ubuntu1igel192

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.1
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General Information 10.05.830
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1-13.4
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini  file transfer (TFTP)
Remote Access via RSH
Legacy Philips Speech Driver
t-Systems TCOS Smartcard Support
DUS Series touchscreens
Elo serial touchscreens
IGEL smartcard without locking desktop
VIA Graphics Support
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon;
by an icon in the 'In-Session Control Bar' (configurable at IGEL Setup > User Interface > 
Desktop);
by a 'Safely Remove Hardware' session (configurable at IGEL Setup > Accessories).

The following clients and features are not available in this release:

Cherry eGK Channel
Open VPN Smartcard Support
Asian Input Methods
Composite Manager
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Known Issues 10.05.830
Citrix

With activated DRI3 and an AMD GPU Citrix H264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer 1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware accelerated H.264 
deep compression codec.
Citrix StoreFront Login with Gemalto smartcard middleware does not detect smartcard 
correctly if the card is inserted after start of login.
As a workaround, insert the smartcard before starting StoreFront Login.
When using Citrix Workspace App 18.10 in combination with Philips Speech driver, the session 
occasionally terminates improperly at logout and hangs. 
As a workaround, the usage of Citrix Receiver 13.10 is recommended when Philips Speech driver is 
needed.
Citrix H264 acceleration plugin does not work with enabled server policy "Optimize for 3D 
graphics workload" in combination with server policy "Use video codec compression" > "For the 
entire screen".
When "Expand the session over a self-selected number of monitors" (for "Multimonitor full-screen 
mode") is used and Setup is restarted, "Restrict full-screen session to one monitor" is indicated 
and the monitor selection is greyed out. The functionality is available, only the notification in 
Setup is broken.
To launch multiple desktop sessions with Citrix HDX RTME and Citrix H.264 acceleration plugin, 
the following registry key must be enabled:
More...

Parameter Activate workaround for dual RTME sessions and H264 acceleration

Registry ica.workaround-dual-rtme

Range enabled / disabled

This workaround is not applicable when "Enable Secure ICA" is active for the specific delivery 
group.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop.
Workaround: map the directory /media as a drive. Then the external devices will show up inside 
the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, if you want to use USB redirection for your storage devices, you should 
note that the USB on-insertion feature is only working if the client drive mapping is 
switched off. 
In the IGEL Setup client drive mapping can be found under Sessions > Horizon Client > 
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Horizon Client Global > Drive Mapping > Enable Drive Mapping. 
It is also recommended to disable local Storage Hotplug under Setup > Devices > Storage 
Devices > Storage Hotplug. 
On the other hand, if you use drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least to deny storage devices by adding a filter to the 
USB class rules. Furthermore, since Horizon Client relies on the OS to mount the storage 
devices itself, go to Setup > Devices > Storage Devices > Storage Hotplug, enable dynamic 
drive mapping and put number of storage hotplug devices to at least 1.

Parallels Client

Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels 
RAS one time with FIPS support disabled.

Smartcard

In some cases, there are instabilities when using A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Base system

Display resolution and rotation could not be changed with NVIDIA GPU driver via tcsetup.

Multimedia

Multimedia redirection with GStreamer could fail with Nouveau GPU driver.
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New Features 10.05.830
Citrix

Added support for Citrix Workspace Launcher functionality as described at https://
support.citrix.com/article/CTX237727.
Updated Citrix HDX RTME used for optimization of Skype for Business to version 2.8.0-2235.
Integrated Citrix Workspace App 19.03.
Added: new registry key supports 1536-bit RSA keys for client authentication.
More...

Parameter Enable RSA 1536 cipher suite

Registry ica.allregions.enabl_rsa_1536

Range factory default / false / true

Added: new registry key to enable different cipher suites client authentication.
More...

Parameter Enables different cipher suites

Registry ica.allregions.sslciphers

Range factory default / ALL / GOV / COM

Info:
TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 – GOV/ALL
TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA – COM/ALL

VMware Horizon

Added possibility to easily evaluate Horizon Blast decoder states. By default, sessions are 
evaluated after the use and the result is put to the journal log. But it can also be used with GUI 
notifications at runtime.

Driver

Added registry keys to modify the Intel graphic driver usage of framebuffer compression and 
power management. 
New registry keys:
More...

Parameter Power saving display C-States to use.

Registry x.drivers.intel.dc_setting

Range [Default] [Disable] [Up to DC5] [Up to DC6]

Info: "Default" - driver default 

https://support.citrix.com/article/CTX237727
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Parameter Use framebuffer compression.

Registry x.drivers.intel.fbc_setting 

Range [Default] [Disable]

Info: "Default" - driver default 

X11 system

Added some registry keys to disable loading of DRM kernel modules (graphic).
New registry keys:
More...

Parameter Disable the loading of the RADEON DRM driver.

Registry x.drivers.ati.disable 

Value "0"

Parameter Disable the loading of the AMDGPU DRM driver.

Registry x.drivers.amdgpu.disable

Value "0"

Parameter Disable the loading of the i915 DRM driver.

Registry x.drivers.intel.disable

Value "0"

Parameter Disable the loading of the NVIDIA kernel driver.

Registry x.drivers.nvidia.disable

Value "0"

Parameter Disable the loading of the NOUVEAU DRM driver.

Registry x.drivers.nouveau.disable

Value "0"

Parameter Disable the loading of the QXL DRM driver.

Registry x.drivers.qxl.disable

Value "0"

Parameter Disable the loading of the VMGFX DRM driver.
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Registry x.drivers.vmware.disable

Value "0"

Parameter Disable the loading of the VBOXVIDEO DRM driver.

Registry x.drivers.vboxvideo.disable

Value "0"

IBM_5250

Improved startup time of IBM iAccess Client.
Improved configuration of IBM iAccess Client via IGEL Setup.
More...

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Connection > Advanced

Parameter Bypass signon

Registry sessions.iaccess<NR>.options.ssoenabled

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Font

Parameter Antialiasing

Registry sessions.iaccess<NR>.options.textantialiasing

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Allow blinking cursor

Registry sessions.iaccess<NR>.options.blinkcursor

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Show blinking text with

Registry sessions.iaccess<NR>.options.blinkstate

Value  [Blinking Text] [Host Color] [Mapped Color]
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Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Blink Color

Registry sessions.iaccess<NR>.options.blinkcolor_fg

Value #ffc800

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Cursor

Parameter Blink Color Background

Registry sessions.iaccess<NR>.options.blinkcolor_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Rule Line

Registry sessions.iaccess<NR>.options.ruleline

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Follow Cursor

Registry sessions.iaccess<NR>.options.rulelinefollows

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Rule Line

Parameter Style

Registry sessions.iaccess<NR>.options.rulelinestyle

Value [Crosshair] [Vertical] [Horizontal]

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Green

Registry sessions.iaccess<NR>.options.color_fgn_fg
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Value #00ff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Green Background

Registry sessions.iaccess<NR>.options.color_fgn_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter White

Registry sessions.iaccess<NR>.options.color_fwt_fg

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter White Background

Registry sessions.iaccess<NR>.options.color_fwt_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Red

Registry sessions.iaccess<NR>.options.color_frd_fg

Value #ff0000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Red Background

Registry sessions.iaccess<NR>.options.color_frd_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Turquoise
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Registry sessions.iaccess<NR>.options.color_ftq_fg

Value #00ffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Turquoise Background

Registry sessions.iaccess<NR>.options.color_ftq_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Yellow

Registry sessions.iaccess<NR>.options.color_fyw_fg

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Yellow Background

Registry sessions.iaccess<NR>.options.color_fyw_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Pink

Registry sessions.iaccess<NR>.options.color_fpk_fg

Value #ff00ff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Pink Background

Registry sessions.iaccess<NR>.options.color_fpk_bg

Value #000000
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Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Blue

Registry sessions.iaccess<NR>.options.color_fbl_fg

Value #7890f0

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Blue Background

Registry sessions.iaccess<NR>.options.color_fbl_bg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Status Indicators

Registry sessions.iaccess<NR>.options.color_osi

Value #7890f0

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Information Indicators

Registry sessions.iaccess<NR>.options.color_oii

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Attention Indicators

Registry sessions.iaccess<NR>.options.color_oai

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Error Indicators

Registry sessions.iaccess<NR>.options.color_oei
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Value #ff0000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter OIA Background

Registry sessions.iaccess<NR>.options.color_oob

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Screen Background

Registry sessions.iaccess<NR>.options.color_sbg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Highlight active field

Registry sessions.iaccess<NR>.options.actfieldhilite

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Active Field

Registry sessions.iaccess<NR>.options.color_actf_fg

Value #000000

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Active Field Background

Registry sessions.iaccess<NR>.options.color_actf_bg

Value #ffff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Crosshair Ruler Color
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Registry sessions.iaccess<NR>.options.color_crc

Value #00ff00

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Screen > Color

Parameter Column Separator

Registry sessions.iaccess<NR>.options.color_ccs

Value #ffffff

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences

Parameter Start window maximized

Registry sessions.iaccess<NR>.options.ismaximized

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Keyboard

Parameter Keyboard Remapping File

Registry sessions.iaccess<NR>.options.keyremapfile

Value IBMi.kmp

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Popup Keypad

Parameter Popup Keypad File

Registry sessions.iaccess<NR>.options.poppadfile

Setup Sessions > IBM iAccess Client > iAccess Sessions > Session Name > 
Preferences > Toolbar

Parameter Toolbar File

Registry sessions.iaccess<NR>.options.toolbarfile

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Open new sessions in a new tab

Registry ibm.iaccess.acssm.opensessionintab
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Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Always display the tab bar

Registry ibm.iaccess.acssm.alwaysshowtabbar

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Switch to new tab when created

Registry ibm.iaccess.acssm.switchtonewtab

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Send a warning when closing multiple tabs

Registry ibm.iaccess.acssm.closemultipletabwarning

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Do not start tabbed sessions until the tab is selected

Registry ibm.iaccess.acssm.tabdelayedstart

Value true/ false

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter New Tab Action

Registry ibm.iaccess.acssm.newtabaction

Value [Disable and Hide] [Run the Same] [Run Other...] 

Setup Sessions > IBM iAccess Client > iAccess Global > Tab Setup

Parameter Tab Placement

Registry ibm.iaccess.acssm.tabplacement

Value [Top] [Bottom] [Left] [Right] 
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Resolved Issues 10.05.830
Firefox

Fixed not working browserglobal.app.local_subdirs_whitelist.
Fixed print hotkey disable option with Firefox 60+.

RDP/IGEL RDP Client 2

Fixed smart card redirection in RDP: SCardGetAttrib was failing if pbAttr was NULL. The fix 
should help running Dutch Zorg-ID applications.

VMware Horizon

Fixed: the configuration choice to use the relative mouse feature.

Citrix

Citrix Workspace App 19.03: Improved USB redirection handling.
Issue solved: Online meeting in VDI: "enable webcam will cut the audio streaming".
Fixed stability issues with Citrix Browser Content Redirection.

Citrix Receiver 13

Added a switch to enable the possibility to launch multiple desktop sessions with RTME and 
H264 acceleration. This switch should not be used when "Enable Secure ICA" is active for the 
specific delivery group.
More...

Registry ica.workaround-dual-rtme

Value enabled / disabled

Network

Fixed: The second Ethernet interface did not get configured when the first one was disabled.
Added a possibility to switch between the third party r8168 and kernel r8169 realtek network 
driver.
New registry key:
More...

Parameter Use thirdparty r8168 kernel module.

Registry network.drivers.r8169.prefer_r8168

Range [Auto] [Yes] [No]

Info: "Auto" (use r8169 in most cases)

Added a possibilty to choose the variant of the realtek r8168 driver.
New registry key:
More...
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Parameter Choose realtek r8168 variant (only if prefer r8168 is choosen).

Registry network.drivers.r8169.r8168_variant

Range [Default] [No NAPI] [NAPI]

Info: "Default" (use NAPI in most cases)

Base system

Fixed: System logout waits for Citrix logout now.
Fixed: Migration tool did not start with the Spanish language setting.
Added new registry key to set USB quirks.
More...

Parameter Set XHCI USB quirks to fix some hardware issues.

Registry system.kernel.bootparams.xhci-hcd_quirks

Range [No quirk] [Spurious Reboot quirk] [Spurious Wakeup quirk] 
[Spurious Reboot Wakeup quirk] 

Lenovo ThinkCentre M73 needs the system.kernel.bootparams.xhci-hcd_quirks registry key set 
to "Spurious Reboot quirk" to fix reboot after shutdown problem.

X11 system

There is now a registry key to ignore a 3Dconnexion SpaceMouse for IGEL graphical use (X11). If 
activated, the SpaceMouse is only passed through to the desktop session. If disabled, it acts also 
as the standard mouse.
More...

Parameter Deactivates a 3Dconnexion SpaceMouse as a standard mouse.

Registry userinterface.mouse.spacemouse.x11_ignore

Value enabled / disabled

The following SpaceMouse products are included:
More...

VID PID Vendor Product

0x046D 0xC603 Logitech, Inc. 3Dconnexion SpaceMouse Plus XT

0x046D 0xC605 Logitech, Inc. 3Dconnexion CADman

0x046D 0xC606 Logitech, Inc. 3Dconnexion SpaceMouse Classic

0x046D 0xC621 Logitech, Inc. 3Dconnexion SpaceBall 5000

0x046D 0xC623 Logitech, Inc. 3Dconnexion SpaceTraveller 3D Mouse

0x046D 0xC625 Logitech, Inc. 3Dconnexion SpacePilot 3D Mouse



Notes for Release 10.05.830

IGEL OS Release Notes   1118 / 1492

•
•
•
•
•
•

•

•
•
•
•

•

VID PID Vendor Product

0x046D 0xC626 Logitech, Inc. 3Dconnexion SpaceNavigator 3D Mouse

0x046D 0xC627 Logitech, Inc. 3Dconnexion SpaceExplorer 3D Mouse

0x046D 0xC628 Logitech, Inc. 3Dconnexion SpaceNavigator for Notebooks

0x046D 0xC629 Logitech, Inc. 3Dconnexion SpacePilot Pro 3D Mouse

0x046D 0xC62B Logitech, Inc. 3Dconnexion SpaceMouse Pro

0x256F ** 3Dconnexion SpaceMouse

USB device reset via USB powercycle is now available on UD6/UD7.
Fixed problems with internal graphic cards and NVIDIA graphic cards.
Fixed Display Switch utility not starting with some translations.
Fixed an issue with the noDDC mode not always working as expected.
Fixed some multimonitor (>4) issues with Nvidia graphic cards.
Updated DisplayLink driver to version 5.1.26 to solve some startup issues.

Driver

Fixed not working WACOM device DTU-1141B.

Hardware

Fixed not working network on Beckhoff CB3163, CB6263 and CB6363 systems.
Fixed not working network on Lex 3I380D.
Fixed black screen issue with some monitors and 2560x1440 resolution (occured on UD2 LX50).
Added possibility to change some DRM settings and limit the DisplayPort lane bandwidth on 
Intel devices.
Added new registry keys:
More...

Parameter Use best graphic mode for all screens on console.

Registry x.drivers.kms.best_console_mode

Range [Default] [Enabled] [Disabled]

Info: "Default" is enabled in most cases.

Parameter Limit the maximum console resolution width to this value.

Registry x.drivers.kms.max_console_width

Type Integer

Value "0"

Info: "0" means default setting. Use the default setting.

Parameter Limit the maximum console resolution height to this value.
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Registry x.drivers.kms.max_console_height

Type Integer

Value "0"

Info: "0" means default setting. Use the default setting.

Parameter Set graphic kernel driver debug level.

Registry x.drivers.kms.debug_level

Range [No debug] [Basic] [Basic + core] [Basic + core + atomic] [Full]

Info: Warning log will grow very fast.

Only for Intel i915 driver:

Parameter Limit the maximum DisplayPort lane link rate.

Registry x.drivers.intel.max_dp_link_rate

Range [default] [1.62Gbps] [2.16Gbps] [2.7Gbps] [3.24Gbps]
[4.32Gbps] [5.4Gbps] [6.48Gbps] [8.1Gbps]  

Info: "Default" means hardware default limit.
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Security Fixes 10.05.830
Firefox

Updated Mozilla Firefox to version 60.7.2 ESR.
Fixed mfsa2019-19 security issue CVE-2019-11708.
Fixed mfsa2019-18 security issue CVE-2019-11707.
Fixed mfsa2019-10 security issues CVE-2019-9810 and CVE-2019-9813.
Fixed mfsa2019-08 security issues.
More...

CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, CVE-2019-9793,
CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, CVE-2019-9788.

Fixed mfsa2019-05 security issues CVE-2018-18356 and CVE-2019-5785.
Fixed mfsa2019-02 security issues CVE-2018-18500, CVE-2018-18505 and CVE-2018-18501.
Fixed mfsa2018-30 security issues.
More...

CVE-2018-17466, CVE-2018-18492, CVE-2018-18493,
CVE-2018-18494, CVE-2018-18498, CVE-2018-12405.

Base system

Fixed kernel TCP vulnerabilities CVE-2019-11477: SACK Panic, CVE-2019-11478: SACK Slowness
and CVE-2019-11479: Excess Resource Consumption Due to Low MSS Values.
Changed minimally allowed MSS size to '1000' to prevent possible denial-of-service attacks.
Updated libwebkit2gtk-4.0-37 to version 1.24.2.
More...

CVE-2019-8595, CVE-2019-8607, CVE-2019-8615, CVE-2019-6251,
CVE-2018-4373, CVE-2018-4375, CVE-2018-4376, CVE-2018-4378,
CVE-2018-4382, CVE-2018-4392, CVE-2018-4416, CVE-2018-4345,
CVE-2018-4386, CVE-2018-4372
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Notes for Release 10.05.800
Software: Version 10.05.800

Release Date: 2019-05-08

Release Notes: Version RN-105800-1

Last update: 2019-05-08

IGEL Linux Universal Desktop (see page 1122)
IGEL Universal Desktop OS 3 (see page 1137)
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IGEL Linux Universal Desktop

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD3-LX 42

UD3-LX 41

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Component Versions 10.05.800 (see page 1123)
General Information 10.05.800 (see page 1127)
Known Issues 10.05.800 (see page 1128)
New Features 10.05.800 (see page 1130)
Resolved Issues 10.05.800 (see page 1134)
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Component Versions 10.05.800
Clients
Product Version

Citrix HDX Realtime Media Engine 2.7.0-2113

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 18.10.0.11

deviceTRUST Citrix Channel 19.1.200.2

deviceTRUST RDP Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.6.2

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_202

Parallels Client (64 bit) 16.5.2.20595

Remote Viewer (RedHat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0

Systancia AppliDis 4.0.0.17
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Thinlinc Client 4.9.0-5775

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel16

VMware Horizon Client 4.10.0-11053294

VNC Viewer 1.8.0+git20180123-igel1

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.6.36

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.5

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5
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Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.28

Reader Driver REINER SCT cyberJack 3.99.5final.SP11

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.13

OpenSSH Client 7.2p2-4ubuntu2.4

OpenSSH Server 7.2p2-4ubuntu2.4

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.2.1-1igel51

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20181113-igel846

Graphics Driver ATI/RADEON 18.0.1-1igel831

Graphics Driver ATI/AMDGPU 18.0.1-1igel831

Graphics Driver VIA 5.76.52.92-009-005f78-20150730

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.3.4-1build2igel639

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver Vmmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-ud-r2531

Xorg X11 Server 1.19.6-1ubuntu4igel838

Xorg Xephyr 1.19.6-1ubuntu4igel832

CUPS printing daemon 2.1.3-4ubuntu0.5igel20
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PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel653

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2igel1

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.2-1ubuntu1igel192

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.1
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General Information 10.05.800
The following clients and features are not supported anymore

Citrix Receiver 12.1 and 13.1 - 13.4
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
Remote Access via RSH
Legacy Philips Speech Driver
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
Video Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
H.264 Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon
by an icon in the 'In-Session Control Bar' (configurable at IGEL Setup > User Interface > 
Desktop)
by a 'Safely Remove Hardware' session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in this release

Cherry eGK Channel
Open VPN Smartcard Support
Asian Input Methods
Composite Manager
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Known Issues 10.05.800
Citrix

With activated DRI3 and an amd gpu citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (api v2) is not affected from this issue.
Citrix has known issues with gstreamer1.0 which describe problems with multimedia redirection 
of H264, MPEG1 and MPEG2. Gstreamer1.0 is used if browser content redirection is active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
When using Citrix Workspace App 18.10 in combination with Philips Speech driver, the session 
occasionally does not proper terminate at logoff and hangs. 
As a workaround, usage of Citrix Receiver 13.10 is recommended when Philips Speech driver is 
needed.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > *"For the 
entire screen"**.
When Expand the session over a self-selected number of monitors (for Multi-monitor full 
screen mode) is used and setup is restarted, Restrict full screen session to one monitor is 
indicated and the monitor selection is greyed out. The functionality is available, only the 
notification in setup is broken.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media  as a drive in your desktop. Then the external devices 
will show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client drive mapping can be found in: Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable Drive Mapping. 
It is also recommended to disable local Storage Hotplug: On page Devices > Storage 
Devices > Storage Hotplug, put number of storage hotplug devices to 0. 
On the other hand, if you use drive mapping instead, it is recommended that you should 
either switch off USB redirection entirely or at least deny storage devices by adding a 
filter to the USB class rules. And because Horizon Client relies on the OS to mount the 
storage devices itself, please go to setup page: Devices > Storage Devices > Storage 
Hotplug and switch on Enable dynamic drive mapping and put Number of storage 
hotplug devices to at least 1.

Parallels Client

Native USB redirection does not work with Parallels Client.
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For using the new FIPS 140-2 compliance mode it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In some cases there are instabilities when using A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Hardware

Suspend on UD10 is disabled.
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New Features 10.05.800
OS 11 Upgrade

It is now possible to upgrade to IGEL OS 11. For more information, please see Upgrading IGEL 
Devices from IGEL OS 10 to IGEL OS 11. The parameters for the upgrade:
More...

IGEL Setup System > Update > OS 11 Upgrade

Parameter Upgrade to OS 11

Registry update.firmware_migrate_to_11

Value enabled / disabled

IGEL Setup System > Update > OS 11 Upgrade

Parameter Upgrade to OS 11 even if a previous upgrade attempt 
failed

Registry update.force_firmware_migrate_to_11

Value enabled / disabled

IGEL Setup System > Update > OS 11 Upgrade

Parameter Upgrade to OS 11 even if PowerTerm is enabled

Registry update.migrate_to_11_with_powerterm

Value enabled / disabled

IGEL Setup System > Update > OS 11 Upgrade

Parameter Require an Enterprise Management Pack license to 
upgrade to OS 11

Registry update.migrate_to_11_enterprise_require

d

Value [Smart] [Always] [Never]

IGEL Setup System > Update > OS 11 Upgrade

Parameter Timeout waiting for OS 11 license to start automatic 
upgrade

Registry update.migrate_to_11_license_timeout
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Value [Disabled] [10 Minutes] [15 Minutes] [30 Minutes] [60 
Minutes]

The parameters for configuring the desktop integration of the IGEL OS 11 Upgrade tool are:
More...

IGEL Setup Accessories > OS 11 Upgrade

Parameter Start menu

Registry sessions.os11_migration0.startmenu

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Application Launcher

Registry sessions.os11_migration0.applaunch

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter System tab of start menu

Registry sessions.os11_migration0.startmenu_sy

stem

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter System tab of Application Launcher

Registry sessions.os11_migration0.applaunch_sy

stem

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Menu folder

Registry sessions.os11_migration0.menu_path

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Desktop folder
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Registry sessions.os11_migration0.desktop_path

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Application Launcher folder

Registry sessions.os11_migration0.applaunch_pa

th

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Quick start panel

Registry sessions.os11_migration0.quick_start

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Password protection

Registry sessions.os11_migration0.pwprotected

Value [None] [Administrator] [User] [Setup user]

IGEL Setup Accessories > OS 11 Upgrade

Parameter Desktop

Registry sessions.os11_migration0.desktop

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Desktop context menu

Registry sessions.os11_migration0.pulldown

Value enabled / disabled

Firefox

Updated Mozilla Firefox to version 60.6.2ESR: Repaired certificate chain to re-enable web 
extensions that had been disabled.

Network
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Added NCP Secure Enterprise VPN Client version 5.10_rev40552: Configurable at IGEL Setup > 
Network > VPN > NCP VPN Client

Driver

Updated deviceTRUST Client to version 19.1.200. These are the release notes:
Welcome to the release of the deviceTRUST 19.1.200 IGEL client, providing the context of IGEL thin 
client and UD Pocket devices into your virtual sessions. This release includes support for logical 
disks attached to the IGEL endpoint, plus bug fixes and stability improvements over the previous 
19.1.100 release.

Logical Disks
Added support for real-time properties representing the LOGICAL DISKS attached to the IGEL 
endpoint. 
This includes...

DEVICE_LOGICALDISK_X_TYPE – Either Fixed or Removable.
DEVICE_LOGICALDISK_X_LABEL – The volume label.
DEVICE_LOGICALDISK_X_FILESYSTEM – The type of file system.
DEVICE_LOGICALDISK_X_PATHS – The paths that the disk is mounted.
DEVICE_LOGICALDISK_X_TOTALMB – The total space available on the disk. This property is 
only available for mounted disks.
DEVICE_LOGICALDISK_X_FREEMB – The free space available on the disk. This property is 
only available for mounted disks.
DEVICE_LOGICALDISK_X_NAME – The name of the underlying physical disk.
DEVICE_LOGICALDISK_X_VENDORID – The vendor identifier uniquely identifying 
the manufacturer. This property is only available for USB or PCI connected devices.
DEVICE_LOGICALDISK_X_PRODUCTID – The product identifier uniquely identifying the 
product. This property is only available for USB or PCI connected devices.
DEVICE_LOGICALDISK_X_SERIALNUMBER – The serial number of the physical disk.
DEVICE_LOGICALDISK_X_BUSTYPE – The storage bus type linked to the physical disk.
DEVICE_LOGICALDISK_COUNT – The number of logical disks.
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Resolved Issues 10.05.800
Network

Added possibility to switch between thirdparty r8168 and kernel r8169 realtek network driver.
More...

Parameter Use thirdparty r8168 kernel module.

Registry network.drivers.r8169.prefer_r8168

Range [Auto] [Yes] [No] |

Info: "Auto" uses r8169 in most cases

WiFi

Fixed non working TP Link Archer T2UH.

Base system

Added possibility to set intel_idle.max_cstate  kernel cmdline parameter with registry 
keys to work against Intel CPU freezes.
Enhanced bootloader to allow the setting of some kernel commandline parameters with registry 
keys.
More...

Parameter Disable use of APIC controller.

Registry system.kernel.bootparams.noapic

Value enabled / disabled

Parameter Disable use of ACPI.

Registry system.kernel.bootparams.noacpi

Value enabled / disabled

Parameter Use only one CPU core and disable all others.

Registry system.kernel.bootparams.nosmp

Value enabled / disabled

Parameter Enable debug console on serial port 1.

Registry system.kernel.bootparams.serial_consol

e_debug



Notes for Release 10.05.800

IGEL OS Release Notes   1135 / 1492

•
•
•

•

•

Value enabled / disabled

Parameter Limit CPU core usage (0 means no limit).

Registry system.kernel.bootparams.maxcpus

Value "0"

Parameter Set maximum allowed cstate on intel cpus.

Registry system.kernel.bootparams.max_cstate

Range [No limit] [1] [2] [3] [4] [5] [6]

Info: do not limit intel cstate

Parameter IOMMU usage setting.

Registry system.kernel.bootparams.iommu

Range [On] [Off] [Passthrough] [Force]

Info: Use IOMMU if possible

Parameter IOMMU usage setting for AMD systems.

Registry system.kernel.bootparams.amd_iommu

Range [On] [Off]

Info: Use IOMMU if possible

Parameter IOMMU usage setting for Intel systems.

Registry system.kernel.bootparams.intel_iommu

Range [On] [Off]

Info: Use IOMMU if possible

Driver

Updated deviceTRUST Client to version 19.1.200. Bug Fixes:
Fixed an issue reading the DEVICE_IGEL_ICG_SERVER property.
Fixed an issue where the NETWORK and LOCATION property providers could cause the 
client to freeze if a disconnection occurred whilst these property providers were checking 
for changes.
Fixed an open file handle leak which lead to the client process reaching its file handle 
limits when left running for a long period of time.

X11 system

Fixed a bug with thinclients reporting the wrong monitor serial number.
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Hardware

Updated AMDGPU Pro driver to 19.10 version. The new version fixes a disappearing mouse cursor 
issue. Enable AMDGPU Pro driver instead of kernel integrated driver by registry key (settings to this 
key will only work after reboot):
More...

Parameter Use AMDGPU PRO driver.

Registry x.drivers.amdgpu.use_amdgpu_pro

Range [Auto] [Yes] [No] |
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IGEL Universal Desktop OS 3
Supported Hardware:

https://kb.igel.com/igelos/en/devices-supported-by-udc3-and-ud-pocket-3117174.html

Component Versions 10.05.800 (see page 1138)
General Information 10.05.800 (see page 1142)
Known Issues 10.05.800 (see page 1143)
New Features 10.05.800 (see page 1145)
Resolved Issues 10.05.800 (see page 1153)
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Component Versions 10.05.800
Clients
Product Version

Citrix HDX Realtime Media Engine 2.7.0-2113

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 18.10.0.11

deviceTRUST Citrix Channel 19.1.200.2

deviceTRUST RDP Channel 19.1.200.2

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.6.2

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

deviceTRUST RDP Channel 19.1.200.2

Leostream Java Connect 3.3.7.0

NCP Secure Enterprise Client 5.10_rev40552

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_202

Parallels Client (64 bit) 16.5.2.20595

Parole Media Player 1.0.1-0ubuntu1igel16

Remote Viewer (RedHat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14
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Usbredir (Red Hat Virtualization) 0.8.0

Systancia AppliDis 4.0.0.17

Thinlinc Client 4.9.0-5775

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel16

VMware Horizon Client 4.10.0-11053294

VNC Viewer 1.8.0+git20180123-igel1

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.6.36

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.5

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3
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Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.28

Reader Driver REINER SCT cyberJack 3.99.5final.SP11

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.13

OpenSSH Client 7.2p2-4ubuntu2.4

OpenSSH Server 7.2p2-4ubuntu2.4

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.2.1-1igel51

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20181113-igel846

Graphics Driver ATI/RADEON 18.0.1-1igel831

Graphics Driver ATI/AMDGPU 18.0.1-1igel831

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2igel775

Graphics Driver Nvidia 390.87-0ubuntu1

Graphics Driver Vboxvideo 5.2.18-dfsg-2igel17

Graphics Driver VMware 13.3.0-2igel812

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.3.4-1build2igel639

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748
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Input Driver Vmmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-udos-r2531

Xorg X11 Server 1.19.6-1ubuntu4igel838

Xorg Xephyr 1.19.6-1ubuntu4igel832

CUPS printing daemon 2.1.3-4ubuntu0.5igel20

PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel653

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2igel1

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.2-1ubuntu1igel192

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.1
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General Information 10.05.800
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
Remote Access via RSH
Legacy Philips Speech Driver
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
VIA Graphics Support
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon
by an icon in the 'In-Session Control Bar' (configurable at IGEL Setup > User Interface > 
Desktop)
by a 'Safely Remove Hardware' session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in this release:

Cherry eGK Channel
Open VPN Smartcard Support
Asian Input Methods
Composite Manager



Notes for Release 10.05.800

IGEL OS Release Notes   1143 / 1492

•

•

•

•

•

•

•

•

•

•

•

Known Issues 10.05.800
Citrix

With activated DRI3 and an AMD GPU Citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (API v2) is not affected from this issue.
Citrix has known issues with GStreamer 1.0 which describe problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer 1.0 is used if browser content redirection is 
active.
Browser content redirection does not work with activated DRI3 and hardware 
accelerated H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of login. 
As a workaround, insert the smartcard before starting StoreFront login.
When using Citrix Workspace App 18.10 in combination with Philips Speech driver, the 
session occasionally terminates improperly at logout and hangs. 
As a workaround, usage of Citrix Receiver 13.10 is recommended when Philips Speech driver is 
needed.
Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D 
graphics workload in combination with server policy Use video codec compression > "For the 
entire screen".
When "Expand the session over a self-selected number of monitors" (for "Multimonitor full-screen 
mode") is used and Setup is restarted, "Restrict full screen session to one monitor" is indicated 
and the monitor selection is greyed out. The functionality is available, only the notification in 
Setup is broken.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory  /media  as a drive in your desktop. Then the external devices 
will show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that 
the USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client drive mapping can be found in: Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable Drive Mapping. 
It is also recommended to disable local Storage Hotplug: On page Devices > Storage 
Devices > Storage Hotplug, put number of storage hotplug devices to 0. 
On the other hand, if you use drive mapping instead, it is recommended that you should 
either switch off USB redirection entirely or at least deny storage devices by adding a 
filter to the USB class rules. And because Horizon Client relies on the OS to mount the 
storage devices itself, please go to setup page: Devices > Storage Devices > Storage 
Hotplug and switch on Enable dynamic drive mapping and put Number of storage 
hotplug devices to at least 1.

Parallels Client
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Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode, it is necessary to connect to the Parallels 
RAS one time with FIPS support disabled.

Smartcard

In some cases, there are instabilities when using A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Base system

Display resolution and rotation could not be changed with NVIDIA GPU driver via tcsetup.

Multimedia

Multimedia redirection with GStreamer could fail with Nouveau GPU driver.
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New Features 10.05.800
RDP/IGEL RDP Client 2

Add field collection to RDP session server page.
More...

IGEL Setup Sessions > RDP > RDP Sessions > RDP Session > 
Server

Sessions > RDP > RDP Sessions > RDP Session > 
Options

Parameter Collection

Registry sessions.winconnect<NR>.option.load-

balance-info

VMware Horizon

Added parameters to specify webcam frame size and rate for RTAV. 
More...

Parameter Webcam frame width

Registry vmware.view.rtav-frame-width

Value <empty_string>

Parameter Webcam frame height

Registry vmware.view.rtav-frame-height

Value <empty_string>

Parameter Webcam frame rate

Registry vmware.view.rtav-frame-rate

Value <empty_string>

Firefox

Updated Mozilla Firefox to version 60.6.2ESR:
Repaired certificate chain to re-enable web extensions that had been disabled.
Fixes for mfsa2019-10, also known as: CVE-2019-9810, CVE-2019-9813.
Fixes for mfsa2019-08, also known as: CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, 
CVE-2019-9793, CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, CVE-2019-9788.
Fixes for mfsa2019-05, also known as: CVE-2018-18356, CVE-2019-5785.
Fixes for mfsa2019-02, also known as: CVE-2018-18500, CVE-2018-18505, CVE-2018-18501.
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Fixes for mfsa2018-30, also known as: CVE-2018-17466, CVE-2018-18492, CVE-2018-18493, 
CVE-2018-18494, CVE-2018-18498, CVE-2018-12405.
Added new parameters: Allow a custom command before and after browser session. 
More...

Parameter Initial Action

Registry sessions.browser%.init_action

Value <empty_string>

Parameter Final Action

Registry sessions.browser%.final_action

Value <empty_string>

OS 11 Upgrade

It is now possible to upgrade to IGEL OS 11. For more information, please see Upgrading IGEL 
Devices from IGEL OS 10 to IGEL OS 11. The parameters for the upgrade:
More...

IGEL Setup System > Update > OS 11 Upgrade

Parameter Upgrade to OS 11

Registry update.firmware_migrate_to_11

Value enabled / disabled

IGEL Setup System > Update > OS 11 Upgrade

Parameter Upgrade to OS 11 even if a previous upgrade attempt 
failed

Registry update.force_firmware_migrate_to_11

Value enabled / disabled

IGEL Setup System > Update > OS 11 Upgrade

Parameter Upgrade to OS 11 even if PowerTerm is enabled

Registry update.migrate_to_11_with_powerterm

Value enabled / disabled

IGEL Setup System > Update > OS 11 Upgrade

Parameter Require an Enterprise Management Pack license to 
upgrade to OS 11



Notes for Release 10.05.800

IGEL OS Release Notes   1147 / 1492

•

Registry update.migrate_to_11_enterprise_require

d

Value [Smart] [Always] [Never]

IGEL Setup System > Update > OS 11 Upgrade

Parameter Timeout waiting for OS 11 license to start automatic 
upgrade

Registry update.migrate_to_11_license_timeout

Value [Disabled] [10 Minutes] [15 Minutes] [30 Minutes] [60 
Minutes]

The parameters for configuring the desktop integration of the IGEL OS 11 Upgrade tool are:
More...

IGEL Setup Accessories > OS 11 Upgrade

Parameter Start menu

Registry sessions.os11_migration0.startmenu

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Application Launcher

Registry sessions.os11_migration0.applaunch

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter System tab of start menu

Registry sessions.os11_migration0.startmenu_sy

stem

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter System tab of Application Launcher

Registry sessions.os11_migration0.applaunch_sy

stem
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Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Menu folder

Registry sessions.os11_migration0.menu_path

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Desktop folder

Registry sessions.os11_migration0.desktop_path

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Application Launcher folder

Registry sessions.os11_migration0.applaunch_pa

th

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Quick start panel

Registry sessions.os11_migration0.quick_start

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Password protection

Registry sessions.os11_migration0.pwprotected

Value [None] [Administrator] [User] [Setup user]

IGEL Setup Accessories > OS 11 Upgrade

Parameter Desktop

Registry sessions.os11_migration0.desktop

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade
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Parameter Desktop context menu

Registry sessions.os11_migration0.pulldown

Value enabled / disabled

Citrix

Updated Citrix HDX RTME used for optimization of Skype for Business to version 2.7.0-2113.

Parallels Client

Updated Parallels Client to version 16.5.2 (64-Bit)

CUPS Printing

Added SMB Network Print Client function. The printer could be created on page Devices > 
Printer > CUPS > Printers > Dialog, SMB Network Printer as Printer Port. The settings for the 
SMB printer must be done in Setup Registry:
More...

IGEL Setup Devices > Printer > CUPS > Printers > Dialog

Parameter Printer Port

Registry print.cups.printer<NR>.backend

Value [Parallel Port Printer] [Serial Port Printer] [USB Printer] [LPD 
Network Printer] [TCP Network Printer] [IPP Network 
Printer] [SMB Network Printer]

Parameter SMB Server

Registry print.cups.printer<NR>.smb_server

Parameter SMB Workgroup

Registry print.cups.printer<NR>.smb_workgroup

Parameter SMB Port

Registry print.cups.printer<NR>.smb_port

Value 0

Parameter SMB Printer

Registry print.cups.printer<NR>.smb_printer

Parameter SMB User

Registry print.cups.printer<NR>.smb_user
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Parameter SMB Password

Registry print.cups.printer<NR>.crypt_password

IBM_5250

Updated IBM iAccess Client Solutions to version 1.1.8.1.

WiFi

Added support for Realtek 8821CE wireless cards.
Added switch to determine the source of WiFi scan results within the Wireless Manager. 
Selecting default is currently identical with the old mechanism (using the iwlist  command). 

This may change in the future. When iwlist  fails, NetworkManager is automatically used as a 
fallback.
More...

Parameter WiFi Scanner

Registry network.interfaces.wirelesslan.device0.m

ssid_scanner

Range default / iwlist / NetworkManager

Info: "default" is currently equal to "iwlist"

X11 System

Added xprintidle tool to firmware.
The new Display Switch tool can use multiple different profiles, automatically chosen at 
runtime depending on the currently connected monitors. A profile is created, when the current 
monitor layout/resolution is configured via the Display Switch utility. The profile will be 
associated with the current connected displays automatically (manufacturer, model and used 
connector are used for allocation) and if applicable, the state of the laptop lid. The setup will be 
restored by hot-(un)plugging known displays, means the system will automatically switch to the 
already configured profile. The Display Switch utility itself got a new interface. All base 
functionality can be configured via drag & drop.
An example workflow:

Connect the hardware and close/open lid
Open the Display Switch Utility

A quick (simple) setting can be selected directly.
Should the desired application deviate from the possibilities provided, the 
Advanced button opens a drag & drop interface for further settings.

In this interface the displays can be dragged and dropped for the intended configuration. The 
display will snap adjacent to others.
If a display should not be used, it can be dragged to the Disabled area on the top right - the 
screen will be reactivated when it is dragged back to the active area.
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To show the same content on multiple displays, one display should be dragged onto an other 
active screen. The interface will show Mirror. The mirroring monitor will be displayed on the lower 
right.
With the Apply button the current state will be set, with Yes on the Keep configuration dialog the 
current settings will be saved to persistent storage and associated with the profile.
Advanced functionality (panning/scaling/resolutions) can be configured in drop-down boxes, 
hidden in a drawer on the right side. The drawer can be expanded by clicking the < button on the 
right edge.
For the Display Switch functionality the following parameters should be enabled for proper 
usage:
More...

IGEL Setup Accessories > Display Switch > Options

Parameter Preserve settings over reboot

Registry sessions.user_display0.options.preserv

e_settings

Value enabled / disabled

IGEL Setup Accessories > Display Switch > Options

Parameter Smart display configuration

Registry x.auto_associate

Value enabled / disabled

The IGEL Display Switch utility is now used for NVIDIA graphics devices as well.

Network

Added NCP Secure Enterprise VPN Client version 5.10_rev40552: Configurable at IGEL Setup > 
Network > VPN > NCP VPN Client

Driver

Updated deviceTRUST Client to version 19.1.200. These are the release notes:
Welcome to the release of the deviceTRUST 19.1.200 IGEL client, providing the context of IGEL thin 
client and UD Pocket devices into your virtual sessions. This release includes support for logical 
disks attached to the IGEL endpoint, plus bug fixes and stability improvements over the previous 
19.1.100 release.

Logical Disks
We’ve added support for real-time properties representing the LOGICAL DISKS attached to the 
IGEL endpoint. 
This includes...

DEVICE_LOGICALDISK_X_TYPE – Either Fixed or Removable.
DEVICE_LOGICALDISK_X_LABEL – The volume label.



Notes for Release 10.05.800

IGEL OS Release Notes   1152 / 1492

•
•
•

•

•
•

•

•
•
•

DEVICE_LOGICALDISK_X_FILESYSTEM – The type of file system.
DEVICE_LOGICALDISK_X_PATHS – The paths that the disk is mounted.
DEVICE_LOGICALDISK_X_TOTALMB – The total space available on the disk. This property is 
only available for mounted disks.
DEVICE_LOGICALDISK_X_FREEMB – The free space available on the disk. This property is 
only available for mounted disks.
DEVICE_LOGICALDISK_X_NAME – The name of the underlying physical disk.
DEVICE_LOGICALDISK_X_VENDORID – The vendor identifier uniquely identifying 
the manufacturer. This property is only available for USB or PCI connected devices.
DEVICE_LOGICALDISK_X_PRODUCTID – The product identifier uniquely identifying the 
product. This property is only available for USB or PCI connected devices.
DEVICE_LOGICALDISK_X_SERIALNUMBER – The serial number of the physical disk.
DEVICE_LOGICALDISK_X_BUSTYPE – The storage bus type linked to the physical disk.
DEVICE_LOGICALDISK_COUNT – The number of logical disks.
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Resolved Issues 10.05.800
Citrix Receiver 13

Fixed crash when H.264 acceleration and RTME will be used on two or more concurrent VDI 
sessions.

VMware Horizon

Fixed optimization for Skype for Business.
Added switch to use system-wide proxyin VMware Horizon appliance mode.
More...

Parameter Use the systemwide proxy.

Registry vmwarevdmapp.use_proxy

Range enabled / disabled

PowerTerm

Fixed editing of parameter  sessions.powerterm\<INST>.logindialog.loginscript  i
n Setup Registry: now multiple lines are possible.

Network

Changed e1000e driver to 3.4.2.3 - directly from Intel.
Changed igb driver to 5.3.5.22 - also directly from Intel.
Added possibility to switch between thirdparty r8168 and kernel r8169 realtek network driver.
More...

Parameter Use thirdparty r8168 kernel module.

Registry network.drivers.r8169.prefer_r8168

Range [Auto] [Yes] [No]

Info: use r8169 in most cases

Base system

Added package ldap-utils which could be used via custom scripts.
Fixed delay in logon as local user, when logon with IGEL Smartcard is also active.
Fixed random 90 seconds shutdown delay (systemd).
Fixed custom bootsplash installation.
Added possibility to set intel_idle.max_cstate  kernel cmdline parameter with registry 
keys to work against Intel CPU freezes.
Enhanced bootloader to allow the setting of some kernel commandline parameters with registry 
keys.
More...
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Parameter Disable use of APIC controller.

Registry system.kernel.bootparams.noapic

Value enabled / disabled

Parameter Disable use of ACPI.

Registry system.kernel.bootparams.noacpi

Value enabled / disabled

Parameter Use only one CPU core and disable all others.

Registry system.kernel.bootparams.nosmp

Value enabled / disabled

Parameter Enable debug console on serial port 1.

Registry system.kernel.bootparams.serial_consol

e_debug

Value enabled / disabled

Parameter Limit CPU core usage (0 means no limit).

Registry system.kernel.bootparams.maxcpus

Value "0"

Parameter Set maximum allowed cstate on intel cpus.

Registry system.kernel.bootparams.max_cstate

Range [No limit] [1] [2] [3] [4] [5] [6]

Info: do not limit intel cstate

Parameter IOMMU usage setting.

Registry system.kernel.bootparams.iommu

Range [On] [Off] [Passthrough] [Force]

Info: Use IOMMU if possible

Parameter IOMMU usage setting for AMD systems.

Registry system.kernel.bootparams.amd_iommu
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Range [On] [Off]

Info: Use IOMMU if possible

Parameter IOMMU usage setting for Intel systems.

Registry system.kernel.bootparams.intel_iommu

Range [On] [Off]

Info: Use IOMMU if possible

Storage Devices

Fixed auto mounting of storage devices inside of Olympus DS-9500 Digital Voice Recorder.

WiFi

Fixed non working TP Link Archer T2UH.

Driver

Updated deviceTRUST Client to version 19.1.200. Bug Fixes:
Fixed an issue reading the DEVICE_IGEL_ICG_SERVER property.
Fixed an issue where the NETWORK and LOCATION property providers could cause the 
client to freeze if a disconnection occurred whilst these property providers were checking 
for changes.
Fixed an open file handle leak which lead to the client process reaching its file handle limits 
when left running for a long period of time.

X11 system

Fixed a bug with thinclients reporting the wrong monitor serial number.
There is now a registry key to ignore a 3Dconnexion SpaceMouse for IGEL graphical use (X11). If 
activated, the SpaceMouse is only passed thru to the desktop session. If false, it acts like the 
standard mouse.
The following SpaceMouse products are included (VID, PID, Vendor, Product).
More...

0x046D; 0xC603; Logitech, Inc.; 3Dconnexion Spacemouse Plus XT

0x046D; 0xC605; Logitech, Inc.; 3Dconnexion CADman

0x046D; 0xC606; Logitech, Inc.; 3Dconnexion Spacemouse Classic

0x046D; 0xC621; Logitech, Inc.; 3Dconnexion Spaceball 5000

0x046D; 0xC623; Logitech, Inc.; 3Dconnexion Space Traveller 3D Mouse

0x046D; 0xC625; Logitech, Inc.; 3Dconnexion Space Pilot 3D Mouse

0x046D; 0xC626; Logitech, Inc.; 3Dconnexion Space Navigator 3D Mouse

0x046D; 0xC627; Logitech, Inc.; 3Dconnexion Space Explorer 3D Mouse

0x046D; 0xC628; Logitech, Inc.; 3Dconnexion Space Navigator for Notebooks

0x046D; 0xC629; Logitech, Inc.; 3Dconnexion SpacePilot Pro 3D Mouse



Notes for Release 10.05.800

IGEL OS Release Notes   1156 / 1492

•
•

•

•
•

•

•
•

0x046D; 0xC62B; Logitech, Inc.; 3Dconnexion Space Mouse Pro

0x256F; **; 3Dconnexion; SpaceMouse

USB device reset via USB powercycle on UD6 / UD7 available.
Fixed screen flicker in some cases if Force NumLock On ( x.global.forcenumlock ) is 
active.

Window manager

Fixed option to disable the local window manager.

Hardware

Fixed non working Laptop Display for Dell Latitude E5510
Ryzen 3 devices (1200, 1300X, 2200G, 2200U and 2300U) will use the AMDGPU PRO driver if 
registry key x.drivers.amdgpu.use_amdgpu_pro is set to auto (default).
Added AMDGPU Pro driver 19.10 version. The new version fixes a disappearing mouse cursor 
issue. Enable AMDGPU Pro driver instead of kernel integrated driver by registry key (settings to this 
key will only work after reboot). 
More...

Parameter Use AMDGPU PRO driver

Registry x.drivers.amdgpu.use_amdgpu_pro

Value [Auto] [True] [False]

Info: Settings to this key will only work after reboot.

IGEL Cloud Gateway

Fixed support for UMS file transfer status in ICG protocol.
When TC is managed over ICG, settings received in connection stage will not be applied 
immediately. The settings must be applied after user prompt dialog.
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Notes for Release 10.05.700
Software: Version 10.05.700

Release Date: 2019-04-12

Release Notes: Version RN-105700-1

Last update: 2019-04-12

IGEL Linux Universal Desktop (see page 1158)
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IGEL Linux Universal Desktop

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD3-LX 42

UD3-LX 41

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Component Versions 10.05.700 (see page 1159)
General Information 10.05.700 (see page 1163)
Known Issues 10.05.700 (see page 1164)
New Features 10.05.700 (see page 1166)
Resolved Issues 10.05.700 (see page 1173)
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Component Versions 10.05.700
Clients
Product Version

Citrix HDX Realtime Media Engine 2.7.0-2113

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 18.10.0.11

deviceTRUST Citrix Channel 19.1.100.0

deviceTRUST RDP Channel 19.1.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.6.1

IBM iAccess Client Solutions 1.1.8.1

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

deviceTRUST RDP Channel 19.1.100.0

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_202

Parallels Client (64 bit) 16.5.2.20595

Parole Media Player 1.0.1-0ubuntu1igel16

Remote Viewer (RedHat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0
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Systancia AppliDis 4.0.0.17

Thinlinc Client 4.9.0-5775

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

Parole Media Player 1.0.1-0ubuntu1igel16

VMware Horizon Client 4.10.0-11053294

VNC Viewer 1.8.0+git20180123-igel1

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.6.36

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.2.36

Reader Driver ACS CCID 1.1.5

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35
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Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.28

Reader Driver REINER SCT cyberJack 3.99.5final.SP11

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.13

OpenSSH Client 7.2p2-4ubuntu2.4

OpenSSH Server 7.2p2-4ubuntu2.4

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.2.1-1igel51

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20181113-igel846

Graphics Driver ATI/RADEON 18.0.1-1igel831

Graphics Driver ATI/AMDGPU 18.0.1-1igel831

Graphics Driver VIA 5.76.52.92-009-005f78-20150730

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.3.4-1build2igel639

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver Vmmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-ud-r2531

Xorg X11 Server 1.19.6-1ubuntu4igel838

Xorg Xephyr 1.19.6-1ubuntu4igel832
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CUPS printing daemon 2.1.3-4ubuntu0.5igel20

PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel653

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2igel1

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.2-1ubuntu1igel192

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.1
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General Information 10.05.700
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
Remote Access via RSH
Legacy Philips Speech Driver
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
Video Hardware Acceleration support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
H.264 Hardware Acceleration support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon
by an icon in the 'In-Session Control Bar' (configurable at `IGEL Setup > User Interface > 
Desktop`)
by a 'Safely Remove Hardware' session (configurable at `IGEL Setup > Accessories`)

The following clients and features are not available in this release:

Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
Composite Manager
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Known Issues 10.05.700
Citrix

With activated DRI3 and an amd gpu citrix H.264 acceleration plugin could freeze. Selective 
H.264 mode (api v2) is not affected from this issue.
Citrix has known issues with gstreamer1.0 which describe problems with multimedia redirection 
of H264, MPEG1 and MPEG2. Gstreamer1.0 is used if browser content redirection is active.
Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
if the card is inserted after start of Login. 
As a workaround, insert the smartcard before starting StoreFront login.
When using Citrix Workspace App 18.10 in combination with Philips Speech driver, the session 
occasionally does not proper terminate at logoff and hangs. 
As a workaround, usage of Citrix Receiver 13.10 is recommended when Philips Speech driver is 
needed.

Citrix H.264 acceleration plugin does not work with enabled server policy Optimize for 3D graphics workload in 
combination with server policy Use video codec compression > *"For the entire screen"**.

When Expand the session over a self-selected number of monitors (for Multi-monitor full 
screen mode) is used and setup is restarted, Restrict full screen session to one monitor is 
indicated and the monitor selection is greyed out. The functionality is available, only the 
notification in setup is broken.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media  as a drive in your desktop. Then the external devices 
will show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time. 

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. 
In the IGEL Setup client drive mapping can be found in: Sessions > Horizon Client > 
Horizon Client Global > Drive Mapping > Enable Drive Mapping. 
It is also recommended to disable local Storage Hotplug: On page Devices > Storage 
Devices > Storage Hotplug, put number of storage hotplug devices to 0. 
On the other hand, if you use drive mapping instead, it is recommended that you should 
either switch off USB redirection entirely or at least deny storage devices by adding a 
filter to the USB class rules. And because Horizon Client relies on the OS to mount the 
storage devices itself, please go to setup page: Devices > Storage Devices > Storage 
Hotplug and switch on Enable dynamic drive mapping and put Number of storage 
hotplug devices to at least 1.

Parallels Client

Native USB redirection does not work with Parallels Client.
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For using the new FIPS 140-2 compliance mode it is necessary to connect to the Parallels RAS
one time with FIPS support disabled.

Smartcard

In some cases there are instabilities when using A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The Console 
Invocation has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Hardware

Suspend on UD10 is disabled.
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New Features 10.05.700
RDP/IGEL RDP Client 2

Add field collection to RDP session server page.
More...

IGEL Setup Sessions > RDP > RDP Sessions > RDP Session > 
Server

Sessions > RDP > RDP Sessions > RDP Session > 
Options

Parameter Collection

Registry sessions.winconnect<NR>.option.load-

balance-info

VMware Horizon

Added parameters to specify webcam frame size and rate for RTAV. 
More...

Parameter Webcam frame width

Registry vmware.view.rtav-frame-width

Value <empty_string>

Parameter Webcam frame height

Registry vmware.view.rtav-frame-height

Value <empty_string>

Parameter Webcam frame rate

Registry vmware.view.rtav-frame-rate

Value <empty_string>

Firefox

Updated Mozilla Firefox to version 60.6.1ESR.
Fixes for mfsa2019-10, also known as: CVE-2019-9810, CVE-2019-9813.
Fixes for mfsa2019-08, also known as: CVE-2019-9790, CVE-2019-9791, CVE-2019-9792, 
CVE-2019-9793, CVE-2019-9795, CVE-2019-9796, CVE-2018-18506, CVE-2019-9788.
Fixes for mfsa2019-05, also known as: CVE-2018-18356, CVE-2019-5785.
Fixes for mfsa2019-02, also known as: CVE-2018-18500, CVE-2018-18505, CVE-2018-18501.
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Fixes for mfsa2018-30, also known as: CVE-2018-17466, CVE-2018-18492, CVE-2018-18493, 
CVE-2018-18494, CVE-2018-18498, CVE-2018-12405.
Added new parameters: Allow a custom command before and after browser session. 
More...

Parameter Initial Action

Registry sessions.browser%.init_action

Value <empty_string>

Parameter Final Action

Registry sessions.browser%.final_action

Value <empty_string>

OS 11 Upgrade

It is now possible to upgrade to IGEL OS 11. For more information, please see the particular 
section in kb.igel.com. The parameters for the upgrade:
More...

IGEL Setup System > Update > OS 11 Upgrade

Parameter Upgrade to OS 11

Registry update.firmware_migrate_to_11

Value enabled / disabled

IGEL Setup System > Update > OS 11 Upgrade

Parameter Upgrade to OS 11 even if a previous upgrade attempt 
failed

Registry update.force_firmware_migrate_to_11

Value enabled / disabled

IGEL Setup System > Update > OS 11 Upgrade

Parameter Upgrade to OS 11 even if PowerTerm is enabled

Registry update.migrate_to_11_with_powerterm

Value enabled / disabled

IGEL Setup System > Update > OS 11 Upgrade

Parameter Require an Enterprise Management Pack license to 
upgrade to OS 11



Notes for Release 10.05.700

IGEL OS Release Notes   1168 / 1492

•

Registry update.migrate_to_11_enterprise_require

d

Value [Smart] [Always] [Never]

IGEL Setup System > Update > OS 11 Upgrade

Parameter Timeout waiting for OS 11 license to start automatic 
upgrade

Registry update.migrate_to_11_license_timeout

Value [Disabled] [10 Minutes] [15 Minutes] [30 Minutes] [60 
Minutes]

The parameters for configuring the desktop integration of the IGEL OS 11 Upgrade tool are:
More...

IGEL Setup Accessories > OS 11 Upgrade

Parameter Start menu

Registry sessions.os11_migration0.startmenu

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Application Launcher

Registry sessions.os11_migration0.applaunch

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter System tab of start menu

Registry sessions.os11_migration0.startmenu_sy

stem

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter System tab of Application Launcher

Registry sessions.os11_migration0.applaunch_sy

stem
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Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Menu folder

Registry sessions.os11_migration0.menu_path

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Desktop folder

Registry sessions.os11_migration0.desktop_path

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Application Launcher folder

Registry sessions.os11_migration0.applaunch_pa

th

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Quick start panel

Registry sessions.os11_migration0.quick_start

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade

Parameter Password protection

Registry sessions.os11_migration0.pwprotected

Value [None] [Administrator] [User] [Setup user]

IGEL Setup Accessories > OS 11 Upgrade

Parameter Desktop

Registry sessions.os11_migration0.desktop

Value enabled / disabled

IGEL Setup Accessories > OS 11 Upgrade



Notes for Release 10.05.700

IGEL OS Release Notes   1170 / 1492

•

•

•

Parameter Desktop context menu

Registry sessions.os11_migration0.pulldown

Value enabled / disabled

Citrix

Updated Citrix HDX RTME used for optimization of Skype for Business to version 2.7.0-2113.

Parallels Client

Updated Parallels Client to version 16.5.2 (64-Bit)

CUPS Printing

Added SMB Network Print Client function. The printer could be created on page Devices > 
Printer > CUPS > Printers > Dialog, SMB Network Printer as Printer Port. The settings for the 
SMB printer must be done in Setup Registry:
More...

IGEL Setup Devices > Printer > CUPS > Printers > Dialog

Parameter Printer Port

Registry print.cups.printer<NR>.backend

Value [Parallel Port Printer] [Serial Port Printer] [USB Printer] [LPD 
Network Printer] [TCP Network Printer] [IPP Network 
Printer] [SMB Network Printer]

Parameter SMB Server

Registry print.cups.printer<NR>.smb_server

Parameter SMB Workgroup

Registry print.cups.printer<NR>.smb_workgroup

Parameter SMB Port

Registry print.cups.printer<NR>.smb_port

Value 0

Parameter SMB Printer

Registry print.cups.printer<NR>.smb_printer

Parameter SMB User

Registry print.cups.printer<NR>.smb_user
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Parameter SMB Password

Registry print.cups.printer<NR>.crypt_password

IBM_5250

Updated IBM iAccess Client Solutions to version 1.1.8.1.

WiFi

Added support for Realtek 8821CE wireless cards.
Added switch to determine the source of WiFi scan results within the Wireless Manager. 
Selecting default is currently identical with the old mechanism (using the iwlist  command). 

This may change in the future. When iwlist  fails, NetworkManager is automatically used as a 
fallback.
More...

Parameter WiFi Scanner

Registry network.interfaces.wirelesslan.device0.m

ssid_scanner

Range default / iwlist / NetworkManager

Info: "default" is currently equal to "iwlist"

X11 System

Added xprintidle tool to firmware.
The new Display Switch tool can use multiple different profiles, automatically chosen at 
runtime depending on the currently connected monitors. A profile is created, when the current 
monitor layout/resolution is configured via the Display Switch utility. The profile will be 
associated with the current connected displays automatically (manufacturer, model and used 
connector are used for allocation) and if applicable, the state of the laptop lid. The setup will be 
restored by hot-(un)plugging known displays, means the system will automatically switch to the 
already configured profile. The Display Switch utility itself got a new interface. All base 
functionality can be configured via drag & drop.
An example workflow:

Connect the hardware and close/open lid
Open the Display Switch Utility

A quick (simple) setting can be selected directly.
Should the desired application deviate from the possibilities provided, the 
Advanced button opens a drag & drop interface for further settings.

In this interface the displays can be dragged and dropped for the intended configuration. The 
display will snap adjacent to others.
If a display should not be used, it can be dragged to the Disabled area on the top right - the 
screen will be reactivated when it is dragged back to the active area.
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To show the same content on multiple displays, one display should be dragged onto an other 
active screen. The interface will show Mirror. The mirroring monitor will be displayed on the lower 
right.
With the Apply button the current state will be set, with Yes on the Keep configuration dialog the 
current settings will be saved to persistent storage and associated with the profile.
Advanced functionality (panning/scaling/resolutions) can be configured in drop-down boxes, 
hidden in a drawer on the right side. The drawer can be expanded by clicking the < button on the 
right edge.
For the Display Switch functionality the following parameters should be enabled for proper 
usage:
More...

IGEL Setup Accessories > Display Switch > Options

Parameter Preserve settings over reboot

Registry sessions.user_display0.options.preserv

e_settings

Value enabled / disabled

IGEL Setup Accessories > Display Switch > Options

Parameter Smart display configuration

Registry x.auto_associate

Value enabled / disabled

The IGEL Display Switch utility is now used for NVIDIA graphics devices as well.

Smartcard

Updated SecMaker NetiD to version 6.7.2.36: now Yubikey 5 is supported.
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Resolved Issues 10.05.700
Citrix

Appropriate icons arise with IGEL and Citrix authentication
Fixed crash when H.264 acceleration and RTME will be used on two or more concurrent VDI 
sessions.

VMware Horizon

Added recognition for password-change-dialog in Horizon local-logon sessions or appliance 
mode.
Fixed optimization for Skype for Business.
Added switch to use system-wide proxy in VMware Horizon appliance mode.
More...

Parameter Use the systemwide proxy

Registry vmwarevdmapp.use_proxy

Value enabled/ disabled

Parallels Client

Fixed: Maximized windows for published applications can be displayed incorrectly.
Fixed: Incorrect user credentials can be picked up during connection, when same farm is 
registered multiple times with different user credentials
Fixed: Linux client not consider universal printing policies, set from the server

PowerTerm

Fixed editing of parameter sessions.powerterm\<INST>.logindialog.loginscript
in Setup Registry: now multiple lines are possible.

Firefox

Fixed an occasional issue with Firefox not being in fullscreen after a suspend.

Network

Improved SCEP client robustness
The cert_agent script does not terminate anymore, when a problem occurs (e.g. the SCEP 
server is unreachable) but tries again after the expiry check interval.
When the client certificate has expired, there is still one attempt for a renewal. However, 
when that fails, a new one is requested. That obviously will fail, if the client presents a 
challenge password that is not valid anymore.

Improved expiration time of ethernet no-link notification
Fixed MBB router configuration (broken since 10.05.500)
Added all Ethernet network drivers from OS to LX version.
Changed e1000e driver to 3.4.2.3 - directly from Intel.
Changed igb driver to 5.3.5.22 - also directly from Intel.
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Smartcard

Fixed OpenSC setting max_send_size for reader driver pcsc in /etc/opensc/opensc.conf .
Fixed Dell KB813 Smartcard Keyboard in combination with certain smartcards, driven by 
OpenSC PKCS#11 module. Before this fix, authentication to Citrix StoreFront and VMWare Horizon 
failed.

Application Launcher

Fixed confusion in nameserver list caused by comments in  /etc/resolv.conf

Base system

Fixed sporadic bootsplash issue.
Fixed Screensaver and Screenlock timeouts to be independent. When both timeouts are set, the 
start of screenlock will not reset the screensaver timeout anymore.
Added package ldap-utils which could be used via custom scripts.
Fixed playback of AAC coded audio streams on IGEL Zero products.
Fixed delay in logon as local user, when logon with IGEL Smartcard is also active.
Fixed random 90 seconds shutdown delay (systemd).
Fixed custom bootsplash installation.

Appliance Mode

Fixed a regression in 10.05.570 that prevents appliance mode from restarting after a suspend.

Storage Devices

Fixed auto mounting of storage devices inside of Olympus DS-9500 Digital Voice Recorder.

Base System

Fixed issues with gen4/5 intel graphic driver in kernel 4.18.20.
Fixed suspend/resume hangs when logged into Citrix sessions.
Fixed CPU scaler and volume control applet suspend/resume issue.

X11 system

Fixed the missing volume control in the panel, when the panel is configured to disappear while 
the login/lock screen is shown.
The In-Session Control Bar now scales with the current DPI setting.
There is now a registry key to ignore a 3Dconnexion SpaceMouse for IGEL graphical use (X11). If 
activated, the SpaceMouse is only passed thru to the desktop session. If false, it acts like the 
standard mouse.
More...

Parameter Deactivates a 3Dconnexion SpaceMouse as a standard 
mouse

Registry userinterface.mouse.spacemouse.x11_ignor

e

Value enabled/ disabled
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The following SpaceMouse products are included (VID, PID, Vendor, Product).
More...

0x046D; 0xC603; Logitech, Inc.; 3Dconnexion Spacemouse Plus XT

0x046D; 0xC605; Logitech, Inc.; 3Dconnexion CADman

0x046D; 0xC606; Logitech, Inc.; 3Dconnexion Spacemouse Classic

0x046D; 0xC621; Logitech, Inc.; 3Dconnexion Spaceball 5000

0x046D; 0xC623; Logitech, Inc.; 3Dconnexion Space Traveller 3D Mouse

0x046D; 0xC625; Logitech, Inc.; 3Dconnexion Space Pilot 3D Mouse

0x046D; 0xC626; Logitech, Inc.; 3Dconnexion Space Navigator 3D Mouse

0x046D; 0xC627; Logitech, Inc.; 3Dconnexion Space Explorer 3D Mouse

0x046D; 0xC628; Logitech, Inc.; 3Dconnexion Space Navigator for Notebooks

0x046D; 0xC629; Logitech, Inc.; 3Dconnexion SpacePilot Pro 3D Mouse

0x046D; 0xC62B; Logitech, Inc.; 3Dconnexion Space Mouse Pro

0x256F; **; 3Dconnexion; SpaceMouse

USB device reset via USB powercycle on UD6 / UD7 available.
Fixed screen flicker in some cases if Force NumLock On ( x.global.forcenumlock ) is 
active.

Caradigm

Fixed Horizon session teardown.

Window manager

Fixed option to disable the local window manager.

Audio

Fixed bad quality sound over DisplayPort in a Citrix ICA session or other applications using ALSA 
API.
Fixed configuration of default audio output and input.

Hardware

Added possibility to use AMDGPU PRO driver instead of the kernel integrated driver.
More...

Parameter Use AMDGPU PRO driver

Registry x.drivers.amdgpu.use_amdgpu_pro

Value [Auto] [True] [False]

Info: Settings to this key will only work after reboot.

IGEL Cloud Gateway
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Fixed support for UMS file transfer status in ICG protocol.
When TC is managed over ICG, settings received in connection stage will not be applied 
immediately. The settings must be applied after user prompt dialog.



Notes for Release 10.05.500

IGEL OS Release Notes   1177 / 1492

•
•
•

Notes for Release 10.05.500
Software: Version 10.05.500

Release Date: 2018-12-20

Release Notes: Version RN-105500-1

Last update: 2018-12-20

IGEL Linux Universal Desktop (see page 1178)
IGEL Universal Desktop OS3/IGEL UD Pocket (see page 1197)
IGEL Universal Desktop Converter (UDC3) (see page 1216)
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IGEL Linux Universal Desktop

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD3-LX 42

UD3-LX 41

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Component Versions 10.05.500 (see page 1179)
General Information 10.05.500 (see page 1183)
Known Issues 10.05.500 (see page 1184)
New Features 10.05.500 (see page 1186)
Resolved Issues 10.05.500 (see page 1193)
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Component Versions 10.05.500
Clients
Product Version

Citrix HDX Realtime Media Engine 2.6.0-2030

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 18.10.0.11

deviceTRUST Citrix Channel 19.1.100.0

deviceTRUST RDP Channel 19.1.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.3.0

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_192

Parallels Client (32 bit) 16.5.2.20588

Parole Media Player 1.0.1-0ubuntu1igel16

Remote Viewer (RedHat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0

Systancia AppliDis 4.0.0.17
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Thinlinc Client 4.9.0-5775

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

VMware Horizon Client 4.10.0-11053294

VNC Viewer 1.8.0+git20180123-igel1

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.6.36

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.0.23

Reader Driver ACS CCID 1.1.5

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.28

Reader Driver REINER SCT cyberJack 3.99.5final.SP11

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.13

OpenSSH Client 7.2p2-4ubuntu2.4

OpenSSH Server 7.2p2-4ubuntu2.4

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.2.1-1igel51

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20181113-igel846

Graphics Driver ATI/RADEON 18.0.1-1igel831

Graphics Driver ATI/AMDGPU 18.0.1-1igel831

Graphics Driver VIA 5.76.52.92-009-005f78-20150730

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.3.4-1build2igel639

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver Vmmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-ud-r2481

Xorg X11 Server 1.19.6-1ubuntu4igel838

Xorg Xephyr 1.19.6-1ubuntu4igel832

CUPS printing daemon 2.1.3-4ubuntu0.5igel20

PrinterLogic 18.2.1.128
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Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel653

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2igel1

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.2-1ubuntu1igel192

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.1
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General Information 10.05.500
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
Remote Access via RSH
Legacy Philips Speech Driver
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
Video Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41,
UD3-LX 40 (M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
H.264 Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41,
UD3-LX 40 (M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
Storage Hotplug devices are not automatically removed anymore, instead they
must be always ejected manually:

by panel tray icon
by an icon in the In-Session Control Bar (configurable at IGEL Setup > User Interface > 
Desktop)

by a Safely Remove Hardware session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in this release:

Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
Composite Manager
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Known Issues 10.05.500
Citrix

With activated DRI3 and an amd gpu citrix h264 acceleration plugin could freeze. Selective 
H.264 mode (api v2) is not affected from this issue.
Citrix has known issues with gstreamer1.0 which describe problems with multimedia redirection 
of H264, MPEG1 and PEG2. Gstreamer1.0 is used if browser content redirection is active.

Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.

Citrix StoreFront Login with Gemalto smartcard middleware does not detect smartcard 
correctly if the card is inserted after start of Login. As a workaround, insert the smartcard before 
starting StoreFront Login.
When using Citrix Workspace App 18.10 in combination with Philips Speech driver, the session 
occasionally does not properly terminate at logoff and hangs. As a workaround, usage of Citrix 
Receiver 13.10 is recommended when Philips Speech driver is needed.
Citrix H264 acceleration plugin does not work with **enabled** server policy "Optimize for 3D 
graphics workload" in combination with server policy Use video codec compression > For the 
entire screen.
When Expand the session over a self-selected number of monitors (for "Multi-Monitor full 
screen mode") is used and setup is restarted, Restrict full screen session to one monitor is 
indicated and the monitor selection is greyed out. The functionality is available, only the 
notification in setup is broken.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive in your desktop. Then the external devices will 
show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, if you want to use USB redirection for your storage devices.

On the other hand, if you use drive mapping instead, it is recommended that you should 
either switch off USB redirection entirely or at least deny storage devices by adding a filter 
to the USB class rules. And because Horizon Client relies on the OS to mount the storage 
devices itself, please go to setup page: Devices > Storage Devices > Storage Hotplug and 
switch on Enable dynamic drive mapping and put Number of storage hotplug devices to 
at least 1.

Parallels Client

Note that the USB on-insertion feature is only working if the Client Drive Mapping is 
switched off. In the IGEL Setup client drive mapping can be found in: Sessions > Horizon 
Client > Horizon Client Global > Drive Mapping > Enable Drive Mapping.
It is also recommended to disable local Storage Hotplug: On page Devices > Storage 
Devices > Storage Hotplug, put number of storage hotplug devices to 0.


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Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode it is necessary to connect to the Parallels RAS one 
time with FIPS support disabled.

Smartcard

In some cases, there are instabilities when using A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The "Console 
Invocation" has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Hardware

Suspend on UD10 is disabled.

IGEL Cloud Gateway

No support for UMS file transfer status in ICG protocol.
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New Features 10.05.500
Citrix

Integrated Citrix Workspace app 18.10.
There is now a registry key to enable Citrix Workspace App selfservice web UI mode. 
More...

ParameterEnable Citrix Workspace app self-service web UI mode

Registry ica.authman.cwacapableenabled

Value enabled / disabled

There is now a registry key to make a Bloomberg v4 keyboard available across multiple 
sessions. Additionally USB redirection has to enabled at least for this device: vid=1188 
pid=9545.
More...

ParameterBloomberg v4 keyboard

Registry ica.allregions.bloombergredirection

Value default / true / false

Removed parameter for Citrix Cloud. This parameter is not needed anymore.
More...

IGEL SetupSessions > Citrix > Citrix Global > Options

Parameter Connect to cloud

Registry ica.cloudconnect

Citrix client version 13.9.1 was removed.
Available Citrix client versions: 13.5.0, 13.10, 18.10 (default)
It is now possible to span a Citrix session over a self-defined number of consecutive monitors. 
For this, the parameter ica.wfclient.usexdgfullscreen  must be deactivated and 

ica.pnlogin.spanmonitorenable  activated. The selection must be defined in the 

parameter ica.pnlogin.spanmonitor .
More...

IGEL SetupSessions > Citrix > Citrix Global > Window

Parameter Expand the session over a self-selected number of monitors

Registry ica.pnlogin.spanmonitorenable

Value enabled / disabled
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IGEL Setup Sessions > Citrix > Citrix Global > Window

Parameter Monitor selection

Registry ica.pnlogin.spanmonitor

Value " "

Sample: When using four monitors and expansion of session across monitor 2, 3 and 4 is 
wanted, insertion should be 2,3,4 or 2,4.

Setup renaming
More...

Old Name New Name

Citrix XenDesktop / XenApp Citrix

Citrix Receiver Selection Citrix Workspace Client Selection

Citrix Receiver version Citrix Client version

HDX / ICA Global Citrix Global

Legacy ICA Sessions Citrix Legacy ICA Sessions

Citrix Storefront/Webinterface Citrix Storefront

XenApp Citrix Virtual Apps

XenDesktop Citrix Virtual Desktops

XenApp / XenDesktop Citrix Virtual Apps / Desktops

Server Location: XenApp 6.x or older Server Location: Web Interface

Server Location: XenApp/XenDesktop 7.x Store Server Location: Storefront

Server Location: XenApp/XenDesktop 7.x 
Legacy Mode

Server Location: StoreFront Legacy Mode

Updated deviceTrust client to version 19.1.100.

IGEL Linux Recovery

Enhanced IGEL Linux Recovery installer by a new option to force a legacy installation if booted in 
EFI mode.
Updated preparestick tool to version 3.3.0.0 with the following fixes:

WMI NullReferenceException
dd.exe Processbar asynchronous

diskpart->clean failed with access denied

RDP/IGEL RDP Client 2
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Updated deviceTrust client to version 19.1.100.

VMware Horizon

Updated Horizon Client for Linux to version 4.10.0-11053294. Added support for the new 
features:

H.264 High Color Accuracy
More...

IGEL SetupSessions > Horizon Client > Horizon Client Global > Server Options

Parameter High Color Accuracy mode

Registry vmware.view.high-color-accuracy-mode

Value enabled / disabled

Serial port redirection support
More...

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Serial Port 
Redirection

Parameter Serial Port Redirection

Registry vmware.view.high-color-accuracy-mode

Value enabled / disabled

High resolution display scaling and DPI synchronisation
More...

Parameter Display Scaling

Registry vmware.view.use-display-scaling

Value enabled / disabled

Relative mouse support
More...

Parameter Relative Mouse Feature for a Remote Desktop

Registry vmware.view.enable-relative-mouse

Value enabled / disabled

Automatically hide toolbar
More...

Parameter Auto-hide menu bar (tool bar)
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Registry vmware.view.menu-bar-auto-hide

Value enabled / disabled

Parallels Client

Updated Parallels Client to version 16.5.2
Fixed: Remote session closes triggered by audio playback

IBM_5250

Enhanced configuration of IBM iAccess Client. The following parameters were added:
More...

Parameter Open new sessions in a new tab

Registry ibm.iaccess.acssm.opensessionintab

Value enabled / disabled

ParameterAlways display the tab bar

Registry ibm.iaccess.acssm.alwaysshowtabbar

Value enabled / disabled

Parameter Switch to new tab when created

Registry ibm.iaccess.acssm.switchtonewtab

Value enabled / disabled

ParameterSend a warning when closing multiple tabs

Registry ibm.iaccess.acssm.closemultipletabwarning

Value enabled / disabled

ParameterDo not start tabbed sessions until the tab is selected

Registry ibm.iaccess.acssm.tabdelayedstart

Value enabled / disabled

ParameterNew Tab Action

Registry ibm.iaccess.acssm.newtabaction

Range [Disable and Hide] [Run the Same] [Run Other...]

ParameterTab Placement
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Registry ibm.iaccess.acssm.tabplacement

Range [Top][Bottom] [Left] [Right]

ParameterList of visible menu entries

Registry ibm.sessions.iaccess%.options.deletemenus

Value list of visible menu entries

Firefox

Updated Mozilla Firefox to version 60.3.0ESR 
Fixes for mfsa2018-27, also known as: CVE-2018-12392, CVE-2018-12393, CVE-2018-12395, 
CVE-2018-12396, CVE-2018-12397, CVE-2018-12389, CVE-2018-12390.

Cisco JVDI Client

Updated Cisco JVDI client to version 12.1

Base system

Updated French and Dutch user interface translation.

Driver

Philips Speech Drivers for Citrix and RDP version 12.6.36 
Support of the new Philips dictation devices SpeechOne 6000 and SpeechAir 2000

Audio

Added support for Jabra Xpress mechanism to deploy firmware updates and settings on Jabra 
USB headsets.
More...

ParameterFile name of Xpress package

Registry jabra.xpress.package_name

ParameterURL hosting Xpress packages

Registry jabra.xpress.package_url

ParameterLogin name for access to Xpress package URL

Registry jabra.xpress.package_url_login

ParameterPassword for access to Xpress package URL

Registry jabra.xpress.package_url_crypt_password

ParameterCheck SSL certificate



Notes for Release 10.05.500

IGEL OS Release Notes   1191 / 1492

•

•

•

Registry jabra.xpress.package_url_ssl_cert_check

Value enabled / disabled

ParameterURL of the Audio Device Dashboard server

Registry jabra.xpress.device_dashboard.server_url

Added suspend on idle for Jabra wireless headsets. The headsets are set to offline state after 5 
seconds of idle time.
More...

ParameterSuspend on idle

Registry devices.jabra.suspend_on_idle

Value enabled / disabled

Added parameters to configure the deferred volume synchronization in Pulseaudio.
More...

ParameterEnable deferred volume

Registry multimedia.pulseaudio.daemon.enable-deferred-volume

Value enabled / disabled

ParameterSafety margin

Registry multimedia.pulseaudio.daemon.deferred-volume-safety-

margin-usec

Value 8000

ParameterExtra delay

Registry multimedia.pulseaudio.daemon.deferred-volume-extra-

delay-usec

Value 0

Added a parameter to force configured volumes for in- and output devices in Pulseaudio.
More...

ParameterForce Volume Settings

Registry userinterface.sound.force

Value enabled / disabled



Notes for Release 10.05.500

IGEL OS Release Notes   1192 / 1492

•

•

Java

Updated Oracle Java Runtime Environment to version 1.8.0 U192.

IGEL Cloud Gateway

Added support for ICG High Availability and ICG load balancing to the IGEL remote management 
service.
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Resolved Issues 10.05.500
Citrix

Fixed tool icacontrol
Added: clear error message is returned when a published desktop is occupied by another user.
Added: clear error message is returned when misconfiguration inhibits start of an application.

RDP/IGEL RDP Client 2

Fixed login error message being displayed in English only.
Allow server side per user scaling for multimonitor configurations as well (RDP sessions 
desktop scaling factor must be set to 100% for this to work):

Global setting
More...

IGEL Setup Sessions > RDP > RDP Global > Window

Parameter Desktop scale factor

Registry rdp.winconnect.desktop-scale-

factor

Value auto / 100% / 125% / 150%

Session setting
More...

IGEL Setup Sessions > RDP > RDP Sessions > **RDP Session** 
> Window

Parameter Desktop scale factor

Registry sessions.winconnect%.option.desktop

-scale-factor

Value Global setting / auto / 100% / 125% / 150%

Evidian

Fixed NLA support in Evidian AuthMgr RDP session type

Network

Fixed handling of the following registry keys:
network.interfaces.wirelesslan.device0.driver.disable_ht

network.interfaces.wirelesslan.device0.driver.chain_num

network.interfaces.wirelesslan.device0.driver.cfg80211.cfg80211

_disable_40mhz_24ghz
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The first and the second parameters only affect the driver rt2800ub (used e.g.for Ralink RT3372 
and RT5572)
Fixed iptables IPv6 support by adding IPv6 netfilter kernel modules.

WiFi

Fixed connection to hidden WiFi networks

Cisco JVDI Client

Fixed: Applications are now startable via desktop, start menu and application launcher.
Fixed Webcam support with 32Bit Citrix Receiver for JVDI.

Open VPN

Fixed desktop folder support for OpenVPN session.

Smartcard

Improved waiting for smartcard events.

Base system

IGEL Setup Assistant will no longer start multiple times, the existing instance will be raised 
instead.
Fixed automatic firmware update on shutdown.

Storage Devices

Fixed potential hangs on suspend/shutdown when a USB memory stick was in use at that time.

X11 system

Fixed huge icons in GTK applications when DPI setting was below 96.
Fixed problems with Avaya VDI Communicator and webcams.
Disabled SNA sprite X video support as default because it is unstable and could crash X server.

New registry key:
More...

Parameter Use SNA sprite video feature (could be unstable)

Registry x.drivers.intel.sprite_video

Value enabled / disabled

Window manager

Fixed the custom UI colors for the window manager decoration that was broken in 10.05.100. 
The custom UI colors are now applied to the window borders again.

Audio

Applied workarounds concerning USB control requests on Plantronics C510 and 520.
Fixed initialization of sound card in Dell Wyse 3040.
Fixed blocking mode in compatibility Pulseaudio PCM plugin for ALSA. The blocking mode is 
used by Parallels client to playback sound.

Media Player (Parole)
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Parole media player now displays a looping animation while initiating the connection for rtmp 
streams.
Extended integration of Parole media player configuration in the setup. The following 
configuration keys are now respected.
More...

IGEL Setup Sessions > Media Player > Media Player Global > 
Window 

Parameter Automatically resize the player window when a new 
video is loaded

Registry multimedia.mediaplayer.auto_resize

Value enabled / disabled

IGEL Setup Sessions > Media Player > Media Player Global > 
Window 

Parameter Main window should stay on top

Registry multimedia.mediaplayer.window_on_top

Value enabled / disabled

IGEL Setup Sessions > Media Player > Media Player Global > 
Options 

Parameter Network connection speed

Registry multimedia.mediaplayer.connection_spee

d

Range [56 kbps Modem/ISDN] [112 kbps Dual ISDN/DSL]

[256 kbps DSL/Cable] [384 kbps DSL/Cable]

[512 kbps DSL/Cable] [1.5 mbps T1/Intranet/LAN]

[Intranet/LAN]

Parameter Enable debug

Registry multimedia.mediaplayer.debug

Value enabled / disabled

Evidian

Added support to log out Citrix session type on tap event.
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More...

Parameter Logout behavior

Registry evidian.sessiontype.ctx.pnlogout

Value [Default] [Force disconnect] [Force logoff]

Hardware

Fixed problems with mouse cursor on intel cherryview devices.
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IGEL Universal Desktop OS3/IGEL UD Pocket
Supported Hardware:

https://kb.igel.com/igelos/en/devices-supported-by-udc3-and-ud-pocket-3117174.html

Component Versions 10.05.500 (see page 1198)
General Information 10.05.500 (see page 1202)
Known Issues 10.05.500 (see page 1203)
New Features 10.05.500 (see page 1205)
Resolved Issues 10.05.500 (see page 1212)
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Component Versions 10.05.500
Clients
Product Version

Citrix HDX Realtime Media Engine 2.6.0-2030

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Workspace App 18.10.0.11

deviceTRUST Citrix Channel 19.1.100.0

deviceTRUST RDP Channel 19.1.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.3.0

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_192

Parallels Client (32 bit) 16.5.2.20588

Parole Media Player 1.0.1-0ubuntu1igel16

Remote Viewer (RedHat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0

Systancia AppliDis 4.0.0.17
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Thinlinc Client 4.9.0-5775

ThinPrint Client 7.5.88

Totem Media Player 2.30.2

VMware Horizon Client 4.10.0-11053294

VNC Viewer 1.8.0+git20180123-igel1

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.6.36

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.0.23

Reader Driver ACS CCID 1.1.5

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.28

Reader Driver REINER SCT cyberJack 3.99.5final.SP11

Resource Manager PC/SC Lite 1.8.23-1igel1

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.13

OpenSSH Client 7.2p2-4ubuntu2.4

OpenSSH Server 7.2p2-4ubuntu2.4

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.2.1-1igel51

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20181113-igel846

Graphics Driver ATI/RADEON 18.0.1-1igel831

Graphics Driver ATI/AMDGPU 18.0.1-1igel831

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2igel775

Graphics Driver Nvidia 390.87-0ubuntu1

Graphics Driver Vboxvideo 5.2.18-dfsg-2igel17

Graphics Driver VMware 13.3.0-2igel812

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.3.4-1build2igel639

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver Vmmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-udos-r2481
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Xorg X11 Server 1.19.6-1ubuntu4igel838

Xorg Xephyr 1.19.6-1ubuntu4igel832

CUPS printing daemon 2.1.3-4ubuntu0.5igel20

PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel653

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2igel1

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.2-1ubuntu1igel192

Python2 2.7.12

Python3 3.5.2

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.1
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General Information 10.05.500
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
Remote Access via RSH
Legacy Philips Speech Driver
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
VIA Graphics Support
Storage Hotplug devices are not automatically removed anymore, instead they
must be always ejected manually:

by panel tray icon
by an icon in the In-Session Control Bar (configurable at IGEL Setup > User Interface > 
Desktop)

by a Safely Remove Hardware session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in this release:

Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
Composite Manager
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Known Issues 10.05.500
Citrix

With activated DRI3 and an amd gpu citrix h264 acceleration plugin could freeze. Selective 
H.264 mode (api v2) is not affected from this issue.
Citrix has known issues with gstreamer1.0 which describe problems with multimedia redirection 
of H264, MPEG1 and PEG2. Gstreamer1.0 is used if browser content redirection is active.

Browser content redirection does not work with activated DRI3 and hardware accelerated 
H.264 deep compression codec.

Citrix StoreFront Login with Gemalto smartcard middleware does not detect smartcard 
correctly if the card is inserted after start of Login. As a workaround, insert the smartcard before 
starting StoreFront Login.
When using Citrix Workspace App 18.10 in combination with Philips Speech driver, the session 
occasionally does not properly terminate at logoff and hangs. As a workaround, usage of Citrix 
Receiver 13.10 is recommended when Philips Speech driver is needed.
Citrix H264 acceleration plugin does not work with **enabled** server policy "Optimize for 3D 
graphics workload" in combination with server policy Use video codec compression > For the 
entire screen.
When Expand the session over a self-selected number of monitors (for "Multi-Monitor full 
screen mode") is used and setup is restarted, Restrict full screen session to one monitor is 
indicated and the monitor selection is greyed out. The functionality is available, only the 
notification in setup is broken.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: map the directory /media as a drive in your desktop. Then the external devices will 
show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, if you want to use USB redirection for your storage devices.

On the other hand, if you use drive mapping instead, it is recommended that you should 
either switch off USB redirection entirely or at least deny storage devices by adding a filter 
to the USB class rules. And because Horizon Client relies on the OS to mount the storage 
devices itself, please go to setup page: Devices > Storage Devices > Storage Hotplug and 
switch on Enable dynamic drive mapping and put Number of storage hotplug devices to 
at least 1.

Parallels Client

Note that the USB on-insertion feature is only working if the Client Drive Mapping is 
switched off. In the IGEL Setup client drive mapping can be found in: Sessions > Horizon 
Client > Horizon Client Global > Drive Mapping > Enable Drive Mapping.
It is also recommended to disable local Storage Hotplug: On page Devices > Storage 
Devices > Storage Hotplug, put number of storage hotplug devices to 0.


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Native USB redirection does not work with Parallels Client.
For using the new FIPS 140-2 compliance mode it is necessary to connect to the Parallels RAS one 
time with FIPS support disabled.

Base system

Display resolution and rotation could not be changed with nvidia gpu driver via tcsetup.

Multimedia

Multimedia redirection with gstreamer could fail with nouveau gpu driver.

Smartcard

In some cases, there are instabilities when using A.E.T. SafeSign smartcards.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi firefox plugin is no longer supported. The "Console 
Invocation" has to allow Native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.

Hardware

Suspend on UD10 is disabled.

IGEL Cloud Gateway

No support for UMS file transfer status in ICG protocol.
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New Features 10.05.500
Citrix

Integrated Citrix Workspace app 18.10.
There is now a registry key to enable Citrix Workspace App selfservice web UI mode. 
More...

ParameterEnable Citrix Workspace app self-service web UI mode

Registry ica.authman.cwacapableenabled

Value enabled / disabled

There is now a registry key to make a Bloomberg v4 keyboard available across multiple 
sessions. Additionally USB redirection has to enabled at least for this device: vid=1188 
pid=9545.
More...

ParameterBloomberg v4 keyboard

Registry ica.allregions.bloombergredirection

Value default / true / false

Removed parameter for Citrix Cloud. This parameter is not needed anymore.
More...

IGEL SetupSessions > Citrix > Citrix Global > Options

Parameter Connect to cloud

Registry ica.cloudconnect

Citrix client version 13.9.1 was removed.
Available Citrix client versions: 13.5.0, 13.10, 18.10 (default)
It is now possible to span a citrix session over a self-defined number of consecutive monitors. 
For this, the parameter  ica.wfclient.usexdgfullscreen  must be deactivated 

and  ica.pnlogin.spanmonitorenable  activated. The selection must be defined in the 

parameter  ica.pnlogin.spanmonitor .
More...

IGEL SetupSessions > Citrix > Citrix Global > Window

Parameter Expand the session over a self-selected number of monitors

Registry ica.pnlogin.spanmonitorenable

Value enabled / disabled
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IGEL Setup Sessions > Citrix > Citrix Global > Window

Parameter Monitor selection

Registry ica.pnlogin.spanmonitor

Value " "

Sample: When using four monitors and expansion of session across monitor 2, 3 and 4 is 
wanted, insertion should be 2,3,4 or 2,4.

Setup renaming
More...

Old Name New Name

Citrix XenDesktop / XenApp Citrix

Citrix Receiver Selection Citrix Workspace Client Selection

Citrix Receiver version Citrix Client version

HDX / ICA Global Citrix Global

Legacy ICA Sessions Citrix Legacy ICA Sessions

Citrix Storefront/Webinterface Citrix Storefront

XenApp Citrix Virtual Apps

XenDesktop Citrix Virtual Desktops

XenApp / XenDesktop Citrix Virtual Apps / Desktops

Server Location: XenApp 6.x or older Server Location: Web Interface

Server Location: XenApp/XenDesktop 7.x Store Server Location: Storefront

Server Location: XenApp/XenDesktop 7.x 
Legacy Mode

Server Location: StoreFront Legacy Mode

Updated deviceTrust client to version 19.1.100.

UDC3 Installer

Added UEFI support in UDC Deployment Appliance 5.0, downloadable via download section on 
www.igel.com44

Enhanced UDC3 Converter by a new option to force MS-DOS partitioning for EFI installations.
Updated "preparestick" tool to version 3.3.0.0 with the following fixes:

WMI NullReferenceException
dd.exe Processbar asynchronous

diskpart->clean failed with access denied

http://www.igel.com
http://www.igel.com
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RDP/IGEL RDP Client 2
Updated deviceTrust client to version 19.1.100.

VMware Horizon
Updated Horizon Client for Linux to version 4.10.0-11053294. Added support for the new 
features:

H.264 High Color Accuracy
More...

IGEL 
Setup

Sessions > Horizon Client > Horizon Client Global > Server 
Options

ParameterHigh Color Accuracy mode

Registry vmware.view.high-color-accuracy-mode

Value enabled / disabled

Serial port redirection support
More...

IGEL 
Setup

Sessions > Horizon Client > Horizon Client Global > Serial Port 
Redirection

Paramet
er

Serial Port Redirection

Registry vmware.view.high-color-accuracy-mode

Value enabled / disabled

High resolution display scaling and DPI synchronisation
More...

ParameterDisplay Scaling

Registry vmware.view.use-display-scaling

Value enabled / disabled

Relative mouse support
More...

ParameterRelative Mouse Feature for a Remote Desktop

Registry vmware.view.enable-relative-mouse

Value enabled / disabled

Automatically hide toolbar
More...

ParameterAuto-hide menu bar (tool bar)
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Registry vmware.view.menu-bar-auto-hide

Value enabled / disabled

Parallels Client
Updated Parallels Client to version 16.5.2

Fixed: Remote session closes triggered by audio playback
IBM_5250

Enhanced configuration of IBM iAccess Client. The following parameters were added:
More...

ParameterOpen new sessions in a new tab

Registry ibm.iaccess.acssm.opensessionintab

Value enabled / disabled

ParameterAlways display the tab bar

Registry ibm.iaccess.acssm.alwaysshowtabbar

Value enabled / disabled

ParameterSwitch to new tab when created

Registry ibm.iaccess.acssm.switchtonewtab

Value enabled / disabled

ParameterSend a warning when closing multiple tabs

Registry ibm.iaccess.acssm.closemultipletabwarning

Value enabled / disabled

ParameterDo not start tabbed sessions until the tab is selected

Registry ibm.iaccess.acssm.tabdelayedstart

Value enabled / disabled

ParameterNew Tab Action

Registry ibm.iaccess.acssm.newtabaction

Range [Disable and Hide] [Run the Same] [Run Other...]

ParameterTab Placement

Registry ibm.iaccess.acssm.tabplacement
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Range [Top][Bottom] [Left] [Right]

ParameterList of visible menu entries

Registry ibm.sessions.iaccess%.options.deletemenus

Value list of visible menu entries

Firefox
Updated Mozilla Firefox to version 60.3.0ESR 
Fixes for mfsa2018-27, also known as: CVE-2018-12392, CVE-2018-12393, CVE-2018-12395, 
CVE-2018-12396, CVE-2018-12397, CVE-2018-12389, CVE-2018-12390.

Cisco JVDI Client
Updated Cisco JVDI client to version 12.1

Base system
Updated French and Dutch user interface translation.

Driver
Philips Speech Drivers for Citrix and RDP version 12.6.36 
Support of the new Philips dictation devices SpeechOne 6000 and SpeechAir 2000

Audio
Added support for Jabra Xpress mechanism to deploy firmware updates and settings 
on Jabra USB headsets.
More...

ParameterFile name of Xpress package

Registry jabra.xpress.package_name

ParameterURL hosting Xpress packages

Registry jabra.xpress.package_url

ParameterLogin name for access to Xpress package URL

Registry jabra.xpress.package_url_login

ParameterPassword for access to Xpress package URL

Registry jabra.xpress.package_url_crypt_password

ParameterCheck SSL certificate

Registry jabra.xpress.package_url_ssl_cert_check

Value enabled / disabled

ParameterURL of the Audio Device Dashboard server

Registry jabra.xpress.device_dashboard.server_url
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Added suspend on idle for Jabra wireless headsets. The headsets are set to offline state 
after 5 seconds of idle time.
More...

ParameterSuspend on idle

Registry devices.jabra.suspend_on_idle

Value enabled / disabled

Added parameters to configure the deferred volume synchronization in Pulseaudio.
More...

ParameterEnable deferred volume

Registry multimedia.pulseaudio.daemon.enable-deferred-

volume

Value enabled / disabled

ParameterSafety margin

Registry multimedia.pulseaudio.daemon.deferred-volume-

safety-margin-usec

Value 8000

ParameterExtra delay

Registry multimedia.pulseaudio.daemon.deferred-volume-

extra-delay-usec

Value 0

Added a parameter to force configured volumes for in- and output devices in Pulseaudio.
More...

ParameterForce Volume Settings

Registry userinterface.sound.force

Value enabled / disabled

Hardware

Added LG CK 500 to supported hardware.
Added Dell Wyse 5070 to supported hardware.
Known issues: 

Headset connectors sometimes not recognises a plugged device. 
USB3.0 ports on back panel sporaradic not recognises USB3.0 devices correctly.
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USB-C front displayport usage is not recommended, connection problems could occur. 
Wake-up after standby could lead to delay when using multimonitor setup 
Screen rotation does not work reliable

Added ONYX VENUS 223 to supported hardware.
Added support for following Plantronics devices:

Blackwire 5210 
Voyager Focus UC B825 
Voyager 8200 UC

Java

Updated Oracle Java Runtime Environment to version 1.8.0 U192.

IGEL Cloud Gateway

Added support for ICG High Availability and ICG load balancing to the IGEL remote management 
service.
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Resolved Issues 10.05.500
Citrix

Fixed tool icacontrol
Added: clear error message is returned when a published desktop is occupied by another user.
Added: clear error message is returned when misconfiguration inhibits start of an application.

RDP/IGEL RDP Client 2

Fixed login error message being displayed in English only.
Allow server side per user scaling for multimonitor configurations as well (RDP sessions 
desktop scaling factor must be set to 100% for this to work):

Global setting
More...

IGEL Setup Sessions > RDP > RDP Global > Window

Parameter Desktop scale factor

Registry rdp.winconnect.desktop-scale-

factor

Value auto / 100% / 125% / 150%

Session setting
More...

IGEL Setup Sessions > RDP > RDP Sessions > **RDP Session** 
> Window

Parameter Desktop scale factor

Registry sessions.winconnect%.option.desktop

-scale-factor

Value Global setting / auto / 100% / 125% / 150%

Evidian

Fixed NLA support in Evidian AuthMgr RDP session type

Network

Fixed handling of the following registry keys:
network.interfaces.wirelesslan.device0.driver.disable_ht

network.interfaces.wirelesslan.device0.driver.chain_num

network.interfaces.wirelesslan.device0.driver.cfg80211.cfg80211

_disable_40mhz_24ghz
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The first and the second parameters only affect the driver rt2800ub (used e.g.for Ralink RT3372 
and RT5572)
Fixed iptables IPv6 support by adding IPv6 netfilter kernel modules.

WiFi

Fixed connection to hidden WiFi networks

Cisco JVDI Client

Fixed: Applications are now startable via desktop, start menu and application launcher.
Fixed Webcam support with 32Bit Citrix Receiver for JVDI.

Open VPN

Fixed desktop folder support for OpenVPN session.

Smartcard

Improved waiting for smartcard events.

Base system

IGEL Setup Assistant will no longer start multiple times, the existing instance will be raised 
instead.
Fixed automatic firmware update on shutdown.

Storage Devices

Fixed potential hangs on suspend/shutdown when a USB memory stick was in use at that time.

X11 system

Fixed huge icons in GTK applications when DPI setting was below 96.
Fixed problems with Avaya VDI Communicator and webcams.
Disabled SNA sprite X video support as default because it is unstable and could crash X server.

New registry key:
More...

Parameter Use SNA sprite video feature (could be unstable)

Registry x.drivers.intel.sprite_video

Value enabled / disabled

Window manager

Fixed the custom UI colors for the window manager decoration that was broken in 10.05.100. 
The custom UI colors are now applied to the window borders again.

Audio

Applied workarounds concerning USB control requests on Plantronics C510 and 520.
Fixed initialization of sound card in Dell Wyse 3040.
Fixed blocking mode in compatibility Pulseaudio PCM plugin for ALSA. The blocking mode is 
used by Parallels client to playback sound.

Media Player (Parole)
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Parole media player now displays a looping animation while initiating the connection for rtmp 
streams.
Extended integration of Parole media player configuration in the setup. The following 
configuration keys are now respected.
More...

IGEL Setup Sessions > Media Player > Media Player Global > 
Window 

Parameter Automatically resize the player window when a new 
video is loaded

Registry multimedia.mediaplayer.auto_resize

Value enabled / disabled

IGEL Setup Sessions > Media Player > Media Player Global > 
Window 

Parameter Main window should stay on top

Registry multimedia.mediaplayer.window_on_top

Value enabled / disabled

IGEL Setup Sessions > Media Player > Media Player Global > 
Options 

Parameter Network connection speed

Registry multimedia.mediaplayer.connection_spee

d

Range [56 kbps Modem/ISDN] [112 kbps Dual ISDN/DSL]

[256 kbps DSL/Cable] [384 kbps DSL/Cable]

[512 kbps DSL/Cable] [1.5 mbps T1/Intranet/LAN]

[Intranet/LAN]

Parameter Enable debug

Registry multimedia.mediaplayer.debug

Value enabled / disabled

Evidian

Added support to log out Citrix session type on tap event.
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More...

Parameter Logout behavior

Registry evidian.sessiontype.ctx.pnlogout

Value [Default] [Force disconnect] [Force logoff]

Hardware

Fixed problems with mouse cursor on intel cherryview devices.
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IGEL Universal Desktop Converter (UDC3)
Supported Hardware:

https://kb.igel.com/igelos/en/devices-supported-by-udc3-and-ud-pocket-3117174.html

Component Versions 10.05.500 (see page 1217)
New Features 10.05.500 (see page 1219)
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Component Versions 10.05.500
Clients
Product Version

Oracle JRE 1.8.0_192

System Components
OpenSSL 1.0.2g-1ubuntu4.13

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.2.1-1igel51

Graphics Driver INTEL 2.99.917+git20181113-igel846

Graphics Driver ATI/RADEON 18.0.1-1igel831

Graphics Driver ATI/AMDGPU 18.0.1-1igel831

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2igel775

Graphics Driver Vboxvideo 5.2.18-dfsg-2igel17

Graphics Driver VMware 13.3.0-2igel812

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.3.4-1build2igel639

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver Vmmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.20 #mainline-udos-r2481

Xorg X11 Server 1.19.6-1ubuntu4igel838

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel653

ISC DHCP Client 4.3.3-5ubuntu12.10igel7

Python2 2.7.12



Notes for Release 10.05.500

IGEL OS Release Notes   1218 / 1492

Python3 3.5.2
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New Features 10.05.500
UDC3 Installer

Added UEFI support in UDC Deployment Appliance 5.0, downloadable via download section on 
www.igel.com45

Enhanced UDC3 Converter by a new option to force MS-DOS partitioning for EFI installations.
Updated "preparestick" tool to version 3.3.0.0 with the following fixes:

WMI NullReferenceException
dd.exe Processbar asynchronous
diskpart->clean failed with access denied

http://www.igel.com
http://www.igel.com
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Notes for Release 10.05.100
Software: Version 10.05.100

Release Date: 2018-10-25

Release Notes: Version RN-105100-1

Last update: 2018-10-25

The following formatting is used in this document:

format type example use

bold and underlined enable/disable the default setting of a value

bold and arrow menu > path menu path in the IGEL setup

bold GUI

[keyboard]

elements of the graphical user interface or 
commands that are entered using the 
keyboard

IGEL Linux Universal Desktop (see page 1221)
IGEL Universal Desktop OS3/IGEL UD Pocket (see page 1269)
IGEL Universal Desktop Converter (UDC3) (see page 1316)
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IGEL Linux Universal Desktop

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD3-LX 42

UD3-LX 41

UD5-LX: UD5-LX 50

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Component Versions 10.05.100 (see page 1223)
General Information 10.05.100 (see page 1227)
Security Fixes 10.05.100 (see page 1228)
Known Issues 10.05.100 (see page 1233)
New Features 10.05.100 (see page 1235)
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• Resolved Issues 10.05.100 (see page 1261)
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Component Versions 10.05.100
Clients
Product Version

Citrix HDX Realtime Media Engine 2.6.0-2030

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Receiver 13.9.1.6

deviceTRUST Citrix Channel 17.2.100.0

deviceTRUST RDP Channel 17.2.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.2.2

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_181

Parallels Client (32 bit) 16.5.1.20446

Parole Media Player 1.0.1-0ubuntu1igel11

Remote Viewer (RedHat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0

Systancia AppliDis 4.0.0.17
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Thinlinc Client 4.9.0-5775

ThinPrint Client 7.5.86

Totem Media Player 2.30.2

VMware Horizon Client 4.8.0-8518891

VNC Viewer 1.8.0+git20180123-igel1

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.5.4

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.0.23

Reader Driver ACS CCID 1.1.5

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24
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Reader Driver MUSCLE CCID 1.4.28

Reader Driver REINER SCT cyberJack 3.99.5final.SP11

Resource Manager PC/SC Lite 1.8.22

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.13

OpenSSH Client 7.2p2-4ubuntu2.4

OpenSSH Server 7.2p2-4ubuntu2.4

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.2.1-1igel51

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20180214-igel1830

Graphics Driver ATI/RADEON 18.0.1-1igel831

Graphics Driver ATI/AMDGPU 18.0.1-1igel831

Graphics Driver VIA 5.76.52.92-009-005f78-20150730

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.3.4-1build2igel639

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver Vmmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.11 #mainline-ud-r2463

Xorg X11 Server 1.19.6-1ubuntu4igel838

Xorg Xephyr 1.19.6-1ubuntu4igel832

CUPS printing daemon 2.1.3-4ubuntu0.5igel20

PrinterLogic 18.2.1.128
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Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel653

ISC DHCP Client 4.3.3-5ubuntu12.10igel6

NetworkManager 1.6.8-2igel1

ModemManager 1.6.4-1

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.2-1ubuntu1igel192

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.0
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General Information 10.05.100
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
Remote Access via RSH
Legacy Philips Speech Driver
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
Video Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
H.264 Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

- by panel tray icon

- by an icon in the In-Session Control Bar (configurable at IGEL Setup > User Interface > Desktop)

- by a Safely Remove Hardware session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in this release:

Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
Composite Manager
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Security Fixes 10.05.100
Firefox

Updated Mozilla Firefox to version 60.2.2esr. 
More...

mfsa2018-24: CVE-2018-12386, CVE-2018-12387

mfsa2018-23: CVE-2018-12385, CVE-2018-12383

mfsa2018-21: CVE-2018-12377, CVE-2018-12378, CVE-2018-12376

mfsa2018-16: CVE-2018-12359, CVE-2018-12360, CVE-2018-12361, CVE-2018-12362,

CVE-2018-5156, CVE-2018-12363, CVE-2018-12364, CVE-2018-12365,

CVE-2018-12371, CVE-2018-12366, CVE-2018-12367, CVE-2018-12369,

CVE-2018-5187, CVE-2018-5188

mfsa2018-14: CVE-2018-6126

mfsa2018-11: CVE-2018-5154, CVE-2018-5155, CVE-2018-5157, CVE-2018-5158,

CVE-2018-5159, CVE-2018-5160, CVE-2018-5152, CVE-2018-5153,

CVE-2018-5163, CVE-2018-5164, CVE-2018-5166, CVE-2018-5167,

CVE-2018-5168, CVE-2018-5169, CVE-2018-5172, CVE-2018-5173,

CVE-2018-5175, CVE-2018-5176, CVE-2018-5177, CVE-2018-5165,

CVE-2018-5180, CVE-2018-5181, CVE-2018-5182, CVE-2018-5151,

CVE-2018-5150.

mfsa2018-10: CVE-2018-5148

Firefox profile partition is now mounted at /userhome/.mozilla instead of /.ffpro.
Firefox could only be started as user.
For security reasons Java processes could not be started from a browser session now.
Added a registry parameter java.browser.access  to control java access for all browser 
sessions. 
More...

IGEL Setup Registry >  java > browser > access

Parameter Allow browser to use java

Registry java.browser.access

Value enabled / disabled

Network

Disabled ICMP redirects.
Changed default LoginGraceTime from 120 to 30 sec.
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Added new registry keys for a secure sshd configuration. 
More...

Parameter Permit X11 forwarding

Registry network.ssh_server.x11_forwarding

Value enabled / disabled

Parameter Show banner

Registry network.ssh_server.show_banner

Value enabled / disabled

Parameter Permit tcp tunnel forwarding

Registry network.ssh_server.permit_tcp_forwardi

ng

Value enabled / disabled

Fixed SCEP client certificate request file access rights.

Base system

Added apparmor as an additional security layer for components like Firefox, evince, dhcpclient 
and cups. 
More...

Parameter Enable apparmor profiles

Registry system.security.apparmor

Value enabled / disabled

For security reasons graphical terminal sessions could now only be started by an administrator 
when an admin password is set. Administrator must authenticate before a terminal session is 
started. This does also affect graphical terminal sessions spawned by applications.
To allow users to start a terminal session again a registry key is defined. 
More...

Parameter User shell terminal

Registry system.security.usershell

Value enabled / disabled

Fixed open-vm-tools security issue CVE-2015-5191.
Fixed procps security issues CVE-2018-1126, CVE-2018-1125, CVE-2018-1124, CVE-2018-1123 and 
CVE-2018-1122.
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Fixed imagemagick security issues. 
More...

CVE-2018-9133, CVE-2018-8960, CVE-2018-8804 

CVE-2018-7443, CVE-2018-5248, CVE-2018-11251, CVE-2018-10177, CVE-2017-18273,

CVE-2017-18271, CVE-2017-18252, CVE-2017-18211, CVE-2017-18209,

CVE-2017-17914, CVE-2017-17879, CVE-2017-17682, CVE-2017-17681,

CVE-2017-17504, CVE-2017-16546, CVE-2017-15281, CVE-2017-15277,

CVE-2017-15017, CVE-2017-15016, CVE-2017-15015, CVE-2017-14989,

CVE-2017-14741, CVE-2017-14739, CVE-2017-14682, CVE-2017-14626,

CVE-2017-14625, CVE-2017-14624, CVE-2017-14607, CVE-2017-14532,

CVE-2017-14531, CVE-2017-14505, CVE-2017-14400, CVE-2017-14343,

CVE-2017-14342, CVE-2017-14341, CVE-2017-14325, CVE-2017-14249,

CVE-2017-14224, CVE-2017-14175, CVE-2017-14174, CVE-2017-14173,

CVE-2017-14172, CVE-2017-14060, CVE-2017-13769, CVE-2017-13768,

CVE-2017-13758, CVE-2017-13145, CVE-2017-13144, CVE-2017-13143,

CVE-2017-13142, CVE-2017-13139, CVE-2017-13134, CVE-2017-12983,

CVE-2017-12877, CVE-2017-12875, CVE-2017-12693, CVE-2017-12692,

CVE-2017-12691, CVE-2017-12674, CVE-2017-12670, CVE-2017-12643,

CVE-2017-12640, CVE-2017-12587, CVE-2017-12563, CVE-2017-12435,

CVE-2017-12432, CVE-2017-12431, CVE-2017-12430, CVE-2017-12429,

CVE-2017-12140, CVE-2017-11640, CVE-2017-11639, CVE-2017-11537,

CVE-2017-11535, CVE-2017-11533, CVE-2017-11352, CVE-2017-10995,

CVE-2017-1000476, CVE-2017-1000445, CVE-2018-13153, CVE-2018-12600 and

CVE-2018-12599.

Fixed elfutils security issues CVE-2017-7613, CVE-2017-7612, CVE-2017-7611, CVE-2017-7610, 
CVE-2017-7609, CVE-2017-7608, CVE-2017-7607, CVE-2016-10255 and CVE-2016-10254.
Fixed ghostscript security issues CVE-2018-10194, CVE-2016-10317, CVE-2018-16802, 
CVE-2018-16585, CVE-2018-16543, CVE-2018-16542, CVE-2018-16541, CVE-2018-16540, 
CVE-2018-16539, CVE-2018-16513, CVE-2018-16511, CVE-2018-16509, CVE-2018-15911, 
CVE-2018-15910, CVE-2018-15909, CVE-2018-15908, CVE-2018-11645, CVE-2018-1, CVE-2018-17183 
and CVE-2018-16510.
Fixed icu security issue CVE-2017-15422.
Fixed webkit2gtk security issues. 
More...

CVE-2018-4200, CVE-2018-4165, CVE-2018-4163,

CVE-2018-4162, CVE-2018-4161, CVE-2018-4146, CVE-2018-4133, CVE-2018-4129,
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CVE-2018-4128, CVE-2018-4127, CVE-2018-4125, CVE-2018-4122, CVE-2018-4120,

CVE-2018-4119, CVE-2018-4118, CVE-2018-4117, CVE-2018-4114, CVE-2018-4113,

CVE-2018-4101, CVE-2018-4233, CVE-2018-4232, CVE-2018-4222, CVE-2018-4218,

CVE-2018-4199, CVE-2018-4190, CVE-2018-12293, CVE-2018-4284, CVE-2018-4278,

CVE-2018-4273, CVE-2018-4272, CVE-2018-4270, CVE-2018-4267, CVE-2018-4266,

CVE-2018-4265, CVE-2018-4264, CVE-2018-4263, CVE-2018-4262, CVE-2018-4261,

CVE-2018-4246 and CVE-2018-12911.

Fixed perl security issues CVE-2018-6913, CVE-2018-6798, CVE-2018-6797, CVE-2017-6512, 
CVE-2016-6185 and CVE-2018-12015.
Fixed poppler security issues CVE-2017-18267 and CVE-2018-13988.
Fixed openssl security issues CVE-2018-0739, CVE-2018-0737, CVE-2018-0737, CVE-2018-0732 and 
CVE-2018-0495.
Fixed tiff security issues. 
More...

CVE-2018-5784, CVE-2017-9936, CVE-2017-9935,

CVE-2017-9815, CVE-2017-9404, CVE-2017-9403, CVE-2017-9147, CVE-2017-9117,

CVE-2017-7602, CVE-2017-7601, CVE-2017-7600, CVE-2017-7599, CVE-2017-7598,

CVE-2017-7597, CVE-2017-7596, CVE-2017-7595, CVE-2017-7594, CVE-2017-7593,

CVE-2017-7592, CVE-2017-5563, CVE-2017-18013, CVE-2017-17095, CVE-2017-13727,

CVE-2017-13726, CVE-2017-12944, CVE-2017-11613, CVE-2017-11335,

CVE-2017-10688, CVE-2016-5318, CVE-2016-5102, CVE-2016-3186, CVE-2016-10371,

CVE-2016-10269, CVE-2016-10268, CVE-2016-10267 and CVE-2016-10266.

Fixed libvncserver security issue CVE-2018-7225.
Fixed libvorbis security issue CVE-2018-5146.
Fixed samba security issues CVE-2018-1057, CVE-2018-1050, CVE-2018-10919 and CVE-2018-10858.
Fixed wget security issue CVE-2018-0494.
Fixed bluez security issue CVE-2017-1000250.
Fixed libgcrypt20 security issue CVE-2018-0495.
Fixed file security issue CVE-2018-10360.
Fixed gnupg2 security issue CVE-2018-12020.
Fixed isc-dhcp security issues CVE-2018-5733, CVE-2018-5732, CVE-2018-573, CVE-2017-3144 and 
CVE-2016-2774.
Fixed curl security issues CVE-2018-1000303, CVE-2018-1000301, CVE-2018-1000300, 
CVE-2018-1000122, CVE-2018-1000121, CVE-2018-1000120, CVE-2017-8818, CVE-2018-14618 and 
CVE-2018-0500.
Fixed python3.5 security issues CVE-2017-1000158, CVE-2016-5636, CVE-2016-1000110 and 
CVE-2016-0772.
Fixed zlib security issues CVE-2016-9843, CVE-2016-9842, CVE-2016-9841 and CVE-2016-9840.
Fixed libsoup2.4 security issue CVE-2018-12910.
Fixed libjpeg-turbo security issue CVE-2018-1152.
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Fixed ntp security issues CVE-2018-7185 and CVE-2018-7183.
Fixed libpng1.6 security issue CVE-2018-13785.
Fixed cups security issues CVE-2018-6553, CVE-2018-4181, CVE-2018-4180, CVE-2018-418 and 
CVE-2017-18248.
Fixed libpng security issue CVE-2016-10087.
Fixed policykit-1 security issue CVE-2018-1116.
Fixed jansson security issue CVE-2016-4425.
Fixed libmspack security issues CVE-2018-14682, CVE-2018-14681, CVE-2018-14680 and 
CVE-2018-14679.
Fixed libonig security issues CVE-2017-9229, CVE-2017-9228, CVE-2017-9227, CVE-2017-9226 and 
CVE-2017-9224.
Fixed libxcursor security issue CVE-2015-9262.
Fixed heimdal security issue CVE-2017-17439.
Fixed libarchive security issues CVE-2017-14503, CVE-2017-14501, CVE-2017-14166, 
CVE-2016-10350, CVE-2016-10349 and CVE-2016-10209.
Fixed libxml2 security issues CVE-2018-14567, CVE-2018-14404, CVE-2017-18258 and 
CVE-2016-9318.
Fixed confuse security issue CVE-2018-14447.
Fixed libgd2 security issues CVE-2018-5711 and CVE-2018-1000222.
Fixed libx11 security issues CVE-2018-14600, CVE-2018-14599, CVE-2018-14598, CVE-2016-7943 
and CVE-2016-7942.
Fixed mpg123 security issues CVE-2017-10683 and CVE-2016-1000247.
Fixed libtirpc security issues CVE-2018-14622, CVE-2017-8779 and CVE-2016-4429.
Fixed jq security issue CVE-2015-8863.
Fixed bind9 security issue CVE-2018-5740.
Fixed lcms2 security issue CVE-2018-16435.
Fixed xdg-utils security issue CVE-2017-18266.
Restricted access to command su to root and user.
Root home is now /root.
Removed system group (GID 0) which shadowed root group (GID 0).
Stricter folder and file permissions.

X11 system

Restricted desktop icon creation to administrator only. Therefore, "/userhome/Desktop" is 
owned by root now.
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Known Issues 10.05.100
Citrix Receiver 13

On devices with AMD/Radeon graphics chipsets and activated DRI3 X driver option the
hardware accelerated Citrix H.264 decoder plugin can hang. To solve this issue deactivation of 
DRI3 option is necessary  (default setting). Selective H.264 mode (api v2) is not affected from this 
issue.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard 
correctly when the card is inserted after start of login. As a workaround, insert the smartcard 
before starting StoreFront login.
The Citrix Receiver has known issues with GStreamer1.x. This causes problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer1.x is used if browser content redirection is 
active.

Parallels Client

Native USB redirection does not work with Parallels Client.
Due to a bug in the Parallels-Client, for using the new FIPS 140-2 compliance mode it is necessary 
to connect to the Parallels RAS one time with FIPS support disabled.

VMware Horizon

VMware Horizon Client for Linux 4.8.0 supports FIPS Mode on only VMware Horizon server 
installations up to version 7.5 .
External drives are mounted already before connection, do not appear in the remote 
desktop. Workaround: mapping the directory /media  as a drive on desktop. The external 
devices will show up within the media drive then.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Enable local Storage Hotplug on setup page Devices > Storage Devices > Storage 
Hotplug.

OpenConnect VPN

VPNs which requires the OpenConnect client cannot be used for firmware updates.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.
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Hardware

Sometimes the DVI Port on a UD6 is not recognized by the Linux system after booting up. The 
only available way to solve the issue is to shut down and disconnect the thin client from power (1-2 
minutes) and connect and power up it again.
Suspend is not working on UD10 so the support for suspend  is disabled.

Smartcard

In seldom cases the authentication hung when using A.E.T. SafeSign smartcards.

IGEL Cloud Gateway

No support for UMS file transfer status in ICG protocol.
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New Features 10.05.100
Citrix Receiver 13

Integrated Citrix Receiver 13.10. Citrix Receiver version 13.7.0 was removed. Citrix Receiver 
version 13.8.0 was removed. Available Citrix Receiver versions: 13.5.0, 13.9.1, 13.10 (default)

Enable Browser content redirection for rendering of whitelisted webpages on the IGEL 
Thin Client. 
More...

IGEL Setup Sessions > Citrix XenDesktop > HDX / ICA Global > HDX 
Multimedia

Parameter Browser content redirection

Registry ica.module.virtualdriver.webpageredirection

Value enabled / disabled

Enhanced Citrix retail logging. 
More...

Parameter Citrix Logging

Registry ica.module.syslogthreshold

Value 0 / 3 / 7

> 0 = Disabled

> 3 = Log only errors

> 7 = Log all levels

Enable Port forwarding. 
More...

Parameter Portforward

Registry ica.module.virtualdriver.portforward

Value enabled / disabled

Workspace configuration parameter for Citrix Cloud is now available on setup page. 
More...

IGEL Setup Sessions > Citrix XenDesktop > HDX / ICA Global > Options

Parameter Connect to cloud

Registry ica.cloudconnect
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Value enabled / disabled

Added a registry key to control the visibility of the Citrix connection bar for desktop 
sessions. If activated, the In-Session Control Bar should be disabled 
at  userinterface.igel_toolbar.enable   and 

userinterface.igel_toolbar.show_always . 
This enables the control of the new Multi-monitor layout persistence feature. 
More...

Parameter Citrix Connection Bar

Registry ica.allregions.connectionbar

Value factory default / off / on / server determined

Added a registry key to control the availability of deprecated cipher suites: 
TLS_RSA_AES256_GCM_SHA384, TLS_RSA_AES128_GCM_SHA256,
TLS_RSA_AES256_CBC_SHA256, TLS_RSA_AES256_CBC_SHA, 
TLS_RSA_AES128_CBC_SHA,
TLS_RSA_3DES_CBC_EDE_SHA. 
More...

Parameter TLS RSA cipher suites

Registry ica.allregions.enable_tls_rsa

Value factory default / false / true

Factory default: true/enabled. Citrix explicitly remarks: Important: Set the 
flag  enable_tls_rsa  to true to use the other two cipher suites Enable_RC4-
MD5 and Enable_RC4_128_SHA.

Added a registry key to control the availability of the deprecated cipher suite: RC4-MD5. 
More...

Parameter RC4-MD5 cipher suite

Registry ica.allregions.enable_rc4_md5

Value factory default / false / true

Factory default: false/disabled. 

Added a registry key to control the availability of the deprecated cipher suite: 
RC4_128_SHA. 
More...

Parameter RC4_128_SHA cipher suite
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Registry ica.allregions.enable_rc4_128_sha

Value factory default / false / true

Factory default: false/disabled. 

Added Selective H.264 (API v2) to the  hardware accelerated Citrix deep compression codec. 
XenDesktop/XenApp server policy: Use video codec for compression -> For actively changing 
regions
Added DRI3 acceleration support to the hardware accelerated Citrix deep compression codec (for 
INTEL and AMD graphics adapters).

Enable debugging to log file  /var/log/user/ctxh264.log . 
More...

Parameter Enable H264 codec debug output

Registry ica.hw-accelerated-h264-codec-debug

Value enabled / disabled

Added Kerberos Passthrough (domain passthrough) authentication to StoreFront. 
Configurable at Sessions > Citrix XenDesktop / XenApp > HDX / ICA Global > StoreFront Logon > 
Authentication Type.
Updated Citrix HDX RTME used for optimization of Skype for Business to 2.6.0-2030. This new 
version adds the support for hardware accelerated H.264 en- and decoding on AMD platforms. 
See https://support.citrix.com/article/CTX236304 section Capability Checker for Linux 
platforms how to enable hardware decoding with Citrix VDA registry keys 
DisableLinuxAMDH264HardwareDecoding  and SupportedAMDHWAVideoCardList .

The capability check program RTOP-CapabilityChk-x64 is already installed at path /

services/ica/hdx_rtme/RTOP-CapabilityChk-x64 . The check program must be run 
with user permissions.
Added display of logged on Citrix username in screen lock, when screen lock password is 
synchronized with Citrix password.
Added checkbox to activate autostart of a single published application/desktop session. 
More...

IGEL Setup Sessions > Citrix XenDesktop / XenApp > Citrix 
StoreFront/Web Interface > Login

Parameter Start a single published application automatically

Registry ica.pnlogin.autostart_single_application

Value enabled / disabled

Added Lakeside SysTrack virtual channel in Citrix, RDP and Horizon sessions. Activation via 
parameters in Setup. 

https://support.citrix.com/article/CTX236304
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More...

IGEL Setup Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global 
> Mapping > Device Support

Parameter Lakeside Systrack channel

Registry ica.module.virtualdriver.lakeside.enable

Value enabled / disabled

IGEL Setup Sessions > RDP > RDP Global > Mapping > Device 
Support

Parameter Lakeside Systrack channel

Registry rdp.winconnect.plugins.lakeside.use

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > 
Performance

Parameter Lakeside Systrack

Registry vmware.view.lakeside_systrack

Value enabled / disabled

Updated Olympus dictation channel for Citrix to version 20180621. 
More...

IGEL Setup Sessions > Citrix XenDesktop / XenApp > HDX / ICA 
Global > Mapping > Device Support

Parameter Olympus channel for dictation

Registry ica.module.virtualdriver.olycom.enable

Value enabled / disabled

Added CrossMatch / DigitalPersona channel for Citrix version 0515. 
More...

IGEL Setup Sessions > Citrix XenDesktop /XenApp > HDX / ICA 
Global > Mapping > Device Support

Parameter Crossmatch DigitalPersona fingerprint channel

Registry ica.module.virtualdriver.dpicacnt.enable

Value enabled / disabled



Notes for Release 10.05.100

IGEL OS Release Notes   1239 / 1492

•

•

•

•
•

RDP/IGEL RDP Client 2

Support for new RDP 10 codec AVC444 (H.264), which reduces network bandwidth with Server 
2016 and Windows 10 hosts. AMD Radeon graphics is required on the client side. Other graphics 
hardware (e.g. Intel) as well as other RDP 10 codecs (AVC420 and AVC444V2) will be supported in 
the future. 
More...

IGEL Setup Sessions > RDP > RDP Global > Performance

Parameter Hardware accelerated codecs AVC420/AVC444 (H.264)

Registry rdp.winconnect.enable-h264

Value auto / on / off

IGEL Setup Sessions > RDP > RDP Sessions > Session Name > 
Performance

Parameter Hardware accelerated codecs AVC420/AVC444 (H.264)

Registry sessions.winconnect%.option.enable-h264

Value Global setting / auto / on / off

The value "auto" enables supported codecs on supported hardware.

The value "on" enables supported codecs on all hardware.

The value "off" disables H.264 codecs.

Added new parameter ignore_errors to RDP Session config to suppress RDP error messages. 
More...

Registry sessions.winconnect%.ignore_errors

Value enabled / disabled

Added Olympus dictation channel for RDP version 20180621. 
More...

IGEL Setup Sessions > RDP > RDP Global > Mapping > Device 
Support

Parameter Olympus channel for dictation

Registry rdp.winconnect.plugins.olyvc.use

Value enabled / disabled

Parallels Client

Updated Parallels client to version 16.5.1.20446 (32-Bit)
Added support for FIPS 140-2 compliance. 
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More...

IGEL Setup System > Registry

Parameter Enable support for FIPS 140-2 compliance

Registry sessions.twox%.connection.fips_compli

ance

Value enabled / disabled

VMware Horizon

Updated Horizon client to version 4.8.0-8518891.

ThinLinc

Updated ThinLinc client to version 4.9.0.
Shadowing notification is now more reliable and interactive, allowing end users more 
control of their sessions.
More than 80 minor enhancements and fixes. See https://www.cendio.com/thinlinc/docs/
relnotes/4.9.0.

RedHat Enterprise Virtualization client

Updated spice components (virt-viewer 7.0, spice-gtk 0.35).
Removed support for spice-xpi plugin.

X session (Xephyr)

Added support for X sessions configurable at `IGEL Setup > Sessions > X Sessions`. The available 
XDMCP connection types: indirect via localhost, indirect, direct and broadcast. With the additional 
connection type "local display", a command can be specified that will be displayed inside the X 
session window. 
More...

IGEL SetupSessions > X Sessions > X Session > Server

Parameter Connection type

Registry sessions.xnest<NR>.server.connectiontype

Range  [Indirect via localhost] [Indirect] [Direct] [Broadcast] [Local display]

IGEL SetupSessions > X Sessions > X Session > Server

Parameter Command to be displayed

Registry sessions.xnest<NR>.server.runcommand

Firefox

Updated Mozilla Firefox to version 60.2.2 ESR.

https://www.cendio.com/thinlinc/docs/relnotes/4.9.0
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The initial page displayed by firefox with default settings is now https://kb.igel.com instead of 
the older https://edocs.igel.com.
Updated Adobe Flash Player download URL to version 31.0.0.122.
Removed the webapp specific options, this feature was removed from Firefox and is not relevant 
anymore.
Moved Browser Certificate configuration to page Sessions > Browser > Browser Global > 
Certificates. 
Moved Browser Security Device configuration to page Sessions > Browser > Browser Global > 
Smartcard Middleware.
Added Fluendo FFmpeg GStreamer proxy: Provides ffmpeg-libavcodec-compatible library, which 
is needed for H.264 playback in firefox. Instead decoding by standard ffmpeg libraries, the video 
stream is redirected to GStreamer framework.

Network

SCEP: Added subject alternative name type DNS Name as UPN (auto). This is similar to DNS 
Name (auto). In the CSR the result is a Microsoft User Principal Name (UPN) that consists of the 
hostname.
NetworkManager updated to version 1.2.6.

Cisco JVDI Client

Integrated new Cisco Jabber Softphone for VDI (Cisco JVDI client) version 12.0.0 as feature with 
limited functionality. See product documentation for details -> https://kb.igel.com/cisco-jvdi/en. 
Activation of this feature at: System > Firmware Customization > Features > Cisco JVDI client. 
Only Citrix Receiver 13.9.1 is supported. 
More...

ParameterLog Level

Registry multimedia.ciscovxme.log_level

Range  [Info] [Warning] [Error] [Fatal] [Debug] [Trace]

IGEL Setup Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global 
> Unified Communications > Cisco JVDI Client

Parameter Cisco JVDI Client

Registry ica.module.virtualdriver.vdcisco.enable

Value enabled / disabled

Registry path for Common JVDI options: `multimedia.ciscovxme.**` The Cisco JVDI Client 
configuration is only displayed if the Multimedia Codec Pack (MMC) is present.

Java

Updated Oracle Java Runtime Environment to version 1.8.0 U181.

Smartcard
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Updated SecMaker Net iD to version 6.7.0.23.
Updated HID Global Omnikey smartcard reader driver to version 4.3.3.
Updated cryptovision sc/interface to version 7.1.9. Changelog since version 7.0.5:

Fixed an error during certificate registration using the MS Minidriver for MS VSC. 
Compatible with sc/interface cache version 1.2 or higher.
Fixed an error where writing a certificate using the Minidriver for MS VSC corrupted the 
Container-ID. As a result, the key could not be used using CNG/CAPI.
Fixed an error during certificate registration using the Minidriver for MS VSC where 
some Container-ID's could not be used by CNG/CAPI.
General Bug Fixes.
Fixed error during profile creation on JCOP3 with ePasslet-Suite 3.0
Added support for additional BWI card profiles based on CardOS-5.x.
Versions 1.7, 1.8, 1.9, 4.2, 4.3 and 4.4. Support 4k RSA for 1.9 and 4.4.
Fixed support for remote logon in sc/interface cache.
Fixed Free after use in ReadOnly Minidriver.
PKCS#11 Fixed MS VSC (GIDSv2) support.
PKCS#11 Fixed CardOS-4.x "non sc/interface card profile" support.
MS VSC (GIDSv2) Support for PKCS#11 - Maximum CKA_ID length reduced to 25 bytes!
Support for JCOP3 and Infineon JTOP - DolphinV2.
Support for cryptovision's ePasslet-Suite-3.0.
New ePKIApplet-2.129 for JCOP3, SCE7 and JTOP (DolphinV2) with up to 4096 bits RSA 
and 512 bits
EC support, PACE optional.
RegisterTool plugins now available in Setup. Removed from 
"support\RegisterTool_Plugins".
New sc/interface Minidriver support for MS VSC (instead of the MS Minidriver) to allow 
extended PIN cache configuration.
Added support for sc/interface cache version 1.0 for Minidriver/ReadOnly Minidriver and 
PKCS#11.
Cross-application PIN cache for Windows 8.1 and later.
WARNING: No longer compatible with Credential Cache (CSP). When there are any 
questions, support@cryptovision.com46 should be contacted.
Added macOS CTK Token Driver for 10.12 and later. Unfortunately, after the installation, a 
shell script must be executed to enable the full functionality.
Removed macOS tokend support beginning with version 10.12, installation of 10.10 can be 
used if needed.
WARNING: macOS tokend support will discontinue, usage of new CTK Token Driver is 
necessary.
Re-Added cvSimpleCardProv for Windows (based on 6.4.2) to enabled the default login 
selection, see "support\CredentialProvider".

Updated OpenSC library to version 0.19.0. Improved handling of PIV and CAC ALT token.

Base system

Updated to kernel version 4.18.11.

mailto:support@cryptovision.com
mailto:support@cryptovision.com
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Added new GStreamer 1.x support version 1.14.2. 
There will only ever be GStreamer in version 1.0 or version 0.10. By default, clients run with the 
version they have best support for. The provided registry key can be used to override the 
automatic detection/setting and pin a single version if required. 
More...

ParameterFluendo GStreamer Codec Version

Registry multimedia.gstreamer.version

Value [1.x] [0.10] [automatic]

With GStreamer 1.x the new Parole player is used for media player sessions. When there occur 
problems with the new player, a switch back to totem/GStreamer 0.10 media player is possible by 
Fluendo GStreamer Codec Version parameter.
Added optional logoff button in taskbar when the screenlock is active. 
More...

IGEL SetupSecurity > Logon > Taskbar

Parameter Show logoff button

Registry userinterface.screenlock_taskbar_logged_in.logoff_butt

on

Value enabled / disabled

Mobile broadband configuration dialog now provides a simple mode, that displays 3 dropdown 
boxes to select country, provider and access point (plan). The former version is available via an 
Expert Mode button.
IGEL Setup Assistant enhancements: 

displaying page for mobile broadband configuration when any mobile broadband modem 
is detected.
displaying page to show broken network connectivity
desktop icon will now be displayed when the assistant was not yet finished.
the assistant is now always started on devices without IGEL license, that are not 
registered at UMS
new icon design

Added support for Chinese, Japanese, Korean and Thai fonts.
KVM kernel modules added.
Added USB power off on shutdown in IGEL UD7 (H850C) and IGEL UD3 (M340C). The feature can 
be configured by the parameter:  (default: deactivated). 
More...

Parameter Power off on shutdown

Registry devices.usb.poweroff_shutdown

Value enabled / disabled
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Added policiykit-1-gnome session agent to get a GUI interface for actions which requires root 
authentification.
Added remote (network attached) logging via rsyslog. 
More...

IGEL SetupSystem -> Remote Syslog

Parameter Remote mode

Registry system.syslog.remote_mode

Range  [Server] [Client] [Off]

ParameterCustom client config entries

Registry system.syslog.client_custom

Server mode is possible, though limited and intended for short-term debugging. 
More...

IGEL Setup System -> Remote Syslog

Parameter Template for log file storage

Registry system.syslog.template

Value  /var/log/%HOSTNAME%/messages

Parameter Local port

Registry system.syslog.input%.port

Value  514

Parameter Transport protocol

Registry system.syslog.input%.transport

Value  [TCP] [UDP] 

Parameter Local Address

Registry system.syslog.input%.local_address

Parameter Name

Registry system.syslog.input%.name

Client mode allows to filter and send commands to multiple remotes.
More...

IGEL SetupSystem -> Remote Syslog
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Parameter Remote port

Registry system.syslog.output%.port

Value  514

Parameter Transport protocol

Registry system.syslog.output%.transport

Value  [TCP] [UDP] 

ParameterRemote address

Registry system.syslog.output%.address

ParameterSyslog facility

Registry system.syslog.output%.facility

Range [Any] [AUTH] [CRON] [DAEMON] [FTP] [KERN] [LPR] [MAIL] [NEWS] [USER] 
UUCP]

ParameterSyslog level

Registry system.syslog.output%.level

Range [Any] [EMERG] [ALERT] [CRIT] [ERR] [WARNING] [NOTICE] [INFO] [DEBUG]

Shutdown or suspend by inactivity. 
More...

IGEL SetupSystem > Power Options > System

Parameter System action on inactivity

Registry system.power_management.system_standby.ac_action

Value  Suspend / Shutdown

Enhanced Change Password utility to be able changing the following items of the logged on user:
Password of local user (screen lock password).
PIN of IGEL smartcard.
PIN of PKCS#11 smartcard.

CUPS Printing

Added PrinterLogic support, Version 18.2.1.128. 
More...
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IGEL SetupDevices > Printer > PrinterLogic

Parameter Manage printers by Printer Installer Client

Registry printerlogic.active

Value  enabled / disabled

ParameterHomeURL Protocol

Registry printerlogic.homeurl.protocol

Value  http:// / https://

ParameterHomeURL Hostname

Registry printerlogic.homeurl.hostname

Value  .printercloud.com

ParameterAuthorization Code

Registry printerlogic.auth.crypt_password

Parameter(Mapping in sessions) ICA Sessions

Registry printerlogic.map_ica

Value  enabled / disabled

Parameter(Mapping in sessions) RDP Sessions

Registry printerlogic.map_rdp

Value  enabled / disabled

Parameter(Mapping in sessions) NX Sessions

Registry printerlogic.map_nxclient

Value  enabled / disabled

Parameter(Mapping in sessions) Parallels Client Sessions

Registry printerlogic.map_twox

Value  enabled / disabled

Driver

Added Kofax virtual channel for signature pads in Citrix sessions. 
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More...

IGEL Setup Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > 
Device Support

Parameter Kofax SPVC Signature Pad Channel

Registry ica.module.virtualdriver.spvc.enable

Value  enabled / disabled

Added configuration to change the dynamic power management settings for ATI graphics 
driver. 
More...

ParameterATI dynamic power management

Registry x.drivers.ati.dpm

Value  default / enabled / disabled

Added the possibility to change the dynamic power management settings for graphics AMDGPU 
driver. 
More...

ParameterAMDGPU dynamic power management

Registry x.drivers.amdgpu.dpm

Value  default / enabled / disabled

Added possibility to use generic modesetting graphics driver instead of the hardware specific 
one.  
More...

ParameterUse generic modesetting driver for ATI hardware.

Registry x.drivers.ati.use_modesetting

Value  enabled / disabled

ParameterUse generic modesetting driver for AMDGPU hardware.

Registry x.drivers.amdgpu.use_modesetting

Value  enabled / disabled

ParameterUse generic modesetting driver for NVIDIA hardware.

Registry x.drivers.nouveau.use_modesetting

Value  enabled / disabled
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ParameterUse generic modesetting driver for VIA hardware.

Registry x.drivers.via.use_modesetting

Value  enabled / disabled

Bluetooth

Added new Bluetooth Autopairing Wizard for IGEL OS installations without keyboard or mouse 
available, but with unpaired bluetooth keyboard/mouse. The Autopairing Wizard is started 
together with IGEL Setup Assistant.

Appliance Mode

The wireless manager can now be invoked from the In-Session control bar. Furthermore, it will 
be automatically started when no network connection can be established.
Prerequisites: A WiFi device is available and the following registry keys are set to true. 
More...

ParameterActivate Wireless Interface

Registry network.interfaces.wirelesslan.device0.active

Value  enabled / disabled

ParameterEnable wireless manager

Registry network.applet.wireless.enable_connection_editor

Value  enabled / disabled

It is possible to use Accessories, VPN connections and other session types in Appliance Mode
now. The access to those session types must be explicitely enabled by a new parameter Appliance 
Mode Access. Possible starting methods:

XDMCP Appliance mode: Hotkey
All other Appliance modes: Desktop icon, Desktop Context Menu, Application Launcher (+ 
System tab), Hotkey, Autostart. 
More...

IGEL SetupAccessories > ICA Connection Center

Parameter Application Mode Access

Registry sessions.icaconncenter0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Task Manager

Parameter Application Mode Access
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Registry sessions.taskmanager0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Application Launcher

Parameter Application Mode Access

Registry sessions.launcher0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Firmware Update

Parameter Application Mode Access

Registry sessions.firmware_update0.appliance_mode_acce

ss

Value  enabled / disabled

IGEL Setup Accessories > Quick Settings

Parameter Application Mode Access

Registry sessions.usersetup0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Sound Preferences 

Parameter Application Mode Access

Registry sessions.mixer0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Disk Removal

Parameter Application Mode Access

Registry sessions.storage_dcdm0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Disk Utility 

Parameter Application Mode Access

Registry sessions.storage_info0.appliance_mode_access
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Value  enabled / disabled

IGEL Setup Accessories > Commands  User Interface > Hotkeys > 
Commands

Parameter Application Mode Access

Registry sessions.commands<NR>.appliance_mode_access

sessions.wmcommands<NR>.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Webcam Information

Parameter Application Mode Access

Registry sessions.webcaminfo0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Touchscreen Calibration

Parameter Application Mode Access

Registry sessions.touchcalib0.appliance_mode_access

Value  enabled / disabled

IGEL Setup User Interface > Screenlock / Screensaver

Parameter Application Mode Access

Registry sessions.xlock0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Monitor Calibration

Parameter Application Mode Access

Registry sessions.xpattern0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Network Tools

Parameter Application Mode Access

Registry sessions.gnome-nettool0.appliance_mode_access

Value  enabled / disabled
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IGEL Setup Accessories > Screenshot Tool

Parameter Application Mode Access

Registry sessions.screenshooter0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > System Information

Parameter Application Mode Access

Registry sessions.device_manager0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Bluetooth Tool

Parameter Application Mode Access

Registry sessions.bluetooth0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Display Switch

Parameter Application Mode Access

Registry sessions.user_display.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Identify Monitors 

Parameter Application Mode Access

Registry sessions.screenid0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > System Log Viewer (> Options)

Parameter Application Mode Access

Registry sessions.systemviewer0.appliance_mode_access

Value  enabled / disabled

Registry sessions.setup.displaynames.add_layout.applianc

e_mode_access
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Value  enabled / disabled

IGEL Setup Accessories > Terminals > Local Terminal 

Parameter Application Mode Access

Registry sessions.xterm<NR>.appliance_mode_access

Value  enabled / disabled

IGEL Setup Sessions > SSH > SSH Session

Parameter Application Mode Access

Registry sessions.ssh<NR>.appliance_mode_access

Value  enabled / disabled

IGEL Setup System > Firmware Customization -> Custom Application -> 
Custom Application

Parameter Application Mode Access

Registry sessions.custom_application<NR>.appliance_mode_

access

Value  enabled / disabled

IGEL Setup Accessories > Mobile Device Access

Parameter Application Mode Access

Registry sessions.mtp-devices0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Network > VPN > OpenConnect VPN (> OpenVPN Connection (> 
Desktop Integration))

Parameter Application Mode Access

Registry sessions.openvpn<NR>.appliance_mode_access

Value  enabled / disabled

IGEL Setup Network > VPN > OpenConnect VPN (> VPN OpenConnection (> 
Desktop Integration))

Parameter Application Mode Access

Registry sessions.openconnect<NR>.appliance_mode_access
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Value  enabled / disabled

IGEL Setup Network > VPN > genucard (> Desktop Integration)

Parameter Application Mode Access

Registry sessions.genucard_vpn_connection0.appliance_mo

de_access

Value  enabled / disabled

X11 system

Set of User Interface > Display > Options > Monitor DPI now automatically affects the size of the 
mouse cursor, the panel height, the desktop icons, the application launcher, the size of the 
start menu and the window manager decorations.

VirtualBox

Added VirtualBox as feature with limited support. Activation of the feature at: System > 
Firmware Customization > Features > VirtualBox. Added new registry keys under `virtualbox` 
and `sessions.virtualbox<NR>`.

Audio

Updated Pulseaudio to version 12.0-1.
The resample method in Pulseaudio can now be configured by the newly introduced parameter
resample-method. 
More...

ParameterResample method

Registry multimedia.pulseaudio.daemon.resample-method

Range [soxr-vhq] [soxr-hq] [soxr-mq] [speex-float-10] [speex-float-5] [speex-float-3] 
[speex-float-1]

Media Player (Parole/Totem)

Added new Parole Media Player 1.0.1-0ubuntu1. It is used for media player sessions by default
now. When there occur problems with the new player, switch back to totem/GStreamer 0.10 media 
player is possible by setting Fluendo GStreamer Codec Version parameter to 0.10. 
More...

ParameterFluendo GStreamer Codec Version

Registry multimedia.gstreamer.version

Range [1.x] [0.10] [automatic]

Added RTSP/RTMP support to parole media player / gstreamer 1.x.
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• The following parameters are only functional with Totem media player/GStreamer 0.10 and not 
for Parole media player. 
More...

IGEL SetupSessions > Media Player > Media Player Global > Window

Parameter Automatically resize the player window when a new video is loaded

Registry multimedia.mediaplayer.auto_resize

Value  enabled / disabled

IGEL SetupSessions > Media Player > Media Player Global > Window

Parameter Main window should stay on top

Registry multimedia.mediaplayer.window_on_top

Value  enabled / disabled

IGEL SetupSessions > Media Player > Media Player Global > Playback

Parameter Visualization size

Registry multimedia.mediaplayer.visual_quality

Range [Small] [Normal] [Large] [Extra Large]

IGEL Setup Sessions > Media Player > Media Player Global > Options

Parameter Network connection speed

Registry multimedia.mediaplayer.connection_speed

Range [56 kbps Modem/ISDN] [112 kbps Dual ISDN/DSL] [256 kbps DSL/Cable] 
[384 kbps DSL/Cable] [512 kbps DSL/Cable] [1.5 mbps T1/Intranet/LAN] 
[Intranet/LAN]

Parameter Enable deinterlacing

Registry multimedia.mediaplayer.deinterlace

Value enabled / disabled

ParameterEnable debug

Registry multimedia.mediaplayer.debug

Value enabled / disabled

ParameterNetwork buffering threshold
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Registry multimedia.mediaplayer.network_buffer_threshold

Value 2

As the Media Player Browser Plugin is not supported with Firefox 60 ESR, the following 
parameters are not available anymore. 
More...

IGEL SetupSessions > Media Player > Media Player Global > Browser Plugin

Parameter Video output

Registry multimedia.mediaplayer.browser_plugin.video_sink

Range [Default] [Auto] [Hardware Accelerated] [X Video Extension] [X Window System]

IGEL SetupSessions > Media Player > Media Player Global > Browser Plugin

Parameter Aspect ratio

Registry multimedia.mediaplayer.browser_plugin.aspect_ratio

Range [Default] [Auto] [Square] [4:3 (TV)] [16:9 (Widescreen)] [2.11:1 (DVB)]

Evidian

Integrated Evidian AuthMgr version 1.5.6840.
Evidian AuthMgr sessions can be configured at IGEL Setup > Sessions > Evidian AuthMgr > 
Evidian AuthMgr Sessions (registry keys: sessions.rsuserauth% ).
Evidian AuthMgr global settings can be configured at IGEL Setup > Sessions > Evidian 
AuthMgr > Evidian AuthMgr Global (registry keys: evidian ).

Added support for Custom catalog of messages. 
More...

IGEL Setup Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > Evidian 
AuthMgr Session > Options

Parameter Language selection

Registry sessions.rsuserauth<NR>.parameters.message_catalog

Range [Automatic] [English (UK)] [English (US)] [German] [French] [Custom]

IGEL Setup Sessions > Evidian AuthMgr > Evidian AuthMgr Global > Options

Parameter Language selection

Registry evidian.message_catalog

Range [Global setting] [English (UK)] [English (US)] [German] [French] [Custom]
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IGEL Setup Sessions > Evidian AuthMgr > Evidian AuthMgr Global > Options

Parameter Custom catalog of messages

Registry evidian.custom_message_catalog

Value /services/evidian/share/locale/en/rsUserAuth.cat

Added support for Evidian Data Partition.
More...

IGEL SetupSessions > Evidian AuthMgr > Evidian AuthMgr Global > Options

Parameter Evidian AuthMgr Data Partition

Registry evidian.datapart.enabled

Value enabled / disabled

IGEL SetupSessions > Evidian AuthMgr > Evidian AuthMgr Global > Options

Parameter Size

Registry evidian.datapart.size

Value 10

Added support for Password Authentication. 
More...

IGEL 
Setup

Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > Evidian AuthMgr 
Session > Options

Paramet
er

Allow password authentication

Registry sessions.rsuserauth<NR>.parameters.password_authentication

Value enabled / disabled

IGEL 
Setup

Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > Evidian AuthMgr 
Session > Options

Paramet
er

Allow password forgotten

Registry sessions.rsuserauth<NR>.parameters.password_forgotten

Value enabled / disabled

IGEL 
Setup

Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > Evidian AuthMgr 
Session > Options
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Paramet
er

Default domain name for password authentication

Registry sessions.rsuserauth<NR>.parameters.password_default_dom

ain

Value

Misc

Added support for local scanning as feature with limited support. Activate the feature at: 
System > Firmware Customization > Features > Scanner support. This has been tested with a 
Canon LiDE 120 scanner. 
More...

Parameter Scanner support

Registry product.partitions41.enabled

Value enabled / disabled

This must be enabled for the feature to become active and the remaining keys to be valid.

Parameter Enable scanner daemon

Registry devices.scanner.daemon

Range [none] [scanbd] [saned] 

The key determines the daemon to be started. scanbd is necessary for handling buttons 
on the scanner. It runs saned when necessary (and the scanner is available). saned alone 
provides scanning functionality to local and remote applications (xsane, scanimage, ..). If 
none is selected the system can still be used as a client for remote scanner servers (using 
xsane or scanimage).

Parameter Allowed remote clients

Registry devices.scanner.allowed_clients

The key may contain a space-separated list of hosts and networks (CIDR > notation) that 
are allowed to connect to a local server.

Parameter Remote scanners

Registry devices.scannerclient.remote

This may contain a space-separated list of remote scanner servers to be used by local 
applications (xsane, scanimage). It is only relevant if no local server is configured.
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The remaining keys influence scanner button handling. For each button there is an instance of 
the devices.scanner.scanbd.action%  template.
In order to keep scanner button handling flexible the default handling may be replaced by 
custom scripts. Details of the default handling are listed at the end of this section. 
More...

Parameter Scanner button name

Registry devices.scanner.scanbd.action%.button

This contains the (symbolic) name of the button. There are currently four predefined 
instances of the template where the value is 'file', 'scan', 'copy', and 'email' respectively. 
(These refer to the buttons on a Canon LiDE 120 from left to right where 'file' may be 
labeled 'PDF')

Parameter Allow while nobody is logged in

Registry devices.scanner.scanbd.action%.allow_lockpanel_logge

d_out

Value enabled / disabled

If this is set to false, the button is ignored when nobody is logged in (only > relevant when 
local logon is configured)

Parameter Allow while screen is locked

Registry devices.scanner.scanbd.action%.allow_lockpanel_logg

ed_in

Value enabled / disabled

When this is set to false, the button is ignored while the screen is locked.

Parameter scanbd custom action

Registry devices.scanner.scanbd.action%.custom_cmd

This may contain a custom button handling command. The value is empty by default. If it 
is not, the value will be passed to "bash -c .." and the default button handling will not be 
effective. The consequence is that entering some space characters results in disabling the 
button.

Parameter Directory

Registry devices.scanner.scanbd.action%.directory

Value /tmp
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Set the target directory for scan results.

Parameter Format

Registry devices.scanner.scanbd.action%.format

Range  [pnm] [tiff] [png] [jpeg]

Determines the image format (passed as argument to scanimage).

Parameter Color mode

Registry devices.scanner.scanbd.action%.mode

Value  [Color] [Gray] [Lineart]

Determines the color mode (passed as argument to scanimage).

Parameter Resolution in dpi

Registry devices.scanner.scanbd.action%.resolution

Range  [75] [100] [150] [300] [600] [1200] [2400] [4800]

Determines the resolution (passed as argument to scanimage).

Parameter Brightness

Registry devices.scanner.scanbd.action%.brightness

Value  0

Determines the brightness (passed as argument to scanimage).

Default button handling script: There is a default button handling script /etc/scanbd/

scripts/action . It might be used as a potential starting point for custom button handling. 
The script handles the four buttons of a Canon LiDE 120 in the following ways:

file results in a PDF document that contains a series of pages where each page contains a 
scan result acquired with scanimage according to the settings. This needs user interaction 
on the local machine's desktop.
scan results in an image file that is silently created and stored according to the settings.
copy makes the script use scanimage according to the settings, convert the resulting image 
to PDF and send it to the default printer. This obviously requires that a printer is configured.
email just results in xsane being started. The following settings are not respected in this 
case:

devices.scanner.scanbd.action%.directory

devices.scanner.scanbd.action%.format

devices.scanner.scanbd.action%.mode
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devices.scanner.scanbd.action%.resolution

devices.scanner.scanbd.action%.brightness

TC Setup (Java)

Updated TC Setup to version 5.9.11.
Added an additional local administrator access to IGEL setup. The local administrator password 
is configurable at Security > Password setup page. The page permissions are configurable at 
Accessories > Setup > Setup Administrator Permissions setup page.
Reworked Accessories > Commands and User Interface > Hotkeys > Commands setup pages.
Reworked Storage Hotplug setup page.

Remote Management

Added support for UMS File Transfer Status.
Added a new configuration to prevent a user from canceling UMS actions like firmware update, 
reboot, shutdown, etc. through the UMS notification dialog. 
More...

ParameterAllow user to cancel UMS actions

Registry userinterface.rmagent.cancel_usermessage

Value enabled / disabled

Fabulatech

FabulaTech USB for Remote Desktop updated to versions 5.2.29; FabulaTech FTPlugin
updated to version 3.4.0.
Support for some specific devices has been improved.
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Resolved Issues 10.05.100
Citrix Receiver 13

Fixed: Now applications may be displayed in application launcher independently from 
startmenu.
Fixed Citrix Azure Cloud login window.
Added a new window manager tweak to automatically unmap unwanted Citrix fragment 
windows when seamless apps are used. 
More...

Parameter Auto-close unwanted Wfica windows

Registry windowmanager.tweaks.suppress_wfica_wind

ow_in_seamless_session

Value enabled / disabled

Fixed native USB redirection with Citrix receiver 13.10.
Fixed black rectangle around 32-bit mouse icons.
Fixed sound playback over Nuance channel.
Fixed stopping of the Pulseaudio PCM I/O plugin which is used by Citrix Receiver for sound output 
and recording.
When using the Citrix login method the system language is used now.
Fixed a problem with the parameter ica.pnlogin.suppressconnectiondialog , 
connection messages are suppressed as desired.

RDP/IGEL RDP Client 2

Fixed locking in smartcard transactions.
Fixed audio recording in RDP sessions.
Fixed $HOSTNAME to work for RDP login when variable substitution is enabled. 
More...

IGEL Setup System > Firmware Customization > Environment 
Variables

Parameter Enable variable substitution in session

Registry system.environment_variables.enable_ap

plication_variables

Value enabled / disabled

IGEL Setup Sessions > RDP > RDP Global > Local Logon

Parameter Type
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Registry rdp.login.saveusertype

Value Set user/domain from session setup / Set user/
domain from last login

Added Arabic (101) keyboard layout to RDP client.
Added MultiPointServer 2016 to supported servers for RDP MultiPoint Server appliance.

RD Web Access

Fixed wrong RDP Remote Application icon when opening a application twice.
Fixed unexpected behavior when maximizing/minimizing RDP Remote Applications.

VMware Horizon

Added possibility to make certificate verification mandatory. 
More...

Parameter Allow change of certificate verification mode

Registry vmware.view.ssl-verify-mode-change-

allow

Value enabled / disabled

Fixed H.264 hardware decoding for Horizon.

PowerTerm

Fixed printing to CUPS printers in PowerTerm.
Added TLS-1.2 in list of SSL Versions for PowerTerm on page Sessions > PowerTerm Terminal 
Emulation > PowerTerm Sessions > session name > Connection.

Parallels Client

Fixed: Authentication fails with Gemalto smartcards.
Fixed: Sometimes remote session windows remain on screen after one was logged off from the 
remote session.
Fixed: Remote session closes unexpectedly.
Fixed: Combination of CTRL-C doesn't work in remote session.
Improved: Use of multiple monitors.
Fixed: Client might hang while watching YouTube videos.
Fixed: Multiple USB drives might not be auto-mapped to a remote session.
Fixed: Logoff from a remote session blocks Linux desktop with a black screen.

Firefox

Fixed occasional loss of trusted certificates in Firefox. Certificates transmitted via UMS 
filetransfer were not reinstalled when Firefox profile was rebuilt.
Fixed PDF Plugin in Firefox browser.
Removed the browser plugin option from RHEV/Spice as it is no longer supported.
Removed the browser plugin option from SecMaker as it is no longer supported.
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Network

Fixed failing Wake-on-LAN configuration after update on shutdown. Particularly UD2-LX40 
devices were affected.
Fixed bug in the GetCA operation for SCEP: An intermediate certificate in addition to the root 
certificate and any RA certificates resulted in confusion.
sscep version is now 0.6.1
CA certificate fingerprint is now mandatory for SCEP. So far it could be left empty for debugging 
purposes.
Added parameter to specify whether a slash (/) is appended to SCEP URL. The slash is needed 
e.g. with Microsoft servers, but not with Nexus servers. 
More...

Parameter Append slash (/) to SCEP server URL

Registry network.scepclient.cert0.scepurlappends

lash

Value enabled / disabled

Fixed generating certificate request if challenge password or other fields include special 
characters like $, #, quotes or spaces in SCEP.
Reaction to Ethernet 802.1X reauthentication failure is now configurable. 
More...

Parameter Restart on reauthentication failure

Registry network.interfaces.ethernet.device%.ieee8

021x.restart_on_reauth_failure

Value enabled / disabled

The default value preserves the traditional behaviour. If the registry key is set to enabled 
the network connection will get restarted when a reauthentication failure occurs. This 
way the system might switch to a guest VLAN where authentication is not required.

Added support for SFTP protocol (enabled as default) configurable with new registry key. 
More...

Parameter Enable SFTP server

Registry network.ssh_server.enable_sftp_server

Value enabled / disabled

Improved general security in regards of SCEP

WiFi

Fixed non working Mediatek MT7630e WiFi driver.
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Added several WiFi drivers (Realtek 8188eu, 8822be, 8150, 8187, 8192ce, 8192de, 8192ee, 8723ae, 
8821ae....) to the firmware.
Re-enforce configuration after IGEL Setup Assistant exits to ensure consistent state between 
configuration and system.
Added drivers for Realtek rtl8723de and rtl8822be WiFi devices.
Added support for StarTech USB300WN2X2C Wireless-N WiFi adapter.

Smartcard

Updated OpenSC library to version 0.19.0. Improved handling of PIV and CAC ALT token and 
other improvements.
Fixed problem with ActivClient smartcards in VMware Horizon sessions. Before this fix, 
smartcard access inside the session was blocked. 
More...

Parameter Smartcard SCardConnect in non-blocking mode

Registry vmware.view.pcsc-connect-nonblocking

Value enabled / disabled

Improved PC/SC lite daemon to handle attributes SCARD_ATTR_DEVICE_FRIENDLY_NAME_W and 
SCARD_ATTR_DEVICE_SYSTEM_NAME_W.
Updated Cherry USB2LAN Proxy to version 3.0.0.6.

Fixed an issue where the SICCT listener was not restarted when a SICCT connection has 
been closed by the EGK device (ORS-880).
Fixed TLS errors resulting from re-using channels before the EGK device confirmed the 
disconnection of the previous connection (ORS-735).
Increase connection handshake timeout from 1 second to 20 seconds. This is necessary 
as the EGK device (G87-1505, firmware 2.108.3) does not process the handshake 
immediately in all situations. (ORS-735).
Added timestamp to log output.

Fixed AD/Kerberos log on with smartcard and Smartcard Removal Action: Lock Thin Client.
Fixed custom PKCS#11 module  for VMware Horizon logon. Before this fix, the parameters did 
not get effective. 
More...

Parameter Horizon logon with custom PKCS#11 module

Registry vmware.view.pkcs11.use_custom

Value enabled / disabled

Parameter Path to the library

Registry vmware.view.pkcs11.custom_path

Value

Fixed error in IGEL Smartcard which prevented login with personalized cards when certain 
card holder names contained non-ASCII characters.
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HID

Added support for Wacom HID 483C touchscreens (HP Pro x2 612 g2).
Fixed non working Lenovo KBRFBU71 wireless keyboard.
Fixed mouse button mapping.

CUPS Printing

Fixed HPLIP related printer drivers.
Added missing LaserJet 200 color MFP M276 Postscript to Printer Names for manufacturer HP 
in the TC Setup under Devices > Printer > CUPS > Printers.

Application Launcher

Fixed display order of DNS servers in Application Launcher and About dialog.

OpenVPN

Fixed no retry in case the client key passphrase was entered incorrectly.

Base system

IGEL Setup Assistant fixes:
Fixed startup on first boot.
Retain network configuration if exited via cancel.
Fixed graphical glitches
Fixed WiFi configuration
Prevent startup if an administrator passphrase is set (e.g. from a IGEL System 5 
migration).

Fixed System suspend on inactivity showing the suspend dialog directly after system resume.
Fixed the custom bootsplashscaling when multiple monitors are configured. Necessary to 
force a re-installation of the custom bootsplash for this fix to take effect. To force a re-installation:

Trigger the Update desktop customization command via UMS or
Press the Bootsplash update button at IGEL Setup > System > Firmware Customization > 
Corporate Design > Custom Bootsplash.

Fixed sporadic problems with custom bootsplash and wallpaper installation.
Fixed the buddy update server so that UD Pocket devices can also update from buddy update 
servers.
Fixed handling of custom environment variables. If values contained white spaces the variables 
could not be set.
Fixed reboot/shutdown when triggered from the lock screen panel.
Improved support for IGEL UD7 with additional graphic card.
Removed maximize button from on-screen keyboard window.
Fixed deletion of debuglog partition content when booted in emergency boot.
Fixed handling of optional partitions which are not active as default while booting in 
emergency mode.
Fixed instability in authentication module pam_igelsession.so in some special cases.
Fixed ECDSA/ECDH support in HEIMDAL libraries.
Fixed black screen issues if hostname contains other characters as 'A-Z a-z 0-9 . _ - ' .
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Improved debuglog partition based login.
Restricted access to command **su** to root and user.
Root home is now /root.
Removed system group (GID 0) which shadowed root group (GID 0).
Stricter folder and file permissions.
Prevent flickering problems on 4k 60Hz screens.

Storage Devices

Fixed mount issue of PTP devices (Mobile Device Access USB feature must be enabled).
Fixed double detection of MTP and PTP. MTP is preferred over PTP now (Mobile Device Access 
USB feature must be enabled).

Appliance Mode

Fixed configuration of post session commands via UMS profile: There is no second reboot 
required anymore to apply the settings properly in Appliance Mode.

X11 system

Fixed automatic order selection of screens for IGEL UD7.
Fixed order of desktop wallpapers for IGEL UD7 when the additional graphics card is installed.
Fixed screen stays black problem on UD3-LX.
Fixed non loading DRM/KMS driver on Spectra Nise 106.
Added possibility to change the framebuffer compression for AMDGPU driver. 
More...

Parameter AMDGPU framebuffer compression.

Registry x.drivers.amdgpu.use_fbc

Range [default][enable][disable]

Fixed sessions.user_display0.options.lid_events  work for eDP also.
Fixed VESA only boot with UEFI system.
AMDGPU stability fixes applied.
Fixed issue with screen configuration for certain cases.
Fixed screen configuration getting in endless loop with multi monitor setups.
Fixed memleak in igel_drm_daemon .
Fixed DRI2 memleak with AMDGPU driver.
Changed x.xserver0.force_reconfig registry key  (former bool now range). 
More...

Parameter Force a display reconfiguration

Registry x.xserver0.force_reconfig

Range [default][only on Xorg start/restart][always][never]

Usage of only on Xorg start/restart as new default for AMDGPU based devices.
Removed x.xserver0.composite  registry key to prevent problems with AMD/ATI devices.
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Fixed screen remains black when Monitor Probing (DDC) option is "Off", configurable at setup 
page User Interface > Display > Options.
Added possibility to configure graphic displays only if DPMS state is not OFF. 
More...

Parameter Do not reconfigure if monitors are in DPMS off state

Registry x.xserver0.config_on_dpms_on

Value enabled / disabled

Window Manager

On-Screen Keyboard will keep aspect ratio when resized via double click on edge.

Shadowing/VNC

Fixed instability of Secure Shadowing connector.

Audio

Added a workaround for button handling of Sennheiser USB headsets.
Fixed saving and restoring of volume controls in Pulseaudio and ALSA.
Improved consistency while storing of changed volume values.
Fixed missing audio output over DVI to HDMI/DP in IGEL UD2 (D220).
Fixed configuration of the default sound output or input on hardware when presence detection 
in jack connector is missing.

Hardware

Fixed non working StarTech.com USB2DVIPRO2 DisplayLink graphics adapter.
Fixed freezes of Intel Baytrail devices.
Fixed non working DisplayLink USB graphics adapter after reboot.

Remote Management

Fixed zero touch deployment by adding a timeout to the Setup Assistant abort message.
Fixed computation of Unit ID. The Unit ID is the identification key of the thin client in UMS, and 
also thin client licenses will be bound to the Unid ID. Now the Unit ID is computed once and 
persistently saved. It consists of the serial number of UD Pocket or the MAC address of a network 
interface. When multiple network interfaces are present, the interface is selected taking following 
attributes into account: 
If a license bound to the interface exists, how it is connected (PCI, SDIO, USB or other) and if it is 
wireless or wired. 
It is best practice not to connect external network interfaces when a freshly installed thin client 
device is booted for the first time, so that the Unit ID will consist of a MAC address of a network 
interface which cannot be removed from the thin client device.
Fixed monitor serial numbers not shown in UMS.
Fixed Bluetooth Asset Inventory zombie when bluetooth dongle is removed.
Fixed UMS filetransfer - now filetransfer action is triggered also if only the file classification was 
changed.
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• Fixed Update on shutdown UMS job which could be stucked if update is failed once for some 
reasons.
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IGEL Universal Desktop OS3/IGEL UD Pocket
Supported Hardware:

https://kb.igel.com/igelos/en/devices-supported-by-udc3-and-ud-pocket-3117174.html

Versions 10.05.100 (see page 1270)
General Information 10.05.100 (see page 1274)
Security Fixes 10.05.100 (see page 1275)
Known Issues 10.05.100 (see page 1280)
New Features 10.05.100 (see page 1282)
Resolved Issues 10.05.100 (see page 1308)
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Versions 10.05.100
Clients
Product Version

Citrix HDX Realtime Media Engine 2.6.0-2030

Citrix Receiver 13.10.0.20

Citrix Receiver 13.5.0.10185126

Citrix Receiver 13.9.1.6

deviceTRUST Citrix Channel 17.2.100.0

deviceTRUST RDP Channel 17.2.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6840

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.29

Firefox 60.2.2

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_181

Parallels Client (32 bit) 16.5.1.20446

Parole Media Player 1.0.1-0ubuntu1igel11

Remote Viewer (RedHat Virtualization) 7.0-igel47

Spice GTK (Red Hat Virtualization) 0.35

Spice Protocol (Red Hat Virtualization) 0.12.14

Usbredir (Red Hat Virtualization) 0.8.0

Systancia AppliDis 4.0.0.17
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Thinlinc Client 4.9.0-5775

ThinPrint Client 7.5.86

Totem Media Player 2.30.2

VMware Horizon Client 4.8.0-8518891

VNC Viewer 1.8.0+git20180123-igel1

Voip Client Ekiga 4.0.1

Permalink:https://kb.igel.com/display/ENLITEOS/Versions+OS3+10.05

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20180621

Philips Speech Driver 12.5.4

Signature
Kofax SPVC Citrix Channel 3.1.41.0

signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.1.9.620

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.7.0.23

Reader Driver ACS CCID 1.1.5

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.3.3

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5
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Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.28

Reader Driver REINER SCT cyberJack 3.99.5final.SP11

Resource Manager PC/SC Lite 1.8.22

Cherry USB2LAN Proxy 3.0.0.6

System Components
OpenSSL 1.0.2g-1ubuntu4.13

OpenSSH Client 7.2p2-4ubuntu2.4

OpenSSH Server 7.2p2-4ubuntu2.4

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.2.1-1igel51

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20180214-igel1830

Graphics Driver ATI/RADEON 18.0.1-1igel831

Graphics Driver ATI/AMDGPU 18.0.1-1igel831

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2igel775

Graphics Driver Nvidia 390.87-0ubuntu1

Graphics Driver Vboxvideo 5.2.18-dfsg-2igel17

Graphics Driver VMware 13.3.0-2igel812

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.3.4-1build2igel639

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver Vmmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813
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Kernel 4.18.11 #mainline-udos-r2463

Xorg X11 Server 1.19.6-1ubuntu4igel838

Xorg Xephyr 1.19.6-1ubuntu4igel832

CUPS printing daemon 2.1.3-4ubuntu0.5igel20

PrinterLogic 18.2.1.128

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel653

ISC DHCP Client 4.3.3-5ubuntu12.10igel6

NetworkManager 1.2.6-0ubuntu0.16.04.2igel58

ModemManager 1.6.8-2igel1

GStreamer 0.10 0.10.36-2ubuntu0.1

GStreamer 1.x 1.14.2-1ubuntu1igel192

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect

Scanner support / SANE

VirtualBox

Features with Limited Functionality
Cisco JVDI Client 12.0
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General Information 10.05.100
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1 - 13.4
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
Remote Access via RSH
Legacy Philips Speech Driver
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
VIA Graphic Support
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

- by panel tray icon

- by an icon in the In-Session Control Bar (configurable at IGEL Setup > User Interface > Desktop)

- by a Safely Remove Hardware session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in this release:

Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
Composite Manager
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Security Fixes 10.05.100
Firefox

Updated Mozilla Firefox to version 60.2.2esr. 
More...

mfsa2018-24: CVE-2018-12386, CVE-2018-12387

mfsa2018-23: CVE-2018-12385, CVE-2018-12383

mfsa2018-21: CVE-2018-12377, CVE-2018-12378, CVE-2018-12376

mfsa2018-16: CVE-2018-12359, CVE-2018-12360, CVE-2018-12361, CVE-2018-12362,

CVE-2018-5156, CVE-2018-12363, CVE-2018-12364, CVE-2018-12365,

CVE-2018-12371, CVE-2018-12366, CVE-2018-12367, CVE-2018-12369,

CVE-2018-5187, CVE-2018-5188

mfsa2018-14: CVE-2018-6126

mfsa2018-11: CVE-2018-5154, CVE-2018-5155, CVE-2018-5157, CVE-2018-5158,

CVE-2018-5159, CVE-2018-5160, CVE-2018-5152, CVE-2018-5153,

CVE-2018-5163, CVE-2018-5164, CVE-2018-5166, CVE-2018-5167,

CVE-2018-5168, CVE-2018-5169, CVE-2018-5172, CVE-2018-5173,

CVE-2018-5175, CVE-2018-5176, CVE-2018-5177, CVE-2018-5165,

CVE-2018-5180, CVE-2018-5181, CVE-2018-5182, CVE-2018-5151,

CVE-2018-5150.

mfsa2018-10: CVE-2018-5148

Firefox profile partition is now mounted at /userhome/.mozilla instead of /.ffpro.
Firefox could only be started as user.
For security reasons Java processes could not be started from a browser session now.
Added a registry parameter  java.browser.access  to control java access for all browser 
sessions. 
More...

Parameter Allow browser to use java

Registry java.browser.access

Value enabled / disabled

Network

Disabled ICMP redirects.
Changed default LoginGraceTime from 120 to 30 sec.
Added new registry keys for a secure sshd configuration. 
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More...

Parameter Permit X11 forwarding

Registry network.ssh_server.x11_forwarding

Value enabled / disabled

Parameter Show banner

Registry network.ssh_server.show_banner

Value enabled / disabled

Parameter Permit tcp tunnel forwarding

Registry network.ssh_server.permit_tcp_forwardi

ng

Value enabled / disabled

Fixed SCEP client certificate request file access rights.

Base system

Added apparmor as an additional security layer for components like Firefox, evince, dhcpclient 
and cups. 
More...

Parameter Enable apparmor profiles

Registry system.security.apparmor

Value enabled / disabled

For security reasons graphical terminal sessions could now only be started by an administrator 
when an admin password is set. Administrator must authenticate before a terminal session is 
started. This does also affect graphical terminal sessions spawned by applications.
To allow users to start a terminal session again a registry key is defined. 
More...

Parameter User shell terminal

Registry system.security.usershell

Value enabled / disabled

Fixed open-vm-tools security issue CVE-2015-5191.
Fixed procps security issues CVE-2018-1126, CVE-2018-1125, CVE-2018-1124, CVE-2018-1123 and 
CVE-2018-1122.
Fixed imagemagick security issues. 
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More...

CVE-2018-9133, CVE-2018-8960, CVE-2018-8804 

CVE-2018-7443, CVE-2018-5248, CVE-2018-11251, CVE-2018-10177, CVE-2017-18273,

CVE-2017-18271, CVE-2017-18252, CVE-2017-18211, CVE-2017-18209,

CVE-2017-17914, CVE-2017-17879, CVE-2017-17682, CVE-2017-17681,

CVE-2017-17504, CVE-2017-16546, CVE-2017-15281, CVE-2017-15277,

CVE-2017-15017, CVE-2017-15016, CVE-2017-15015, CVE-2017-14989,

CVE-2017-14741, CVE-2017-14739, CVE-2017-14682, CVE-2017-14626,

CVE-2017-14625, CVE-2017-14624, CVE-2017-14607, CVE-2017-14532,

CVE-2017-14531, CVE-2017-14505, CVE-2017-14400, CVE-2017-14343,

CVE-2017-14342, CVE-2017-14341, CVE-2017-14325, CVE-2017-14249,

CVE-2017-14224, CVE-2017-14175, CVE-2017-14174, CVE-2017-14173,

CVE-2017-14172, CVE-2017-14060, CVE-2017-13769, CVE-2017-13768,

CVE-2017-13758, CVE-2017-13145, CVE-2017-13144, CVE-2017-13143,

CVE-2017-13142, CVE-2017-13139, CVE-2017-13134, CVE-2017-12983,

CVE-2017-12877, CVE-2017-12875, CVE-2017-12693, CVE-2017-12692,

CVE-2017-12691, CVE-2017-12674, CVE-2017-12670, CVE-2017-12643,

CVE-2017-12640, CVE-2017-12587, CVE-2017-12563, CVE-2017-12435,

CVE-2017-12432, CVE-2017-12431, CVE-2017-12430, CVE-2017-12429,

CVE-2017-12140, CVE-2017-11640, CVE-2017-11639, CVE-2017-11537,

CVE-2017-11535, CVE-2017-11533, CVE-2017-11352, CVE-2017-10995,

CVE-2017-1000476, CVE-2017-1000445, CVE-2018-13153, CVE-2018-12600 and

CVE-2018-12599.

Fixed elfutils security issues CVE-2017-7613, CVE-2017-7612, CVE-2017-7611, CVE-2017-7610, 
CVE-2017-7609, CVE-2017-7608, CVE-2017-7607, CVE-2016-10255 and CVE-2016-10254.
Fixed ghostscript security issues CVE-2018-10194, CVE-2016-10317, CVE-2018-16802, 
CVE-2018-16585, CVE-2018-16543, CVE-2018-16542, CVE-2018-16541, CVE-2018-16540, 
CVE-2018-16539, CVE-2018-16513, CVE-2018-16511, CVE-2018-16509, CVE-2018-15911, 
CVE-2018-15910, CVE-2018-15909, CVE-2018-15908, CVE-2018-11645, CVE-2018-1, CVE-2018-17183 
and CVE-2018-16510.
Fixed icu security issue CVE-2017-15422.
Fixed webkit2gtk security issues. 
More...

CVE-2018-4200, CVE-2018-4165, CVE-2018-4163,

CVE-2018-4162, CVE-2018-4161, CVE-2018-4146, CVE-2018-4133, CVE-2018-4129,

CVE-2018-4128, CVE-2018-4127, CVE-2018-4125, CVE-2018-4122, CVE-2018-4120,
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CVE-2018-4119, CVE-2018-4118, CVE-2018-4117, CVE-2018-4114, CVE-2018-4113,

CVE-2018-4101, CVE-2018-4233, CVE-2018-4232, CVE-2018-4222, CVE-2018-4218,

CVE-2018-4199, CVE-2018-4190, CVE-2018-12293, CVE-2018-4284, CVE-2018-4278,

CVE-2018-4273, CVE-2018-4272, CVE-2018-4270, CVE-2018-4267, CVE-2018-4266,

CVE-2018-4265, CVE-2018-4264, CVE-2018-4263, CVE-2018-4262, CVE-2018-4261,

CVE-2018-4246 and CVE-2018-12911.

Fixed perl security issues CVE-2018-6913, CVE-2018-6798, CVE-2018-6797, CVE-2017-6512, 
CVE-2016-6185 and CVE-2018-12015.
Fixed poppler security issues CVE-2017-18267 and CVE-2018-13988.
Fixed openssl security issues CVE-2018-0739, CVE-2018-0737, CVE-2018-0737, CVE-2018-0732 and 
CVE-2018-0495.
Fixed tiff security issues. 
More...

CVE-2018-5784, CVE-2017-9936, CVE-2017-9935,

CVE-2017-9815, CVE-2017-9404, CVE-2017-9403, CVE-2017-9147, CVE-2017-9117,

CVE-2017-7602, CVE-2017-7601, CVE-2017-7600, CVE-2017-7599, CVE-2017-7598,

CVE-2017-7597, CVE-2017-7596, CVE-2017-7595, CVE-2017-7594, CVE-2017-7593,

CVE-2017-7592, CVE-2017-5563, CVE-2017-18013, CVE-2017-17095, CVE-2017-13727,

CVE-2017-13726, CVE-2017-12944, CVE-2017-11613, CVE-2017-11335,

CVE-2017-10688, CVE-2016-5318, CVE-2016-5102, CVE-2016-3186, CVE-2016-10371,

CVE-2016-10269, CVE-2016-10268, CVE-2016-10267 and CVE-2016-10266.

Fixed libvncserver security issue CVE-2018-7225.
Fixed libvorbis security issue CVE-2018-5146.
Fixed samba security issues CVE-2018-1057, CVE-2018-1050, CVE-2018-10919 and CVE-2018-10858.
Fixed wget security issue CVE-2018-0494.
Fixed bluez security issue CVE-2017-1000250.
Fixed libgcrypt20 security issue CVE-2018-0495.
Fixed file security issue CVE-2018-10360.
Fixed gnupg2 security issue CVE-2018-12020.
Fixed isc-dhcp security issues CVE-2018-5733, CVE-2018-5732, CVE-2018-573, CVE-2017-3144 and 
CVE-2016-2774.
Fixed curl security issues CVE-2018-1000303, CVE-2018-1000301, CVE-2018-1000300, 
CVE-2018-1000122, CVE-2018-1000121, CVE-2018-1000120, CVE-2017-8818, CVE-2018-14618 and 
CVE-2018-0500.
Fixed python3.5 security issues CVE-2017-1000158, CVE-2016-5636, CVE-2016-1000110 and 
CVE-2016-0772.
Fixed zlib security issues CVE-2016-9843, CVE-2016-9842, CVE-2016-9841 and CVE-2016-9840.
Fixed libsoup2.4 security issue CVE-2018-12910.
Fixed libjpeg-turbo security issue CVE-2018-1152.
Fixed ntp security issues CVE-2018-7185 and CVE-2018-7183.
Fixed libpng1.6 security issue CVE-2018-13785.
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Fixed cups security issues CVE-2018-6553, CVE-2018-4181, CVE-2018-4180, CVE-2018-418 and 
CVE-2017-18248.
Fixed libpng security issue CVE-2016-10087.
Fixed policykit-1 security issue CVE-2018-1116.
Fixed jansson security issue CVE-2016-4425.
Fixed libmspack security issues CVE-2018-14682, CVE-2018-14681, CVE-2018-14680 and 
CVE-2018-14679.
Fixed libonig security issues CVE-2017-9229, CVE-2017-9228, CVE-2017-9227, CVE-2017-9226 and 
CVE-2017-9224.
Fixed libxcursor security issue CVE-2015-9262.
Fixed heimdal security issue CVE-2017-17439.
Fixed libarchive security issues CVE-2017-14503, CVE-2017-14501, CVE-2017-14166, 
CVE-2016-10350, CVE-2016-10349 and CVE-2016-10209.
Fixed libxml2 security issues CVE-2018-14567, CVE-2018-14404, CVE-2017-18258 and 
CVE-2016-9318.
Fixed confuse security issue CVE-2018-14447.
Fixed libgd2 security issues CVE-2018-5711 and CVE-2018-1000222.
Fixed libx11 security issues CVE-2018-14600, CVE-2018-14599, CVE-2018-14598, CVE-2016-7943 
and CVE-2016-7942.
Fixed mpg123 security issues CVE-2017-10683 and CVE-2016-1000247.
Fixed libtirpc security issues CVE-2018-14622, CVE-2017-8779 and CVE-2016-4429.
Fixed jq security issue CVE-2015-8863.
Fixed bind9 security issue CVE-2018-5740.
Fixed lcms2 security issue CVE-2018-16435.
Fixed xdg-utils security issue CVE-2017-18266.
Root home is now /root.
Removed system group (GID 0) which shadowed root group (GID 0).
Stricter folder and file permissions.

X11 system

Restricted desktop icon creation to administrator only. Therefore, "/userhome/Desktop" is 
owned by root now.
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Known Issues 10.05.100
Citrix Receiver 13

On devices with AMD/Radeon graphics chipsets and activated DRI3 X driver 
option the hardware accelerated Citrix H.264 decoder plugin can hang. To solve this issue 
deactivation of DRI3 option is necessary  (default setting). Selective H.264 mode (api v2) is not 
affected from this issue.
Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard 
correctly when the card is inserted after start of login. As a workaround, insert the smartcard 
before starting StoreFront login.
The Citrix Receiver has known issues with GStreamer1.x. This causes problems with multimedia 
redirection of H264, MPEG1 and MPEG2. GStreamer1.x is used if browser content redirection is 
active.

Parallels Client

Native USB redirection does not work with Parallels Client.
Due to a bug in the Parallels-Client, for using the new FIPS 140-2 compliance mode it is necessary 
to connect to the Parallels RAS one time with FIPS support disabled.

VMware Horizon

VMware Horizon Client for Linux 4.8.0 supports FIPS Mode on only VMware Horizon server 
installations up to version 7.5 .
External drives are mounted already before connection, do not appear in the remote 
desktop. Workaround: mapping the directory  /media  as a drive on desktop. The external 
devices will show up within the media drive then.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug on setup page Devices > Storage Devices > Storage Hotplug.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Enable local Storage Hotplug on setup page Devices > Storage Devices > Storage 
Hotplug.

OpenConnect VPN

VPNs that require the OpenConnect client cannot be used for firmware updates.

Appliance Mode

Appliance mode RHEV/Spice: spice-xpi Firefox plugin is no longer supported. The Console 
Invocation has to allow native client (auto is also possible) and it should start in fullscreen to 
prevent opening windows.
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Smartcard

In seldom cases, the authentication hung when using A.E.T. SafeSign smartcards.

IGEL Cloud Gateway

No support for UMS file transfer status in ICG protocol.
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New Features 10.05.100
Citrix Receiver 13

Integrated Citrix Receiver 13.10. Citrix Receiver version 13.7.0 was removed. Citrix Receiver 
version 13.8.0 was removed. Available Citrix Receiver versions: 13.5.0, 13.9.1, 13.10 (default)

Enable Browser content redirection for rendering of whitelisted webpages on the IGEL 
Thin Client. 
More...

IGEL SetupSessions > Citrix XenDesktop > HDX / ICA Global > HDX Multimedia

Parameter Browser content redirection

Registry ica.module.virtualdriver.webpageredirection

Value enabled / disabled

Enhanced Citrix retail logging. 
More...

Parameter Citrix Logging

Registry ica.module.syslogthreshold

Value 0 / 3 / 7

> 0 = Disabled; > 3 = Log only errors; > 7 = Log all levels

Enable Port forwarding. 
More...

ParameterPortforward

Registry ica.module.virtualdriver.portforward

Value enabled / disabled

Workspace configuration parameter for Citrix Cloud is now available on setup page. 
More...

IGEL SetupSessions > Citrix XenDesktop > HDX / ICA Global > Options

Parameter Connect to cloud

Registry ica.cloudconnect

Value enabled / disabled

Added a registry key to control the visibility of the Citrix connection bar for desktop 
sessions. If activated, the In-Session Control Bar should be disabled 
at  userinterface.igel_toolbar.enable   
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and  userinterface.igel_toolbar.show_always . 
This enables the control of the new Multi-monitor layout persistence feature. 
More...

ParameterCitrix Connection Bar

Registry ica.allregions.connectionbar

Value factory default / off / on / server determined

Added a registry key to control the availability of deprecated cipher suites: 
TLS_RSA_AES256_GCM_SHA384, TLS_RSA_AES128_GCM_SHA256,
TLS_RSA_AES256_CBC_SHA256, TLS_RSA_AES256_CBC_SHA, 
TLS_RSA_AES128_CBC_SHA,
TLS_RSA_3DES_CBC_EDE_SHA. 
More...

Parameter TLS RSA cipher suites

Registry ica.allregions.enable_tls_rsa

Value factory default / false / true

Factory default: true/enabled. Citrix explicitly remarks: Important: Set the 
flag  enable_tls_rsa  to true to use the other two cipher suites Enable_RC4-
MD5 and Enable_RC4_128_SHA.

Added a registry key to control the availability of the deprecated cipher suite: RC4-MD5. 
More...

Parameter RC4-MD5 cipher suite

Registry ica.allregions.enable_rc4_md5

Value factory default / false / true

Factory default: false/disabled. 

Added a registry key to control the availability of the deprecated cipher 
suite: RC4_128_SHA. 
More...

Parameter RC4_128_SHA cipher suite

Registry ica.allregions.enable_rc4_128_sha

Value factory default / false / true

Factory default: false/disabled. 
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Added Selective H.264 (API v2) to the  hardware accelerated Citrix deep compression codec. 
XenDesktop/XenApp server policy: Use video codec for compression -> For actively changing 
regions
Added DRI3 acceleration support to the hardware accelerated Citrix deep compression codec (for 
INTEL and AMD graphics adapters).

Enable debugging to log file  /var/log/user/ctxh264.log . 
More...

Parameter Enable H264 codec debug output

Registry ica.hw-accelerated-h264-codec-debug

Value enabled / disabled

Added Kerberos Passthrough (domain passthrough) authentication to StoreFront. 
Configurable at Sessions > Citrix XenDesktop / XenApp > HDX / ICA Global > StoreFront Logon > 
Authentication Type.
Updated Citrix HDX RTME used for optimization of Skype for Business to 2.6.0-2030. This new 
version adds the support for hardware accelerated H.264 en- and decoding on AMD platforms. 
See https://support.citrix.com/article/CTX236304 section Capability Checker for Linux 
platforms how to enable hardware decoding with Citrix VDA registry 
keys  DisableLinuxAMDH264HardwareDecoding  and  SupportedAMDHWAVideoCardL

ist . The capability check program RTOP-CapabilityChk-x64 is already installed at path  /

services/ica/hdx_rtme/RTOP-CapabilityChk-x64 . The check program must be run 
with user permissions.
Added display of logged on Citrix username in screen lock, when screen lock password is 
synchronized with Citrix password.
Added checkbox to activate autostart of a single published application/desktop session. 
More...

IGEL Setup Sessions > Citrix XenDesktop / XenApp > Citrix 
StoreFront/Web Interface > Login

Parameter Start a single published application automatically

Registry ica.pnlogin.autostart_single_application

Value enabled / disabled

Added Lakeside SysTrack virtual channel in Citrix, RDP and Horizon sessions. Activation via 
parameters in Setup. 
More...

IGEL Setup Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global 
> Mapping > Device Support

Parameter Lakeside Systrack channel

https://support.citrix.com/article/CTX236304
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Registry ica.module.virtualdriver.lakeside.enable

Value enabled / disabled

IGEL Setup Sessions > RDP > RDP Global > Mapping > Device 
Support

Parameter Lakeside Systrack channel

Registry rdp.winconnect.plugins.lakeside.use

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > 
Performance

Parameter Lakeside Systrack

Registry vmware.view.lakeside_systrack

Value enabled / disabled

Updated Olympus dictation channel for Citrix to version 20180621. 
More...

IGEL Setup Sessions > Citrix XenDesktop / XenApp > HDX / ICA 
Global > Mapping > Device Support

Parameter Olympus channel for dictation

Registry ica.module.virtualdriver.olycom.enable

Value enabled / disabled

Added CrossMatch / DigitalPersona channel for Citrix version 0515. 
More...

IGEL Setup Sessions > Citrix XenDesktop /XenApp > HDX / ICA 
Global > Mapping > Device Support

Parameter Crossmatch DigitalPersona fingerprint channel

Registry ica.module.virtualdriver.dpicacnt.enable

Value enabled / disabled

RDP/IGEL RDP Client 2

Support for new RDP 10 codec AVC444 (H.264), which reduces network bandwidth with Server 
2016 and Windows 10 hosts. AMD Radeon graphics is required on the client side. Other  graphics 
hardware (e.g. Intel) as well as other RDP 10 codecs (AVC420 and AVC444V2) will be supported in 
the future. 
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More...

IGEL Setup Sessions > RDP > RDP Global > Performance

Parameter Hardware accelerated codecs AVC420/AVC444 (H.264)

Registry rdp.winconnect.enable-h264

Value auto / on / off

IGEL Setup Sessions > RDP > RDP Sessions > Session Name > 
Performance

Parameter Hardware accelerated codecs AVC420/AVC444 (H.264)

Registry sessions.winconnect%.option.enable-h264

Value Global setting / auto / on / off

The value "auto" enables supported codecs on supported hardware.

The value "on" enables supported codecs on all hardware.

The value "off" disables H.264 codecs.

Added new parameter ignore_errors to RDP Session config to suppress RDP error messages. 
More...

Registry sessions.winconnect%.ignore_errors

Value enabled / disabled

Added Olympus dictation channel for RDP version 20180621. 
More...

IGEL Setup Sessions > RDP > RDP Global > Mapping > Device 
Support

Parameter Olympus channel for dictation

Registry rdp.winconnect.plugins.olyvc.use

Value enabled / disabled

UD Pocket

UD Pocket demo license registration dialog will now show an option to set up proxy servers 
when IGEL servers cannot be reached.
Updated the page displayed for the UD Pocket demo registration. It can be choosen now whether 
a partner or the customer is setting up the device, before displaying the form asking for customer 
information.

Parallels Client

Updated Parallels client to version 16.5.1.20446 (32-Bit)
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Added support for FIPS 140-2 compliance. 
More...

IGEL Setup System > Registry

Parameter Enable support for FIPS 140-2 compliance

Registry sessions.twox%.connection.fips_compli

ance

Value enabled / disabled

VMware Horizon

Updated Horizon client to version 4.8.0-8518891.

ThinLinc

Updated ThinLinc client to version 4.9.0.
Shadowing notification is now more reliable and interactive, allowing end users more 
control of their sessions.
More than 80 minor enhancements and fixes. See https://www.cendio.com/thinlinc/docs/
relnotes/4.9.0.

RedHat Enterprise Virtualization client

Updated spice components (virt-viewer 7.0, spice-gtk 0.35).
Removed support for spice-xpi plugin.

X session (Xephyr)

Added support for X sessions configurable at `IGEL Setup > Sessions > X Sessions`. The available 
XDMCP connection types: indirect via localhost, indirect, direct and broadcast. With the additional 
connection type "local display" a command can be specified, that will be displayed inside the X 
session window. 
More...

IGEL SetupSessions > X Sessions > X Session > Server

Parameter Connection type

Registry sessions.xnest<NR>.server.connectiontype

Range  [Indirect via localhost] [Indirect] [Direct] [Broadcast] [Local display]

IGEL SetupSessions > X Sessions > X Session > Server

Parameter Command to be displayed

Registry sessions.xnest<NR>.server.runcommand

Firefox

Updated Mozilla Firefox to version 60.2.2 ESR.

https://www.cendio.com/thinlinc/docs/relnotes/4.9.0
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The initial page displayed by firefox with default settings is now https://kb.igel.com/ instead of 
the older https://edocs.igel.com/.
Updated Adobe Flash Player download URL to version 31.0.0.122.
Removed the webapp specific options, this feature was removed from Firefox and is not relevant 
anymore.
Moved Browser Certificate configuration to page Sessions > Browser > Browser Global > 
Certificates. 
Moved Browser Security Device configuration to page Sessions > Browser > Browser Global > 
Smartcard Middleware.
Added Fluendo FFmpeg GStreamer proxy: Provides ffmpeg-libavcodec-compatible library, which 
is needed for H.264 playback in firefox. Instead decoding by standard ffmpeg libraries, the video 
stream is redirected to GStreamer framework.

Network

SCEP: Added subject alternative name type DNS Name as UPN (auto). This is similar to DNS 
Name (auto). In the CSR the result is a Microsoft User Principal Name (UPN) that consists of the 
hostname.
NetworkManager updated to version 1.2.6.

Cisco JVDI Client

Integrated new Cisco Jabber Softphone for VDI (Cisco JVDI client) version 12.0.0 as feature with 
limited functionality. See product documentation for details -> https://kb.igel.com/cisco-jvdi/en. 
Activation of this feature at: System > Firmware Customization > Features > Cisco JVDI client. 
Only Citrix Receiver 13.9.1 is supported. 
More...

ParameterLog Level

Registry multimedia.ciscovxme.log_level

Range  [Info] [Warning] [Error] [Fatal] [Debug] [Trace]

IGEL Setup Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global 
> Unified Communications > Cisco JVDI Client

Parameter Cisco JVDI Client

Registry ica.module.virtualdriver.vdcisco.enable

Value enabled / disabled

Registry path for Common JVDI options: `multimedia.ciscovxme.**` The Cisco JVDI Client 
configuration is only displayed if the Multimedia Codec Pack (MMC) is present.

Java

Updated Oracle Java Runtime Environment to version 1.8.0 U181.

Smartcard
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Updated SecMaker Net iD to version 6.7.0.23.
Updated HID Global Omnikey smartcard reader driver to version 4.3.3.
Updated cryptovision sc/interface to version 7.1.9. Changelog since version 7.0.5:

Fixed an error during certificate registration using the MS Minidriver for MS VSC. 
Compatible with sc/interface cache version 1.2 or higher.
Fixed an error where writing a certificate using the Minidriver for MS VSC corrupted the 
Container-ID. As a result the key could not be used using CNG/CAPI.
Fixed an error during certificate registration using the Minidriver for MS VSC where 
some Container-ID's could not be used by CNG/CAPI.
General Bug Fixes.
Fixed error during profile creation on JCOP3 with ePasslet-Suite 3.0
Added support for additional BWI card profiles based on CardOS-5.x.
Versions 1.7, 1.8, 1.9, 4.2, 4.3 and 4.4. Support 4k RSA for 1.9 and 4.4.
Fixed support for remote logon in sc/interface cache.
Fixed Free after use in ReadOnly Minidriver.
PKCS#11 Fixed MS VSC (GIDSv2) support.
PKCS#11 Fixed CardOS-4.x "non sc/interface card profile" support.
MS VSC (GIDSv2) Support for PKCS#11 - Maximum CKA_ID length reduced to 25 bytes!
Support for JCOP3 and Infineon JTOP - DolphinV2.
Support for cryptovision's ePasslet-Suite-3.0.
New ePKIApplet-2.129 for JCOP3, SCE7 and JTOP (DolphinV2) with up to 4096 bits RSA 
and 512 bits
EC support, PACE optional.
RegisterTool plugins now available in Setup. Removed from 
"support\RegisterTool_Plugins".
New sc/interface Minidriver support for MS VSC (instead of the MS Minidriver) to allow 
extended PIN cache configuration.
Added support for sc/interface cache version 1.0 for Minidriver/ReadOnly Minidriver and 
PKCS#11.
Cross-application PIN cache for Windows 8.1 and later.
WARNING: No longer compatible with Credential Cache (CSP). When there are any 
questions, support@cryptovision.com47 should be contacted.
Added macOS CTK Token Driver for 10.12 and later. Unfortunately, after the installation, a 
shell script must be executed to enable the full functionality.
Removed macOS tokend support beginning with version 10.12, installation of 10.10 can be 
used if needed.
WARNING: macOS tokend support will discontinue, usage of new CTK Token Driver is 
necessary.
Re-Added cvSimpleCardProv for Windows (based on 6.4.2) to enabled the default login 
selection, see "support\CredentialProvider".

Updated OpenSC library to version 0.19.0. Improved handling of PIV and CAC ALT token.

Base system

Updated to kernel version 4.18.11.

mailto:support@cryptovision.com
mailto:support@cryptovision.com
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Added new GStreamer 1.x support version 1.14.2. 
There will only ever be GStreamer in version 1.0 or version 0.10. By default, clients run with the 
version they have best support for. The provided registry key can be used to override the 
automatic detection/setting and pin a single version if required. 
More...

ParameterFluendo GStreamer Codec Version

Registry multimedia.gstreamer.version

Value [1.x] [0.10] [automatic]

With GStreamer 1.x the new Parole player is used for media player sessions. When there occur 
problems with the new player, a switch back to totem/GStreamer 0.10 media player is possible 
by Fluendo GStreamer Codec Version parameter.
Added optional logoff button in taskbar when the screenlock is active. 
More...

IGEL SetupSecurity > Logon > Taskbar

Parameter Show logoff button

Registry userinterface.screenlock_taskbar_logged_in.logoff_butt

on

Value enabled / disabled

Mobile broadband configuration dialog now provides a simple mode, that displays 3 dropdown 
boxes to select country, provider and access point (plan). The former version is available via 
an Expert Mode button.
IGEL Setup Assistant enhancements: 

displaying page for mobile broadband configuration when any mobile broadband modem 
is detected.
displaying page to show broken network connectivity
desktop icon will now be displayed when the assistant was not yet finished.
the assistant is now always started on devices without IGEL license, that are not 
registered at UMS
new icon design

Added support for chinese, japanese, korean and thai fonts.
KVM kernel modules added.
Added policiykit-1-gnome session agent to get a gui interface for actions which requires root 
authentification.
Added remote (network attached) logging via rsyslog. 
More...

IGEL SetupSystem -> Remote Syslog

Parameter Remote mode
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Registry system.syslog.remote_mode

Range  [Server] [Client] [Off]

ParameterCustom client config entries

Registry system.syslog.client_custom

Server mode is possible, though limited and intended for short-term debugging. 
More...

IGEL SetupSystem -> Remote Syslog

Parameter Template for log file storage

Registry system.syslog.template

Value  /var/log/%HOSTNAME%/messages

ParameterLocal port

Registry system.syslog.input%.port

Value  514

ParameterTransport protocol

Registry system.syslog.input%.transport

Value  [TCP] [UDP] 

ParameterLocal Address

Registry system.syslog.input%.local_address

ParameterName

Registry system.syslog.input%.name

Client mode allows to filter and send commands to multiple remotes.
More...

IGEL SetupSystem -> Remote Syslog

Parameter Remote port

Registry system.syslog.output%.port

Value  514

ParameterTransport protocol
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Registry system.syslog.output%.transport

Value  [TCP] [UDP] 

ParameterRemote address

Registry system.syslog.output%.address

ParameterSyslog facility

Registry system.syslog.output%.facility

Range [Any] [AUTH] [CRON] [DAEMON] [FTP] [KERN] [LPR] [MAIL] [NEWS] [USER] 
UUCP]

ParameterSyslog level

Registry system.syslog.output%.level

Range [Any] [EMERG] [ALERT] [CRIT] [ERR] [WARNING] [NOTICE] [INFO] [DEBUG]

Shutdown or suspend by inactivity. 
More...

IGEL SetupSystem > Power Options > System

Parameter System action on inactivity

Registry system.power_management.system_standby.ac_action

Value  Suspend / Shutdown

Enhanced Change Password utility to be able changing the following items of the logged on user:
Password of local user (screen lock password).
PIN of IGEL smartcard.
PIN of PKCS#11 smartcard.

CUPS Printing

Added PrinterLogic support, Version 18.2.1.128. 
More...

IGEL SetupDevices > Printer > PrinterLogic

Parameter Manage printers by Printer Installer Client

Registry printerlogic.active

Value  enabled / disabled
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ParameterHomeURL Protocol

Registry printerlogic.homeurl.protocol

Value  http:// / https://

ParameterHomeURL Hostname

Registry printerlogic.homeurl.hostname

Value  .printercloud.com48

ParameterAuthorization Code

Registry printerlogic.auth.crypt_password

Parameter(Mapping in sessions) ICA Sessions

Registry printerlogic.map_ica

Value  enabled / disabled

Parameter(Mapping in sessions) RDP Sessions

Registry printerlogic.map_rdp

Value  enabled / disabled

Parameter(Mapping in sessions) NX Sessions

Registry printerlogic.map_nxclient

Value  enabled / disabled

Parameter(Mapping in sessions) Parallels Client Sessions

Registry printerlogic.map_twox

Value  enabled / disabled

Driver

Added Kofax virtual channel for signature pads in Citrix sessions. 
More...

IGEL 
Setup

Sessions > Citrix XenDesktop/XenApp > HDX/ICA Global > Mapping > Device 
Support

http://printercloud.com
http://printercloud.com
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Paramet
er

Kofax SPVC Signature Pad Channel

Registry ica.module.virtualdriver.spvc.enable

Value  enabled / disabled

Improved support for FIBOCOM L830-EB LTE module in Lenovo Thinpad L480.
Added configuration to change the dynamic power management settings for ATI graphics 
driver. 
More...

ParameterATI dynamic power management

Registry x.drivers.ati.dpm

Value  default / enabled / disabled

Added the possibility to change the dynamic power management settings for graphics AMDGPU 
driver. 
More...

ParameterAMDGPU dynamic power management

Registry x.drivers.amdgpu.dpm

Value  default / enabled / disabled

Added possibility to use generic modesetting graphics driver instead of the hardware specific 
one.  
More...

ParameterUse generic modesetting driver for ATI hardware.

Registry x.drivers.ati.use_modesetting

Value  enabled / disabled

ParameterUse generic modesetting driver for AMDGPU hardware.

Registry x.drivers.amdgpu.use_modesetting

Value  enabled / disabled

ParameterUse generic modesetting driver for NVIDIA hardware.

Registry x.drivers.nouveau.use_modesetting

Value  enabled / disabled

Bluetooth
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Added new Bluetooth Autopairing Wizard for IGEL OS installations without keyboard or mouse 
available, but with unpaired bluetooth keyboard/mouse. The Autopairing Wizard is started 
together with IGEL Setup Assistant.

Appliance Mode

The wireless manager can now be invoked from the In-Session control bar. Furthermore, it will 
be automatically started when no network connection can be established.
Prerequisites: A WiFi device is availabe and the following registry keys are set to true. 
More...

ParameterActivate Wireless Interface

Registry network.interfaces.wirelesslan.device0.active

Value  enabled / disabled

ParameterEnable wireless manager

Registry network.applet.wireless.enable_connection_editor

Value  enabled / disabled

It is possible to use Accessories, VPN connections and other session types in Appliance 
Mode now. The access to those session types must be explicitely enabled by a new 
parameter Appliance Mode Access. The possible starting methods:

XDMCP Appliance mode: Hotkey
All other Appliance modes: Desktop icon, Desktop Context Menu,Application Launcher (+ 
System tab), Hotkey, Autostart. 
More...

IGEL SetupAccessories > ICA Connection Center

Parameter Application Mode Access

Registry sessions.icaconncenter0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Task Manager

Parameter Application Mode Access

Registry sessions.taskmanager0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Application Launcher

Parameter Application Mode Access

Registry sessions.launcher0.appliance_mode_access
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Value  enabled / disabled

IGEL SetupAccessories > Firmware Update

Parameter Application Mode Access

Registry sessions.firmware_update0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Quick Settings

Parameter Application Mode Access

Registry sessions.usersetup0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Sound Preferences 

Parameter Application Mode Access

Registry sessions.mixer0.appliance_mode_access

Value  enabled / disabled

IGEL Setup Accessories > Disk Removal

Parameter Application Mode Access

Registry sessions.storage_dcdm0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Disk Utility 

Parameter Application Mode Access

Registry sessions.storage_info0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Commands  User Interface > Hotkeys > Commands

Parameter Application Mode Access

Registry sessions.commands<NR>.appliance_mode_access

sessions.wmcommands<NR>.appliance_mode_access

Value  enabled / disabled
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IGEL SetupAccessories > Webcam Information

Parameter Application Mode Access

Registry sessions.webcaminfo0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Touchscreen Calibration

Parameter Application Mode Access

Registry sessions.touchcalib0.appliance_mode_access

Value  enabled / disabled

IGEL SetupUser Interface > Screenlock / Screensaver

Parameter Application Mode Access

Registry sessions.xlock0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Monitor Calibration

Parameter Application Mode Access

Registry sessions.xpattern0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Network Tools

Parameter Application Mode Access

Registry sessions.gnome-nettool0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Screenshot Tool

Parameter Application Mode Access

Registry sessions.screenshooter0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > System Information

Parameter Application Mode Access
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Registry sessions.device_manager0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Bluetooth Tool

Parameter Application Mode Access

Registry sessions.bluetooth0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Display Switch

Parameter Application Mode Access

Registry sessions.user_display.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > Identify Monitors 

Parameter Application Mode Access

Registry sessions.screenid0.appliance_mode_access

Value  enabled / disabled

IGEL SetupAccessories > System Log Viewer (> Options)

Parameter Application Mode Access

Registry sessions.systemviewer0.appliance_mode_access

Value  enabled / disabled

Regist
ry

sessions.setup.displaynames.add_layout.appliance_mode

_access

Value  enabled / disabled

IGEL SetupAccessories > Terminals > Local Terminal 

Parameter Application Mode Access

Registry sessions.xterm<NR>.appliance_mode_access

Value  enabled / disabled

IGEL SetupSessions > SSH > SSH Session
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Parameter Application Mode Access

Registry sessions.ssh<NR>.appliance_mode_access

Value  enabled / disabled

IGEL 
Setup

System > Firmware Customization -> Custom Application -> Custom 
Application

Paramet
er

Application Mode Access

Registry sessions.custom_application<NR>.appliance_mode_acce

ss

Value  enabled / disabled

IGEL SetupAccessories > Mobile Device Access

Parameter Application Mode Access

Registry sessions.mtp-devices0.appliance_mode_access

Value  enabled / disabled

IGEL 
Setup

Network > VPN > OpenConnect VPN (> OpenVPN Connection (> Desktop 
Integration))

Paramet
er

Application Mode Access

Registry sessions.openvpn<NR>.appliance_mode_access

Value  enabled / disabled

IGEL 
Setup

Network > VPN > OpenConnect VPN (> VPN OpenConnection (> Desktop 
Integration))

Paramet
er

Application Mode Access

Registry sessions.openconnect<NR>.appliance_mode_access

Value  enabled / disabled

IGEL SetupNetwork > VPN > genucard (> Desktop Integration)

Parameter Application Mode Access
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Registry sessions.genucard_vpn_connection0.appliance_mode_a

ccess

Value  enabled / disabled

X11 system

Set of User Interface > Display > Options > Monitor DPI now automatically affects the size of 
the mouse cursor, the panel height, the desktop icons, the application launcher, the size of the 
start menu and the window manager decorations.

VirtualBox

Added VirtualBox as feature with limited support. Activation of the feature at: System > 
Firmware Customization > Features > VirtualBox. Added new registry keys under `virtualbox` 
and `sessions.virtualbox<NR>`.

Audio

Updated Pulseaudio to version 12.0-1.
The resample method in Pulseaudio can now be configured by the newly introduced 
parameter resample-method. 
More...

ParameterResample method

Registry multimedia.pulseaudio.daemon.resample-method

Range [soxr-vhq] [soxr-hq] [soxr-mq] [speex-float-10] [speex-float-5] [speex-float-3] 
[speex-float-1]

Media Player (Parole/Totem)

Added new Parole Media Player 1.0.1-0ubuntu1. It is used for media player sessions by 
default now. When there occur problems with the new player, switch back to totem/GStreamer 
0.10 media player is possible by setting Fluendo GStreamer Codec Version parameter to 0.10. 
More...

ParameterFluendo GStreamer Codec Version

Registry multimedia.gstreamer.version

Range [1.x] [0.10] [automatic]

Added RTSP/RTMP support to parole media player / gstreamer 1.x.
The following parameters are only functional with Totem media player/GStreamer 0.10 and not 
for Parole media player. 
More...

IGEL SetupSessions > Media Player > Media Player Global > Window
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Parameter Automatically resize the player window when a new video is loaded

Registry multimedia.mediaplayer.auto_resize

Value  enabled / disabled

IGEL SetupSessions > Media Player > Media Player Global > Window

Parameter Main window should stay on top

Registry multimedia.mediaplayer.window_on_top

Value  enabled / disabled

IGEL SetupSessions > Media Player > Media Player Global > Playback

Parameter Visualization size

Registry multimedia.mediaplayer.visual_quality

Range [Small] [Normal] [Large] [Extra Large]

IGEL 
Setup

Sessions > Media Player > Media Player Global > Options

Paramete
r

Network connection speed

Registry multimedia.mediaplayer.connection_speed

Range [56 kbps Modem/ISDN] [112 kbps Dual ISDN/DSL] [256 kbps DSL/Cable] [384 
kbps DSL/Cable] [512 kbps DSL/Cable] [1.5 mbps T1/Intranet/LAN] [Intranet/
LAN]

ParameterEnable deinterlacing

Registry multimedia.mediaplayer.deinterlace

Value enabled / disabled

ParameterEnable debug

Registry multimedia.mediaplayer.debug

Value enabled / disabled

ParameterNetwork buffering threshold

Registry multimedia.mediaplayer.network_buffer_threshold

Value 2
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As the Media Player Browser Plugin is not supported with Firefox 60 ESR, the following 
parameters are not available anymore. 
More...

IGEL SetupSessions > Media Player > Media Player Global > Browser Plugin

Parameter Video output

Registry multimedia.mediaplayer.browser_plugin.video_sink

Range [Default] [Auto] [Hardware Accelerated] [X Video Extension] [X Window System]

IGEL SetupSessions > Media Player > Media Player Global > Browser Plugin

Parameter Aspect ratio

Registry multimedia.mediaplayer.browser_plugin.aspect_ratio

Range [Default] [Auto] [Square] [4:3 (TV)] [16:9 (Widescreen)] [2.11:1 (DVB)]

Evidian

Integrated Evidian AuthMgr version 1.5.6840.
Evidian AuthMgr sessions can be configured at IGEL Setup > Sessions > Evidian AuthMgr > 
Evidian AuthMgr Sessions (registry keys:  sessions.rsuserauth% ).
Evidian AuthMgr global settings can be configured at IGEL Setup > Sessions > Evidian 
AuthMgr > Evidian AuthMgr Global (registry keys:  evidian ).

Added support for Custom catalog of messages. 
More...

IGEL 
Setup

Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > Evidian AuthMgr 
Session > Options

Paramet
er

Language selection

Registry sessions.rsuserauth<NR>.parameters.message_catalog

Range [Automatic] [English (UK)] [English (US)] [German] [French] [Custom]

IGEL SetupSessions > Evidian AuthMgr > Evidian AuthMgr Global > Options

Parameter Language selection

Registry evidian.message_catalog

Range [Global setting] [English (UK)] [English (US)] [German] [French] [Custom]

IGEL SetupSessions > Evidian AuthMgr > Evidian AuthMgr Global > Options
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Parameter Custom catalog of messages

Registry evidian.custom_message_catalog

Value /services/evidian/share/locale/en/rsUserAuth.cat

Added support for Evidian Data Partition.
More...

IGEL SetupSessions > Evidian AuthMgr > Evidian AuthMgr Global > Options

Parameter Evidian AuthMgr Data Partition

Registry evidian.datapart.enabled

Value enabled / disabled

IGEL SetupSessions > Evidian AuthMgr > Evidian AuthMgr Global > Options

Parameter Size

Registry evidian.datapart.size

Value 10

Added support for Password Authentication. 
More...

IGEL 
Setup

Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > Evidian AuthMgr 
Session > Options

Paramet
er

Allow password authentication

Registry sessions.rsuserauth<NR>.parameters.password_authentication

Value enabled / disabled

IGEL 
Setup

Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > Evidian AuthMgr 
Session > Options

Paramet
er

Allow password forgotten

Registry sessions.rsuserauth<NR>.parameters.password_forgotten

Value enabled / disabled

IGEL 
Setup

Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > Evidian AuthMgr 
Session > Options
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er

Default domain name for password authentication

Registry sessions.rsuserauth<NR>.parameters.password_default_dom

ain

Value

Misc

Added support for local scanning as feature with limited support. Activate the feature 
at: System > Firmware Customization > Features > Scanner support. This has been tested with 
a Canon LiDE 120 scanner. 
More...

Parameter Scanner support

Registry product.partitions41.enabled

Value enabled / disabled

This must be enabled for the feature to become active and the remaining keys to be valid.

Parameter Enable scanner daemon

Registry devices.scanner.daemon

Range [none] [scanbd] [saned] 

The key determines the daemon to be started. scanbd is necessary for handling buttons 
on the scanner. It runs saned when necessary (and the scanner is available). saned alone 
provides scanning functionality to local and remote applications (xsane, scanimage, ..). If 
none is selected the system can still be used as a client for remote scanner servers (using 
xsane or scanimage).

Parameter Allowed remote clients

Registry devices.scanner.allowed_clients

The key may contain a space-separated list of hosts and networks (CIDR > notation) that 
are allowed to connect to a local server.

Parameter Remote scanners

Registry devices.scannerclient.remote

This may contain a space-separated list of remote scanner servers to be used by local 
applications (xsane, scanimage). It is only relevant if no local server is configured.
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The remaining keys influence scanner button handling. For each button there is an instance of 
the  devices.scanner.scanbd.action%  template.
In order to keep scanner button handling flexible the default handling may be replaced by 
custom scripts. Details of the default handling are listed at the end of this section. 
More...

Parameter Scanner button name

Registry devices.scanner.scanbd.action%.butto

n

This contains the (symbolic) name of the button. There are currently four predefined 
instances of the template where the value is 'file', 'scan', 'copy', and 'email' respectively. 
(These refer to the buttons on a Canon LiDE 120 from left to right where 'file' may be 
labeled 'PDF')

Parameter Allow while nobody is logged in

Registry devices.scanner.scanbd.action%.allow_lockpanel_logge

d_out

Value enabled / disabled

If this is set to false, the button is ignored when nobody is logged in (only > relevant when 
local logon is configured)

ParameterAllow while screen is locked

Registry devices.scanner.scanbd.action%.allow_lockpanel_logged_

in

Value enabled / disabled

When this is set to false, the button is ignored while the screen is locked.

Parameter scanbd custom action

Registry devices.scanner.scanbd.action%.custom

_cmd

This may contain a custom button handling command. The value is empty by default. If it 
is not, the value will be passed to "bash -c .." and the default button handling will not be 
effective. The consequence is that entering some space characters results in disabling the 
button.

ParameterDirectory
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Registry devices.scanner.scanbd.action%.directory

Value /tmp

Set the target directory for scan results.

Parameter Format

Registry devices.scanner.scanbd.action%.format

Range  [pnm] [tiff] [png] [jpeg]

Determines the image format (passed as argument to scanimage).

Parameter Color mode

Registry devices.scanner.scanbd.action%.mode

Value  [Color] [Gray] [Lineart]

Determines the color mode (passed as argument to scanimage).

ParameterResolution in dpi

Registry devices.scanner.scanbd.action%.resolution

Range  [75] [100] [150] [300] [600] [1200] [2400] [4800]

Determines the resolution (passed as argument to scanimage).

ParameterBrightness

Registry devices.scanner.scanbd.action%.brightness

Value  0

Determines the brightness (passed as argument to scanimage).

Default button handling script: There is a default button handling script  /etc/scanbd/

scripts/action . It might be used as a potential starting point for custom button handling. 
The script handles the four buttons of a Canon LiDE 120 in the following ways:

file results in a PDF document that contains a series of pages where each page contains a 
scan result acquired with scanimage according to the settings. This needs user interaction 
on the local machine's desktop.
scan results in an image file that is silently created and stored according to the settings.
copy makes the script use scanimage according to the settings, convert the resulting image 
to PDF and send it to the default printer. This obviously requires that a printer is configured.
email just results in xsane being started. The following settings are not respected in this 
case:

devices.scanner.scanbd.action%.directory
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devices.scanner.scanbd.action%.format

devices.scanner.scanbd.action%.mode

devices.scanner.scanbd.action%.resolution

devices.scanner.scanbd.action%.brightness

Hardware

Added official support for HP T630.
Added official support for Intel NUC 6CAYH and 5i5MYHE.
Added official support for Dell/Wyse 3040.
Added official support for Toshiba Tecra C50-B1503.
Added official support for Toshiba R50.
Added official support for Dell/Wyse AIO 5212.
Added official support for LG 24CK550W AiO Thin Client.

TC Setup (Java)

Updated TC Setup to version 5.9.11.
Added an additional local administrator access to IGEL setup. The local administrator password 
is configurable at Security > Password setup page. The page permissions are configurable 
at Accessories > Setup > Setup Administrator Permissions setup page.
Reworked Accessories > Commands and User Interface > Hotkeys > Commands setup pages.
Reworked Storage Hotplug setup page.

Remote Management

Added support for UMS File Transfer Status.
Added a new configuration to prevent a user from canceling UMS actions like firmware update, 
reboot, shutdown, etc. through the UMS notification dialog. 
More...

ParameterAllow user to cancel UMS actions

Registry userinterface.rmagent.cancel_usermessage

Value enabled / disabled

Fabulatech

FabulaTech USB for Remote Desktop updated to versions 5.2.29; FabulaTech 
FTPlugin updated to version 3.4.0.
Support for some specific devices has been improved.
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Resolved Issues 10.05.100
Citrix Receiver 13

Fixed: Now applications may be displayed in application launcher independently from 
startmenu.
Fixed Citrix Azure Cloud login window.
Added a new window manager tweak to automatically unmap unwanted Citrix fragment 
windows when seamless apps are used. 
More...

Parameter Auto-close unwanted Wfica windows

Registry windowmanager.tweaks.suppress_wfica_wind

ow_in_seamless_session

Value enabled / disabled

Fixed native USB redirection with Citrix receiver 13.10.
Fixed black rectangle around 32-bit mouse icons.
Fixed sound playback over Nuance channel.
Fixed stopping of the Pulseaudio PCM I/O plugin which is used by Citrix Receiver for sound output 
and recording.
When using the Citrix login method the system language is used now.
Fixed a problem with the parameter  ica.pnlogin.suppressconnectiondialog , connec
tion messages are suppressed as desired.

RDP/IGEL RDP Client 2

Fixed locking in smartcard transactions.
Fixed audio recording in RDP sessions.
Fixed $HOSTNAME to work for RDP login when variable substitution is enabled. 
More...

IGEL Setup System > Firmware Customization > Environment 
Variables

Parameter Enable variable substitution in session

Registry system.environment_variables.enable_ap

plication_variables

Value enabled / disabled

IGEL Setup Sessions > RDP > RDP Global > Local Logon

Parameter Type
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Registry rdp.login.saveusertype

Value Set user/domain from session setup / Set user/
domain from last login

Added Arabic (101) keyboard layout to RDP client.
Added MultiPointServer 2016 to supported servers for RDP MultiPoint Server appliance.

RD Web Access

Fixed wrong RDP Remote Application icon when opening a application twice.
Fixed unexpected behavior when maximizing/minimizing RDP Remote Applications.

UD Pocket

Fixes for UD Pocket demo license registration dialog:
Fixed german translation.
The toolbar context menu is not available anymore (it could hide the toolbar without a 
way to restore it).
The javascript confirm popup from igel.com is hidden now.

VMware Horizon

Added possibility to make certificate verification mandatory. 
More...

Parameter Allow change of certificate verification mode

Registry vmware.view.ssl-verify-mode-change-

allow

Value enabled / disabled

Fixed H.264 hardware decoding for Horizon.

PowerTerm

Fixed printing to CUPS printers in PowerTerm.
Added TLS-1.2 in list of SSL Versions for PowerTerm on page Sessions > PowerTerm Terminal 
Emulation > PowerTerm Sessions > session name > Connection.

Parallels Client

Fixed: Authentication fails with Gemalto smartcards.
Fixed: Sometimes remote session windows remain on screen after one was logged off from the 
remote session.
Fixed: Remote session closes unexpectedly.
Fixed: Combination of CTRL-C doesn't work in remote session.
Improved: Use of multiple monitors.
Fixed: Client might hang while watching YouTube videos.
Fixed: Multiple USB drives might not be auto-mapped to a remote session.
Fixed: Logoff from a remote session blocks Linux desktop with a black screen.
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Firefox

Fixed occasional loss of trusted certificates in Firefox. Certificates transmitted via UMS 
filetransfer were not reinstalled when Firefox profile was rebuilt.
Fixed PDF Plugin in Firefox browser.
Removed the browser plugin option from RHEV/Spice as it is no longer supported.
Removed the browser plugin option from SecMaker as it is no longer supported.

Network

Fixed failing Wake-on-LAN configuration after update on shutdown. Particularly UD2-LX40 
devices were affected.
Fixed bug in the GetCA operation for SCEP: An intermediate certificate in addition to the root 
certificate and any RA certificates resulted in confusion.
sscep version is now 0.6.1
CA certificate fingerprint is now mandatory for SCEP. So far it could be left empty for debugging 
purposes.
Added parameter to specify whether a slash (/) is appended to SCEP URL. The slash is needed 
e.g. with Microsoft servers, but not with Nexus servers. 
More...

Parameter Append slash (/) to SCEP server URL

Registry network.scepclient.cert0.scepurlappends

lash

Value enabled / disabled

Fixed generating certificate request if challenge password or other fields include special 
characters like $, #, quotes or spaces in SCEP.
Reaction to Ethernet 802.1X reauthentication failure is now configurable. 
More...

Parameter Restart on reauthentication failure

Registry network.interfaces.ethernet.device%.ieee8

021x.restart_on_reauth_failure

Value enabled / disabled

The default value preserves the traditional behaviour. If the registry key is set to enabled 
the network connection will get restarted when a reauthentication failure occurs. This 
way the system might switch to a guest VLAN where authentication is not required.

Added support for SFTP protocol (enabled as default) configurable with new registry key. 
More...

Parameter Enable SFTP server

Registry network.ssh_server.enable_sftp_server
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Value enabled / disabled

Improved general security in regards of SCEP

WiFi

Fixed non working Mediatek MT7630e WiFi driver.
Added several WiFi drivers (Realtek 8188eu, 8822be, 8150, 8187, 8192ce, 8192de, 8192ee, 8723ae, 
8821ae....) to the firmware.
Re-enforce configuration after IGEL Setup Assistant exits to ensure consistent state between 
configuration and system.
Added drivers for Realtek rtl8723de and rtl8822be WiFi devices.
Added support for StarTech USB300WN2X2C Wireless-N WiFi adapter.

Smartcard

Updated OpenSC library to version 0.19.0. Improved handling of PIV and CAC ALT token and 
other improvements.
Fixed problem with ActivClient smartcards in VMware Horizon sessions. Before this fix, 
smartcard access inside the session was blocked. 
More...

Parameter Smartcard SCardConnect in non-blocking mode

Registry vmware.view.pcsc-connect-nonblocking

Value enabled / disabled

Improved PC/SC lite daemon to handle attributes SCARD_ATTR_DEVICE_FRIENDLY_NAME_W and 
SCARD_ATTR_DEVICE_SYSTEM_NAME_W.
Updated Cherry USB2LAN Proxy to version 3.0.0.6.

Fixed an issue where the SICCT listener was not restarted when a SICCT connection has 
been closed by the EGK device (ORS-880).
Fixed TLS errors resulting from re-using channels before the EGK device confirmed the 
disconnection of the previous connection (ORS-735).
Increase connection handshake timeout from 1 second to 20 seconds. This is necessary 
as the EGK device (G87-1505, firmware 2.108.3) does not process the handshake 
immediately in all situations. (ORS-735).
Added timestamp to log output.

Fixed AD/Kerberos log on with smartcard and Smartcard Removal Action: Lock Thin Client.
Fixed custom PKCS#11 module  for VMware Horizon logon. Before this fix, the parameters did 
not get effective. 
More...

Parameter Horizon logon with custom PKCS#11 module

Registry vmware.view.pkcs11.use_custom

Value enabled / disabled
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Parameter Path to the library

Registry vmware.view.pkcs11.custom_path

Value

Fixed error in IGEL Smartcard which prevented login with personalized cards when certain 
card holder names contained non-ASCII characters.

HID

Added support for Wacom HID 483C touchscreens (HP Pro x2 612 g2).
Fixed non working Lenovo KBRFBU71 wireless keyboard.
Fixed mouse button mapping.

CUPS Printing

Fixed HPLIP related printer drivers.
Added missing LaserJet 200 color MFP M276 Postscript to Printer Names for manufacturer HP 
in the TC Setup under Devices > Printer > CUPS > Printers.

Application Launcher

Fixed display order of DNS servers in Application Launcher and About dialog.

Base system

IGEL Setup Assistant fixes:
Fixed startup on first boot.
Retain network configuration if exited via cancel.
Fixed graphical glitches
Fixed WiFi configuration
Prevent startup if an administrator passphrase is set (e.g. from a IGEL System 5 
migration).

Fixed System suspend on inactivity showing the suspend dialog directly after system resume.
Fixed the custom bootsplash scaling when multiple monitors are configured. Necessary to 
force a re-installation of the custom bootsplash for this fix to take effect. To force a re-installation:

Trigger the Update desktop customization command via UMS or
Press the Bootsplash update button at IGEL Setup > System > Firmware Customization > 
Corporate Design > Custom Bootsplash.

Fixed sporadic problems with custom bootsplash and wallpaper installation.
Fixed the buddy update server so that UD Pocket devices can also update from buddy update 
servers.
Fixed handling of custom environment variables. If values contained white spaces the variables 
could not be set.
Fixed reboot/shutdown when triggered from the lock screen panel.
Removed maximize button from on-screen keyboard window.
Fixed deletion of debuglog partition content when booted in emergency boot.
Fixed handling of optional partitions which are not active as default while booting in 
emergency mode.
Fixed instability in authentication module pam_igelsession.so in some special cases.
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Fixed ECDSA/ECDH support in HEIMDAL libraries.
Fixed black screen issues if hostname contains other characters as 'A-Z a-z 0-9 . _ - ' .
Improved debuglog partition based login.
Restricted access to command **su** to root and user.
Root home is now /root.
Removed system group (GID 0) which shadowed root group (GID 0).
Stricter folder and file permissions.
Prevent flickering problems on 4k 60Hz screens.

Storage Devices

Fixed mount issue of PTP devices (Mobile Device Access USB feature must be enabled).
Fixed double detection of MTP and PTP. MTP is preferred over PTP now (Mobile Device Access 
USB feature must be enabled).

Appliance Mode

Fixed configuration of post session commands via UMS profile: There is no second reboot 
required anymore to apply the settings properly in Appliance Mode.

X11 system

Fixed graphic card support for HP EliteBook 745 G5 (disabled AMDGPU framebuffer compression 
as default).
Fixed non loading DRM/KMS driver on Spectra Nise 106.
Added possibility to change the framebuffer compression for AMDGPU driver. 
More...

Parameter AMDGPU framebuffer compression.

Registry x.drivers.amdgpu.use_fbc

Range [default][enable][disable]

Fixed DP MST handling (fixes Dell XPS Notebook Dock Station monitor issues).
Fixed sessions.user_display0.options.lid_events  work for eDP also.
Fixed VESA only boot with UEFI system.
AMDGPU stability fixes applied.
Fixed issue with screen configuration for certain cases.
Fixed screen configuration getting in endless loop with multi monitor setups.
Fixed memleak in  igel_drm_daemon .
Fixed DRI2 memleak with AMDGPU driver.
Changed  x.xserver0.force_reconfig registry key  (former bool now range). 
More...

Parameter Force a display reconfiguration

Registry x.xserver0.force_reconfig

Range [default][only on Xorg start/restart][always][never]
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Usage of only on Xorg start/restart as new default for AMDGPU based devices.
Removed  x.xserver0.composite  registry key to prevent problems with AMD/ATI devices.
Fixed screen remains black when Monitor Probing (DDC) option is "Off", configurable at setup 
page User Interface > Display > Options.
Fixed wrong detected DisplayPort (eDP instead of DP) for Dell Wyse 5070.
Added possibility to configure graphic displays only if DPMS state is not OFF. 
More...

Parameter Do not reconfigure if monitors are in DPMS off state

Registry x.xserver0.config_on_dpms_on

Value enabled / disabled

Window Manager

On-Screen Keyboard will keep aspect ratio when resized via double click on edge.

Shadowing/VNC

Fixed instability of Secure Shadowing connector.

Audio

Added a workaround for button handling of Sennheiser USB headsets.
Fixed saving and restoring of volume controls in Pulseaudio and ALSA.
Fixed volume control of the internal speaker in Wyse ZX0D.
Improved consistency while storing of changed volume values.
Fixed configuration of the default sound output or input on hardware when presence detection 
in jack connector is missing.

Hardware

Fixed shutdown problems for Dell Wyse Thin Client AIO 5212 (use legacy boot instead of EFI).
Fixed support for four screens with Nvidia Quadro graphic cards (all current cards which are 
able to drive four outputs).
Fixed graphic issues for HP ProBook 455 G5.
Fixed non working StarTech.com USB2DVIPRO2 DisplayLink graphics adapter.
Fixed freezes of Intel Baytrail devices.
Fixed VDPAU hardware accelerated video support for NVIDIA graphics cards.
Fixed non working DisplayLink USB graphics adapter after reboot.

Remote Management

Fixed zero touch deployment by adding a timeout to the Setup Assistant abort message.
Fixed computation of Unit ID. The Unit ID is the identification key of the thin client in UMS, and 
also thin client licenses will be bound to the Unid ID. Now the Unit ID is computed once and 
persistently saved. It consists of the serial number of UD Pocket or the MAC address of a network 
interface. When multiple network interfaces are present, the interface is selected taking following 
attributes into account: 
If a license bound to the interface exists, how it is connected (PCI, SDIO, USB or other) and if it is 
wireless or wired. 
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It is best practice not to connect external network interfaces when a freshly installed thin client 
device is booted for the first time, so that the Unit ID will consist of a MAC address of a network 
interface which cannot be removed from the thin client device.
Fixed monitor serial numbers not shown in UMS.
Fixed Bluetooth Asset Inventory zombie when bluetooth dongle is removed.
Fixed UMS filetransfer - now filetransfer action is triggered also if only the file classification was 
changed.
Fixed Update on shutdown UMS job which could be stucked if update is failed once for some 
reasons.
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IGEL Universal Desktop Converter (UDC3)
Supported Hardware:

https://kb.igel.com/igelos/en/devices-supported-by-udc3-and-ud-pocket-3117174.html

Versions 10.05.100 (see page 1317)
New Features 10.05.100 (see page 1318)
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Versions 10.05.100
Clients
Product Version

Oracle JRE 1.8.0_181

System Components
OpenSSL 1.0.2g-1ubuntu4.13

Bluetooth stack (bluez) 5.50-0ubuntu1igel5

MESA OpenGL stack 18.2.1-1igel51

Graphics Driver INTEL 2.99.917+git20180214-igel1830

Graphics Driver ATI/RADEON 18.0.1-1igel831

Graphics Driver ATI/AMDGPU 18.0.1-1igel831

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2igel775

Graphics Driver Vboxvideo 5.2.18-dfsg-2igel17

Graphics Driver VMware 13.3.0-2igel812

Graphics Driver QXL (Spice) 0.1.5-2build1igel775

Graphics Driver FBDEV 0.5.0-1igel819

Graphics Driver VESA 2.3.4-1build2igel639

Input Driver Evdev 2.10.5-1ubuntu1igel750

Input Driver Elographics 1.4.1-1build5igel633

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1igel748

Input Driver Vmmouse 13.1.0-1ubuntu2igel635

Input Driver Wacom 0.36.1-0ubuntu1igel813

Kernel 4.18.11 #mainline-udos-r2463

Xorg X11 Server 1.19.6-1ubuntu4igel838

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2igel653

ISC DHCP Client 4.3.3-5ubuntu12.10igel6
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New Features 10.05.100
Hardware

Added official support for HP T630.
Added official support for Intel NUC 6CAYH and 5i5MYHE.
Added official support for Dell/Wyse 3040.
Added official support for Toshiba Tecra C50-B1503.
Added official support for Toshiba R50.
Added official support for Dell/Wyse AIO 5212.
Added official support for LG 24CK550W AiO Thin Client.
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Notes for Release 10.04.100
Software: Version 10.04.100

Release Date: 2018-04-12

Release Notes: Version RN-104100-1

Last update: 2018-04-12

The following formatting is used in this document:

format type example use

bold and underlined enable/disable the default setting of a value

bold and arrow menu > path menu path in the IGEL setup

bold GUI

[keyboard]

elements of the graphical user interface or 
commands that are entered using the 
keyboard

IGEL Linux Universal Desktop 10.04.100 (see page 1320)
IGEL Universal Desktop OS3/IGEL UD Pocket 10.04.100 (see page 1346)
IGEL Universal Desktop Converter (UDC3) 10.04.100 (see page 1371)
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IGEL Linux Universal Desktop 10.04.100

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 51

UD3-LX 50

UD3-LX 42

UD3-LX 41

UD5-LX: UD5-LX 50

UD5-LX 40

UD6-LX: UD6-LX 51

UD7-LX: UD7-LX 10

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Versions for Release 10.04.100 (see page 1322)
General Information 10.04.100 (see page 1326)
Security Fixes 10.04.100 (see page 1327)
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Known Issues 10.04.100 (see page 1330)
New Features 10.04.100 (see page 1332)
Resolved Issues 10.04.100 (see page 1343)
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Versions for Release 10.04.100
Clients
Product Version

Citrix HDX Realtime Media Engine 2.4.0-1233

Citrix Receiver 13.3.2.366713

Citrix Receiver 13.4.2.10146724

Citrix Receiver 13.7.0.10276927

Citrix Receiver 13.8.0.10299729

deviceTRUST Citrix Channel 17.2.100.0

deviceTRUST RDP Channel 17.2.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6362

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.23

Firefox 52.7.2

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_162

Parallels Client (64 bit) 16.2.0.19039

Remote Viewer (RedHat Virtualization) 7.0

Systancia AppliDis 4.0.0.17

Thinlinc Client 4.8.0-5456

ThinPrint Client 7.5.83

Totem Media Player 2.30.2
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VMware Horizon Client 4.7.0-7395152

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20161103

Philips Speech Driver 12.5.4

Signature
signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.0.5.592

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.6.0.30

Reader Driver ACS CCID 1.1.5

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.2.4

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.28

Reader Driver REINER SCT cyberJack 3.99.5final.SP11

Resource Manager PC/SC Lite 1.8.22

Cherry USB2LAN Proxy 3.0.0.4

System Components
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Bluetooth stack (bluez) 5.46-0ubuntu3

MESA OpenGL stack 17.2.8-0igel3

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20180214-igel1

Graphics Driver ATI/RADEON 7.10.0-2igel3

Graphics Driver ATI/AMDGPU 1.4.0-2igel3

Graphics Driver Nouveau (Nvidia 
Legacy)

1.0.15-2

Graphics Driver Nvidia 384.111-0ubuntu0.16.04.1

Graphics Driver Vboxvideo 5.2.6-dfsg-2

Graphics Driver VMware 13.2.1-1build1

Graphics Driver QXL (Spice) 0.1.5-2build1

Graphics Driver FBDEV 0.4.4-1build5

Graphics Driver VESA 2.3.4-1build2

Input Driver Evdev 2.10.5-1ubuntu1

Input Driver Elographics 1.4.1-1build5

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1

Input Driver Vmmouse 13.1.0-1ubuntu2

Input Driver Wacom 0.34.0-0ubuntu2

Kernel 4.15.15 #mainline-ud-r2141

Xorg X11 Server 1.19.6-2igel1

CUPS printing daemon 2.1.3-4ubuntu0.4

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2

ISC DHCP Client 4.3.3-5ubuntu12.7

NetworkManager 1.2.2-0ubuntu0.16.04.4

ModemManager 1.6.4-1
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GStreamer 0.10 0.10.36-2ubuntu0.1

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect
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General Information 10.04.100
The following clients and features are not supported anymore in version 10.04.100:

Citrix Receiver 12.1 and 13.1
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
Remote Access via RSH
Legacy Philips Speech Driver
Digital Persona Support
Sane Scanner Support
Softpro/Kofax Citrix Virtual Channel
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
Video Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, D10-LX 10
H.264 Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
Storage Hotplug devices are not automatically removed anymore, instead they must always be 
ejected manually:

by panel tray icon
by an icon in the 'In-Session Control Bar' (configurable at IGEL Setup > User Interface > 
Desktop)
by a 'Safely Remove Hardware' session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in release 10.04.100:

X session (Xorg Xephyr)
Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
Composite Manager
Softpro/Kofax Citrix Virtual Channel
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Security Fixes 10.04.100
Firefox

Fixes for mfsa2018-08, also known as CVE-2018-5146, CVE-2018-5147.
Fixes for mfsa2018-07, also known as CVE-2018-5127, CVE-2018-5129, CVE-2018-5130, 
CVE-2018-5131, CVE-2018-5144, CVE-2018-5125, CVE-2018-5145.

Base System

Added support for UEFI Secure Boot.

When booted with Secure Boot the downgrade to a firmware version older than 10.04.100 is 
locked.
Fixed evince security issue CVE-2017-1000159.
Fixed bind9 security issue CVE-2017-3145.
Fixed glibc security issues CVE-2018-1000001, CVE-2017-16997, CVE-2017-15804, CVE-2017-15670, 
CVE-2017-1000409 and CVE-2017-1000408.
Fixed gdk-pixbuf security issues CVE-2017-6314, CVE-2017-6313, CVE-2017-6312 and 
CVE-2017-1000422.
Fixed webkit2gtk security issues CVE-2017-7156, CVE-2017-5753, CVE-2017-5715, CVE-2017-13870, 
CVE-2017-13866, CVE-2017-13856, CVE-2018-4096, CVE-2018-4088, CVE-2017-7165, CVE-2017-7161, 
CVE-2017-7160, CVE-2017-7153, CVE-2017-13885 and CVE-2017-13884.
Fixed poppler security issues CVE-2017-14976 and CVE-2017-1000456.
Fixed openssl security issues CVE-2017-3738 and CVE-2017-3737.
Fixed libxml2 security issues CVE-2017-16932 and CVE-2017-15412.
Fixed nvidia-graphics-drivers-384 security issue CVE-2017-5753.
Fixed openssh security issues CVE-2017-15906, CVE-2016-10012, CVE-2016-10011, CVE-2016-10010 
and CVE-2016-10009.
Fixed libtasn1-6 security issues CVE-2018-6003 and CVE-2017-10790.
Fixed curl security issues CVE-2018-1000005 and CVE-2018-1000007.
Fixed libvorbis security issues CVE-2017-14633 and CVE-2017-14632.
Fixed wavpack security issue CVE-2016-10169.
Fixed cups security issue CVE-2017-18190.
Fixed sensible-utils security issue CVE-2017-17512.
Removed terminal start function from task manager menu bar.
Updated kernel to version 4.15.15

Fixed Meltdown (CVE-2017-5754) by PTI (page table isolation)
Fixed Spectre Variant 1 (CVE-2017-5753) by __user pointer sanitization
Fixed Spectre Variant 2 (CVE-2017-5715) by full generic retpoline

Fixed beep security issue CVE-2018-0492.
Added Intel Processor Microcode Updates to provide IBRS/IBPB/STIBP microcode support for 
Spectre Variant 2 (CVE-2017-5715) mitigation.

When booted with Secure Boot the downgrade to a firmware version older than 10.04.100 
is locked.


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Product Name CPU ID Platform ID Microcode Revision

IGEL UD9-LX Touch 
41, IGEL UD9-LX 40, 
IGEL UD6-LX 51, IGEL 
UD5-LX 50 Bay Trail

30678 0C 0x836

IGEL UD2-LX 40 Bay 
Trail

30679 0F 0x90A

IGEL UD5-LX 40 Sandy 
Bridge

206A7 12 0x2D

Network

Disabled weak message authentication codes for SSH server and client as default. If problems 
occur change the default setting.
More

Parameter Disable weak message authentication codes

Registry network.ssh_client.disable_weak_macs

Value enabled / disabled

Parameter Disable weak message authentication codes

Registry network.ssh_server.disable_weak_macs

Value enabled / disabled

Disabled weak key exchange algorithms for SSH server and client as default. If problems occur, 
change the default setting.
More

Parameter Disable weak key exchange algorithms

Registry network.ssh_client.disable_weak_kexalg

orithms

Value enabled / disabled

Parameter Disable weak key exchange algorithms

Registry network.ssh_server.disable_weak_kexalg

orithms
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Value enabled / disabled

Disabled weak hostkeys (server) and hostkey algorithms (client) for SSH server and client as 
default. If problems occur, change the default setting.
More

Parameter Disable weak Hostkey algorithms

Registry network.ssh_client.disable_weak_hostke

y_algos

Value enabled / disabled

Parameter Disable weak Hostkeys

Registry network.ssh_server.disable_weak_hostke

ys

Value enabled / disabled

Changed SMB protocol version default v1.0 to v2.0 for mounting windows shares to improve 
security.
Added the possibility to change the SMB protocol version for windows shares. The windows 
shares are configurable at IGEL Setup > Network > Network Drives > Windows Drive.
More

Parameter SMB protocol version

Registry network.smbmount.smb_version

Range 1.0 / 2.0 / 2.1 / 3.0

When using a very old Windows file server, the change to version 1.0 is necessary.

RDP / IGEL RDP Client 2

Fixed RDP: CVE-2018-0886.

Java

Fixed in Oracle JRE 1.8U162 : CVE-2018-2638, CVE-2018-2639, CVE-2018-2633, CVE-2018-2627, 
CVE-2018-2637, CVE-2018-2634, CVE-2018-2582, CVE-2018-2641, CVE-2018-2618, CVE-2018-2629, 
CVE-2018-2603, CVE-2018-2657, CVE-2018-2599, CVE-2018-2581, CVE-2018-2602, CVE-2018-2677, 
CVE-2018-2678, CVE-2018-2588, CVE-2018-2663, CVE-2018-2675, CVE-2018-2579
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Known Issues 10.04.100
Citrix Receiver 13

On devices with AMD/Radeon graphics chipsets and activated DRI3 X driver option the hardware 
accelerated Citrix H.264 decoder plugin can hang. To solve this issue deactivation of DRI3 
option is necessary (default setting).
More

Parameter Use DRI3

Registry x.drivers.use_dri3

Value enabled / disabled

Parameter Force usage of DRI3

Registry x.drivers.amdgpu.force_dri3

x.drivers.ati.force_dri3

Value enabled / disabled

Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
when the card is inserted after start of login. As a workaround, insert the smartcard before starting 
StoreFront login.
No smooth playback over Nuance channel if the dictation device isn't attached.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: mapping the directory /media  as a drive on desktop. 
Then the external devices will show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug: On page Devices > Storage Devices > Storage Hotplug, put number of storage 
hotplug devices to 0.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Change on the following setup page is required: Devices > Storage Devices > Storage 
Hotplug.
Activate Enable dynamic drive mapping and set Number of storage hotplug devices to at 
least 1.
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Firefox

Because the support for the gstreamer framework was dropped by recent Firefox versions, 
support for H264 decoding in the browser is not possible anymore due to licensing restrictions.

OpenConnect VPN

VPNs which need the OpenConnect client cannot be used for firmware updates.

Evidian

Active Directory users with a password containing special characters may have problems to 
authenticate with the configured session. 
Known special characters which result in errors are: 
` (grave accent, ASCII code 96) 
´ (acute accent, ASCII code 239)
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New Features 10.04.100
Citrix Receiver 13

Integrated Citrix Receiver 13.8.0.
More

Parameter Use Citrix Cloud with receiver 13.8 or newer

Registry ica.cloudconnect

Value enabled / disabled

Support for Azure Active Directory (Azure AD) authentication
Support for Workspace configuration from Citrix Cloud

Integrated Citrix Receiver 13.4.2. Citrix Receiver version 13.5.0 was removed. Available Citrix 
Receiver versions: 13.3.2, 13.4.2, 13.7.0, 13.8.0 (default)
Updated Citrix HDX RTME used for optimization of Skype for Business to 2.4.0.

RDP / IGEL RDP Client 2

Added possibility to use RDP local logon for smartcard login. This can be activated in the setup.
More

Parameter Enable smartcard support for local logon

Registry rdp.login.smartcard-local-logon

Value enabled / disabled

By enabling this parameter local logon can be used for smartcard authentication. If 
Username is left empty the connection to the RDP server will be made without sending 
credentials, so you can choose Smartcard as login method in the microsoft login 
window . However this will not work with NLA.

Added support for CredSSP up to version 6.

VMware Horizon

Updated VMware Horizon Client to version 4.7.0-7395152.
Added key to enable seamless window mode in each application session.
More

Parameter Seamless Application Windows

Registry sessions.vdm_client.options.enable_seamless_window

Value enabled / disabled

Added possibility to use Fabulatech USB Redirection in a Horizon Client PCoIP session.
More
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IGEL Setup Sessions > Horizon Client > Horizon Client Global > 
Fabulatech USB Redirection

Parameter Enable Fabulatech USB Redirection

Registry vmware.view. usb.enable-fabulatech-usb

Value enabled / disabled

Parallels Client

Integrated Parallels Client version 16.2.0 (19039)
Added support for USB Redirection, configurable at new IGEL Setup page Sessions > Parallels 
Client > Parallels Client Global > USB Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable USB Redirection

Registry twox.usb_redirection.usb_enable

Value enabled / disabled

Parameter Product ID

Registry twox.usb_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.usb_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.usb_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.usb_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule
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Parameter Automatically redirect all USB devices

Registry twox.usb_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for PTP/MTP Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable PTP/MTP Redirection

Registry twox.mtp_redirection.mtp_enable

Value enabled / disabled

Parameter Product ID

Registry twox.mtp_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.mtp_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.mtp_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.mtp_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule

Parameter Automatically redirect all PTP/MTP devices

Registry twox.mtp_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for Clipboard Redirection.
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More

IGEL Setup Sessions > Parallels Client > Parallels Client Sessions > Parallels Client 
Session > Local Resources

Parameter Connect clipboard

Registry sessions.twox.local_resources.connect_clipboard

Value enabled / disabled

VoIP

Added VoIP client Ekiga 4.0.1.

Firefox

Updated Firefox to version 52.7.2 ESR.
Updated Adobe Flash Player download URL to version 29.0.0.113.

Network

Added TTLS/PAP and TTLS/MSCHAPv2 to possible 802.1x authentication methods.
Improved support for Sierra EM7305 LTE device (e.g. in Toshiba Portégé and Fujitsu LIFEBOOK E 
Series).

Added support for Sierra EM7455 WWAN module.
Added support for running the Huawei E3531i WWAN device in modem mode (in addition to 
HiLink mode).
Added possibility to adopt the hostname from a DHCP lease as permanent terminal name. The 
purpose is to use the name received as part of a DHCP lease in future interactions with the DHCP 
server.
More

Parameter Adopt permanent Terminal Name from DHCP lease

Registry network.dns.hostname_adopt_from_dhcp

Value enabled / disabled

NetworkManager updated to version 1.2.2
ModemManager updated to version 1.6.4
usb_modeswitch updated to version 2.5.1

Open VPN

The EM7305 comes in various variants, e.g. one with ProductId 9041 and another one with 
ProductId 9063. The latter comes at least with one or with two USB configuration options. 
A device with only one configuration option has been observed on a Toshiba Tecra Z-50-
D-115 notebook. It only works in MBIM mode and with IGEL firmware, when the device has 
successfully connected before with the same settings (particularly APN), e.g. under 
Microsoft Windows 10.


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Added Huawei HiLink Mobile Broadband USB device as possible uplink to OpenVPN sessions.

OpenConnect VPN

Added OpenConnect client version 7.08 to connect to Cisco AnyConnect and Juniper VPN. The 
feature must be enabled.
More

IGEL Setup System > Firmware Customization > Features

Parameter VPN OpenConnect (Limited support - functionality "as is", see product 
documentation for details)

Registry services.unsupported02.enabled

Value enabled / disabled

The OpenConnect VPN configuration is available at IGEL Setup page Network > VPN > 
OpenConnect VPN.
More

IGEL Setup Network > VPN > OpenConnect VPN > VPN OpenConnect > Session

Parameter Gateway

Registry sessions.openconnect.vpnopts.gateway

Parameter Enable Name/Password Authentication

Registry sessions.openconnect.vpnopts.enable-name-pwd

Value enabled / disabled

Parameter User Name

Registry sessions.openconnect.vpnopts.username

Parameter Password

Registry sessions.openconnect.vpnopts.crypt_password

Parameter CA Certificate

Registry sessions.openconnect.vpnopts.ca-cert

Parameter User Certificate

Registry sessions.openconnect.vpnopts.user-cert

Parameter Private Key

Registry sessions.openconnect.vpnopts.priv-key
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Parameter Private Key password

Registry sessions.openconnect.vpnopts.priv-key-

pwd.crypt_password

Parameter Connect to Juniper Networks VPN

Registry sessions.openconnect%.vpnopts.is-juniper

Value enabled / disabled

Smartcard

Added CoolKey PKCS#11 library for access to Common Access Card (CAC) smartcards.
More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter Coolkey Security Device

Registry browserglobal.security_device.coolkey

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by Coolkey library

Registry vmware.view.pkcs11.use_coolkey

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter Coolkey

Registry scard.pkcs11.use_coolkey

Value enabled / disabled

Updated Gemalto SafeNet PKCS#11 library to version 10.0.37-0. This package replaces Gemalto/
SafeNet eToken and Gemalto IDPrime libraries.
Gemalto SafeNet (formerly Gemalto/SafeNet eToken) now handles Gemalto cards and tokens 
including eToken and IDPrime. 
Gemalto IDPrime now handles IDPrime cards and tokens, preferred Common Creteria (CC) cards 
and tokens in Unlinked Mode.
Added full integration of OpenSC PKCS#11 library for access to smartcards.

Tray icon is placed in the panel to disconnect from a running OpenConnect VPN 
connection.


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More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter OpenSC Security Device

Registry browserglobal.security_device.opensc

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by OpenSC library

Registry vmware.view.pkcs11.use_opensc

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter OpenSC

Registry scard.pkcs11.use_opensc

Value enabled / disabled

Updated MUSCLE CCID smartcard reader driver to version 1.4.28.
Updated ACS CCID smartcard reader driver to version 1.1.5.
Updated REINER SCT cyberJack smartcard reader driver to version 3.99.5final.sp11.
Added parameter to disable Identive CCID smartcard reader driver. If this driver is disabled, some 
of the readers are handled by the MUSCLE CCID driver. This can help when problems with Identive 
reader driver occur.
More

Parameter Identive driver for smart card readers

Registry scard.pcscd.identiv_enable

Value enabled / disabled

Updated cryptovision sc/interface PKCS#11 library to version 7.0.5.592.
New smartcard reader driver for Fujitsu KB SCR eSIG version 5.0.24.

HID

Added layout toggle feature to on-screen keyboard.
More

IGEL Setup Accessories > On-Screen Keyboard > Appearance

Parameter Enable switching to alternative layout
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Registry userinterface.softkeyboard.enable_alternative_layo

ut

Value enabled / disabled

If this is enabled there is a key on the on-screen keyboard for toggling between the normal 
layout and a reduced layout, that saves space on the screen and has more or less the 
same features as the number block of an ordinary keyboard with some extensions.

Base System

Added support for UEFI Secure Boot.

Updated kernel to version 4.15.15
Boot time optimization (up to 25% faster)
Switch power off on USB ports on shutdown and reboot. The feature can be enabled in IGEL 
Setup. At the moment only IGEL H830C is supported.
More

IGEL Setup System > Registry

Parameter Power off on shutdown

Registry devices.usb.poweroff_shutdown

Value enabled / disabled

Added Unit ID in Application Launcher About > Hardware section.
Showing number of CPU cores in Application Launcher About > Hardware section now.

Storage Devices

Added support for Mobile Device Access feature in Appliance Mode. The Mobile Device Access 
tool can be opened via a new icon in the In-session control bar. The Mobile Device Access tool can 
also be started automatically.
More

Parameter Autostart

Registry sessions.mtp-devices0.autostart

Value enabled / disabled

Mobile Device Access must be enabled at IGEL Setup > System > Firmware 
Customization > Features. Appliance Mode must be enabled at IGEL Setup > Sessions > 
Appliance Mode.

When booted with Secure Boot the downgrade to a firmware version older than 10.04.100 
is locked.


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The Mobile Device Access tool is now configurable at IGEL Setup > Accessories > Mobile Device 
Access.
The Mobile Device Access tray icon respects the current theme now.

X11 System

Added support for XDMCP Appliance Mode. The XDMCP connection is configurable.
More

IGEL Setup Sessions > Appliance Mode

Parameter XDMCP for this Display

Registry x.xdmcp0.enabled

Value enabled / disabled

IGEL Setup Sessions > Appliance Mode

Parameter Connection Type

Registry x.xdmcp0.server.connectiontype

Range indirect via localhost / indirect / direct / broadcast

IGEL Setup Sessions > Appliance Mode

Parameter Name or IP of server

Registry x.xdmcp0.server.servername

IGEL Setup Sessions > Appliance Mode

Parameter Enable hotkeys for XDMCP Display

Registry x.xdmcp0.hotkeys.enabled

Value enabled / disabled

The default hotkey to open IGEL Setup is: CTRL + ALT + F2. The setup page User Interface 
> Display > XDMCP was removed.

Added XC Font Service support.
More

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Enable XC Font Service

Registry x.xc_fontservice.enabled

Value enabled / disabled



Notes for Release 10.04.100

IGEL OS Release Notes   1341 / 1492

•

•

•
•

IGEL Setup User Interface > Font Services > XC Font Service

Parameter XC Font Server

Registry x.xc_fontservice.fontserver

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Port Number

Registry x.xc_fontservice.port

Value 7100

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Prefer Local Fonts

Registry x.xc_fontservice.prefer_localfonts

Value enabled / disabled

Added auto detection of monitor refresh rate. This can be controlled with new parameters.
More

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0.auto_frequency

Value enabled / disabled

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0. screen.auto_frequency

Value enabled / disabled

Added xorg debug script /etc/igel/igel_debug_tools/xorg-debug.sh to make collecting Xorg 
debug data easier (a /tmp/xorg-debug.log file is generated).

Window Manager

Added possibility to
a) change the preferred placement mode and
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b) modify the threshold value up to which window size this placement mode should be 
chosen (otherwise window placement defaults to so called smart mode which tries to 
minimize overlapping).

More

Parameter Preferred Placement

Registry windowmanager.wm0.variables.placement_mode

Value At mouse position / Centered

Parameter Maximum window size for which the preferred placement should apply

Registry windowmanager.wm0.variables.placement_ratio

Value 0% / 10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%

Audio

Volume of audio output and input can now be configured up to 150% at IGEL Setup page 
Accessories > Sound Preferences > Options.
Added a parameter for log level configuration of Pulseaudio service.
More

Parameter Log level

Registry multimedia.pulseaudio.daemon.log-level

Range debug / info / notice / warning / error

Misc

An EULA must be accepted now in IGEL setup assistant before finalizing it and using the IGEL OS.

Java

Updated Oracle JRE to 1.8U162.

Remote Management

Added new log file transfer mechanism for UMS feature Save TC files for support (UMS 5.08.110 
or higher required). By default, it collects all log files visible in system log viewer, system 
configuration files group.ini, setup.ini and dhclient lease files. More files can be specified at IGEL 
Setup > Accessories > System Log Viewer > Options. The resulting zip file has now a folder 
structure.

IGEL Cloud Gateway

Added UMS structure tag handling for usage with ICG agent.

Hardware

Added support for IGEL UD7-LX 10.



Notes for Release 10.04.100

IGEL OS Release Notes   1343 / 1492

•

•
•

•
•
•

•

•

•

•

•

Resolved Issues 10.04.100
Citrix

Fixed sporadic crashes of the Citrix USB Daemon.

RDP / IGEL RDP Client 2

Fixed passing Ctrl+Alt+C keyboard shortcut to RDP session.
Fixed smartcard redirection: after session reconnection readers and cards were not connected 
any more in some cases.
Fixed the rdpdebugger to work again (was broken in the previous release).
Fixed misleading RDP error message `Authentication failed` on wakeup from suspend mode
Fixed TCP timeout value to get more stable RDP connections under certain circumstances.

VMware Horizon

Fixed bug which prevented microphone redirection in Horizon Client RDP sessions.
More

IGEL Setup Sessions > RDP > RDP Global > Mapping > Audio

Parameter Audio recording

Registry rdp.winconnect.rdpeai.enable

Value enabled / disabled

RedHat Enterprise Virtualization Client

Fixed display corruption with Windows connections.

Firefox

Fixed possibility to download files in the browser if needed. The parameter to enable/disable file 
download is available here.
More

IGEL Setup Sessions > Browser > Browser Sessions > Window

Parameter Hide local filesystem

Registry sessions.browser.app.filepicker_dialog_hidden

Value enabled / disabled

If enabled, the user is not allowed to download or use any save-as functionality from 
menu, context or keyboard shortcut.

Fixed bug which prevented the download using the file dialog (in the case you open a link to a 
file of unkonwn type).
Fixed unmounting of the Firefox profile partition during shutdown - now it is unmounted in a 
determinate manner after Custom Partition.
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Network

Fixed bug: Network tray icons sometimes didn't reappear after network restart.
Fixed bug: tcpdump debug tool terminated immediately during boot.
Fixed issue with naming of USB ethernet devices.
Fixed wrong LinkMode (10baseT/Half) with autonegotiation and some USB ethernet devices.

AppliDis

Changed default value of PasswordMode from cmdline to prompt as suggested by Systancia.

Smartcard

Fixed driver for Elatec RFID readers. Before this fix the readers sometimes were not available after 
boot.
Fixed VMware Horizon logon with OpenSC smartcards.

CUPS Printing

Fixed bug where the user for printjobs was not set to the domain user.

Base System

Fixed Kerberos password change to work also with transport protocol TCP. To force protocol 
TCP, prepend Domain Controllers with prefix "tcp/", e.g. "tcp/dc.example.com".
Fixed occasional desktop hang in the local login or the network login mask after successful 
authentication.
Fixed password expiry notification showing negative expiry period.
Fixed update to connect to SFTP servers with very restrictive key exchange settings.
Fixed input of the reset key in reset to defaults boot, if the administrator password is not 
available anymore. If more than 255 characters were entered in the 1st try, it was not possible to 
enter the reset key for a 2nd or 3rd time.
Fixed Active Directory logon with smartcard: If the smartcard contains logon certificates for 
multiple users, it is possible to switch between these certificates and log on with the chosen 
certificate now.
Fixed missing names for some partitions in update notification when having a user interface 
language other than English.
Fixed problems with never ending bootcode update with some EFI BIOS variants.
Fixed ssh server port configuration.
Fixed signotec signature pad channel for Citrix.
Increased stability of signotec VCOM Daemon.
Remove residual information belonging to a removed content from a custom partition.
Fixed crash of xfce4-power-manager after adding or removing input devices.

Custom Partition

Fixed automatic update of custom partition - if download source isn't accessible then the 
content of the custom partition got lost.

Appliance Mode

Fixed post session command Logoff in Appliance Mode.

X11 System
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Fixed Elo-USB Touchscreen functionality after reboot.
Fixed DisplayLink USB Support on UD3 LX50.
Fixed issue with two monitors connected via DVI-D to HDMI adapter on a UD3 M330 (VIA). 
Added registry key to disable the new HDMI autodetection.
More

Parameter Autodetect if DVI to HDMI adapter is in use

Registry x.drivers.via.autodetect_hdmi_output

Value enabled / disabled

Fixed wrong automatic resolution detection if monitor does not have a preferred mode.
Fixed sporadic display corruptions after monitors leaving the power saving mode.
Improved handling of more than 2 screens.

Shadowing/VNC

Fixed sporadic VNC server crash.

Audio

Fixed volume control of internal speaker in HP T610.
Fixed automatic switch to output over analog headphones.
Not existing S/PDIF inputs and outputs in Plantronics and Jabra USB headsets are now ignored 
by audio subsystem (Pulseaudio).
Added workaround in the kernel USB audio driver for volume control on Sennheiser USB 
headsets.

Remote Management

Fixed calculation of Unit ID for UMS management. In some cases, it could happen that the MAC 
address of wrong network interface was chosen.
Fixed IGEL Setup Assistant to get stopped when settings were received from UMS.
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IGEL Universal Desktop OS3/IGEL UD Pocket 10.04.100
Supported Hardware:

Third-Party Devices Supported by IGEL OS 10

Versions for Release 10.04.100 (see page 1347)
General Information 10.04.100 (see page 1351)
Security Fixes 10.04.100 (see page 1352)
Known Issues 10.04.100 (see page 1355)
New Features 10.04.100 (see page 1357)
Resolved Issues 10.04.100 (see page 1368)
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Clients
Product Version

Citrix HDX Realtime Media Engine 2.4.0-1233

Citrix Receiver 13.3.2.366713

Citrix Receiver 13.4.2.10146724

Citrix Receiver 13.7.0.10276927

Citrix Receiver 13.8.0.10299729

deviceTRUST Citrix Channel 17.2.100.0

deviceTRUST RDP Channel 17.2.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-_dev_-34574

Evidian AuthMgr 1.5.6362

Evince PDF Viewer 3.18.2-1ubuntu4.3

FabulaTech USB for Remote Desktop 5.2.23

Firefox 52.7.2

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_162

Parallels Client (64 bit) 16.2.0.19039

Remote Viewer (RedHat Virtualization) 7.0

Systancia AppliDis 4.0.0.17

Thinlinc Client 4.8.0-5456

ThinPrint Client 7.5.83

Totem Media Player 2.30.2
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VMware Horizon Client 4.7.0-7395152

Voip Client Ekiga 4.0.1

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20161103

Philips Speech Driver 12.5.4

Signature
signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 7.0.5.592

PKCS#11 Library Gemalto SafeNet 10.0.37-0

PKCS#11 Library SecMaker NetID 6.6.0.30

Reader Driver ACS CCID 1.1.5

Reader Driver Gemalto eToken 10.0.37-0

Reader Driver HID Global Omnikey 4.2.4

Reader Driver Identive CCID 5.0.35

Reader Driver Identive eHealth200 1.0.5

Reader Driver Identive SCRKBC 5.0.24

Reader Driver MUSCLE CCID 1.4.28

Reader Driver REINER SCT cyberJack 3.99.5final.SP11

Resource Manager PC/SC Lite 1.8.22

Cherry USB2LAN Proxy 3.0.0.4

System Components
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Bluetooth stack (bluez) 5.46-0ubuntu3

MESA OpenGL stack 17.2.8-0igel3

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20180214-igel1

Graphics Driver ATI/RADEON 7.10.0-2igel3

Graphics Driver ATI/AMDGPU 1.4.0-2igel3

Graphics Driver Nouveau (Nvidia 
Legacy)

1.0.15-2

Graphics Driver Nvidia 384.111-0ubuntu0.16.04.1

Graphics Driver Vboxvideo 5.2.6-dfsg-2

Graphics Driver VMware 13.2.1-1build1

Graphics Driver QXL (Spice) 0.1.5-2build1

Graphics Driver FBDEV 0.4.4-1build5

Graphics Driver VESA 2.3.4-1build2

Input Driver Evdev 2.10.5-1ubuntu1

Input Driver Elographics 1.4.1-1build5

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1

Input Driver Vmmouse 13.1.0-1ubuntu2

Input Driver Wacom 0.34.0-0ubuntu2

Kernel 4.15.15 #mainline-udos-r2141

Xorg X11 Server 1.19.6-2igel1

CUPS printing daemon 2.1.3-4ubuntu0.4

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2

ISC DHCP Client 4.3.3-5ubuntu12.7

NetworkManager 1.2.2-0ubuntu0.16.04.4

ModemManager 1.6.4-1
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GStreamer 0.10 0.10.36-2ubuntu0.1

Features with Limited IGEL Support
Mobile Device Access USB

VPN OpenConnect
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General Information 10.04.100
The following clients and features are not supported anymore in version 10.04.100:

Citrix Receiver 12.1 and 13.1
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
Remote Access via RSH
Legacy Philips Speech Driver
Digital Persona Support
Sane Scanner Support
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
VIA Graphics Support
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon
by an icon in the In-Session Control Bar (configurable at IGEL Setup > User Interface > 
Desktop)
by a Safely Remove Hardware session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in release 10.04.100:

X session (Xorg Xephyr)
Cherry eGK Channel
Softpro/Kofax Citrix Virtual Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
Composite Manager
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Security Fixes 10.04.100
Firefox

Fixes for mfsa2018-08, also known as CVE-2018-5146, CVE-2018-5147.
Fixes for mfsa2018-07, also known as CVE-2018-5127, CVE-2018-5129, CVE-2018-5130, 
CVE-2018-5131, CVE-2018-5144, CVE-2018-5125, CVE-2018-5145.

Base System

Added support for UEFI Secure Boot.

When booted with Secure Boot the downgrade to a firmware version older than 10.04.100 is 
locked.
Fixed evince security issue CVE-2017-1000159.
Fixed bind9 security issue CVE-2017-3145.
Fixed glibc security issues CVE-2018-1000001, CVE-2017-16997, CVE-2017-15804, CVE-2017-15670, 
CVE-2017-1000409 and CVE-2017-1000408.
Fixed gdk-pixbuf security issues CVE-2017-6314, CVE-2017-6313, CVE-2017-6312 and 
CVE-2017-1000422.
Fixed webkit2gtk security issues CVE-2017-7156, CVE-2017-5753, CVE-2017-5715, CVE-2017-13870, 
CVE-2017-13866, CVE-2017-13856, CVE-2018-4096, CVE-2018-4088, CVE-2017-7165, CVE-2017-7161, 
CVE-2017-7160, CVE-2017-7153, CVE-2017-13885 and CVE-2017-13884.
Fixed poppler security issues CVE-2017-14976 and CVE-2017-1000456.
Fixed openssl security issues CVE-2017-3738 and CVE-2017-3737.
Fixed libxml2 security issues CVE-2017-16932 and CVE-2017-15412.
Fixed nvidia-graphics-drivers-384 security issue CVE-2017-5753.
Fixed openssh security issues CVE-2017-15906, CVE-2016-10012, CVE-2016-10011, CVE-2016-10010 
and CVE-2016-10009.
Fixed libtasn1-6 security issues CVE-2018-6003 and CVE-2017-10790.
Fixed curl security issues CVE-2018-1000005 and CVE-2018-1000007.
Fixed libvorbis security issues CVE-2017-14633 and CVE-2017-14632.
Fixed wavpack security issue CVE-2016-10169.
Fixed cups security issue CVE-2017-18190.
Fixed sensible-utils security issue CVE-2017-17512.
Removed terminal start function from task manager menu bar.
Updated kernel to version 4.15.15

Fixed Meltdown (CVE-2017-5754) by PTI (page table isolation)
Fixed Spectre Variant 1 (CVE-2017-5753) by __user pointer sanitization
Fixed Spectre Variant 2 (CVE-2017-5715) by full generic retpoline

Fixed beep security issue CVE-2018-0492.
Added Intel Processor Microcode Updates to provide IBRS/IBPB/STIBP microcode support for 
Spectre Variant 2 (CVE-2017-5715) mitigation.

When booted with Secure Boot the downgrade to a firmware version older than 10.04.100 
is locked.


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Product Name CPU ID Platform ID Microcode Revision

IGEL UD9-LX Touch 
41, IGEL UD9-LX 40, 
IGEL UD6-LX 51, IGEL 
UD5-LX 50 Bay Trail

30678 0C 0x836

IGEL UD2-LX 40 Bay 
Trail

30679 0F 0x90A

IGEL UD5-LX 40 Sandy 
Bridge

206A7 12 0x2D

Network

Disabled weak message authentication codes for SSH server and client as default. If problems 
occur change the default setting.
More

Parameter Disable weak message authentication codes

Registry network.ssh_client.disable_weak_macs

Value enabled / disabled

Parameter Disable weak message authentication codes

Registry network.ssh_server.disable_weak_macs

Value enabled / disabled

Disabled weak key exchange algorithms for SSH server and client as default. If problems occur, 
change the default setting.
More

Parameter Disable weak key exchange algorithms

Registry network.ssh_client.disable_weak_kexalg

orithms

Value enabled / disabled

Parameter Disable weak key exchange algorithms

Registry network.ssh_server.disable_weak_kexalg

orithms
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Value enabled / disabled

Disabled weak hostkeys (server) and hostkey algorithms (client) for SSH server and client as 
default. If problems occur, change the default setting.
More

Parameter Disable weak Hostkey algorithms

Registry network.ssh_client.disable_weak_hostke

y_algos

Value enabled / disabled

Parameter Disable weak Hostkeys

Registry network.ssh_server.disable_weak_hostke

ys

Value enabled / disabled

Changed SMB protocol version default v1.0 to v2.0 for mounting windows shares to improve 
security.
Added the possibility to change the SMB protocol version for windows shares. The windows 
shares are configurable at IGEL Setup > Network > Network Drives > Windows Drive.
More

Parameter SMB protocol version

Registry network.smbmount.smb_version

Range 1.0 / 2.0 / 2.1 / 3.0

When using a very old Windows file server, the change to version 1.0 is necessary.

RDP / IGEL RDP Client 2

Fixed RDP: CVE-2018-0886.

Java

Fixed in Oracle JRE 1.8U162 : CVE-2018-2638, CVE-2018-2639, CVE-2018-2633, CVE-2018-2627, 
CVE-2018-2637, CVE-2018-2634, CVE-2018-2582, CVE-2018-2641, CVE-2018-2618, CVE-2018-2629, 
CVE-2018-2603, CVE-2018-2657, CVE-2018-2599, CVE-2018-2581, CVE-2018-2602, CVE-2018-2677, 
CVE-2018-2678, CVE-2018-2588, CVE-2018-2663, CVE-2018-2675, CVE-2018-2579
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Known Issues 10.04.100
Citrix Receiver 13

On devices with AMD/Radeon graphics chipsets and activated DRI3 X driver option the hardware 
accelerated Citrix H.264 decoder plugin can hang. To solve this issue deactivation of DRI3 
option is necessary (default setting).
More

Parameter Use DRI3

Registry x.drivers.use_dri3

Value enabled / disabled

Parameter Force usage of DRI3

Registry x.drivers.amdgpu.force_dri3

x.drivers.ati.force_dri3

Value enabled / disabled

Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
when the card is inserted after start of login. As a workaround, insert the smartcard before starting 
StoreFront login.
No smooth playback over Nuance channel if the dictation device isn't attached.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: mapping the directory /media  as a drive on desktop. 
Then the external devices will show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug: On page Devices > Storage Devices > Storage Hotplug, put number of storage 
hotplug devices to 0.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Change on the following setup page is required: Devices > Storage Devices > Storage 
Hotplug.
Activate Enable dynamic drive mapping and set Number of storage hotplug devices to at 
least 1.
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Firefox

Because the support for the gstreamer framework was dropped by recent Firefox versions, 
support for H264 decoding in the browser is not possible anymore due to licensing restrictions.

OpenConnect VPN

VPNs which need the OpenConnect client cannot be used for firmware updates.

Evidian

Active Directory users with a password containing special characters may have problems to 
authenticate with the configured session. 
Known special characters which result in errors are: 
` (grave accent, ASCII code 96) 
´ (acute accent, ASCII code 239)
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New Features 10.04.100
Citrix Receiver 13

Integrated Citrix Receiver 13.8.0.
More

Parameter Use Citrix Cloud with receiver 13.8 or newer

Registry ica.cloudconnect

Value enabled / disabled

Support for Azure Active Directory (Azure AD) authentication
Support for Workspace configuration from Citrix Cloud

Integrated Citrix Receiver 13.4.2. Citrix Receiver version 13.5.0 was removed. Available Citrix 
Receiver versions: 13.3.2, 13.4.2, 13.7.0, 13.8.0 (default)
Updated Citrix HDX RTME used for optimization of Skype for Business to 2.4.0.

RDP / IGEL RDP Client 2

Added possibility to use RDP local logon for smartcard login. This can be activated in the setup.
More

Parameter Enable smartcard support for local logon

Registry rdp.login.smartcard-local-logon

Value enabled / disabled

By enabling this parameter local logon can be used for smartcard authentication. If 
Username is left empty the connection to the RDP server will be made without sending 
credentials, so you can choose Smartcard as login method in the microsoft login 
window . However this will not work with NLA.

Added support for CredSSP up to version 6.

VMware Horizon

Updated VMware Horizon Client to version 4.7.0-7395152.
Added key to enable seamless window mode in each application session.
More

Parameter Seamless Application Windows

Registry sessions.vdm_client.options.enable_seamless_window

Value enabled / disabled

Added possibility to use Fabulatech USB Redirection in a Horizon Client PCoIP session.
More
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IGEL Setup Sessions > Horizon Client > Horizon Client Global > 
Fabulatech USB Redirection

Parameter Enable Fabulatech USB Redirection

Registry vmware.view. usb.enable-fabulatech-usb

Value enabled / disabled

Parallels Client

Integrated Parallels Client version 16.2.0 (19039)
Added support for USB Redirection, configurable at new IGEL Setup page Sessions > Parallels 
Client > Parallels Client Global > USB Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable USB Redirection

Registry twox.usb_redirection.usb_enable

Value enabled / disabled

Parameter Product ID

Registry twox.usb_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.usb_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.usb_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.usb_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule
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Parameter Automatically redirect all USB devices

Registry twox.usb_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for PTP/MTP Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable PTP/MTP Redirection

Registry twox.mtp_redirection.mtp_enable

Value enabled / disabled

Parameter Product ID

Registry twox.mtp_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.mtp_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.mtp_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.mtp_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule

Parameter Automatically redirect all PTP/MTP devices

Registry twox.mtp_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for Clipboard Redirection.
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More

IGEL Setup Sessions > Parallels Client > Parallels Client Sessions > Parallels Client 
Session > Local Resources

Parameter Connect clipboard

Registry sessions.twox.local_resources.connect_clipboard

Value enabled / disabled

VoIP

Added VoIP client Ekiga 4.0.1.

Firefox

Updated Firefox to version 52.7.2 ESR.
Updated Adobe Flash Player download URL to version 29.0.0.113.

Network

Added TTLS/PAP and TTLS/MSCHAPv2 to possible 802.1x authentication methods.
Improved support for Sierra EM7305 LTE device (e.g. in Toshiba Portégé and Fujitsu LIFEBOOK E 
Series).

Added support for Sierra EM7455 WWAN module.
Added support for running the Huawei E3531i WWAN device in modem mode (in addition to 
HiLink mode).
Added possibility to adopt the hostname from a DHCP lease as permanent terminal name. The 
purpose is to use the name received as part of a DHCP lease in future interactions with the DHCP 
server.
More

Parameter Adopt permanent Terminal Name from DHCP lease

Registry network.dns.hostname_adopt_from_dhcp

Value enabled / disabled

NetworkManager updated to version 1.2.2
ModemManager updated to version 1.6.4
usb_modeswitch updated to version 2.5.1

Open VPN

The EM7305 comes in various variants, e.g. one with ProductId 9041 and another one with 
ProductId 9063. The latter comes at least with one or with two USB configuration options. 
A device with only one configuration option has been observed on a Toshiba Tecra Z-50-
D-115 notebook. It only works in MBIM mode and with IGEL firmware, when the device has 
successfully connected before with the same settings (particularly APN), e.g. under 
Microsoft Windows 10.


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Added Huawei HiLink Mobile Broadband USB device as possible uplink to OpenVPN sessions.

OpenConnect VPN

Added OpenConnect client version 7.08 to connect to Cisco AnyConnect and Juniper VPN. The 
feature must be enabled.
More

IGEL Setup System > Firmware Customization > Features

Parameter VPN OpenConnect (Limited support - functionality "as is", see product 
documentation for details)

Registry services.unsupported02.enabled

Value enabled / disabled

The OpenConnect VPN configuration is available at IGEL Setup page Network > VPN > 
OpenConnect VPN.
More

IGEL Setup Network > VPN > OpenConnect VPN > VPN OpenConnect > Session

Parameter Gateway

Registry sessions.openconnect.vpnopts.gateway

Parameter Enable Name/Password Authentication

Registry sessions.openconnect.vpnopts.enable-name-pwd

Value enabled / disabled

Parameter User Name

Registry sessions.openconnect.vpnopts.username

Parameter Password

Registry sessions.openconnect.vpnopts.crypt_password

Parameter CA Certificate

Registry sessions.openconnect.vpnopts.ca-cert

Parameter User Certificate

Registry sessions.openconnect.vpnopts.user-cert

Parameter Private Key

Registry sessions.openconnect.vpnopts.priv-key
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Parameter Private Key password

Registry sessions.openconnect.vpnopts.priv-key-

pwd.crypt_password

Parameter Connect to Juniper Networks VPN

Registry sessions.openconnect%.vpnopts.is-juniper

Value enabled / disabled

Smartcard

Added CoolKey PKCS#11 library for access to Common Access Card (CAC) smartcards.
More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter Coolkey Security Device

Registry browserglobal.security_device.coolkey

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by Coolkey library

Registry vmware.view.pkcs11.use_coolkey

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter Coolkey

Registry scard.pkcs11.use_coolkey

Value enabled / disabled

Updated Gemalto SafeNet PKCS#11 library to version 10.0.37-0. This package replaces Gemalto/
SafeNet eToken and Gemalto IDPrime libraries.
Gemalto SafeNet (formerly Gemalto/SafeNet eToken) now handles Gemalto cards and tokens 
including eToken and IDPrime. 
Gemalto IDPrime now handles IDPrime cards and tokens, preferred Common Creteria (CC) cards 
and tokens in Unlinked Mode.
Added full integration of OpenSC PKCS#11 library for access to smartcards.

Tray icon is placed in the panel to disconnect from a running OpenConnect VPN 
connection.


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More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter OpenSC Security Device

Registry browserglobal.security_device.opensc

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by OpenSC library

Registry vmware.view.pkcs11.use_opensc

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter OpenSC

Registry scard.pkcs11.use_opensc

Value enabled / disabled

Updated MUSCLE CCID smartcard reader driver to version 1.4.28.
Updated ACS CCID smartcard reader driver to version 1.1.5.
Updated REINER SCT cyberJack smartcard reader driver to version 3.99.5final.sp11.
Added parameter to disable Identive CCID smartcard reader driver. If this driver is disabled, some 
of the readers are handled by the MUSCLE CCID driver. This can help when problems with Identive 
reader driver occur.
More

Parameter Identive driver for smart card readers

Registry scard.pcscd.identiv_enable

Value enabled / disabled

Updated cryptovision sc/interface PKCS#11 library to version 7.0.5.592.
New smartcard reader driver for Fujitsu KB SCR eSIG version 5.0.24.

HID

Added layout toggle feature to on-screen keyboard.
More

IGEL Setup Accessories > On-Screen Keyboard > Appearance

Parameter Enable switching to alternative layout
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Registry userinterface.softkeyboard.enable_alternative_layo

ut

Value enabled / disabled

If this is enabled there is a key on the on-screen keyboard for toggling between the normal 
layout and a reduced layout, that saves space on the screen and has more or less the 
same features as the number block of an ordinary keyboard with some extensions.

Base System

Added support for UEFI Secure Boot.

Updated kernel to version 4.15.15
Boot time optimization (up to 25% faster)
Switch power off on USB ports on shutdown and reboot. The feature can be enabled in IGEL 
Setup. At the moment only IGEL H830C is supported.
More

IGEL Setup System > Registry

Parameter Power off on shutdown

Registry devices.usb.poweroff_shutdown

Value enabled / disabled

Added Unit ID in Application Launcher About > Hardware section.
Showing number of CPU cores in Application Launcher About > Hardware section now.

Storage Devices

Added support for Mobile Device Access feature in Appliance Mode. The Mobile Device Access 
tool can be opened via a new icon in the In-session control bar. The Mobile Device Access tool can 
also be started automatically.
More

Parameter Autostart

Registry sessions.mtp-devices0.autostart

Value enabled / disabled

Mobile Device Access must be enabled at IGEL Setup > System > Firmware 
Customization > Features. Appliance Mode must be enabled at IGEL Setup > Sessions > 
Appliance Mode.

When booted with Secure Boot the downgrade to a firmware version older than 10.04.100 
is locked.


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The Mobile Device Access tool is now configurable at IGEL Setup > Accessories > Mobile Device 
Access.
The Mobile Device Access tray icon respects the current theme now.

X11 System

Added support for XDMCP Appliance Mode. The XDMCP connection is configurable.
More

IGEL Setup Sessions > Appliance Mode

Parameter XDMCP for this Display

Registry x.xdmcp0.enabled

Value enabled / disabled

IGEL Setup Sessions > Appliance Mode

Parameter Connection Type

Registry x.xdmcp0.server.connectiontype

Range indirect via localhost / indirect / direct / broadcast

IGEL Setup Sessions > Appliance Mode

Parameter Name or IP of server

Registry x.xdmcp0.server.servername

IGEL Setup Sessions > Appliance Mode

Parameter Enable hotkeys for XDMCP Display

Registry x.xdmcp0.hotkeys.enabled

Value enabled / disabled

The default hotkey to open IGEL Setup is: CTRL + ALT + F2. The setup page User Interface 
> Display > XDMCP was removed.

Added XC Font Service support.
More

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Enable XC Font Service

Registry x.xc_fontservice.enabled

Value enabled / disabled
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IGEL Setup User Interface > Font Services > XC Font Service

Parameter XC Font Server

Registry x.xc_fontservice.fontserver

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Port Number

Registry x.xc_fontservice.port

Value 7100

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Prefer Local Fonts

Registry x.xc_fontservice.prefer_localfonts

Value enabled / disabled

Added auto detection of monitor refresh rate. This can be controlled with new parameters.
More

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0.auto_frequency

Value enabled / disabled

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0. screen.auto_frequency

Value enabled / disabled

Added xorg debug script /etc/igel/igel_debug_tools/xorg-debug.sh to make collecting Xorg 
debug data easier (a /tmp/xorg-debug.log file is generated).

Window Manager

Added possibility to
a) change the preferred placement mode and
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b) modify the threshold value up to which window size this placement mode should be 
chosen (otherwise window placement defaults to so called smart mode which tries to 
minimize overlapping).

More

Parameter Preferred Placement

Registry windowmanager.wm0.variables.placement_mode

Value At mouse position / Centered

Parameter Maximum window size for which the preferred placement should apply

Registry windowmanager.wm0.variables.placement_ratio

Value 0% / 10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%

Audio

Volume of audio output and input can now be configured up to 150% at IGEL Setup page 
Accessories > Sound Preferences > Options.
Added a parameter for log level configuration of Pulseaudio service.
More

Parameter Log level

Registry multimedia.pulseaudio.daemon.log-level

Range debug / info / notice / warning / error

Misc

An EULA must be accepted now in IGEL setup assistant before finalizing it and using the IGEL OS.

Java

Updated Oracle JRE to 1.8U162.

Remote Management

Added new log file transfer mechanism for UMS feature Save TC files for support (UMS 5.08.110 
or higher required). By default, it collects all log files visible in system log viewer, system 
configuration files group.ini, setup.ini and dhclient lease files. More files can be specified at IGEL 
Setup > Accessories > System Log Viewer > Options. The resulting zip file has now a folder 
structure.

IGEL Cloud Gateway

Added UMS structure tag handling for usage with ICG agent.

Hardware

Added support for IGEL UD7-LX 10.
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Resolved Issues 10.04.100
Citrix

Fixed sporadic crashes of the Citrix USB Daemon.

RDP / IGEL RDP Client 2

Fixed passing Ctrl+Alt+C keyboard shortcut to RDP session.
Fixed smartcard redirection: after session reconnection readers and cards were not connected 
any more in some cases.
Fixed the rdpdebugger to work again (was broken in the previous release).
Fixed misleading RDP error message `Authentication failed` on wakeup from suspend mode
Fixed TCP timeout value to get more stable RDP connections under certain circumstances.

VMware Horizon

Fixed bug which prevented microphone redirection in Horizon Client RDP sessions.
More

IGEL Setup Sessions > RDP > RDP Global > Mapping > Audio

Parameter Audio recording

Registry rdp.winconnect.rdpeai.enable

Value enabled / disabled

RedHat Enterprise Virtualization Client

Fixed display corruption with Windows connections.

Firefox

Fixed possibility to download files in the browser if needed. The parameter to enable/disable file 
download is available here.
More

IGEL Setup Sessions > Browser > Browser Sessions > Window

Parameter Hide local filesystem

Registry sessions.browser.app.filepicker_dialog_hidden

Value enabled / disabled

If enabled, the user is not allowed to download or use any save-as functionality from 
menu, context or keyboard shortcut.

Fixed bug which prevented the download using the file dialog (in the case you open a link to a 
file of unkonwn type).
Fixed unmounting of the Firefox profile partition during shutdown - now it is unmounted in a 
determinate manner after Custom Partition.



Notes for Release 10.04.100

IGEL OS Release Notes   1369 / 1492

•
•
•
•

•

•

•

•

•

•

•
•
•

•

•

•
•
•
•
•
•

•

•

Network

Fixed bug: Network tray icons sometimes didn't reappear after network restart.
Fixed bug: tcpdump debug tool terminated immediately during boot.
Fixed issue with naming of USB ethernet devices.
Fixed wrong LinkMode (10baseT/Half) with autonegotiation and some USB ethernet devices.

AppliDis

Changed default value of PasswordMode from cmdline to prompt as suggested by Systancia.

Smartcard

Fixed driver for Elatec RFID readers. Before this fix the readers sometimes were not available after 
boot.
Fixed VMware Horizon logon with OpenSC smartcards.

CUPS Printing

Fixed bug where the user for printjobs was not set to the domain user.

Base System

Fixed Kerberos password change to work also with transport protocol TCP. To force protocol 
TCP, prepend Domain Controllers with prefix "tcp/", e.g. "tcp/dc.example.com".
Fixed occasional desktop hang in the local login or the network login mask after successful 
authentication.
Fixed password expiry notification showing negative expiry period.
Fixed update to connect to SFTP servers with very restrictive key exchange settings.
Fixed input of the reset key in reset to defaults boot, if the administrator password is not 
available anymore. If more than 255 characters were entered in the 1st try, it was not possible to 
enter the reset key for a 2nd or 3rd time.
Fixed Active Directory logon with smartcard: If the smartcard contains logon certificates for 
multiple users, it is possible to switch between these certificates and log on with the chosen 
certificate now.
Fixed missing names for some partitions in update notification when having a user interface 
language other than English.
Fixed problems with never ending bootcode update with some EFI BIOS variants.
Fixed ssh server port configuration.
Fixed signotec signature pad channel for Citrix.
Increased stability of signotec VCOM Daemon.
Remove residual information belonging to a removed content from a custom partition.
Fixed crash of xfce4-power-manager after adding or removing input devices.

Custom Partition

Fixed automatic update of custom partition - if download source isn't accessible then the 
content of the custom partition got lost.

Appliance Mode

Fixed post session command Logoff in Appliance Mode.

X11 System
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Fixed Elo-USB Touchscreen functionality after reboot.
Fixed DisplayLink USB Support on UD3 LX50.
Fixed issue with two monitors connected via DVI-D to HDMI adapter on a UD3 M330 (VIA). 
Added registry key to disable the new HDMI autodetection.
More

Parameter Autodetect if DVI to HDMI adapter is in use

Registry x.drivers.via.autodetect_hdmi_output

Value enabled / disabled

Fixed wrong automatic resolution detection if monitor does not have a preferred mode.
Fixed sporadic display corruptions after monitors leaving the power saving mode.
Improved handling of more than 2 screens.

Shadowing/VNC

Fixed sporadic VNC server crash.

Audio

Fixed volume control of internal speaker in HP T610.
Fixed automatic switch to output over analog headphones.
Not existing S/PDIF inputs and outputs in Plantronics and Jabra USB headsets are now ignored 
by audio subsystem (Pulseaudio).
Added workaround in the kernel USB audio driver for volume control on Sennheiser USB 
headsets.

Remote Management

Fixed calculation of Unit ID for UMS management. In some cases, it could happen that the MAC 
address of wrong network interface was chosen.
Fixed IGEL Setup Assistant to get stopped when settings were received from UMS.
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IGEL Universal Desktop Converter (UDC3) 10.04.100
Supported Hardware:

Third-Party Devices Supported by IGEL OS 10

Versions for Release 10.04.100 (see page 1372)
New Features 10.04.100 (see page 1374)
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Versions for Release 10.04.100
Clients
Product Version

Oracle JRE 1.8.0_162

System Components
Bluetooth stack (bluez) 5.46-0ubuntu3

MESA OpenGL stack 17.2.8-0igel3

VAAPI ABI Version 0.40

Graphics Driver INTEL 2.99.917+git20180214-igel1

Graphics Driver ATI/RADEON 7.10.0-2igel3

Graphics Driver ATI/AMDGPU 1.4.0-2igel3

Graphics Driver Nouveau (Nvidia 
Legacy)

1.0.15-2

Graphics Driver Vboxvideo 5.2.6-dfsg-2

Graphics Driver VMware 13.2.1-1build1

Graphics Driver QXL (Spice) 0.1.5-2build1

Graphics Driver FBDEV 0.4.4-1build5

Graphics Driver VESA 2.3.4-1build2

Input Driver Evdev 2.10.5-1ubuntu1

Input Driver Elographics 1.4.1-1build5

Input Driver Synaptics 1.9.0-1ubuntu1

Input Driver Vmmouse 13.1.0-1ubuntu2

Input Driver Wacom 0.34.0-0ubuntu2

Kernel 4.15.15 #mainline-udos-r2141

Xorg X11 Server 1.19.6-2igel1

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2

ISC DHCP Client 4.3.3-5ubuntu12.7
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Added support for UEFI Secure Boot.

When booted with Secure Boot the downgrade to a firmware version older than 10.04.100 
is locked.


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New Features 10.04.100
Citrix Receiver 13

Integrated Citrix Receiver 13.8.0.
More

Parameter Use Citrix Cloud with receiver 13.8 or newer

Registry ica.cloudconnect

Value enabled / disabled

Support for Azure Active Directory (Azure AD) authentication
Support for Workspace configuration from Citrix Cloud

Integrated Citrix Receiver 13.4.2. Citrix Receiver version 13.5.0 was removed. Available Citrix 
Receiver versions: 13.3.2, 13.4.2, 13.7.0, 13.8.0 (default)
Updated Citrix HDX RTME used for optimization of Skype for Business to 2.4.0.

RDP / IGEL RDP Client 2

Added possibility to use RDP local logon for smartcard login. This can be activated in the setup.
More

Parameter Enable smartcard support for local logon

Registry rdp.login.smartcard-local-logon

Value enabled / disabled

By enabling this parameter local logon can be used for smartcard authentication. If 
Username is left empty the connection to the RDP server will be made without sending 
credentials, so you can choose Smartcard as login method in the microsoft login 
window . However this will not work with NLA.

Added support for CredSSP up to version 6.

VMware Horizon

Updated VMware Horizon Client to version 4.7.0-7395152.
Added key to enable seamless window mode in each application session.
More

Parameter Seamless Application Windows

Registry sessions.vdm_client.options.enable_seamless_window

Value enabled / disabled

Added possibility to use Fabulatech USB Redirection in a Horizon Client PCoIP session.
More
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IGEL Setup Sessions > Horizon Client > Horizon Client Global > 
Fabulatech USB Redirection

Parameter Enable Fabulatech USB Redirection

Registry vmware.view. usb.enable-fabulatech-usb

Value enabled / disabled

Parallels Client

Integrated Parallels Client version 16.2.0 (19039)
Added support for USB Redirection, configurable at new IGEL Setup page Sessions > Parallels 
Client > Parallels Client Global > USB Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable USB Redirection

Registry twox.usb_redirection.usb_enable

Value enabled / disabled

Parameter Product ID

Registry twox.usb_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.usb_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.usb_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.usb_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule
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Parameter Automatically redirect all USB devices

Registry twox.usb_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for PTP/MTP Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable PTP/MTP Redirection

Registry twox.mtp_redirection.mtp_enable

Value enabled / disabled

Parameter Product ID

Registry twox.mtp_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.mtp_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.mtp_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.mtp_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule

Parameter Automatically redirect all PTP/MTP devices

Registry twox.mtp_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for Clipboard Redirection.
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More

IGEL Setup Sessions > Parallels Client > Parallels Client Sessions > Parallels Client 
Session > Local Resources

Parameter Connect clipboard

Registry sessions.twox.local_resources.connect_clipboard

Value enabled / disabled

VoIP

Added VoIP client Ekiga 4.0.1.

Firefox

Updated Firefox to version 52.7.2 ESR.
Updated Adobe Flash Player download URL to version 29.0.0.113.

Network

Added TTLS/PAP and TTLS/MSCHAPv2 to possible 802.1x authentication methods.
Improved support for Sierra EM7305 LTE device (e.g. in Toshiba Portégé and Fujitsu LIFEBOOK E 
Series).

Added support for Sierra EM7455 WWAN module.
Added support for running the Huawei E3531i WWAN device in modem mode (in addition to 
HiLink mode).
Added possibility to adopt the hostname from a DHCP lease as permanent terminal name. The 
purpose is to use the name received as part of a DHCP lease in future interactions with the DHCP 
server.
More

Parameter Adopt permanent Terminal Name from DHCP lease

Registry network.dns.hostname_adopt_from_dhcp

Value enabled / disabled

NetworkManager updated to version 1.2.2
ModemManager updated to version 1.6.4
usb_modeswitch updated to version 2.5.1

Open VPN

The EM7305 comes in various variants, e.g. one with ProductId 9041 and another one with 
ProductId 9063. The latter comes at least with one or with two USB configuration options. 
A device with only one configuration option has been observed on a Toshiba Tecra Z-50-
D-115 notebook. It only works in MBIM mode and with IGEL firmware, when the device has 
successfully connected before with the same settings (particularly APN), e.g. under 
Microsoft Windows 10.


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Added Huawei HiLink Mobile Broadband USB device as possible uplink to OpenVPN sessions.

OpenConnect VPN

Added OpenConnect client version 7.08 to connect to Cisco AnyConnect and Juniper VPN. The 
feature must be enabled.
More

IGEL Setup System > Firmware Customization > Features

Parameter VPN OpenConnect (Limited support - functionality "as is", see product 
documentation for details)

Registry services.unsupported02.enabled

Value enabled / disabled

The OpenConnect VPN configuration is available at IGEL Setup page Network > VPN > 
OpenConnect VPN.
More

IGEL Setup Network > VPN > OpenConnect VPN > VPN OpenConnect > Session

Parameter Gateway

Registry sessions.openconnect.vpnopts.gateway

Parameter Enable Name/Password Authentication

Registry sessions.openconnect.vpnopts.enable-name-pwd

Value enabled / disabled

Parameter User Name

Registry sessions.openconnect.vpnopts.username

Parameter Password

Registry sessions.openconnect.vpnopts.crypt_password

Parameter CA Certificate

Registry sessions.openconnect.vpnopts.ca-cert

Parameter User Certificate

Registry sessions.openconnect.vpnopts.user-cert

Parameter Private Key

Registry sessions.openconnect.vpnopts.priv-key
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Parameter Private Key password

Registry sessions.openconnect.vpnopts.priv-key-

pwd.crypt_password

Parameter Connect to Juniper Networks VPN

Registry sessions.openconnect%.vpnopts.is-juniper

Value enabled / disabled

Smartcard

Added CoolKey PKCS#11 library for access to Common Access Card (CAC) smartcards.
More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter Coolkey Security Device

Registry browserglobal.security_device.coolkey

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by Coolkey library

Registry vmware.view.pkcs11.use_coolkey

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter Coolkey

Registry scard.pkcs11.use_coolkey

Value enabled / disabled

Updated Gemalto SafeNet PKCS#11 library to version 10.0.37-0. This package replaces Gemalto/
SafeNet eToken and Gemalto IDPrime libraries.
Gemalto SafeNet (formerly Gemalto/SafeNet eToken) now handles Gemalto cards and tokens 
including eToken and IDPrime. 
Gemalto IDPrime now handles IDPrime cards and tokens, preferred Common Creteria (CC) cards 
and tokens in Unlinked Mode.
Added full integration of OpenSC PKCS#11 library for access to smartcards.

Tray icon is placed in the panel to disconnect from a running OpenConnect VPN 
connection.


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More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter OpenSC Security Device

Registry browserglobal.security_device.opensc

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by OpenSC library

Registry vmware.view.pkcs11.use_opensc

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter OpenSC

Registry scard.pkcs11.use_opensc

Value enabled / disabled

Updated MUSCLE CCID smartcard reader driver to version 1.4.28.
Updated ACS CCID smartcard reader driver to version 1.1.5.
Updated REINER SCT cyberJack smartcard reader driver to version 3.99.5final.sp11.
Added parameter to disable Identive CCID smartcard reader driver. If this driver is disabled, some 
of the readers are handled by the MUSCLE CCID driver. This can help when problems with Identive 
reader driver occur.
More

Parameter Identive driver for smart card readers

Registry scard.pcscd.identiv_enable

Value enabled / disabled

Updated cryptovision sc/interface PKCS#11 library to version 7.0.5.592.
New smartcard reader driver for Fujitsu KB SCR eSIG version 5.0.24.

HID

Added layout toggle feature to on-screen keyboard.
More

IGEL Setup Accessories > On-Screen Keyboard > Appearance

Parameter Enable switching to alternative layout
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Registry userinterface.softkeyboard.enable_alternative_layo

ut

Value enabled / disabled

If this is enabled there is a key on the on-screen keyboard for toggling between the normal 
layout and a reduced layout, that saves space on the screen and has more or less the 
same features as the number block of an ordinary keyboard with some extensions.

Base System

Added support for UEFI Secure Boot.

Updated kernel to version 4.15.15
Boot time optimization (up to 25% faster)
Switch power off on USB ports on shutdown and reboot. The feature can be enabled in IGEL 
Setup. At the moment only IGEL H830C is supported.
More

IGEL Setup System > Registry

Parameter Power off on shutdown

Registry devices.usb.poweroff_shutdown

Value enabled / disabled

Added Unit ID in Application Launcher About > Hardware section.
Showing number of CPU cores in Application Launcher About > Hardware section now.

Storage Devices

Added support for Mobile Device Access feature in Appliance Mode. The Mobile Device Access 
tool can be opened via a new icon in the In-session control bar. The Mobile Device Access tool can 
also be started automatically.
More

Parameter Autostart

Registry sessions.mtp-devices0.autostart

Value enabled / disabled

Mobile Device Access must be enabled at IGEL Setup > System > Firmware 
Customization > Features. Appliance Mode must be enabled at IGEL Setup > Sessions > 
Appliance Mode.

When booted with Secure Boot the downgrade to a firmware version older than 10.04.100 
is locked.


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The Mobile Device Access tool is now configurable at IGEL Setup > Accessories > Mobile Device 
Access.
The Mobile Device Access tray icon respects the current theme now.

X11 System

Added support for XDMCP Appliance Mode. The XDMCP connection is configurable.
More

IGEL Setup Sessions > Appliance Mode

Parameter XDMCP for this Display

Registry x.xdmcp0.enabled

Value enabled / disabled

IGEL Setup Sessions > Appliance Mode

Parameter Connection Type

Registry x.xdmcp0.server.connectiontype

Range indirect via localhost / indirect / direct / broadcast

IGEL Setup Sessions > Appliance Mode

Parameter Name or IP of server

Registry x.xdmcp0.server.servername

IGEL Setup Sessions > Appliance Mode

Parameter Enable hotkeys for XDMCP Display

Registry x.xdmcp0.hotkeys.enabled

Value enabled / disabled

The default hotkey to open IGEL Setup is: CTRL + ALT + F2. The setup page User Interface 
> Display > XDMCP was removed.

Added XC Font Service support.
More

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Enable XC Font Service

Registry x.xc_fontservice.enabled

Value enabled / disabled
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IGEL Setup User Interface > Font Services > XC Font Service

Parameter XC Font Server

Registry x.xc_fontservice.fontserver

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Port Number

Registry x.xc_fontservice.port

Value 7100

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Prefer Local Fonts

Registry x.xc_fontservice.prefer_localfonts

Value enabled / disabled

Added auto detection of monitor refresh rate. This can be controlled with new parameters.
More

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0.auto_frequency

Value enabled / disabled

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0. screen.auto_frequency

Value enabled / disabled

Added xorg debug script /etc/igel/igel_debug_tools/xorg-debug.sh to make collecting Xorg 
debug data easier (a /tmp/xorg-debug.log file is generated).

Window Manager

Added possibility to
a) change the preferred placement mode and
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b) modify the threshold value up to which window size this placement mode should be 
chosen (otherwise window placement defaults to so called smart mode which tries to 
minimize overlapping).

More

Parameter Preferred Placement

Registry windowmanager.wm0.variables.placement_mode

Value At mouse position / Centered

Parameter Maximum window size for which the preferred placement should apply

Registry windowmanager.wm0.variables.placement_ratio

Value 0% / 10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%

Audio

Volume of audio output and input can now be configured up to 150% at IGEL Setup page 
Accessories > Sound Preferences > Options.
Added a parameter for log level configuration of Pulseaudio service.
More

Parameter Log level

Registry multimedia.pulseaudio.daemon.log-level

Range debug / info / notice / warning / error

Misc

An EULA must be accepted now in IGEL setup assistant before finalizing it and using the IGEL OS.

Java

Updated Oracle JRE to 1.8U162.

Remote Management

Added new log file transfer mechanism for UMS feature Save TC files for support (UMS 5.08.110 
or higher required). By default, it collects all log files visible in system log viewer, system 
configuration files group.ini, setup.ini and dhclient lease files. More files can be specified at IGEL 
Setup > Accessories > System Log Viewer > Options. The resulting zip file has now a folder 
structure.

IGEL Cloud Gateway

Added UMS structure tag handling for usage with ICG agent.

Hardware

Added support for IGEL UD7-LX 10.
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Notes for Release 10.03.570
Software: Version 10.03.570

Release Date: 2018-02-01

Release Notes: Version RN-1003570-1

Last update: 2018-02-05

IGEL Universal Desktop LX / IGEL Zero 10.03.570 (see page 1386)
IGEL Universal Desktop OS 3 / IGEL UD Pocket 10.03.570 (see page 1394)
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IGEL Universal Desktop LX / IGEL Zero 10.03.570

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 50

UD3-LX 42

UD3-LX 41

UD3-LX 40

UD5-LX: UD5-LX 50

UD5-LX 40

UD6-LX: UD6-LX 51

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Versions for Release 10.03.570 (see page 1387)
Security Fixes 10.03.570 (see page 1390)
General Information 10.03.570 (see page 1391)
Known Issues 10.03.570 (see page 1393)
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Versions for Release 10.03.570
Clients
Product Version

Citrix HDX Realtime Media Engine 2.3.0-1075

Citrix Receiver 13.3.2.366713

Citrix Receiver 13.5.0.10185126

Citrix Receiver 13.7.0.10276927

deviceTRUST Citrix Channel 17.2.100.0

deviceTRUST RDP Channel 17.2.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-dev-34574

Evidian AuthMgr 1.5.6362

Evince PDF Viewer 3.18.2-1ubuntu4.2

FabulaTech USB for Remote Desktop 5.2.23

Firefox 52.5.0

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_152

Parallels 2X Client 16.2.0.19039

Remote Viewer for RedHat Enterprise 
Virtualization Desktops

7.0

Systancia AppliDis 4.0.0.17

Thinlinc Client 4.8.0-5456

ThinPrint Client 7.5.83

Totem Media Player 2.30.2
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VMware Horizon Client 4.6.0-6617224

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20161103

Philips Speech Driver 12.5.4

Signature
signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 6.6.3.502

PKCS#11 Library Gemalto IDPrime 1.2.3

PKCS#11 Library SecMaker NetID 6.6.0.30

Reader Driver ACS CCID 1.1.3

Reader Driver Gemalto eToken 9.0.43

Reader Driver HID Global Omnikey CCID 4.2.4

Reader Driver Identiv / SCM Microsystems CCID 5.0.35

Reader Driver Identiv eHealth200 1.0.5

Reader Driver MUSCLE CCID 1.4.27

Reader Driver REINER SCT cyberJack 3.99.5final.SP09

Resource Manager PC/SC Lite 1.8.22

Cherry USB2LAN Proxy 3.0.0.4

System Components
Bluetooth stack (bluez) 5.46-0ubuntu3

MESA OpenGL stack 17.2.2-0ubuntu1
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VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20171109-igel

Graphics Driver ATI/RADEON 7.10.0-1

raphics Driver ATI/AMDGPU 1.4.0-1

Graphics Driver VIA 5.76.52.92-009-005f78-20150730

Graphics Driver FBDEV 0.4.4-1build5

Graphics Driver VESA 2.3.4-1build2

Input Driver Evdev 2.10.5-1ubuntu1

Input Driver Elographics 1.4.1-1build5

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1

Input Driver Vmmouse 13.1.0-1ubuntu2

Input Driver Wacom 0.34.0-0ubuntu2

Kernel 4.10.17 #43.47-ud-r1949

Xorg X11 Server 1.19.5-0ubuntu2

CUPS printing daemon 2.1.3-4ubuntu0.3

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2

ISC DHCP Client 4.3.3-5ubuntu12.7

NetworkManager 1.2.0-0ubuntu0.16.04.3

ModemManager 1.4.12-1ubuntu1

GStreamer 0.10.36-2ubuntu0.1

Features with Limited IGEL Support
Mobile Device Access USB
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Security Fixes 10.03.570
Fixed kernel security issues CVE-2017-16939, CVE-2017-12192, CVE-2017-1000370, 
CVE-2017-1000371, CVE-2017-12190, CVE-2017-15274, CVE-2017-14156, CVE-2017-14140, 
CVE-2017-15115, CVE-2017-14489, CVE-2017-12153, CVE-2017-16525, CVE-2017-7542 and 
CVE-2017-8824.
Removed Intel Spectre microcode updates due to various issues with them. (Intel officially 
withdrew the microcode updates.)
Fixed kernel security issues CVE-2017-1000405 (aka Huge Dirty Cow).
Fixed Intel meltdown problem CVE-2017-5754 with Kernel Page Table Isolation (KPTI) Patch
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General Information 10.03.570
The following clients and features are not supported anymore in version 10.03.570:

Citrix Receiver 12.1 and 13.1
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
XC Font Service
Remote Access via RSH
Legacy Philips Speech Driver
Digital Persona Support
Sane Scanner Support
Softpro/Kofax Citrix Virtual Channel
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
Video Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
H.264 Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon
by an icon in the 'In-Session Control Bar' (configurable at
IGEL Setup > User Interface > Desktop
)
by a 'Safely Remove Hardware' session (configurable at
IGEL Setup > Accessories
)

The following clients and features are not available in release 10.03.570:

Voip Client Ekiga
X session (Xorg Xephyr)
XDMCP
Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
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Known Issues 10.03.570
Citrix Receiver 13

With Citrix Receiver 13.5 print problems in legacy sessions can occur.

VMware Horizon

External drives mounted already before connection, do not appear in the remote desktop. 
Workaround: map the directory /media as a drive in your desktop. Then the external devices will 
show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. In the 
IGEL Setup client drive mapping can be found in:
Sessions > Horizon Client > Horizon Client Global > Drive Mapping > Enable Drive Mapping
. It is also recommended to disable local Storage Hotplug: On page
Devices > Storage Devices > Storage Hotplug
, put number of storage hotplug devices to 0.
On the other hand, if you use drive mapping instead, it is recommended that you should 
either switch off USB redirection entirely or at least deny storage devices by adding a filter 
to the USB class rules. And because Horizon Client relies on the OS to mount the storage 
devices itself, please go to setup page:
Devices > Storage Devices > Storage Hotplug
and switch on 'Enable dynamic drive mapping' and put 'Number of storage hotplug devices' 
to at least 1.

Firefox

Support for the gstreamer framework was dropped by recent Firefox versions. Therefore support 
for H264 decoding in the browser is not possible anymore, due to licensing restrictions.
After firmware update, a fullscreen browser session starts onetime in window mode. Afterwards 
the fullscreen mode is functional again.

Audio

Headphone jack detection doesn't properly work on IGEL UD3 (M330C and M340C). The audio 
controlling system is unable to notice status change of the audio jack.
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IGEL Universal Desktop OS 3 / IGEL UD Pocket 10.03.570
Versions for Release 10.03.570 (see page 1395)
Security Fixes 10.03.570 (see page 1398)
General Information 10.03.570 (see page 1399)
Known Issues 10.03.570 (see page 1401)
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Versions for Release 10.03.570
Clients
Product Version

Citrix HDX Realtime Media Engine 2.3.0-1075

Citrix Receiver 13.3.2.366713

Citrix Receiver 13.5.0.10185126

Citrix Receiver 13.7.0.10276927

deviceTRUST Citrix Channel 17.2.100.0

deviceTRUST RDP Channel 17.2.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-dev-34574

Evidian AuthMgr 1.5.6362

Evince PDF Viewer 3.18.2-1ubuntu4.2

FabulaTech USB for Remote Desktop 5.2.23

Firefox 52.5.0

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_152

Parallels 2X Client 16.2.0.19039

Remote Viewer for RedHat Enterprise 
Virtualization Desktops

7.0

Systancia AppliDis 4.0.0.17

Thinlinc Client 4.8.0-5456

ThinPrint Client 7.5.83

Totem Media Player 2.30.2
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VMware Horizon Client 4.6.0-6617224

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20161103

Philips Speech Driver 12.5.4

Signature
signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 6.6.3.502

PKCS#11 Library Gemalto IDPrime 1.2.3

PKCS#11 Library SecMaker NetID 6.6.0.30

Reader Driver ACS CCID 1.1.3

Reader Driver Gemalto eToken 9.0.43

Reader Driver HID Global Omnikey CCID 4.2.4

Reader Driver Identiv / SCM Microsystems CCID 5.0.35

Reader Driver Identiv eHealth200 1.0.5

Reader Driver MUSCLE CCID 1.4.27

Reader Driver REINER SCT cyberJack 3.99.5final.SP09

Resource Manager PC/SC Lite 1.8.22

Cherry USB2LAN Proxy 3.0.0.4

System Components
Bluetooth stack (bluez) 5.46-0ubuntu3

MESA OpenGL stack 17.2.2-0ubuntu1
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VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20171109-igel

Graphics Driver ATI/RADEON 7.10.0-1

raphics Driver ATI/AMDGPU 1.4.0-1

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2

Graphics Driver Nvidia 384.90-0ubuntu0.16.04.2

Graphics Driver Vboxvideo 5.1.30-dfsg-1

Graphics Driver VMware 13.2.1-1build1

Graphics Driver QXL (Spice) 0.1.5-2build1

Graphics Driver FBDEV 0.4.4-1build5

Graphics Driver VESA 2.3.4-1build2

Input Driver Evdev 2.10.5-1ubuntu1

Input Driver Elographics 1.4.1-1build5

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1

Input Driver Vmmouse 13.1.0-1ubuntu2

Input Driver Wacom 0.34.0-0ubuntu2

Kernel 4.10.17 #43.47-udos-r1949

Xorg X11 Server 1.19.5-0ubuntu2

CUPS printing daemon 2.1.3-4ubuntu0.3

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2

ISC DHCP Client 4.3.3-5ubuntu12.7

NetworkManager 1.2.0-0ubuntu0.16.04.3

ModemManager 1.4.12-1ubuntu1

GStreamer 0.10.36-2ubuntu0.1

Features with Limited IGEL Support
Mobile Device Access USB
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Security Fixes 10.03.570
Fixed kernel security issues CVE-2017-16939, CVE-2017-12192, CVE-2017-1000370, 
CVE-2017-1000371, CVE-2017-12190, CVE-2017-15274, CVE-2017-14156, CVE-2017-14140, 
CVE-2017-15115, CVE-2017-14489, CVE-2017-12153, CVE-2017-16525, CVE-2017-7542 and 
CVE-2017-8824.
Partially addressed CVE-2017-5715 (Spectre Branch Target Injection) with Intel microcode updates 
version 20180108. CPU Models with updated microcode:

IVT C0
SKL-U/Y D0 and SKL-H/S R0
BDW-U/Y E/F and BDW-H E/G
HSW-ULT Cx/Dx and HSW Cx/Dx
Crystalwell Cx
HSX-EX E0 and HSX C0
BDX-DE V0/V1 and BDX-DE V2
KBL-U/Y H0, KBL Y0 / CFL D0 and KBL-H/S B0
CFL U0 and CFL B0
SKX H0
GLK B0

Fixed kernel security issues CVE-2017-1000405 (aka Huge Dirty Cow).
Fixed Intel meltdown problem CVE-2017-5754 with Kernel Page Table Isolation (KPTI) Patch
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General Information 10.03.570
The following clients and features are not supported anymore in version 10.03.570:

Citrix Receiver 12.1 and 13.1
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
XC Font Service
Remote Access via RSH
Legacy Philips Speech Driver
Digital Persona Support
Sane Scanner Support
Softpro/Kofax Citrix Virtual Channel
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
Video Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
H.264 Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon
by an icon in the 'In-Session Control Bar' (configurable at
IGEL Setup > User Interface > Desktop
)
by a 'Safely Remove Hardware' session (configurable at
IGEL Setup > Accessories
)

The following clients and features are not available in release 10.03.570:

Voip Client Ekiga
X session (Xorg Xephyr)
XDMCP
Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
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Known Issues 10.03.570
Citrix Receiver 13

With Citrix Receiver 13.5 print problems in legacy sessions can occur.

VMware Horizon

External drives mounted already before connection, do not appear in the remote desktop. 
Workaround: map the directory /media as a drive in your desktop. Then the external devices will 
show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. In the 
IGEL Setup client drive mapping can be found in:
Sessions > Horizon Client > Horizon Client Global > Drive Mapping > Enable Drive Mapping
. It is also recommended to disable local Storage Hotplug: On page
Devices > Storage Devices > Storage Hotplug
, put number of storage hotplug devices to 0.
On the other hand, if you use drive mapping instead, it is recommended that you should 
either switch off USB redirection entirely or at least deny storage devices by adding a filter 
to the USB class rules. And because Horizon Client relies on the OS to mount the storage 
devices itself, please go to setup page:
Devices > Storage Devices > Storage Hotplug
and switch on 'Enable dynamic drive mapping' and put 'Number of storage hotplug devices' 
to at least 1.

Firefox

Support for the gstreamer framework was dropped by recent Firefox versions. Therefore support 
for H264 decoding in the browser is not possible anymore, due to licensing restrictions.
After firmware update, a fullscreen browser session starts onetime in window mode. Afterwards 
the fullscreen mode is functional again.

Audio

Headphone jack detection doesn't properly work on IGEL UD3 (M330C and M340C). The audio 
controlling system is unable to notice status change of the audio jack.
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Notes for Release 10.03.550
Software: Version 10.03.550

Release Date: 2018-01-12

Release Notes: Version RN-1003550-1

Last update: 2018-01-12

IGEL Universal Desktop / IGEL Zero 10.03.550 (see page 1403)
IGEL Universal Desktop OS 3 / IGEL UD Pocket 10.03.550 (see page 1412)
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IGEL Universal Desktop / IGEL Zero 10.03.550
Supported Devices

Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 50

UD3-LX 42

UD3-LX 41

UD3-LX 40

UD5-LX: UD5-LX 50

UD5-LX 40

UD6-LX: UD6-LX 51

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Versions for Release 10.03.550 (see page 1404)
Security Fixes 10.03.550 (see page 1407)
General Information 10.03.550 (see page 1408)
Known Issues 10.03.550 (see page 1409)
New Features 10.03.550 (see page 1410)
Resolved Issues 10.03.550 (see page 1411)
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Versions for Release 10.03.550
Clients
Product Version

Citrix HDX Realtime Media Engine 2.3.0-1075

Citrix Receiver 13.3.2.366713

Citrix Receiver 13.5.0.10185126

Citrix Receiver 13.7.0.10276927

deviceTRUST Citrix Channel 17.2.100.0

deviceTRUST RDP Channel 17.2.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-dev-34574

Evidian AuthMgr 1.5.6362

FabulaTech USB for Remote Desktop 5.2.23

Firefox 52.5.0

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_152

Parallels 2X Client 16.2.0.19039

Remote Viewer for RedHat Enterprise 
Virtualization Desktops

7.0

Systancia AppliDis 4.0.0.17

Thinlinc Client 4.8.0-5456

ThinPrint Client 7.5.83

Totem Media Player 2.30.2

VMware Horizon Client 4.6.0-6617224

Dictation
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Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20161103

Philips Speech Driver 12.5.4

Signature
signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 6.6.3.502

PKCS#11 Library Gemalto IDPrime 1.2.3

PKCS#11 Library SecMaker NetID 6.6.0.30

Reader Driver ACS CCID 1.1.3

Reader Driver Gemalto eToken 9.0.43

Reader Driver HID Global Omnikey CCID 4.2.4

Reader Driver Identiv / SCM Microsystems CCID 5.0.35

Reader Driver Identiv eHealth200 1.0.5

Reader Driver MUSCLE CCID 1.4.27

Reader Driver REINER SCT cyberJack 3.99.5final.SP09

Resource Manager PC/SC Lite 1.8.22

Cherry USB2LAN Proxy 3.0.0.4

System Components
Bluetooth stack (bluez) 5.46-0ubuntu3

MESA OpenGL stack 17.2.2-0ubuntu1

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1
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Graphics Driver INTEL 2.99.917+git20171109-igel

Graphics Driver ATI/RADEON 7.10.0-1

raphics Driver ATI/AMDGPU 1.4.0-1

Graphics Driver VIA 5.76.52.92-009-005f78-20150730

Graphics Driver FBDEV 0.4.4-1build5

Graphics Driver VESA 2.3.4-1build2

Input Driver Evdev 2.10.5-1ubuntu1

Input Driver Elographics 1.4.1-1build5

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1

Input Driver Vmmouse 13.1.0-1ubuntu2

Input Driver Wacom 0.34.0-0ubuntu2

Kernel 4.10.17 #43.47-ud-r1949

Xorg X11 Server 1.19.5-0ubuntu2

CUPS printing daemon 2.1.3-4ubuntu0.3

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2

ISC DHCP Client 4.3.3-5ubuntu12.7

NetworkManager 1.2.0-0ubuntu0.16.04.3

ModemManager 1.4.12-1ubuntu1

GStreamer 0.10.36-2ubuntu0.1

Features with Limited IGEL Support
Mobile Device Access USB
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Security Fixes 10.03.550
Fixed kernel security issues CVE-2017-16939, CVE-2017-12192, CVE-2017-1000370, 
CVE-2017-1000371, CVE-2017-12190, CVE-2017-15274, CVE-2017-14156, CVE-2017-14140, 
CVE-2017-15115, CVE-2017-14489, CVE-2017-12153, CVE-2017-16525, CVE-2017-7542 and 
CVE-2017-8824.
Fixed kernel security issues CVE-2017-1000405 (aka Huge Dirty Cow).
Fixed Intel meltdown problem CVE-2017-5754 with Kernel Page Table Isolation (KPTI) Patch.
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•
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General Information 10.03.550
The following clients and features are not supported anymore:

Citrix Receiver 12.1 and 13.1
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
XC Font Service
Remote Access via RSH
Legacy Philips Speech Driver
Digital Persona Support
Sane Scanner Support
Softpro/Kofax Citrix Virtual Channel
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
Video Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
H.264 Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon
by an icon in the 'In-Session Control Bar' (configurable at IGEL Setup > User Interface > 
Desktop)
by a 'Safely Remove Hardware' session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in this release:

Voip Client Ekiga
X session (Xorg Xephyr)
XDMCP
Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
Composite Manager
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Known Issues 10.03.550
Citrix Receiver 13

With Citrix Receiver 13.5 print problems in legacy sessions can occur.

VMware Horizon

External drives mounted already before connection, do not appear in the remote desktop. 
Workaround: map the directory /media as a drive in your desktop. Then the external devices will 
show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. In the 
IGEL Setup client drive mapping can be found in: Sessions > Horizon Client > 

Horizon Client Global > Drive Mapping > Enable Drive Mapping . It is 

also recommended to disable local Storage Hotplug: On page Devices > Storage 

Devices > Storage Hotplug , put number of storage hotplug devices to 0.
On the other hand, if you use drive mapping instead, it is recommended that you should 
either switch off USB redirection entirely or at least deny storage devices by adding a filter 
to the USB class rules. And because Horizon Client relies on the OS to mount the storage 
devices itself, please go to setup page: Devices > Storage Devices > Storage 

Hotplug  and switch on 'Enable dynamic drive mapping' and put 'Number of storage 
hotplug devices' to at least 1.

Firefox

Because the support for the gstreamer framework was dropped by recent Firefox versions, support 
for H264 decoding in the browser is not possible anymore due to licensing restrictions.
After firmware update, a fullscreen browser session starts onetime in window mode. Afterwards 
the fullscreen mode is functional again.

Audio

Headphone jack detection doesn't properly work on IGEL UD3 (M330C and M340C). The audio 
controlling system is unable to notice status change of the audio jack.
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New Features 10.03.550
Parallels Client

Integrated Parallels Client version 16.2.0 (19039) 64 bit.
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Resolved Issues 10.03.550
RDP/IGEL RDP Client 2

Fixed the rdpdebugger to work again (was broken in the previous release).
Fixed smartcard redirection: after session reconnection readers and cards were not connected 
anymore in some cases.

Parallels Client

Fixed crash after closing one session if started 2 same sessions before

Smartcard

Fixed driver for Elatec RFID readers. Before this fix the readers sometimes were not available after 
boot.

Base System

Updated kernel to Ubuntu-hwe-4.10.0-43.47_16.04.1.
Fixed kernel security issues CVE-2017-16939, CVE-2017-12192, CVE-2017-1000370, 
CVE-2017-1000371, CVE-2017-12190, CVE-2017-15274, CVE-2017-14156, CVE-2017-14140, 
CVE-2017-15115, CVE-2017-14489, CVE-2017-12153, CVE-2017-16525, CVE-2017-7542 and 
CVE-2017-8824.
Fixed kernel security issues CVE-2017-1000405 (aka Huge Dirty Cow).
Fixed Intel meltdown problem CVE-2017-5754 with Kernel Page Table Isolation (KPTI) Patch.
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IGEL Universal Desktop OS 3 / IGEL UD Pocket 10.03.550
Supported Hardware:

Third-Party Devices Supported by IGEL OS 10

Versions for Release 10.03.550 (see page 1413)
Security Fixes 10.03.550 (see page 1416)
General Information 10.03.550 (see page 1417)
Known Issues 10.03.550 (see page 1418)
New Features 10.03.550 (see page 1419)
Resolved Issues 10.03.550 (see page 1420)
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Versions for Release 10.03.550
Clients
Product Version

Citrix HDX Realtime Media Engine 2.3.0-1075

Citrix Receiver 13.3.2.366713

Citrix Receiver 13.5.0.10185126

Citrix Receiver 13.7.0.10276927

deviceTRUST Citrix Channel 17.2.100.0

deviceTRUST RDP Channel 17.2.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-dev-34574

Evidian AuthMgr 1.5.6362

Evince PDF Viewer 3.18.2-1ubuntu4.2

FabulaTech USB for Remote Desktop 5.2.23

Firefox 52.5.0

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_152

Parallels 2X Client 16.2.0.19039

Remote Viewer for RedHat Enterprise 
Virtualization Desktops

7.0

Systancia AppliDis 4.0.0.17

Thinlinc Client 4.8.0-5456

ThinPrint Client 7.5.83

Totem Media Player 2.30.2
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VMware Horizon Client 4.6.0-6617224

Dictation
Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20161103

Philips Speech Driver 12.5.4

Signature
signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 6.6.3.502

PKCS#11 Library Gemalto IDPrime 1.2.3

PKCS#11 Library SecMaker NetID 6.6.0.30

Reader Driver ACS CCID 1.1.3

Reader Driver Gemalto eToken 9.0.43

Reader Driver HID Global Omnikey CCID 4.2.4

Reader Driver Identiv / SCM Microsystems CCID 5.0.35

Reader Driver Identiv eHealth200 1.0.5

Reader Driver MUSCLE CCID 1.4.27

Reader Driver REINER SCT cyberJack 3.99.5final.SP09

Resource Manager PC/SC Lite 1.8.22

Cherry USB2LAN Proxy 3.0.0.4

System Components
Bluetooth stack (bluez) 5.46-0ubuntu3

MESA OpenGL stack 17.2.2-0ubuntu1
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VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1

Graphics Driver INTEL 2.99.917+git20171109-igel

Graphics Driver ATI/RADEON 7.10.0-1

raphics Driver ATI/AMDGPU 1.4.0-1

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2

Graphics Driver Nvidia 384.90-0ubuntu0.16.04.2

Graphics Driver Vboxvideo 5.1.30-dfsg-1

Graphics Driver VMware 13.2.1-1build1

Graphics Driver QXL (Spice) 0.1.5-2build1

Graphics Driver FBDEV 0.4.4-1build5

Graphics Driver VESA 2.3.4-1build2

Input Driver Evdev 2.10.5-1ubuntu1

Input Driver Elographics 1.4.1-1build5

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1

Input Driver Vmmouse 13.1.0-1ubuntu2

Input Driver Wacom 0.34.0-0ubuntu2

Kernel 4.10.17 #43.47-udos-r1949

Xorg X11 Server 1.19.5-0ubuntu2

CUPS printing daemon 2.1.3-4ubuntu0.3

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2

ISC DHCP Client 4.3.3-5ubuntu12.7

NetworkManager 1.2.0-0ubuntu0.16.04.3

ModemManager 1.4.12-1ubuntu1

GStreamer 0.10.36-2ubuntu0.1

Features with Limited IGEL Support
Mobile Device Access USB
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Security Fixes 10.03.550
Fixed kernel security issues CVE-2017-16939, CVE-2017-12192, CVE-2017-1000370, 
CVE-2017-1000371, CVE-2017-12190, CVE-2017-15274, CVE-2017-14156, CVE-2017-14140, 
CVE-2017-15115, CVE-2017-14489, CVE-2017-12153, CVE-2017-16525, CVE-2017-7542 and 
CVE-2017-8824.
Partially addressed CVE-2017-5715 (Spectre Branch Target Injection) with Intel microcode updates 
version 20180108. CPU Models with updated microcode:

IVT C0
SKL-U/Y D0 and SKL-H/S R0
BDW-U/Y E/F and BDW-H E/G
HSW-ULT Cx/Dx and HSW Cx/Dx
Crystalwell Cx
HSX-EX E0 and HSX C0
BDX-DE V0/V1 and BDX-DE V2
KBL-U/Y H0, KBL Y0 / CFL D0 and KBL-H/S B0
CFL U0 and CFL B0
SKX H0
GLK B0

Fixed kernel security issues CVE-2017-1000405 (aka Huge Dirty Cow).
Fixed Intel meltdown problem CVE-2017-5754 with Kernel Page Table Isolation (KPTI) Patch.
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General Information 10.03.550
The following clients and features are not supported anymore in version 10.03.550:

Citrix Receiver 12.1 and 13.1
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
XC Font Service
Remote Access via RSH
Legacy Philips Speech Driver
Digital Persona Support
Sane Scanner Support
Softpro/Kofax Citrix Virtual Channel
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
VIA Graphics Support
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon
by an icon in the 'In-Session Control Bar' (configurable at IGEL Setup > User Interface > 
Desktop)
by a 'Safely Remove Hardware' session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in release 10.03.550:

Voip Client Ekiga
X session (Xorg Xephyr)
XDMCP
Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
Composite Manager
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Known Issues 10.03.550
Citrix Receiver 13

With Citrix Receiver 13.5 print problems in legacy sessions can occur.

VMware Horizon

External drives mounted already before connection, do not appear in the remote desktop. 
Workaround: map the directory /media as a drive in your desktop. Then the external devices will 
show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at the 
same time.

On the one hand, if you want to use USB redirection for your storage devices: Note that the 
USB on-insertion feature is only working if the client drive mapping is switched off. In the 
IGEL Setup client drive mapping can be found in: Sessions > Horizon Client > 

Horizon Client Global > Drive Mapping > Enable Drive Mapping . It is 

also recommended to disable local Storage Hotplug: On page Devices > Storage 

Devices > Storage Hotplug , put number of storage hotplug devices to 0.
On the other hand, if you use drive mapping instead, it is recommended that you should 
either switch off USB redirection entirely or at least deny storage devices by adding a filter 
to the USB class rules. And because Horizon Client relies on the OS to mount the storage 
devices itself, please go to setup page: Devices > Storage Devices > Storage 

Hotplug  and switch on 'Enable dynamic drive mapping' and put 'Number of storage 
hotplug devices' to at least 1.

Firefox

Because the support for the gstreamer framework was dropped by recent Firefox versions, support 
for H264 decoding in the browser is not possible anymore due to licensing restrictions.
After firmware update, a fullscreen browser session starts onetime in window mode. Afterwards 
the fullscreen mode is functional again.

Hardware

The TrackPoint and TrackPoint keys of the Toshiba Portege X30-D laptop are not working.
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New Features 10.03.550
Parallels Client

Integrated Parallels Client version 16.2.0 (19039) 64 bit.
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Resolved Issues 10.03.550
RDP/IGEL RDP Client 2

Fixed the rdpdebugger to work again (was broken in the previous release).
Fixed smartcard redirection: after session reconnection readers and cards were not connected 
anymore in some cases.

Parallels Client

Fixed crash after closing one session if started 2 same sessions before

Smartcard

Fixed driver for Elatec RFID readers. Before this fix the readers sometimes were not available after 
boot.

Base System

Updated kernel to Ubuntu-hwe-4.10.0-43.47_16.04.1.
Fixed kernel security issues CVE-2017-16939, CVE-2017-12192, CVE-2017-1000370, 
CVE-2017-1000371, CVE-2017-12190, CVE-2017-15274, CVE-2017-14156, CVE-2017-14140, 
CVE-2017-15115, CVE-2017-14489, CVE-2017-12153, CVE-2017-16525, CVE-2017-7542 and 
CVE-2017-8824.
Partially addressed CVE-2017-5715 (Spectre Branch Target Injection) with Intel microcode updates 
version 20180108. CPU Models with updated microcode:

IVT C0
SKL-U/Y D0 and SKL-H/S R0
BDW-U/Y E/F and BDW-H E/G
HSW-ULT Cx/Dx and HSW Cx/Dx
Crystalwell Cx
HSX-EX E0 and HSX C0
BDX-DE V0/V1 and BDX-DE V2
KBL-U/Y H0, KBL Y0 / CFL D0 and KBL-H/S B0
CFL U0 and CFL B0
SKX H0
GLK B0

Fixed kernel security issues CVE-2017-1000405 (aka Huge Dirty Cow).
Fixed Intel meltdown problem CVE-2017-5754 with Kernel Page Table Isolation (KPTI) Patch.
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Notes for Release 10.03.500
Software: Version 10.03.500

Release Date: 2017-12-14

Release Notes: Version RN-1003500-1

Last update: 2017-12-14

IGEL Universal Desktop / IGEL Zero 10.03.500 (see page 1422)
IGEL Universal Desktop OS3 / IGEL UD Pocket 10.03.500 (see page 1450)
IGEL Universal Desktop Converter (UDC3) 10.03.500 (see page 1477)
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IGEL Universal Desktop / IGEL Zero 10.03.500

Supported Devices
Universal Desktop:

UD2-LX: UD2-LX 40

UD3-LX: UD3-LX 50

UD3-LX 42

UD3-LX 41

UD3-LX 40

UD5-LX: UD5-LX 50

UD5-LX 40

UD6-LX: UD6-LX 51

UD9-LX: UD9-LX Touch 41

UD9-LX 40

UD10-LX: UD10-LX Touch 10

UD10-LX 10

IGEL Zero:

IZ2-RFX

IZ2-HDX

IZ2-HORIZON

IZ3-RFX

IZ3-HDX

IZ3-HORIZON

Versions for 10.03.500 (see page 1424)
Security Fixes 10.03.500 (see page 1427)
General Information 10.03.500 (see page 1433)
Known Issues 10.03.500 (see page 1434)
New Features 10.03.500 (see page 1436)
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Versions for 10.03.500
Clients
Product Version

Citrix HDX Realtime Media Engine 2.3.0-1075

Citrix Receiver 13.3.2.366713

Citrix Receiver 13.5.0.10185126

Citrix Receiver 13.7.0.10276927

deviceTRUST Citrix Channel 17.2.100.0

deviceTRUST RDP Channel 17.2.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-dev-34574

Evidian AuthMgr 1.5.6362

FabulaTech USB for Remote Desktop 5.2.23

Firefox 52.5.0

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_152

Parallels 2X Client 16.0.1.18456

Remote Viewer for RedHat Enterprise 
Virtualization Desktops

7.0

Systancia AppliDis 4.0.0.17

Thinlinc Client 4.8.0-5456

ThinPrint Client 7.5.83

Totem Media Player 2.30.2

VMware Horizon Client 4.6.0-6617224

Dictation
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Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20161103

Philips Speech Driver 12.5.4

Signature
signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 6.6.3.502

PKCS#11 Library Gemalto IDPrime 1.2.3

PKCS#11 Library SecMaker NetID 6.6.0.30

Reader Driver ACS CCID 1.1.3

Reader Driver Gemalto eToken 9.0.43

Reader Driver HID Global Omnikey CCID 4.2.4

Reader Driver Identiv / SCM Microsystems CCID 5.0.35

Reader Driver Identiv eHealth200 1.0.5

Reader Driver MUSCLE CCID 1.4.27

Reader Driver REINER SCT cyberJack 3.99.5final.SP09

Resource Manager PC/SC Lite 1.8.22

Cherry USB2LAN Proxy 3.0.0.4

System Components
Bluetooth stack (bluez) 5.46-0ubuntu3

MESA OpenGL stack 17.2.2-0ubuntu1

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1
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Graphics Driver INTEL 2.99.917+git20171109-igel

Graphics Driver ATI/RADEON 7.10.0-1

raphics Driver ATI/AMDGPU 1.4.0-1

Graphics Driver VIA 5.76.52.92-009-005f78-20150730

Graphics Driver FBDEV 0.4.4-1build5

Graphics Driver VESA 2.3.4-1build2

Input Driver Evdev 2.10.5-1ubuntu1

Input Driver Elographics 1.4.1-1build5

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1

Input Driver Vmmouse 13.1.0-1ubuntu2

Input Driver Wacom 0.34.0-0ubuntu2

Kernel 4.10.17 #41.45-ud-r1938

Xorg X11 Server 1.19.5-0ubuntu2

CUPS printing daemon 2.1.3-4ubuntu0.3

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2

ISC DHCP Client 4.3.3-5ubuntu12.7

NetworkManager 1.2.0-0ubuntu0.16.04.3

ModemManager 1.4.12-1ubuntu1

GStreamer 0.10 0.10.36-2ubuntu0.1

Features with Limited IGEL Support
Mobile Device Access USB
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Security Fixes 10.03.500
Fixed wpa security issues (KRACK vulnerability).
More

CVE-2017-13077

CVE-2017-13078

CVE-2017-13079

CVE-2017-13080

CVE-2017-13081

CVE-2017-13082

CVE-2017-13086

CVE-2017-13087

CVE-2017-13088

CVE-2016-4476

CVE-2016-4477

Fixed libgd2 security issues. CVE-2017-7890 and CVE-2017-6362.
Fixed graphite2 security issues.
More

CVE-2017-7778

CVE-2017-7777

CVE-2017-7776

CVE-2017-7775

CVE-2017-7774

CVE-2017-7773

CVE-2017-7772

CVE-2017-7771

Fixed ghostscript security issues.
More

CVE-2017-9835

CVE-2017-9739

CVE-2017-9727

CVE-2017-9726

CVE-2017-9612

CVE-2017-9611

CVE-2017-11714
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Fixed libmspack security issues CVE-2017-6419 and CVE-2017-11423.
Fixed libsoup2.4 security issue CVE-2017-2885.
Fixed xorg-server security issues.
More

CVE-2017-10971

CVE-2017-10972

CVE-2017-13721

CVE-2017-13723

CVE-2017-12176

CVE-2017-12177

CVE-2017-12178

CVE-2017-12179

CVE-2017-12180

CVE-2017-12181

CVE-2017-12182

CVE-2017-12183

CVE-2017-12184

CVE-2017-12185

CVE-2017-12186

CVE-2017-12187

Fixed bluez security issue CVE-2017-1000250.
Fixed kernel security issues.
More

CVE-2017-7541

CVE-2017-1000112

CVE-2017-1000111

CVE-2017-7487

CVE-2017-7533

CVE-2017-1000251

CVE-2017-14106

CVE-2017-11176

CVE-2017-10911

CVE-2017-14340

CVE-2017-10663

CVE-2017-1000252
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CVE-2017-12188

CVE-2017-12146

Fixed gdk-pixbuf security issues CVE-2017-6311, CVE-2017-2870 and CVE-2017-2862.
Fixed tcpdump security issues.
More

CVE-2017-13725, CVE-2017-13690, CVE-2017-13689, CVE-2017-13688,

CVE-2017-13687, CVE-2017-13055, CVE-2017-13054, CVE-2017-13053,

CVE-2017-13052, CVE-2017-13051, CVE-2017-13050, CVE-2017-13049,

CVE-2017-13048, CVE-2017-13047, CVE-2017-13046, CVE-2017-13045,

CVE-2017-13044, CVE-2017-13043, CVE-2017-13042, CVE-2017-13041,

CVE-2017-13040, CVE-2017-13039, CVE-2017-13038, CVE-2017-13037,

CVE-2017-13036, CVE-2017-13035, CVE-2017-13034, CVE-2017-13033,

CVE-2017-13032, CVE-2017-13031, CVE-2017-13030, CVE-2017-13029,

CVE-2017-13028, CVE-2017-13027, CVE-2017-13026, CVE-2017-13025,

CVE-2017-13024, CVE-2017-13023, CVE-2017-13022, CVE-2017-13021,

CVE-2017-13020, CVE-2017-13019, CVE-2017-13018, CVE-2017-13017,

CVE-2017-13016, CVE-2017-13015, CVE-2017-13014, CVE-2017-13013,

CVE-2017-13012, CVE-2017-13011, CVE-2017-13010, CVE-2017-13009,

CVE-2017-13008, CVE-2017-13007, CVE-2017-13006, CVE-2017-13005,

CVE-2017-13004, CVE-2017-13003, CVE-2017-13002, CVE-2017-13001,

CVE-2017-13000, CVE-2017-12999, CVE-2017-12998, CVE-2017-12997,

CVE-2017-12996, CVE-2017-12995, CVE-2017-12994, CVE-2017-12993,

CVE-2017-12992, CVE-2017-12991, CVE-2017-12990, CVE-2017-12989,

CVE-2017-12988, CVE-2017-12987, CVE-2017-12986, CVE-2017-12985,

CVE-2017-12902, CVE-2017-12901, CVE-2017-12900, CVE-2017-12899,

CVE-2017-12898, CVE-2017-12897, CVE-2017-12896, CVE-2017-12895,

CVE-2017-12894, CVE-2017-12893, CVE-2017-11543, CVE-2017-11542,

CVE-2017-11541 and CVE-2017-11108.

Fixed libxml2 security issues.
More

CVE-2017-9050

CVE-2017-9049

CVE-2017-9048

CVE-2017-9047
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CVE-2017-7376

CVE-2017-7375

CVE-2017-0663

Fixed samba security issues.
More

CVE-2017-12163

CVE-2017-12151

CVE-2017-12150

CVE-2017-15275

CVE-2017-14746

Fixed libplist security issue CVE-2017-7982.
Fixed nss security issue CVE-2017-7805.
Fixed libidn security issue CVE-2017-14062.
Fixed poppler security issues.
More

CVE-2017-9776,

CVE-2017-14977

CVE-2017-14975

CVE-2017-14929

CVE-2017-14928

CVE-2017-14926

CVE-2017-14617

CVE-2017-14520

CVE-2017-14519

CVE-2017-14518

CVE-2017-15565

Fixed dnsmasq security issues.
More

CVE-2017-14496

CVE-2017-14495

CVE-2017-14494

CVE-2017-14493

CVE-2017-14492

CVE-2017-14491

Fixed libxfont security issues CVE-2017-13722, CVE-2017-13720 and CVE-2017-16611.
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Fixed curl security issues.
More

CVE-2016-9586

CVE-2017-2629

CVE-2017-7407

CVE-2017-7468

CVE-2017-1000100

CVE-2017-1000101

CVE-2017-1000254

CVE-2017-1000257

CVE-2017-8816

CVE-2017-8817

Fixed libxfont2 security issues CVE-2017-13722, CVE-2017-13720 and CVE-2017-16611.
Fixed nvidia security issues CVE-2017-6266, CVE-2017-6267 and CVE-2017-6272.
Fixed icu security issue CVE-2017-14952.
Fixed wget security issues CVE-2017-6508, CVE-2017-13090, CVE-2017-13089 and CVE-2016-7098.
Fixed systemd security issue CVE-2017-15908.
Fixed openssl security issues CVE-2017-3736 and CVE-2017-3735.
Fixed perl security issues CVE-2017-12883 and CVE-2017-12837.
Fixed webkit2gtk security issues.
More

CVE-2017-13803

CVE-2017-13802

CVE-2017-13798

CVE-2017-13796

CVE-2017-13795

CVE-2017-13794

CVE-2017-13793

CVE-2017-13792

CVE-2017-13791

CVE-2017-13788

CVE-2017-13785

CVE-2017-13784

CVE-2017-13783

Fixed db5.3 security issue CVE-2017-10140.
Fixed ldns security issues CVE-2017-1000232 and CVE-2017-1000231.
Fixed python2.7 security issue CVE-2017-1000158.
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Fixed python3.5 security issue CVE-2017-1000158.
Fixed libxcursor security issue CVE-2017-16612.
Fixed a security issue in the base system regarding of not reseting certain environment variables.
Updated Firefox to version 52.5 ESR:

Fixes for mfsa2017-25, also known as: CVE-2017-7828, CVE-2017-7830, CVE-2017-7826.
Fixes for mfsa2017-22, also known as: CVE-2017-7793, CVE-2017-7818, CVE-2017-7819, 
CVE-2017-7824, CVE-2017-7805, CVE-2017-7814, CVE-2017-7823, CVE-2017-7810.
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General Information 10.03.500
The following clients and features are not supported anymore in version 10.03.500:

Citrix Receiver 12.1 and 13.1
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
XC Font Service
Remote Access via RSH
Legacy Philips Speech Driver
Digital Persona Support
Sane Scanner Support
Softpro/Kofax Citrix Virtual Channel
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
Video Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
H.264 Hardware Acceleration Support is discontinued on UD3-LX 42, UD3-LX 41, UD3-LX 40 
(M320C/M330C) and UD10-LX Touch 10, UD10-LX 10
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon
by an icon in the 'In-Session Control Bar' (configurable at IGEL Setup > User Interface > 
Desktop)
by a 'Safely Remove Hardware' session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in the release 10.03.500:

Voip Client Ekiga
X session (Xorg Xephyr)
XDMCP
Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
Composite Manager
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Known Issues 10.03.500
Citrix Receiver 13

On devices with AMD/Radeon graphics chipsets and activated DRI3 X driver option the hardware 
accelerated Citrix H.264 decoder plugin can hang. To solve this issue deactivation of DRI3 
option is necessary (default setting).
More

Parameter Use DRI3

Registry x.drivers.use_dri3

Value enabled / disabled

Parameter Force usage of DRI3

Registry x.drivers.amdgpu.force_dri3

x.drivers.ati.force_dri3

Value enabled / disabled

Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
when the card is inserted after start of login. As a workaround, insert the smartcard before starting 
StoreFront login.
No smooth playback over Nuance channel if the dictation device isn't attached.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: mapping the directory /media  as a drive on desktop. 
Then the external devices will show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug: On page Devices > Storage Devices > Storage Hotplug, put number of storage 
hotplug devices to 0.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Change on the following setup page is required: Devices > Storage Devices > Storage 
Hotplug.
Activate Enable dynamic drive mapping and set Number of storage hotplug devices to at 
least 1.
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Firefox

Because the support for the gstreamer framework was dropped by recent Firefox versions, 
support for H264 decoding in the browser is not possible anymore due to licensing restrictions.

OpenConnect VPN

VPNs which need the OpenConnect client cannot be used for firmware updates.

Evidian

Active Directory users with a password containing special characters may have problems to 
authenticate with the configured session. 
Known special characters which result in errors are: 
` (grave accent, ASCII code 96) 
´ (acute accent, ASCII code 239)
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New Features 10.03.500
Citrix Receiver 13

Integrated Citrix Receiver 13.8.0.
More

Parameter Use Citrix Cloud with receiver 13.8 or newer

Registry ica.cloudconnect

Value enabled / disabled

Support for Azure Active Directory (Azure AD) authentication
Support for Workspace configuration from Citrix Cloud

Integrated Citrix Receiver 13.4.2. Citrix Receiver version 13.5.0 was removed. Available Citrix 
Receiver versions: 13.3.2, 13.4.2, 13.7.0, 13.8.0 (default)
Updated Citrix HDX RTME used for optimization of Skype for Business to 2.4.0.

RDP / IGEL RDP Client 2

Added possibility to use RDP local logon for smartcard login. This can be activated in the setup.
More

Parameter Enable smartcard support for local logon

Registry rdp.login.smartcard-local-logon

Value enabled / disabled

By enabling this parameter local logon can be used for smartcard authentication. If 
Username is left empty the connection to the RDP server will be made without sending 
credentials, so you can choose Smartcard as login method in the microsoft login 
window . However this will not work with NLA.

Added support for CredSSP up to version 6.

VMware Horizon

Updated VMware Horizon Client to version 4.7.0-7395152.
Added key to enable seamless window mode in each application session.
More

Parameter Seamless Application Windows

Registry sessions.vdm_client.options.enable_seamless_window

Value enabled / disabled

Added possibility to use Fabulatech USB Redirection in a Horizon Client PCoIP session.
More
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IGEL Setup Sessions > Horizon Client > Horizon Client Global > 
Fabulatech USB Redirection

Parameter Enable Fabulatech USB Redirection

Registry vmware.view. usb.enable-fabulatech-usb

Value enabled / disabled

Parallels Client

Integrated Parallels Client version 16.2.0 (19039)
Added support for USB Redirection, configurable at new IGEL Setup page Sessions > Parallels 
Client > Parallels Client Global > USB Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable USB Redirection

Registry twox.usb_redirection.usb_enable

Value enabled / disabled

Parameter Product ID

Registry twox.usb_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.usb_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.usb_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.usb_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule
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Parameter Automatically redirect all USB devices

Registry twox.usb_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for PTP/MTP Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable PTP/MTP Redirection

Registry twox.mtp_redirection.mtp_enable

Value enabled / disabled

Parameter Product ID

Registry twox.mtp_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.mtp_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.mtp_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.mtp_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule

Parameter Automatically redirect all PTP/MTP devices

Registry twox.mtp_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for Clipboard Redirection.
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More

IGEL Setup Sessions > Parallels Client > Parallels Client Sessions > Parallels Client 
Session > Local Resources

Parameter Connect clipboard

Registry sessions.twox.local_resources.connect_clipboard

Value enabled / disabled

VoIP

Added VoIP client Ekiga 4.0.1.

Firefox

Updated Firefox to version 52.7.2 ESR.
Updated Adobe Flash Player download URL to version 29.0.0.113.

Network

Added TTLS/PAP and TTLS/MSCHAPv2 to possible 802.1x authentication methods.
Improved support for Sierra EM7305 LTE device (e.g. in Toshiba Portégé and Fujitsu LIFEBOOK E 
Series).

Added support for Sierra EM7455 WWAN module.
Added support for running the Huawei E3531i WWAN device in modem mode (in addition to 
HiLink mode).
Added possibility to adopt the hostname from a DHCP lease as permanent terminal name. The 
purpose is to use the name received as part of a DHCP lease in future interactions with the DHCP 
server.
More

Parameter Adopt permanent Terminal Name from DHCP lease

Registry network.dns.hostname_adopt_from_dhcp

Value enabled / disabled

NetworkManager updated to version 1.2.2
ModemManager updated to version 1.6.4
usb_modeswitch updated to version 2.5.1

Open VPN

The EM7305 comes in various variants, e.g. one with ProductId 9041 and another one with 
ProductId 9063. The latter comes at least with one or with two USB configuration options. 
A device with only one configuration option has been observed on a Toshiba Tecra Z-50-
D-115 notebook. It only works in MBIM mode and with IGEL firmware, when the device has 
successfully connected before with the same settings (particularly APN), e.g. under 
Microsoft Windows 10.


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Added Huawei HiLink Mobile Broadband USB device as possible uplink to OpenVPN sessions.

OpenConnect VPN

Added OpenConnect client version 7.08 to connect to Cisco AnyConnect and Juniper VPN. The 
feature must be enabled.
More

IGEL Setup System > Firmware Customization > Features

Parameter VPN OpenConnect (Limited support - functionality "as is", see product 
documentation for details)

Registry services.unsupported02.enabled

Value enabled / disabled

The OpenConnect VPN configuration is available at IGEL Setup page Network > VPN > 
OpenConnect VPN.
More

IGEL Setup Network > VPN > OpenConnect VPN > VPN OpenConnect > Session

Parameter Gateway

Registry sessions.openconnect.vpnopts.gateway

Parameter Enable Name/Password Authentication

Registry sessions.openconnect.vpnopts.enable-name-pwd

Value enabled / disabled

Parameter User Name

Registry sessions.openconnect.vpnopts.username

Parameter Password

Registry sessions.openconnect.vpnopts.crypt_password

Parameter CA Certificate

Registry sessions.openconnect.vpnopts.ca-cert

Parameter User Certificate

Registry sessions.openconnect.vpnopts.user-cert

Parameter Private Key

Registry sessions.openconnect.vpnopts.priv-key
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Parameter Private Key password

Registry sessions.openconnect.vpnopts.priv-key-

pwd.crypt_password

Parameter Connect to Juniper Networks VPN

Registry sessions.openconnect%.vpnopts.is-juniper

Value enabled / disabled

Smartcard

Added CoolKey PKCS#11 library for access to Common Access Card (CAC) smartcards.
More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter Coolkey Security Device

Registry browserglobal.security_device.coolkey

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by Coolkey library

Registry vmware.view.pkcs11.use_coolkey

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter Coolkey

Registry scard.pkcs11.use_coolkey

Value enabled / disabled

Updated Gemalto SafeNet PKCS#11 library to version 10.0.37-0. This package replaces Gemalto/
SafeNet eToken and Gemalto IDPrime libraries.
Gemalto SafeNet (formerly Gemalto/SafeNet eToken) now handles Gemalto cards and tokens 
including eToken and IDPrime. 
Gemalto IDPrime now handles IDPrime cards and tokens, preferred Common Creteria (CC) cards 
and tokens in Unlinked Mode.
Added full integration of OpenSC PKCS#11 library for access to smartcards.

Tray icon is placed in the panel to disconnect from a running OpenConnect VPN 
connection.


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More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter OpenSC Security Device

Registry browserglobal.security_device.opensc

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by OpenSC library

Registry vmware.view.pkcs11.use_opensc

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter OpenSC

Registry scard.pkcs11.use_opensc

Value enabled / disabled

Updated MUSCLE CCID smartcard reader driver to version 1.4.28.
Updated ACS CCID smartcard reader driver to version 1.1.5.
Updated REINER SCT cyberJack smartcard reader driver to version 3.99.5final.sp11.
Added parameter to disable Identive CCID smartcard reader driver. If this driver is disabled, some 
of the readers are handled by the MUSCLE CCID driver. This can help when problems with Identive 
reader driver occur.
More

Parameter Identive driver for smart card readers

Registry scard.pcscd.identiv_enable

Value enabled / disabled

Updated cryptovision sc/interface PKCS#11 library to version 7.0.5.592.
New smartcard reader driver for Fujitsu KB SCR eSIG version 5.0.24.

HID

Added layout toggle feature to on-screen keyboard.
More

IGEL Setup Accessories > On-Screen Keyboard > Appearance

Parameter Enable switching to alternative layout
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Registry userinterface.softkeyboard.enable_alternative_layo

ut

Value enabled / disabled

If this is enabled there is a key on the on-screen keyboard for toggling between the normal 
layout and a reduced layout, that saves space on the screen and has more or less the 
same features as the number block of an ordinary keyboard with some extensions.

Base System

Added support for UEFI Secure Boot.

Updated kernel to version 4.15.15
Boot time optimization (up to 25% faster)
Switch power off on USB ports on shutdown and reboot. The feature can be enabled in IGEL 
Setup. At the moment only IGEL H830C is supported.
More

IGEL Setup System > Registry

Parameter Power off on shutdown

Registry devices.usb.poweroff_shutdown

Value enabled / disabled

Added Unit ID in Application Launcher About > Hardware section.
Showing number of CPU cores in Application Launcher About > Hardware section now.

Storage Devices

Added support for Mobile Device Access feature in Appliance Mode. The Mobile Device Access 
tool can be opened via a new icon in the In-session control bar. The Mobile Device Access tool can 
also be started automatically.
More

Parameter Autostart

Registry sessions.mtp-devices0.autostart

Value enabled / disabled

Mobile Device Access must be enabled at IGEL Setup > System > Firmware 
Customization > Features. Appliance Mode must be enabled at IGEL Setup > Sessions > 
Appliance Mode.

When booted with Secure Boot the downgrade to a firmware version older than 10.04.100 
is locked.


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The Mobile Device Access tool is now configurable at IGEL Setup > Accessories > Mobile Device 
Access.
The Mobile Device Access tray icon respects the current theme now.

X11 System

Added support for XDMCP Appliance Mode. The XDMCP connection is configurable.
More

IGEL Setup Sessions > Appliance Mode

Parameter XDMCP for this Display

Registry x.xdmcp0.enabled

Value enabled / disabled

IGEL Setup Sessions > Appliance Mode

Parameter Connection Type

Registry x.xdmcp0.server.connectiontype

Range indirect via localhost / indirect / direct / broadcast

IGEL Setup Sessions > Appliance Mode

Parameter Name or IP of server

Registry x.xdmcp0.server.servername

IGEL Setup Sessions > Appliance Mode

Parameter Enable hotkeys for XDMCP Display

Registry x.xdmcp0.hotkeys.enabled

Value enabled / disabled

The default hotkey to open IGEL Setup is: CTRL + ALT + F2. The setup page User Interface 
> Display > XDMCP was removed.

Added XC Font Service support.
More

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Enable XC Font Service

Registry x.xc_fontservice.enabled

Value enabled / disabled
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IGEL Setup User Interface > Font Services > XC Font Service

Parameter XC Font Server

Registry x.xc_fontservice.fontserver

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Port Number

Registry x.xc_fontservice.port

Value 7100

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Prefer Local Fonts

Registry x.xc_fontservice.prefer_localfonts

Value enabled / disabled

Added auto detection of monitor refresh rate. This can be controlled with new parameters.
More

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0.auto_frequency

Value enabled / disabled

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0. screen.auto_frequency

Value enabled / disabled

Added xorg debug script /etc/igel/igel_debug_tools/xorg-debug.sh to make collecting Xorg 
debug data easier (a /tmp/xorg-debug.log file is generated).

Window Manager

Added possibility to
a) change the preferred placement mode and
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b) modify the threshold value up to which window size this placement mode should be 
chosen (otherwise window placement defaults to so called smart mode which tries to 
minimize overlapping).

More

Parameter Preferred Placement

Registry windowmanager.wm0.variables.placement_mode

Value At mouse position / Centered

Parameter Maximum window size for which the preferred placement should apply

Registry windowmanager.wm0.variables.placement_ratio

Value 0% / 10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%

Audio

Volume of audio output and input can now be configured up to 150% at IGEL Setup page 
Accessories > Sound Preferences > Options.
Added a parameter for log level configuration of Pulseaudio service.
More

Parameter Log level

Registry multimedia.pulseaudio.daemon.log-level

Range debug / info / notice / warning / error

Misc

An EULA must be accepted now in IGEL setup assistant before finalizing it and using the IGEL OS.

Java

Updated Oracle JRE to 1.8U162.

Remote Management

Added new log file transfer mechanism for UMS feature Save TC files for support (UMS 5.08.110 
or higher required). By default, it collects all log files visible in system log viewer, system 
configuration files group.ini, setup.ini and dhclient lease files. More files can be specified at IGEL 
Setup > Accessories > System Log Viewer > Options. The resulting zip file has now a folder 
structure.

IGEL Cloud Gateway

Added UMS structure tag handling for usage with ICG agent.

Hardware

Added support for IGEL UD7-LX 10.
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Resolved Issues 10.03.500
Citrix

Fixed sporadic crashes of the Citrix USB Daemon.

RDP / IGEL RDP Client 2

Fixed passing Ctrl+Alt+C keyboard shortcut to RDP session.
Fixed smartcard redirection: after session reconnection readers and cards were not connected 
any more in some cases.
Fixed the rdpdebugger to work again (was broken in the previous release).
Fixed misleading RDP error message `Authentication failed` on wakeup from suspend mode
Fixed TCP timeout value to get more stable RDP connections under certain circumstances.

VMware Horizon

Fixed bug which prevented microphone redirection in Horizon Client RDP sessions.
More

IGEL Setup Sessions > RDP > RDP Global > Mapping > Audio

Parameter Audio recording

Registry rdp.winconnect.rdpeai.enable

Value enabled / disabled

RedHat Enterprise Virtualization Client

Fixed display corruption with Windows connections.

Firefox

Fixed possibility to download files in the browser if needed. The parameter to enable/disable file 
download is available here.
More

IGEL Setup Sessions > Browser > Browser Sessions > Window

Parameter Hide local filesystem

Registry sessions.browser.app.filepicker_dialog_hidden

Value enabled / disabled

If enabled, the user is not allowed to download or use any save-as functionality from 
menu, context or keyboard shortcut.

Fixed bug which prevented the download using the file dialog (in the case you open a link to a 
file of unkonwn type).
Fixed unmounting of the Firefox profile partition during shutdown - now it is unmounted in a 
determinate manner after Custom Partition.
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Network

Fixed bug: Network tray icons sometimes didn't reappear after network restart.
Fixed bug: tcpdump debug tool terminated immediately during boot.
Fixed issue with naming of USB ethernet devices.
Fixed wrong LinkMode (10baseT/Half) with autonegotiation and some USB ethernet devices.

AppliDis

Changed default value of PasswordMode from cmdline to prompt as suggested by Systancia.

Smartcard

Fixed driver for Elatec RFID readers. Before this fix the readers sometimes were not available after 
boot.
Fixed VMware Horizon logon with OpenSC smartcards.

CUPS Printing

Fixed bug where the user for printjobs was not set to the domain user.

Base System

Fixed Kerberos password change to work also with transport protocol TCP. To force protocol 
TCP, prepend Domain Controllers with prefix "tcp/", e.g. "tcp/dc.example.com".
Fixed occasional desktop hang in the local login or the network login mask after successful 
authentication.
Fixed password expiry notification showing negative expiry period.
Fixed update to connect to SFTP servers with very restrictive key exchange settings.
Fixed input of the reset key in reset to defaults boot, if the administrator password is not 
available anymore. If more than 255 characters were entered in the 1st try, it was not possible to 
enter the reset key for a 2nd or 3rd time.
Fixed Active Directory logon with smartcard: If the smartcard contains logon certificates for 
multiple users, it is possible to switch between these certificates and log on with the chosen 
certificate now.
Fixed missing names for some partitions in update notification when having a user interface 
language other than English.
Fixed problems with never ending bootcode update with some EFI BIOS variants.
Fixed ssh server port configuration.
Fixed signotec signature pad channel for Citrix.
Increased stability of signotec VCOM Daemon.
Remove residual information belonging to a removed content from a custom partition.
Fixed crash of xfce4-power-manager after adding or removing input devices.

Custom Partition

Fixed automatic update of custom partition - if download source isn't accessible then the 
content of the custom partition got lost.

Appliance Mode

Fixed post session command Logoff in Appliance Mode.

X11 System
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Fixed Elo-USB Touchscreen functionality after reboot.
Fixed DisplayLink USB Support on UD3 LX50.
Fixed issue with two monitors connected via DVI-D to HDMI adapter on a UD3 M330 (VIA). 
Added registry key to disable the new HDMI autodetection.
More

Parameter Autodetect if DVI to HDMI adapter is in use

Registry x.drivers.via.autodetect_hdmi_output

Value enabled / disabled

Fixed wrong automatic resolution detection if monitor does not have a preferred mode.
Fixed sporadic display corruptions after monitors leaving the power saving mode.
Improved handling of more than 2 screens.

Shadowing/VNC

Fixed sporadic VNC server crash.

Audio

Fixed volume control of internal speaker in HP T610.
Fixed automatic switch to output over analog headphones.
Not existing S/PDIF inputs and outputs in Plantronics and Jabra USB headsets are now ignored 
by audio subsystem (Pulseaudio).
Added workaround in the kernel USB audio driver for volume control on Sennheiser USB 
headsets.

Remote Management

Fixed calculation of Unit ID for UMS management. In some cases, it could happen that the MAC 
address of wrong network interface was chosen.
Fixed IGEL Setup Assistant to get stopped when settings were received from UMS.
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IGEL Universal Desktop OS3 / IGEL UD Pocket 10.03.500
Supported Hardware:

Third-Party Devices Supported by IGEL OS 10

Versions 10.03.500 (see page 1451)
Security Fixes 10.03.500 (see page 1454)
General Information 10.03.500 (see page 1460)
Known Issues 10.03.500 (see page 1461)
New Features 10.03.500 (see page 1463)
Resolved Issues 10.03.500 (see page 1474)
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Versions 10.03.500
Clients
Product Version

Citrix HDX Realtime Media Engine 2.3.0-1075

Citrix Receiver 13.3.2.366713

Citrix Receiver 13.5.0.10185126

Citrix Receiver 13.7.0.10276927

deviceTRUST Citrix Channel 17.2.100.0

deviceTRUST RDP Channel 17.2.100.0

Ericom PowerTerm 12.0.1.0.20170219.2-dev-34574

Evidian AuthMgr 1.5.6362

FabulaTech USB for Remote Desktop 5.2.23

Firefox 52.5.0

IBM iAccess Client Solutions 1.1.5.0

IGEL RDP Client 2.2

Imprivata OneSign ProveID Embedded

Leostream Java Connect 3.3.7.0

NX Client 5.3.12

Open VPN 2.3.10-1ubuntu2.1

Oracle JRE 1.8.0_152

Parallels 2X Client 16.0.1.18456

Remote Viewer for RedHat Enterprise 
Virtualization Desktops

7.0

Systancia AppliDis 4.0.0.17

Thinlinc Client 4.8.0-5456

ThinPrint Client 7.5.83

Totem Media Player 2.30.2

VMware Horizon Client 4.6.0-6617224

Dictation
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Diktamen driver for dictation

Driver for Grundig Business Systems 
dictation devices

Nuance Audio Extensions for dictation B048

Olympus driver for dictation 20161103

Philips Speech Driver 12.5.4

Signature
signotec Citrix Channel 8.0.6

signotec VCOM Daemon 2.0.0

StepOver TCP Client 2.1.0

Smartcard
PKCS#11 Library A.E.T SafeSign 3.0.101

PKCS#11 Library Athena IDProtect 623.07

PKCS#11 Library cryptovision sc/interface 6.6.3.502

PKCS#11 Library Gemalto IDPrime 1.2.3

PKCS#11 Library SecMaker NetID 6.6.0.30

Reader Driver ACS CCID 1.1.3

Reader Driver Gemalto eToken 9.0.43

Reader Driver HID Global Omnikey CCID 4.2.4

Reader Driver Identiv / SCM Microsystems CCID 5.0.35

Reader Driver Identiv eHealth200 1.0.5

Reader Driver MUSCLE CCID 1.4.27

Reader Driver REINER SCT cyberJack 3.99.5final.SP09

Resource Manager PC/SC Lite 1.8.22

Cherry USB2LAN Proxy 3.0.0.4

System Components
Bluetooth stack (bluez) 5.46-0ubuntu3

MESA OpenGL stack 17.2.2-0ubuntu1

VAAPI ABI Version 0.40

VDPAU Library version 1.1.1-3ubuntu1
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Graphics Driver INTEL 2.99.917+git20171109-igel

Graphics Driver ATI/RADEON 7.10.0-1

raphics Driver ATI/AMDGPU 1.4.0-1

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2

Graphics Driver Nvidia 384.90-0ubuntu0.16.04.2

Graphics Driver Vboxvideo 5.1.30-dfsg-1

Graphics Driver VMware 13.2.1-1build1

Graphics Driver QXL (Spice) 0.1.5-2build1

Graphics Driver FBDEV 0.4.4-1build5

Graphics Driver VESA 2.3.4-1build2

Input Driver Evdev 2.10.5-1ubuntu1

Input Driver Elographics 1.4.1-1build5

Input Driver eGalax 2.5.5814

Input Driver Synaptics 1.9.0-1ubuntu1

Input Driver Vmmouse 13.1.0-1ubuntu2

Input Driver Wacom 0.34.0-0ubuntu2

Kernel 4.10.17 #41.45-udos-r1938

Xorg X11 Server 1.19.5-0ubuntu2

CUPS printing daemon 2.1.3-4ubuntu0.3

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2

ISC DHCP Client 4.3.3-5ubuntu12.7

NetworkManager 1.2.0-0ubuntu0.16.04.3

ModemManager 1.4.12-1ubuntu1

GStreamer 0.10 0.10.36-2ubuntu0.1

Features with Limited IGEL Support
Mobile Device Access USB
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Security Fixes 10.03.500
Fixed wpa security issues (KRACK vulnerability).
More

CVE-2017-13077

CVE-2017-13078

CVE-2017-13079

CVE-2017-13080

CVE-2017-13081

CVE-2017-13082

CVE-2017-13086

CVE-2017-13087

CVE-2017-13088

CVE-2016-4476

CVE-2016-4477

Fixed libgd2 security issues. CVE-2017-7890 and CVE-2017-6362.
Fixed graphite2 security issues.
More

CVE-2017-7778

CVE-2017-7777

CVE-2017-7776

CVE-2017-7775

CVE-2017-7774

CVE-2017-7773

CVE-2017-7772

CVE-2017-7771

Fixed ghostscript security issues.
More

CVE-2017-9835

CVE-2017-9739

CVE-2017-9727

CVE-2017-9726

CVE-2017-9612

CVE-2017-9611

CVE-2017-11714
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Fixed libmspack security issues CVE-2017-6419 and CVE-2017-11423.
Fixed libsoup2.4 security issue CVE-2017-2885.
Fixed xorg-server security issues.
More

CVE-2017-10971

CVE-2017-10972

CVE-2017-13721

CVE-2017-13723

CVE-2017-12176

CVE-2017-12177

CVE-2017-12178

CVE-2017-12179

CVE-2017-12180

CVE-2017-12181

CVE-2017-12182

CVE-2017-12183

CVE-2017-12184

CVE-2017-12185

CVE-2017-12186

CVE-2017-12187

Fixed bluez security issue CVE-2017-1000250.
Fixed kernel security issues.
More

CVE-2017-7541

CVE-2017-1000112

CVE-2017-1000111

CVE-2017-7487

CVE-2017-7533

CVE-2017-1000251

CVE-2017-14106

CVE-2017-11176

CVE-2017-10911

CVE-2017-14340

CVE-2017-10663

CVE-2017-1000252
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CVE-2017-12188

CVE-2017-12146

Fixed gdk-pixbuf security issues CVE-2017-6311, CVE-2017-2870 and CVE-2017-2862.
Fixed tcpdump security issues.
More

CVE-2017-13725, CVE-2017-13690, CVE-2017-13689, CVE-2017-13688,

CVE-2017-13687, CVE-2017-13055, CVE-2017-13054, CVE-2017-13053,

CVE-2017-13052, CVE-2017-13051, CVE-2017-13050, CVE-2017-13049,

CVE-2017-13048, CVE-2017-13047, CVE-2017-13046, CVE-2017-13045,

CVE-2017-13044, CVE-2017-13043, CVE-2017-13042, CVE-2017-13041,

CVE-2017-13040, CVE-2017-13039, CVE-2017-13038, CVE-2017-13037,

CVE-2017-13036, CVE-2017-13035, CVE-2017-13034, CVE-2017-13033,

CVE-2017-13032, CVE-2017-13031, CVE-2017-13030, CVE-2017-13029,

CVE-2017-13028, CVE-2017-13027, CVE-2017-13026, CVE-2017-13025,

CVE-2017-13024, CVE-2017-13023, CVE-2017-13022, CVE-2017-13021,

CVE-2017-13020, CVE-2017-13019, CVE-2017-13018, CVE-2017-13017,

CVE-2017-13016, CVE-2017-13015, CVE-2017-13014, CVE-2017-13013,

CVE-2017-13012, CVE-2017-13011, CVE-2017-13010, CVE-2017-13009,

CVE-2017-13008, CVE-2017-13007, CVE-2017-13006, CVE-2017-13005,

CVE-2017-13004, CVE-2017-13003, CVE-2017-13002, CVE-2017-13001,

CVE-2017-13000, CVE-2017-12999, CVE-2017-12998, CVE-2017-12997,

CVE-2017-12996, CVE-2017-12995, CVE-2017-12994, CVE-2017-12993,

CVE-2017-12992, CVE-2017-12991, CVE-2017-12990, CVE-2017-12989,

CVE-2017-12988, CVE-2017-12987, CVE-2017-12986, CVE-2017-12985,

CVE-2017-12902, CVE-2017-12901, CVE-2017-12900, CVE-2017-12899,

CVE-2017-12898, CVE-2017-12897, CVE-2017-12896, CVE-2017-12895,

CVE-2017-12894, CVE-2017-12893, CVE-2017-11543, CVE-2017-11542,

CVE-2017-11541 and CVE-2017-11108.

Fixed libxml2 security issues.
More

CVE-2017-9050

CVE-2017-9049

CVE-2017-9048

CVE-2017-9047
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CVE-2017-7376

CVE-2017-7375

CVE-2017-0663

Fixed samba security issues.
More

CVE-2017-12163

CVE-2017-12151

CVE-2017-12150

CVE-2017-15275

CVE-2017-14746

Fixed libplist security issue CVE-2017-7982.
Fixed nss security issue CVE-2017-7805.
Fixed libidn security issue CVE-2017-14062.
Fixed poppler security issues.
More

CVE-2017-9776,

CVE-2017-14977

CVE-2017-14975

CVE-2017-14929

CVE-2017-14928

CVE-2017-14926

CVE-2017-14617

CVE-2017-14520

CVE-2017-14519

CVE-2017-14518

CVE-2017-15565

Fixed dnsmasq security issues.
More

CVE-2017-14496

CVE-2017-14495

CVE-2017-14494

CVE-2017-14493

CVE-2017-14492

CVE-2017-14491

Fixed libxfont security issues CVE-2017-13722, CVE-2017-13720 and CVE-2017-16611.
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Fixed curl security issues.
More

CVE-2016-9586

CVE-2017-2629

CVE-2017-7407

CVE-2017-7468

CVE-2017-1000100

CVE-2017-1000101

CVE-2017-1000254

CVE-2017-1000257

CVE-2017-8816

CVE-2017-8817

Fixed libxfont2 security issues CVE-2017-13722, CVE-2017-13720 and CVE-2017-16611.
Fixed nvidia security issues CVE-2017-6266, CVE-2017-6267 and CVE-2017-6272.
Fixed icu security issue CVE-2017-14952.
Fixed wget security issues CVE-2017-6508, CVE-2017-13090, CVE-2017-13089 and CVE-2016-7098.
Fixed systemd security issue CVE-2017-15908.
Fixed openssl security issues CVE-2017-3736 and CVE-2017-3735.
Fixed perl security issues CVE-2017-12883 and CVE-2017-12837.
Fixed webkit2gtk security issues.
More

CVE-2017-13803

CVE-2017-13802

CVE-2017-13798

CVE-2017-13796

CVE-2017-13795

CVE-2017-13794

CVE-2017-13793

CVE-2017-13792

CVE-2017-13791

CVE-2017-13788

CVE-2017-13785

CVE-2017-13784

CVE-2017-13783

Fixed db5.3 security issue CVE-2017-10140.
Fixed ldns security issues CVE-2017-1000232 and CVE-2017-1000231.
Fixed python2.7 security issue CVE-2017-1000158.
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Fixed python3.5 security issue CVE-2017-1000158.
Fixed libxcursor security issue CVE-2017-16612.
Fixed a security issue in the base system regarding of not reseting certain environment variables.
Updated Firefox to version 52.5 ESR:

Fixes for mfsa2017-25, also known as: CVE-2017-7828, CVE-2017-7830, CVE-2017-7826.
Fixes for mfsa2017-22, also known as: CVE-2017-7793, CVE-2017-7818, CVE-2017-7819, 
CVE-2017-7824, CVE-2017-7805, CVE-2017-7814, CVE-2017-7823, CVE-2017-7810.
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General Information 10.03.500
The following clients and features are not supported anymore in version 10.03.550:

Citrix Receiver 12.1 and 13.1
Citrix Access Gateway Standard Plug-in
Dell vWorkspace Connector for Linux
Ericom PowerTerm Emulation 9 and 11
Ericom Webconnect
IGEL Legacy RDP Client (rdesktop)
Virtual Bridges VERDE Client
PPTP VPN Support
IGEL Upgrade License Tool with IGEL Smartcard Token
Remote Management by setup.ini file transfer (TFTP)
XC Font Service
Remote Access via RSH
Legacy Philips Speech Driver
Digital Persona Support
Sane Scanner Support
Softpro/Kofax Citrix Virtual Channel
t-Systems TCOS Smartcard Support
DUS Series touch screens
Elo serial touch screens
IGEL Smartcard without locking desktop
VIA Graphics Support
Storage Hotplug devices are not automatically removed anymore, instead they must be always 
ejected manually:

by panel tray icon
by an icon in the 'In-Session Control Bar' (configurable at IGEL Setup > User Interface > 
Desktop)
by a 'Safely Remove Hardware' session (configurable at IGEL Setup > Accessories)

The following clients and features are not available in release 10.03.550:

Voip Client Ekiga
X session (Xorg Xephyr)
XDMCP
Cherry eGK Channel
Open VPN Smartcard Support
NCP Secure Client
Asian Input Methods
Composite Manager
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Known Issues 10.03.500
Citrix Receiver 13

On devices with AMD/Radeon graphics chipsets and activated DRI3 X driver option the hardware 
accelerated Citrix H.264 decoder plugin can hang. To solve this issue deactivation of DRI3 
option is necessary (default setting).
More

Parameter Use DRI3

Registry x.drivers.use_dri3

Value enabled / disabled

Parameter Force usage of DRI3

Registry x.drivers.amdgpu.force_dri3

x.drivers.ati.force_dri3

Value enabled / disabled

Citrix StoreFront login with Gemalto smartcard middleware does not detect smartcard correctly 
when the card is inserted after start of login. As a workaround, insert the smartcard before starting 
StoreFront login.
No smooth playback over Nuance channel if the dictation device isn't attached.

VMware Horizon

External drives mounted already before connection do not appear in the remote desktop. 
Workaround: mapping the directory /media  as a drive on desktop. 
Then the external devices will show up inside the media drive.
Client drive mapping and USB redirection for storage devices should not be enabled both at 
the same time.

On the one hand, when using USB redirection for storage devices: The USB on-insertion 
feature is only working when the client drive mapping is switched off. In the IGEL Setup 
client drive mapping can be found in: Sessions > Horizon Client > Horizon Client Global > 
Drive Mapping > Enable Drive Mapping. It is also recommended to disable local Storage 
Hotplug: On page Devices > Storage Devices > Storage Hotplug, put number of storage 
hotplug devices to 0.
On the other hand, when using drive mapping instead, it is recommended to either switch 
off USB redirection entirely or at least deny storage devices by adding a filter to the USB 
class rules. Furthermore, Horizon Client relies on the OS to mount the storage devices itself. 
Change on the following setup page is required: Devices > Storage Devices > Storage 
Hotplug.
Activate Enable dynamic drive mapping and set Number of storage hotplug devices to at 
least 1.
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Firefox

Because the support for the gstreamer framework was dropped by recent Firefox versions, 
support for H264 decoding in the browser is not possible anymore due to licensing restrictions.

OpenConnect VPN

VPNs which need the OpenConnect client cannot be used for firmware updates.

Evidian

Active Directory users with a password containing special characters may have problems to 
authenticate with the configured session. 
Known special characters which result in errors are: 
` (grave accent, ASCII code 96) 
´ (acute accent, ASCII code 239)
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New Features 10.03.500
Citrix Receiver 13

Integrated Citrix Receiver 13.8.0.
More

Parameter Use Citrix Cloud with receiver 13.8 or newer

Registry ica.cloudconnect

Value enabled / disabled

Support for Azure Active Directory (Azure AD) authentication
Support for Workspace configuration from Citrix Cloud

Integrated Citrix Receiver 13.4.2. Citrix Receiver version 13.5.0 was removed. Available Citrix 
Receiver versions: 13.3.2, 13.4.2, 13.7.0, 13.8.0 (default)
Updated Citrix HDX RTME used for optimization of Skype for Business to 2.4.0.

RDP / IGEL RDP Client 2

Added possibility to use RDP local logon for smartcard login. This can be activated in the setup.
More

Parameter Enable smartcard support for local logon

Registry rdp.login.smartcard-local-logon

Value enabled / disabled

By enabling this parameter local logon can be used for smartcard authentication. If 
Username is left empty the connection to the RDP server will be made without sending 
credentials, so you can choose Smartcard as login method in the microsoft login 
window . However this will not work with NLA.

Added support for CredSSP up to version 6.

VMware Horizon

Updated VMware Horizon Client to version 4.7.0-7395152.
Added key to enable seamless window mode in each application session.
More

Parameter Seamless Application Windows

Registry sessions.vdm_client.options.enable_seamless_window

Value enabled / disabled

Added possibility to use Fabulatech USB Redirection in a Horizon Client PCoIP session.
More
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IGEL Setup Sessions > Horizon Client > Horizon Client Global > 
Fabulatech USB Redirection

Parameter Enable Fabulatech USB Redirection

Registry vmware.view. usb.enable-fabulatech-usb

Value enabled / disabled

Parallels Client

Integrated Parallels Client version 16.2.0 (19039)
Added support for USB Redirection, configurable at new IGEL Setup page Sessions > Parallels 
Client > Parallels Client Global > USB Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable USB Redirection

Registry twox.usb_redirection.usb_enable

Value enabled / disabled

Parameter Product ID

Registry twox.usb_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.usb_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.usb_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.usb_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule
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Parameter Automatically redirect all USB devices

Registry twox.usb_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for PTP/MTP Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable PTP/MTP Redirection

Registry twox.mtp_redirection.mtp_enable

Value enabled / disabled

Parameter Product ID

Registry twox.mtp_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.mtp_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.mtp_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.mtp_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule

Parameter Automatically redirect all PTP/MTP devices

Registry twox.mtp_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for Clipboard Redirection.
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More

IGEL Setup Sessions > Parallels Client > Parallels Client Sessions > Parallels Client 
Session > Local Resources

Parameter Connect clipboard

Registry sessions.twox.local_resources.connect_clipboard

Value enabled / disabled

VoIP

Added VoIP client Ekiga 4.0.1.

Firefox

Updated Firefox to version 52.7.2 ESR.
Updated Adobe Flash Player download URL to version 29.0.0.113.

Network

Added TTLS/PAP and TTLS/MSCHAPv2 to possible 802.1x authentication methods.
Improved support for Sierra EM7305 LTE device (e.g. in Toshiba Portégé and Fujitsu LIFEBOOK E 
Series).

Added support for Sierra EM7455 WWAN module.
Added support for running the Huawei E3531i WWAN device in modem mode (in addition to 
HiLink mode).
Added possibility to adopt the hostname from a DHCP lease as permanent terminal name. The 
purpose is to use the name received as part of a DHCP lease in future interactions with the DHCP 
server.
More

Parameter Adopt permanent Terminal Name from DHCP lease

Registry network.dns.hostname_adopt_from_dhcp

Value enabled / disabled

NetworkManager updated to version 1.2.2
ModemManager updated to version 1.6.4
usb_modeswitch updated to version 2.5.1

Open VPN

The EM7305 comes in various variants, e.g. one with ProductId 9041 and another one with 
ProductId 9063. The latter comes at least with one or with two USB configuration options. 
A device with only one configuration option has been observed on a Toshiba Tecra Z-50-
D-115 notebook. It only works in MBIM mode and with IGEL firmware, when the device has 
successfully connected before with the same settings (particularly APN), e.g. under 
Microsoft Windows 10.


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Added Huawei HiLink Mobile Broadband USB device as possible uplink to OpenVPN sessions.

OpenConnect VPN

Added OpenConnect client version 7.08 to connect to Cisco AnyConnect and Juniper VPN. The 
feature must be enabled.
More

IGEL Setup System > Firmware Customization > Features

Parameter VPN OpenConnect (Limited support - functionality "as is", see product 
documentation for details)

Registry services.unsupported02.enabled

Value enabled / disabled

The OpenConnect VPN configuration is available at IGEL Setup page Network > VPN > 
OpenConnect VPN.
More

IGEL Setup Network > VPN > OpenConnect VPN > VPN OpenConnect > Session

Parameter Gateway

Registry sessions.openconnect.vpnopts.gateway

Parameter Enable Name/Password Authentication

Registry sessions.openconnect.vpnopts.enable-name-pwd

Value enabled / disabled

Parameter User Name

Registry sessions.openconnect.vpnopts.username

Parameter Password

Registry sessions.openconnect.vpnopts.crypt_password

Parameter CA Certificate

Registry sessions.openconnect.vpnopts.ca-cert

Parameter User Certificate

Registry sessions.openconnect.vpnopts.user-cert

Parameter Private Key

Registry sessions.openconnect.vpnopts.priv-key
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Parameter Private Key password

Registry sessions.openconnect.vpnopts.priv-key-

pwd.crypt_password

Parameter Connect to Juniper Networks VPN

Registry sessions.openconnect%.vpnopts.is-juniper

Value enabled / disabled

Smartcard

Added CoolKey PKCS#11 library for access to Common Access Card (CAC) smartcards.
More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter Coolkey Security Device

Registry browserglobal.security_device.coolkey

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by Coolkey library

Registry vmware.view.pkcs11.use_coolkey

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter Coolkey

Registry scard.pkcs11.use_coolkey

Value enabled / disabled

Updated Gemalto SafeNet PKCS#11 library to version 10.0.37-0. This package replaces Gemalto/
SafeNet eToken and Gemalto IDPrime libraries.
Gemalto SafeNet (formerly Gemalto/SafeNet eToken) now handles Gemalto cards and tokens 
including eToken and IDPrime. 
Gemalto IDPrime now handles IDPrime cards and tokens, preferred Common Creteria (CC) cards 
and tokens in Unlinked Mode.
Added full integration of OpenSC PKCS#11 library for access to smartcards.

Tray icon is placed in the panel to disconnect from a running OpenConnect VPN 
connection.


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More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter OpenSC Security Device

Registry browserglobal.security_device.opensc

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by OpenSC library

Registry vmware.view.pkcs11.use_opensc

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter OpenSC

Registry scard.pkcs11.use_opensc

Value enabled / disabled

Updated MUSCLE CCID smartcard reader driver to version 1.4.28.
Updated ACS CCID smartcard reader driver to version 1.1.5.
Updated REINER SCT cyberJack smartcard reader driver to version 3.99.5final.sp11.
Added parameter to disable Identive CCID smartcard reader driver. If this driver is disabled, some 
of the readers are handled by the MUSCLE CCID driver. This can help when problems with Identive 
reader driver occur.
More

Parameter Identive driver for smart card readers

Registry scard.pcscd.identiv_enable

Value enabled / disabled

Updated cryptovision sc/interface PKCS#11 library to version 7.0.5.592.
New smartcard reader driver for Fujitsu KB SCR eSIG version 5.0.24.

HID

Added layout toggle feature to on-screen keyboard.
More

IGEL Setup Accessories > On-Screen Keyboard > Appearance

Parameter Enable switching to alternative layout
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Registry userinterface.softkeyboard.enable_alternative_layo

ut

Value enabled / disabled

If this is enabled there is a key on the on-screen keyboard for toggling between the normal 
layout and a reduced layout, that saves space on the screen and has more or less the 
same features as the number block of an ordinary keyboard with some extensions.

Base System

Added support for UEFI Secure Boot.

Updated kernel to version 4.15.15
Boot time optimization (up to 25% faster)
Switch power off on USB ports on shutdown and reboot. The feature can be enabled in IGEL 
Setup. At the moment only IGEL H830C is supported.
More

IGEL Setup System > Registry

Parameter Power off on shutdown

Registry devices.usb.poweroff_shutdown

Value enabled / disabled

Added Unit ID in Application Launcher About > Hardware section.
Showing number of CPU cores in Application Launcher About > Hardware section now.

Storage Devices

Added support for Mobile Device Access feature in Appliance Mode. The Mobile Device Access 
tool can be opened via a new icon in the In-session control bar. The Mobile Device Access tool can 
also be started automatically.
More

Parameter Autostart

Registry sessions.mtp-devices0.autostart

Value enabled / disabled

Mobile Device Access must be enabled at IGEL Setup > System > Firmware 
Customization > Features. Appliance Mode must be enabled at IGEL Setup > Sessions > 
Appliance Mode.

When booted with Secure Boot the downgrade to a firmware version older than 10.04.100 
is locked.


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The Mobile Device Access tool is now configurable at IGEL Setup > Accessories > Mobile Device 
Access.
The Mobile Device Access tray icon respects the current theme now.

X11 System

Added support for XDMCP Appliance Mode. The XDMCP connection is configurable.
More

IGEL Setup Sessions > Appliance Mode

Parameter XDMCP for this Display

Registry x.xdmcp0.enabled

Value enabled / disabled

IGEL Setup Sessions > Appliance Mode

Parameter Connection Type

Registry x.xdmcp0.server.connectiontype

Range indirect via localhost / indirect / direct / broadcast

IGEL Setup Sessions > Appliance Mode

Parameter Name or IP of server

Registry x.xdmcp0.server.servername

IGEL Setup Sessions > Appliance Mode

Parameter Enable hotkeys for XDMCP Display

Registry x.xdmcp0.hotkeys.enabled

Value enabled / disabled

The default hotkey to open IGEL Setup is: CTRL + ALT + F2. The setup page User Interface 
> Display > XDMCP was removed.

Added XC Font Service support.
More

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Enable XC Font Service

Registry x.xc_fontservice.enabled

Value enabled / disabled
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IGEL Setup User Interface > Font Services > XC Font Service

Parameter XC Font Server

Registry x.xc_fontservice.fontserver

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Port Number

Registry x.xc_fontservice.port

Value 7100

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Prefer Local Fonts

Registry x.xc_fontservice.prefer_localfonts

Value enabled / disabled

Added auto detection of monitor refresh rate. This can be controlled with new parameters.
More

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0.auto_frequency

Value enabled / disabled

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0. screen.auto_frequency

Value enabled / disabled

Added xorg debug script /etc/igel/igel_debug_tools/xorg-debug.sh to make collecting Xorg 
debug data easier (a /tmp/xorg-debug.log file is generated).

Window Manager

Added possibility to
a) change the preferred placement mode and
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b) modify the threshold value up to which window size this placement mode should be 
chosen (otherwise window placement defaults to so called smart mode which tries to 
minimize overlapping).

More

Parameter Preferred Placement

Registry windowmanager.wm0.variables.placement_mode

Value At mouse position / Centered

Parameter Maximum window size for which the preferred placement should apply

Registry windowmanager.wm0.variables.placement_ratio

Value 0% / 10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%

Audio

Volume of audio output and input can now be configured up to 150% at IGEL Setup page 
Accessories > Sound Preferences > Options.
Added a parameter for log level configuration of Pulseaudio service.
More

Parameter Log level

Registry multimedia.pulseaudio.daemon.log-level

Range debug / info / notice / warning / error

Misc

An EULA must be accepted now in IGEL setup assistant before finalizing it and using the IGEL OS.

Java

Updated Oracle JRE to 1.8U162.

Remote Management

Added new log file transfer mechanism for UMS feature Save TC files for support (UMS 5.08.110 
or higher required). By default, it collects all log files visible in system log viewer, system 
configuration files group.ini, setup.ini and dhclient lease files. More files can be specified at IGEL 
Setup > Accessories > System Log Viewer > Options. The resulting zip file has now a folder 
structure.

IGEL Cloud Gateway

Added UMS structure tag handling for usage with ICG agent.

Hardware

Added support for IGEL UD7-LX 10.
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Resolved Issues 10.03.500
Citrix

Fixed sporadic crashes of the Citrix USB Daemon.

RDP / IGEL RDP Client 2

Fixed passing Ctrl+Alt+C keyboard shortcut to RDP session.
Fixed smartcard redirection: after session reconnection readers and cards were not connected 
any more in some cases.
Fixed the rdpdebugger to work again (was broken in the previous release).
Fixed misleading RDP error message `Authentication failed` on wakeup from suspend mode
Fixed TCP timeout value to get more stable RDP connections under certain circumstances.

VMware Horizon

Fixed bug which prevented microphone redirection in Horizon Client RDP sessions.
More

IGEL Setup Sessions > RDP > RDP Global > Mapping > Audio

Parameter Audio recording

Registry rdp.winconnect.rdpeai.enable

Value enabled / disabled

RedHat Enterprise Virtualization Client

Fixed display corruption with Windows connections.

Firefox

Fixed possibility to download files in the browser if needed. The parameter to enable/disable file 
download is available here.
More

IGEL Setup Sessions > Browser > Browser Sessions > Window

Parameter Hide local filesystem

Registry sessions.browser.app.filepicker_dialog_hidden

Value enabled / disabled

If enabled, the user is not allowed to download or use any save-as functionality from 
menu, context or keyboard shortcut.

Fixed bug which prevented the download using the file dialog (in the case you open a link to a 
file of unkonwn type).
Fixed unmounting of the Firefox profile partition during shutdown - now it is unmounted in a 
determinate manner after Custom Partition.
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Network

Fixed bug: Network tray icons sometimes didn't reappear after network restart.
Fixed bug: tcpdump debug tool terminated immediately during boot.
Fixed issue with naming of USB ethernet devices.
Fixed wrong LinkMode (10baseT/Half) with autonegotiation and some USB ethernet devices.

AppliDis

Changed default value of PasswordMode from cmdline to prompt as suggested by Systancia.

Smartcard

Fixed driver for Elatec RFID readers. Before this fix the readers sometimes were not available after 
boot.
Fixed VMware Horizon logon with OpenSC smartcards.

CUPS Printing

Fixed bug where the user for printjobs was not set to the domain user.

Base System

Fixed Kerberos password change to work also with transport protocol TCP. To force protocol 
TCP, prepend Domain Controllers with prefix "tcp/", e.g. "tcp/dc.example.com".
Fixed occasional desktop hang in the local login or the network login mask after successful 
authentication.
Fixed password expiry notification showing negative expiry period.
Fixed update to connect to SFTP servers with very restrictive key exchange settings.
Fixed input of the reset key in reset to defaults boot, if the administrator password is not 
available anymore. If more than 255 characters were entered in the 1st try, it was not possible to 
enter the reset key for a 2nd or 3rd time.
Fixed Active Directory logon with smartcard: If the smartcard contains logon certificates for 
multiple users, it is possible to switch between these certificates and log on with the chosen 
certificate now.
Fixed missing names for some partitions in update notification when having a user interface 
language other than English.
Fixed problems with never ending bootcode update with some EFI BIOS variants.
Fixed ssh server port configuration.
Fixed signotec signature pad channel for Citrix.
Increased stability of signotec VCOM Daemon.
Remove residual information belonging to a removed content from a custom partition.
Fixed crash of xfce4-power-manager after adding or removing input devices.

Custom Partition

Fixed automatic update of custom partition - if download source isn't accessible then the 
content of the custom partition got lost.

Appliance Mode

Fixed post session command Logoff in Appliance Mode.

X11 System
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Fixed Elo-USB Touchscreen functionality after reboot.
Fixed DisplayLink USB Support on UD3 LX50.
Fixed issue with two monitors connected via DVI-D to HDMI adapter on a UD3 M330 (VIA). 
Added registry key to disable the new HDMI autodetection.
More

Parameter Autodetect if DVI to HDMI adapter is in use

Registry x.drivers.via.autodetect_hdmi_output

Value enabled / disabled

Fixed wrong automatic resolution detection if monitor does not have a preferred mode.
Fixed sporadic display corruptions after monitors leaving the power saving mode.
Improved handling of more than 2 screens.

Shadowing/VNC

Fixed sporadic VNC server crash.

Audio

Fixed volume control of internal speaker in HP T610.
Fixed automatic switch to output over analog headphones.
Not existing S/PDIF inputs and outputs in Plantronics and Jabra USB headsets are now ignored 
by audio subsystem (Pulseaudio).
Added workaround in the kernel USB audio driver for volume control on Sennheiser USB 
headsets.

Remote Management

Fixed calculation of Unit ID for UMS management. In some cases, it could happen that the MAC 
address of wrong network interface was chosen.
Fixed IGEL Setup Assistant to get stopped when settings were received from UMS.
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IGEL Universal Desktop Converter (UDC3) 10.03.500
Supported Hardware:

Third-Party Devices Supported by IGEL OS 10

Versions 10.03.500 (see page 1478)
New Features 10.03.500 (see page 1479)
Resolved Issues 10.03.500 (see page 1490)
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Versions 10.03.500
Clients
Oracle JRE 1.8.0_152

System Components
Bluetooth stack (bluez) 5.46-0ubuntu3

MESA OpenGL stack 17.2.2-0ubuntu1

VAAPI ABI Version 0.40

Graphics Driver INTEL 2.99.917+git20171109-igel

Graphics Driver ATI/RADEON 7.10.0-1

raphics Driver ATI/AMDGPU 1.4.0-1

Graphics Driver Nouveau (Nvidia Legacy) 1.0.15-2

Graphics Driver Vboxvideo 5.1.30-dfsg-1

Graphics Driver VMware 13.2.1-1build1

Graphics Driver QXL (Spice) 0.1.5-2build1

Graphics Driver FBDEV 0.4.4-1build5

Graphics Driver VESA 2.3.4-1build2

Input Driver Evdev 2.10.5-1ubuntu1

Input Driver Elographics 1.4.1-1build5

Input Driver Synaptics 1.9.0-1ubuntu1

Input Driver Vmmouse 13.1.0-1ubuntu2

Input Driver Wacom 0.34.0-0ubuntu2

Kernel 4.10.17 #41.45-udos-r1938

Xorg X11 Server 1.19.5-0ubuntu2

Lightdm graphical login manager 1.18.3-0ubuntu1.1

XFCE4 Windowmanager 4.12.3-1ubuntu2

ISC DHCP Client 4.3.3-5ubuntu12.7
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New Features 10.03.500
Citrix Receiver 13

Integrated Citrix Receiver 13.8.0.
More

Parameter Use Citrix Cloud with receiver 13.8 or newer

Registry ica.cloudconnect

Value enabled / disabled

Support for Azure Active Directory (Azure AD) authentication
Support for Workspace configuration from Citrix Cloud

Integrated Citrix Receiver 13.4.2. Citrix Receiver version 13.5.0 was removed. Available Citrix 
Receiver versions: 13.3.2, 13.4.2, 13.7.0, 13.8.0 (default)
Updated Citrix HDX RTME used for optimization of Skype for Business to 2.4.0.

RDP / IGEL RDP Client 2

Added possibility to use RDP local logon for smartcard login. This can be activated in the setup.
More

Parameter Enable smartcard support for local logon

Registry rdp.login.smartcard-local-logon

Value enabled / disabled

By enabling this parameter local logon can be used for smartcard authentication. If 
Username is left empty the connection to the RDP server will be made without sending 
credentials, so you can choose Smartcard as login method in the microsoft login 
window . However this will not work with NLA.

Added support for CredSSP up to version 6.

VMware Horizon

Updated VMware Horizon Client to version 4.7.0-7395152.
Added key to enable seamless window mode in each application session.
More

Parameter Seamless Application Windows

Registry sessions.vdm_client.options.enable_seamless_window

Value enabled / disabled

Added possibility to use Fabulatech USB Redirection in a Horizon Client PCoIP session.
More
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IGEL Setup Sessions > Horizon Client > Horizon Client Global > 
Fabulatech USB Redirection

Parameter Enable Fabulatech USB Redirection

Registry vmware.view. usb.enable-fabulatech-usb

Value enabled / disabled

Parallels Client

Integrated Parallels Client version 16.2.0 (19039)
Added support for USB Redirection, configurable at new IGEL Setup page Sessions > Parallels 
Client > Parallels Client Global > USB Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable USB Redirection

Registry twox.usb_redirection.usb_enable

Value enabled / disabled

Parameter Product ID

Registry twox.usb_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.usb_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.usb_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.usb_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule
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Parameter Automatically redirect all USB devices

Registry twox.usb_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for PTP/MTP Redirection.
More

IGEL Setup Sessions > Parallels Client > Parallels Client Global > USB Redirection

Parameter Enable PTP/MTP Redirection

Registry twox.mtp_redirection.mtp_enable

Value enabled / disabled

Parameter Product ID

Registry twox.mtp_redirection.devicepolicy.product_rule.pro

duct

Parameter Vendor ID

Registry twox.mtp_redirection.devicepolicy.product_rule.ven

dor

Parameter Rule

Registry twox.mtp_redirection.devicepolicy.product_rule.rul

e

Value Deny / Allow

Parameter Name

Registry twox.mtp_redirection.devicepolicy.product_rule.nam

e

Value Policy Rule

Parameter Automatically redirect all PTP/MTP devices

Registry twox.mtp_redirection.devicepolicy.redirect_all

Value enabled / disabled

Added support for Clipboard Redirection.
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More

IGEL Setup Sessions > Parallels Client > Parallels Client Sessions > Parallels Client 
Session > Local Resources

Parameter Connect clipboard

Registry sessions.twox.local_resources.connect_clipboard

Value enabled / disabled

VoIP

Added VoIP client Ekiga 4.0.1.

Firefox

Updated Firefox to version 52.7.2 ESR.
Updated Adobe Flash Player download URL to version 29.0.0.113.

Network

Added TTLS/PAP and TTLS/MSCHAPv2 to possible 802.1x authentication methods.
Improved support for Sierra EM7305 LTE device (e.g. in Toshiba Portégé and Fujitsu LIFEBOOK E 
Series).

Added support for Sierra EM7455 WWAN module.
Added support for running the Huawei E3531i WWAN device in modem mode (in addition to 
HiLink mode).
Added possibility to adopt the hostname from a DHCP lease as permanent terminal name. The 
purpose is to use the name received as part of a DHCP lease in future interactions with the DHCP 
server.
More

Parameter Adopt permanent Terminal Name from DHCP lease

Registry network.dns.hostname_adopt_from_dhcp

Value enabled / disabled

NetworkManager updated to version 1.2.2
ModemManager updated to version 1.6.4
usb_modeswitch updated to version 2.5.1

Open VPN

The EM7305 comes in various variants, e.g. one with ProductId 9041 and another one with 
ProductId 9063. The latter comes at least with one or with two USB configuration options. 
A device with only one configuration option has been observed on a Toshiba Tecra Z-50-
D-115 notebook. It only works in MBIM mode and with IGEL firmware, when the device has 
successfully connected before with the same settings (particularly APN), e.g. under 
Microsoft Windows 10.





Notes for Release 10.03.500

IGEL OS Release Notes   1483 / 1492

•

•

•

Added Huawei HiLink Mobile Broadband USB device as possible uplink to OpenVPN sessions.

OpenConnect VPN

Added OpenConnect client version 7.08 to connect to Cisco AnyConnect and Juniper VPN. The 
feature must be enabled.
More

IGEL Setup System > Firmware Customization > Features

Parameter VPN OpenConnect (Limited support - functionality "as is", see product 
documentation for details)

Registry services.unsupported02.enabled

Value enabled / disabled

The OpenConnect VPN configuration is available at IGEL Setup page Network > VPN > 
OpenConnect VPN.
More

IGEL Setup Network > VPN > OpenConnect VPN > VPN OpenConnect > Session

Parameter Gateway

Registry sessions.openconnect.vpnopts.gateway

Parameter Enable Name/Password Authentication

Registry sessions.openconnect.vpnopts.enable-name-pwd

Value enabled / disabled

Parameter User Name

Registry sessions.openconnect.vpnopts.username

Parameter Password

Registry sessions.openconnect.vpnopts.crypt_password

Parameter CA Certificate

Registry sessions.openconnect.vpnopts.ca-cert

Parameter User Certificate

Registry sessions.openconnect.vpnopts.user-cert

Parameter Private Key

Registry sessions.openconnect.vpnopts.priv-key
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Parameter Private Key password

Registry sessions.openconnect.vpnopts.priv-key-

pwd.crypt_password

Parameter Connect to Juniper Networks VPN

Registry sessions.openconnect%.vpnopts.is-juniper

Value enabled / disabled

Smartcard

Added CoolKey PKCS#11 library for access to Common Access Card (CAC) smartcards.
More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter Coolkey Security Device

Registry browserglobal.security_device.coolkey

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by Coolkey library

Registry vmware.view.pkcs11.use_coolkey

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter Coolkey

Registry scard.pkcs11.use_coolkey

Value enabled / disabled

Updated Gemalto SafeNet PKCS#11 library to version 10.0.37-0. This package replaces Gemalto/
SafeNet eToken and Gemalto IDPrime libraries.
Gemalto SafeNet (formerly Gemalto/SafeNet eToken) now handles Gemalto cards and tokens 
including eToken and IDPrime. 
Gemalto IDPrime now handles IDPrime cards and tokens, preferred Common Creteria (CC) cards 
and tokens in Unlinked Mode.
Added full integration of OpenSC PKCS#11 library for access to smartcards.

Tray icon is placed in the panel to disconnect from a running OpenConnect VPN 
connection.


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More

IGEL Setup Sessions > Browser > Browser Global > Encryption

Parameter OpenSC Security Device

Registry browserglobal.security_device.opensc

Value enabled / disabled

IGEL Setup Sessions > Horizon Client > Horizon Client Global > Smartcard

Parameter Horizon logon with smartcards supported by OpenSC library

Registry vmware.view.pkcs11.use_opensc

Value enabled / disabled

IGEL Setup Security > Smartcard > Middleware

Parameter OpenSC

Registry scard.pkcs11.use_opensc

Value enabled / disabled

Updated MUSCLE CCID smartcard reader driver to version 1.4.28.
Updated ACS CCID smartcard reader driver to version 1.1.5.
Updated REINER SCT cyberJack smartcard reader driver to version 3.99.5final.sp11.
Added parameter to disable Identive CCID smartcard reader driver. If this driver is disabled, some 
of the readers are handled by the MUSCLE CCID driver. This can help when problems with Identive 
reader driver occur.
More

Parameter Identive driver for smart card readers

Registry scard.pcscd.identiv_enable

Value enabled / disabled

Updated cryptovision sc/interface PKCS#11 library to version 7.0.5.592.
New smartcard reader driver for Fujitsu KB SCR eSIG version 5.0.24.

HID

Added layout toggle feature to on-screen keyboard.
More

IGEL Setup Accessories > On-Screen Keyboard > Appearance

Parameter Enable switching to alternative layout
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Registry userinterface.softkeyboard.enable_alternative_layo

ut

Value enabled / disabled

If this is enabled there is a key on the on-screen keyboard for toggling between the normal 
layout and a reduced layout, that saves space on the screen and has more or less the 
same features as the number block of an ordinary keyboard with some extensions.

Base System

Added support for UEFI Secure Boot.

Updated kernel to version 4.15.15
Boot time optimization (up to 25% faster)
Switch power off on USB ports on shutdown and reboot. The feature can be enabled in IGEL 
Setup. At the moment only IGEL H830C is supported.
More

IGEL Setup System > Registry

Parameter Power off on shutdown

Registry devices.usb.poweroff_shutdown

Value enabled / disabled

Added Unit ID in Application Launcher About > Hardware section.
Showing number of CPU cores in Application Launcher About > Hardware section now.

Storage Devices

Added support for Mobile Device Access feature in Appliance Mode. The Mobile Device Access 
tool can be opened via a new icon in the In-session control bar. The Mobile Device Access tool can 
also be started automatically.
More

Parameter Autostart

Registry sessions.mtp-devices0.autostart

Value enabled / disabled

Mobile Device Access must be enabled at IGEL Setup > System > Firmware 
Customization > Features. Appliance Mode must be enabled at IGEL Setup > Sessions > 
Appliance Mode.

When booted with Secure Boot the downgrade to a firmware version older than 10.04.100 
is locked.


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The Mobile Device Access tool is now configurable at IGEL Setup > Accessories > Mobile Device 
Access.
The Mobile Device Access tray icon respects the current theme now.

X11 System

Added support for XDMCP Appliance Mode. The XDMCP connection is configurable.
More

IGEL Setup Sessions > Appliance Mode

Parameter XDMCP for this Display

Registry x.xdmcp0.enabled

Value enabled / disabled

IGEL Setup Sessions > Appliance Mode

Parameter Connection Type

Registry x.xdmcp0.server.connectiontype

Range indirect via localhost / indirect / direct / broadcast

IGEL Setup Sessions > Appliance Mode

Parameter Name or IP of server

Registry x.xdmcp0.server.servername

IGEL Setup Sessions > Appliance Mode

Parameter Enable hotkeys for XDMCP Display

Registry x.xdmcp0.hotkeys.enabled

Value enabled / disabled

The default hotkey to open IGEL Setup is: CTRL + ALT + F2. The setup page User Interface 
> Display > XDMCP was removed.

Added XC Font Service support.
More

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Enable XC Font Service

Registry x.xc_fontservice.enabled

Value enabled / disabled
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IGEL Setup User Interface > Font Services > XC Font Service

Parameter XC Font Server

Registry x.xc_fontservice.fontserver

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Port Number

Registry x.xc_fontservice.port

Value 7100

IGEL Setup User Interface > Font Services > XC Font Service

Parameter Prefer Local Fonts

Registry x.xc_fontservice.prefer_localfonts

Value enabled / disabled

Added auto detection of monitor refresh rate. This can be controlled with new parameters.
More

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0.auto_frequency

Value enabled / disabled

IGEL Setup User Interface > Display > Advanced

Parameter Detect refresh rate automatically

Registry x.xserver0. screen.auto_frequency

Value enabled / disabled

Added xorg debug script /etc/igel/igel_debug_tools/xorg-debug.sh to make collecting Xorg 
debug data easier (a /tmp/xorg-debug.log file is generated).

Window Manager

Added possibility to
a) change the preferred placement mode and
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b) modify the threshold value up to which window size this placement mode should be 
chosen (otherwise window placement defaults to so called smart mode which tries to 
minimize overlapping).

More

Parameter Preferred Placement

Registry windowmanager.wm0.variables.placement_mode

Value At mouse position / Centered

Parameter Maximum window size for which the preferred placement should apply

Registry windowmanager.wm0.variables.placement_ratio

Value 0% / 10% / 20% / 30% / 40% / 50% / 60% / 70% / 80% / 90% / 100%

Audio

Volume of audio output and input can now be configured up to 150% at IGEL Setup page 
Accessories > Sound Preferences > Options.
Added a parameter for log level configuration of Pulseaudio service.
More

Parameter Log level

Registry multimedia.pulseaudio.daemon.log-level

Range debug / info / notice / warning / error

Misc

An EULA must be accepted now in IGEL setup assistant before finalizing it and using the IGEL OS.

Java

Updated Oracle JRE to 1.8U162.

Remote Management

Added new log file transfer mechanism for UMS feature Save TC files for support (UMS 5.08.110 
or higher required). By default, it collects all log files visible in system log viewer, system 
configuration files group.ini, setup.ini and dhclient lease files. More files can be specified at IGEL 
Setup > Accessories > System Log Viewer > Options. The resulting zip file has now a folder 
structure.

IGEL Cloud Gateway

Added UMS structure tag handling for usage with ICG agent.

Hardware

Added support for IGEL UD7-LX 10.
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Resolved Issues 10.03.500
Citrix

Fixed sporadic crashes of the Citrix USB Daemon.

RDP / IGEL RDP Client 2

Fixed passing Ctrl+Alt+C keyboard shortcut to RDP session.
Fixed smartcard redirection: after session reconnection readers and cards were not connected 
any more in some cases.
Fixed the rdpdebugger to work again (was broken in the previous release).
Fixed misleading RDP error message `Authentication failed` on wakeup from suspend mode
Fixed TCP timeout value to get more stable RDP connections under certain circumstances.

VMware Horizon

Fixed bug which prevented microphone redirection in Horizon Client RDP sessions.
More

IGEL Setup Sessions > RDP > RDP Global > Mapping > Audio

Parameter Audio recording

Registry rdp.winconnect.rdpeai.enable

Value enabled / disabled

RedHat Enterprise Virtualization Client

Fixed display corruption with Windows connections.

Firefox

Fixed possibility to download files in the browser if needed. The parameter to enable/disable file 
download is available here.
More

IGEL Setup Sessions > Browser > Browser Sessions > Window

Parameter Hide local filesystem

Registry sessions.browser.app.filepicker_dialog_hidden

Value enabled / disabled

If enabled, the user is not allowed to download or use any save-as functionality from 
menu, context or keyboard shortcut.

Fixed bug which prevented the download using the file dialog (in the case you open a link to a 
file of unkonwn type).
Fixed unmounting of the Firefox profile partition during shutdown - now it is unmounted in a 
determinate manner after Custom Partition.
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Network

Fixed bug: Network tray icons sometimes didn't reappear after network restart.
Fixed bug: tcpdump debug tool terminated immediately during boot.
Fixed issue with naming of USB ethernet devices.
Fixed wrong LinkMode (10baseT/Half) with autonegotiation and some USB ethernet devices.

AppliDis

Changed default value of PasswordMode from cmdline to prompt as suggested by Systancia.

Smartcard

Fixed driver for Elatec RFID readers. Before this fix the readers sometimes were not available after 
boot.
Fixed VMware Horizon logon with OpenSC smartcards.

CUPS Printing

Fixed bug where the user for printjobs was not set to the domain user.

Base System

Fixed Kerberos password change to work also with transport protocol TCP. To force protocol 
TCP, prepend Domain Controllers with prefix "tcp/", e.g. "tcp/dc.example.com".
Fixed occasional desktop hang in the local login or the network login mask after successful 
authentication.
Fixed password expiry notification showing negative expiry period.
Fixed update to connect to SFTP servers with very restrictive key exchange settings.
Fixed input of the reset key in reset to defaults boot, if the administrator password is not 
available anymore. If more than 255 characters were entered in the 1st try, it was not possible to 
enter the reset key for a 2nd or 3rd time.
Fixed Active Directory logon with smartcard: If the smartcard contains logon certificates for 
multiple users, it is possible to switch between these certificates and log on with the chosen 
certificate now.
Fixed missing names for some partitions in update notification when having a user interface 
language other than English.
Fixed problems with never ending bootcode update with some EFI BIOS variants.
Fixed ssh server port configuration.
Fixed signotec signature pad channel for Citrix.
Increased stability of signotec VCOM Daemon.
Remove residual information belonging to a removed content from a custom partition.
Fixed crash of xfce4-power-manager after adding or removing input devices.

Custom Partition

Fixed automatic update of custom partition - if download source isn't accessible then the 
content of the custom partition got lost.

Appliance Mode

Fixed post session command Logoff in Appliance Mode.

X11 System
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Fixed Elo-USB Touchscreen functionality after reboot.
Fixed DisplayLink USB Support on UD3 LX50.
Fixed issue with two monitors connected via DVI-D to HDMI adapter on a UD3 M330 (VIA). 
Added registry key to disable the new HDMI autodetection.
More

Parameter Autodetect if DVI to HDMI adapter is in use

Registry x.drivers.via.autodetect_hdmi_output

Value enabled / disabled

Fixed wrong automatic resolution detection if monitor does not have a preferred mode.
Fixed sporadic display corruptions after monitors leaving the power saving mode.
Improved handling of more than 2 screens.

Shadowing/VNC

Fixed sporadic VNC server crash.

Audio

Fixed volume control of internal speaker in HP T610.
Fixed automatic switch to output over analog headphones.
Not existing S/PDIF inputs and outputs in Plantronics and Jabra USB headsets are now ignored 
by audio subsystem (Pulseaudio).
Added workaround in the kernel USB audio driver for volume control on Sennheiser USB 
headsets.

Remote Management

Fixed calculation of Unit ID for UMS management. In some cases, it could happen that the MAC 
address of wrong network interface was chosen.
Fixed IGEL Setup Assistant to get stopped when settings were received from UMS.
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